
15. Quality Assurance 

This section describes the tools available for science data Quality Assurance (QA) - the QA 
Monitor and the QA Metadata Update Tool (QAMUT). 

Operational Quality Assurance is performed by DAAC operations personnel authorized to 
modify the value of the Operational QA flag attribute value for a product generated at the 
DAAC. The operator has the capability to view the product through EOSView and retrieve 
production history files. Figure 15-1 provides an overview of the quality assurance process. 
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Figure 15-1. QA Metadata Update Process 

15.1 QA Monitor 

The purpose of the QA Monitor is to enable DAAC QA experts to modify ScienceQualityFlag 
and OperationalQualityFlag attributes of core metadata for a granule. SCFs send email requests 
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to the DAAC to update the ScienceQualityFlag attribute, until the QA Metadata Update Tool 
(Section 15.2) is available. 

The QA Monitor can be used to request the Science Data Server to search for specific types of 
Data Granules; Query, Retrieve, and Update (QRU) Metadata; transfer Data Granules to the 
operator’s computer; and transfer Production History to the operator’s computer. It can also be 
used to update data granule metadata, view graphical images of data granules, and print/display 
lists of data granules and data types. Table 15.1-1 summarizes common operator functions 
performed with the QA Monitor. Table 15.1-2 describes the fields in the QA Monitor; Table 
15.1-2 provides the usage for each of the pushbuttons. 

The QA Monitor is launched by clicking on the Desktop Icon, or via Unix commands. The Unix 
commands are provided following Tables 15.1-1 through 15.1-3. 

Table 15.1-1. Common Operator Functions Performed with the 
QA Monitor 

Operator Function Description Purpose 
Query Data Granules Initiates a request to search the science 

archive for data granules 
Find all archived data granules 
with the same data type which 
were inserted into the archive 
at a certain time (data interval) 

Retrieve Data Granules Initiates a request to get data granules 
from the science archive 

Transfer data granule(s) from 
archive to local disk for 
visualization 

Visualize Data (HDF files) Display Visualize screen View graphical image of data 
granules to assess quality 

Update Metadata Initiates a request to archive QA 
information about data granules 

Update data granule QA 
information in the archive, 
based on DAAC QA activities 
encompassing use of the 
Visualize Data function. 

Table 15.1-2. QA Monitor GUI Fields 
Field Name Data Type Size Entry Description 

Data Granule Insert 
Begin 
End 

Date 
min 
max 

1/2/1901 
6/1/2036 

Initial default value ­
can be changed by 
user 

Search criteria for 
granule metadata 
beginning and end date 

Data Types list single 
selection 

N/A User selects a data 
type from the list 
displayed at startup 

The list of all available 
data types at a specific 
DAAC 

Data Granules list multiple 
selection 

N/A User clicks data 
granule row(s) then 
clicks retrieve 
pushbutton 

The list of all data 
granules in the date 
interval above for a 
particular selected data 
type are available for 
retrieval. 

Status text N/A Displays status 
messages only 

Displays status 
messages 
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Table 15.1-3. QA Monitor GUI Pushbuttons 
Button Description 
Query Populates list of data granules on the bottom half of the GUI for a particular 

selected data type within a data interval 
Find (below the data types and data granules list) - allow the operator to perform a 

keyword search for information stored in those 2 lists. 
Retrieve Allows the operator to retrieve data granule(s) or production history tar file(s) 

from the DAAC’s data archive and place on the local disk. 
Update Pops up a Granule Parameters screen Update Metadata Dialog 

Launching the QA Monitor Using UNIX Commands 

1	 Access the command shell. 
The command shell prompt is displayed. 

NOTE: Commands in Steps 2 through 14 are typed at a UNIX system prompt. 

2 Type xhost + then press the Return/Enter key on the keyboard. 

3 Open another UNIX window. 

4	 Start the log-in to the Data Processing Subsystem host by typing either telnet hostname 
(e.g., g0sps06), rlogin hostname, or rsh hostname in the new window then press the 
Return/Enter key. 

If you use the telnet command, a Login: prompt appears; continue with Step 5. 
If you use either the rlogin or rsh command, the system uses the User ID currently in 

use; go to Step 6. 

5	 If a Login: prompt appears, log in as yourself by typing your UserID then pressing the 
Return/Enter key. 

6 At the Password: prompt type your Password then press the Return/Enter key. 

7 Start the log-in to DCE by typing dce_login then pressing the Return/Enter key. 

8	 At the Enter Principal Name: prompt type your DCE UserID then press the 
Return/Enter key. 

9	 At the Enter Password: prompt type your DCE Password then press the Return/Enter 
key. 

10	 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
Use either the terminal/workstation IP address or the machine-name for the clientname. 

11 Type setenv MODE mode  then press the Return/Enter key. 
The mode will most likely be one of the following operating modes: 

OPS (for normal operation). 
TS1 (for SSI&T). 
TS2 (new version checkout). 
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Note that the separate subdirectories under /usr/ecs apply to (describe) different operating 
modes. 

12	 Type source /usr/ecs/mode/CUSTOM/utilities/EcCoEnvCsh then press Return/Enter. 
The source command sets the environment variables identified in the specified file. 

13 Type cd /path then press Return/Enter. 
Change directory to the directory (e.g., /usr/ecs/mode/CUSTOM/utilities) containing the 

data processing start scripts (e.g., EcDpPrStartQaMonitorGUI). 
14	 Type EcDpPrStartQaMonitorGUI mode ApplicationID &  then press Return/Enter 

to launch the QA Monitor GUI. 
The QA Monitor GUI (Figure 15-2) is displayed. 
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Figure 15-2. QA Monitor GUI - QRU Data Tab 

15.1.1 DAAC Product QA with the QA Monitor 

The Product QA process begins with the QA Monitor Application. The DAAC operations 
personnel will Query, Retrieve, and Update (QRU) the selected product. The operator will then 
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retrieve those specific products and perform a visual check of those products using the Visualize 
Data option of QA Monitor (Figure 15-3). 

Retrieval and Viewing of Data Granules 

1 Start up the QA Monitor 

2 Select QRU Data tab. 

3	 From list of data types, select the ESDT or compose a query in query window and click 
on the Query button. 

4	 Select a data granule by filename from the list and click on the Retrieve Data Granule 
button. 
Quit the QA Monitor GUI. 

5	 To visualize the data, select the data granule as described above and click on the 
Visualize Data button. 
Displays EOS View GUI (Figure 15-3) 

6	 Open a HDF product file from which metadata is to be viewed, select the File→ Open 
button from the main menu bar. 
A File Selection Dialog window will open and the user should be able to select the 

appropriate directory and file to open. 
Once the desired product file has been opened, the specific types of HDF objects in the 

file will be listed in the Contents window. 

7	 From the Contents window double-click on a particular HDF Object (Vgroup, SDS, 
etc.). 
The structure of the HDF object will appear in a dialog window with buttons on the 

bottom portion of the window to view the data of the object itself. 

8	 Display the science data values of this particular HDF object by selecting the Table 
button to display the table data of the object. 

9	 View the attribute values of this particular HDF object by selecting the File-Attribute 
button. 
Metadata is referred to as attribute data. 
Any metadata associated with the object will be displayed in another text window. 

10 Quit when done by typing Q then press the Enter key. 
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Visualize Data


Figure 15-3. QA Monitor - Visualize Data 

15.1.2 Updating QA Metadata 

After the viewing, the operator will update the Operational QA flag for that specific product. 
The operator also updates the Science QA flags in response to an email request from SCF 
personnel, who have the responsibility for performing QA of their own products. 
This procedure for updating QA metadata starts with the assumption that all applicable servers 
are currently running and the QA Monitor GUI QRU data tab (Figure 15-4) is being displayed. 

Table 15.1-4 summarizes the QA metadata attributes and their descriptions. 
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Table 15.1-4. QA Metadata Attributes 
Field Name Data Type Description 

OperationalQualityFlag 

ScienceQualityFlag 

character DAAC and SCF quality status setting of a data 
granule parameter, selected by the user. The valid 
values are: 
- passed 
- failed 
- being investigated 
- not investigated 
- inferred passed 
- inferred failed 

OperationalQualityFlagExplanation 

ScienceQualityFlagExplanation 

character Text describing quality status (less than 255 
characters), input by user. 

AutomaticQualityFlag character DAAC and SCF quality status setting of a data 
granule parameter, set during data processing. 

AutomaticQualityFlagExplanation character Text describing quality status of a data qranule 
parameter - set during data processing. 

Updating Quality Assurance (QA) Metadata using the QA Monitor 

1	 In the Data Types field, click on the data type to be checked. 
It may be necessary to scroll through the Data Types list. 
The selected data type is highlighted. 
Only one data type can be selected at a time. 
Alternatively, the Find field and button can be used for specifying a data type. 

 The Find field is case-sensitive. 
2	 Click in the appropriate Data Granule Insert window field(s) and either type or use the 

up/down arrow buttons to enter the Begin date and End date in MM/DD/YYYY format. 
In the Data Granule Insert window it is necessary to specify the range of dates (between 

the Begin date and the End date) to formulate a query for searching for the desired 
granule(s) to be checked. Time is based upon day of insert into the data server. If no 
dates are entered, an error message is displayed. The up and down arrows next to the 
duration fields may be used for modifying entries in each field. 

The Tab key may be used to move from field to field. 
3 Click on the Query button. 

Granules within the specified date range appear in the Data Granules field. 
4	 In the Data Granules field, click on the granule for which metadata is to be updated. 

It may be necessary to scroll through the list of granules. 
The selected granule is highlighted. 
Alternatively, the Find field and button may be used for specifying a data granule. 

 The Find field is case-sensitive. 
5	 Click on the Update Metadata button. 

The Update Metadata window is displayed. 
The Update Metadata window displays one line for each parameter for the selected 

granule. 
6	 Click on a parameter in the Update Metadata window. 

The selected parameter is highlighted. 
The Edit Parameter dialog box is displayed. 
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7	 Click and hold on the Operator Quality Flag option button, move the mouse cursor to 
the desired selection (highlighting it), then release the mouse button. 
The selected metadata flag is displayed on the Operator Quality Flag option button. 
The following options are available: 

 passed 
 failed 
 being investigated 
 not investigated 
 inferred passed 
 inferred failed 

8 Type an explanation for changing the QA flag value in the Explanation field. 
9 Click and hold on the SCF Quality Flag option button, move the mouse cursor to the 

desired selection (highlighting it), then release the mouse button.

The selected metadata flag is displayed on the SCF Quality Flag option button.

The same options are available as those on the Operator Quality Flag option button.


10 Type an explanation of the QA flag selection in the Explanation field. 
11 Click on the OK button to accept the QA flag settings. 

The Edit Parameter dialog box is dismissed. 
12	 To verify that the QA flag settings have actually been applied to the granule, first repeat 

Steps 1 through 5 to retrieve the same granule. 
The Granule Parameters window (Figure 15-4) is displayed. 
The QA flag values and explanations entered using the Edit Parameter dialog box are 

displayed. 
13 Repeat steps as necessary to review additional granules. 
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Figure 15-4. QA Monitor Granule Parameters Window 

15.1.3 Production History 

The Production History (PH) is created during PGE execution within the PDPS and then Inserted 
into the Data Server upon PGE completion. Included in the PH are the PGE log files. Accessing 
a Production History associated with a particular PGE run requires the DPR ID of the PGE run. 

The Production History is retrieved using the QA Monitor GUI, using the following procedure. 

Follow the procedures above for selecting a data granule. 

•	 Select the Retrieve ProdHistory button and view the contents of the 
Production History Log. 

15.2 QA Metadata Update Tool 

The purpose of the QA Metadata Update Tool (QAMUT) is to enable Science Computing 
Facility (SCF) and Distributed Active Archive Center (DAAC) QA experts to modify values of 
their respective quality flags (i.e., ScienceQualityFlag and OperationalQualityFlag) on core 
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metadata, provided via a client, for multiple granules at a time in a batch mode (vs. one granule 
at a time using the QA Monitor). 

The QA MUT and Logical ID/UR Report Generator Tool are being implemented as a DAAC 
Unique Extension to ECS per Engineering Support Directive #70. This work is not yet 
completed, but the reference version is available at the DAACs as explained below. 

The QAMUT tool itself consists of two major components: The SCF component (for updating 
ScienceQualityFlags) and the DAAC component (for updating Operational Quality Flags). The 
procedures for using QAMUT are fully documented in the following text. 

INSTRUCTIONS and GUIDE ON USING THE ECS DATABASE QA 
UPDATER 1.3 

(by Richard H. Buss Jr. on May 1999 at GSFC. Revised: October 1999) 
(GDAAC specific instructions are marked with "at GSFC" or "At GSFC") 

1. PURPOSE of the DATABASE QA UPDATER TOOL 

The Database QA Updater is designed to update the values of the Quality Assurance (QA) Flags 
in the ECS Inventory metadata within the Science Data Server. The QA Updater tool updates 
either Science or Operational metadata QA Flags, but not Automatic metadata QA Flags. The 
QA Updater sets QA values for a granule containing one or more Measured Parameters that have 
been examined by science or DAAC facility staff for Quality Assurance and that need to have 
their QA Flags values and associated QA Explanations updated. 

During one run, the tool can update multiple granules at a time by assigning them distinct QA 
values for each Measured Parameter. This is the main purpose and strength of the tool: updating 
batches of various granules at a time. The granules can contain different Measured Parameters, 
and the QA Update Tool will still update each of the QA Flags in each Measured Parameter for 
all the granules listed in the input. Similar updates for the same granule but with different 
Measured Parameters should be grouped contiguously on separate lines in the Request so that all 
the updates for a granule can be done at the same time. 

A uniformly formatted input request is expected to have arrived at the DAAC by email, 
containing an email header with the requester's return address, and containing a list of the 
granules to be updated, along with the new QA Flag values for the specified Measured 
Parameters. This list of Updates can then be passed to the Updater tool through UNIX standard 
input (file or terminal input). A useful but configurable Cshell script is also provided to 
automatically setup the UNIX environment and to run the Updater automatically to process 
multiple requests that reside in a single directory. 
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2. SCOPE 

The program reads a list of granule URs (Universal References; i.e. database Identifiers), and 
their Measured Parameters, along with the new QA Flag values and associated QA Explanations. 
The QA tool records the date of the Update at the end of the Explanations and then updates the 
QA values in the Inventory metadata database (not Archive Metadata), for each granule 
Measured Parameter. The program accomplishes this by overwriting previous QA Flag values 
and previous QA Explanations with the new QA Flags and new QA Explanations for each 
specified Measured Parameter. Thus, the QA Updater writes new QA metadata values but does 
NOT append QA values to existing metadata. Instead, blank inputs for QA Flag and Explanation 
values will cause the tool to set metadata QA values to "NULL" in the database, effectively 
erasing previous QA metadata. 

Also, if the input specifies "ALL" for the Measured Parameter of a single granule, the tool will 
update all the Measured Parameter QA Flags in that granule so that all the flags will have the 
same value and all the QA explanations will have another uniform value. IMPORTANT: The 
tool can not update granules that have no Measured Parameters. Also, if a Measured Parameter 
is incorrectly specified for one granule, the Updater tool will perform updates to all other 
granules in the request, but it will not update any of the QA Flags in any Measured Parameters 
for that erroneously specified granule. 

After performing the updates, the Database QA Updater will write to disk a file logging 1) the 
initial request, 2) the old QA values, and 3) the new updated QA values. This QA Update log file 
is intended to be saved as an record of the updates. In addition, the program will write runtime 
diagnostic messages that can be viewed on the terminal or redirected to a runtime log file (UNIX 
standard out). Finally, the program writes a temporary file specifying the status of the requests, 
notifies the requester by emailing this file back to the remote return address, and then the 
program deletes the notice from the local disk. This completes the QA Update process. The 
program must be invoked again in order for another request to be processed. However, if 
multiple requests reside in a single directory, the companion Cshell script, QAupdate.csh, will 
process all the requests together by invoking the QA Updater Tool multiple times. 

3. TO INSTALL the TOOL 

The core of the tool is a UNIX C++ binary executable that must run with its ascii configuration 
file. Forinteractivity, there is an optional Graphical User Interface program in TCL language that 
can invoke the C++ executable. These components of the Database QA Updater are distributed 
as a package tar file and a README file. 

a) Files 

First, if needed, unpack the tar file on the ECS Science Data Server Machine (SDSRV) in your 
local QAmanagement directory with UNIX command: 
tar -xvf packet_QA_UPDATER.tar . 
chmod u+x ClMuQaMetadataUpdate* 
more ClMuQaMetadataUpdate.CFG 
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The account containing this directory must be able to receive email or files that contain the QA 
Update Requests. Your directory should now have the following files: 

Filename....................................................................................... Purpose


README_QA_Updater The master usage guide to the QA Updater 
ClMuQaMetadataUpdate.CFG The text configuration file for use in ECS 
ClMuQaMetadataUpdate The binary executable that updates the QA 
ClMuQaMetadataUpdate.tcl A manual Graphical User Interface to the Updater 
ClMuQaMetadataUpdate.C The partial source C++ code of the main program 
QAupdate.csh Cshell script to setup and run Updater on multiple requests 
Input_example_QA_Updater A sample input file that the Updater can process 
Log_example_QA_Updater A sample output log file that the Updater writes 
Runtime_example_QA_Updater A sample runtime diagnostic to standard out 
Output_example_QA_Updater A sample email notice sent back to the requester 

The approximate sizes in kbytes of the Update Tool files are:

README_QA_Updater 28

ClMuQaMetadataUpdate.CFG 0.8

ClMuQaMetadataUpdate 3679

ClMuQaMetadataUpdate.tcl 10.6

ClMuQaMetadataUpdate.C 27

QAupdate.csh 1.1

Input_example_QA_Updater 1.6

Log_example_QA_Updater 9

Runtime_example_QA_Updater 0.6

Output_example_QA_Updater 1.7


It is recommended that all the ClMuQaMetadataUpdate* files, including examples be kept

together in one directory at all times. It is also recommended that the real input requests be

placed in a separate directory and that the output log files be placed in yet other separate

directories. This structure should help you manage separately the inputs, the tool, and the

outputs. Directories at GSFC:

\bin

\requests

\logs

\archiveQAupdates


b) Platform 

The Database QA Updater C++ source code was compiled with CC compiler 4.0 at Raytheon 
Landover, MD in the ECS build environment containing links to other source code libraries such 
as Roguewave. It therefore can not be compiled at your site. The version and other information is 
imbedded in the binary file. This info can be view by the unix command: 

what ClMuQaMetadataUpdate | more 
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The QA Updater Version 1.3 was compiled on a UNIX machine: 

SunOS starfire 5.5.1 Generic_103640-08 sun4m sparc SUNW,SPARCstation-20. 

The source code of the main program is given to help you understand the actions of the program. 
The program was successfully repeatedly tested on a SunOS g0acs03 5.5.1 Generic_103640-20 
sun4u sparc SUNW,Ultra-Enterprise at GSFC using input emails sent by UNIX mail, Netscape 
Messenger, Eudora, and Microsoft Outlook, all saved to disk with Netscape 4.0.7 
Communicator. 

****The average execution time is about 2 CPU seconds for each update.**** 

4. CONFIGURATION FILE 

At the moment, the Database QA Updater is NOT formally integrated into ECS, so many lines in 
the configuration file are not yet used by ECS nor the tool. 

There are, however, three required lines and one recommended one (Site) for you to specify 
correctly. At GSFC some entries from the ClMuQaMetadataUpdate.CFG file are: 

EcDsScienceDataServerG1 = G1

Site = GSFC

Name = ClMuQaMetadataUpdate

STATUSFILEPATH = /home/quality/archiveQAupdates/


These are the names of the DCE SDSRV Database Cell, the DAAC, the QA Updater program, 
and the path to where the QA Update log files will be saved (write permission required). In 
addition, the line 

DataFileName = /usr/ecs/TS2/CUSTOM/security/EcSeRandomDataFile 

can apparently be used in the future for security. The major and minor versions in the config file 
should be kept current so that they reflect the version of the binary tool itself: e.g. 1.3 . 

The directory of the executable QA update tool is the default directory that the tool uses in case 
the configuration file can not be found by the tool. However, a configuration file can be placed in 
and referenced to an arbitrary location (neither links nor cross-mounting recommended). At 
GSFC, the /tools/gdaac/$MODE/bin/DSS and /tools/gdaac/$MODE/cfg/DSS contain the QA 
Updater Tool and configuration file, respectively. 

5. TO RUN the TOOL 

SHORT METHOD: 

1) edit the QAupdate.csh script to refer to your local directories 
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2) place QA request files with valid URs into the requests directory 

3) setenv MODE <TS1/TS2/OPS> (one of the three! Default: OPS) 

4) execute QAupdate.csh on the UNIX command line within the Cshell 

The ESDTs for the granules must already have been loaded by system administration into the 
Science Data Server and the Science Data Server must already be running. If the tool becomes 
formally part of ECS, an initial dce_login will probably be required, too, before the tool can run. 
The QA Update Tool is known to interact with the ECS system by: 

A) updating the SDSRV database metadata, 

B) querying ESDTs installed in SDSRV, and 

C) fulfilling subscription events to metadata updates. 

Since the QA updates are restricted to the SDSRV, the tool is simple to run and will work in 
parallel with other ECS activities such as INGEST. 

All DAACs can run the Updater on their local file structure. (However, at GSFC, the DAAC 
Database QA Updater can be run on g0acs03 from the quality account (/home/quality/bin) with 
the Tool and configuration file in /tools/gdaac/$MODE/bin/DSS and 
/tools/gdaac/$MODE/cfg/DSS .) 

LONG METHOD: 
---First, set the MODE to one of the following three: 
setenv MODE <TS1/TS2/OPS> 

---Second, source the setup file 
source /usr/ecs/$MODE/CUSTOM/utilities/EcCoEnvCsh 

IMPORTANT!!!!!!!!If this file is missing, manually convert the EcCoEnvKsh file 
in that directory to EcCoEnvCsh and then source the converted file. 

This step creates links to needed libraries through the LD_LIBRARY_PATH path. Some DSS 
and CSS subsystem libraries are probably both used by the tool. (In an emergency at GSFC, 
source EcCoEnvCshcopy in /home/quality/bin.) 

---Third, invoke the Database QA Updater. The tool can be run two ways: by command or by 
GUI window. 
1) From the command line, an example execution (at GSFC, tool is in 
/tools/gdaac/<MODE>/bin/DSS): ClMuQaMetadataUpdate ConfigFile 
ClMuQaMetadataUpdate.CFG ecs_mode $MODE < QAupdate_emailrequest.txt 

where the format is:

executable ConfigFile (Configuration filename) ecs_mode (MODE) < (input filename) > (output

runtime log filename)


and where the "> output runtime log filename" is optional to save STDOUT. Note that absolute

and relative path names can be used for the filenames on the command line. Note also that the
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optional runtime log file is distinctly different from the mandatory QA update log filename 
specified in the configuration file; in the first case, program runtime information is saved or 
displayed; in the second case, the QA metadata values and Update Request are saved. 

2) An operator can also invoke and use a graphical tool ClMuQaMetadataUpdate.tcl to perform

QA updates with GUI buttons.

Example:

ClMuQaMetadataUpdate.tcl ClMuQaMetadataUpdate.CFG $MODE &


Limited online help for running the Updater is available in the GUI. STDOUT also is written in 
the GUI window but can only be saved manually to a file. 

6. INPUT FILE FORMAT (Specifications) 

Though the wrapper script QAupdate.csh can process multiple request files in one directory, the

Updater tool itself processes one QA update request file at a time. The input file is constructed

by the requester who has examined the granules for quality and has decided to update the QA

Flags in the granules. The requester should have previously obtained a granule identifier (UR,

Universal Reference) from ECS, for example, by the subscription notices that are emailed to the

requester when data is transferred by ECS to the requester. (Alternately, to facilitate

identification of data granules at GSFC, the UR is published together with the local granule ID in

a lookup file. Note that the UR is NOT contained inside the granule itself nor in its metadata!) In

any case, the Update Request must specify the granule by UR for the Updater tool to work.


The input QA Update request file must have four major items:


email header

begin line

request line(s)

end line


Sample Input File (Example):


Date: Wed, 25 Nov 1998 12:55:42 -0500

From: rbuss@gsfcsrvr4.gsfcmo.ecs.nasa.gov

Reply-To: Richard.Buss@gsfc.nasa.gov

Organization: EOS-DAAC GSFC

X-Mailer: Mozilla 4.07 [en] (X11; I; SunOS 5.5.1 sun4m)

MIME-Version: 1.0

To: quality@g0ins01u.ecs.nasa.gov

Subject: QA Update Request for ECS. This is a test of the DAAC Database QA Update Tool.


begin QAMetadataUpdate Science

UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[GSF:DSSDSRV]:19:SC:AST_09T.001:19

88 GuruTej Passed test


UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[GSF:DSSDSRV]:18:SC:AST_05.001:1990

GuruTej Passed test

end QAMetadataUpdate
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This concludes the Example input file. Details on each item follow: 

1) The email header MUST contain at least three lines in any order:

From:

Subject:

To:


The email header safely can contain many other fields such as Reply-To: or Received: or Date:,

but it must contain at minimum, these three fields.


A) The Database QA Updater will email the return notice back to the sender at the Reply-To:

address, if it exists before the end of the header, or alternatively, back to the From: address.


B) The Subject line is a valuable means of identifying the QA update Request, both for the

requester and for the DAAC. At GSFC the subject line should begin with

Subject: QA Update Request for ECS.


and then followed on the same line by any other information that the requester wants to use to

identify the request. The QA Updater will echo back this subject line in the return email notice

sent to the requester. This will help identify which Update request was actually completed. The

use of single quotes (') in the subject line is, however, strongly discouraged to avoid confusing

email programs.


C) The To: address that receives the requests at GSFC is quality@g0ins01u.ecs.nasa.gov .


2) a begin line with either Science or Operational specified for the kind of update:

begin QAMetadataUpdate Science

or

begin QAMetadataUpdate Operational


The request must be for a single type of update; it can not contain both kinds of update at once. 

3) one or more update entries, one entry to each line and four fields in each entry, each separated

by tabs, not blanks nor commas, nor double quotes. The fields on one line are

A) Database ID name/number (UR) B) Parameter name C) QA Flag Value D) QA Flag

Explanation.

FORMAT:

NAME:NUMBER<tab>PARAMATER<tab>QAFLAG<tab>Explanation

Example:

UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[GSF:DSSDSRV]:18:SC:AST_05.001:1990

GuruTej Not Investigated An Explanation


The Updater has been successfully tested on a request with 63 update UR lines. 

4) an end line with a return (new line) as the last character: 
end QAMetadataUpdate 

15-17 611-CD-510-001




Here are some IMPORTANT details to consider when the requester creates an input file: 

--When a cut and paste is used to send in a request, it often loses the crucial tab and line-wrap 
formattings. It is recommended that an editor be used to compose the Request, rather than 
pasting into an email messaging utility. The edited file can then be imported or read into the 
emailer rather than a dangerous cut and paste. 

---The six valid QA flag values for both Science and Operational in the 1999 ECS Data Model 
are: 
i) Not Investigated ii) Being Investigated iii) Passed iv) Failed v) Inferred Passed vi) Inferred

Failed. No double

quotes (") can be with the Flag or the request will fail.


---The Explanation field is free form, can be blank, and can contain special characters EXCEPT

double quotes (") or tabs. The length of the Explanation can be up to 235 characters. An update

date is always appended to the Explanation (for a maximum length of 255 characters) when the

database is updated.


---The same granule can be updated twice within the same request, but the entry lines for that

granule must

immediately follow each other (be contiguous). Otherwise, the program will crash (bus error)

when the granule is accessed for the second update attempt! This applies particularly to granules

with several Measured Parameters.


---For a given update type (either Science or Operational), the requester can specify ALL as the

parameter name in order for all Measured Parameters in the granule to be set with the same value

and with the same explanations (but values and explanations separate from each other.)


7. OUTPUTS 

Each time it runs, the QA Updater program creates several outputs: 

1) 	New QA Metadata in the Science Data Server Database Table 
(DsMdMeasuredParamater). 

2) An Update log file, named by current date and time, containing the 

A) address of the requester, the request subject, and a copy of the request 

B) QA Metadata values before and after the update 

C) runtime status messages and success/fail summary 

3) A return status notice that is emailed back to the requester. It contains: 

A) a short summary, if the QA Updater was successful 

B) a long description with error/warnings for most failures. 

4) An output stream to Standard Out (STDOUT), listing the progress of the program. 

(The QAupdate.csh wrapper script sends a few minor diagnostic messages to STDOUT (the 
screen). 
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8. CAPABILITIES OF the DATABASE QA UPDATER 

The tool: 

1) Updates Operational and Science QA metadata separately. 

2) Reads a single request file containing an email header and one or more granule ID 
updates. 

3) Successfully batch updates all specified QA metadata in those granules. 

4) Updates together both the QA Flag and the QA Explanation. 

5) Completely updates the QA metadata including those with null (blank) values. 

6) Writes the date of the Update at the end of the QA Explanation. 

7) Successfully processes one update request after another. 

8) Works if multiple simultaneous QA update processes are invoked. 

9) Accepts full path and current directory file names (known to work on 143 characters). 

10) Updates other granules if Measured Parameter is incorrectly specified for some granules. 

11) Successfully processes requests with blank lines or one line containing only tabs. 

12) If requested, updates other Measured Parameters if one is incorrect for the same granule. 

13) Will update the QA flag in all Measured Parameters in the granule if ALL option is 
specified. 

14) Processes QA explanations with special characters such as @ and ' and one extra <tab>. 

15) Sends return email to most REPLY-TO: addresses instead of FROM: address. 

16) Writes various success, warning and error status messages to Standard Out (STDOUT). 

17) Writes similar status messages to the Update log file and to the return notice. 

18) Deletes the return notice from disk after it has been emailed back to the requester. 

19) Can be used with a wrapper script QAupdate.csh to process multiple request files. 

9. LIMITATIONS OF the DATABASE QA UPDATER 

1) Issues warnings in the log file ("is invalid with respect to rule") that invalid metadata was 
requested, but still allows the values to be written into the database! 

2) Allows further QA updates of the same granule in the same message only if the update 
request lines for that granule are contiguous (sequential) in the request file. Otherwise, if 
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the same granule is requested to be updated again in the same request file, and the update 
lines are separated in the file, then the program crashes! 

3) Does not process QA Explanations nor Flags containing double quotes " 

(error written in log: "Could not update metadata in catalog") 

4) For safety reasons to the Database QA Metadata, requests that appear to be corrupted and 
do not follow the format, are not processed, other than to send error messages to the log 
file and back to the requester. NONE of the granules are updated for these format/content 
errors, which include: 

A) extra entries (total >4) on any line ("Too many fields on line" message is written to 
the log) 

B) a non-existent database ID name/number (UR) on any line, including a blank or 
misspelled UR 

C) missing begin line 

D) missing or incomplete email header 

5) The program exits abruptly, without warning messages, if the specified configuration file 
is misspelled or nonexistent. 

10. FUTURE 

A more complex Cshell wrapper script is under development at GSFC DAAC. The script sorts 
the URs to prevent crashing caused by repeating URs, provides a configurable security limit of, 
say, 10,000 allowed updates per message, and checks metadata valids before the Updater is run. 
The wrapper script also tests for the presence of the configuration file and will exit with warning 
messages if the file is not found. It also will manage the requests by filing them into failed, 
passed, and partially successful categories, so that appropriate actions can be taken by the DAAC 
and the requester. 
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12. APPENDIX: ERROR AND WARNING MESSAGES 

To access the status messages written by the program, read the Standard Out stream. This stream 
contains some status messages, as well as contains the name of the associated Updater log file 
(named with a date/time stamp). Print the log file to examine more status messages. The log file 
also contains the address of the requester and the subject of the request, which identify which log 
file corresponds to each processed request. 

1) Operating system statuses 

---Warning: Could not open message catalog "oodce.cat"


You can safely ignore this ECS warning message produced by the dce utility.


---ld.so.1: ClMuQaMetadataUpdate: fatal: libDsClSh.so: can't open file: errno=2

Killed


This is a failure to link with the required libraries.

Make sure you are on the SDSRV machine, at GSFC g0acs03.

Try sourcing the EcCoEnvCsh setup file and re-running the Updater.


---ld.so.1: ClMuQaMetadataUpdate: fatal: relocation error: symbol not found:

__0oPGlParameterBasectPCc: referenced in ClMuQaMetadataUpdate

Killed


This is a failure to link with the required libraries probably

because of a mismatch between the tool version and the ECS drop version.

A new drop version of ECS installed at your site might have caused this error.

The executable needs to be recompiled at Landover/Raytheon under a newly

created clearcase view for that drop version.


---Permission denied


Try adding execute (chmod +x) to the file permissions for ClMuQaMetadataUpdate.


2) Standard Out messages 

---SUCCESSFULLY updated all granules.

Errcount = 0


---ERRORS occurred during processing the request. QA Update program is quitting.

NO GRANULES WERE UPDATED FOR THIS REQUEST.


(Probably one or more UR granule IDs in the request are not in the database.)


---WARNING: Invalid metadata was entered in the Inventory.


(The requester misspelled the value of QA Flags. Process a revised request

containing valid QAFlag values; otherwise, bad metadata will remain in the database!!)
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-----------------------------------------------

-----------------------------------------------

---ERROR in updating QA: Email return address is missing from request. 
NO QA updates were performed for this request. 

(The email request was saved only partially to disk before the program ran.) 

---ERROR: Update Request had invalid metadata values such as quotes. 

(No double quotes are allowed in the QAFlag and QA Explanations in the request.) 

---WARNING: A measured parameter did not initially have any QA Flag. 

(Best to check that the database contains updated QA values. If, not, try 
processing the request again; it might work the second time.) 

3) Updater program status messages: 

=====================================================================

---Error creating DsClESDTReference for granule

Failure to create ESDT Reference, QA Update program is quitting.

NO GRANULES WERE UPDATED FOR THIS REQUEST.


The database ID (UR) is missing or wrong for AT LEAST one entry in the input request.

This happens when:

a) an ESDT specified in a request UR does not match the actual ESDT UR (database ID) for a 
particular granule. (E.g. the requested UR contains MOD01 when the actual granule is 
MOD07_L2 type.) 
b) a UR field is missing from any one line in the input request. 
c) one UR Database ID in the request is nonexistent in the SDSRV database. (E.g. 44790 when 
there are only 30000 granules in the database.) 
d) there are only blank lines between the begin and end lines in the request, 

In these cases, NO updates on ANY granules have been done; a revised request for updating the 
same granules, but all with proper URs, will have to be submitted by the requester. 

=====================================================================

---*****MeasuredParameter <param> not found in granule metadata

Errors during update process. Updates not done for this granule UR.

An ERROR occurred during the update process for <granule>

**** This QA Update was not done for granule: <granule>

Other granules will be updated.


A line in the input request file has a wrong or missing parameter name. The program does not

make any of the QA

update for this granule. The program makes all other updates for the other granules, though.

The program automatically by email notifies the requester of this error.
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-----------------------------------------------

-----------------------------------------------

-----------------------------------------------

-----------------------------------------------

-----------------------------------------------

=====================================================================

---UnnamedPL[(MeasuredParameter not found.) ErrorMsg(ESDT Execution failed)]

**** This QA Update was not done for granule: <granule>

Other granules will be updated.


The granule does not even have a Measured Parameter or QA Flag to be updated!

This granule should be deleted from the Update request because the metadata do not permit

updating or even setting the QA Flags.


=====================================================================

---ESDTResults[(Could not update metadata in catalog) ErrorMsg(ESDT Execution failed)]

ESDTStatus(0)

CmdSuccess(1)]]


The request line has double quotes in the explanation.


===================================================================== 
---Can't get status file path from config file. 

Make sure that the directory path to the logfile, as specified in the configuration file, is spelled 
correctly and has write permission. 

=====================================================================

---Unable to find a begin line or the email header is incomplete.

Input file does not have proper format: Subject, From, To, begin.

NO QA updates were performed for this request.


Check the email header to make sure all three required lines are present.

Check that the begin line has Science or Operational after the begin word.

The program should be run again on the corrected request.


=====================================================================

--Too many fields on line

End of input requests

Errors occurred during processing, quitting.


There are extra fields on one input line (5 or more filled out fields separated by tabs).

The program does NOT process any of QA updates on ANY of the granules.

Notify requester that the request did not have the proper format.


=====================================================================

---WARNING: end QAMetadataUpdate line not found.

Processing will continue, but lines may be missing.

End of input requests
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-----------------------------------------------

-----------------------------------------------

-----------------------------------------------

-----------------------------------------------

Check that the input request file was not split or the latter part deleted, because the input file 
does not have an end line (or is missing a <return> after the end line). If the request was 
erroneous, notify the requester. 

The program finishes and does all the updates listed in the processed request, but some of the 
updates in original request email might not have been processed because the request was 
inadvertently altered. 

=====================================================================

---ESDTResults[WARNING(Attribute

(INVENTORYMETADATA:MeasuredParameter:MeasuredParameterContainer:QAFlags:Scien

ceQualityFlag=Fail)


is invalid with respect to rule [Match(Passed,Failed,Being Investigated,Not Investigated,Inferred

Passed,Inferred Failed)])

UR(UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[GSF:DSSDSRV]:19:SC:AST_09T.00

1:1076)]

ESDTStatus(1) CmdSuccess(1)]]


The request updates QA flags with invalid new metadata values. The program processes all

entries, finishes, but writes this warning.

In the log, both ESDTStatus(1) CmdSuccess(1) mean success; either ESDTStatus(0) or

CmdSuccess(0) for a given request line means that the particular granule QA update failed.


=====================================================================

---ESDTResults[WARNING(Missing parameter

INVENTORYMETADATA:MeasuredParameter:MeasuredParameterContainer:QAFlags:Autom

aticQualityFlagExplanation

in group

INVENTORYMETADATA:MeasuredParameter:MeasuredParameterContainer:QAFlags.)


The metadata of this granule were initially incorrect before the QA Updater

was even run.

The MCF file or the ESDT in the Inventory SDSRV database is not properly

written to receive QA metadata updates. Before the QA update request can be

processed, the MCF file or ESDT for the data product will have to be modified

so that the PGE can write at least one QA metadata Flag

(e.g. AutomaticQualityFlag) in the metadata.


===================================================================== 
---ERROR on begin QAMetadataUpdate line: expecting \"Science\" or \"Operational\"" 

The type of request is misspelled or missing on the begin line of the request. 
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13. APPENDIX: BUILD LINE 

CC -I. -I./sun5.5 -I/tools/oodce/usr/include/oodce 
-I/tools/oodce/usr/include/ -I/usr/include/dce -I/usr/include 
-I/ecs/formal/CLS/include -I/ecs/formal/COMMON/include 
-I/ecs/formal/COMMON/include/sun5.5 -I/ecs/formal/CSS/include 
-I/ecs/formal/CSS/include/sun5.5 -I/ecs/formal/MSS/COTS/peer/src/include 
-I/ecs/formal/MSS/include -I/ecs/formal/MSS/include/sun5.5 
-I/ecs/formal/IOS/include -I/ecs/formal/IOS/include/sun5.5 
-I/ecs/formal/DSS/include -I/ecs/formal/DSS/include/sun5.5 -g 
-DSUNOS55X -ptrsun5.5/Templates/ClMuQaMetadataUpdate.o -mt 
-I/ecs/formal/IOS/include/ -I/ecs/formal/IOS/include/sun5.5 
-I/tools/rogue70_new -DRW_MULTI_THREAD -D_REENTRANT -DRWDEBUG=1 
-I/tools/rogue70_new -DRW_MULTI_THREAD -D_REENTRANT -DRWDEBUG=1 
-I/tools/sybOCv11.1.0//include -Dunix -DNIDL_PROTOTYPES -D_REENTRANT 
-D_CMA_PROTO_ -DSYSV -I/tools/oodce/usr/include/oodce -I/usr/include/dce 
-I/tools/oodce/usr/include/oodce -I/usr/include/dce -mt -c -o 
sun5.5/ClMuQaMetadataUpdate.o ClMuQaMetadataUpdate.C 
"/ecs/formal/CSS/include/EcPfClient.h", line 74: Warning: 
EcPfClient::PfProcessEvent hides the virtual function 
EcPfGenProcess::PfProcessEvent(EcAgEvent*, EcTAgLogType). 
"ClMuQaMetadataUpdate.C", line 542: Warning (Anachronism): Undefined 
character escape sequence "\-". 
"ClMuQaMetadataUpdate.C", line 542: Note: Type "CC -migration" for more on 
anachronisms. 
"ClMuQaMetadataUpdate.C", line 542: Warning (Anachronism): Undefined 
character escape sequence "\-". 
3 Warning(s) detected. 

/ecs/formal/COMMON/CSCI_Util/src/Build//cmAccess 
/ecs/formal/CLS/bin/sun5.5/ClMuQaMetadataUpdate 

/ecs/formal/COMMON/SysBuild/generate_EcsVersion_C 
ClMuQaMetadataUpdate 

CC -DSUNOS55X -c 
/ecs/formal/COMMON/SysBuild/Versions/ClMuQaMetadataUpdate_EcsVersion.C -o 
/ecs/formal/COMMON/SysBuild/Versions/ClMuQaMetadataUpdate_EcsVersion.o 

CC -ptrsun5.5/Templates/Pr_ClMuQaMetadataUpdate 
-ptrsun5.5/Templates/ClMuQaMetadataUpdate.o 
-ptrsun5.5/Templates/ClMuQaMetadataUpdate.o -R 
../../lib/COM:../../lib/CLS:../../lib/DMS:../../lib/CSS:../../lib/DPS:../../lib/DSS:../../lib/INS:../../lib/I 
OS:../../lib/MSS:../../lib/PLS:../../lib/V0_Client:../../../COTS/rogue/lib:../../../COTS/sybase/lib:../.. 
/../COTS/xaclient/lib:/ecs/formal/CLS/lib/sun5.5:/ecs/formal/COMMON/lib/sun5.5:/ecs/formal/ 
CSS/lib/sun5.5:/ecs/formal/MSS/lib/sun5.5:/ecs/formal/IOS/lib/sun5.5:/ecs/formal/DSS/lib/sun5. 
5:/view/DROP5A_sun5.5/ecs/formal/COMMON/lib/sun5.5:/view/DROP5A_sun5.5/ecs/formal/ 
CSS/lib/sun5.5:/view/DROP5A_sun5.5/ecs/formal/MSS/lib/sun5.5:/view/DROP5A_sun5.5/ecs/f 
ormal/IOS/lib/sun5.5:/view/DROP5A_sun5.5/ecs/formal/DSS/lib/sun5.5:/ecs/formal/IOS/lib/sun 
5.5:/view/DROP5A_sun5.5/ecs/formal/IOS/lib/sun5.5:/tools/rogue70_jun99/lib/:/tools/rogue70_j 
un99/lib:/tools/rogue70_jun99/lib:/tools/sybOCv11.1.0//lib:/tools/oodce_jun99/usr/lib 
-o /ecs/formal/CLS/bin/sun5.5/ClMuQaMetadataUpdate 
sun5.5/ClMuQaMetadataUpdate.o -L/ecs/formal/CLS/lib/sun5.5 
/ecs/formal/COMMON/SysBuild/Versions/ClMuQaMetadataUpdate_EcsVersion.o 
-L/ecs/formal/CLS/lib/sun5.5 -L/ecs/formal/COMMON/lib/sun5.5 
-L/ecs/formal/CSS/lib/sun5.5 -L/ecs/formal/MSS/lib/sun5.5 
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-L/ecs/formal/IOS/lib/sun5.5 -L/ecs/formal/DSS/lib/sun5.5

-L/view/DROP5A_sun5.5/ecs/formal/COMMON/lib/sun5.5

-L/view/DROP5A_sun5.5/ecs/formal/CSS/lib/sun5.5

-L/view/DROP5A_sun5.5/ecs/formal/MSS/lib/sun5.5

-L/view/DROP5A_sun5.5/ecs/formal/IOS/lib/sun5.5

-L/view/DROP5A_sun5.5/ecs/formal/DSS/lib/sun5.5 -lDsClSh -lDsCnSh

-lEcUtMiscSh -lDsShSh -lGlSh -L/ecs/formal/IOS/lib/sun5.5

-L/view/DROP5A_sun5.5/ecs/formal/IOS/lib/sun5.5 -lIoAdSearchSh -lIoAdSubsSh

-lIoAdCoreSh -lIoAdServerSh -lIoAdProxySh -lEcPoSh -lEcPoDbRWSh -lDsCnSh

-lEcUtMiscSh -L/tools/rogue70_jun99/lib/ -lrwdbg_mt

-L/tools/rogue70_jun99/lib -lrwtoolg_mt -lGlSh -lEcUtMiscSh -lEcDcNotifySh

-lEcDcMsgPsng1 -lCsEmMailRelASh -lC -lEcNsServiceLocSh -lEcFhSh

-lEcNsServiceLocatorSh -lEcUrSh -lEcPfSh -lEcCfSh -lEcAgInstrm

-lagenteventSh -leventSh -lCsFtFTPSchedObjSh -lCsFtFTPRelASh -lexpect -ltcl

-lEcTiTimeSh -lEcSeSybSecurityStubbedSh -lEcSeUtilityCtStubbedSh

-lEcSeServerKeyMgmtSh -lEcSeCmiSh -lEcDcMsgPsng1Sh -lEcDnDirSh -lEcUtSh

-lEcUtFactorySh -lEcPtSpecialLockSh -L/tools/rogue70_jun99/lib -lrwtoolg_mt

-Bstatic -L/tools/sybOCv11.1.0//lib /tools/sybOCv11.1.0//lib/libct_r.a

/tools/sybOCv11.1.0//lib/libcs_r.a /tools/sybOCv11.1.0//lib/libcomn_r.a

/tools/sybOCv11.1.0//lib/libintl_r.a /tools/sybOCv11.1.0//lib/libtcl_r.a

-Bdynamic /tools/sybOCv11.1.0//lib/libtli_r.so -L/tools/oodce_jun99/usr/lib

-loodce -lnsl -Bdynamic -ldce -lsocket -Bdynamic -lthread -lm -lresolv

/usr/lib/libintl.so -ldl -lm -mt


clearmake: Warning: Configuration record will not include objects accessed using view

"DROP5A_sun5.5"
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16. Ingest 

This section describes the procedures the Data Ingest Technician (DIT) can use when performing 
and monitoring ingest of science data. The data ingest process is largely automated, however, 
the DIT will be required to support hard media operations, resolve problems, periodically 
monitor ingest operations, and coordinate with the appropriate internal and external entities to 
resolve resource conflicts. Section 16.1 describes the Ingest subsystem custom software items. 
Section 16.2 describes how to use the ECS GUI Ingest tool. Section 16.3 describes how to use 
the HTML Interactive Ingest tool. Section 16.4 describes the Ingest Polling process. Section 
16.5 describes the process of recovering from Data Ingest Failures. Section 16.6 describes the 
Document Ingest process. Section 16.7 describes how to use the ECS Science Data Server 
Operator tool. 

16.1 Ingest Custom Software Items 

The Ingest custom software items supports the ingest of data into ECS repositories on a routine 
and ad hoc basis. The software supports a variety of data formats and structures. Ingest data 
processing and storage functions vary according to attributes of the ingested data such as data 
type, data format, and the level to which the ingested data has been processed. 

The Ingest subsystem is capable of accepting data from a variety of sources including both 
electronic network interfaces and physical media. Data received is predefined within ECS with 
regard to expected metadata and metadata characteristics, data types, files, and formats, and 
means of delivery to ECS in accordance with approved ICDs with external organizations. The 
following list defines the ECS Ingest Subsystem custom software items: 

1. 	 EcInAuto - is the Automated Network Ingest Interface process that provides basic 
capability to ingest data electronically from an external source. 

2.	 EcInPolling - is the Polling Ingest Client Interface process that creates polling request, 
detects new files in a specified external location, creates and submits ingest request. 

3.	 EcInInter - is the Interactive Ingest Interface process that provides science users and ECS 
operators the capability for interactive request to ingest data available on the network. 

4.	 EcInReqMgr - is the Ingest Request Manager process that manages ingest request traffic 
and processing. 

5. 	 EcInGran - is the Ingest Granule Server process that provides services for required 
preprocessing of data and subsequent insertion into the FSMS. 

6.	 EcInGUI - is Ingest GUI Interface process that provides operators ability to perform 
ingest from physical media, monitor the status of on-going ingest requests, and modify 
Ingest configuration parameters. 
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7 . 	 Ingest Database - is a Sybase database that stores and provides access to Ingest 
Subsystem internal data. 

16.2ECS Ingest Tool 

The ECS Ingest tool has five tab widgets; Ingest Intro, History Log, Monitor/Control, 
Operator Tools, and Media Ingest. The Ingest Intro screen can be used as a menu path to Save 
or Print screens, and Exit the Ingest tool. The History Log (Section 16.2.2 & Section 16.2.3) is 
a view only screen which allows the DIT the capability to view ingest activities that have already 
completed, and to create reports. The Monitor/Control (Section 16.2.4) screen provides the 
DIT the capability to view and update ongoing ingest activities in the system. The Operator 
Tools (Section 16.2.5) are used by the DIT to view and set ingest thresholds. The Media Ingest 
(Section 16.2.6) screen gives the DIT the capabilities to perform media ingest. 

The Activity Checklist table that follows provides an overview of the Ingest tool and its 
functions. Column one (Order) shows the order in which tasks should be accomplished. 
Column two (Role) list the Role/Manager/Operator responsible for performing the task. Column 
three (Task) provides a brief explanation of the task. Column four (Section) provides the 
Procedure (P) section number or Instruction (I) section number where details for performing the 
task can be found. 

Table 16.2-1. ECS Ingest Tool - Activity Checklist 
Order Role Task Section 

DIT Starting the Ingest GUI (P)16.2.1 

DIT Viewing the Ingest History Log (P)16.2.2 

DIT Ingest History Log Reports (P)16.2.3 

DIT Monitoring/Controlling Ingest Requests (P)16.2.4 

DIT Suspending Ingest Requests (P)16.2.5 

DIT Resuming Ingest Requests (P)16.2.6 

5 DIT Ingest Operator Tools (P)16.2.7 

6 DIT Physical Media Ingest (P)16.2.8 

16.2.1 Starting the Ingest GUI 

Starting the Ingest GUI in normal operations will be just a matter of clicking an icon that appears 
on your desktop. Because the desktop configurations have not been installed to date it will be 
necessary to follow the interim procedure described below. Starting the Ingest GUI assumes that 
the applicable servers are running and the DIT has logged in. If you are already familiar with the 
procedure, you may prefer to use the quick-step table at the end of the procedure. If you are new 
to the system, you should use the following detailed procedures: 

1 Type xhost + at the command shell prompt and then press Return. 
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2	 Bring up the Ingest GUI server. If the Ingest GUI has not already been brought up. From 
a SUN workstation or NCD X-Term terminal telnet into the Ingest Server. Enter telnet 
<hostname>. Example telnet g0dis01. 

3	 Log into the Ingest Operator workstation using your user identifier and password by 
typing YourUserID, and then press Return. 
• A password prompt is displayed. 

4 Enter YourPassword, then press Return. 
• You are authenticated as yourself. 

5	 Set your terminal display environment using the following command: 

setenv DISPLAY <hostname:0.0> 

6	 Create an xterm window for the Ingest GUI Ingest the following command: 

xterm -n GUI_<mode> -sl 5000-sb & 

7	 Change directory to the directory containing the Ingest GUI command file: 

cd /usr/ecs/<mode>/CUSTOM/utilities 

8	 Start the Ingest GUI using the following command: 

EcInGUIStart <mode> 

• The ECS Ingest tool is opened. 
• The Ingest Intro screen is displayed. 

Table 16.2-2. Starting Ingest Operator GUI - Quick-Steps 
Step What to Enter or Select Action to Take 

xhost + press Return 

telnet <hostname> press Return 

YourUserID press Return 

YourPassword press Return 

setenv DISPLAY <hostname:0.0> press Return 

xterm -n GUI_<mode> -sl 5000-sb & press Return 

cd /usr/ecs/<mode>/CUSTOM/utilities press Return 

EcInGUIStart <mode> press Return 

16.2.2 Viewing the Ingest History Log 

The DIT can determine if an Ingest request has been completed by viewing the entries in the 
ECS Ingest History Log. An Ingest request is not logged into the History Log until the Ingest 
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process has been completed. There are four different search criteria that can be used to view 
Ingest History Log entries, the Start and Stop Date/Time, the Data Provider ID, the Data 
Type, and Final Request Status. The DIT must manually enter the Start and Stop Date/Time 
criteria, which displays all Ingest entries that were logged between the start date and time, and 
the stop date and time. The Data Provider, Data Type, and Final Request Status each have a 
drop down option menu in which to select the criteria. After the DIT enters the search criteria, 
he/she clicks on the Display button to display the log of completed Ingest entries that match the 
search criteria. The History Log displays the following: 

Request ID Data Provider, Status, Ingest Type, Start Date, Start Time, End Date, End Time, 
Total Number of Granules, #Success Granules, Data Vol (MB), File Count, Time to Xfer (min.), 
Time Preproc (min.), Time to Archive (min.), and Priority Restart Flag. 

The DIT can display the same information on the granule level by clicking on the desired entry. 

The procedure that follows explains how to view Ingest Log entries using the History Log. This 
example will use the Start and Stop date/time filters to display a list of Ingest requests that were 
logged in the last twenty-four hour period. If you are already familiar with the procedure, you 
may prefer to use the quick-step table at the end of the procedure. If you are new to the system, 
you should use the following detailed procedures: 

1 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest Intro screen is displayed. 

2 Click the History Log tab widget. 
• The History Log screen is displayed. 

3 Click on the Start Date/Time field. 
• The cursor moves to the month field. 

4 Enter the month, then press Tab. 
• The cursor moves to the day field. 

5 Enter the day of the month, then press Tab. 
• The cursor moves to the year field. 

6 Enter the year, then press Tab. 
• The cursor moves to the hour field. 

7 Enter the hour, then press Tab. 
• The cursor moves to the min field. 
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8 Enter the minute, then press Tab. 
• The cursor moves to the sec field. 

9 Enter the seconds, then press Tab or, bypass the second’s field by pressing tab first. 
• The cursor moves to the month field for Stop Date/Time. 

10 Repeat steps 4 through 9 for the Stop Date/Time field. 

11 Select either Detailed Report or Summary Report. 
•	 Summary Report requires the operator to select either Request Level or Granule 

level. 

12 Click on the Display button. 
•	 Each ingest request that was completed and logged between the start and end time 

and date are displayed. 
•	 Each entry displays the Request ID, # of Success Granules, External Data 

Provider, Ingest Type, Processing Start and End Time, Data Volume, Number 
of Data Sets, and Number of Data Files. 

13 Click on an individual Entry. 
• The granule level of the selected entry is displayed. 

14 Select another function by clicking on a GUI tab. 

15 To exit the ECS Ingest tool, select menu path File/Exit. 

Table 16.2-3. View Ingest History Log - Quick-Steps (1 of 2) 
Step What to Enter or Select Action to take 

ECS Ingest icon single Click 

History Log press Return 

Month (Start Month field) single Click 

Enter the Month press Tab 

Enter the Day press Tab 

Enter the Year press Tab 

Enter the Hour press Tab 

Enter the Minute press Tab 

Enter the Seconds press Tab 

Enter the Month press Tab 

Enter the Day press Tab 

Enter the Year press Tab 
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Table 16.2-3. View Ingest History Log - Quick-Steps (2 of 2) 
Step What to Enter or Select Action to take 

13 Enter the Hour press Tab 

14 Enter the Minute press Tab 

15 Enter the Seconds press Tab 

16 Select Detailed Report or Summary Report single Click 

17 Display button single Click 

18 Individual Entry record single Click 

19 Select another function single Click or, 

20 File/Exit single Click and drag 

16.2.3 Ingest History Log Reports 

The History Log can support four report formats, a request history log report, a data type history 
report, a request summary statistics report, and a data type summary statistics report. The reports 
can be generated for specified time periods and executed on a regular basis. There are two radio 
buttons above the display box, Detailed Report and Summary Report. Each report supplies 
the DIT and operations staff with a view of the ingest request completion performance. The 
Detailed Report gives detailed information about each completed ingest request. The 
Summary Report gives a summary, which includes the average and maximum time taken to 
perform each step in the ingest process. 

The Detailed Report can be sorted by Start and Stop Date & Time, by Data Provider, and by 
Data Type.  The default for the Detailed Report is DAAC and Start Time. The Summary 
Report should be sorted by DAAC, Data Provider or Data Types. 

The following procedure will order a Detailed Report with the Data Provider as the sort 
criteria, then will clear the screen and order a Summary Report using the Data Type as the sort 
criteria. If you are already familiar with the procedure, you may prefer to use the quick-step 
table at the end of the procedure. If you are new to the system, you should use the following 
detailed procedures: 

1 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest intro screen is displayed. 

2 Click on the History Log tab widget. 
• The History Log screen is displayed. 

3 Click on the Data Provider field. 

• Cursor moves to the Data Provider field. 
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4	 Enter the Data Provider, then press Tab or, a drop down option menu may also be used 
as follows: 
a) Point the mouse on the arrow to the right of the Data Provider field. 
b) While holding down on the mouse, highlight the required Data Provider. 
c) Release the mouse button. 
d) The Data Provider that was chosen is now displayed in the Data Provider field. 

5 Click on the Detailed Report Radio box. 

6 Click on the Display button. 
• The Detailed Report is now displayed. 
•	 The Detailed Report displays the following information; Request ID, Data 

Provider, Start and End Time, Completion Status, Restart Flag, Processing 
Time (minutes),Transfer Time (minutes), Archive Time (minutes), Number of 
Files, Number of Granules, Number of Success Granules, Data volume (MB), 
and Ingest Type. 

7 Click on the Clear All button. 
• The display box and criteria fields are cleared. 

8 Click on the Data Type field. 
• The cursor moves to the Data Type field. 

9	 Enter the Data Type, then press Tab or, a drop down option menu may also be used as 
shown below: 
a) Point the mouse on the arrow to the right of the Data Type field. 
b) While holding down on the mouse, highlight the required Data Type. 
c) 	 Release the mouse button. The Data Type that was chosen is now displayed in the 

Data Type field. 

10 Click on the Summary Report radio box. 

11 Click on the Display button. 
• The Summary Report is displayed. 
•	 The Summary Report displays the following information; Data Provider, Data 

Type, Total Requests, Total Errors, Granules (Avg/Max), Files (Avg/Max), Size 
-MB (Avg/Max), Transfer Time- minutes (Avg/Max), Pre-Processing Time­
minutes (Avg/Max), and Archive Time-minutes (Avg/Max). 

12 Print the report by following menu path File / Print. 

13 Select another function by clicking on a widget tab. 

14 To exit the ECS Ingest tool, select menu path File / Exit. 
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Table 16.2-4. Ingest History Log Reports - Quick-Steps 
Step What to Enter or Select Action to Take 

ECS Ingest icon single Click 

History Log press Return 

Data Provider field single Click 

Enter the Data Provider press Tab 

Detailed Report Radio Box single Click 

Display button single Click 

Clear All button single Click 

Data Type field single Click 

Enter Data Type press Tab 

Summary Report Radio Box single Click 

Display button single Click 

File / Print single Click and drag 

Select another function single Click or, 

File/Exit single Click and drag 

16.2.4 Monitoring/Controlling Ingest Requests 

The DIT can monitor and control ingest activities using the Ingest Monitor/Control tool. The 
DIT can view all or selective ingest requests in the system. A search can be filtered by using a 
sort criteria of Request ID, Data Provider, or All Requests. After the search criteria has been 
selected, the DIT has the option of displaying a Graphical View or a Text View of the ingest 
requests. The Graphical View displays the Request Id, the Time processing began, and the 
Percent of the ingest process that has been completed. The Text View displays the Request Id, 
State of Request, External Data Provider, Ingest Type, Request Priority, Start Date & Time, 
Expiration Date, Total Granules, and Completion Time. 

The DIT has the capability of updating ongoing ingest activities in the system. The DIT can 
Suspend (inactive) Resume, Cancel, and change the Priority (inactive) of a request. To display a 
request on a granule level, the DIT will double click on the request. 

The following procedure will display all requests currently in the system, select and view a 
request on the granule level, then cancel the request. If you are already familiar with the 
procedures, you may prefer to use the quick-step tables at the end of this procedure. If you are 
new to the system, or have not performed this task recently, you should use the detailed 
procedures that follow. 

1 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is now open. 
• The Ingest Intro screen is displayed. 
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2 Click on the Monitor/Control tab widget. 
• The Monitor/Control screen is displayed. 

3 Click on the All Requests button, in the radio box. 

4 Click on the Text View button. 
• All ongoing ingest requests are displayed. 

5 Double Click on the desired request line. 
• Text is displayed at the granule level. 

7 Click on the Cancel button, from the toggle control box. 

8 Click on the OK push button. 
• A confirmation dialog box pops up. 

9 Click the Yes button in the confirmation dialog box. 
• Ingest request has been canceled. 

10 Select another function by clicking on a widget tab. 

11 To exit the ECS Ingest tool, select menu path File / Exit. 

Table 16.2-5. Monitoring/Controlling Ingest Requests - Quick-Steps 
Step What to Enter or Select Action to Take 

ECS Ingest icon single Click 

Monitor/Control tab widget single Click 

All Requests button single Click 

Text View button single Click 

Highlight individual account double Click 

Cancel button single Click 

OK push button single Click 

Yes OK button in confirmation box single Click 

Select another function single Click or 

File / Exit single Click and drag 

16.2.6 Resuming Ingest Requests 

After the matter that caused an ingest request to be suspended from processing has been taken 
care of, the processing can be resumed. If you are already familiar with the procedure to resume 
an ingest request, you may prefer to use the quick-step table at the end of the procedure. If you 
are new to the system, you should use the following detailed procedures. The procedure starts 
with the assumption that all applicable servers and the ECS Ingest GUI are currently running 
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and the ingest that was suspended by the system's automated process is being displayed on the 
Monitor/Control tab. 

♦ In the Ingest GUI Monitor/Control screen 

♦ Select the ingest request which has request state of “Suspended” 

♦ Select the Resume button on the Ingest GUI 

♦ Select the OK button on the Ingest GUI 

♦ Confirm the resumption by clicking “Yes” button on the pop-up window 

1. Verify that the request is archived on the Ingest GUI Monitor/Control screen. 

Table 16.2-6. Resuming Ingest Requests - Quick-Steps 
Step What to Enter or Select Action to Take 

1 Highlight the request to be resumed Single Click 

2 Resume button Single Click 

3 OK button Single Click 

4 Yes button in the confirmation box Single Ckick 

16.2.7 Cancel Ingest Request 

16.2.7.1 Cancel Ingest Request on the Request Level 

In some cases it will be necessary to cancel an Ingest Request. If you are already familiar with 
the procedure to cancel an ingest request, you may prefer to use the quick-step table at the end of 
the procedure. If you are new to the system, you should use the following detailed procedures. 
The procedure starts with the assumption that all applicable servers and the ECS Ingest GUI are 
currently running and the ingest request to be canceled is being displayed on the 
Monitor/Control tab. 

♦ In the Ingest GUI Monitor/Control screen 

♦ select the ingest request on the screen 

♦ Single click on the desired request to be cancelled 

♦ Select the Cancel button on the screen 

♦ Select the OK button the screen 

♦ Confirm the cancellation of the selected request by clicking “Yes” on the pop-up window 

♦	 Verify the cancellation of the selected request by viewing the Request state in the 
Monitor/Control display. 

16.2.7.2 Cancel Ingest Request on Granuel Level 

♦ In the Ingest GUI Monitor/Control screen 

♦ double click the request to display the granule information 

♦ Single click to select the desired granule to be cancelled 
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♦ Select the Cancel button on the screen 

♦ Select the OK button on the screen 

♦ Confirm the cancellation of the selected granule by clicking “Yes” on the pop-up window 

♦	 Verify the cancellation of the selected granule by viewing the granule state in the 
Monitor/Control display. 

Table 16.2-7. Running Cancel Ingest Requests - Quick-Steps 
Step What to Enter or Select Action to Take 

1 Highlight the request to be Cancelled Single Click 

2 Cancel button Single Click 

3 OK button Single Click 

4 Yes button in confirmation bax Single Click 

16.2.8 Cancel Suspended Ingest Request 

In some cases it will be necessary to cancel a suspended Ingest Request. If you are already 
familiar with the procedure to cancel a suspended ingest request, you may prefer to use the 
quick-step table at the end of the procedure. If you are new to the system, you should use the 
following detailed procedures. The procedure starts with the assumption that all applicable 
servers and the ECS Ingest GUI are currently showing (the Monitor/Control) the suspended 
ingest request to be canceled. 

16.2.8.1 Ingest Cancel Suspended Request 

♦ In the Ingest GUI Monitor/Control screen


♦ Select the ingest request which has request state of “Suspended”


♦ Select the Cancel button on the Ingest GUI


♦ Select the OK button on the Ingest GUI


♦ Confirm the cancellation by clicking “Yes” button on the pop-up window


16.2.8.2 Cancel Partially Suspended Ingest Request 

1. Using Ingest GUI select Monitor/Control function to monitor 

Request processing 

♦ Select Monitor/Control 

♦ Select Text View 

2. In the Ingest GUI Monitor/Control screen 

♦ Double click the request to display granule information 

The granule state on the Ingest GUI Monitor/Control screen changes from “Transferring” to 
“Suspended”. 
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The request state on the Ingest GUI Monitor/Control screen changes from “Active” to Partially 
“Suspended” 

3.	 In the Ingest GUI Monitor/Control screen 

♦ Select the ingest request which has request state of Partially “Suspended” 

♦ Select the cancel button on the Ingest GUI 

♦ Select the OK button on the Ingest GUI 

♦ Confirm the cancellation by clicking “Yes” button on the pop-up window 

Table 16.2-8. Running Cancel Suspended and Partially Suspended Ingest 
Requests - Quick-Steps 

Step What to Enter or Select Action to Take 

1 Highlight the request to be Cancelled Single Click 

2 Cancel button Single Click 

3 
4 

OK button 
Yes button in confirmation box 

Single Click 
Single Click 

16.2. 9 Ingest Operator Tools 

The Ingest Operator Tools give the Production Monitor (PM) and/or DIT the capability to set 
and view ingest thresholds. The ingest thresholds are broken up into two groups: System-wide 
and Data Provider specific. To edit the Data Provider click on the Modify External Data 
Provider/User Information tab stack just below the tab widgets (Section 16.2.7.1). To make 
System-Wide edits click on the Modify System Parameters tab stack (Section 16.2.7.2). 
When a DIT reviews the previous day’s Ingest activity, he/she may discover that there is a 
backlog of requests for ingest. After reviewing the report he/she may invoke the Ingest 
Operator Tool, then increase the System or Data Provider volume threshold to support a catch­
up mode. Another tool, File Transfer (Section 16.2.7.3), allows the DIT to transfer requested 
files to optional remote sites. 

The Activity Checklist table that follows provides an overview of the Ingest Operator tool. 
Column one (Order) shows the order in which tasks should be accomplished. Column two 
(Role) list the Role/Manager/Operator responsible for performing the task. Column three (Task) 
provides a brief explanation of the task. Column four (Section) provides the Procedure (P) 
section number or Instruction (I) section number where details for performing the task can be 
found. 

Table 16.2-9a. Ingest Operator Tools - Activity Checklist 
Order Role Task Section 

1 PM/DIT Modify External Data Provider/User 
Information 

(P) 16.2.7.1 

2 PM/DIT Modify System Parameters (P) 16.2.7.2 

3 DIT File Transfer (P) 16.2.7.3 
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16.2.9.1 Modify External Data Provider User Information 

The PM or DIT can edit the FTP User Name, FTP Password, Email Address, HTML Password, 
CDS Entry Name, Server Destination UUID, Volume Threshold, Request Threshold, Priority 
Level, and Notify Parameters when the Modify External Data Provider User Information tab 
stack is selected. 

The Volume Threshold is the maximum data volume allowed to be ingested concurrently by the 
data provider in one day. The Request Threshold is the maximum number of requests allowed 
to be processed by the data provider in one day. One day is a 24 hour period beginning when the 
first request is received. Each Data Provider is given a data Priority Level, which can effect 
when the ingest data is processed. When the Data Providers thresholds have been reached, the 
system will no longer process ingest requests for that specific Data Provider until the following 
day. If the DIT determine that this specific Data Provider’s data needs to be processed, he/she 
can change the thresholds to allow the system to accept the request. 

The procedure that follows explains how to edit the Data Provider’s Email Address, Volume 
Threshold, Request Threshold and Priority Level. If you are already familiar with the 
procedures, you may prefer to use the quick-step table at the end of this procedure. If you are 
new to the system, or have not performed this task recently, you should use the following 
detailed procedure. 

1 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest Info screen is displayed. 

2 Click on the Operator Tools tab widget. 
• The Operator Tool is opened. 

3 Click on the Modify External Data Provider/User Information tab. 
• The Data Provider screen is displayed. 

4 Click on the Data Provider field. 
• Cursor moves to the Data Provider field. 

5 Enter the Data Provider name, then press Tab or, a drop down option menu may also be 
used as follows: 
a) Point the mouse on the arrow to the right of the Data Provider field. 
b) While holding down the mouse, highlight the chosen Data Provider. 
c)	 Release the mouse button. The Data Provider that was chosen is now displayed in 

the Data Provider field. 

6 Click on the Email Address field. 
• Cursor moves to the Email Address field. 
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7 Enter the Email Address, then press Tab. 
• Cursor moves to the new Volume Threshold field. 

8 Enter the New Volume Threshold, then press Tab. 
• Cursor moves to the new Request Threshold field. 

9 Enter the New Request Threshold, then press Tab. 
• Cursor moves the new Priority Level field. 

10	 Enter the new Priority Level, then press Tab or, a drop down option menu may also be 
used as follows: 
a) Point the mouse on the arrow to the right of the New Priority Level field. 
b) While holding down the mouse, highlight the chosen Priority Level. 
c)	 Release the mouse button. The Priority Level that was chosen is now displayed in 

the Priority Level field. 

11 Click on the OK push button. 
• Invokes changes to the system. 

12 Select another function by clicking on a widget tab. 

13 To exit the ECS Ingest tool, select menu path File / Exit. 

Table 16.2-9b. Modify External Data Provider/ 
Interactive User Information - Quick-Steps 

Step What to Enter or Select Action to Take 

ECS Ingest icon Single Click 

Operator Tools Tab widget Single Click 

Modify External Data Provider User Information tab Single Click 

Data Provider field Single Click 

Enter the Data Provider Name Press Tab 

Email Address field Single Click 

Enter the Email Address Press Tab 

Enter the New Volume Threshold Press Tab 

Enter the New Request Threshold Press Tab 

Enter the New Priority Level Press Tab 

OK push button Single Click 

Select another function/widget Single Click 

File / Exit Single Click and drag 
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16.2.9.2 Modify System Parameters 

The Modify System Parameters tool allows the PM or DIT to edit the System Volume 
Threshold, to set the maximum number of ingest requests allowed to be processed concurrently, 
to set the number of transfer retry attempts and the retry intervals when network failure occurs, 
to set the monitor time for a completed request, and the frequency of screen update. 

In the following procedure the DIT will invoke the ECS Ingest tool then select the Operator 
Tools tab widget. From the Operator Tools display screen the DIT will click on the Modify 
System Parameters tab stack , then edit the Volume Threshold, Request Threshold, 
Communication Retry Count, Communication Retry Interval, Monitor Time, and Screen 
Update Time fields. If you are already familiar with the procedure, you may prefer to use the 
quick-step table at the end of the procedure. If you are new to the system, or have not performed 
this task recently you should use the following detailed procedure. 

1 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest Intro screen is displayed. 

2 Click on the Operator Tools tab widget. 
• The Operator Tool is opened. 

3 Click on the Modify System Parameters  tab. 
• The System Parameters screen is displayed. 

4 Click on the New Volume Threshold field. 
• The cursor moves to the New Volume Threshold field. 

5 Enter the New Volume Threshold, then press Tab. 
• The Maximum data volume to be ingested concurrently is changed. 
• The cursor moves to the New Request Threshold field. 

6 Enter the New Request Threshold, then press Tab. 
• The Maximum number of ingest requests to be processed concurrently is changed. 
• The cursor moves to the New Communication Retry Count field. 

7 Enter the New Communication Retry Count, then press Tab. 
•	 The number of retries to perform when a communication failure is encountered with 

the external data provider is changed. 
• The cursor moves to the New Communication Retry Interval field. 

8 Enter the New Communication Retry Interval, then press Tab. 
•	 The number of minutes to wait between retries when attempting to communicate 

with the External Data Provider. 
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• The cursor moves to the Monitor Time field. 

9 Enter the New Monitor Time, then press Tab. 
•	 The Monitor Time tells the system how often to monitor the network for ingest 

requests. 
• The cursor moves to the Screen Update Time field. 

10 Enter the New Screen Update Time, then press Tab. 
•	 The Screen Update Time tells the system how often to update the 

Monitor/Control screen, which shows the current ingest request activity. 

11 Click on the OK push button. 
• Implements the changes entered. 

12 Select another function by clicking on a widget tab. 

13 To exit the ECS Ingest tool, select menu path File / Exit. 

Table 16.2-9c. Modify System Parameters - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

ECS Ingest icon Single Click 

Operator Tools Tab widget Single Click 

Modify System Parameters  tab Single Click 

New Volume Threshold Single Click 

Enter the New Volume Threshold Press Tab 

Enter the New Request Threshold Press Tab 

Enter the New Communication Retry Count Press Tab 

Enter the New Communication Retry Interval Press Tab 

Enter the New Monitor Time Press Tab 

Enter the New Screen Update Time Press Tab 

OK push button Single Click 

Select another function/widget Single Click 

File / Exit Single Click and drag 

16.2.9.3 File Transfer 

The File Transfer tool allows the DIT to transfer System Management Center (SMC) History 
and Generic files to the Science Community. The tool allows the DIT to build a SMC History 
File or select any file to be transferred from a specified source of origin to a destination desired 
by the user. 

In the following procedure the DIT will invoke the ECS Ingest tool then select the Operator 
Tools tab widget. From the Operator Tools display screen the DIT will click on the File 
Transfer tab, then edit the Volume Threshold, Request Threshold, Communication Retry 
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Count, Communication Retry Interval, Monitor Time, and Screen Update Time fields. If 
you are already familiar with the procedure, you may prefer to use the quick-step table at the end 
of the procedure. If you are new to the system, or have not performed this task recently you 
should use the following detailed procedure. 

1	 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in Section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest Intro screen is displayed. 

2 Click on the Operator Tools tab widget. 
• The Operator Tool is opened. 

3 Click on the File Transfer tab. 
• The File Transfer screen is displayed. 

4 Click on Build SMC History File or the Generic File Transfer push button. 
• The Build SMC History File creates selected file for operator transfer. 
• The Generic File transfer allows any directory or file to be transferred. 

5 Click on the New Filter field. 
• The Cursor moves enters the field. 

6 Enter the New Filter, then press Tab. 
• The Cursor moves to Directories field. 

7 At Directories, select desired table entry, then press Tab. 
• The directory is entered into the Selection field. 
• The Cursor moves to Files field. 

8 At Files, select desired table entry, then press Tab. 
• The file is added to the path entered in the Selection field. 
• The Cursor moves to Selection field. 

9 Click on the OK push Button in the Transfer Origin Box. 

10 Enter the New Transfer Destination in the Transfer Destination field. 

11 Click on the OK push button for File Transfers window. 

12 Select another function by clicking on a widget tab. 

13 To exit the ECS Ingest tool, select menu path File / Exit. 
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Table 16.2-9d. File Transfer- Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 ECS Ingest icon single Click 

2 Operator Tools Tab widget single Click 

3 File Transfer toggle tab single Click 

4 Click SMC Build History File or Generic File Transfer single click 

6 Click the New Filter, enter filter press Tab 

7 Enter the New Directories press Tab 

8 Enter the New Files press Tab 

9 OK push button in Transfer Origin press Tab 

10 Enter the New Transfer Destination press Tab 

11 OK push button for window single Click 

12 Select another function/widget single Click 

13 File/Exit single Click and drag 

16.2.10 Physical Media Ingest 

When the Science Community sends a data ingest request, the DIT can ingest data from physical 
media into the DAAC using the Media Ingest tool. Table 16.2-10a identifies the different types 
of physical media used within the ECS system ingest process. Each cartridge is identified by 
means of a bar code label that shows the media number. 

Table 16.2-10a. Physical Media Ingest Types 
Media Type Media Name Media Purpose Capacity 

8mm 8 Millimeter cartridges Ingest 160m 7Gb 

D3 D3 Cartridge tape Ingest (EDC Only) 50 Gigabyte 

Activity Checklist Table 16.2-10b, provides an overview of Physical Media Ingest activities. 
Column one (Order) shows the order in which tasks should be accomplished. Column two 
(Role) list the Role/Manager/Operator responsible for performing the task. Column three (Task) 
provides a brief explanation of the task. Column four (Section) provides the Procedure (P) 
section number or Instruction (I) section number where details for performing the task can be 
found. Table 16.2-10b. Physical Media Ingest - Activity Checklist 
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Table 16.2-10b Activity CheckList 
Order Role Task Section 

1 DIT Performing Media Ingest from 8mm Media Tape (P) 16.2.8.2 

2 DIT Performing Media Ingest from D3 Tape (EDC only) (P) 16.2.8.3 

16.2.10.1 AccessingD3/8mm/Tape Drives and Stackers 

This section describes how to access the 8mm and D3 tapes and drives as used by Media Ingest. 
Both types of tapes can be used for physical media data requests for the Ingest system. The DIT 
can start the Ingest process by accessing the appropriate tape, utilizing the Ingest GUI Interface 
and the tape stacker units. Each 8mm stacker contains two tape drives and can store up to 10 
tapes. 

Note: While data is being read from tape the 
GUI will not allow another function to be 
selected until data transfer is complete 

16.2.10.2 Performing Media Ingest from 8mm Tape 

A Delivery Record file is required for Media Ingest. The Delivery Record file can either be 
embedded in the hard media or be made available electronically. If it is not embedded on the 
hard media, the Delivery Record must be in a specified network directory. The external data 
provider must ftp the Delivery Record file into the location prior to delivering the hard media. 
The Delivery Record identifies parameters such as data source, number of files, and location of 
data. The DIT will invoke the ECS Ingest tool, then click on the Media Ingest tab widget to 
display the screen. 

In the following procedure the DIT will invoke the ECS Ingest tool then select the Media Ingest 
tab widget. A drop down menu can be used to select the 8mm Media Type. Enter Stacker ID and 
Stacker Slot ID for 8mm tape ingest. Another drop down menu can be used to select the Data 
Provider. Enter Media Volume ID (Barcode) in the the Media Volume ID field. 

Note: Only one tape can be loaded and Ingested at a time. 

The Data Delivery Record File Location can be selected by clicking on the On Network, or 
Embedded in Media buttons located in the radio box. The file name supplied by the Data 
Provider is entered in the Data Delivery Record File Name field. If you are already familiar 
with the procedure, you may prefer to use the quick-step table at the end of the procedure. If you 
are new to the system, or have not performed this task recently you should use the following 
detailed procedure. 
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1	 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest Intro screen is displayed. 

2 Click on the Media Ingest tab widget. 
• The Media Ingest screen is displayed. 

3 Click on the Media Type field. 
• Cursor moves to the Media Type field. 

4 Choose the Media Type, then press Tab. 
• Cursor moves to the Stacker ID field. 

5 Enter the stacker ID in the Stacker ID field, then press Tab. 
• Cursor moves to the Stacker Slot ID field. 

6 Place the tape cartridge in a stacker slot. 

7 Enter the stacker slot ID in the Stacker Slot ID field, then press Tab. 
• Cursor moves to the Data Provider field. 

8 Enter the Data Provider, then press Tab. 
• A drop down option menu can also be used. 
• The cursor moves to the Media Volume ID (Barcode) field. 

9 Enter the Media Volume ID number from the tape. 
•	 The Media Volume ID number is displayed in the display box below the Media 

Volume ID field. 
8. Enter the Data Delivery Record File Name that is supplied by the Data Provider 

10 Click on the On Network button located in the Radio Box. 
• This tells the system that the Delivery Record is located on the Network. 
•	 If the Delivery Record is embedded in the tape, select the Embedded in Media 

button. 

11 Click on the OK button. 
•  Data transfer is initiated. 

12 Select another function by clicking on a widget tab. 

13 To exit the ECS Ingest tool, select menu path File / Exit. 
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Table 16.2-10c. Performing Media Ingest from 8mm Tape -
Quick Steps Procedures 

Step What to Enter or Select Action to Take 

ECS Ingest icon Single Click 

Media Ingest Tab widget Single Click 

Media Type field Single Click 

Enter the Media Type (8mm) Press Tab 

Enter the Stacker ID Press Tab 

Place the 8mm tape cartridge in a 8mm stacker slot 

Enter the Stacker Slot ID Press Tab 

Enter the Data Provider Press Tab 

Enter the Media Volume ID Press Tab 

On Network button Single Click 

OK push button Single Click 

Select another function/widget Single Click 

File / Exit Single Click and drag 

16.2.10.3 Performing Media Ingest from D3 Tape (EDC Only) 

This section describes how to access the StorageTek Controller/Transport Redwood SD-3 for D3 
tape processing as used by Media Ingest. The DIT can access the information stored on a D3 tape 
by utilizing the Ingest GUI Interface. 

Once the extraction command has been executed the system will read the D3 tape from the 
header label then access the data needed for Ingest processing. Upon completion of the process 
the D3 tape will automatically rewind and eject itself from the tape drive. 

If you are already familiar with the procedure, you may prefer to use the quick-step table at the 
end of the procedure. If you are new to the system, or have not performed this task recently you 
should use the following detailed procedure. 

1 Compare the received medium to a media ingest readiness checklist to verify that 
everything needed for the media ingest is in order. 
• The media ingest readiness checklist includes the following types of checks: 

•	 PDR file is available, either placed on the network by the data provider or 
embedded in the medium. 

• Data provider has identified the PDR file name. 
• There is a unique Media Volume ID for each tape received. 
• An appropriate device (tape drive) is available to support the data transfer. 

2 Verify that the display above the D3 tape unit indicates “*”. 

3 Verify that there is no tape cartridge inserted in the D3 tape unit. 
• Remove the tape cartridge in the D3 tape unit (if applicable). 
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4	 Verify that the Ready light is illuminated in the second row of the panel near the window 
of the D3 tape unit where the tape is inserted. 
• If the Ready light is not illuminated, push the Ready button. 

5	 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is opened. 
• The Ingest Intro screen is displayed. 

6 Click on the Media Ingest tab widget. 
• The Media Ingest screen is displayed. 

7 Click on the Media Type field. 
• Cursor moves to the Media Type field. 

8 Enter the Media Type, then press Tab. 
•	 To enter the type of medium (i.e., D3 Tape) click and hold on the option button to 

the right of the Media Type field, move the mouse cursor to the desired selection 
(highlighting it), then release the mouse button. 

• The selected type of medium is displayed in the Media Type field. 
• Cursor moves to the Data Provider field. 

9 Enter the Data Provider, then press Tab. 
• A drop down option menu can also be used. 
•	 To enter the data provider (e.g., SCF) click and hold on the option button to the 

right of the Data Provider field, move the mouse cursor to the desired selection 
(highlighting it), then release the mouse button. 

• The selected data provider is displayed in the Data Provider field. 
• The cursor moves to the Media Volume ID field. 

10	 Enter the Media Volume ID number from the tape in the Media Volume Id (Barcode) 
field. 

11 Click on the On Network button located in the Radio Box. 
• This tells the system that the Delivery Record is located on the Network. 
•	 If the Delivery Record is embedded in the tape, select the Embedded in Media 

button. 

12	 Enter the data delivery record file name (e.g., scf11a.PDR) in the Data Delivery Record 
File Name field. 

13 Click (once only) on the OK button at the bottom of the GUI. 
•	 The GUI OK button is sensitive to being clicked more than once. It is important to 

click it dead center once only or D3 ingest is likely to fail. 
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14 Insert the tape cartridge in the D3 tape drive. 
•	 The tape cartridge must be inserted within one minute of clicking on the OK button 

on the Ingest GUI. 
• The message "Loading" should be displayed on the D3 tape drive unit panel. 
•	 Then the message "Ready" should be displayed on the D3 tape drive unit panel and 

the "ready" light should blink on and off for a while. 
•	 Avoi d clicki ng t he mouse on t he Ingest GUI whi l e t he D3 tape uni t is reading the 

tape. 
•	 Once the extraction command has been executed, the system reads the D3 tape from 

the header label, then accesses the data needed for Ingest processing. 

15	 When the data transfer has been completed, wait for the message "Ingest Request 
Completed.” 
•	 The messages "Rewi nding" then “Unl oadi ng” shoul d be displ ayed on the D3 tape 

dri ve uni t panel as the D3 tape dri ve uni t rewi nds and unl oads aft er the dat a 
transfer. 

•	 Upon completion of the process the D3 tape automatically rewinds and ejects 
itself from the tape drive. 

16 Remove the tape cartridge from the D3 tape drive. 

17 Select another function by clicking on a widget tab. 

18 To exit the ECS Ingest tool, select menu path File / Exit. 

Table 16.2-10d. Performing Media Ingest from D3 Tape -
Quick Steps Procedures 

Step What to Enter or Select Action to Take 

ECS Ingest icon Single Click 

Media Ingest Tab widget Single click 

Media Type field Single Click 

Enter the Media Type (D3) Press Tab 

Enter the Data Provider Press Tab 

Enter the Media Volume ID Press Tab 

On Network button Single Click 

Enter Data Delivery Record File Name 

OK push button Single Click 

Select another function/widget Single Click 

File / Exit Single Click and drag 
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16.2.10.4 Ingest EDOS D3 (GDAAC) 

1. After D3 tape(s) are received from EDOS, they must be manual placed into the ingest 
polling directory. Use the following steps to complete the operational task. 

2.	  On g0drg01 log-on using the amass account and password. Once logged on vary drive 8 
off-line, using the following command: drivestat –i 8 

Note drive 8 is used as an example any drive could be used. 

3. Insert the D3 EDOS tape into the archive using the following steps: 

Log-on the g0drs04 system using the ACSLS account & password. 

Enter the D3 media into the StorageTek archive. Using the ACSLS window type: 
enter 0,0,0 

Prior to this write down the volume label for reference. Note the D3 media must be 
inserted in the Upper most left corner of the input/output bin. Close the input/output door 
after the D3 media has been placed in to the bin. The media is now loaded into the 
Archive. 

1.	 Move the media into Drive 8 using the following commands (note user is still on the g0drs04 
box): 

mount volume label 0,0,1,3 

2.	 Read the tape contents using the following command (user now back on g0drg01 box): This 
process could take several iterations to read the complete tape. 

tar –tvf /dev/rmt/tps94d4nr 

3.	 Once the read completes. Extract the data from tape to a holding location large enough to 
store all the data on the tape. This will be some place on the L0_buffer (g0drg01). Again 
this could take several iterations. But it will be the same number of trys as in step 5. To 
Extract the data type: 

tar –xvf /dev/rmt/tps94d4nr /L0_buffer/predetermined location 

4.	 When the extract completes. The ingest data must be identified. Once the files to be 
ingested have been identified they must be transferred to g0icg01 polling directory location: 
/usr/ecs/<MODE>/icl/a/data/pollEDOS.. Recommended transfer method: dd if=data 
location/filename of=/usr/ecs/<MODE>/icl/a/data/pollEDOS/filename bs=4096 

5.	  Once all the files that make up a granule have been transferred to g0icg01  2 files must be 
created using the following utility: 
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/tools/share/bin/genPDRS5A <data type name> <first PDS file on the granule> < 
usr/ecs/<MODE>/icl/a/data/pollEDOS> 

6.	 Have the ingest technician verify the transfer completes successfully. Repeat steps 7 & 8 
until all granules have been ingested. 

16.2.10.5 Ingest - ASTER On Demand Processing 

ASTER On Demand Processing generally refers to the generation of products that are not 
included as part of the standard ASTER L1A and L1B products that are sent from ASTER GDS 
to ECS. These On Demand Products include, but may not be limited to: ASTER Digital 
Elevation Map (DEM), Higher Level ASTER Products, and other non-standard ASTER products 
that may be ordered from the user community. There are three items associated with On 
Demand Processing; (a) The production of Digital Elevation Maps; (b) Handling requests 
associated with non-standard L1B and (c) Handling requests associated Higher level(s) products 
L1B products. 

(a) ON DEMAND PROCESSING - DIGITAL ELEVATION MAPS (DEM) 

This type of On Demand Processing requires that the DAAC Operator produce the DEM 
manually at the DAAC. Using the On-Demand Form (ODFRM), the user submits the request to 
ECS. Upon receiving the request (the ODFRM and e-mail) to produce the DEM, the DAAC 
Operator takes the following action: 

1.)	 From the granule information present on the ODFRM and in the e-mail, the DAAC 
Operator creates the DEM. 

2.) Using the Ingest Sub-system, the DAAC Operator Ingests the DEM Product 

3.) Using the Science Data Server, the DAAC Operator Archives the DEM product 

4.) The DAAC Operator notifies ECS that the product is available. 

(b) ON DEMAND PROCESSING - NON- STANDARD L1B 

In this type of On Demand Processing, using the On-Demand Form (ODFRM) web page (CLS), 
the user selects a non-standard product and submits the request directly to ASTER GDS, Japan. 
The processing of non-standard L1B is conducted at ASTER GDS, Japan. Upon notification that 
the product is available, the DAAC Operator will Ingest and archive the product in the Science 
Data Server in accordance with section 16.2.8 of this document. Using the email process, the 
DAAC Operator will notify the user that the product is available. 

(c) ON DEMAND PROCESSING OF HIGHER LEVEL(S) L1B PRODUCTS 

is accomplished at ASTER GDS, Japan The product processing is accomplished Unlike the 
standard L1A and L1B products 
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16.3.1 Creating a Data Availability Notice (DAN) (descoped) 

Before a Data Provider can ingest data into the ECS system a Data Availability Notice (DAN) 
must be sent to the Subsystem indicating that data is ready for transfer. The DAN specifies the 
parameters needed to identify what files are ready for pickup, the location, and how long it will 
be available in that location. The maximum message length allowed for a DAN is 1 megabyte. 
More than one DAN may be sent if needed. 

Each DAN includes a Message Header, Exchange Data Unit (EDU) Label and Parameter Value 
Language (PVL) Statements. The Message Header and labels are in a contiguous string, 
followed by the PVL. The labels and PVL statements are in Standard Formatted Data Unit 
(SFDU) format. More information about SFDU and PVL can be found in the following 
documents: Consultative Committee for Space Data Systems (CCSDS), Standard Formatted 
Data Units--Structure and Construction Rules, Consultative Committee for Space Data Systems 
(CCSDS) and Parameter Value Language Specification (CCSD0006, blue book). 

The system will log the receipt of the DAN and assign a request ID number. A summary of the 
DAN contents is placed in the event log. The Ingest subsystem generates a corresponding ingest 
request and stores the request on a prioritized list. A Data Availability Acknowledgment 
(DAA) is sent from Ingest to the Data Provider indicating readiness to ingest the data identified 
in the DAN. 

The procedure that follows explains the information needed to create a DAN.  This procedure 
will assume the Data Provider has already used an xterm or SUN to obtain the DAN template. If 
you are familiar with the procedure, you may prefer to use the quick-step table at the end of this 
procedure. If you are new to the system, or have not performed this task recently, you should 
use the detailed procedure that follows. 

1 The DAN Sequence Number is system generated, therefore press Tab. 
• The cursor moves to the Expiration Time field. 

2 Enter the Expiration Time, then press Return. 
• Time for data deletion from originating system. 
• The cursor moves to the Originating System field. 

3 Enter the Originating System, then press Return. 
• The originator of the DAN. 
• The cursor moves to the Aggregate Length field. 

4 Enter the Aggregate Length, then press Return. 
• Total number of bytes to transfer (Sum for all files). 
• The cursor moves to the Total File Count field. 

5 Enter the Total File Count, then press Return. 
• Total number of files to transfer. 
• The Cursor moves to the Object field. 
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6 Enter the Object, then press Return. 
• The start of file group parameters (repeat for each group of files). 
• The cursor moves to the Data Type field. 

7 Enter the Data Type, then press Return. 
• ECS Data Type. 
• Cursor moves to Node Name field. 

8 Enter the Node Name, then press Return. 
• Name of the network node on which the file resides. 
• The cursor moves to the Descriptor field. 

9 Enter the Descriptor, then press Return. 
• The string. 
• The cursor moves to the Object field. 

10 Enter the Object, then press Return. 
• Start of Detached SFDU Header File Object, if appropriate. 
• The cursor moves to the File ID field. 

11 Enter the File ID, then press Return. 
• The File Name. 
• The cursor moves to the File Type field. 

12 Enter the File Type, then press Return. 
• The File Data Type. 
• The cursor moves to the Directory ID field. 

13 Enter the Directory ID, then press Return. 
• The file directory name (i.e., path name). 
• The cursor moves to the File Size field. 

14 Enter the File Size, then press Return. 
• The length of the file in bytes. 
• The cursor moves to the End Object field. 

15 Enter the End Object, then press Return. 
• The End Detached SFDU Header File Object. 

Table 16.3-2. Creating Data Availability Notice (DAN) - Quick-Step 
Procedures (1 of 2) 

Step What to Enter or Select Action to Take 

1 DAN Sequence Number (system generated) press Tab 

2 Enter the Expiration Time press Return 
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Table 16.3-2. Creating Data Availability Notice (DAN) - Quick-Step 
Procedures (2 of 2) 

Step What to Enter or Select Action to Take 

3 Enter the Originating System press Return 

4 Enter the Aggregate Length press Return 

5 Enter the Total File Count press Return 

6 Enter the Object press Return 

7 Enter the Data Type press Return 

8 Enter the Node Type press Return 

9 Enter the Descriptor press Return 

10 Enter the Object press Return 

11 Enter the File ID press Return 

12 Enter the File Type press Return 

13 Enter the Directory ID press Return 

14 Enter the File Size press Return 

15 Enter the End Object press Return 

16.3.2 Submitting an Ingest Request (descoped) 

The Science Data Provider can access the network ingest subsystem through Netscape. The 
following procedure describes the automated network ingest of data to ECS from data providers 
which will be accomplished without direct operator action. This procedure assumes that the 
DAN has already been created, which describes the location of the available data. The 
Interactive Ingest Main Form displays three options to the data provider; Create DAN File, 
Submit Ingest Request, and Monitor On-Going Request Status. 

The following procedure will open the Interactive Ingest tool, then submit an ingest request. The 
Data Provider selects the files to be ingested from a list displayed on the Submit Ingest Request 
screen. If you are already familiar with the procedures, you may prefer to use the quick-step 
table at the end of this procedure. If you are new to the system, or have not performed this task 
recently, you should use the following detailed procedure. 

1 Click on the Netscape Navigator icon. 

2 Enter the URL of the Ingest Home Page, then press Return. 
• The Data Provider login page is displayed. 

3 Enter the Data Provider name in the ECS Data Provider field, then press Return. 
• The cursor movers to the Data Provider Password field. 

4	 Enter the Data Provider Password, in the ECS Data Provider Password field, then 
press Return. 

5 Click on the Submit Ingest Request radio button. 
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6 Click on the Submit push button. 
• The Submit Ingest Request screen is displayed. 
• A list of data files are displayed. 

7 Click on the Data File to be ingested. 
• The data file number appears to the right of Select Requests (s) 
• More than one file can be selected at one time. 

8 Click on the Submit push button. 
• The Ingest Request has been submitted. 

9 Exit the Interactive Ingest system by following menu path File → Quit. 

Table 16.3-3. Submitting an Ingest Request - Quick-Step Procedure 
Step What to Enter or Select Action to Take 

Netscape Navigator icon single Click 

Enter the URL of the Ingest Home Page press Return 

Enter Data Provider press Return 

Enter Data Provider Password press Return 

Submit Ingest Request radio button single Click 

Submit push button single Click 

Data File single Click 

Submit push button single Click 

File → Quit single Click and drag 

16.3.3 Monitoring On-Going Request Status (descoped) 

The on-going status of submitted data requests can be viewed by invoking the Interactive Ingest 
Main Form, then entering the Data Providers name and selecting the Monitor On-Going 
Request Status radio button. The Ingest Request On-Going Status screen displays all the 
active requests for the Data Provider. The Ingest Request On-Going Status screen displays 
each data request, its Request ID number and the acceptance or rejection of the data request. To 
display more details on a specific data request click on the individual data request, which opens 
the On-Going Status Monitor screen. From the On-Going Status Monitor screen click on the 
data request to display the Granule Level status. 

The following procedure will open the Interactive Ingest Tool, then view the status of a data 
request at the granule level. If you are already familiar with the procedure, you may prefer to use 
the quick-step table at the end of this procedure. If you are new to the system, or have not 
performed this task recently, you should use the following detailed procedure. If the Interactive 
Ingest Main Form has already been opened, skip steps 1 through 7, otherwise begin with step 1. 

1 Click on the Netscape Navigator icon. 
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2 Enter the URL of the Ingest Home Page, then press Return 

3 Enter the user Password, then press Return. 

4 Enter the Data Provider name, then press Return. 

5 Click on the Monitor On-Going Request Status radio button. 

6 Click on the Submit push button. 
• The Ingest Request On-Going Status screen is displayed. 
• The following information is displayed for all active requests; 

a. Data request file number 
b. Acceptance or rejection of each request. 
c. System Request Id number. 

7 Click on a Individual Ingest Request. 
• The On-Going Status Monitor screen is opened, which displays: 
• The Request ID. 
• State of request . 
• % Complete 
• Priority 
• Start Time 
• End Time 

8 Click on the Request ID. 
• The Granule Level Status Monitor screen for the selected Request ID is opened, 

displaying the following information: 
− The Request ID number. 
− The Status. 
− The Percent Complete. 
− The Data Provider. 
− The Ingest Type. 
− The Priority. 
− The Process Start Time. 
− The Expiration Time. 
− The Granule Count. 
− The Data Volume. 
− The Data Type. 
− The Granule Volume. 
− The Granule State. 

9 Exit the Interactive Ingest system by following menu path File → Quit. 
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Table 16.3-4. Monitoring On-Going Request Status -
Quick-Step Procedures 

Step What to Enter or Select Action to Take 

Netscape Navigator icon single Click 

Enter the URL of the Ingest Home Page press Return 

Enter Password press Return 

Enter the Data Provider press Return 

Monitor On-Going Request Status radio button single Click 

Submit push button single Click 

Individual ingest Request single Click 

Request ID single Click 

File → Quit single Click and drag 

16.4 Ingest Polling Process 

The ECS Ingest Subsystem supports a transfer mechanism to acquire data from a supplier 
system (Data Provider). This process is called Polling. There are two Polling processes 
supported, Polling Ingest with Product Delivery Record (Section 16.4.1), and Polling Ingest 
without Product Delivery Record (Section 16.4.2). Ingest Information Notifications that are 
received from, and sent to the Data Provider, or any pre-defined e-mail address, during this 
process will be addressed in Section 16.4.3. Ingest Archive Verification is discussed in Section 
16.4.4. 

The Activity Checklist table that follows provides an overview of the Ingest polling Subsystem 
process. Column one (Order) shows the order in which tasks should be accomplished. Column 
two (Role) list the Role/Manager/Operator responsible for performing the task. Column three 
(Task) provides a brief explanation of the task. Column four (Section) provides the Procedure 
(P) section number or Instruction (I) section number where details for performing the task can be 
found. 

Table 16.4-1. Ingest Polling - Activity Checklist 
Order Role Task Section 

1 DIT Polling Ingest With Product Delivery Record (PDR) (I) 16.4.1 

2 DIT Polling Ingest Without (PDR) (I) 16.4.2 

3 DIT Ingest Information Notifications (P)16.4.3 

4 DIT Ingest Archive Verification (P)16.4.4 

5 DIT Deleting Files from the Ingest Polling Directory (P)16.4.5 

16.4.1 Polling Ingest With Product Delivery Record 

ECS periodically checks on an agreed-upon network location for a Product Delivery Record 
(PDR) file. The PDR file contains information identical to that in a DAN, see (Section 16.3.1). 
The Data Provider may have previously transferred the data to a working storage device within 
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ECS, otherwise an ftp “get” will be used to obtain the data from the Data Provider within a 
specified time window. The Data Provider and the ECS Ingest Subsystem are each equipped 
with a computer program that invokes an FTP daemon, which automatically polls the server 
supplying the data. 

A periodic polling process detects and then acquires a PDR. The Ingest subsystem then 
validates the information contained in the PDR. If the system fails to validate the PDR or if 
validation of the PDR failed, a Product Delivery Record Discrepancy (PDRD) is sent to the Data 
Provider via ftp or email. . If the Ingest Subsystem is able to read the PDR, a request ID is 
assigned and the PDR, and its contents are placed in the Event Log. A DAA is sent to the Data 
Provider indicating readiness to ingest the data identified in the PDR. Ingest generates a 
corresponding ingest request and stores the request on a prioritized list. The Ingest function 
ensures that all required devices are allocated and schedules and performs the data transfer. 
After ECS has attempted to ingest and archive data, a Product Acceptance Notice (PAN) is 
automatically sent via email or ftp to the data provider. The Pan file announces the completion 
of data transfer and archive. The PAN file also identifies any error or problems that may have 
been encountered during the ingest process. 

The DIT may monitor the status of any ingest request by using the Monitor/Control screen of 
the ECS Ingest Tool (Section 16.2.4). The Ingest process is automated, however there are 
several sequences in which errors can be encountered which will cause the process to stop, 
requiring Operator intervention (see Section 16.4.4). The Event log will be updated during each 
phase of the Ingest process, therefore the DIT can easily access the status of any request. If 
intervention is required, the Computer Operator and/or DIT can Suspend, Cancel or Resume the 
Ingest process by using the Operator Tools of the ECS Ingest subsystem (Section 16.2.5). 

16.4.2 Polling Ingest Without Product Delivery Record 

This mechanism is planned to be used for the transfer of certain ancillary products required for 
data processing. The ingest subsystem periodically polls an agreed-upon network location for 
the presence of data (no PDR is needed in polling W/O PDR). All data at the specified location 
are assumed to make up a collection of ingest data with one file per data granule. Note: Only the 
actual data will be placed in the specified location for polling W/O PDR. The ingest function 
automatically performs an ftp get from the Data Provider within a system tunable time interval . 
The data goes through the usual ingest verification process of format conversion and metadata 
extraction and validation, with status messages going to the event log. When the ingest process 
has been completed, a message is sent to the History Log (Section 16.2.3), the polling interval is 
reset, and the system enters a wait state. 

16.4.3 Ingest Information Notifications 

16.4.3.1 Polling With Delivery Record 

During the Ingest process several Information Notices are sent to the Data Provider, the Ingest 
subsystem, and the event log. The first notice is from the Data Provider, informing the ingest 
subsystem that data is ready for transfer. This notice is called a Data Availability Notice 
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(DAN) or Product Delivery Record (PDR).  PDR h contains the information, such as data 
source, number of files, and location of data. 

16.4.3.2 Auto Ingest Interface 

In some cases an Auto Ingest is accomplished., for example LPS to Land Sat 7 GW. When the 
subsystem receives the D A N  or PDR it sends a message back to the Data Provider to 
acknowledge the receipt of the DAN or PDR. The return message is called a Data Availability 
Acknowledgment (DAA).  The Ingest system automatically logs all of the messages into the 
event log, therefore the DIT can obtain the current status of an ingest request at any time. If an 
error occurs during the ingest process another DAA is sent to the Data Provider and to the event 
log explaining the problem. When the ingest process has been completed, the system generates a 
DATA Delivery Notice (DDN), which is sent to the Data Provider. The Data Provider then 
returns a Data Delivery Acknowledgment (DDA) in response to the DDN and terminates the 
session. Ingest provides a status message to the Ingest History Log when the transaction is 
complete. 

The following section describes the steps needed to view the information contained in the notices 
for a specific Data Provider. The DIT can view the contents of any notice through the ECS 
Ingest tool. If you are familiar with the procedure, you may prefer to use the quick-step table at 
the end of this procedure. If you are new to the system, or have not performed this task recently, 
you should use the detailed procedure that follows. 

1 Click on the ECS Ingest icon. This assumes that the Ingest GUI is running, if the GUI is 
not up, then follow the steps for bringing up the Ingest GUI outlined in section 16.2.1. 
• The ECS Ingest tool is now open. 
• The Ingest Introduction screen is displayed. 

2 Click on the Monitor/Control tab widget. 
• The Monitor/Control screen is displayed. 

3 Click on the Data Provider button, in the radio box. 
• The cursor moves to the periodic box to the right of the Data Provider. 

4 Enter the Data Provider, then press Return. 

5 Click on the Text view button. 

6 Click on the OK push button. 
•	 All ongoing ingest requests for the Data Provider are displayed, including the 

Informational Notices. 

7 Highlight an individual request, then double Click. 
• Text is displayed at a granule level. 
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8	 Exit the ECS Ingest tool by following menu path File → Exit. 

Table 16.4-2. Ingest Information Notification - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

ECS Ingest icon single Click 

Monitor/Control tab widget single Click 

Data Provider radio button single Click 

Enter the Data Provider press Return 

Text view button single Click 

OK push button single Click 

Highlight individual request double Click 

Follow menu path File → Exit 

16.4.4 Ingest Archive Verification 

In an effort to verify that the data ingested has been archived successfully, the following steps 
are used to verify whether data is present on the archive. This procedures makes it unnecessary 
to get into any archive software. This procedure is pretty straight forward and safe so don’t 
worry about doing anything strange and wonderful to the system. Good luck. The aster, ceres, 
data, l7, and modis directories correspond directly to tape volumes in the system. The data is 
listed in the Amass data base and is actually on tape. 

1 Log on to any workstation. 

2 Type in your login and password. 

3 Enter telnet <hostname>. Example telnet g0drg01. 

4	 Set your terminal display environment using the command: 
setenv DISPLAY <hostname:0.0> 

5 Type in your login and password. 

6	 Change directory to the directory containing the location of the archive data: 

cd /dss_stk1 

7 Enter ls to list the contents of the directory. 

• Should see OPS, TS1, TS2, and test mode directories 
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8	 Change directory to the directory containing the mode used: 

cd [ OPS, TS1, TS2, test] 

9 Enter ls to list the contents of the directory. 

• Should see aster, ceres, data, 17, and modis directories 

10	 Change directory to the directory containing the location of the type of data ingested: 

cd [ aster, ceres, data, 17, and modis] 

11 Enter ls to list the contents of the directory. 

• Should see data listed on tape in the archive. 

Table 16.4-3. Ingest Archive Verification - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

Telnet <hostname> press Return 

UserId press Return 

Password press Return 

setenv DISPLAY <hostname:0.0> press Return 

cd /dss_stk1 press Return 

cd [ OPS, TS1, TS2, test] press Return 

cd [ aster, ceres, data, 17, and modis] press Return 

ls press Return 

16.4.5 Deleting Files from the Ingest Polling Directory 

The Ingest Polling Directory performs cleaned-up operations after a successful archive. At the 
present time this process is being done manually. The EcInPollClean script was delivered in 
Drop4PX to manually clean the EDOS polling directory, which is where the problem was first 
identified. The EcInPollClean script will clean all files in the specified directory (to include all 
files in subdirectories, if any) that are older than 48 hours. The script requires two inputs, the 
name of the path containing the files to be deleted, and the number of hours. If you are already 
familiar with the procedure, you may prefer to use the quick-step table at the end of the 
procedure. If you are new to the system, you should use the following detailed procedures: 

1 Log in to any workstation using your user identifier and password by typing 
YourUserID, and then press Return. 
• A password prompt is displayed. 
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2 Enter YourPassword, then press Return. 
• You are authenticated as yourself. 

3 Enter telnet <hostname>. Example telnet g0drg01. 

4 Enter YourUserID, and then press Return. 
• A password prompt is displayed. 

5 Enter YourPassword, then press Return. 
• You are authenticated as yourself. 

6	 Set your terminal display environment using the following command: 
setenv DISPLAY <hostname:0.0> 

7 Change directory to the directory containing the Ingest EcInPollClean script file: 

cd /usr/ecs/<mode>/CUSTOM/utilities 

8 Enter ls to list the contents of the directory: 

9	 Execute the EcInPollClean script using the following command: 
EcInPollClean <path name> <number of day> 

Table 16.4-4. Deleting Files From the Ingest Polling Directory -
Quick-Steps 

Step What to Enter or Select Action to Take 

YourUserID press Return 

YourPassword press Return 

telnet <hostname> press Return 

YourUserID press Return 

YourPassword press Return 

setenv DISPLAY <hostname:0.0> press Return 

cd /usr/ecs/<mode>/CUSTOM/utilities press Return 

Ls press Return 

EcInPollClean <path name> <number of day> press Return 

16.5Recovery from a Data Ingest Failure 

When an ingest fault (error) occurs, there may be a requirement for action to recover from the 
error. Recovery actions may be made necessary by invalid DAN contents or other errors that 
result in data ingest failure. When a fault (error) occurs, the following actions occur: 

• The processing of the ingest request stops. 
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•	 A message is sent to the Ingest/Distribution Technician and the data provider with a 
brief description of the problem. 

The Ingest/Distribution Technician may use the Ingest GUI Monitor/Control screen, the Ingest 
History Log (refer to the section on Ingest Status Monitoring) and/or the following log files (in 
the /usr/ecs/mode/CUSTOM/logs directory on the ingest host machine) to review the failure 
event: 

• EcInReqMgr.ALOG (ingest request manager log). 
• EcInAuto.ALOG (automated ingest log). 
• EcInPolling.ALOG (polling ingest log). 
• EcInGran.ALOG (granule server log). 
• EcInGUI.ALOG (Ingest GUI log). 

In addition, it is possible to check the ECS Event Log (for events related to ingest failure) using 
the ECS Event Log Browser tab on the Management Data Access (MDA) GUI. 

This section contains some examples of faults that are likely to occur, describes the notifications 
provided, and proposes operator actions in response to each fault situation. The specific 
recovery actions may vary due to operator preference or local DAAC policy. 

The Activity Checklist table that follows provides an overview of the Recovery from a Data 
Ingest failure process. Column one (Order) shows the order in which tasks should be 
accomplished. Column two (Role) list the Role/Manager/Operator responsible for performing 
the task. Column three (Task) provides a brief explanation of the task. Column four (Section) 
provides the Procedure (P) section number or Instruction (I) section number where details for 
performing the task can be found. 

Table 16.5-1. Recovery from a Data Ingest Failure - Activity Checklist 
Order Role Task Section 

1 DIT Troubleshooting a Data Ingest Failure (P)16.5.1 

2 DIT Recovering from a Faulty DAN (P)16.5.2 

3 DIT Recovering from Exceeding the Volume Threshold (P)16.5.3 

4 DIT Recovering from Exceeding the Maximum Number of 
Concurrent Requests 

(P)16.5.4 

5 DIT Recovering from Insufficient Disk Space (I) 16.5.5 

6 DIT Recovering from Exceeding the Expiration Date/Time 
Period 

(P)16.5.6 

7 DIT Recovering from File Transfer (ftp) Error (P)16.5.7 

8 DIT Recovering from Processing Errors (P)16.5.8 

16.5.1 Troubleshooting a Data Ingest Failure 

When troubleshooting a data ingest failure, use the procedure that follows. The procedure starts 
with the assumption that all applicable servers and the Ingest GUI are currently running and the 
Monitor/Control (All Requests) screen is being displayed. 
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Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as necessary to 
identify the faulty ingest request. 
•	 When there is a data ingest failure, the system provides the following three responses: 

− Logs the error. 
− Alerts the Ingest/Distribution Technician. 
− Returns a DDN to the data provider indicating the nature of the failure. 

Review the information concerning the faulty ingest request. 
If additional information is needed, open and read the appropriate log file in the 

/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 
• EcInReqMgr.ALOG (ingest request manager log). 
• EcInAuto.ALOG (automated ingest log). 
• EcInPolling.ALOG (polling ingest log). 
• EcInGran.ALOG (granule server log). 
• EcInGUI.ALOG (Ingest GUI log). 

Perform the appropriate recovery procedure depending on the nature of the problem: 
• Recovering from a Faulty DAN. 
• Recovering from Exceeding the Volume Threshold. 
• Recovering from Exceeding the Maximum Number of Concurrent Requests. 
• Recovering from Insufficient Disk Space. 
• Recovering from Exceeding the Expiration Date/Time Period. 
• Recovering from File Transfer (ftp) Error. 
• Recovering from Processing Errors. 

16.5.2 Recovering from a Faulty DAN 

If the DAN/PDR is invalid, the data provider must submit a new DAN. The DIT should respond 
to the error by contacting the data provider to give an alert that the ingest failure has occurred, 
provide as much information as possible about why the failure occurred, and determine whether 
the data ingest request will be re-initiated. When working to recover from an invalid DAN/PDR, 
use the procedure that follows. The procedure starts with the following assumption that the 
Ingest GUI Monitor/Control (All Requests) screen is being displayed. 

1	 Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as 
necessary to identify the faulty ingest request. 

2 Review the information concerning the faulty ingest request. 

3	 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 

4 Contact (by telephone or e-mail) the data provider to discuss the following issues: 
• Report the ingest failure. 
• Discuss what has been discovered from reviewing the failure event data. 
•	 Determine whether the data provider will re-initiate the data ingest request with a new 

DAN. 
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5	 If the data ingest request is to be re-initiated, monitor the subsequent ingest as described 
in the procedure for Monitoring Ingest Requests. 

16.5.3 Recovering from Exceeding the Volume Threshold 

Data Ingest may fail for reasons other than invalid DAN/PDR contents. For example, if the 
specified system volume threshold has been exceeded, the system sends a DDN to the Data 
Provider indicating that the system is full and an attempt should be retried again later. If a data 
provider’s volume threshold has been exceeded, use the procedure that follows. The procedure 
starts with the following assumption that the Ingest GUI Monitor/Control (All Requests) screen 
is being displayed. 

1	 Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as 
necessary to identify the faulty ingest request. 

2 Review the information concerning the faulty ingest request. 

3	 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 

4	 If it is decided to increase the system volume threshold, first click on the Operator Tools 
tab. 
• The Operator Tools screen is displayed. 

5 Click on the Modify System Parameters tab. 
• The Modify System Parameters screen is displayed. 

6	 Click in the New: field corresponding to Volume Threshold, then type the numerical 
value for the new volume threshold. 
•	 The current value of the volume threshold is printed on the corresponding line for 

reference purposes. 

7	 Click on the OK button at the bottom of the Operator Tools: Modify System 
Parameters tab to save the changes to system parameters. 
• The changes are invoked. 

8 Click on the Monitor/Control tab. 
• The Monitor/Control screen is displayed. 

9 Click on the All Requests button. 
•	 Alternatively, either a particular Data Provider or Request ID may be specified as 

described in the procedure for Monitoring Ingest Requests. 

10 Click on the Text View button. 
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11	 If the data ingest request is to be re-initiated, monitor the subsequent ingest as described 
in the procedure for Monitoring Ingest Requests. 

16.5.4 Recovering from Exceeding the Maximum Number of Concurrent Requests 

If the specified system request threshold has been exceeded, the system sends a DDN to the Data 
Provider indicating that the system is full and an attempt should be retried again later. If a data 
provider’s request threshold has been exceeded, use the procedure that follows to increase the 
system request threshold. The procedure starts with the following assumptions that the Ingest 
GUI Monitor/Control (All Requests) screen is being displayed. 

1	 Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as 
necessary to identify the faulty ingest request. 

2 Review the information concerning the faulty ingest request. 

3 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 

4 
5 If it is decided to increase the system request threshold, first click on the Operator Tools 

tab. 
• The Operator Tools screen is displayed. 

5 Click on the Modify System Parameters tab. 
• The Modify System Parameters screen is displayed. 

6	 Click in the New: field corresponding to Request Threshold, then type the numerical 
value for the new volume threshold. 
•	 The current value of the request threshold is printed on the corresponding line for 

reference purposes. 

7	 Click on the OK button at the bottom of the Operator Tools: Modify System 
Parameters tab to save the changes to system parameters. 
• The changes are invoked. 

8 Click on the Monitor/Control tab. 
• The Monitor/Control screen is displayed. 

9 Click on the All Requests button. 
•	 Alternatively, either a particular Data Provider or Request ID may be specified as 

described in the procedure for Monitoring Ingest Requests. 

10 Click on the Text View button. 

11	 If the data ingest request is to be re-initiated, monitor the subsequent ingest as described 
in the procedure for Monitoring Ingest Requests. 
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16.5.5 Recovering from Insufficient Disk Space 

After the receipt of the DAN, a disk space allocation is requested from the Data Server, and a 
time-out timer for the disk allocation is set. In the event that the Data Server has insufficient 
disk space, the time-out timer will expire. The Ingest Subsystem notifies the operator that the 
ingest request is waiting for Data Server disk allocation. At present the Ingest/Distribution 
Technician has no real option for responding to the problem except perhaps to discuss the 
situation with the system administrator. 

16.5.6 Recovering from Exceeding the Expiration Date/Time Period 

If data are unavailable but the time period during which that data were to have been made 
available has expired, the error is logged in the event log, and a DDN is sent to the Data Provider 
indicating expiration date/time exceeded. The Ingest/Distribution Technician receives an alert 
on his/her screen, then contacts the data provider to resolve the problem. If a data provider’s 
expiration date/time period has been exceeded, use the procedure that follows. The procedure 
starts with the assumption that the Ingest GUI Monitor/Control (All Requests) screen is being 
displayed. 

1	 Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as 
necessary to identify the faulty ingest request. 

Review the information concerning the faulty ingest request. 

2	 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 

3 Contact (by telephone or e-mail) the data provider to discuss the following issues: 
• Report the ingest failure. 
• Discuss what has been discovered from reviewing the failure event data. 
• Determine whether the data provider will re-initiate the data ingest request. 

If the data ingest request is to be re-initiated, monitor the subsequent ingest as described 
in the procedure for Monitoring Ingest Requests. 

16.5.7 Recovering from File Transfer (ftp) Error 

After numerous unsuccessful data transfer retries, an error is logged into the event log, the 
Ingest/Distribution Technician is notified and a DDN is sent to the Data Provider indicating ftp 
failure. The Ingest/Distribution Technician reviews all current ingest requests using the 
Operator Tool of the ECS Ingest GUI to determine whether other communication-related 
failures have occurred and may consult with the data provider(s) to resolve the problem. If it is 
necessary to recover from a file transfer error, use the procedure that follows. The procedure 
starts with the assumption that the Ingest GUI Monitor/Control (All Requests) screen is being 
displayed. 

1	 Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as 
necessary to identify the faulty ingest request. 
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2 Review the information concerning the faulty ingest request. 

3	 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 

4 Click on the Ingest GUI Operator Tools tab. 
• The Operator Tools screen is displayed. 

5 Click on the Modify System Parameters tab. 
• The Modify System Parameters screen is displayed. 

6 Review the current value for Communication Retry Count. 

7	 If it is decided to increase the communication retry count, follow the procedure for 
Modifying System Parameters. 

8	 If the data ingest request is to be re-initiated, monitor the subsequent ingest as described 
in the procedure for Monitoring Ingest Requests. 

16.5.8 Recovering from Processing Errors 

Ingest processing errors may require Ingest/Distribution Technician intervention. The following 
problems are examples of processing errors. 

• Missing Required Metadata. 
• Unknown Data Type. 
• Template Out of Synchronization (Sync). 
• Unavailable File Type. 
• Metadata Validation Error. 
• Missing Optional Data Files. 

If it is necessary to recover from a processing error, use the procedure that follows. The 
procedure starts with the assumption that the Ingest GUI Monitor/Control (All Requests) 
screen is being displayed. 

1	 Upon receipt of the operator alert, use the Monitor/Control screen scroll bars as 
necessary to identify the faulty ingest request. 

2 Review the information concerning the faulty ingest request. 

3	 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/mode/CUSTOM/logs directory on the ingest host machine. 

4	 If the processing error involves missing required metadata or an unknown data type, 
contact (by telephone or e-mail) the data provider to request the data provider to make the 
necessary corrections and re-initiate ingest. 
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5	 If the processing error involves an out-of-sync template or an unavailable file type, 
submit a trouble ticket in accordance with the trouble ticketing procedures. 

6	 If the processing error involves a metadata validation error or missing optional data files 
and if the processing template instructions indicate to continue inserting the data, contact 
(by telephone or e-mail) the data provider to provide notification that the data have been 
flagged as bad. 
• If the processing template instructions indicate to continue inserting the data, the 

following events occur: 
− The error is logged in the event log, 
− The data are flagged as bad. 
− A preprocessing failure alert for each data granule appears on the 

Ingest/Distribution Technician’s screen. 
− A Metadata Problem Report is generated. 

7	 If the processing error involves a metadata validation error or missing optional data files 
and if the processing template instructions require the rejection of the data, contact (by 
telephone or e-mail) the data provider to request the data provider to make the necessary 
corrections and re-initiate ingest. 
•	 If the template instructions require the rejection of the data, the normal notices and 

alerts are sent, including a DDN to the external data provider indicating the 
preprocessing failure. 

8	 If the data ingest request is to be re-initiated, monitor the subsequent ingest as described 
in the procedure for Monitoring Ingest Requests. 

16.6Document Ingest 

The Ingest subsystem will not include any capabilities for document ingest in B.0. All ingest 
will be done manually by operators via ftp pull. Operators are notified of the need to pull a 
document by phone or e-mail. 

The ingest format will remain as originally planned, i.e., it will follow the established document 
ingest formats. That is, the document submitter must prepare a set of document files in one of 
the approved ECS formats, an accompanying valid metadata file, and a valid DAN. 

The document data server (DDSRV) host will include a directory to keep B.0 ingest requests. 
The directory name is TBS. By operational procedures, operators are expected to create a 
subdirectory in that directory for each ingest and deposit the files as ingested into that 
subdirectory. The purpose of the subdirectory is to retain ingested material for subsequent "real" 
ingest into ECS once the DDSRV and the document ingest functions are implemented. The 
naming conventions for these subdirectories are TBS. 

The documents will be placed by operational procedure into directories on the DDSRV Netscape 
Server host. The directory names must be in compliance with B.0 directory naming conventions, 
but are otherwise at the discretion of DAAC Ops. DAAC Ops will be responsible for creating 
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web pages on the DDSRV Netscape host which point to these documents, and provide links to 
these web pages from relevant other ECS web pages. 

16.6.1 Document Inserts From Within ECS 

Documents generated automatically within ECS will be associated with fixed pathnames on the 
DDSRV host (if the DDSRV will store always only one occurrence of the document), or fixed 
directories on the DDSRV host (if there will be multiple instances of the document kept on the 
DDSRV). 

Documents which are planned for insertion into the DDSRV from within ECS (e.g., algorithm 
documentation) by manual procedure, will have their procedure changed to provide ingest 
documentation, generate a DAN, have the document placed into an "archive" directory, and then 
have the document placed into a DDSRV directory. 

The providers of documents generated automatically by ECS or inserted manually, are 
responsible for having web pages produced and stored on the DDSRV Netscape server host 
pointing to the documents. The web pages must be compliant with the ECS HTML guidelines. 
DAAC operations are free to add links to them in other ECS web pages. 

DAAC Ops will maintain and update any web pages needed to support access to the documents 
on the B.0 DDSRV web server. The web pages are placed into directories named in accordance 
with the Release B.0 directory naming conventions, but the names are otherwise at the discretion 
of DAAC Ops 

There is no guarantee that the B.0 URLs for DDSRV documents will be valid for these 
documents in B.1. 

If documents are updated, the updated versions need to go through the manual ingest procedure 
to ensure that they can be ingested into B.1. 

DDSRV is responsible for any configuration tailoring of the DDSRV Netscape Server. 

SSI&T will need to produce and save a DAN for the documents which are part of a DAP/SSAP. 

16.6.2 Scanning Documents 

This procedure will take you step by step in operating the HP Jetscan Scanner to create a 
temporary file for data to be downloaded to the system for archiving documents. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure; 

1 Click on the Start button. 

2 Select Programs. 
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3	 Select TexBridge Pro 96 to access the TexBridge software for scanning documents 
consisting of both text and tables. 

• Select TexBridge Pro 96 once again within the second column. 

•	 When the TexBridge Pro 96 screen appears insure that the following 5 options are 
listed as follows. 

Page Quality / Page Orientation / Original Document Layout / Document Recomposition / Brightness 

Auto  Auto  Auto  Recompose All Auto 

4 Select Save Image Defer OCR this is the 8th icon to far right of the screen.


5 Load documents into HP ScanJet feeder.


6 Click Go this will start the scanning process.


7 When the document has been scanned, save the document with a valid file name.


This process will require a filename to be created “when saving” the data before the data 
information can be accessed in the system for verification. 

Table 16.6-1. Scanning Documents - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 Select Start from the Windows 95 menu bar single Click 

2 Select Programs single Click 

3 Select TexBridge Pro 96 single Click 

4 If scanning both text and table select Save Image 
Defer OCR 

single Click 

5 Load documents into HP ScanJet feeder 

6 Click Go single Click 

16.6.3 Accessing Scanned Documents 

After a document has been scanned, it should be checked to ensure that it has been properly 
scanned and saved. The procedure for accessing scanned documents starts with the assumption 
that the Ingest/Distribution Technician has logged in to Windows 95 on the applicable personal 
computer (PC). Upon completion of the above procedure follow the step to access the scanned 
files you’ve just created. 

1 Select Start from the Windows 95 menu bar. 
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2 Select Programs


3 Select Windows Explorer from the file menu.


4 Click Program files under this option


5 Select TexBridge Pro 96


6 Click folder called Tiffs


7 Select the filename/s you created from the documents you’ve just scanned.


Table 16.6-2. Opening Tiffs File - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

Select Start from the Windows 95 menu bar single Click 

Select Programs single Click 

Select Windows Explorer single Click 

Select Program Files single Click 

Select TexBridge Pro 96 single Click 

Click Tiffs file single Click 

Select the file you created single Click 
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17. Archive Management 

The Storage Management software component of the Data Server Subsystem (DSS) provides 
management services for storing and accessing File Storage Management System (FSMS) data 
files held in FSMS. The storing of the data is the main focus of the FSMS described in this 
section. This storage capability is implemented by both custom and commercial off the shelf 
(COTS) file storage management systems. The FSMS consists of the main storage and a browse 
facility. This system utilizes two types of archive robotic units, Storage Technology (STK) 9310 
Powderhorn Library Storage Module (LSM) and an EMASS Automated Media Library (AML). 
A grouping of STK storage silos combine to form the main data tape storage facility. An 
EMASS AML/2 unit implements the browse functionality. 

The main storage STK Powderhorns have a maximum capacity of 6000 cartridges each 
depending on the configuration of the silo. The cartridges have a capacity of 50 Gigabytes each 
non-compressed, and 100 Gigabytes if compressed. This gives each library an approximate 
capacity of 300 Terabytes of data. The dual arm robotic unit is capable of 300 to 400 cartridge 
exchanges per hour. The library utilizes STK Redwood SD3 helical scan tape drives. The main 
data storage facility houses Level 0-4 data, ancillary data, command history, algorithms, 
engineering data, calibration data, systems and applications software. 

The EMASS browse unit utilizes 6 optical disk units for two media types. Currently, there are 
three 2.6 Gigabyte Hewlett Packard and three 9.4 Gigabyte drives. This archive is under 
configuration at this time. A single picker arm unit operates as a robot for both media types. The 
EMASS browse unit contains metadata reference data available in the main archive storage 
facility. It allows the user to search for one specific type, category, or grouping of data. By 
performing this function for the system, it allows the main storage facility to concentrate on the 
ingesting, storing, and distribution of the data products. 

17.1 Custom Software Items 

The following custom software items reside on the Storage Management Server: 

1. 	 EsDsStArchiveServer  The Archive Server moves files in and out of the FSMS via the 
Archival Management and Storage System (AMASS) cache. It is the front end to the FSMS. 
The Archive Server has three services to perform on behalf of its clients: 

•	 Store: Move the listed files from staging disk to mass storage cache. AMASS moves 
the files from cache into the archive. 

• Retrieve: Request files from the archive when files are available. 
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•	 Delete: Request that references to the files be deleted from the AMASS database. A 
request includes a file list (1 to N) on which the service is performed. The request is 
handled as a transaction, the action will occur for all files in the list or not at all. 

2.	 EsDsStStagingDiskServer  The Staging Disk Server provides a full set of directory services 
against the physical storage. The server process manages all access to the staging disk. By 
maintaining allocation data with each use of the area. The directory services are: 

• list a file 

• allocate space for a file 

• extend an allocation 

• link files 

• copy in/out 

• delete 

•	 create subdirectory. Requests that cannot be handled immediately due to insufficient 
space are queued and then fetched from the queue for completion when the space is 
available. 

3.	 EsDsStStagingMonitorServer  The Staging Monitor Server is a persistent server that moves 
files from FSMS and monitors the read only cache area. It also tracks the staging disk access 
counts. 

4.	 EcDsStFTPDisServer  The FTP Distribution Server distributes files via ftp and file push into 
the appropriate servers. 

5.	 EcDsStPullMonitorServer  The Pull Monitor Server constantly monitors the contents of the 
pull area. It also provides mechanisms to delete data objects from the pull area and report 
utilization of the pull area. 

6.	 EcDsStIngestFtpServer  The Ingest FTP Server transfers files from external provider to 
staging disk. Request includes source host, source directory, source file, target host and target 
directory. 

7. EcDsStmgtGUI  Provides access to the Storage Management GUIs. 

8.	 EcDsSt8MMServer EcDsSt4MMServer EcDsStD3Server EcDsStCDROMServer  Controls 
reads and writes to the appropriate units. 

17.2 COTS Software 

The FSMS relies on software from both STK and EMASS for management of data files held in 
their mass storage systems. ECS reliance on COTS software is prevalent in the FSMS system. 
The FSMS utilizes three COTS software packages for control functions of archive management, 
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AMASS, GRAU Distributive AML Server (DAS), and STK Automated Cartridge System 
Library Software (ACSLS). 

AMASS acts as the main control and interface to the FSMS. It serves as a UNIX file system that 
manages removable media jukeboxes. AMASS integrates with DAS to manage the EMASS 
robotics and with ACSLS to manage the STK robotics. 

Each of the two robot control packages, ACSLS and DAS, are furnished by their respective 
hardware vendors, STK and EMASS, and are bundled with the hardware delivery. ACSLS runs 
on a SUN SPARC5 workstation and, in turn, relies on an ORACLE Database. The ORACLE 
database also resides on the SPARC5 and while the ACSLS is a tool which is not administered, 
ORACLE must be backed up periodically and may need to be restored or repaired. DAS is the 
ACSLS equivalent for the EMASS robotics and it resides on a built-in PC, on the EMASS AML. 

Figure 17-2 depicts the software configuration of the FSMS subsystem. 

STK Main Storage Facility EMASS Browse Facility 

DSS Software 

with 

Storage Management GUI 

DSS Software 

with 

Storage Management GUI 

AMASS Software AMASS Software 

ACSLS Software DAS Software 

Figure 17-2. FSMS Software Configuration 

The Activity Checklist depicted in Table 17.2-1 provides an overview of the COTS Software 
section. Column one (Order) shows the order in which tasks should be accomplished. Column 
two (Role) lists the Role/Manager/Operator responsible for performing the task. Column three 
(Task) provides a brief explanation of the task. Column four (Section) provides the Procedure 
(P) section number or Instruction (I) section number where details for performing the task can 
be found. 
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Table 17.2-1. COTS Software Activity Checklist 
Order Role Task Section 

DAM/DIT/SA AMASS (I) 17.2.1 

DAM Media Control (I) 17.2.1.1 

DAM/DIT Data Integrity (I) 17.2.1.2 

DAM/DIT Cache (I) 17.2.1.3 

DAM/DIT AMASS On-line Database (I) 17.2.1.4 

DAM Rebooting the AMASS Database (P) 17.2.1.4.1 

DAM/DIT Off-Line Media Management (I) 17.2.1.5 

DAM/DIT File Size Limitations (I) 17.2.1.6 

DAM/DIT Distributive AML Server (DAS) (I) 17.2.2 

DAM/DIT Automated Cartridge System Library 
Software (ACSLS) 

(I) 17.2.3 

17.2.1 AMASS 

The FSMS utilization of robotic systems requires the implementation of a FSMS to control 
functions and data archiving. AMASS provides this function for ECS. 

Since AMASS is implemented at the virtual file system (VFS) layer of the host operating system, 
it is transparent to other software programs. The VFS layer is designed for this approach and is 
the layer where other UNIX file systems attach, such as UFS, NUS, and RFS. Because AMASS 
is implemented at this level, you do not have to modify the host operating system. 

The system call transparencies provided by this implementation allows the host computer 
running AMASS to be a server to an entire network of homogeneous or heterogeneous systems. 
The networking software runs without modification on top of AMASS so that the host can run 
whatever networking protocols are available, including NFS, RFS, TCP/IP, DECnet, or HYPER 
channel. 

Because AMASS is implemented at the UNIX operating system level, it isolates the integration 
of the removable media drives and libraries from the specific applications that use it. In this case 
the application is DSS storage management (STMGT) software. Because AMASS supports 
applications by providing access to the files using standard file system semantics, programs that 
currently run on standard UNIX file Systems can use AMASS without modification. 

The AMASS file system is designed to conform to all the standard UNIX data integrity functions 
and conventions. This conformity is beneficial when creating file systems with the potential size 
of an AMASS file system. 

AMASS provides transparent access to the files stored in the AMASS file system. AMASS 
makes the drives and media (volumes) normally considered off-line storage appear as a single, 
online, logical device with a single, mounted, file system. Therefore, the extensive storage 
provided by a library appears as one large file system. 
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The AMASS file system is mounted as a single mount point in the host file system tree. With 
this single mount call, the entire AMASS file system capacity is brought online and made 
available for use. Although your clients may think their files are located on the AMASS server, 
in reality they may be stored on multiple libraries or even on off-line storage. 

FSMS supports the transport of files from the UNIX server, Silicon Graphic Incorporated (SGI) 
Challenger Series CPU, where it is installed, onto robotic libraries and standalone drives. 
AMASS allows system administrators to manage libraries, drives, and volumes. These elements 
can be logically sub-divided into user-definable groups, if desired. To users, the files, no matter 
where they reside, appear as a single, mounted file system. AMASS treats each tape or optical 
disk as a volume. 

Moving and mounting volumes are transparent to both the host and the client accessing data. 
Consequently, access to data stored in an AMASS system is identical to accessing data on a 
mounted, magnetic disk file system. 

17.2.1.1 Media Control 

The Archive Manager enters either a bar code ID or a volume label ID when a new volume is 
introduced to AMASS with the volnew command. At the same time, AMASS also assigns this 
new volume a unique numerical ID. From then on, AMASS tracks the volume by this unique 
identifier and verifies the volume by using either bar codes or headers. 

With AMASS, volumes from one or more libraries are allocated into groups, called volume 
groups. Then these volume groups are assigned to serve a particular subdirectory tree. Because 
these volume groups are assigned to directory subtrees, similar to mounting a file system, they 
are considered to be logical mount points. This allows the system administrator to assign 
volumes for specific purposes within AMASS without losing the benefits of a single file system 
and a single mount point that spans media. 

The following types of volume groups are assigned; numerical group (#0 through 2047), space 
pool, and the cleaning group. After a volume group has been defined for a set of volumes, all 
writes to the volume group directory and its subdirectories go to the specified volumes. No other 
data is placed on these volumes. Therefore, when all the volumes are filled up, subsequent writes 
fail because the volume group is full. However, you can add volumes to the group as needed or 
allow the volume group to automatically grab more volume from a special volume group called 
the space pool. For more information on volume groups, refer to the AMASS  System 
Administrator's Guide. The AMASS guide can be viewed using Adobe Acrobat and is available 
electronically on servers g0drg01 and g0drg02 in /usr/amass/books. 

When a volume is full, AMASS automatically rolls to the next available volume to continue its 
operations. The volumes that make up AMASS are subdivided, into multiple groups (logical file 
systems or mount points) called volume groups. 

In a library environment, there are many volumes but only a few drives. If several requests come 
in for many different volumes, the potential exists for AMASS to spend most of its time moving 
media and little of its time actually performing useful Input / Output (I/O). But because AMASS 
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simultaneously handles many random and simultaneous I/O requests, this design prevents 
thrashing (overworking the robot arm due to multiple requests) and optimizes I/O tasks. These 
items combine to minimize library operations and maximize the number of simultaneous 
operations that can be handled by the library. 

Volume verification is extremely important in both standalone drives and libraries. Both types of 
devices are subject to operator error and automated systems can suffer from hardware 
malfunctions leading to incorrect volumes being loaded into the drives. AMASS supports 
multiple types of volume verification. 

In libraries, media can be left in the drives if a system crash occurs. AMASS uses the volume bar 
codes or volume headers to identify the volumes and automatically put the volumes away. 

17.2.1.2 Data Integrity 

AMASS provides data integrity in several ways. Write operations to files are allowed to 
complete to the cache, including sync, rsync, and synchronous I/O. AMASS tracks these 
operations and completes the I/O to the removable media in the event of a system crash. This 
tracking provides a level of data integrity consistent with standard UNIX file systems 

17.2.1.3  Cache 

The AMASS cache resides on the magnetic disk of the UNIX server where AMASS is installed. 
The cache implementation follows all UNIX file system conventions for synchronous I/O, sync, 
and fsync functions. The caching of data provides the following benefits; greater system 
performance, protection against thrashing, facilitates the simultaneous access of library file 
system data by both multi-user and multi-tasking applications. 

After files are in the cache, multiple file-writes to the same volumes are grouped into single large 
I/O operation that minimizes volume movement and maximizes I/O throughput. Therefore, a 
high aggregate throughput is achieved through the following items; grouping write operations in 
the cache, prioritizing reads-from volumes over writes-to-volumes. 

The AMASS cache was designed to solve the disparity between the input of data streams from 
clients through the AMASS server and the output to a library. The data caching function of 
AMASS is used in conjunction with read-ahead and write-behind algorithms to optimize the I/O 
block sizes and the amount of data read and written after the media is positioned for I/O. 

Because all operations completed to the cache are recovered in the event of a system crash, the 
write operations complete after a cache-write is done. Multiple cache partitioning allows the 
AMASS cache to be a maximum of 256 2-GB sized partitions. This large cache allows more data 
to remain resident in the cache for a longer period of time thereby increasing throughput and 
performance. In addition, a large cache allows large files to be cached faster before being moved 
to a secondary device. which increases throughput. 

The cache size is configured to take advantage of both the application being used and the system 
environment where AMASS is installed. Because the cache size does not impact maximum file 
size, the cache can be very small. On the other hand, applications running database tables in the 
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library, may need a larger cache configuration to optimize the number of cache hits and allow 
updates to table headers to be predominantly cache I/O. The cache parameters are configured 
during installation. For information on sizing the cache, refer to AMASS document; Installing 
and Configuring AMASS. 

17.2.1.4 AMASS On-line Database 

AMASS keeps a magnetic, disk-resident database of attributes called metadata pertaining to 
directories and files resident in its file system, (attributes consist of access time, user id, etc.). 
This database grows as files and directories are added to the AMASS file system. 

The AMASS online database allows common file system utilities and system calls to operate 
very quickly, in many cases faster than even the host's native file system. Basic commands such 
as directory listings (ls), changing the working directory (cd), and even searching through part or 
all of the file system for files of given attributes, operate in AMASS without having to access the 
media in the library. 

A secondary benefit of the online database is less media contention in the library when multiple 
users are accessing the AMASS file system. Because only the actual read- and write-data system 
calls need access to the library, more operations can be completed without waiting for media 
changes. This minimizes the number of media changes, greatly enhancing total I/O throughput 
capability. 

Most UNIX file Systems require fsck (a file system integrity check) of all file systems mounted 
at the time of a system crash This checking can be very time-consuming. The AMASS database, 
eliminates the need for this file system check associated with other file system designs. On 
system reboot, AMASS corrects the database based upon the journal files and brings the system 
back online. Typically, this function takes less than 30 seconds to complete. 

Rebooting the AMASS Database 

The AMASS file system may need to be rebooted during certain anomalous conditions. A few 
reasons to reboot AMASS could be if the system gets hung, if it is not communicating with 
ACSLS or DAS, or if one of the required daemons has aborted. To check the health of AMASS 
while it is still running, execute the healthcheck command. AMASS needs to have the following 
daemons running at all times: 
libio_tape, amassmain, daemons/lm_ip -a fslock, qset 

To verify they are running, simply search for the AMASS processes. 

Ex. ps -ef | grep amass 

In order to reboot AMASS you must have root privileges. The following procedure demonstrates 
the steps to reboot AMASS. Table 17.2-2 presents the steps required to follow the reboot 
process. If you are already familiar with the procedure, you may prefer to use this quick-step 
table. If you are new to the system, or have not performed this task recently, you should use the 
following detailed procedure: 
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1. Log in as root and enter the password. 

2. Kill daemons by typing: killdaemons 

3.	 If you want to test AMASS before restarting, go to step 4, otherwise, enter: 

amass_start 

4.	 To test the AMASS filesystem prior to starting AMASS type: 

install_tests 

• Tests the operation jukebox operation and cache partitions, then restarts AMASS. 

Table 17.2-2. Rebooting the AMASS Database 
Step What to Do Action to Take 

1 Log in as root press Return 

2 killdaemons press Return 

3 amass_start press Return 

4 install_tests press Return 

17.2.1.5 Off-line Media Management 

Off-line media is supported through the online database. Because the file system's database is 
resident on the magnetic disk, all files and directories are always visible to clients and 
application programs. In robotic library environments, the online database allows media to be 
removed from the library without losing track of the files and directories resident on the media. 
Directory and file listing commands as well as all system calls, except read and write files, 
succeed on files even though media has been removed from the library. If a file's data is needed, 
AMASS uses the online database to quickly identify which of the off-line volumes must be 
reintroduced in order to access the data. 

17.2.1.6 File Size Limitations 

Within AMASS, file sizes are limited only by the host operating system's limitations. This means 
that files larger than the capacity of one volume can be stored in its file system (for example, a 2 
GB-file can be stored on 5.25 inch optical disks that have a 300 MB-per side capacity). The file 
system and directory sizes of AMASS are virtually unlimited. Although every attempt is made to 
keep files of a directory on a single volume, both files and directories can span media 
boundaries. Therefore, file and directory sizes are not limited to media size. Consequently, a 
directory can reside on one or more volumes. 

Even though files can reach 2 GB, regardless of the physical volume size to AMASS, the entire 
volume set appears as a single logical device of very large capacity. You can configure the file 
system to consist of any number of volumes (tapes or optical disks); the default is 65,000 
volumes. On IRIX Versions 5.3 and 6.2 as well as Solaris 2.5, AMASS supports a 64-bit file 
system, which allows files greater than 2 GB. 
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17.2.2 Distributive AML Server (DAS) 

AMASS supports mixed media in EMASS Automated Media Libraries (AMLs), using the DAS 
software on the Archive Management Unit (AMU). During the AMASS installation, unique 
media types are configured as if they were in separate libraries. 

DAS is a COTS product with both client and server components. The server component is 
installed on the AMU OS/2 server, and the client component is embedded in AMASS. For DAS 
installation and operation on the AMU, refer to the DAS Installation and System Administration 
Guide. The DAS guide can be viewed using Adobe Acrobat and is available electronically on 
servers g0acg01 and g0acg05 in /usr/amass/books. 

DAS is designed to provide shared access to the family of AMASS Automated Mixed-Media 
Libraries. An unlimited number of heterogeneous networked clients can be configured within a 
DAS environment. DAS provides customers with the ability to optimize their automation 
strategies, throughout the enterprise, and leverage their AML acquisition decision. DAS 
provides the ability to share AMLs with many clients. 

DAS is integrated with backup, tape management and/or hierarchical storage management 
(HSM) applications on the client to direct automated removable media activity through the DAS 
server to the library. A DAS client may be any system requiring AML services. A client may be 
granted complete or restricted access to AML resources. AML resources are defined as drives, 
volumes and insert/eject areas and may be marked as shared or private to each client. Through 
client registration, the administrator function in DAS is able to control client access and 
privileges. 

The DAS server component runs within the AMU on the AML. The DAS server converts client 
requests into complete AMU requests. It also creates journal entries of all requests, for recovery 
purposes, and sends request status back to the client. DAS may be installed as a standalone AML 
connection or be configured to share an AML with MVS or other, EMASS supported, host 
attachments. 

17.2.3 Automated Cartridge System Library Software (ACSLS) 

Storage Tek's UNIX-based ACSLS, allows applications based on the client systems access and 
manage information stored in an automated cartridge system (ACS). Client access appears as if 
the libraries were operating exclusively under the control of each client system. ACSLS performs 
library command processing on the client's behalf, as well as processing operator commands 
issued by the library system administrator. Library requests and messages move across a 
network which is a client-independent control path that connects client systems and the 
operator's console with the ACS. 

ACSLS consists of a system administration component. The system administrator component 
provides an operator interface to control and monitor the ACS, including access control. A batch 
user interface allows automated scheduling of storage management functions, such as cartridge 
entry and eject, according to client processing requirements. 
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A programmatic interface allows client applications to direct specific library service requests to 
the ACSLS. These service requests include cartridge mounts, dismounts, enters, and ejects. 
Additional requests allow client applications to determine and change the status of cartridges 
and ACS components. 

Basic library management facilities of ACSLS includes command and message processing, 
maintenance of the contents and configuration data base, Cartridge Access Port (CAP) 
management, event log recording, scratch-pool management and access control. 

ACSLS facilitates data security with administrator-assigned volumes and limited command 
access. 

The centralization of operations support reduced storage management requirements and 
facilitates lights-out data center management. The FSMS supports multiple media. Table 17.2-3 
identifies the different types of archive media used within the FSMS system. Archive media 
consist of tape and optical disk cartridges. Each tape or disk cartridge is identified by means of 
a bar code label that shows the media number. This number provides the means to produce an 
archive catalog that tracks the location of each cartridge within the library. The catalog 
numbering is based on information provided to the robot arm mounted laser bar code reading 
scanners. 

Table 17.2-3. FSMS Media Types 
Media Media Purpose Archive 

2.6 Gigabyte Optical Disk 
9.4 Gigabyte Optical Disk 

Archive Storage EMASS 

50 Gigabyte D3 Tape Cartridge Archive Storage STK 

17.3 Archive Configuration 

The ability of the FSMS to absorb and to serve data at required rates depends on a well 
integrated, well tuned combination of high performance archival hardware and software. All the 
ECS DAACs have the same architecture and constituent components. The DAACs differ only in 
the size and particulars of equipment. 

Figure 17.3-1, depicts the overall configuration for the STK main storage. For a representation 
of RAID attachment see Figures 17.3-2. 
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Figure 17.3-1. Archive Hardware and Software Configuration for STK 

AMASS controls the physical storage of the data in the repository and is hosted on a SGI 
multiprocessor Challenge class server. The data collection resides in the STK Powderhorn 
robotic silo and is recorded using D3 helical scan tape drives from Storage Tek. SGI RAID is 
used for the temporary caching of data en route to and from the robotic silo. 

As shown, the tape drives (D3) residing in the Storage Tek robotic silo are directly connected to 
the SGI Host via Fast-And-Wide SCSI II channels. Each channel is individually capable of the 
throughput of 20 MB/sec. Each of the eight tape drives is rated by the manufacturer capable of 
11.2 MB/sec sustained throughput. 

The control of the robotic mechanism of the silo (loading and unloading of the tapes) is affected 
via the STK ACSLS interface software running on a SPARC 5 SUN workstation. AMASS 
addresses the ACSLS through a network connection. ACSLS controls the robot directly via an 
RS232 line. 

Figure 17.3-2, RAID Configuration, illustrates the configuration as of 8/19/97. The RAID level 
configuration is 3. 
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Figure 17.3-2. RAID Configuration 8/19/97 

Note 

This configuration is the same for the EMASS browse system. 

ECS browse capabilities depend on its ability to serve data to its users at required rates on a well 
integrated, well tuned combination of high performance archival hardware and software. Figure 
17.3-3, depicts the overall configuration for the EMASS browse system. For a representation of 
RAID attachment see Figures 17.3-2. 
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Figure 17.3-3. Archive Hardware and Software Configuration for EMASS 

AMASS controls the physical storage of the data in the browse unit and is hosted on a SGI 
multiprocessor Challenge class server. The data collection resides in the EMASS AML/2 and is 
recorded using a combination of optical disk drives, 2.6 Gigabyte and 9.4 Gigabyte, by Hewlard 
Packard and TBD. SGI RAID is used for the temporary caching of data en route to and from the 
AML. 

As shown, the optical disk drives residing in the AML are directly connected to the SGI Host via 
Fast-And-Wide SCSI II channels. Each channel is individually capable of the throughput of 20 
MB/sec. The 2.6 G drives are capable of 3.4MB per sec read and 1.7MB per sec writes with a 25 
msec average seek time. The 9.4 G drives capabilities are not yet known. 

The control of the robotic mechanism of the AML (loading and unloading of the disks) is 
effected via the GRAU DAS interface software running on a IBM PS/2 with OS/2. AMASS 
addresses the DAS through a network XDI interface connection. DAS controls the robot 
directly via an RS232 line. 

17.4 Graphical User Interface (GUI) 

Both custom and COTS software are supplied with a configurable X-Windows/Motif GUI 
interface. Many functions available on the command line can also be performed from the GUI. 
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The GUI is configured by editing a button file. The System Administrator can comment out 
certain buttons, thus removing those functions from a user's GUI. The button file is then 
provided to the user and appropriate paths are set to locate the GUI interface button file and 
executables. 

Data that are inserted into the archive can be received from a number of sources including the 
Ingest Subsystem, Processing Subsystem, other DAACs, and Authorized Users. The Data Ingest 
Technician (DIT) or other operators can monitor the insertion of data into the archive using the 
Data Server Subsystem (DSS) GUIs. 

1. DDIST Graphical User Interface (GUI). 

2. STMGT GUIs 

The Activity Checklist depicted in Table 17.4-1 provides an overview of the Graphical User 
Interface section. Column one (Order) shows the order in which tasks should be accomplished. 
Column two (Role) lists the Role/Manager/Operator responsible for performing the task. 
Column three (Task) provides a brief explanation of the task. Column four (Section) provides 
the Procedure (P) section number or Instruction (I) section number where details for performing 
the task can be found. 

Table 17.4-1. Graphical User Interface- Activity Checklist 
Order Role Task Section 

1 DAM/DIT Graphical User Interface (I) 17.4 

2 DAM/DIT  Launching DSS GUIs Using 
UNIX Commands 

(P) 17.4.1 

3 DAM/DIT Storage Management Control GUI (I) 17.4.2 

4 DAM/DIT AMASS GUI (P) 17.4.3 

5 DAM/DIT AMASS GUI File Function (I) 17.4.3.1 

6 DAM/DIT AMASS GUI Tasks Function (I) 17.4.3.2 

7 DAM/DIT AMASS GUI Admin Function (I) 17.4.3.3 

8 DAM/DIT AMASS GUI Preferences Function (I) 17.4.3.4 

9 DAM/DIT AMASS GUI Help Function (I) 17.4.3.5 

17.4.1 Launching DSS GUIs Using UNIX Commands 

The following procedure demonstrates how to bring up a DSS GUI. It is expected that eventually 
the ECS DAAC desktop will be configured to allow access to the DDIST and other GUIs using 
icons. In the interim, access to the DSS GUIs must be gained through the use of UNIX 
commands. In any case, launching the GUIs starts with the assumption that the applicable servers 
are running and the operator has logged in. Table 17.4-2 presents the steps required to follow the 
procedure. If you are already familiar with the procedure, you may prefer to use this quick-step 
table. If you are new to the system, or have not performed this task recently, you should use the 
following detailed procedure: 
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1. Access the command shell. 

•	 The command shell prompt is displayed. 

NOTE:  Commands in Steps 2 through 12 are typed at a UNIX system prompt. 

2. Type xhost + and then press the Enter key. 

3.	 Start the log-in to the DDIST client server by typing either telnet hostname (e.g., g0dis02), 
rlogin hostname, or rsh hostname in the second window and then press the Enter key. 

• If you use the telnet command, a Login: prompt appears; go to Step 5. 

•	 If you use either the rlogin or rsh  command, the system uses the User ID currently in 
use; go to Step 6. 

4.	 When a login: prompt appears, log in as yourself by typing your UserID and then pressing 
the Enter key. 

5. At the Password prompt type your Password and then press the Enter key. 

6. Type setenv DISPLAY clientname:0.0 and then press the Enter key. 

•	 Use either the terminal/workstation IP address or the machine-name for the 
clientname. 

7. Type cd /path and then press the Enter key. 

•	 Change directory to the directory path(e.g., /usr/ecs/mode/CUSTOM/utilities) 
containing the DSS command files (e.g., EcDsDdistGui). 

•	 The mode will most likely be one of the following operating modes: 

 OPS (for normal operation). 

 TS1 (for testing). 

 TS2 (for other uses). 

Note: the separate subdirectories under /usr/ecs apply to different operating modes. 

8 . 	To launch the Data Distribution Requests GUI, type the following command: 
EcDsDdistGuiStart and then press the Enter key. 

• The Data Distribution GUI is displayed. 

9 . 	To launch the Storage Management Control GUI type the following command: 
EcDsStmgtGuiStart and then press the Enter key. 

• The Storage Management Control GUI is displayed. 
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Table 17.4-2. Launching DSS GUIs Using UNIX CommandsÄ
Step What to Do Action to Take 

xhost press Return 

telnet hostname press Return 

UserID press Return 

Password press Return 

setenv DISPLAY clientname:0.0 press Return 

cd /usr/ecs/mode/CUSTOM/utilities press Return 

EcDsDdistGuiStart press Return 

EcDsStmgtGuiStart press Return 

17.4.2 Storage Management Control GUI 

This tool enables operations to manage various data storage functions. These functions include 
the capability to set and modify configurations of various Server Types (e.g., 4mm tape, Archive 
Server, D3 tape), manage data location within the archive and on disk, configure stacker slots, 
display storage events which possibly require operator actions, and view backup/restore failures 
with the ability to restart a backup/restore operation. AMASS has to be up in order for the 
Storage management Tool to archive and retrieve files. Moreover the FTP server on the ACP 
host has to have debug logging enabled to write the filename of pulled files into the syslog for 
pull notification to the pull monitor. 

The Tool is used to perform the following operator functions listed in Table 17.4-3. 
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Table 17.4-3. Common ECS Operator Functions Performed with This ToolÄ
Operating 
Function 

Command/Script or 
GUI 

Description When and Why to Use 

Configure Server 
Devices 

Storage Config Tab Allows operators to organize 
and configure various Server 
Devices and manage data 
flow in and out of various 
archives. 

As needed to add, delete, 
or modify the 
configuration of a set of 
Servers or a Server 
Device. 

View the current 
cache statistics 
for the Pull 
Monitor cache. 

Cache Stats. Tab Allows the operator to view 
the Pull Monitor cache and 
view the statistics on its use. 
Operator can delete expired 
files. 

Used when warning is 
displayed in the message 
area informing the 
operator the cache is 
getting too full. 

Search Event Log Storage Events Tab Allows operators to find 
events from selected 
parameters 

As needed to locate 
events. 

View current 
requests and 
manage tapes 

Resource Schedule 
Tab 

Allows operators to display 
the storage management 
view of the current requests 

Used to select a specific 
request, manage tape 
group, stacker and slot 
configurations. 

Storage Management Control can be operated from any one of the 4 tabs which control the 4 
components as listed above (Table 17.4-3). The operator can select the following menu 
functions for each component tab from the menu bar items at the top of the window: 

• File contains the exit command to close application 

•	 Options allows operator to set the polling rate for the event log for the current 
execution of the application. 

•	 Backup  allows operator to set up data files as a backup at the operator site and at 
operator off-sites, to view backup files and to restart backup files. 

• Setup allows operator to set up files for backup to on site or off site areas. 

•	 Restart shows the location of failed files and provide a restart capability, see 
figure 4.10.2-14 (Restart Backup). 

Menus named Selected, Edit  , and View are also present at the top of the window, but 
functionality to be associated with them has not yet defined. They will be used in future releases. 

For a detailed description of the Storage Management GUI, refer to the 609 document Section 
4.10.2. 
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17.4.3 AMASS GUIÄ

Note 

The AMASS GUI is a System Administrator tool, to be used only for monitoring the 
displayed information at this time. The GUI experiences intermittent problems known to 
the manufacturer and is due for complete functionality in a later software revisions 5.0. 

The AMASS software provides DAAC Operations personnel with a GUI to access the 
functionality of AMASS utilities and command line functions. 

AAWin (AMASS Administrator Window) provides the use of the AMASS GUI. This allows the 
menu functions of the GUI to become queries to the on-line index and facilitates the following 
functions: 

• Assign and delete volumes. 

• Modify volume characteristics. 

• Modify volume groups. 

• View volume/volume group usage statistics and monitor system performance. 

• Reuse a volume. 

The GUI performs a subset of the administration commands. The above tasks can be done with 
the AMASS administration commands, which are issued from the command line. Use the 
following procedure to start the AMASS GUI (AAWin). Table 17.4-4 presents the steps required 
reboot the AMASS database. If you are already familiar with the procedure, you may prefer to 
use this quick-step table. If you are new to the system, or have not performed this task recently, 
you should use the following detailed procedure: 

1. Login as amass and enter the password. 

2. 	Verify that AMASS is running. 

At the prompt, type: amassstat -c 

A message will display a message indicating the status of AMASS. 

3. 	 The GUI is accessible through the AMASS directory, /usr/amass/bin/. To start the AMASS 
GUI, type: aawin 

Note: only one aawin session can be up at a time. 

4. To exit, select the menu path: File/Exit 

For a complete description of these commands, refer to the manual Managing the AMASS File 
System. 
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Table 17.4-4. Starting The AMASS GUIÄ
Step What to Do Action to Take 

1 amass press Return 

2 amassstat -c press Return 

3 /usr/amass/bin/aawin press Return 

4 File/Exit press Return 

AMASS GUI menu selections are described in sections 17.4.3.1 through 17.4.3.5. Additional 
menu keys provide help information to the user and a quit GUI option key. 

17.4.3.1 File 

This pull down menu has the following selections: 

• Exit- Exits AAWin. Closes all windows except the sysperf window. 

• Clear Workroom- Clears the Workroom of all icons. 

17.4.3.2 Tasks 

This pull down menu has the following selections: 

• Add Volumes- SCSI (This appears when there are SCSI-attached libraries.) 

• Modify a Volume Group 

Displays volume status and information. Volume, volume group, juke, position, 
label/barcode, status, used space, available space, dead space, and number of errors are 
displayed in this selection. The user is allowed to perform various functions on a single or 
combinations of volumes using this selection . These functions are the following: 

⇒ Enable or disable space pool. 

⇒ Add or remove directories. 

⇒ View volume group information. 

• Modify a Volume 

Displays volume status and information. Volume, volume group, juke, position, 
label/barcode, status, used space, available space, dead space, and number of errors are 
displayed in this selection. The user is allowed to perform various functions on a single or 
combinations of volumes using this selection . These functions are the following: 

⇒ Toggle status active or inactive 

⇒ Toggle volume on-line or off-line 
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⇒ Changing label 

⇒ Delete volume 

⇒ Introduce new volume to archive 

⇒ Quick or normal formatting of volume 

17.4.3.3 Admin 

This pull down menu has the following selections: 

• Scheduler - Opens the Scheduler Status Window. 

• Sysperf - Opens the sysperf window displaying the AMASS I/O activity. 

17.4.3.4 Preferences 

This pull down window has the following selection: 

•	 Show/Hide Detail Windows - These windows give a brief description of the items the 
mouse pointer is touching. 

17.4.3.5 Help 

• Opens the Help Window. 

Detailed explanations of the GUI functions are located in the AMASS guide; Using the AMASS 
GUI. The AMASS guide can be viewed using Adobe Acrobat and is available electronically on 
servers g0drg01 and g0drg02 in /usr/amass/books. 

17.5 Command Line Functions 

Some but not all archive functions can be accomplished using a GUI. The operator should 
however become familiar with all command line utilities and commands. The following table 
provides a list of AMASS commands and utilities. 
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Table 17.5-1. Common ECS Operator Functions Performed with AMASS (1 of 2)Ä
Operating 
Function 

Command or GUI Description When and Why to Use 

activate or 

deactivate the 

AMASS filesystem 

• amassstat 

• AA Win GUI 
displays or toggles the status 

of AMASS 

(ACTIVE/INACTIVE) 

used to inactivate the file­
system for maintenance and/or 
to reactivate it 

add a volume • volnew 

• AA Win GUI 

introduces a new volume 
to AMASS and assigns a 
volume number 

to add storage space for data 

add space to a 
volume group 

• volnew 

volgroup 

• AA Win GUI 

adds additional volumes to 
an existing volume group 

when more space is required 
in an existing volume group 

create a space 
pool 

• volnew one or more volumes 
assigned to a special 
volume group of “SP” 

to allow AMASS to 
automatically add space 
(volumes) to 
that has run out of space 

create a volume 
group 

• volgroup 

setvolgrp 

• AA Win GUI 

partitions the volumes in 

AMASS 

to assign volumes for specific 
purposes within AMASS 

delete a volume • volstat 

voldelete 

• AA Win GUI 

removes a volume and its 
files from the archive 

to delete a volume and any 
files 

it contains 

generate a report •  amassreport generates formatted report 
and/or raw output 

to extract information about 
files and directories from the 
AMASS index 

back up the 
AMASS index 

• amassbackup performs full or partial back 
up of the AMASS index 

any time that the system 
needs 

to be backed up other than 
what 
backup provides 

put a drive into 
service 

• drivelist 

drivestat 

• AA Win GUI 

displays the current status 
of the drives and to change 
the status 

when an INACTIVE drive is 

ready to return to service 

recover dead 
space 

• volspace 

volcomp 

volformat 

compresses a selected 
volume 

to recover dead space on 
volumes 

reinitialize the 
AMASS index 

refer to the vendor 
documentation for the 
command and 
procedure 

clears out the existing 
index and reinitializes it to 
an empty index 

only when AMASS is not 
running 

reintroduce an 
offline volume 

• vollist 

volslot 

bulkinlet 

volloc 

reintroduces an offline 
volume to a jukebox 

if data from an offline volume 
needs to referenced for read 
access 

volume group 

AMASSs automatic 
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Table 17.5-1. Common ECS Operator Functions Performed with AMASS (2 of 2)Ä
Operating 
Function 

Command or GUI Description When and Why to Use 

Remove a volume 
or volume group 

• vollist, voloutlet, 

volloc 

removes a volume or an 
entire volume group from 
the jukebox 

to make room for new volumes 
or because data not being 
used needs to be retained 

remove space from 
a volume group 

• vgroot #VG 

• setvolgrp /path #VG 

• volgroup 

removes space from one 
volume group to add it to 
another 

when space is needed in 
another volume group 

replace a full 
backup volume 

• voloutlet 1, 

• bulkinlet 0, 

• vollabel {to rename} 

• tapelength 1 2 

• volformat -b 256k 1 

• amassbackup -fv 

initializes a new backup 
volume and performs a full 
backup 

when the backup volume is 
95% full 

restore the AMASS 
database 

• amassrestore restores the index either 
completely or to the point 
of the last full or partial 
backup 

• when the index is corrupt on 

the magnetic disk 

• do not use the amassrestore 
command when AMASS is 
running 

retrieve system 
usage by user 

• amassreport displays the number of 

files and directories owned 
by a user and the amount 

of space they take up 

to get statistical information on 

the amount of space used by 
an individual(s) 

retrieve system 
usage by volume 

• adf displays volume group, 
jukebox reference number, 
position of volume, amount 
of used space, number of 
directories and files on 
volume, amount of free 
and dead space 

to get statistical information 

about the usage of a particular 
volume 

reuse a volume • (volcomp, volstat, 
volclean, volformat 

compresses and moves 
existing data to another 
volume, then reformats the 
volume 

when a volume contains data 
no longer needed or contains 
mostly dead space 

take a drive out of 
service 

• drivelist, drivestat displays and changes the 
status of the drive 

when a drive has excessive 
failures or for maintenance 

For a full explanation of all AMASS commands see the AMASS System Administrator‘s Guide. 
The AMASS guide can be viewed using Adobe Acrobat and is available electronically on servers 
g0drg01 and g0drg02 in /usr/amass/books. 

The Activity Checklist depicted in Table 17.5-2 provides an overview of the Command Line 
Fuctions section. Column one (Order) shows the order in which tasks should be accomplished. 
Column two (Role) lists the Role/Manager/Operator responsible for performing the task. 
Column three (Task) provides a brief explanation of the task. Column four (Section) provides 
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the Procedure (P) section number or Instruction (I) section number where details for performing 
the task can be found. 

Table 17.5-2. Command Line Functions - Activity ChecklistÄ
Order Role Task Section 

1 DAM/DIT Formatting a Volume (I) 17.5.1 

2 DAM/DIT Formatting a Tape Volume (P) 17.5.1.1 

3 DAM/DIT Formatting an Optical Disk Volume (P) 17.5.1.2 

17.5.1 Formatting a Volume 

To format a volume, it must be online. A volume is placed online using the volloc command. If 
the volume is a tape cartridge, you must first set the tape length using the tapelength command. 
Formatting a volume will destroy any files on that volume. Before formatting a volume, check to 
make sure it does not have any files which should be saved. Tables 17.5-3 and Table 17.5-4 
present the steps required to follow the formatting process. If you are already familiar with the 
procedure, you may prefer to use this quick-step table. If you are new to the system, or have not 
performed this task recently, you should use the following detailed procedure: 

17.5.1.1 Formatting a Tape Volume 
1.	 Put the volume online using the following command: 

volloc -n volnumber 
• volnumber is the number of the volume 

2.	 Verify there are no files on volume. 
volfilelist volnumber 

3.	 Set the tape length. 
Tapelength 2 volnumber 
• 2 is the value used to set tape length for 50G tape. 
• volnumber is the number of the volume 

4.	 Format the volume. 
volformat -b 262144 volnumber 

5.	 Verify status of the volume 
volprint -a volnumber 
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Table 17.5-3. Formatting a Tape VolumeÄ
Step What to Do Action to Take 

1 volloc -n volnumber press Return 

2 volfilelist volnumber press Return 

3 Tapelength 2 volnumber press Return 

4 volformat -b 262144 volnumber press Return 

5 volprint -a volnumber press Return 

17.5.1.2 Formatting an Optical Disk Volume 
1.	 Put the volume online using the following command: 

volloc -n volnumber 
• volnumber is the number of the volume 

2.	 Verify there are no files on volume. 
volfilelist volnumber 

3.	 Format the volume. 
volformat -b 1024 volnumber 

4.	 Verify status of the volume 
volprint -a volnumber 

Table 17.5-4. Formatting an Optical Disk Volume 
Step What to Do Action to Take 

1 volloc -n volnumber press Return 

2 volfilelist volnumber press Return 

3 volformat -b 1024 volnumber press Return 

4 volprint -a volnumber press Return 

17.6 Storing New Data in Archive Repository 

Storing new data in the archive repository is largely an automated process that does not normally 
require operator interaction and occurs as a result of operations such as ingest and data 
production. Any operations involvement would be to support archive administration operations, 
resolve problems, periodically monitor working storage and archival operations, and coordinate 
with the appropriate external/internal sources to resolve schedule conflicts. 

Because of the automated nature of this process, step-by-step procedures are not required 
however, a typical archive scenario is shown. 

Insert Data into the Archive Scenario 
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NOTE: The scenario that follows describes the insertion of data into the Data Server at an ECS 
DAAC and is derived from document 605-CD-002-001, Release B SDPS/CSMS Operations 
Scenarios for the ECS Project (March 1996). 

Data and associated metadata can be received from numerous sources. This scenario focuses on 
a routine data insert from the Science Data Processing subsystem. It assumes that all 
components are active and not in any degraded modes of operation, that ESDT data collection 
types have been established, and that the data server’s nominal activity rate is 50% of capacity. 

Initiate the session between the Processing Subsystem and the Data Server. 

The Processing Subsystem sends a Data Insert Request to the Science Data Server. 

Receipt of the request is logged (via MSS Logging Services) and a request identifier is 
associated with the Data Insert Request. 

The content of the request is validated; if successful, it is queued for later processing. If 
unsuccessful, a rejection message is issued. 

The operator may examine the progress of a request by following menu path Other 
Screens→Logs & Reports (MSS). In the Data Server Subsystem, open Storage Manager (DSS-
OSM) to browse the log files provided by the Management Services Subsystem (MSS); see next 
section for details. 

Transfer data from Processing Subsystem to Data Server. 

The queued Data Insert Request is reached and processing begins. 

Associated data granules and metadata are transferred from the Processing Subsystem to the 
Data Server working storage. 

Data transfer status, including recoverable errors, are indicated in the event log via MSS Logging 
Services. 

The operator may check request status at any time using the DSS-OSM Request Screen. 

Validate metadata received from the Processing Subsystem. 

The metadata update file(s) produced by the associated product PGEs are validated for 
completeness and correctness. 

Validation success or failure is logged via MSS Logging Services with the associated Data Insert 
Request Identifier and the appropriate status message is returned to the Processing Subsystem. 

Store data granules in the permanent archive. 

Upon successful validation of the metadata update file, Science Data Server sends a Data Storage 
Request to Storage Management. 

The data granules in working storage associated with the Data Storage Request are stored. 
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The Archive Activity Log (via MSS Logging Services) records each data product being stored 
and storage status of each storage operation. 

A checksum value is calculated for each data object associated with each granule. 

The checksum value, storage status, and other selected metadata are forwarded to the Science 
Data Server in a status message upon completion of the Data Storage Request. 

Store metadata. 

Science Data Server receives and logs the Data Storage Request status message from Storage 
Management. 

The additional metadata items are validated. 

The PGE produced metadata update file and the storage management provided metadata are 
loaded into the metadata database. 

The status of the metadata load is entered in the event log. 

The operator may examine the progress of the insert by following menu path Other 
Screens→Logs & Reports (MSS) in the DSS-OSM to browse the log files provided by the MSS. 

Report Data Insert Request status. 

The Science Data Server logs completion of the Data Insert Request in the event log and reports 
completion of the Data Insert Request to the Data Archive Manager, the operator console and to 
the insert Requester (the Processing Subsystem in this scenario). 

Each of the above entities would also be notified if the request failed and reason(s) for failure 
identified. 

Process subscriptions based on newly inserted data. 

The Science Data Server will then examine the event list for all subscriptions for that event. 

Subscription notifications are sent to the appropriate entities as appropriate and distribution 
processing is initiated. 

The Science Data Server sends an Advertisement Update Message to the Advertising Server to 
advertise the new data. 

17.6.1 Monitor Insertion of Data into the Archive 

Data that is inserted into the archive can be received from a number of sources including the 
Ingest Subsystem, Science Data Processing Subsystem, other DAACs, and Authorized Users. 
The DIT can monitor the insertion of data into the archive using the Ingest GUI or, by going to 
the appropriate server (e.g. g0drg01) following archive directory and doing a list: 
/dss_stk1/mode/datatype  where mode is the operating mode i.e. TS1, TS2, SHARED or, OPS 
and datatype is the type of data being archived, i.e. aster or modis. For detailed information on 
the functionality of these GUIs, review the 609 User’s Guide document. 
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17.6.2 Monitor Insertion of Data into the Archive using AMASS 

AMASS provides a capability to monitor the system with a number of commands. Table 17.6-1 
provides a list of helpful AMASS software commands that may be used to monitor insertion of 
data into the FSMS system. These commands are accessible through the /usr/amass/bin 
directory. 

Table 17.6-1. AMASS Monitoring Commands 
amassstat _view or toggle AMASS status 

dirfilelist _view subdirectories or files under a directory 

drivelist _Listing and status of the drives. 

jobs _displays jobs pending and status of jobs completed 

quedisplay _displays request in the que and volumes allocated to the drives 

sysperf _system through put and individual drive data rate performance, drive status, and 
volume mounts 

vglist _view attributes for a volume group 

vgroot _view relative path for a volume group 

volstat _view status (active or inactive) or, change status of a volume 

volusage _view statistics for all volumes 

vollist _Listing and status of the volumes in library. 

volspace _view volumes with a specified percentage of dead space 

The AMASS GUI is available for the DAM to view drive, file, file system, volume, and juke box 
statuses. The GUI is to be used for monitoring only. All drive juke, file or volume changes 
should be done through command line operations. The GUI is accessible through the AMASS 
directory, /usr/amass/bin/gui. 

17.6.3 Monitor Archive Status Using ACSLS 

ACSLS provides the capability to monitor the Storagetek portion of the FSMS system. Although 
ACSLS does not keep track of data files, equipment and media status may indicate any problems 
in accessing the data. Table 17.6-2 provides a list of ACSLS software commands that are useful 
in monitoring the system. These are query commands that can be used to status specific items, 
or all in the category specified. These commands are accessed through the command procedure 
shell window of the ACSLS workstation. 

17-27 611-CD-510-001




Table 17.6-2. ACSLS Monitoring Commands 
query server all _display status of all servers 

query request all _display status of all request 

query volume all _display status of all volumes 

query drives all _display status of all drives 

query lsm all _display status of all lsms 

query cap all _display status of all caps 

query acs all _display status of all acs 

query port all _display status of all ports 

17.6.4 Monitor Insertion of Data into the Archive using DAS 

DAS provides the capability to monitor the status of the EMASS portion of the FSMS system. 
Table 17.6-3 provides a list of DAS Administration commands that are useful in monitoring the 
system. These are query commands that can be used to status specific items, or all in the 
category specified. These commands are accessed through the command procedure shell window 
of the DAS workstation or from the PC located on the AML. 

Table 17.6-3. DAS Monitoring Commands 
list _requests DAS to list currently 

active requests 

view _displays the status of a volume 

listd _display status of drives 

robstat _display or change status of robot 

qvolsrange _display list of accessible 
volumes within the specifies 
range 

17.6.5 Fault Notification 

The fault notification process in the archive begins with an error condition arising with software, 
hardware, or data related faults. The problem notification between the DIT and the DAM will 
most likely be verbal, although electronic notification may be necessary at times. 

The DAM or DIT will use the trouble ticket system available on site to officially notify the 
DAAC of warranted archive problems. The trouble ticketing procedures are found in the 
Problem Resolution section of the DID 611 document (section 8). The DAM or DIT may notify 
appropriate DAAC personnel while still in the error evaluation mode and before the trouble 
ticket creation process. This stipulation allows for the timely notification process to begin before 
an official document is issued. Table 17.6-4 presents the steps required to follow the fault 
notification process. If you are already familiar with the fault notification procedures, you may 
prefer to use this quick-step table. If you are new to the system, or have not performed this task 
recently, you should use the following detailed procedure: 
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1. Identify problem with the ingest, archive, or data distribution subsystems. 

2. Investigate error messages or problem indications. 

3. Notify DAM of problem via person, phone, or electronic means. 

4.	 DAM identifies and evaluates severity of problem. DAM must determine downtime 
and production impact, if any. Some problems may require a software reboot or 
simply putting damaged hardware off-line and continuing until servicing is possible. 

5.	 DAM investigates error messages or problem indications: software, hardware, data 
related. 

6.	 Evaluation should determine if the problem is repairable or if repair requires 
attention of the specified maintenance contractor. 

7. Solve problem if possible. 

8.	 Notify personnel deemed necessary if severity warrants via phone, in person or by 
electronic means (optional step). Some circumstances deemed severe enough may 
require notifications to DAAC staff in evaluation stage before a trouble ticket is 
created. This does not circumvent the trouble ticket process. It only allows for the 
repair effort process to start without addition downtime awaiting official notices. 

9. Create Trouble Ticket. 

10. DIT/ DAM officially notify DAAC of a problem and severity with a trouble ticket. 

11. Notify service personnel required to repair problem if appropriate. 

Table 17.6-4. Fault Notification-Quick-Step Procedure 
Step What to Do Action to Take 

1 DAM or DIT Identify problem with the archive system investigate error messages or 
problem indications 

2 DAM notified of problem oral, phone or electronic 
notification 

3 DAM identifies and evaluates severity of problem investigate error messages or 
problem indications: software, 
hardware, data related 

4 Repair problem in timely manner if possible Solve problem if possible 

5 Notify personnel deemed necessary if severity 
warrants (optional step) 

oral, phone or electronic 
notification 

6 DIT/ DAM officially notify DAAC of a problem and 
severity 

Create Trouble Ticket in Remedy 
and or DDTS 

7 Notify service personnel required to repair problem if 
appropriate. 

Notify appropriate personnel 
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17.6.6 Recovery from Failure to Store or Retrieve Data 

When a storage failure occurs, the request is failed and the reason for failure is returned to 
SDSRV. The Storage Management Control GUI as well as AMASS commands and utilities 
permit the operator (e.g., Data Ingest Technician) to review the error messages. The operator can 
also monitor system tail logs in UNIX windows in order to track storage activity. For AMASS 
based archives, the most likely cause of a failure will be file copy errors due to network 
problems, mount point problems, AMASS being down, or failure to associate a volume group 
with a directory in the AMASS cache. AMASS will not report write errors even if all of the 
drives are off-line. Only when there is no media in AMASS will a write error be reported. Table 
17.6-5 presents the steps required to follow the fault notification process. If you are already 
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the 
system, or have not performed this task recently, you should use the following detailed 
procedure: 
1. Login as amass or root and enter the password 

• Remember that your password is case sensitive. 

2. Use the amassstat command to determine if AMASS is running. 

3. Use the amass_log script and SYSLOG to display AMASS errors. 

• The amass_log script is located in the /usr/amass/tools directory. 

•	 The SYSLOG is located in the /var/adm/ directory. It may be necessary for the 
operator to look at the syslog on the host where the file is located to see if there are 
error messages which may explain the failure to access a file. 

•	 Each AMASS entry in the system log file has a date and time stamp. Several days‘ 
worth of messages may exist in the log. When reviewing the output to determine if 
any of these messages might indicate the cause of the problem, make sure that the 
messages being looked at are for the correct date and time. 

4.	 See the “Error Messages” in the appendix of the AMASS System Administrator’s Guide, 
Version 4.9, for probable causes and possible solution to the problem. The AMASS 
document can be viewed using Adobe Acrobat and is available electronically on servers 
g0drg01 and g0drg02 in /usr/amass/books. 

5. After the corrective action has been performed, see if the problem is corrected. 

6.	 If the problem persists further problem diagnosis should be attempted starting with the 
procedures below in sections 17.6.6.1 (Write errors) or 17.6.6.2 (Read errors). 
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Table 17.6-5. Recovery from Failure to Store or Retrieve Data Quick-Step 
Step What to Do Action to Take 

1 amass or root press Enter 

2 amassstat press Enter 

3 amass_log press Enter 

4 Correct the problem 

5 Verify correction 

17.6.6.1 Diagnoses and Investigation of Write Errors 

Write errors to the archive should be infrequent. If the archive is a robotic library which is 
fronted by the AMASS software, error messages in /var/adm/syslog will show the error messages 
from the AMASS software. If the archive is a disk based archive, then the software will receive 
the write errors and report them via operator notification and MSS error logging. 

17.6.6.1.1 Causes of Write Errors 

With AMASS 

AMASS off-line  - software will capture the error and log this since the directory that is being 
written to will not exist. However, the nature of the write error will not be detected. 

All Drives off-line - Cache space will fill up, write requests will be accepted but, all new data 
sent to cache will not be captured. The data transfer requests hang and do not return an error. 
Current code does not allow for detection of this condition. Write requests to AMASS can not 
be killed. The operator will have to diagnose this condition after being notified by Tivoli that 
AMASS drives are off-line or by noticing problems while looking at the log files. 

No media associated with the directory - will cause a write error which is detectable by the 
software. The nature of the error will not be detected. 

Without AMASS: 

Disk Partition Filled up - software will capture this condition although the error condition will 
not be known. 

With or without AMASS 

Directory does not exist - will cause a write error 

Undetected write errors 

AMASS: media write failure  - will cause the drive to go off-line and the media volume to go off­
line as well. The error will be written to /var/adm/syslog. No error will be detected by the 
application software. The operator can execute a /usr/amass/bin/drivelist to see which drive has 
been put off-line. 
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17.6.6.2 Diagnoses and Investigation of Read Errors 

When a read error is encountered by AMASS, both the drive and the tape will be taken off-line. 
The application will be notified of the read failure. The Archive Server will log an error message 
when the read failure is returned. The log message will include the name of the file, the 
secondary path for the file, the checksum for the file, and a reason for the failure. If the reason 
for failure is a checksum mismatch on retrieval, then the file will have to be restored. If the 
reason for failure indicates the media was off-line, then further investigation will have to take 
place to determine why the tape was off-line. This could be the result of a write error, a read 
error on the file, or a read error on a another file that caused AMASS to take the tape off-line. 
For a tape that is off-line, visual inspection or more likely, the need to have vendor maintenance 
remove the media from the drive, will indicate that a tape is damaged. Any requests for files on 
that tape will fail or be served from backup. It will be important that the list of files that will be 
created for restoring a tape from backup be kept and searched when new files are reported 
missing. This should reduce the number of times that certain procedures have to be performed. 

This operations concept builds on the operations concept for reviewing a read error in the first 
case, and the concept of determining which file was damaged in a situation where data has been 
recovered from damaged tape. 

17.6.6.2.1 File was not successfully retrieved 

1.	 The operator will be notified of Retrieval errors on the STMGT GUI (NCR 16497), the 
reason for the failure, and the file path for which the file was accessed. 

2.	 The operator will use the path and filename to get the volume id by using the AMASS 
command fileprint fullpathname. 

3.	 Once the tape is found, then a vollist given the volume id will indicate the state of the tape. 
If the tape is not active, then investigation using the AMASS logs will have to be done to 
determine if there was a drive error on the read which took the tape and a drive off-line. If 
the tape is on-line then the operator will have to determine the cause of the read error from 
the STMGT GUI. 

4. The Operator must now decide whether the effected tape is still useable or not: 

•	 In the event that the tape appears not to be physically damaged and only a small number 
of files on the tape have reported read failures recovery of those files alone can be 
attempted. This should use the procedure “Data Recovery Procedure for Known Files” in 
section 17.9.2.2. A small number of files from more than one tape may also be handled 
together at this stage. 

•	 Alternatively if the tape is visibly damaged or is suffering multiple read failures recovery 
of the entire tape can be attempted. This should use the procedure “Data Recovery 
Procedure for an Entire Tape” in section 17.9.2.1. 
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17.6.7 Deleting Files From the Archive using the AMASS GUI 

Deleting files from the archive can be an automated process, with a window provided to show 
files available for deletion based on system requirements. The AMASS GUI provides a window 
that allows file deletions. For detailed instructions see AMASS document Using The AMASS 
GUI. 

17.7 Archive Backup 

AMASS gives you the ability to manage archive and backup applications from a variety of hosts 
on the network using one or more protocols and any backup solution that can write disk files, for 
example, tar or cpio. 

Because the online AMASS database is the database to the media contents of an AMASS 
volume set, it must be protected. AMASS provides an automated procedure to back up the 
database to a dedicated volume in the library. The backup process supports both full and partial 
backups and can be run either automatically by AMASS or manually by the system 
administrator. However, for standalone drives you must manually backup the database. Text to 
insert in 17.7/17.6.6: 

Archive data recovery and restoration requirements create backup tapes for storage at local as 
well as designated remote sites. The arrangement eliminates a single point of failure in data 
recovery and restoration for the individual DAACs. 

Operational staff create these tapes at regular intervals by the using manual commands or 
automated scripts. The backup procedure creates a tape for local storage in the archive and on­
site. The second backup transfers to tape for shipping or to a temporary file for transmit to the 
designated off-site storage location. 

GDAAC sends its backup data to a location at Goddard, but separate from the GDAAC. 

Backup data stores that data that which would be hard to reproduce if needed. This data includes 
the following types: ancillary, metadata, algorithms, engineering, calibration, systems and 
application software, and selected other data depending on need. 

Because the above recovery functions are automated and can be executed from the startup script 
upon system reboot, the AMASS recovery, startup, and file system mount can all be done in the 
same fashion as the handling of other UNIX file systems. 

Archive data backup is largely an automated process. Automatic and manual backup and restore 
operations ensure data integrity and safety. Backups are called on automatically to satisfy Read 
requests where the Read from Primary has failed. As a clarification of terms, backup is used in 
two contexts. 

The first context involves a fully automated process and is set up by the System Administrator 
via a cron job. This process backs up the AMASS database with options, full (File System Index 
and Journal Files) or partial (Journal Files only) database backup. This same process can also be 
duplicated using a AMASS software command. This process backs up the AMASS database at 
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the operators convenience or when necessary for performing maintenance or troubleshooting on 
the system. 

A second context of backup pertains to the backup of actual archive data. This data is selected 
for backup by the severity of efforts to recover in event of its loss. This data is saved in the 
archive, saved to a local site, and saved to a remote site. This replication is essential to data 
safety. 

The actual data backup is performed with the custom software provided or by manual operations. 
The custom software automatically backs up selected data types. Configured software will 
transfer the backup data simultaneously with the actual data transfer to the archive parent volume 
or store the data in cache for a later transfer to backup volumes. 

The Activity Checklist depicted in Table 17.7-1 provides an overview of archive data backups. 
Column one (Order) shows the order in which tasks should be accomplished. Column two 
(Role) lists the Role/Manager/Operator responsible for performing the task. Column three 
(Task) provides a brief explanation of the task. Column four (Section) provides the Procedure 
(P) section number or Instruction (I) section number where details for performing the task can 
be found. 

Table 17.7-1. Archive Data Backup- Activity Checklist 
Order Role Task Section 

1 DAM/DIT/SA AMASS Database Backup (I) 17.7.1 

2 System 
Administrator 
(SA) 

AMASS Automated Backup (I) 17.7.1.1 

3 DAM/SA AMASS Manual Backup (P) 17.7.1.2 

4 DAM/SA AMASS Database Manual Restore (P) 17.7.1.3 

5 DAM/SA ACSLS Database Backup and Restore (P) 17.7.2 

6  DAM Backing Up Archive Data (I) 17.7.3 

7 DAM Generate List of Data to be Backed Up (P) 17.7.3.1 

8 DAM/SA Creating Local Backup Tapes (P) 17.7.3.2 

9 DAM/SA Creating Off-Site Backup Tapes (P) 17.7.3.3 

17.7.1 AMASS Database Backup 

AMASS software provides two backup procedures. One, fully automated, performs a full 
backup on the first day of each month along with selectable full or incremental backups at 
regular intervals set by the system administrator. The current setup initiates a partial backup 
every evening at 2 a.m. A selection of a full backup involves Journal and File System Index files. 
The second procedure is partial backup involving only Journal files. 

17-34 611-CD-510-001




The AMASS software also provides a manually performed backup procedure, amassbackup that 
performs the same functions as the automated backup except with manual intervention. 

17.7.1.1 AMASS Automated Backup 

The online database of AMASS needs protection. It is the index to the media contents of the 
AMASS volume sets. This procedure performs automatically without outside intervention. The 
Systems Administrator can modify the frequency of these backups and add partial backups for 
another time by changing the cron job which initiates the backup. 

17.7.1.2 AMASS Manual Backup 

This second procedure involves logging into AMASS and commanding the backup script, 
amassbackup, which utilizes either full or partial options. This command also includes 
capability to transfer to a tape device or to a designated archive volume. Since the system 
performs the automated backup without intervention, only the second procedure is be described 
below. 

This backup procedure utilizes a backup volume or tape device. Please note that both methods 
only back up the File System Index and Journal files. If you are already familiar with the 
procedures, you may prefer to use the quick-step table. If you are new to the system, or have not 
performed this task recently, you should use the following detailed procedure: 

1.	 At the UNIX prompt, type amass or root and enter the password. 

• Logs you into AMASS 

2. Enter AMASS command: 

amassbackup [-fv] 

Table 17.7-2. AMASS Backup Command-Quick-Step Procedure 
Step What to Enter or Select Action to Take 

1 amass or root press Return 

2 amassbackup [-fuv] [-d tapedevice] press Return 

Further explanation of the command is found in the AMASS System Administraors Guide. The 
AMASS guide can be viewed using Adobe Acrobat and is available electronically on servers 
g0drg01 and g0drg02 in /usr/amass/books. 

17.7.1.3 AMASS Database Manual Restore 

Restoring the AMASS database is a manual process which must be initiated by either the System 
Administrator or, the DAM. The AMASS database is restored using the AMASS command, 
amassrestore. The amassrestore command will restore the last full backup, the last partial backup 

17-35 611-CD-510-001




and all journal transactions that occurred since the last backup. Upon execution, the amassrestore 
command will create a sub-directory under filesysdb called journal. All restored files will be 
copied to the journal directory. 

This restore procedure utilizes a backup volume or tape device. Please note that both methods 
only restore the File System Index and Journal files. If you are already familiar with the 
procedures, you may prefer to use the quick-step table. If you are new to the system, or have not 
performed this task recently, you should use the following detailed procedure: 

1.	 At the UNIX prompt, type amass or root and enter the password. 

• Logs you into AMASS 

2. Enter AMASS command: 

amassrestore [-fuv] 

Table 17.7-3. AMASS Backup Command-Quick-Step Procedure 
Step What to Enter or Select Action to Take 

1 amass or root press Return 

2 amassbackup [-fuv] press Return 

Further explanation of the command is found in the AMASS System Administrators Guide. The 
AMASS guide can be viewed using Adobe Acrobat and is available electronically on servers 
g0drg01 and g0drg02 in /usr/amass/books. 

17.7.2 ACSLS Database Backup and Restore 

The ACSLS databases are located on disk on SUN workstations; each library silo having it‘s 
own dedicated SUN. ACSLS provides a script to perform its database backup. This script is run 
from the ACSSA cmd_proc window. The ACSLS database should be backed up periodically. 
StorageTek recommends that you use bdb.acsss to back up the database to tape after any of the 
following conditions: 

• Running acsss config 

• Importing or converting the database. 

• A significant number of enters or ejects. 

• A large number of scratch mounts. 

• A significant number of volume state changes, such as from scratch to data or from 

locked to unlocked. 

• Any database recovery. 
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You can only use backups created by bdb.acsss to restore the ACSLS database and you must use 
rdb.acsss to restore it. Similarly, you can only use the db_export.sh, and db_convert.sh database 
utilities to export, and convert/import, the ACSLS database. For more information on exporting 
and converting the ACSLS database refer to the ACSLS Installation and Configuration Guide. 

To ensure that you recover an accurate and consistent database, always use the most current 
database backup. 

After you upgrade to a new version of ACSLS, do not use database backups or exports created 
with previous versions. Make sure, however, to create a new backup as soon as you have 
upgraded. 

Use the bdb.acsss utility to back up the ACSLS database. 

When the server disk that contains the database reaches a predefined limit, ACSLS automatically 
creates a checkpoint backup file to disk. You should also, however, periodically run the 
bdb.acsss utility to manually create checkpoint files (especially to create tape backups that can be 
stored offsite). During ACSLS operations, transactions with the library create redo log files. 
Table 17.7-4 describes the database checkpoint and redo log files. If the database fails, you can 
recover the database using the rdb.acsss utility. Retain all utility event logs. These logs will help 
StorageTek to resolve any problems. 

Table 17.7-4. Checkpoint and redo log files. 
File Type Definition and Use 

checkpoint files Provides a point-in-time snapshot copy of 

the entire database 

redo log files Transaction records of database changes 
made since the last checkpoint. 
During database recovery using rdb.acsss, 
these files are applied sequentially to the 
checkpoint to re-create the database including 
all transactions since the checkpoint. 

17.7.2.1 ACSLS Database Backup Script 

If you are already familiar with the procedures, you may prefer to use the quick-step table. If 
you are new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1.	 Log in as acsss and enter the password. 

• Logs you into acsss 
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2. Load tape into backup drive. 

3.	 If you enter bdb.acsss with no options, the backup utility defaults to the default tape 
device attached and configured to the ACSLS server. At acssa prompt, enter: 

• bdb.acsss 

• The bdb.acsss utility backs up the ACSLS database and miscellaneous library 
resource files. 

4. For backup to a specific drive or file; enter the utility and options: 

_ bdb.acsss [-f filename or tape~device] [-o] 

• -f tape_device 

specifies any tape device attached and configured to the ACSLS server. 

• -f filename 

specifies a UNIX file to contain the ACSLS database. You must have write 
permissions to the file. 

• -0 is ignored; provided for compatibility with previous 11 ACSLS versions. 

Table 17.7-5. Create ACSLS Back Up - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 acsss press Return 

2 bdb.acsss  [-f db_file I tape~device] [-o] press Return 

17.7.2.2 ACSLS Database Restore Script 

ACSLS provides the rdb.acsss utility to restore the database in case of severe disk or data 
problems. Provided you have made regular backups, you should be able to restore the database 
with little or no loss of data. It will probably be necessary to restore the database in any of the 
following situations: 

• After a system crash. 

• Anytime the database can not be started. 

• Anytime there is a physical or logical error in the database. 
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If you are already familiar with the procedures, you may prefer to use the quick-step table. If 
you are new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1. Log in as acsss and enter the password. 

• Logs you into acsss 

2. Load the restore tape into backup drive. 

3.	 If you enter bdb.acsss with no options, the backup utility defaults to the default tape 
device attached and configured to the ACSLS server. At acssa prompt, enter: 

rdb.acsss 

•	 The rdb.acsss utility restores the ACSLS database and miscellaneous library resource 
files. 

4. To restore from a specific drive or file; enter the utility and options: 

rdb.acsss [-f filename or tape~device] [-o] 

• -f tape_device 

specifies any tape device attached and configured to the ACSLS server. 

• -f filename 

specifies a UNIX file to contain the ACSLS database. You must have read 
permissions to the file. 

• -0 is ignored; provided for compatibility with previous 11 ACSLS versions. 

Table 17.7-6. Create ACSLS Restore - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 acsss press Return 

2 rdb.acsss [-f db_file I tape~device] [-o] press Return 

17.7.3 Backing Up Archive Data 

During normal operations, data will be backed up automatically to volume groups according to 
parameters set in the ESDT. When an ESDT is loaded into the system, part of the information 
that is given is the Archive Id, Backup Archive Id, and off-site id. The Archive Id and Backup 
Archive Id dictate where the file will be stored for the primary and backup copies. Backup 
Archive Id and off-site id may be empty strings, in which case no backup is done. 

The Archive Id and Backup Archive Id are both comprised of two parts: the server key and the 
logical volume group indicator. The server key is used by the code to attach to the correct 
archive server when data for the ESDT is ingested or acquired. The logical volume group 
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indicator is used by the archive server to write the file to the correct volume group in the archive. 
The off-site id is a three character id of the DAAC which is doing off-site storage for that ESDT. 
The software supports having the three character designation for the local DAAC be the off-site 
id. In this case, the file will be backed up to a volume group within the local archive. The 
STMGT operations GUI can be used to get information about the pathnames in AMASS that 
map to the different logical volume group identifiers. Logical volume group identifiers are also 
configured via the GUI. 

For various reasons however, it may be necessary to manually backup data. To backup specific 
data, the DAAC Archive Manager (DAM) will generate or will have generated for him/her a list 
of data types which are designated for local or off-site backup. At the time the files are archived 
they are written to specific volume groups which correspond to the specific data type(s). Only 
files belonging to the data type are written to the tapes in a specific volume group. Hence, by 
knowing which data types are designated for backup, the DAM can determine the tapes which 
should be backed up locally and for off-site storage. This can be accomplished using the AMASS 
administration vollist command. The DAM can determine how many tapes must be backed up 
by using this command. 

If there are other files designated for local and off-site backup which have not been written to a 
specific volume group, the DAM can use the appropriate AMASS administration commands, 
dirfilelist and/or volfilelist, to locate the appropriate archive volume which contains the 
designated archived files. 

For more information about these AMASS commands, refer to the AMASS System 
Administrators Guide. The AMASS guide can be viewed using Adobe Acrobat and is available 
electronically on servers g0drg01 and g0drg02 in /usr/amass/books. 

17.7.3.1 Generate List of Data to be Backed Up 

Certain volume groups are dedicated for storing backup data. Using the AMASS administration 
commands and UNIX utilities, the DAM generates a sorted list of files contained on each volume 
in a backup volume group. It is important to sort the list by volume number to minimize the 
number of volume mounts and dismounts. The sorted list is edited to remove files which are not 
desired to be backed up. 

Table 17.7-7 presents the steps required to generate a list of data to be backed up. If you are 
already familiar with the procedures, you may prefer to use this quick-step table. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 

1. At the UNIX prompt, type; amass or root and enter the password. 

• Logs you into AMASS. 
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2.	 To generate a list of all files on a backup directory type: 
dirfilelist pathname 
• pathname is the path of the backup directory i.e., /dss_stk2/modis/backup. 

3.	 To generate a list of the files on each volume, type: 
volfilelist volumenumber 

• The volume numbers used should be the ones designated for data backup. 

Table 17.7-7. Generate List of Data to be Backed Up - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 amass or root press Return 

2 vollist press Return 

3 volfilelist volumenumber press Return 

17.7.3.2 Creating AMASS Local Backup Tapes 

Using the output from section 17.7.3.1 as input, create local backup tapes using the appropriate 
UNIX commands to copy all of the files to a designated volume group. After creation of the 
backup tapes, remove the tapes from the AML if required. 

Although some backup volumes may be stored locally external to the Powderhorn LSM, most 
will be stored within a library silo. Table 17.7-8 presents the steps required to create a volume 
group to be used for the creation of local backup tapes. If you are already familiar with the 
procedures, you may prefer to use this quick-step table. If you are new to the system, or have not 
performed this task recently, you should use the following detailed procedure: 

1.	 At the UNIX prompt, type; amass or root and enter the password. 

• Logs you into AMASS. 

2. Create the subdirectory (if not already created) by entering the following: 
a)  mkdir /dss_stk1/vg22/local_backup/ 

•	 The directory above is only an example, actual directory structure is determined by 
the System Administrator. 

b) Press Return. 

3.	 Create a volume group and associate it with the subdirectory just created by typing: 
setvolgrp path volumegroup 

•	 Path is the full UNIX system path name of the directory whose directory tree is being 
assigned to the volume group. 
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•	 Volumegroup is a number between 0 and 2047 assigned to the volumes by the 
volgroup command. 

• Ex. setvolgrp /dss_stk1/vg22/local_backup 22 

4.	 The operator goes to the Configure tab in the STMGT GUI and selects the 
appropriate archive server. 

5.	 The operator then selects Add Volume Group and enters in the volume group 
identifier and the path for the volume group. 

6.	 The operator then selects Backup from the pull down menu at the top of the STMGT 
GUI and selects Setup. 

7. The operator sets the site id to be the three character specification for the local site. 

8.	 The operator has to then go into the STMGT database and update the off-site table 
with the volume group name that was created to hold the data that needs to be 
backed up for off-site storage. (GUI doesn‘t cover this yet, see System Administrator 
for help). 

9.	 Add tape volumes to the volume group as needed using the volgroup command or, 
enable the space pool for that volume group with the vgpool command. 

•	 For more information on using AMASS commands, see AMASS System 
Administrator‘s User Guide. The AMASS guide can be viewed using Adobe Acrobat 
and is available electronically on servers g0drg01 and g0drg02 in /usr/amass/books. 

Table 17.7-8. Create Local Back Up - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 amass or root press Return 

2 mkdir /dss_stk1/vg22/local_backup/ press Return 

3 setvolgrp path volumegroup press Return 

4 cp filename pathname press Return 

5 ADD volume group enter volume group 
identifier 

6 Select Backup/Setup 

7 Set id to be 3 character designation 

8 Update STMGT database backup table 
with volume group name 

9 Add tapes to volume group as needed volgroup / vgpool 
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17.7.3.3 Creating AMASS Off-Site Backup Tapes 

ESDTs whose files have to be backed up should have the backup archive id and off-site id 
configured in SDSRV at installation time. Since cross DAAC transfer of data is not supported 
in the current delivery, the off-site id should be the same as the local site. 

Using the output from section 17.7.3.1 as input, create the backup tapes using the following 
procedures. Table 17.7-9 presents the quick steps required to follow the procedure. If you are 
already familiar with the procedure, you may prefer to use this quick-step table. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 

1. At the UNIX prompt, type; amass or root and enter the password. 

• Logs you into AMASS. 

2.	 The operator creates a new volume group in AMASS. Create the subdirectory (if 
not already created) by entering the following: 
a) mkdir /dss_stk1/mode/offsite_backup/ 

•	 The directory above is only an example, actual directory structure is determined by 
the System Administrator. 

b) Press Return. 

3.	 Create a volume group and associate it with the subdirectory just created by typing: 
setvolgrp path volumegroup 

•	 Path is the full UNIX system path name of the directory whose directory tree is being 
assigned to the volume group. 

•	 Volumegroup is a number between 0 and 2047 assigned to the volumes by the 
volgroup command. 

• Ex. setvolgrp /dss_stkn/modis/ 

4.	 The operator goes to the Configure tab in the STMGT GUI and selects the 
appropriate archive server. 

5.	 The operator then selects Add Volume Group and enters in the volume group 
identifier and the path for the volume group. 

6.	 The operator then selects Backup from the pull down menu at the top of the STMGT 
GUI and selects Setup. 

7.	 The operator sets the off-site id to be the three character specification for the local 
site. 
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8.	 The operator has to then go into the STMGT database and update the off-site table 
with the volume group name that was created to hold the data that needs to be 
backed up for off-site storage. (GUI doesn‘t cover this yet, see System Administrator 
for help). 

9.	 Add tape volumes to the volume group as needed using the volgroup command or, 
enable the space pool for that volume group with the vgpool command. 

Table 17.7-9. Creating AMASS Off-Site Backup Tapes 
Step What to Enter or Select Action to Take 

1 amass or root press Return 

2 mkdir /dss_stk1/mode/offsite_backup/ press Return 

3 setvolgrp path volumegroup press Return 

4 Configure/Archive Server Select from STMGT GUI 

5 ADD volume group enter volume group 
identifier 

6 Select Backup/Setup 

7 Set id to be 3 character designation 

8 Update STMGT database off-site table 
with volume group name 

9 Add tapes to volume group as needed volgroup / vgpool 

17.7.3.3.1 Close out AMASS Off-Site Backup Volume Group 

Follow this procedure in the event that a different volume group is to be used for backup so that 
the original volume group can be exported. Table 17.7-10 presents the quick steps required to 
follow the procedure. If you are already familiar with the procedure, you may prefer to use this 
quick-step table. If you are new to the system, or have not performed this task recently, you 
should use the following detailed procedure: 

1. The operator repeats steps 1 and 2 from the procedure above. 

2.	 The operator selects Modify Volume Group and enters the logical volume group identifier 
for the off-site backup (may have to look up in the database) 

3.	 The operator enters the new path created in step 1 for the new path for the volume group 
identifier. 
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4.	 The old volume group can now be exported using AMASS commands. Remove volume and 
send to distribution for shipment. Along with the AMASS backup tape, a metadata file is 
exported to the off-site facility using vgexport. 

•	 For more information on using AMASS commands, see AMASS System 
Administrator‘s User Guide. The AMASS guide can be viewed using Adobe Acrobat 
and is available electronically on servers g0drg01 and g0drg02 in /usr/amass/books. 

Table 17.7-10. Create Off-Site Back Up - Quick-Step Procedures 
Step What to Enter or Select Action to Take 

1 amass or root press Return 

2 mkdir /dss_stk1/vg22/local_backup/ press Return 

3 setvolgrp path volumegroup press Return 

4 Select appropriate archive server from STMGT GUI 

5 Add volume group enter group identifier 
and path 

6 Select backup/setup 

7 Set off-site ID Enter 3 characters for 
local site 

8 Update off-site table with backup volume group 

5 Add volumes to group as needed volgroup, vgpool 

17.8 Media Quality Control 

The Archive Manager is responsible for the quality of data found in the archive. This 
encompasses not only getting quality data to the media, but also assuring this same data is 
available to users for a number of years. 

Each archive manager will have to develop the media QC schedules and methods depending on 
the needs of each DAAC. Each DAAC has its own production loads and special needs. 
DAAC’s with light loads can perform QC functions without impacting normal production 
timelines. DAAC’s under heavy loads have to take this into consideration when scheduling QC 
functions. 

The archive software provides command line instructions to access data such as; drive errors, 
databases that record when data is first recorded, when data is last retrieved, and number of 
times that data has been accessed by the users. Some AMASS commands which are useful for 
monitoring status and errors are: amassreport, adf, and drivelist. AMASS also provides scripts 
that can be run to view system logs such as amass_log and amass_snap. They can be used to 
ascertain if the data has problems or possibly degrading. For detailed information on these 
commands see AMASS System Administrator’s Guide. The AMASS guide can be viewed using 
Adobe Acrobat and is available electronically on servers g0drg01 and g0drg02 in 
/usr/amass/books. 
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The D3 tape media is new to the market, but indications are that the data will have a shelf life of 
at least ten years. This means that the oldest data will have to be periodically tested from the 
storage area as well as the physical archive itself. The object is to find a comfort range of data 
storage limits before tapes have to be copied to other media. 

If a tape resides off-line, the tape can be retrieved from storage and inserted into the archive to be 
copied to a volume group or copied to another media using an upcoming improvement to the 
volcopy command. This will have new tape to tape as well as disk to disk capabilities. 

It is important to realize the difficulty in recovering data and take the care to handle cartridges 
properly. If a cartridge shows physical damage, it should be removed from the archive or 
storage and assessed for damage before using. Drive safety is of extreme importance in the 
evaluation of tape usage. Physical breakage, cracks or visible problems with the tape outer 
cartridge should be carefully assessed. Cartridges should be free of dust, dirt and moisture. 

Damage to the physical tape; crinkles, scratches, tears, etc., are not a matter of ‘how bad is it’. 
Any of these warrant a tape not being loaded onto any drive. Damaged tape can wrap around of 
rollers and the heads causing considerable damage especially to the rotating heads of a drive. The 
following are instructions on handling of cartridges. 

The Activity Checklist depicted in Table 17.7-1 provides an overview of the Graphical User 
Interface section. Column one (Order) shows the order in which tasks should be accomplished. 
Column two (Role) lists the Role/Manager/Operator responsible for performing the task. 
Column three (Task) provides a brief explanation of the task. Column four (Section) provides 
the Procedure (P) section number or Instruction (I) section number where details for performing 
the task can be found. 

Table 17.8-1. Media Quality Control - Activity Checklist 
Order Role Task Section 

1 DAM/DIT Handling a Cartridge (I) 17.8.1 

2 DAM/DIT Inspecting a Cartridge (I) 17.8.2 

3 DAM/DIT Storing Environment for Cartridges (I) 17.8.3 

4 DAM/DIT Operating Environment for Cartridges (I) 17.8.4 

5 DAM/DIT Cleaning Cartridges (P) 17.8.5 

17.8.1 Handling a Cartridge 

The following instructions on handling a cartridge are to be observed in order to prevent 
cartridge tape damage: 

• Make sure the leader block is latched every time you pick up a cartridge. 

• Keep cartridges clean. 

•	 Inspect a cartridge each time it is used and never put a damaged cartridge into a 
transport. 
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• Do not expose the tape or cartridge to direct sunlight or moisture. 

•	 Do not expose a recorded cartridge to magnetic fields. Such exposure will destroy 
data on the tape. 

•	 Do not release a leader block and pull tape from a cartridge unless you are repairing 
the leader. 

• Do not handle tape that is outside the cartridge. The tape could be damaged. 

17.8.2 Inspecting a Cartridge 

Before a cartridge is loaded into a transport, look for the following problems: 

• Cracked or broken cartridge 

• Liquid in the cartridge 

• Dirty cartridge 

• Broken leader block 

• Broken leader block detent springs 

• Damaged write-protect selector 

• Gum label loose or extending over the cartridge edge 

Cartridges need a stable environment in order to last their full expected life. Unstable 
environment conditions such as bad temperature control and or humidity problems can degrade 
tapes being stored. These conditions can affect the binding between the oxide and backing of the 
tape. This allows the oxide to flake off the backing and leave gaps in the oxide surface which 
wholes the actual data stored on tape. 

Not only do you lose data but the flaking of oxide while running on a drive can effect the rollers 
control of tape motion. This can also lodge itself on spinning heads causing degraded read and 
write conditions. The following are basic rules for stabilizing the cartridge environment. These 
are standards found in the STK D3 Operators Guide. 

17.8.3 Storing Environment for Cartridges 

When storing cartridges: 

•	 Store cartridges in a clean environment. The preferred temperature for storage is 50C 
to 320C (400F to 900F) with a relative humidity of 40% to 60%. 

•	 Keep cartridge tapes in the operating environment for at least 24 hours before you use 
them. 

• Keep a cartridge tape in its protective wrapping until you are ready to use it. 
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17.8.4 Operating Environment for Cartridges 

When using the cartridges, the recommended temperature range is 150C to 270C (590F to 810F) 
with a relative humidity of 30% to 60%. 

Since the environment has a direct affect on the tape stability, following is a listing of the 
operational, storage, and device specific requirements found in Release B Environmental Control 
Plan for the ECS Project, 532-CD-002-00l. 

Environment Restraints 

Area / Device Temperature Humidity 

Computer Room 41-113 F (5-45 C) degrees 20-80 % 

Archive Room 59-77 F (15-25 C) degrees 30-70 % 

D3 cartridge /operating 60-90 F (16-32 C) degrees 20-80% 

D3 cartridge /storage 40-90 F (4-32 C) degrees 5-80 % 

EMASS AML/2 range 60-90 F (16-32 C) degrees 15-80% 

EMASS AML/2 recommended range 70-75 F (21-24 C) degrees 40-60 % 

STK Powderhom 60-90 F (16-32 C) degrees 20-80 % 

STK Redwood SD-3 drive 59-81 F (15-27 C) degrees 30-60 % 

The QC function involves the operational duty of cleaning tape drives. Tape drives need regular 
cleaning to ensure the inserted and retrieved data to the archive is of good quality. Tapes are 
subject to problems inherited from dirty drives. Dirty drives can leave hazardous material on the 
loaded tape or damage the tape due to the slippage or sticking of roller surfaces. ACSLS 
software automatically cleans the drives when each reaches the set usage time which is tracked 
by the software. Cleaning tapes are kept on each archive for this purpose. 

17.8.5 Cleaning Cartridges 

The main cause of errors on tape is debris embedded in the tape and dirty drive heads. To reduce 
the chance of a tape becoming corrupted, the FSMS employs cleaning tapes to regularly clean 
the drive heads. Cleaning tapes are unknown to the AMASS database to prevent them from being 
used as data tapes. The STK Redwood SD3 helical scan tape drives are pre-set by STK to 
request a cleaning tape after 100 hours of head use. A cleaning tape has a set number of times it 
can be used before ACSLS will not use it anymore. The current value is set to 10. This value can 
be changed using the set clean command. There will be times when the operator wants to clean 
drives between this cycle. The ACSLS command mount allows the operator to load cleaning 
tapes to drives to perform this function. The following procedure lists the steps to clean a drive. 
If you need further information refer to the ACSLS System Administrator’s Guide. Table 17.8-2 
presents the steps required to follow the process. If you are already familiar with the procedure, 
you may prefer to use the quick-step table. If you are new to the system, or have not performed 
this task recently, you should use the following detailed procedure: 

1.	 Enter an ACSSA window on a SUN Workstation: 
Login as acssa and enter password 
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• ACSSA mode entered and cmd_proc window opened. 

2.	 Load a cleaning tape to the desired drive. 
Type: mount vol_id drive_id where vol_id is the volume id of the cleaning tape and 
drive_id is the id of the drive to be cleaned. 
• The cleaning tape is loaded to the specified drive and the cleaning tape cleans the 

heads upon tape mount. 

3.	 Dismount the tape from the drive. 
Type: dismount vol_id drive_id 
• The tape is dismounted and placed in it‘s home slot. 

4.	 Perform this step only if you want to change the number of times a cleaning tape 
can be used. Type: set clean max_usage vol_id where max_usage (e.g. 10)is the 
maximum number of uses for that volume and vol_id is the volume id of that 
cleaning cartridge. 

Warning 

Please note that the command line instruction ,Volclean, actually erases 

data from the tape and is not for the purposes stated in the above text. 

Do not confuse the terms. 

Table 17.8-2. Cleaning Cartridges 
Step What to Do Action to Take 

1  acssa press Enter 

2  mount vol_id drive_id press Enter 

3 dismount vol_id drive_id press Enter 

4  set clean max_usage vol_id press Enter 

17.9 Archive Data Restoration after Failure 

This section deals with the permanent restoration of Archive data primary copy where it has been 
otherwise permanently lost or corrupted. It does not deal with the real-time use of backup data, 
where it exists, to satisfy Read requests for which the Read of the primary file has failed. That 
process happens automatically and is covered in section 17.7. 

Whilst the Archive hardware is highly reliable errors e.g. due to tape or drive failure must be 
expected to occur albeit at an extremely low rate as a function of the archived data volume. 
Where errors have occurred and data has been lost from the archive and can not be restored from 
backup there may exist the potential to recover and re-archive equivalent data by one of the 
following means: 
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copying from backup onto the original or a new primary, 

replacing damaged or corrupted volumes with vendor restored or backup volumes, 

re-generation by reprocessing, 

obtaining replacement data from the original external provider. 

This section defines the procedures to follow for such data recovery. Details of technical actions 
are presented in the enclosed or referenced sub-procedures. This section does not deal with 
restoring the AMASS system database which is described in section 17.7.1.3. 

The procedure described can be performed for a single file, or for multiple files. It is expected 
that for a single or small number of files the files to restore will be the result of failed file Read 
requests for which the entry point to these procedures is section 17.9.2.2. Recovery of large 
numbers of files may be required, for example, after failure of an entire tape. For this the 
procedure starting point is 17.9.2.1. 

The Activity Checklist depicted in Table 17.9-1 provides an overview of archive data restoration. 
Column one (Order) shows the order in which tasks should be accomplished. Column two 
(Role) lists the Role/Manager/Operator responsible for performing the task. Column three 
(Task) provides a brief explanation of the task. Column four (Section) provides the Procedure 
or Instruction section number where details for performing the task can be found. 

Table 17.9-1. Archive Data Recovery/Restoration - Activity Checklist 
Order Role Task Section 

1  DAM Manual Data Recovery from Damaged Cartridge 17.9.5 

2 DAM/SA Manual Data Recovery from Local Backup Tapes 17.9.4.1 

3 DAM/SA Manual Data Recovery from Off-Site Backup 
Tapes 

17.9.4.2 

4 DAM/DIT Data Re-Generation or Re-Supply 17.9.2.3 

17.9.1 Data Recovery Process Overview 

For the specific procedure steps for data recovery see section 17.9.2. This section should be used 
as a guide and overview of the process only. 

Data re-generation and re-ingestion are not purely Archive internal activities and hence this 
process involves other ECS sub-systems, namely the SDSRV and PDPS as well as STMGT. The 
storage device vendor, (Storage Technologies Inc., known as Storage Tek or STK) , is also 
involved. 

Storage Tek offer a service to recover remaining good blocks on tapes which have started to fail. 
Use of this service is the first step to recover entire tapes. 

Storage Management (STMGT) is the point of failure detection in the event of data loss from the 
ECS archive. STMGT, as part of DSS, deals with data only as named files. 
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Science Data Server (SDSRV) manages the ECS metadata inventory. The inventory database 
relates archive files with the ECS data "granules" of which they are part. ECS sub-systems other 
than DSS manage data in terms of granules and hence must manage data loss and replacement 
likewise. SDSRV is used, within this process, to serve STMGT with archive 'volume IDs' and 
file checksums and to serve PDPS, with metadata defining the granules related to lost files. 

The Planning and Data Production System (PDPS) manages production within the DAAC. PDPS 
plans and runs PGEs as DPRs (Data Processing Requests) the outputs of which are new granules 
which are stored in the archive. Where lost archive files were from granules generated within the 
local DAAC PDPS may be able to re-generate them by repeating the appropriate DPRs, 

For the purposes of overview only the following define the major tasks of each ECS sub-system 
in recovery of lost archive data. 

Archive (STMGT): 

1. Detect the failure, i.e. of a drive or tape. 

2.	 Optionally attempt to recover files still readable from the effected tape(s), e.g. up to the point 
of physical failure. 

3.	 Interface to SDSRV to determine location and checksum metadata for files effected by a 
failure (using the "Effected File List"). 

4.	 Interface to Storage Tek for recovery of files on the tape where possible by application of 
their (Storage Tek’s) in-house procedures. 

5. Verify correctness of files thus recovered using checksums. 

6. Recover additional files from local and remote tape backups where applicable. 

7.	 Pass to second SDSRV procedure list of residual files lost and not recovered (using the "Lost 
File List"). 

Archive (SDSRV): 

1.	 Service STMGT requests for file details for recovery from backup and post file recovery 
verification (SDSRV sub-procedure "SDSRV Retrieval of File Location metadata for 
STMGT"). 

2. Determine list of Granules effected by otherwise permanent file loss, from "Lost File List". 

3.	 Determine Granules which can potentially be replaced by re-generation by PDPS based on 
retrieving a valid local Production History (PH) file UR for the Granule. 

4.	 Retrieve metadata for such granules required by PDPS, including PH UR, and pass to PDPS 
(using the list "Granules for PDPS Re-Generation"). 

5.	 Return list of remaining granules effected by file loss to the calling procedure ("Residual 
Granules to Recover"). 
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PDPS (PLS): 

Search for and then Acquire from SDSRV the actual PH granules (tar files) related to the 
granules to be re-generated. 

Extract from those PCFs the parameters of the lost granules production and create corresponding 
new Production Requests (PRs) for granule re-generation using them. 

Verify that resulting PRs can and should be run (e.g. version of lost data justifies regeneration; 
applicable version of PGE is 'qualified' for operational version of ECS etc.). 

Insert resulting PRs into production plan sequenced as necessary (e.g. regeneration of lost 
granule 'B' may be dependent on earlier regeneration of lost granule 'A'). 

Activation of the resulting plan then leads via the normal PLS/DPS production process to granule 
regeneration and insertion. 

Return list of any granules not re-generatable by this instance of PDPS to the calling procedure 
(as "PDPS Residual Granules"). 

17.9.2 Data Recovery Process 

For an overview of the procedures referenced from this section and their interfaces see 
Section 17.9.1. The entry point to these procedures is usually from the analysis of Read errors in 
Section 17.6.6. 

17.9..2.1 Data Recovery Procedure for an Entire Tape 

This procedure is to be utilized when an entire tape has been damaged or corrupted such that it 
has had to be removed from the Archive and can not be re-inserted ‘as-is’. The aim of the 
procedure is to recover or regenerate as much of the tape’s contents as possible. 

Note that at this point specific failed Read requests against files on the tape which have backups 
will have been satisfied by the read of the backup data. This procedure therefore has only to be 
concerned with permanently recovering the primary copy of such backed up data, not with 
satisfying pending Read requests. 

1.	 Execute the Archive (STMGT) procedure for Manual Data Recovery from Damaged Tape in 
section 17.9.5. That procedure includes use of the SDSRV procedure for “Retrieval of File 
Location Metadata” (17.9.6.1), the Storage Tek tape recovery procedure and optionally an 
attempt to directly recover data from the beginning of the failed tape to the point of first 
failure. 

2.	 As output of the above step the operator must have the following information and should use 
it as input to the “Data Recovery Procedure for Known Files” 17.9.2.2: 

•	 the output of the SDSRV “Retrieval of File Location Metadata” procedure (17.9.6.1) which 
will contain a list of all files originally on the failed tape, their Archive IDs (primary and 
backup and off-site if applicable) and, 
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•	 a list of those files remaining to be recovered i.e. which were not successfully recovered 
within the scope of step 1. (e.g. which did not pass checksum verification on the tape 
returned by Storage Tek). 

17.9.2.2 Data Recovery Procedure for Known Files 

This procedure can be executed for residual files not recovered within the —Data Recovery 
Procedure for an Entire Tape“, 17.9.2.1, or for any other individual or set of known files which 
need to be recovered. 

As part of the input to this process the Operator needs the following information for each file to 
be recovered: 

the file “Archive unique filename”, 

ArchiveIDs i.e. primary plus local and off-site backup ArchiveIDs if valid, 

file checksum. 

The above data are either supplied by the preceding process or can be generated for a list of files 
using the SDSRV procedure “Retrieval of File Location Metadata” (17.9.6.1). 

For all files for which a backup exists, as indicated by the backup Archive IDs, the procedures 
(local and off-site) for “Manual Data Recovery from Backup”, 17.9.4 should be attempted. 

Files thus recovered should be removed from the list of remaining files. For remaining files re­
generation of the effected Granules can now be attempted. This is achieved by the following 
steps. 

Using the list of remaining files as input execute the SDSRV procedure “SDSRV Retrieval of 
Granule Production History Metadata” in section 17.9.6.2. This will output a file of metadata 
related to the specified files which is needed by PLS to re-generate the equivalent granules. 

Pass the output of the above step to the PDPS/PLS process to “Re-Generate Granules Effected 
by Loss of Files from the Archive” in section 13.1.6 of this document. That procedure will result 
in the generation of new Production Requests to replace locally generated granules. 

The PDPS/PLS procedure will also generate a list of “PDPS Residual Granules”. The SDSRV 
procedures may also return Granules with no known Production History. All these are Granules, 
related to the lost files, which cannot be recovered within the above procedure steps. They 
should be input to the procedure following for “Recovery of Granules from other sources”. 

17.9.2.3 Recovery of Granules from other sources 

Residual Granules from the procedure for “Data Recovery Procedure for Known Files”, 17.9.2.2, 
represent granules not recovered by the above described procedures. These should fall into the 
following classes: 

• data to re-ingest, 
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• granules remotely inserted/acquired from another DAAC, 

• granules for which re-generation has been deemed unnecessary, and 

• errors in the recovery process. 

The residual granule lists should be concatenated and passed in turn through the following sub­
procedures. 

17.9.2.3.1 Sub-procedure: Data to Re-Ingest 

1.	 Based on ESDT ShortName INS or Archive Operators must select from the list those lost 
granules which were input into this DAAC via the INS. 

2. The resulting list of Ingested Granules should be sub-divided by data source. 

3. 	 With reference to the applicable ICD and using the Granule metadata from the list (as 
generated by SDSRV or PDPS) the required data re-supply requests should be initiated as per 
the ICD defined re-supply process for those data suppliers able to re-supply data. 

4.	 Note that some data suppliers, e.g. Landsat-7 have decided not to support such re-supply of 
data. 

17.9.2.3.2 Remotely Inserted Granules 

Remote Insert of granules is a special case for Granule recovery because they have been 
Archived at a DAAC other than the producing DAAC and (generally) not archived at the 
producing DAAC. Note that Remote Insert of granules is not supported in the applicable 
versions of ECS (Drop 4). However the following procedure should serve to recover them when 
applicable: 

1. 	 The procedure is as for locally produced granules up to this point, i.e. the non-locally 
produced granules will be identified in the output of the SDSRV procedure (“SDSRV 
Retrieval of Granule Production History Metadata”) as known to the local SDSRV but 
without an associated PH granule. 

2.	 Divide the residual granules list by ESDT ShortName and identify those granules which are 
remotely Inserted i.e. supplied to this DAAC by other DAACs. 

3. By source DAAC forward the granule metadata lists to the source DAAC. 

4.	 At the source DAAC this list should be used as input to the PDPS/PLS procedure (“Re-
Generate Granules Effected by Loss of Files from the Archive” in section 13.1.6). This is 
necessary because currently for remotely Inserted granules the PH granule will be inserted at 
the producing DAAC only and not at the Archive DAAC. 

5.	 As a result the lost granule itself will not be found by the QA monitor search (within the PLS 
procedure) at the producing DAAC. To find the PH granule the operator must instead search 
on the short-name of another granule created by the generating PGE. Once the PH granule 
has been thus found the PLS process can continue to granule re-generation without variation. 
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Note that for remotely 
Acquired granules 
there is no issue of 

Archive recovery as 
these are granules 

Archived only at their 
producing DAAC but 
Acquired, as required, 
by processing at other 

DAACs. 

17.9.2.3.3 Permanently Lost Data and Errors 

Remaining granules effected by the archive tape failure and not recovered by one of the above 
means will fall into one of the following categories: 

•	 lost files which have, by design, been deleted from the SDSRV databases during this 
recovery procedure, 

•	 granules the re-generation of which was determined not to be necessary within the PDPS 
procedure, 

•	 Ingested granules which were not included in Archive backup or re-deliverable by the 
supplier (e.g. Landsat Level 0 data), 

•	 an error either in the recovery processes, actions or in system configuration e.g. in the 
configuration of backups. 

As an example in this final category the outputs of SSI&T should always be included amongst 
those files configured for automatic backup within the Archive. Where this is not the case and 
the primary copies are effected by Archive failure re-SSI&T of the effected PGEs will be 
required. 

In addition it is essential that granules which are necessary inputs to the recovery process itself, 
e.g. the Production History (PH) as input to PLS re-generation, must be assigned to backed up 
volume groups. If PH granules are lost and not backed up then the science granules to which they 
correspond will not be re-generatable by PDPS. 

Compound failure of the archive backups may also result in a permanent data loss. 

17.9.3 Results of File and Granule Recovery 

The result of file or granule recovery are slightly different depending on whether the lost file was 
recovered, e.g. from backup, or the corresponding lost granule had to be re-Archived, e.g. after 
re-generation by PDPS. 
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Files which are recovered within the Archive/STMGT procedures are re-archived under the same 
name such that the effected granule(s) are restored as per before the failure. 

Where file recovery within STMGT control is not possible the resulting Granule recovery, e.g by 
PDPS re-generation or via-INS re-ingestion, results in the insertion of a new granule. This new 
granule will have a new UR and a new 'Production Date and Time'. Particularly where granule 
re-generation is required, i.e. by PDPS, exact re-production of the original granule (data byte-for­
byte) is not guaranteed. 

17.9.4 Manual Use of Backup Data for Recovery 

The following procedures present the steps required for manual use of local or off-site backup 
data for recovery. These procedures assume the backup data is available on tape. 

17.9.4.1 Manual Data Recovery from Local Backup Tapes 

The following procedure presents the steps required for manual data recovery from local backup 
tapes. This procedure assumes the tape is on-line and in the Powderhorn LSM. Volume groups 
and tapes are transparent to the automated file and storage management system. As long as the 
AMASS database is aware of the files, the operator moves data using standard UNIX commands. 
Table 17.9-2 presents the steps required to follow the process. If you are already familiar with 
the procedure, you may prefer to use the quick-step table. If you are new to the system, or have 
not performed this task recently, you should use the following detailed procedure: 

1. The operator goes to the STMGT GUI and uses the Configure tab. 

2.	 The operator chooses the Archive Server that is associated with the ServerKey portion 
of the Archive ID. Example: EcDsStArchiveServerDRP1 

3. The operator selects View Volume Groups. 

4.	 The operator clicks on the volume group identifiers that are specified for primary and 
secondary storage in the archive. 

5.	 Once the operator knows the location of the backup file and the location of the primary 
file, he/she can issue a copy command (or dd) from the Unix command line to copy the 
file from the backup version of the file to the primary version. 

6.	 If this recovery is one of a set of files to be restored, e.g. because they were lost from a 
damaged tape, files recovered from backup should be removed from the list of files to be 
recovered by other means. 
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Table 17.9-2. Manual Data Recovery from Local Backup Tapes 
Step What to Do Action to Take 

1  Configure Select from STMGT GUI 

2 Archive Server Select from STMGT GUI 

3 View Volume Groups Select from STMGT GUI 

4 identifiers Select from STMGT GUI 

5 Copy file to primary cp path path 

17.9.4.2 Manual Data Recovery from Off-Site Backup Tapes 

The following presents the steps required for manual data recovery from off-site backup. 
Initially, GDAAC off-site backup tapes will be stored at Goddard in another building. If in the 
future, backup data is sent to Langley, this document will be updated to reflect that procedure. 
Table 17.9-3 presents the steps required to follow the data recovery process. If you are already 
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the 
system, or have not performed this task recently, you should use the following detailed 
procedure: 

To determine whether or not the file exists in the tape library: 

1.	 The operator runs the AMASS fileprint command giving as input the filename and pathname 
into AMASS cache. 

fileprint <filepathname>. 

2.	 The output from fileprint will be a structure of information displayed on the terminal. The 
operator needs to check on the volume id. There may be two ids, in which case the file is 
split over volumes. 

3. The operator issues an AMASS vollist command giving the volume id as input. 

vollist <volumenumber> 

•	 If the volume is active and in a juke box (as displayed in the output from the vollist 
command), then the operator can move the file to the primary and secondary archive 
locations by following the same process as in the operations concept for restoring the file 
from the local backup (essentially this is a case where there are two local backups). 

•	 If the volume is inactive and not in a juke box (as displayed in the out put from the 
vollist command), then the operator will have to request the tape(s) from the off-site 
storage. 

4.	 After requesting and receiving the required data from off-site backup, mount the tape and 
bring it on-line. 

a) Insert the tape following procedures in section 17.10.1 STK Media Interface. 

• The AMASS database will have a record of the data. 
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5.	 Using an appropriate UNIX command, copy the file(s) from the off-site backup tape(s) 
to the correct archive directory. 

6.	 If this recovery is one of a set of files to be restored, e.g. because they were lost from a 
damaged tape, files recovered from backup should be removed from the list of files to be 
recovered by other means 

Table 17.9-3. Manual Data Recovery from Off-Site Backup Tapes 
Step What to Do Action to Take 

1 fileprint <filepathname>. press Return 

2 Check volume id Review fileprint 

3 vollist <volumenumber> press Return 

4 Mount tape Procedure 17.9.1 

5 Copy file(s) to primary directory cp path path 

17.9.5 Manual Data Recovery From Damaged Cartridge 

Manual recovery of AMASS generated data from the D3 cartridge will be necessary in the event 
that a tape volume becomes damaged. In the course of operations it is possible for a tape to 
become physically damaged or accidentally overwritten. Some indications of a damaged tape are 
AMASS read/write errors, or AMASS may determine the volume is unreadable and mark it 
inactive. In that event, a manual recovery of AMASS generated data from the STK Redwood 
(D3) cartridge must be attempted. 

Due to the technical complexity of the D3 tape recovery, it will be performed by STK personnel. 
A listing of all the files on tape and the associated start block numbers must be generated and 
provided to the recovery personnel in order to proceed with the recovery. The archive operator 
needs to invoke a perl5 utility script and respond to the scripted prompts. The utility will 
generate three ASCII files, that must be provided to the STK recovery personnel along with the 
damaged tape. The files are: filelist_volnumber, start_block_listing_volnumber, and 
README_volnumber, where volnumber is the volume number of the requested tape volume. 

The script utility, DsStFilesPerVolume, is located in the utilities directory. The script will 
initially output directory information followed by three files. 

Example directory information output: 

/data1/data/:BR:Browse.001:1170:1.BINARY 
/data1/data/:BR:Browse.000:1170:1.BINARY 
/data1/data/:SC:MOD00:65001:1.CCSDS 
/data1/data/:SC:MOD00:65002:1.CCSDS 
/data1/data/:SC:MOD00:20001:1.CCSDS 
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/data1/data/:PH:PH.001:2000000076:1.BINARY 
/data1/data/:PH:PH.000:2000000076:1.BINARY 
/data1/data/:QA:QA.001:1003:1.ASCII 
/data1/data/:QA:QA.001:1004:1.ASCII 
/data1/data/:QA:QA.001:1005:1.ASCII 
/data1/data/:OR:OR.001:2100:1.ASCII 
/data1/data/:OR:OR.001:2101:1.ASCII 
/data1/data/:OR:OR.001:2102:1.ASCII 
/data1/data/:OR:OR.001:2103:1.ASCII 
/data1/data/:AN:AN.001:3100:1.ASCII 
/data1/data/:AN:AN.001:3101:1.ASCII 
/data1/data/:AN:AN.001:3102:1.ASCII 
/data1/data/:AN:AN.001:3103:1.ASCII 

The three files produced by DsStFilesPerVolume are as follows: 

A readme file (README_TAPE_RECOVERY) 

A list of all files on the tape (filelist_v#) 

A list of file starting blocks on the tape (start_block_listing_v#) 

Where ‘#’ stands for the AMASS designated volume number being recovered. The ‘filelist_v#’ 
file output is in the form of one file name per line e.g. 

/dss_stk2/joel/TestStdSeq6_0_10.wrt 
/dss_stk2/joel/TestStdSeq6_0_10.wrt 
/dss_stk2/joel/TestStdSeq6_0_10.wrt 
/dss_stk2/joel/TestStdSeq6_0_10.wrt 
/dss_stk2/joel/TestStdSeq6_0_10.wrt 

If you are new to the system, you should use the following detailed procedure. If you are familiar 
with the system, you may prefer to use the quick-step table 17.9-4. 

1. Login as amass or root and enter the password 

2. Verify AMASS is running using the amassstat command. 

3.	 Run vollist and grep for the volume label in order to get the volume id. 
vollist|grep SG0003 

4.	 Remove the volume from the library using the voloutlet command. 
voloutlet volumenumber 

• AMASS will move volume to the Cartridge Access Port (CAP) and mark it offline. 

5.	 The DAM will inspect the physical cartridge and tape for damage, see section 
17.7.4.2 Inspecting a Cartridge. Any creasing, scratches, snapping, or stretching of 
the tape may warrant keeping the volume offline and sending it STK for 
replacement. 
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6.	 If the DAM determines that the tape is damaged, it is shipped to STK for recovery 
along the three files generated by the DsStFilesPerVolume utility script. In order to 
run the script you must be logged in as amass or root. 
a) To start the perl utility script, enter: 
/usr/ecs/mode/CUSTOM/utilities/DsStFilesPerVolume 

•	 You will be prompted to enter the AMASS volume number for which you wish to 
generate listings. 

a) Enter the volume number of the AMASS volume. 

• A message will display informing you when the listings are complete. 

b)	  (optional) If the tape is damaged towards the end of the tape, it will be possible to 
copy files from the tape using the start_block_listing_v(nn) file generated above. The 
file to be copied must first be renamed using the Unix mv command and the copied to 
the original filename ( mv a b; cp b a). It is important that the file remain within the 
volume group. Care must be taken while doing this procedure. Reading from the 
part of tape which contains the damaged area may cause damage to the drives. 
Recovering data in this manner will limit the amount of regeneration of data that may 
need to be performed. The list of files that are recovered should be kept so that 
further attempts to regenerate them will not be started. A copy of the list of files that 
need to be recovered should be kept as well so that any files which fail to be retrieved 
can be checked against the list first before investigation commences. 

7. Send the volume to STK along with the files generated by the perl utility. 

•	 STK will copy all uncorrupted data to a new tape and insert filler data blocks to 
replace the lost data. 

•	 The filler data is inserted using the original block sequence so that the remaining data 
can be accessed by AMASS. 

•	 After the data has been copied to a new cartridge, it is shipped back to the DAAC 
archive with the original volume label and a report indicating which data blocks were 
replaced with filler data. 

8.	 After receiving the recovered tape back from STK, load the tape into the library 
using the bulkinlet command: 
bulkinlet volgroupnumber 

• AMASS will read the volume label and place the volume in it‘s home slot. 

9.	 Put the volume online using the volloc command 
volloc -n volumenumber 
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10.	 Make the volume active using the volstat command 
volstat -a volumenumber 

11.	 Using the report provided by STK, determine which files have had data blocks 
replaced and delete those files from the database using standard UNIX commands. 
All such files must be recorded on a list of non-recovered files. 
rm filepathname 

12.	 If the DAM determines that the amount of dead space created on the tape exceeds 
the allowed threshold, the files can be copied to another volume within the volume 
group and the tape can be reformatted. See Recycle a Volume in the AMASS System 
Administrator’s User Guide. The AMASS guide can be viewed using Adobe Acrobat 
and is available electronically on servers g0drg01 and g0drg02 in /usr/amass/books. 

13.	 Once the tape has been returned from STK, the list of files that are on the tape (i.e. 
the file ‘filelist_v#’ described above) must be used as input to the SDSRV procedure 
for “Retrieval of File Location Metadata”, as specified in section 17.9.6.1, to recover 
the ArchiveIDs and checksum for each file. 

14.	 These checksums, and other STK output if available, are then used to validate the 
files on the returned tape. All files which fail these tests must be deleted as described 
in point 11, above. They must also be added to the list of non-recovered files. 
•	 For files with a non-zero checksum returned by SDSRV the checksum of the 

recovered file must be validated with the Unix command ‘cksum’ i.e. 
cksum filepathnam 
This command returns one line with three parameters per input file. The file 
checksum is the first column. For all files where the returned checksum does not 
match the SDSRV generated checksum the file has failed the checksum test and 
must be deleted. 

•	 For remaining files, for which the SDSRV returns a checksum of zero, the 
checksum can not be use to verify validity of the file on the returned tape. If 
STK have supplied information detailing the corrupt blocks on the tape then 
that may be used with the data in the “start_block_listing_v#” file to determine 
which of the files have been corrupted and the remaining files recovered. 
Alternatively all zero checksum files should be assumed to be corrupted and not 
recovered, i.e. they must be deleted. 

15.	 The list of non-recovered files then serves as input to subsequent file recovery by 
other means, i.e. as specified in section 17.9.2.2. 
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Table 17.9-4. D3 Cartridge Data Recovery - Quick-Step Procedures 
Step What to Enter or Select Action Taken 

1 amass or root press Return 

2 amasssstat press Return 

3 vollist|grep SG0003 press Return 

4 voloutlet volumenumber proceed to step 5 

5 Check for Physical tape damage Tape Damage ? 
Y- run DsStFilesPerVolume script 
N- Enter cartridge into archive 

6 ship to STK with files 

7 bulkinlet volgroupnumber press Return 

8 volloc -n volumenumber press Return 

9 volstat -a volumenumber press Return 

10 rm filepathname proceed to step 5 

11 Run SDSRV procedure 

12 Send retrieve request to SDSRV 

17.9.6 SDSRV Procedures in Support of Data Recovery 

This section details steps in the recovery of lost archive data which must be executed against the 
SDSRV database. It contains two procedures. The first returns file metadata including file 
checksums to the Archive/STMGT operator for use with file recovery from tapes. The second 
generates granule metadata for use by the Planning sub-system, PLS, in re-creating granules 
from which files have been irrecoverably lost. 

The “lists” which form the interfaces between these procedures should be exchanged as 
electronic files e.g. as email ‘attachments’ or by copying. 

These operations procedures are valid for ECS Release B drop 4PL7 and subsequent 4Pn drops. 
They should be used in conjunction with the related Archive/STMGT procedures (17.9.5) and 
overview procedure (17.9.2.1, 17.9.2.2). 

17.9.6.1 SDSRV Retrieval of File Location Metadata 

For information on the context of this procedures and its interfaces see section 17.9.1. The usual 
entry point to this process is the Archive/STMGT procedure for “Manual Data Recovery from 
Damaged Cartridge” (section 17.9.5). It returns its output to its calling procedure. 

The input to this procedure is a list of the unique file names of files in the Archive effected by a 
tape failure e.g. as generated within procedure 17.9.5 by the script DsStFilesPerVolume. The list 
is called the “Effected File List” and is referred to below as the EFL. The example file name 
used for it is “eflfile.txt”. The file names in the EFL will match the 
DsMdFileStorage.internalFileName column within the SDSRV metadata database. 

17-62 611-CD-510-001




The output from this procedure is a list of file metadata (archiveIDs and checksum) for each file 
named in the input. It is called the “Effected File Metadata” list and is referred to below as the 
EFM. The example file name used for it is “eflmetadata.txt”. It is used to determine the backup 
locations, if any, of lost files and to verify the checksum of files restored via tape drive vendor 
(StorageTek) support. 

This procedure has the following dependencies: 

•	 The operator is working on a machine from which SQL connections can be made to the 
SDSRV SQL server, e.g. ‘t1acg0’ and that server recognizes the sybase account 
EcDsScienceDataServer. 

•	 The Unix account in use has execute permission on the required scripts, the ‘path’ shell 
variable set to include a directory where the command ‘isql’ is located and the SYBASE 
(Sybase ‘home’) environment variable set appropriately (e.g. setenv SYBASE 
/tools/sybOCv11.1.0). 

• The operator knows the password for the SDSRV Sybase user EcDsScienceDataServer 

Procedure: 

1.	 Receive the Effected File List (EFL) generated by the procedure e.g. as generated by the 
utility DsStFilesPerVolume (see section 17.9.5) as an electronic file. Save a local copy of the 
file with the name ‘eflfile.txt’ or similar. 

2.	 Execute the shell script DsDbSrFileLocMetadata at the Unix prompt against this file as 
follows: 
DsDbSrFileLocMetadata eflfile.txt eflmetadata.txt 

3. At the prompt enter the Sybase password for the Sybase account EcDsScienceDataServer. 

For each of the —internalFileNames“ in the input —Effected File List“ the script retrieves from the 
SDSRV database the file primary archive ID and checksum and the backup and offsite archive 
IDs if they are set. 

4.	 Check that the output file is not empty (i.e. of zero length) using the ”ls‘ command. If the file 
is of zero length either the input file was of zero length or an unexplained error occurred. 

ls -l eflmetadata.txt 

5.	 Visually inspect the file to verify success of the command (using e.g. ”more‘). The output file 
will be in two sections. First the Effected File metadata found within SDSRV Inventory 
database. Lines in this section appear as follows: 
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InternalFileName_found_in_SDSRV_Inventory_Metadata_Database Tue Jan 5 18:26:07 EST 1999


:BR:Browse.001:1170:1.BINARY

DRP1_TS3:VG1 NOT_SUPPLIED NOT_SUPPLIED "NONE" 0 1000 BRBrowse.0011170


:SC:MOD00:65001:1.CCSDS

DRP1_TS3:VG1 NOT_SUPPLIED NOT_SUPPLIED

"Oct 10 1996 12:02:00:000AM" 0 1000 SCAST_04.00120001


:PH:PH.001:2000000076:1.BINARY

DRP1_TS3:VG1 NOT_SUPPLIED NOT_SUPPLIED "NONE" 0 65536 PHPH.0012000000076


:QA:QA.001:1003:1.ASCII

SGI_RCCLAB1DEV:VG1 NULL NotSupported "NONE" 0 0 QAQA.0011003


:OR:OR.001:2100:1.ASCII

RECOV_TEST:VG1 NOT_SUPPLIED NOT_SUPPLIED "NONE" 0 0 OROR.0012100


:AN:AN.001:3100:1.ASCII

RECOV_TEST:VG1 NOT_SUPPLIED NOT_SUPPLIED "NONE" 0 0 ANAN.0013100


Second files not found within SDSRV. This section will usually be empty. 

6.	 It is advisable to check for errors in the output of the script using the Unix ”grep‘ command. 
This is done by searching the output for occurrences of the strings ”msg‘ and ”error‘. To do 
this execute the following at the Unix prompt: 

grep œi msg eflmetadata.tx | wc -l 

grep œi error eflmetadata.tx | wc -l 

If no errors occurred these commands will both output ‘0’ (zero). Any other output means there 
were errors in the process. If errors are found they must be diagnosed based on the error 
message(s) and the procedure repeated after correction of the input file. 

7. When the output file passes the above tests it should be passed back to the calling procedure. 

17.9.6.2 SDSRV Retrieval of Granule Production History Metadata 

For information on the context of this procedures and its interfaces see section 17.9.1. The entry 
point to this process is the Archive/STMGT procedure for “Data Recovery Procedure for Known 
Files” (section 17.9.2.2). Its input is a list of files remaining to be recovered, referred to below as 
the “Lost File List” (LFL). Its output serves as input to the PDPS/PLS procedure for granule 
regeneration, “Re-Generate Granules Effected by Loss of Files from the Archive”, in 
Section 13.1.6. 
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Note this procedure assumes that: 

•	 the Algorithm Package information has been inserted into the SDSRV for all 
associate datatypes. This is populated by SSI&T processing. There may be a period of 
time in the “granules” lifetime when this information is not populated. Attributes 
PGEName and PGEVersion are affected 

The goal of this procedure is to list PLS required granule metadata for those granules which the 
local PDPS should be able to re-generate. This decision is based on finding valid Production 
History URs for the ‘lost’ granules in the local SDSRV database. 

Output from this procedure is a file containing: 

•  “Granules for PDPS Re-generation” - those found within SDSRV. These are passed 
to the PLS operators for re-generation using the procedure “Re-Generate Granules 
Effected by Loss of Files from the Archive” (section 13.1.6). 

•	 “Residual Granules to Recover” - those not found within SDSRV inventory. This is 
passed back to the top-level procedure. This may include granules that have been 
removed by the “Physical Delete” service within SDSRV. 

Procedure: 

1.	 Receive the “Lost File List” (LFL) e.g. as generated by the procedure in section 17.9.5, as an 
electronic file. Save a local copy of the file with the name ‘lflfile.txt’ or similar. 

Execute the shell script DsDbSrFileLocMetadata at the Unix prompt against this file as 
follows: 

DsDbSrGranPHMetadata lflfile.txt lgrmetadata.txt 

2. At the prompt enter the Sybase password for the Sybase account EcDsScienceDataServer. 

The output file will be divided into two sections: 

• Granule metadata found within SDSRV Inventory database for use with e.g. PDPS 
granule re-generation. 

• Residual files to recover. Those files not found within SDSRV. 

For each of the —internalFileNames“ in the input —Lost File List“ for which related Granule 
metadata is found in this SDSRV the script retrieves the following pertaining to the Granule 
of which that file was part: 

- the —GeoID“ (partial UR), 

- the UR of its associated Production History granule, if available, 
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- the ESDT shortname and versionID, 

- the granule beginning date and time and ending date and time. 

1 . 	 Verify that the metadata extraction was successful by applying to the output file 
(lgrmetadata.txt) the tests as specified in steps 4, 5 and 6 of section 17.9.4.1, above. Lines in 
this section appear as follows: 

Granule_metadata_found_within_SDSRV_Inventory_database Tue Jan 5 18:26:53 EST 1999


:BR:Browse.001:1170:1.BINARY

0 1000 BRBrowse.0011170 PGEName 1 "None" "None" "NONE" "NORMAL"

PH_Does_Not_Apply


:SC:MOD00:65001:1.CCSDS

0 1000 SCAST_04.00120001 PGEName 1

"Jan 1 1997 12:00:00:000AM" "Jan 1 1997 12:00:00:000AM" 
"Oct 10 1996 12:02:00:000AM" 
"NORMAL" 2

NO_PH


:PH:PH.001:2000000076:1.BINARY

0 65536 PHPH.0012000000076 PGEName 1 
 "None" "None" "None" "NORMAL" 
PH_Does_Not_Apply 

:QA:QA.001:1003:1.ASCII 
0 0 QAQA.0011003 PGEName 1 
PH_Does_Not_Apply 

:OR:OR.001:2102:1.ASCII 
0 0 OROR.0012102 PGEName 1 
PH_Does_Not_Apply 

:AN:AN.001:3100:1.ASCII 
0 0 ANAN.0013100 PGEName 1 
PH_Does_Not_Apply 

"None" "None" "None" "NORMAL" 

"None" "None" "None" "NORMAL" 

"None" "None" "None" "NORMAL" 

Granule_metadata_not_found_within_SDSRV_Inventory_database Tue Jan 5 18:26:53 EST 1999 

2. When the output file passes the above tests it should be passed back to the calling procedure. 

Note: 

•	 For the at-launch system (Drop 4P*), granule metadata for recovered files will produce 
“logical duplicate” metadata, one set for the original “lost” files and another for the “re­
generated” files. 

• Granules for recovered files will by definition have a different granuleUR (dbID). 
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17.10 Operations of Archive Media Interfaces 

Operations of archive media interfaces involves the insertion and removal of archive media 
cartridges, tapes, or optical disk. Archive media insertion and removal from the library is an 
automated or manual function. The method used is dependent upon the amount of media 
involved. Large amounts of media is loaded or unloaded manually. Small amounts are handled 
automatically. Archive media is added or removed via the Cartridge Access Port (CAP) on the 
STK, the EMASS Entry Interface Facility (EIF), or the EMASS I/O Unit depending on the 
model used. 

The term manual loading can have one of two meanings. The first is the loading of cartridges 
directly into the archive storage slots. The second is the loading of media into the CAP, EIF or 
I/O Unit and commanding the robotic units through the EIF keypad or operator terminal to insert 
the tapes into the archive. 

The STK CAP and EMASS EIF or I/O Units also have fully automatic operational function. 
These functions allow an operator to set an operational mode that inserts media into the archive 
after loading and closing of the CAP, EIF, or I/O. In this mode, the system inserts without 
operator intervention. 

The Activity Checklist depicted in Table 17.10-1 provides an overview of the operations of the 
archive media interfaces. Column one (Order) shows the order in which tasks should be 
accomplished. Column two (Role) lists the Role/Manager/Operator responsible for performing 
the task. Column three (Task) provides a brief explanation of the task. Column four (Section) 
provides the Procedure (P) section number or Instruction (I) section number where details for 
performing the task can be found. 

Table 17.10-1. Operations of Archive Media Interfaces - Activity Checklist 
(1 of 2) 

Order Role Task Section 

DIT STK Media Interface (I) 17.10.1 

DIT Manual Insertion of STK Media (I) 17.10.1.1 

DIT Insertion of STK Media Using Bulkload (P) 17.10.1.1.1 

DIT Insertion of STK Media Using Bulkinlet (P) 17.10.1.1.2 

DIT Automatic Insertion of STK Media (P) 17.10.1.2 

DIT Manual Ejection of STK Media (I) 17.10.1.3 

DIT Commanding Ejection of STK Media (P) 17.10.1.3.1 

DIT Manually Removing STK Media from the Powderhorn 
Library Storage Module (LSM) 

(P) 17.10.1.3.2 

9 DIT EMASS Media Interface Units (I) 17.10.2 

10 DIT Inserting Media into the EMASS EIF (P) 17.10.2.1 

11 DIT Automatically Loading EMASS Archive Media (P) 17.10.2.2 

12 DIT Manually Loading EMASS Archive Media (P) 17.10.2.3 

13 DIT Ejecting EMASS Archive Media Using AMASS (P) 17.10.2.4 
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Table 17.10-1. Operations of Archive Media Interfaces - Activity Checklist 
(2 of 2) 

Order Role Task Section 

14 DIT Ejecting EMASS Archive Media Using DAS (P) 17.10.2.5 

15 DIT Removing Media from the EMASS EIF (P) 17.10.2.6 

16 DIT Manual Ejection of EMASS Media (P) 17.10.2.7 

17 DIT Removing Problem Media from the EMASS EIF (P) 17.10.2.8 

18 DIT EMASS I/O Unit (I) 17.10.3 

19 DIT Inserting Media into the EMASS I/O Unit (P) 17.10.3.1 

20 DIT Ejecting Media from the EMASS I/O Unit (P) 17.10.3.2 

21 DIT Removing Problem Media from the EMASS I/O Unit (P) 17.10.3.3 

17.10.1 STK Media Interface 

The STK employs a CAP as an interface unit. The CAP is the access door to the storage unit as 
well as the means of inserting and ejecting media for the archive user. The CAP mode controls 
how a CAP will be used for cartridge enters and ejects. CAP modes are manual and automatic. In 
manual mode the CAP is locked when not in use. This is the initial mode for all multi-cartridge 
CAPs. When in manual mode, you can enter or eject cartridges only after issuing a command. In 
automatic mode, the CAP is unlocked when not in use. While in automatic mode, you can enter 
or eject cartridges without explicitly issuing an enter command. The enter is initiated when you 
open the CAP door, place a cartridge inside and close the CAP. Whether the CAP mode is in 
manual or automatic, you must explicitly issue an eject command to eject a cartridge. 

17.10.1.1 Manual Insertion of STK Media 

The robotic unit retrieves cartridges from the CAP in two modes, manual and automatic. Manual 
mode requires the operator to request robot intervention in inserting media by issuing a 
command. This section discusses the manual insertion of media into the STK silo. The following 
procedures details how to insert tape cartridges by entering the silo, and by loading the CAP. 
Note that the ejection of media is always an operational request. 

Note: If using an ACSLS or DAS command to insert media, be aware that AMASS will not 
know of it’s existence. 

17.10.1.1.1 Insertion of STK Media Using Bulkload 

Since the CAP functions as an access door, manual loading of media into storage slots is 
possible. When inserting a large number of tapes, it is faster to enter them directly into the silo 
by entering through the CAP. This is normally only done when populating a new silo. 

Table 17.10-2 presents the steps required for manual insertion of media using the CAP. If you 
are already familiar with the procedures, you may prefer to use this quick-step table. If you are 
new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 
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1.	 Open an ACSSA window on the SUN Workstation: 
Login as acssa and enter password 

• ACSSA mode entered and cmd_proc window opened. 

2. Enter vary lsm 0,0, offline 

• There will be an audible click and the door will unlock 

3. Unlock CAP door with key 

• Safety light red, caution 

4. Set latch for safety light to become green. Lock the latch and remove the key 

• Prevents personnel from being locked inside. 

5. Enter the LSM and load or eject cartridges manually 

6. Close CAP door 

7. Lock door with key, lock latch, wait for robotic diagnostic completion 

8. From an ACSSA cmd_proc window, enter audit 

9. ACSLS will scan every volume label and update the ACSLS database. 

10. Enter bulkload -s 

• AMASS will synchronize it‘s database with ACSLS 

Table 17.10-2. Manual Insertion using CAP as an Access Door 
Step What to Enter or Select Action to Take 

enter ACSSA window on SUN Workstation 

vary lsm 0,0 offline audible click, door unlocks 

unlock CAP door with key safety light red, caution 

set latch for safety light to become green OK to enter 

load or eject cartridges manually 

close CAP door 

lock door with key, lock latch, wait for robotic 
diagnostic completion 

8 audit audit performed 

9 bulkload –s database sync 
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17.10.1.1.2 Insertion of STK Media Using Bulkinlet 

Manual insertion of STK media through the CAP requires the operator to place tape cartridges 
into the CAP. The CAP has a capacity of 21 cartridges, three rows of seven each as shown in 
Figure 17.10-1. Insertion of cartridges must begin at the left hand corner of the top rack. If this 
is not done, the system will not insert the media. No spacing is allowed between media slots. The 
system interprets the space as the end of media for insertion. It stops input operations until door 
is opened and cartridges are input again. 

The bulkinlet command is used to load multiple volumes through the mailbox, create entries in 
the AMASS database for new volumes, and mark volumes Online in the AMASS database. For 
tracking purposes, AMASS assigns each new volume a unique volume number. If you attempt to 
load several volumes at one time and one volume fails to load, AMASS will not load the 
remaining volumes after the first failure. For example, if you load volumes 1 through 6 and 
volume 3 is unsuccessful, AMASS successfully loads volumes 1 and 2 but does not load 
volumes 3, 4, 5, and 6. 

1 2 3 4 7 

8 9 10 11 12 13 14 

15 16 17 18 19 20 21 

6 5 

Figure 17.10-1. Cartridge Insertion Order into CAP 

Table 17.10-3 presents the steps required for manual insertion of media using the CAP. If you 
are already familiar with the procedures, you may prefer to use this quick-step table. If you are 
new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1. Login as amass or root and enter the password 

2.	 Load volumes into the CAP mailbox. Make sure to start in the upper left slot and fill 
slots to the right and close the CAP. 
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3.	 Enter the following AMASS command: 
bulkinlet volgroup 

•	 volgroup is the number of the volume group where the volumes are to be assigned. 
Options are: 0-2047, SP, and CL 

• audible click indicating the CAP is unlocked 

• AMASS assigns a unique volume number to each volume. 

a)	 All new volumes in the AMASS database have an initial status of unformatted 
(U) and inactive (I). If the inserted volumes are new (unknown to AMASS), 
prepare the volumes so AMASS can read or write to them using the format 
procedure in section 17.5.1. 

Table 17.10-3. Manual Insertion Using bulkinlet 
Step What to Enter or Select Action to Take 

1 Login as amass or root 

2 Load volumes into the CAP mailbox 

3 Enter bulkinlet volgroup audible click, door unlocks 

4 For new volumes set tapelength, format and activate 
see section 17.5.1 

see AMASS System 
Administrator’s Guide 

17.10.1.2 Automatic Insertion of STK Media 

Automatic insertion of STK media into the CAP is accomplished without operator intervention. 

Table 17.10-4 presents the steps required for automatic insertion of STK media using the CAP. 
If you are already familiar with the procedures, you may prefer to use this quick-step table. If 
you are new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1.	 Enter ACSSA window on SUN Workstation: 
Login as acssa and enter password 
• ACSSA mode entered and cmd_proc window opened. 

2.	 If already in automatic mode go to step 3. If not, enter: 
set cap 0,0,0 mode automatic 

• audible click indicating door is unlocked 

3. Open CAP media door 

4. Load cartridges into the door , top left slot first 
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5. Close CAP door 

• Robot inserts media without operator intervention. 

6. If entering new media (unknown to AMASS) update the amass database using the 
command:

volnew volgroup slot vollabel


ex. volnew SP NET SG0009 

Table 17.10-4. Automatic Insertion of STK Media 
Step What to Enter or Select Action to Take 

1 enter ASCCA window on SUN Workstation 

2 enter set cap 0,0,0 mode automatic audible sound from CAP, CAP 
unlocked 

3 open CAP media door 

4 load cartridges into the door top left slot first 

5 close CAP door robot inserts media without 
operator intervention 

6 volnew volgroup slot vollabel 

17.10.1.3 Manual Ejection of STK Media 

As mentioned previously, ejection of STK media is always requires manual intervention. Manual 
ejection can be by means of issuing commands or physically entering the Powderhorn LSM and 
removing a tape. Keep in mind that when a tape is physically removed from archive, the AMASS 
and ACSLS databases will think the tape is still in the LSM. 

17.10.1.3.1 Commanding Ejection of STK Media 

Table 17.10-5 presents the steps required for comanding ejection of STK media using the CAP. 
If you are already familiar with the procedures, you may prefer to use this quick-step table. If 
you are new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1 . 	 Determine which volumes you want to remove, utilizing the volume number. If 
necessary to review volume numbers and other information, log into the AMASS host, 
type vollist and then press the Enter key. 

2.	 If there are only a few volumes to remove, then for each volume to be removed type: 
/usr/amass/bin/voloutlet #, where # is the volume number, and then press the Enter key. 

• AMASS marks the volume off-line and the volume is transferred to the CAP. 
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3.	 For the STK Powderhorn, open the recessed latch on the Cartridge Access Port (CAP) 
door and remove the tape(s) 

Table 17.10-5. Commanding Ejection of STK Media 
Step What to Do Action to Take 

1 Vollist Press return 

2 voloutlet volnumber Press return 

3 Open CAP and remove tape 

17.10.1.3.2 Manually Removing STK Media From the Powderhorn Library Storage 
Module (LSM) 

Table 17.10-6 presents the steps required for manual removal of media from the STK 
Powderhorn using the CAP as an access door. If you are already familiar with the procedures, 
you may prefer to use this quick-step table. If you are new to the system, or have not performed 
this task recently, you should use the following detailed procedure: 

1.	 Enter ACSSA window on SUN Workstation: 
Login as acssa and enter password 

• ACSSA mode entered and cmd_proc window opened. 

2. Enter vary lsm 0,0 offline 

• audible click indicating door is unlocked 

2. Unlock CAP door with key and open the access door. 

• Safety light red, caution 

2. Set latch for safety light to become green by locking the CAP. 

3. Enter the Powderhorn LSM and load or remove cartridges manually 

4. Close CAP door 

5. Lock door with key, wait for robotic diagnostic completion 
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1

2

3

4

5

6

7

Table 17.10-6. Manually Removing STK Media From the LSM 
Step What to Enter or Select Action to Take 

enter ASCCA window on SUN Workstation 

vary lsm 0,0 offline Listen for audible click 

unlock CAP door with key safety light red, caution 

set latch for safety light to become green OK to enter 

load or remove cartridges manually 

close CAP door 

lock door with key wait for robotic diagnostic 
completion 

17.10.2 EMASS Media Interface Units 

There are two EMASS media interface units for data archiving being utilized. Different media 
I/O interfaces exist for these units. The instructions in this section describe the manual 
procedures for operating either the Entry Interface Facility (EIF) or I/O Unit. The procedures 
include the insertion and removal of media before automated loading or after automated ejection 
from the archive. 

The GODDARD DAAC EMASS AML/2 incorporates an EIF. Smaller capacity EMASS models 
may incorporate an I/O Unit. 

17.10.2.1 Inserting Media into the EMASS EIF 

The Goddard DAAC EMASS unit utilizes an Entry Interface Facility (EIF). The EIF is a media 
handling I/O unit. It utilizes three sections. Two of these sections allow the operator to input 
and output media. This is for archive storage as well as Foreign media. Foreign media have no 
bar-code number for storage to the archive. The media travels directly from the Foreign box to a 
selected drive for operations. When completed, it returns to the Foreign box for removal from 
the system. 

A third section allows for the ejection of media classified as Problem media from the archive 
storage. The Problem box is a separate entity populated by the archive system. Removal of 
Problem media is an operator function. 

Media are inserted into and ejected from the EMASS archive system through the EIF. Cartridges 
are loaded by hand into hand-carry racks, each with a capacity of 30 half-inch tape cartridges or 
22 optical cartridges. The robot system physically moves each cartridge from the EIF to the 
AML. EMASS recommends that you turn ON the Auto Import option for each library. With 
this option on, you only need to place media into the EIF and close it. 

The EIF uses a keypad with a display for commands. Figure 17.10-2 depicts the configuration 
for the EIF keypad configuration. The EIF handling boxes for Insert/Eject/Foreign Media 
compartments are fully selectable for either operation. 
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COMMAND 

KEYPAD 

Section 1 (TOP) 

PROBLEM BOX 

Manual ROTATING TRAY 

[9 available slots per side] 

Section 2 (MIDDLE) 

INSERT/EJECT/FOREIGN MEDIA 

4 ROTATING HANDLING 

BOXES [120 available slots] 

[keypad entries1-4] 

Section 3 (BOTTOM) 

INSERT/EJECT/FOREIGN MEDIA 

4 ROTATING HANDLING 

BOXES [120 available slots] 

[keypad entries 5-8] 

Figure 17.10-2. EIF Keypad Configuration 

Table 17.10-7 presents the steps required for inserting media into the EMASS EIF. If you are 
already familiar with the procedures, you may prefer to use this quick-step table. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 
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1. Verify that the Main Menu on the EIF keypad is active 

• Display is lit 

2. Select Insert with cursor keys 

• Insert is highlighted 

a) Press Enter 

• Display shows selection for, handling box number entry 

3. Select handling box (1-8) 

• Selection is displayed 

a) Press Enter 

• Handling box selected is rotated, into access position 

4. Select Open Door with cursor keys 

• Display prompts for reply to open door for access 

a) Press Enter 

• Door opens 

5. Put media in Insert I/O box selected 

• Option 1 Take out handling box and load with media 

• Option 2 Load handling box while in place 

• Make sure box is seated correctly 

6. Select Close Door with cursor keys 

• Display prompts for reply to close door 

a) Press Enter 

• Door closes, tray rotates 180 degrees 
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Table 17.10-7. Inserting All Media Types into EIF - Quick-Step Procedure 
Step Action to Take Verification 

1 Verify Main Menu is active on the EIF Display is lit 

2 Select Insert with cursor keys Insert is highlighted 

3 Press Enter Display shows selection for, 
handling box number entry 

4 Select handling box (1-8) Selection is displayed 

5 Press Enter Handling box selected is rotated, 
to into access position 

6 Select Open Door with cursor keys Display prompts for reply to, 
open door for access 

7 Press Enter Door opens 

8 Put media in Insert I/O box selected Options: 
1) Take out handling box and load 
with media 
2) Load handling box while in 
place 
Make sure box is seated correctly 

9 Select Close Door with cursor keys Display prompts for reply to close 
door 

10 Press Enter Door closes, tray rotates 180 degrees 

17.10.2.2 Automatically Loading EMASS Archive Media 

Table 17.10-8 presents the steps required for inserting media into the EMASS EIF. If you are 
already familiar with the procedures, you may prefer to use this quick-step table. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 

1. To log in, type amass or root and then press the Enter key. 

• A password prompt is displayed. 

2. Enter the Password, then press the Enter key. 

• Remember that Password is case sensitive. 

• You are authenticated (as amass or root) and returned to the UNIX prompt. 

3.	 Remove the left box to insert or remove tape media, and/or remove the right box to insert 
or remove optical media. 

4. 	 Write down or note the bar code numbers on the labels of the cartridges, insert the 
cartridges in the removed box(es), reinsert the box(es) in the EIF, and close the door. 
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• The robot scans all the volumes. 

5. At the AMASS host, type /usr/amass/bin/bulkinlet SP and then press the Enter key. 

•	 Data for the newly inserted media are displayed, including bar codes, associated 
volume numbers, and, in the flag column, the letters IUO, indicating that the volumes 
are inactive (I), unformatted (U), and offline (O). 

6.	 For any newly inserted media, it is necessary to issue a formatting command. For tapes, 
type volformat # , where # is the volume number. For optical cartridges, type volformat 
-p #, where # is the volume number. You can enter more than one, separating each 
number from the preceding one with a space. 

Note: You may wish to use the & (to run the process in the background) for formatting tapes as 
well as for optical cartridges. It is highly recommended for formatting optical cartridges, 
because of the length of time required. 

7. A message requests confirmation that you wish to continue. 

8. Type y and then press the Enter key. 

•	 A message is displayed requesting further confirmation, stating that The following 
volumes will be formatted: and listing volume numbers, followed by (Y-N). 

9. Type y and then press the Enter key. 

•	 After a few minutes (or, for optical cartridges, about an hour for each), a message; 
Completed formatting all volumes is displayed. 

10.	 To verify that the volume(s) are inserted, type /usr/amass/bin/vollist and then press the 
Enter key. 

11.	 Data for the media are displayed; the flag column shows that the newly formatted 
volumes are inactive (I). 

12.	 To activate the media for use, type: 

volstat -a 

13.	 Data for the media are displayed; the flag column shows that the volumes are now active 
(A). 
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Table 17.10-8. Automatically Loading EMASS Archive Media -
Quick-Step Procedure 

Step What to do Action to Take 

1 amass or root Press return 

2 Insert or remove media Remove left tape box for tape media or 
right box for optical media 

3 Load cartridges Note lables, load boxes and insert into 
EIF 

4 /usr/amass/bin/bulkinlet SP Press return 

5 volformat (-p) volnumber Press return 

6 Confirm format Enter Y 

7 /usr/amass/bin/vollist Press return 

8 volstat –a Press return 

17.10.2.3 Manually Loading EMASS Archive Media 

With the bulkload command, you bypass the EIF and manually load media directly into the 
library bins. Typically, this will only be done at the initial load of the system with large numbers 
of media volumes. The bulkload command enables AMASS to determine what type of media 
have been placed in the library and to convey this information to the AMASS database. The 
following procedures are applicable. Table 17.10-9 presents the steps required for inserting 
media into the EMASS bins. If you are already familiar with the procedures, you may prefer to 
use this quick-step table. If you are new to the system, or have not performed this task recently, 
you should use the following detailed procedure: 

Warning 

If it is necessary to enter the AML after AMASS is 
started, the following step (Step 1) must be performed 
first to avoid hazard and ensure safety of personnel and 
equipment. 

1.	 Turn the Operation Mode switch, located above the AMU keyboard shelf, to manual by 
rotating it to the horizontal position. 

• The Control Off amber light comes on. 

•	 All power to the robot and tower is then turned off and it is safe to enter the enclosed 
area. 
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2. Press the Illumination On button. 

• The overhead light in the AML comes on. 

3. Turn the key to the access door two full turns clockwise to open the door. 

•	 Physically enter the library and load the desired media into the bins. 

Caution 

The following step (Step 4) must be performed before leaving the 
enclosed area to ensure proper functioning of the AML robot. 

4.	 Before leaving the enclosed area, straighten the robot arm so that it is parallel to the main 
hallway and pointing to the front of the AML. 

Warning 

To avoid hazard and ensure safety of personnel and 
equipment, the following step (Step 5) must be 
performed before Step 6. 

5. On leaving the area, lock the door by turning the key two full turns counterclockwise. 

6.	 Turn the Operation Mode switch, located above the AMU keyboard shelf, to automatic by 
rotating it to the vertical position. 

• The Control Off amber light goes off. 

7.	 From a DAS command line, execute the inventory command, DAS will scan all AML media 
and update the archive catalogue. 

• The archive catalogue can be viewed with the list command. 

8. At the AMASS host, type bulkload -s SP and then press the Enter key. 

• The AMASS database is populated with data for the volumes in the AML. 

9 . 	 To view a list of media in the AML, type medialist [-#] (where # is the jukebox 
identification number), and then press the Enter key. 

•	 If you do not specify a jukebox number with the -# option, the default is 1, which 
specifies the EMASS AML optical disks. 
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•	 If you want to specify a different jukebox, specify -2 to indicate the EMASS AML 
tapes. 

•	 The utility reads the library element status stored in the library, and information about 
the library contents, including the status (FULL or EMPTY) of the elements. 

Table 17.10-9. Manually Loading EMASS Archive Media - Quick-Step Procedure 
Step Action to Take Verification 

1 Turn operational mode switch to manual Control Off amber light comes on 

2 Press the Illumination On button. The overhead light in the AML comes on 

3 Turn key two full turns clockwise Enter library and load media 

4 Turn the Operation Mode switch to 
Automatic 

The Control Off amber light goes off 

5 Inventory DAS scans media 

6 bulkload -s SP AMASS database is updated 

17.10.2.4 Ejecting EMASS Archive Media Using AMASS 

Ejecting media from archive is always a manual operation. Problem media however, may be 
moved to the Problem Box automatically. Table 17.10-10 presents the steps required for 
ejecting EMASS archive media using AMASS commands. If you are already familiar with the 
procedures, you may prefer to use this quick-step table. If you are new to the system, or have not 
performed this task recently, you should use the following detailed procedure: 

1.	 Determine which volumes you want to remove by utilizing the volume number. If 
necessary to review volume numbers and other information, log into the AMASS host, 
type /usr/amass/bin/vollist and then press the Enter key. 

2. 	 If there are only a few volumes to removed; for each volume to be removed type: 
/usr/amass/bin/voloutlet #, where # is the volume number, and then press the Enter key. 

• AMASS marks the volume off-line and the volume is transferred to the EIF. 

3.	 Remove the left box to remove tape media, and/or remove the right box to remove optical 
media. 
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Table 17.10-10. Ejecting EMASS Archive Media Using AMASS -
Quick-Step Procedure 

Step What to do Action to Take 

1 /usr/amass/bin/vollist Press return 

2 /usr/amass/bin/voloutlet # Press return 

3 Remove media Remove the left box to remove tape 
media, and/or remove the right box to 
remove optical media 

17.10.2.5 Ejecting EMASS Archive Media Using DAS 

Ejecting media from archive is always a manual operation. Problem media however, may be 
moved to the Problem Box automatically. Table 17.10-11 presents the steps required for ejecting 
EMASS archive media using DAS commands. If you are already familiar with the procedures, 
you may prefer to use this quick-step table. If you are new to the system, or have not performed 
this task recently, you should use the following detailed procedure: 

1.	 Determine which volumes you want to remove by utilizing the volser label. If necessary 
to review volser labels, log into the DAS host, type dasadmin list and then press the Enter 
key. For more information on the use of DAS commands, see the DAS Administration 
Guide . The DAS guide can be viewed using Adobe Acrobat and is available 
electronically on servers g0drg01 and g0drg02 in /usr/amass/books. 

2. After determining which volumes to remove, type: 

dasadmin eject (ej) [-c] [-t media-type] volser-rangearea 

• DAS marks the volume ejected and the volume is transferred to the EIF. 

• See Table 17.10-12 for parameter descriptions. 

3.	 Remove the left box to remove tape media, and/or remove the right box to remove optical 
media. 

Table 17.10-11. Ejecting EMASS Archive Media Using DAS -
Quick-Step Procedure 

Step What to do Action to Take 

1 dasadmin list Press return 

2 dasadmin eject (ej) [-c] [-t media-type] 
volser-rangearea 

Press return 

3 Remove media Remove the left box to remove tape 
media, and/or remove the right box to 
remove optical media 
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Table 17.10-12 provides an explanation of DAS command parameters. Table 17.10-13 provides 
a list of media types specified by the parameter media-type. 

Table 17.10-12. Parameter Explanation 
-c The optional parameter -c indicates to DAS a complete eject 

operation requested (volser will be removed from the archive catalog) 

media-type The optional media-type parameter allows the specification of a media type 
(see table 9-13). 

volser-range The volser-range specifies one or more volsers to be ejected. 
The volser range must be in one of the following formats: 
volser | 
volser, volser,... | 
volser-volser. 

area The area specifies the eject area name in the I/O unit to which 
the volume(s) are moved (e.g. E01). 

Table 17.10-13. Media Types 
Media Types Type Explanation AMU-

Types 

3480 3480 and 3490 
and 3490E 

Cartridges C0 

3590 3590/8590 Cartridges C2 

OD-THIN Optical disk Reflection (9 mm) O0 

OD-THICK Optical disk 512, MO/WORM (11mm) O1 

CD CD-ROM disk (CD-Caddy) C6 

TRAVAN TRAVAN cartridge V5 

BETACAM BETACAM cartridge V8 

DECDLT TK-85 Digital Linear Tape (DLT) C1 

8MM D8 cartridge (8 mm) V1 

4MM DDS or DAT cartridge (4mm) (Digital Data Storage) V2 

VHS VHS cartridge V0 

D2 Small and medium cartridge V3 (V4) 

DTF DTF small and medium cartridge V6 (V7) 

17.10.2.6 Removing Media from the EMASS EIF 

Table 17.10-14 presents the steps required for removing all ejected media types from the EIF. 
If you are already familiar with the procedures, you may prefer to use this quick-step table. If 
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you are new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1. Verify that the Main Menu on the EIF keypad is active 

• Display is lit 

2. Select Eject with cursor keys 

• Eject is highlighted 

3. Press Enter 

• Display shows selection for, handling box number entry 

4. Select Eject handling box (1-8) 

• Selection is displayed 

5. Press Enter 

• Handling box selected is rotated, into access position 

6. Select Open Door with cursor keys 

• Display prompts for reply to open door for access 

7. Press Enter 

• Door opens 

8. Remove media in Eject I/O box. 

• Option 1 Take out handling box and unload media 

• Option 2 Unload handling box while in place 

• Make sure box is seated correctly 

9. Select Close Door with cursor keys 

• Display prompts for reply to close door 

10. Press Enter 

• Door closes 
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Table 17.10-14. Removing All Ejected Media Types from EIF -
Quick-Step Procedure 

Step Action to Take Verification 

1 Verify Main Menu is active on the EIF Display is lit 

2 Select Eject with cursor keys Eject is highlighted 

3 Press Enter Display shows selection for, 
handling box number entry 

4 Select Eject handling box (1-8) Selection is displayed 

5 Press Enter Handling box selected is rotated, 
to into access position 

6 Select Open Door with cursor keys Display prompts for reply to, 
open door for access 

7 Press Enter Door opens 

8 Remove media in Eject I/O box selected Options: 
1) Take out handling box and 
unload media 
2) Unload handling box while in 
place 
Make sure box is seated correctly 

9 Select Close Door with cursor keys Display prompts for reply to close 
door 

10 Press Enter Door closes 

17.10.2.7 Manual Ejection of EMASS Media 

As mentioned previously, ejection of STK media is always requires manual intervention. Manual 
ejection can be by means of issuing commands or physically entering the Powderhorn LSM and 
removing a tape. Keep in mind that when a tape is physically removed from archive, the AMASS 
and ACSLS databases will think the tape is still in the LSM. Table 17.10-15 presents the steps 
required to eject EMASS media. If you are already familiar with the procedures, you may prefer 
to use this quick-step table. If you are new to the system, or have not performed this task 
recently, you should use the following detailed procedure: 

1 . 	 Determine which volumes you want to remove, utilizing the volume number. If 
necessary to review volume numbers and other information, log into the AMASS host, 
type vollist and then press the Enter key. 

2.	 If there are only a few volumes to remove, then for each volume to be removed type: 
/usr/amass/bin/voloutlet #, where # is the volume number, and then press the Enter key. 

• AMASS marks the volume off-line and the volume is transferred to the CAP. 

3.	 For the STK Powderhorn, open the recessed latch on the Cartridge Access Port (CAP) 
door and remove the tape(s) 
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Table 17.10-15. Ejecting EMASS Archive Media Using DAS -
Quick-Step Procedure 

Step What to do Action to Take 

1 Vollist Press return 

2 /usr/amass/bin/voloutlet #, Press return 

3 Remove media Open the recessed latch on the Cartridge 
Access Port (CAP) door and remove the 
tape(s) 

17.10.2.8 Removing Problem Media from the EMASS EIF 

Table 17.10-16 presents the steps required to remove Problem media from the EIF media 
interface unit. If you are already familiar with the procedures, you may prefer to use this quick­
step table. If you are new to the system, or have not performed this task recently, you should use 
the following detailed procedure: 

1. Verify that the Main Menu on the EIF keypad is active 

• Display is lit 

2. Press F1  key 

• Audible click, Problem Box unlocks 

3. Open doors 

• Swing open both doors to full extent 

4. Manually spin tray 180 degrees, clockwise 

• Expelled tapes are now accessible to operator 

5. Remove media 

• Remove tapes from tray 

6. Close Door 

• Swing doors closed 
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Table 17.10-16. Removing Problem Media - Quick-Step Procedure 
Step Action to Take Verification 

1 Verify Main Menu is active on the EIF Display is lit 

2 Press F1 cursor key Audible click, Problem Box unlocks 

3 Open doors Swing open both doors to full extent 

4 Manually spin tray 180 degrees, clockwise Expelled tapes are now accessible to 
operator 

5 Remove Media Remove tapes from tray 

6 Close doors Swing doors closed 

17.10.3 EMASS I/O UNIT 

The I/O Unit is the media interface on EMASS models not located at the Goddard facility. The 
unit consists of three media compartments. The top compartment is the Problem Box reserved 
for system ejected media. The middle and bottom compartments are the operational insertion 
and ejection compartments for storage and Foreign media. The unit has EMERGENCY STOP, 
ON, and OPERATION buttons. There is also a shutter system that isolates the I/O 
compartments from the robotics unit. 

Figure 17.10-3 displays the basic layout for the EMASS I/O Unit. 

Problem Box 

Handling Box 1 Handling Box 2 

Handling Box 2 Handling Box 4 

Figure 17.10-3. EMASS I/O Unit Layout 

17.10.3.1 Inserting Media into the EMASS I/O UNIT 

Table 17.10-17 presents the steps required inserting media into the EMASS I/O Unit. If you are 
already familiar with the procedures, you may prefer to use this quick-step table. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 

1. Press ON push-button 
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• Generates door opening request 
• Shutter closes 
• At closing of shutter, OPERATION push-button illuminates 
• ON push-button goes off 

2. Open I/O door as far as possible, 15 sec timer 

• I/O media compartment is now ready 

• If timer is not met, shutter closes, Step 1 has to be repeated 

3. Remove Handling box or boxes 
• Audible Click from seating switch 

4. Insert tapes into box starting with the left slot in bottom row 

5. Insert the handling box into the I/O 

•	 Place the box correctly, tapes face toward the rear or unit, a seating switch will click 
if done properly 

6. Close the I/O door 

• Audible latch at door closing 

• OPERATION light pulses if handling boxes are not seated correctly 

• Shutter closes automatically 

• OPERATION and ON push-buttons turn off 
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Table 17.10-17. Inserting All Media Types into I/O Unit - Quick-Step Procedure 
Step Action to Take Verification 

1 Press ON push-button Generates door opening request: 
1) Shutter closes 
2) At closing of shutter, OPERATION 
push-button illuminates 
3) ON push-button goes off 

2 Open I/O door as far 
as possible, 15 sec timer 

I/O media compartment is now ready: 
1) If timer is not met, shutter closes, 
Step 1 has to be repeated 

3 Remove Handling box or boxes Audible Click from seating switch 

4 Insert tapes into box starting 
with the left slot in bottom row 

5 Insert the handling box into the 
I/O 

Place the box correctly, tapes face toward 
the rear or unit, a seating switch will 
will click if done properly 

6 Close the I/O door 1) Audible latch at door closing 
OPERATION light pulses if handling 
boxes are not seated correctly 
3) Shutter closes automatically 
OPERATION and ON push-buttons 
turn off 

17.10.3.2 Ejecting Media into the EMASS I/O UNIT 

Table 17.10-18 presents the steps required for removing all ejected media types from the 
EMASS I/O unit. If you are already familiar with the procedures, you may prefer to use this 
quick-step table. If you are new to the system, or have not performed this task recently, you 
should use the following detailed procedure: 

1. Press ON push-button 

• Generates door opening request 
• Shutter closes 
• At closing of shutter, OPERATION push-button luminates 
• ON push-button goes off 

2. Open I/O door as far as possible, 15 sec timer 

• I/O media compartment is now ready 

• If timer is not met, shutter closes, Step 1 has to be repeated 

3. Remove Handling box or boxes 

17-89 611-CD-510-001




• Audible Click from seating switch 

4. Remove tapes from box 

5. Insert the handling box into the I/O 

•	 Place the box correctly, tapes face toward the rear of unit, a seating switch will click if 
properly 

6. Close the I/O door 

• Audible latch at door closing 

• OPERATION light pulses if handling boxes are not seated correctly 

• Shutter closes automatically 

• OPERATION and ON push-buttons turn off 

Table 17.10-18. Removing All Ejected Media Types from I/O Unit -
Quick-Step Procedure 

Step Action to Take Verification 

1 Press ON push-button Generates door opening request: 
1) Shutter closes 
2) At closing of shutter, OPERATION 
push-button luminates 
3) ON push-button goes off 

2 Open I/O door as far 
as possible, 15 sec timer 

I/O media compartment is now ready: 
1) If timer is not met, shutter closes, 
Step 1 has to be repeated 

3 Remove Handling box or boxes Audible Click from seating switch 

4 Remove tapes from box 

5 Insert the handling box into the 
I/O 

Place the box correctly, tapes face 
toward the rear of unit, a seating switch 
will click if done properly 

6 Close the I/O door 1) Audible latch at door closing 
2) OPERATION light pulses if handling 
box is not seated correctly 
3) Shutter closes automatically 
OPERATION and ON push-buttons 
turn off 
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17.10.3.3 Removing Problem Media from the EMASS I/O UNIT 

Table 17.10-19 presents the steps required for removing media from the EMASS I/O Unit 
Problem Box. If you are already familiar with the procedures, you may prefer to use this quick-
step table. If you are new to the system, or have not performed this task recently, you should use 
the following detailed procedure: 

1. Press ON push-button 

• Generates door opening request 
• Shutter closes 
• At closing of shutter, OPERATION push-button luminates 
• ON push-button goes off 

2. Open I/O door as far as possible, 15 sec timer 

• I/O media compartment is now ready 

• If timer is not met, shutter closes, Step 1 has to be repeated 

3. Remove tapes from Problem Box 

4. Close the I/O door 

• Audible latch at door closing 

• OPERATION light pulses if handling boxes are not seated correctly 

• Shutter closes automatically 

• OPERATION and ON push-buttons turn off 
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Table 17.10-19. Removing Problem Media from I/O Unit- Quick-Step Procedure 
Step Action to Take Verification 

1 Press ON push-button Generates door opening request: 
1) Shutter closes 
2) At closing of shutter, OPERATION 
push-button luminates 
3) ON push-button goes off 

2 Open I/O door as far 
as possible, 15 sec timer 

I/O media compartment is now ready: 
1) If timer is not met, shutter closes, 
Step 1 has to be repeated 

3 Remove tapes from 
Problem Box 

4 Close the I/O door 1) Audible latch at door closing 
2) OPERATION light pulses if one of the handling 
boxes are not seated correctly 
3) Shutter closes automatically 
4) OPERATION and ON push-buttons turn off 

17.11 Archiving Application Log Files to AMASS 

The purpose of this Operations Procedure is to support permanent archiving of ECS Application 
Log files (ALOGs) to the AMASS archive device as and when required. Use of this procedure is 
DAAC optional. However if application logs are to be written to the archive it is recommended 
that this procedure be adhered to. 

The ECS system ALOG files capture messages from ECS code on requests, responses and status. 
One ALOG file is generated per individual ECS custom code component (see ECS software 
baseline documentation, e.g. 910-TDA-007). Under normal operating conditions the ALOG files 
are not saved but are over-written by continuous process logging when they reach their 
maximum size. The procedure documented here should be employed whenever it is decided that 
at a particular time a log file or files need to be preserved. 

The overall process is straightforward. Initial set-up must be completed by DAAC AMASS 
Operators. Individual file archiving and retrieval is then undertaken using a Unix account created 
for this purpose: “alogxfr”. ALOG files are copied on the application server to the home 
directory of user “alogxfr” and then, on a STMGT host which mounts the AMASS cache, from 
there into the archive in the form of a specific Volume Group in AMASS. The Volume Group 
and its internal directory structure must be pre-configured as must the account “alogxfr”. 

File uniqueness in the archive and retrieval from the archive rely on (i) division of the volume 
structure by sub-system and application, (ii) preservation of default ALOG file naming in writing 
to the archive and (iii) where necessary file name extension with unique numbering. 
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Table 17.11-1. Archiving Application Log Files - Activity Checklist 
Order Role Task Section 

1 DAM/DIT Configuration (I) 17.11.1 

2 DAM/DIT Amass Volume/ Volume Group set – up (I) 17.11.1.1 

3 DAM/DIT Secure Shell ALOG file transfer account setup (P) 17.11.1.2 

4 DAM/DIT ALOG file archiving (I) 17.11.2 

5 DAM/DIT Verify/ create required Archive Volume Group 
and Subdirectory 

(P) 17.11.2.1 

6 DAM/DIT Verify/create subsystem/application specific 
subdirectory 

(P) 17.11.2.2 

7 DAM/DIT Copy ALOG file and write to archive (P) 17.11.2.3 

8 DAM/DIT ALOG file retrieval from archvive (P) 17.11.3 

17.11.1 Configuration 

Use of these procedures requires (i) the setting up of a system wide account to support ALOG 
file copying over the network and (ii) initialization of a specific AMASS Volume Group in 
which to archive the files. 

17.11.1.1 AMASS Volume / Volume Group Set-up 

The following Volume Group assignment must be made, and the directory structure created, 
before ALOG files are archived. Failure to do this will imply that the files are either not archived 
correctly or will not be retrievable from the documented locations. 

The Volume Group “mss” should be pre-configured in the local archive. If it is not it needs to be 
defined. This Volume Group may also be used for archiving of certain MSS ESDTs. However 
that usage and this archiving of ALOGs should not interfere with one another. For first usage the 
Volume Group will also require the addition of an initial Volume (tape). 

In the following the local/applicable AMASS cache mount point may differ from that shown i.e. 
“/dss_stk1/OPS”. Check your local DAAC configuration. Below that directory a sub-directory 
for the volume group should be found named “mss”. Within that directory a specific directory for 
archiving of ALOG files by this procedure is required i.e. “ALOGs”. Sub-directories below that 
shall be used for ALOG files from each ECS sub-system by three-letter abbreviation in upper­
case, i.e. “IDG”, “MSS”, “DSS”, “PLS”, “DPS”, etc. Hence, as an example, to archive DPS 
ALOG files the following directory must exist in the AMASS cache: 

“/dss_stk1/OPS/mss/ALOGs/DPS/” 

Note: If this procedure is heavily used DAAC Operations may optionally insert additional levels 
of sub-division under the “ALOGs” directory, for example by calendar year of the date-stamp of 
the ALOGs archived, e.g.: 

“/dss_stk1/OPS/mss/ALOGs/1999/DPS/” 
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17.11.1.2 Secure shell ALOG file transfer account Set-up 

The following account for use with this procedure should be pre-defined. If it is not the likely 
cause is that the ECS baseline configuration changes related to this procedure have not yet been 
propagated to your environment. Refer to the ECS CCB and/or MSS sub-system support for 
guidance. 

The account for ALOG file transfer is called “alogxfr”. This must be defined as a network (i.e. 
NIS) account. It may be configured for secure access (i.e. use of “ssh” without supplying of a 
password) to all local ECS custom code application servers. To enable this configuration refer to 
local System Administration support (i.e. to set-up secure shell connection without password 
entry). 

17.11.2 ALOG File Archiving Procedure 

The following procedures explain how to properly verify and create the required archive and 
Volume Group for the archiving of operational ALOG files. Complete steps are provided, that 
step through the process of creating and logging ALOG files to the archive. Quick steps are 
provided for reference, after the operator has developed an understanding of the following 
procedures. 

17.11.2.1 Verify/create required archive Volume Group and sub-directory 

As described above ALOGs are to be archived by sub-system and application to specific 
AMASS sub-directories within the “mss” Volume Group. 

1. As input to this procedure you will need to know the following information: 

• The name of the ALOG file to be archived and its full file path if non-standard. 

• The name of the application server from which the ALOG file is to be copied. 

• How to determine the ALOG file’s applicable ECS sub-system and application. 

•	 Which STMGT hosts mount the AMASS cache and the local name of the mount 
point for that cache. 

• The alogxfr account password (for copying ALOG files from the application servers). 

•	 For actions within this section support of an AMASS operator and/or root (i.e. for 
initial configuring of the archive). 

2. Select the STMGT host for use in this activity. It must mount the AMASS cache e.g. 
directory: /dss_stk1 

Within this procedure this mount point will be referenced as “acmountp”. 

3. Login as alogxfr to the chosen STMGT host and enter the password 

• Remember that your password is case sensitive. 
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4.	 Use the amassstat command to determine if AMASS is running. If it is not you can not 
continue until AMASS has been restarted. Refer to local AMASS Operators. 

5.	 Check that the required archive Volume Group exists within the required MODE and has 
the correct ownership and permissions by use of the command: 

ls –l /<acmountp>/<mode>/mss 

Typically “mode” will be “OPS”. Hereafter this procedure assumes use of mode “OPS”. 
Replace with the relevant mode as necessary. 

If the above directory does not exist refer to the description in “Configuration”above and 
seek support from DAAC System Administration / STMGT operators to create the 
required Volume Group / add a volume to that group. This should only be necessary 
when (i) this procedure is first used and (ii) a new tape volume needs to be added to the 
volume group (i.e. rarely). 

6. Check that the required sub-directory exists and has the correct ownership and 
permissions by use of the command: 

ls –l /<acmountp>/OPS/mss/ALOGs 

This directory must exist and be owned by use “alogxfr”. If it does not exist, it must be 
created with the command “mkdir”. 

mkdir /<acmountp>/OPS/mss/ALOGs 

This may require permissions of the AMASS operator or root. If the directory is not 
owned by “alogxfr”(e.g. it has just been created) its ownership must be set. This may 
require root permission. 

chown alogxfr /<acmountp>/OPS/mss/ALOGs 

Repeat the ‘ls –l’ command above to check the directory’s ownership and permissions. 

Table 17.11-2. ALOG file archiving procedure – Quick-Steps 
Step What to Do Action to take 

1 Login to Storage Management Host Type login alogxfr 

2 Determine if AMASS is running Type ammassstat 

3 Check that the required archive group exists Type ls –l /<acmountp>/<mode>/mss 

4 Check that the required subdirectory exists Type ls –l /<acmountp>/OPS/mss/ALOGs 

17.11.2.2 Verify/create Sub-system/Application Specific Sub-directory 

The procedure may start with this step if the “mss” archive volume and “ALOGs” sub-directory 
have previously been verified and/or created as above. 

1.	 If you are not already logged in as “alogxfr” set your userid to this user with use of the 
command ‘su’ as follows: 
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 su - alogxfr 
Note the ‘-‘ is separated by white-space from the userid ‘alogxfr’. Enter the ‘alogxfr’ account 
password when prompted. Verify that you are now user ‘alogxfr’ with the command 
‘whoami’. 

2. ALOG files have a standard file naming format as follows: 
<ApplicationName>.ALOG.<timestamp> 

To archive this ALOG file from the ApplicationName determine the sub-system and 
application to which the log belongs, e.g. file: 

EcDsScienceDataServer.ALOG.19981014232357 
is from the sub-system DSS and application “ScienceDataServer”. Refer to ECS system 
software overview documentation for guidance. 

3. Verify that the required sub-system sub-directory exists and has the correct ownership 
and permissions by use of the command e.g.: 

ls -l /<acmountp>/OPS/mss/ALOGs/DSS 
If it does not exist use “mkdir” to create it. It must be owned by user “alogxfr”. 

4.	 Check that the required application sub-directory exists by use of the command e.g.: 
ls -l /<acmountp>/OPS/mss/ALOGs/DSS/ScienceDataServer 
Be sure to avoid missing directories because of case sensitivity. If the directory does not exist 
use “mkdir” to create it. It must also be owned by user “alogxfr”. 

Table 17.11-3. Verify/Create Subsystem specific subdirectory – Quick-Steps 
Step What to Do Action to take 

1 Verify that you are logged in as alogxfr Type whoami 

2 Determine subsystem to which ALOG 
belongs 

Refer to ECS software documentation for guidance 

3 Verify that subsystem subdirectory exists 
and has correct permissions 

Type ls -l /<acmountp>/OPS/mss/ALOGs/DSS 

4 Check that the required application sub­
directory exists by use of the command 

Type ls -l /<acmountp>/OPS/mss/ALOGs/DSS 
/ScienceDataServer 

17.11.2.3 Copy ALOG file and Write to archive 

The procedure may start with this step if the sub-system and application specific archive sub­
directory has previously been verified and/or created as above. 

1. If you are not already logged in as “alogxfr” set your userid to this user with use of the 
command ‘su’ as follows: 

su - alogxfr 
Note the ‘-‘ is separated by white-space from the userid ‘alogxfr’. Enter the ‘alogxfr’ account 
password when prompted. Verify that you are now user ‘alogxfr’ with the command 
‘whoami’. 

2.	 Copy the required ALOG file from the application host to the home directory of user 
‘alogxfr’. This can be achieved by more than one sequence of commands. However the 
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recommended route is by use of the ‘secure shell’ command, ‘ssh’. Assuming the 
application host name is “remhost”, ‘secure shell’ to it with the command: 

ssh <remhost> 
If prompted enter the password for the alogxfr account. If you enter the correct password and 
the connection is refused (e.g. with the message “Secure connection to <remhost> refused”) 
then contact your local System Administration to enable ‘ssh’ for account ‘alogxfr’. 
Assuming the ALOG file is in the location “alogdir” and named “alogfile” verify its 
existence and size with the command: 
ls –l /<alogdir>/<alogfile> 
Now copy the file to the home directory of user ‘alogxfr’: 
cp –p /<alogdir>/<alogfile> ~ 
Note: for OPS mode the default location of the ALOG file (value of “<alogdir>”) is: 

/usr/ecs/OPS/CUSTOM/logs 
Exit from the ‘ssh’ session using: 
exit 
Verify that you are now running again on the STMGT host and still as account “alogxfr” 
with the commands: 
hostname 
whoami 

3. Verify that the file has been successfully copied by comparing the results of the following 
‘ls’ with those of the ‘ls’ command above: 

ls –l ~/<alogfile> 
The file size should be the same or slightly larger than before (if the ALOG file is in use it 
may have grown slightly in the interval between the above ‘ls –l’ and ‘cp’ commands). 

4.	 Change directory to the appropriate sub-directory location within the “mss” volume 
group for this file. For example for file 
EcDsScienceDataServer.ALOG.19981014232357 

Change directory to the sub-system DSS and application “ScienceDataServer” sub-directory

i.e.:

cd /<acmountp>/OPS/mss/ALOGs/DSS/ScienceDataServer


5.	 NOTE that only one copy of a given ALOG file name can be preserved within a single 
directory in the archive. Uniqueness of ALOG files is determined by their 
“.<timestamp>” component. This value (format “.YYYYMMDDHHMMSS” e.g. 
“.19981014232357”) identifies to the second the date and time of the file’s creation. To 
enable multiple instances of the same named ALOG file (i.e. with the same file name 
including the timestamp) to be archived the file name in the archive should be extended 
with an operator entered three-digit numbering extension, e.g. “.001”. 

6.	 Check for pre-existence in the archive of an identically named file with the command: 
ls –l ./<alogfile>.??? 
If any such files are found select the next available three-digit file extension number, i.e. 
“.nnn”. 

7.	 Write the ALOG file to be archived to the AMASS cache. NOTE currently (Feb. 1999) 
this action must NOT use the normal Unix ‘cp’ command. Instead the ECS command 
“EcUtCopyExec” must be used. To write the first instance of a specific ALOG file 
(normal activity) use: 
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EcUtCopyExec ~alogxfr/<alogfile> . 

To write a new instance of the file (i.e. because the ALOG file name has not been updated by 
server restart since a previous copy of the log was archived) use: 

EcUtCopyExec ~alogxfr/<alogfile> ./<alogfile>.<nnn> 
8. The EcUtCopyExec action commits the file to the archive but the copy in ~alogxfr must 

now be removed. 
Check that the file has been successfully copied with command: 
ls –l ./<alogfile> 
The file size should be the same as that in ~/alogxfr i.e. compare the output from the above 
‘ls’ with the output from: 
ls -l ~/<alogfile> 
The local copy of the ALOG file made in ~alogxfr must now be removed. Move to the home 
directory of user alogxfr, check the existence of the local ALOG file copy, remove it and 
check on its deletion with the following commands: 
cd 
ls <alogfile> 
rm <alogfile> 
ls <alogfile> 
This completes the procedure for archiving of an ALOG file. 

Table 17.11-4. Copy and write ALOG file to Archive– Quick-Steps 
Step What to Do Action to take 

1 Verify that you are logged in as alogxfr Type whoami 

3 Login to remote host Type ssh <remote host name> 

4 Verify existence and sizeof of ALOG file in 
directory 

Type ls –l /<alogdir>/<alogfile> 

5 Copy the file to the home directory user 
alogxfer 

Type cp –p /<alogdir>/<alogfile> ~ 

6 Exit the secure shell session Type exit 

7 Compare the file transfer results Type ls –l ~/<alogfile> 

8 Change directory to the appropriate sub­
directory 

cd /<acmountp>/OPS/mss/ALOGs/DSS/ScienceDataServer 

9 Check for pre-existence in the archive of 
an identically named file 

Type ls –l ./<alogfile>.??? 

10 Write the ALOG file to be archived to the 
AMASS cache 

Type EcUtCopyExec ~alogxfr/<alogfile> 

11 Check that the file has been successfully 
copied 

ls –l ./<alogfile> 

12 Remove the local copy of the ALOG file 
made in ~alogxfr. 

rm <alogfile> 
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17.11.3 ALOG File Retrieval from Archive 

This procedure supports retrieval from the archive to the home directory of the “alogxfr” account 
of a specific instance of an ALOG. 

1. As input to this procedure you will need the following information: 

•	 The name of the source ECS application which created the ALOG file and which 
ECS sub-system it belongs to. 

•	 To know which STMGT hosts mount the AMASS cache and the local name of the 
mount point for that cache. 

• The alogxfr account password (for writing local copy of the ALOG file). 

2. Select the STMGT host for use in this activity. It must mount the AMASS cache e.g. 
directory: /<acmountp>/OPS/ 

Within this procedure this mount point will be referenced as “acmountp”. 

3. Login as alogxfr to the chosen STMGT host and enter the password 

• Remember that your password is case sensitive. 

4.	 Use the amassstat command to determine if AMASS is running. If it is not you can not 
continue until AMASS has been restarted. Contact the AMASS Operator. 

5. Check that the required top-level Volume Group “mss” can be accessed by use of the 
command: 

ls /<acmountp>/OPS/mss 

For modes other than “OPS” substitute the required mode abbreviation. If this command 
fails then contact STMGT/Archive operators to check on the Volume Groups availability. 

6. Check that the next required level of sub-directory also exists i.e. 

ls /<acmountp>/OPS/mss/ALOGs 

If it does not then no ALOG files have been correctly entered into the archive using the 
above procedure or the AMASS archive database has been lost or corrupted. 

7. Determine the ECS Sub-system and Application names for the ALOG file being sort. 
You can also use the commands ‘ls’ and ‘cd’ to search the sub-directories under volume 
group “mss” for available archived ALOGs. 

8. ALOG files follow a standard naming convention of: 

<ApplicationName>.ALOG.<timestamp> 

This file naming is preserved when they are written to the archive by the above procedure 
(with the optional addition of a three-digit numeric identifier). In particular from the 
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“ApplicationName” the originating sub-system and ECS application name can be 
derived. The timestamp identifies the date and time at which the ALOG file was created. 

9. For example for ALOG file: 

EcDsScienceDataServer.ALOG.19981014232357 

the related sub-system is “DSS” and application name “ScienceDataServer”. These 
values are used to define the sub-directory in which applicable ALOG files have been 
archived, e.g. in sub-directory “/<acmountp>/OPS/mss/DSS/ ScienceDataServer”. 

10. Change directory to the location where the required ALOG file(s) reside, e.g. 

cd /<acmountp>/OPS/mss/ALOGs/DSS/ ScienceDataServer 

11. Search for matching ALOG files with ‘ls’ e.g.: 

ls < ApplicationName >.ALOG.* 

12. Select the ALOG file(s) required. Where multiple instances of the identically named (i.e. 
including time-stamped) file were archived they should be differentiated by a numerical 
file name extension, e.g. “.001”, and by their file creation time (time of file copying into 
the archive). 

13. Read a copy of the ALOG file from the archive. NOTE currently (Feb. 1999) this action 
must N O T  use the normal Unix ‘cp’ command. Instead the ECS command 
“EcUtCopyExec” must be used. To copy a specific ALOG file (normal activity) to the 
home directory of user “alogxfr” use: 

EcUtCopyExec <alogfile> ~ 

14. The ALOG file copy should now be available in the home directory of user “alogxfr” for 
further use, i.e. can be found with one or all of the following commands: 

ls -l ~/<alogfile> 

ls -l ~alogxfr/<alogfile> 

cd; ls -l <alogfile> 

The file size should match that in the archive copy. This completes the procedure for 
reading ALOG files from the archive. 
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Table 17.11-5. ALOG file retrieval from Archive – Quick-Step Procedures

Step What to Do Action to take 

1 Login to Storage Management Host Type login alogxfr 

2 Determine if AMASS is running Type ammassstat 

3 Check that the required top level 
Volume Group can be accessed 

Type ls /<acmountp>/OPS/mss 

4 Check that the next required level 
of sub-directory also exists 

Type ls /<acmountp>/OPS/mss/ALOGs 

5 Change directory to the location 
where the ALOG file(s) reside. 

cd /<acmountp>/OPS/mss/ALOGs/DSS/ ScienceDataServer 

6  Search for matching ALOG files ls < ApplicationName >.ALOG.* 

7 Copy a specific ALOG file to alogxfr EcUtCopyExec <alogfile> ~ 
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18. Data Distribution


This section describes the procedures the Data Distribution Technician (DDT) can use when 
performing data distribution activities at the Distributed Active Archive Centers (DAACs). Data 
Distribution is a process of retrieving archived data and providing the data to users in response to 
the users’ request. The primary functions provided to the DDT are monitoring and controlling of 
distribution requests. Data Distribution processing mainly consists of preparing requested data 
products for distribution on specified media or via the network and subsequently delivering or 
causing the delivery of data products to the requester. 

In addition to preparing the data, packaging materials are generated automatically if the data is to be 
distributed on media, and read-me files if the data is to be distributed via the network. The 
packaging materials include the packing list, which shows all data files stored on the delivery 
media. 

Data Distribution is facilitated through three mechanisms; 

• Hard media distribution by tape (8mm or D3) or (in the future) CD-ROM. 

•	 Electronic pull where the user is notified where to find data and is allowed to ftp it from a 
temporary ECS storage area. 

•	 Electronic push is where the ECS system uses an ftp put command to push the data to a 
predefined location on the end-user’s platform. 

Of these three mechanisms, only the electronic push is subject to errors not associated with 
hardware/media or software faults. A push distribution might fail because the remote location was 
not available, or the disk capacity was insufficient. 

Note: Data Distribution threshold, determined by the capacity of the media type, is set up during 
Custom Code installation using ECSASSIST GUI. These are tunable parameters that may be 
modified at any time to accommodate the capacity of each media type. See sections 4.1.11.2.1.4 – 
“ECSAssist Subsystem Manager’s mkcfg file selection screen” and 4.1.11.2.1.5 - “ECSAssist 
Subsystem Manager’s mkcfg screen” of the ECSASSIST documentation (609-CD-510-001), for 
more information relative to the process for setting of these parameters. In addition, please refer to 
the specific Installation Instructions associated with DDIST that are generated for each custom code 
release. 

Table 18.1-1 identifies the different types of media used within the ECS system. Each cartridge is 
identified by means of a bar code label that shows the media number. As the system matures more 
information about the bar code label process will be available. 
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Table 18.1-1. Distribution Media Types

Media Type Media Name Media Purpose 

8mm 8 Millimeter cartridges Distribution 

D3 D3 tape cartridge Distribution 

CD ROM Distribution 

Electronic Push ftp “put” Distribution 

Electronic Pull ftp ”get” Distribution 

Section 18.1 describes Data Distribution Custom Software items. Section 18.2 describes the ECS 
Data Distribution Operator tool. Section 18.3 describes media operations. Section 18.4 describes 
how to prepare products for shipment. Section 18.5 describes the process for recovering from a 
data distribution failure. 

18.1 Data Distribution Custom Software Items 

The Data Distribution custom software items monitor and control processing for distribution 
requests. Data Distribution processing directs storage management software to place data for 
distribution in working storage and creates packing lists as needed. Storage management software 
is directed to copy data on to tape or ftp push data as required and send notifications as required. 
Data Distribution performs limited automatic error response by suspending requests when most 
errors are encountered. The following list defines the ECS Data Distribution custom software 
items: 

1.	 EcDsDistributionServer - the server process that provides the control and coordination for data 
distribution through request processing. 

2.	 EcDsDdistGui - the GUI process that allows operations to initiate, track, and manipulate 
distribution requests by utilizing input GUI controls and Sybase Database information. 

3.	 Data Base - the Sybase database server process that contains the request list, updates the 
request configuration and provides the request configuration to GUI operations. Data 
Distribution shares a database with Storage Management. 

18.2 ECS Data Distribution Operator Tool 

The Data Distribution Operator Tool GUI is used to interface with the DDT. The GUI provides 
error conditions and status to DDT, and allows the DDT to set parameters and control operations. 
The ECS Data Distribution Operator tool has five tab widgets; Distrib’n Requests, 
System Requests, Tape ID’s, Packing List, and Event Logging. The Distrib’n 
Requests screen (Section 18.2.1) provides the DDT the capability to monitor detailed information 
on data distribution request activities, control operations including suspending, canceling, and 
resuming requests, changing priorities on requests, and indicate shipping status. The other tabs 
provide functionality still TBD. 

The Activity Checklist table that follows provides an overview of the Data Distribution Operator 
tool. Column one (Order) shows the order in which tasks should be accomplished. Column two 
(Role) lists the Role/Manager/Operator responsible for performing the task. Column three (Task) 
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provides a brief explanation of the task. Column four (Section) provides the Procedure (P) 
section number or Instruction (I) section number where details for performing the task can be 
found. 

Table 18.2-1. ECS Data Distribution Operator Tool - Activity Checklist 
Order Role Task Section 

1 DDT Starting the Data Distribution Operator GUI (P)18.2.1 

2 DDT Monitoring/Controlling Data Distribution 
Request 

(P)18.2.2 

3 DDT Configuring Data Distribution Polling and Error 
Retry Rate 

(P)18.2.3 

4 DDT Changing the Priority of Data Distribution 
Requests 

(P)18.2.4 

5 DDT Suspending Data Distribution Requests (P)18.2.5 

6 DDT Resuming Processing on a Suspended Data 
Distribution Request 

(P)18.2.6 

7 DDT Canceling a Data Distribution Request (P)18.2.7 

18.2.1 Starting the Data Distribution Operator GUI 

The Data Distribution Operator GUI provides operations personnel at a DAAC the capability to 
manage the distribution requests. The GUI is used to monitor data that has been retrieved from 
the File Storage Management System (FSMS) for distribution to users in response to their 
requests. Starting the Data Distribution Operator GUI in normal operations will be just a matter of 
clicking an icon that appears on your desktop. Because the desktop configurations have not been 
installed to date it will be necessary to follow the procedure described below. 

1	 Bring up the Data Distribution Operator GUI if the Data Distribution Operator GUI has 
not already been brought up. From a SUN workstation or X-Term NCD Terminal use 
secure shell to log into the Data Distribution Operator host. Enter /tools/bin/ssh 
<hostname> and press the return key. Example /tools/bin/ssh 
g0dis02.gsfcb.ecs.nasa.gov 

2	 If prompted to do so, log into the Data Distribution Operator workstation using your user 
identifier and password by typing YourUserID, and then press Return. 
• A password prompt is displayed. 

3 Enter YourPassword or YourPassphrase (as applicable), then press Return. 
• You are authenticated as yourself. 

4	 Set your display environment using the following command: 
setenv DISPLAY <hostname:0.0> and press the return key 

5	 Change directory to the Data Distribution GUI directory using the following command: 
cd /usr/ecs/<mode>/CUSTOM/utilities and press the return key 
• The mode will most likely be one of the following: 
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• OPS (for normal operations) 
• TS2 (for site testing) 

6	 Start the Data Distribution Operator GUI using command: 
EcDsDdistGuiStart <mode> and press the return key 
• The Data Distribution Operator tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

Table 18.2-2. Starting Data Distribution Operator GUI - Quick-Steps 
S t e p  What to Enter or Select Action to Take 

1 /tools/bin/ssh <hostname> press Return 

2 YourUserID (If prompted) press Return 

3 YourPassword or YourPassphrase press Return 

4 setenv DISPLAY <hostname:0.0> press Return 

5 cd /usr/ecs/<mode>/CUSTOM/utilities press Return 

6 EcDsDdistGuiStart <mode> press Return 

18.2.2 Monitoring/Controlling Data Distribution Requests 

The DDT can determine if a distribution request has completed by viewing the entries in the ECS 
Data Distribution Operator GUI tool. The DDT can view data distribution requests, change the 
priority on a selected request, mark a selected request shipped, terminate a request, and filter on all 
or specific requests. Additionally the filter is by Request ID, Requester, or All Requests, Media 
Type, and State. Each data distribution request is displayed with the Request ID, Requester, Media 
type, # of Files, Total Size of the request in Mbytes, State, Ordered State, Priority, Submission 
Time, End Time, # Media, # Granule, Media # Completed, ESDT Type, Order ID, and Warm Start 
status. 

The following procedure will display all data distribution requests currently in the system, select 
filter, and view a request by media type and state. Table 18.2-3 presents the steps required to 
monitor data distribution requests in a condensed manner. If you are already familiar with the 
procedure, you may prefer to use the quick-step table at the end of this procedure. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 

1 Click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running; if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Click on the GUI’s Distrib’n Requests tab. 
• The Data Distribution - Track Activity window is displayed. 
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•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size 
(Mbytes), State, Ordered State, Priority, Submission Time, End Time, 
# of Media, # Granules, Media # Completed, ESDT, Order ID, and Warm 
Start. 

3	 Select View → Filter from the pull-down menu to view specific distribution requests by 
media type and/or state. 
• The Distribution Filter Requests dialog box is displayed. 

•	 The Distribution Filter Requests dialog box makes it possible to select specific 
distribution requests by request ID, requester, media type, or state, to be displayed in 
the Data Distribution - Track Activity window. 

4	 Click the 8 mm radio button under Media Type, followed by the Apply and OK buttons 
to view all requests for that media type. 
•	 The Data Distribution - Track Activity window will reappears with only the 

requests in the system for the 8 mm media type. 

5	 Select View →  Filter from the pull-down menu again to view specific distribution 
requests by state and media type. 
• The Distribution Filter Requests dialog box is displayed. 

6	 Click the 8 mm radio button under Media Type, followed by the Apply button, then click 
the Pending radio button under State, followed by the Apply button and the OK button 
to view all requests that are waiting for the 8 mm tape drive. 
•	 The Data Distribution - Track Activity window will reappears with the 

requests for the 8 mm media type in the “pending” state. 
•	 Make sure that the 8 mm tape library has sufficient tapes to handle the request in the 

system. 

7	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 

Table 18.2-3. Monitoring/Controlling Data Distribution Requests -
Quick-Steps (1 of 2) 

S t e p  What to Enter or Select Action to Take 

1 Data Distribution Operator GUI icon double Click 

2 Distrib’n Requests tab single Click 

3 View → Filter single Click 

4 8 mm radio button single Click 

5 Apply button single Click 

6 OK button single Click 

7 Filter… button single Click 

8 8 mm radio button single Click 

9 Apply button single Click 
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Table 18.2-3. Monitoring/Controlling Data Distribution Requests -

Quick-Steps (2 of 2)


S t e p  What to Enter or Select Action to Take 

1 0  Pending radio button single Click 

1 1  Apply button single Click 

1 2  OK button single Click 

1 3  File → Exit single Click and drag 

18.2.3 Configuring Data Distribution Polling and Error Retry Rate 

The polling rate specifies how often (in seconds) the system updates the information displayed in 
the Data Distribution - Track Activity window. The Data Distribution Operator GUI 
Options menu provides the Data Distribution Technician with a means of switching the Data 
Distribution database polling function on or off. The technician can modify the DDist Polling Rate 
and the Error Retry Rate. The error retry rate specifies the amount of time (in seconds) that the 
system waits before trying to poll the Data Server after a failed attempt. 

The following procedures for configuring data distribution polling and error retry rate starts with 
the assumption that all applicable servers and the Data Distribution Operator GUI are 
currently running and the Data Distribution - Track Activity window on the Distrib’n 
Requests tab is being displayed. Table 18.2-4 presents the steps required to configure the Data 
Distribution polling rate in a condensed manner. If you are already familiar with the procedure, 
you may prefer to use the quick-step table at the end of this procedure. If you are new to the 
system, or have not performed this task recently, you should use the following detailed procedure: 

1 Select Options → Refresh Options from the pull-down menu. 

• The Refresh Options dialog box is displayed. 

2	 Click on the DDist Polling On button, to change the DDist Polling state (from off to on 
or vice versa), 

• If the button does not have a check mark in it, clicking on it turns DDist Polling on. 
• If the button already has a check mark in it, clicking on it turns DDist Polling off. 

3	 Enter the desired value (in seconds) in the DDist Polling Rate field, to change the 
polling rate. 

4	 Enter the desired value (in seconds) in the Error Retry Rate field, to change the error 
retry rate. 

5	 Click on the OK button to apply the selections and dismiss the Refresh Options dialog 
box. 
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Table 18.2-4. Configuring Data Distribution Polling and

Error Retry Rate - Quick-Steps


S t e p  What to Enter or Select Action to Take 

1 Options → Refresh Options single Click 

2 Ddist Polling On single Click 

3 Ddist Polling Rate value in seconds press Return 

4 Error Retry Rate value in seconds press Return 

5 OK single Click 

18.2.4 Changing the Priority of Data Distribution Requests 

The DDT can change the priority of a selected data distribution request only after the request has 
been suspended. The priority of an active data distribution request can not be changed. Priority of a 
request can be changed by selecting the request of interest, then selecting the priority, and clicking 
on the “Apply” button in the Change Priority frame. 

The following procedure will explain the Change Request Priority. The available priorities are 
Xpress, Vhigh, High, Normal, and Low. Table 18.2-5 presents the steps required to monitor data 
distribution requests in a condensed manner. If you are already familiar with the procedure, you 
may prefer to use the quick-step table at the end of this procedure. If you are new to the system, or 
have not performed this task recently, you should use the following detailed procedure: 

1	 Double click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running, if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator GUI tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Click on the GUI’s Distrib’n Requests tab. 
• The Data Distribution - Track Activity window is displayed. 
•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size 

(Mbytes), State, Ordered State, Priority, Submission Time, End Time, 
# of Media, # Granules, Media # Completed, ESDT, Order ID, and Warm 
Start. 

3	 Select the desired request from the request list displayed in the Data Distribution -
Track Activity window whose priority must be changed. 
• The request is highlighted. 

4	 Press the Suspend push button on the GUI before the request is marked as being 
shipped. 
• The action is successful if no error dialog appears. 
• The desired request’s state changes to “Suspend”. 
•	 A check mark will appear in the left hand column to show which request item was 

changed. 
•  Verify that the desired request’s state has changed to “Suspend”. 
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5	 Click and hold the Change Priority option button to display a menu of priorities, move 
the mouse cursor to the desired selection (highlighting it), then release the mouse button. 
• The following priority codes are available: 
(Xpress, Vhigh, High, Normal, Low) 
• The desired request’s priority changes to “High”. 
• The action is successful if no error dialog appears. 
•	 A check mark will appear in the left hand column to show which request item was 

changed. 

6 Press the Apply or Refresh button. 
• The data distribution list is updated with the most recent request list. 

• Verify that the desired request’s priority has changed to “High”. 

7	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 

Table 18.2-5. Changing the Priority of Data Distribution Requests -
Quick-Steps 

S t e p  What to Enter or Select Action to Take 

1 Data Distribution Operator GUI icon double Click 

2 Distrib’n Requests tab single Click 

3 Request whose Priority is to change single Click 

4 Suspend push button single Click 

5 Change Priority push button single Click and hold 

6 Apply or Refresh push single Click 

7 File → Exit single Click and drag 

button 

18.2.5 Suspending Data Distribution Requests 

Under certain circumstances it may be advisable to suspend the processing of a data distribution 
request and resume it at a later time. For example, if there is a very large request that is taking up 
resources and causing others requests to back up  (especially requests from data processing that 
must be filled to allow processing to proceed). The processing of that request should be suspended 
until a time when there is less demand on data distribution. Data Distribution Requests can also be 
suspended when the data distribution threshold, that were set for each media type, has been 
exceeded. The DDT can suspend a selected request thus putting it on a hold queue until processing 
is later resumed. A request will automatically suspend if errors are encountered. Each DAAC will 
be responsible for identifying reasons to operationally suspend requests. 

The following procedure will put an incoming data distribution request on the hold queue using the 
Suspend function. Table 18.2-6 presents the steps required to suspend a data distribution request 
in a condensed manner. If you are already familiar with the procedure, you may prefer to use the 
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quick-step table at the end of this procedure. If you are new to the system, or have not performed 
this task recently, you should use the following detailed procedure: 

1	 Double click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running, if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator GUI tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Click on the GUI’s Distrib’n Requests tab. 
• The Data Distribution - Track Activity window is displayed. 
•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size 

(Mbytes), State, Ordered State, Priority, Submission Time, End Time, 
# of Media, # Granules, Media # Completed, ESDT, Order ID, and Warm 
Start. 

3	 Select the desired request from the request list displayed in the Data Distribution -
Track Activity window whose state must be changed. 
• The request is highlighted. 

4	 Press the Suspend push button on the GUI before the request is marked as being 
shipped. 
• The action is successful if no error dialog appears. 
• The desired request’s state changes to “Suspend.” 
•	 A check mark will appear in the left hand column to show which request item was 

changed. 

5 Press the Refresh push button. 
• The data distribution list is updated with the most recent request list. 

• Verify that the desired request’s state has changed to “Suspend.” 

6	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 

Table 18.2-6. Suspend a Request - Quick-Steps 
S t e p  What to Enter or Select Action to Take 

1 Data Distribution Operator GUI icon double Click 

2 Distrib’n Requests tab single Click 

3 Request whose Status is to change single Click 

4 Suspend push button single Click 

5 Refresh push single Click 

6 File → Exit single Click and drag 

button 
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18.2.6 Resuming Processing on a Suspended Data Distribution Request 

The DDT can resume processing on a suspended request using the Resume function. The 
following procedure will restart the normal 18.2-7 presents the steps required to resume a data 
distribution request in a condensed manner. If you are already familiar with the procedure, you 
may prefer to use the quick-step table at the end of this procedure. If you are new to the system, or 
have not performed this task recently, you should use the following detailed procedure: 

1	 Click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running, if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator GUI tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Click on the GUI’s Distrib’n Requests tab. 
• The Data Distribution - Track Activity window is displayed. 

•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size 
(Mbytes), State, Ordered State, Priority, Submission Time, End Time, 
# of Media, # Granules, Media # Completed, ESDT, Order ID, and Warm 
Start. 

3	 Select the suspended request from the request list displayed in the Data Distribution -
Track Activity window whose priority must be changed. 
• The request is highlighted. 

4 Press the Resume push button on the GUI to resume processing of the request. 
• The action is successful if no error dialog appears. 
• The suspended request’s state changes to “Resume.” 
•	 A check mark will appear in the left hand column to show which request item was 

changed 

5 Press the Refresh push button. 
• The data distribution list is updated with the most recent request list. 

• Verify that the desired request’s state has changed to “Resume.” 

6	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 
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Table 18.2-7. Resuming Processing on a Suspended

Data Distribution Request - Quick-Steps


S t e p  What to Enter or Select Action to Take 

1 Data Distribution Operator GUI icon double Click 

2 Distrib’n Requests tab single Click 

3 Request whose Status is to change single Click 

4 Resume push button single Click 

5 Refresh push button single Click 

6 File → Exit single Click and drag 

18.2.7 Canceling a Data Distribution Request 

The DDT can cancel an incoming request using the Cancel function. The following procedure will 
cancel a data distribution request using the Cancel function. Table 18.2-8 presents the steps 
required to cancel a data distribution request in a condensed manner. If you are already familiar 
with the procedure, you may prefer to use the quick-step table at the end of this procedure. If you 
are new to the system, or have not performed this task recently, you should use the following 
detailed procedure: 

1	 Double click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running, if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator GUI tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Click on the GUI’s Distrib’n Requests tab. 
• The Data Distribution - Track Activity window is displayed. 

• 	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size (Mbytes), 
State, Ordered State, Priority, Submission Time, End Time, # of Media, # Granules, 
Media # Completed, ESDT, Order ID, and Warm Start. 

3	 Select the request you wish to cancel from the request list displayed in the Data 
Distribution - Track Activity window whose priority must be changed. 
• The request is highlighted. 

4 Press the Cancel push button on the GUI to resume processing of the request. 
• The action is successful if no error dialog appears. 
• The highlighted request’s state changes to “Cancel.” 
•	 A check mark will appear in the left hand column to show which request item was 

changed 

5 Press the Refresh push button. 
• The data distribution list is updated with the most recent request list. 

• Verify that the desired request’s state has changed to “Cancel.” 
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6	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 

Table 18.2-8. Canceling a Data Distribution Request - Quick-Steps 
S t e p  What to Enter or Select Action to Take 

1 Data Distribution Operator GUI icon Double Click 

2 Distrib’n Requests tab Single Click 

3 Request whose Status is to change Single Click 

4 Cancel push button single Click 

5 Refresh push button single Click 

6 File → Exit single Click and drag 

18.3 Physical Media Operations 

This section describes how a DDT might perform media operations. Physical media operations 
functions such as loading and unloading tapes into distribution peripherals, mounting and 
dismounting tapes from distribution peripherals, handling distribution media tape faults, and 
labeling distribution media are discussed in the procedures that follow. 

The Activity Checklist table that follows provides an overview of media operations. Column one 
(Order) shows the order in which tasks should be accomplished. Column two (Role) lists the 
Role/Manager/Operator responsible for performing the task. Column three (Task) provides a brief 
explanation of the task. Column four (Section) provides the Procedure (P) section number or 
Instruction (I) section number where details for performing the task can be found. 

Table 18.3-1. Media Operations - Activity Checklist 
Order Role Task Section 

1 DDT Loading and Unloading Tapes (P) 18.3.1 

2 DDT Correcting Tape Fault (I) 18.3.2 

3 DDT Labeling Tape Cartridges (I) 18.3.3 

Detailed procedures for tasks performed by the DDT are provided in the sections that follow. 

18.3.1 Loading and Unloading Tapes 

Loading and unloading tapes into the 8mm tape stackers is a manual process. It is recommended 
that the DDT check the stackers at the beginning of each shift and throughout the day to make sure 
tapes are available for the distribution process to write to when fulfilling hard media distribution 
requests. When the hard media distribution requests have completed by writing data to the 8mm 
tapes the distribution process will automatically unmount and deallocate the tape. Tapes can be 
removed and replaced individually without having to load or unload the entire stacker. 
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The procedure that follows explains how to load and unload the 8mm tape stackers. Table 18.3-2 
presents the steps required to verify there are no 8mm requests in the system and to load and 
unload the 8mm tape stackers in a condensed manner. If you are already familiar with the 
procedure, you may prefer to use the quick-step table at the end of this procedure. If you are new 
to the system, or have not performed this task recently, you should use the following detailed 
procedure: 

1	 Double click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running, if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Click on the GUI’s Distrib’n Requests tab. 
• The Data Distribution - Track Activity window is displayed. 

•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size (Mbytes), 
State, Ordered State, Priority, Submission Time, End Time, # of Media, # Granule, 
Media # Completed, ESDT, Order ID, and Warm Start. 

3 Click on the Refresh button to update the data displayed on the screen. 
• The data distribution list is updated with the most recent request list. 

4	 Select View → Filter from the pull-down menu to view specific distribution requests by 
media type. 
• The Filter Requests dialog box is displayed. 

5	 Click the 8 mm radio button, followed by the Apply  and OK buttons to view all requests 
for that media type. 
•	 The Data Distribution - Track Activity screen will appears with only the requests 

in the system for 8mm tapes. 
• Check the state of all 8mm requests to make sure they are not active. 

•	 Status of the request displayed in the State column of the Data Distribution 
Requests list may be… (Waiting for Shipment, Shipped, Suspended). 

•	 Status of the request displayed in State column of the Data Distribution Requests 
list should not be…. (Pending, Active, Staging or Transferring). 

•	 Either wait until all 8mm distribution requests are in an inactive state or suspend all 
active 8mm data distribution requests using the procedure in section 18.2.5 
Suspending Data Distribution Requests. 

6	 When there are no 8 mm distribution requests in the system, stop EXB-210 operation and 
open the door by turning the key in the key-lock of the EXB-210 8mm tape stacker to stop 
tape stacker unit operations. Wait for the tape stacker cartridge handling mechanism to 
finish the current operation and moves to the “park” position. 
• The doors interlock mechanism releases. Now open the front door. 

7 Remove the cartridge holder by pulling out first from the top, and then the bottom. 
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2

3

4

5

6

7

8 Gently remove the tapes by pulling each one straight out from its slot. 

9	 Make sure that the write-protect switch on the replacement tapes are set correctly for the 
desired operation. Either Read-Only (write-protected) or Writable. 

1 0 	 Hold the tapes so that the write protect switch is at the bottom, or toward the right. Insert 
the tape by pushing gently straight into a slot in the cartridge holder. 

1 1 	 Replace the cartridge holder by inserting the two orientation features on the bottom of the 
holder into the bottom of the plate. Snap the holder into place by pressing on the top. 

12 Close the door to start the process of resuming EXB-210 tape stacker operation. 

13	 Lock the door by turning the key in the key lock. After the door is closed, unit attention is 
returned to the data distribution server host. 

14	 If any 8mm distribution requests were suspended to allow stacker unloading/loading, 
resume distribution request processing using the procedure in section 18.2.6 Resuming 
Processing on a Suspended Data Distribution Request. 

15	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 

Table 18.3-2. Loading and Unloading Tapes - Quick-Step Procedures 
S t e p  What to Enter or Select Action to Take 

Data Distribution Operator GUI icon double Click 

Distrib’n Request tab single Click 

View → Filter single Click 

8 mm radio button single Click 

Apply button single Click 

OK button single Click 

File → Exit single Click and drag 

18.3.2 Correcting Tape Faults 

Tape faults may occur which prevent the writing to a specific tape but not the drive. When the 
system is unable to write to a specific drive the operator will be notified, and the system will restart 
the specific operation on a new tape. 

Correcting a tape fault involves replacing the faulty tape cartridge. The procedure is identical to 
that for Loading and Unloading Tapes. What differs is the reason for replacing the tape; i.e., 
because the tape cartridge is faulty rather than full. 
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18.3.3 Labeling Tape Cartridges 

The distribution process automatically creates media and shipping labels. Preprinted bar code 
labels will be purchased for the 8mm tape cartridges. When the 8mm tapes are delivered to the 
distribution area the tapes will be removed from their boxes and the DDT will affix bar coded labels 
to the area on the edge of the tape. 

18.4 Product Shipment 

Before products are packaged and shipped the contents of the hard media should be verified. The 
tapes should be read to make sure they are readable and the contents are correct matching their 
corresponding packing slips. 

The Activity Checklist table that follows provides an overview of the product shipment process. 
Column one (Order) shows the order in which tasks should be accomplished. Column two 
(Role) lists the Role/Manager/Operator responsible for performing the task. Column three (Task) 
provides a brief explanation of the task. Column four (Section) provides the Procedure (P) 
section number or Instruction (I) section number where details for performing the task can be 
found. Column five (Complete?) is used as a checklist to keep track of which task steps have 
been completed. 

Table 18.4-1. Product Shipment - Activity Checklist 
Order Role Task Section 

1 DDT Performing Quality Control of Hard Media (P) 18.4.1 

2 DDT Packaging Hard Media Products for Shipment (I) 18.4.2 

3 DDT Mark Hard Media for Shipment (P) 18.4.3 

Detailed procedures for tasks performed by the DDT are provided in the sections that follow. 

18.4.1 Performing Quality Control of Hard Media 

Each DAAC should individually evaluate their Quality Control needs and the impact to the overall 
throughput of distribution processing to achieve the proper balance of throughput against Quality 
Control processing requirements. Before products are packaged and shipped, the contents of the 
hard media should be verified. If possible, each media product should be read to ensure that the 
content meets the following conditions: 

• Readable. 

• Correct. 

• Matches the corresponding packing list. 

The procedure that follows identifies the steps required for performing Quality Control on tapes 
and other hard media. The procedure starts with the assumption that the DDT has logged into the 
ECS system and the proper desktop environment is being displayed. 
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1	 Bring up the Storage Management Operator GUI if the Storage Management Operator 
GUI has not already been brought up. From a SUN workstation telnet into the Storage 
Management Operator host. Enter /tools/bin/ssh <hostname> and press the return 
key. Example /tools/bin/ssh g0dis02. 

2	 If prompted to do so, log into the Storage Management Operator workstation using your 
user identifier by typing YourUserID, and then press Return. 
• A password/passphrase prompt is displayed. 

3 Enter YourPassword or YourPassphrase (as applicable) then press Return. 
• You are authenticated as yourself. 

4	 Set your terminal display environment using the following command: 
setenv DISPLAY <hostname:0.0> and press the return key 

5	 Change to the Storage Management Operator GUI directory using the following command: 
cd /usr/ecs/<mode>/CUSTOM/utilities and press the return key 

6	 Start the Storage Management Control GUI using command: 
EcDsStStmgtGuiStart <mode> and press the return key 
• The Storage Management Control GUI tool is opened. 
• The Configuration Parameter Reporting screen is displayed. 

7 Click on the Resource Schedule tab. 
•	 The Storage Management - Resource and Device Scheduling screen is 

displayed. 
• From this screen make a drive or stacker available for Quality Control use. 
•	 Check the tape label to make sure that the drive or stacker that you want to reserve 

was not used to write the tape 

8 Steps to schedule the resources are TBD. 

9	 Load the drive or stacker in accordance with the applicable loading and unloading 
procedure. 

1 0  Mount the tapes. 

1 1  List the contents of the tapes. 

1 2  Compare the list of the tapes’ contents with the packing list. 

1 3  Dismount the tapes. 

1 4  Unload the drive or stacker in accordance with the applicable loading/unloading procedure. 

1 5 	 Use the storage management reservation mechanism to return the drive or stacker to normal 
use. 
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Table 18.4-2. Performing Quality Control of Hard Media - Quick-Steps 
S t e p  What to Enter or Select Action to Take 

/tools/bin/ssh <hostname> press Return 

YourUserID (if prompted) press Return 

YourPassword or YourPassphrase press Return 

setenv DISPLAY <hostname:0.0> press Return 

cd /usr/ecs/<mode>/CUSTOM/utilities press Return 

EcDsStStmgtGuiStart <mode> press Return 

Resource Schedule tab single click 

18.4.2 Correcting Defective Tapes In Preparation For Shipment 

18.4.3 Packaging Hard Media Products for Shipment 

After the distribution process has completed and the contents of the tapes have been verified, the 
DDT will package the request for shipping. All hard media data requests must be packaged and 
sent out to the requester. The procedure to follows is DAAC dependent. Each DAAC should 
follow procedures currently in place for V0 Operations. 

18.4.4 Mark Hard Media for Shipment 

After the DDT completes the packaging process in preparation for shipping the media, he/she 
should use the DATA DISTRIBUTION OPERATOR GUI tool to mark the tapes for shipment. 
The DDT executes the DATA DISTRIBUTION OPERATOR GUI tool and goes to the Distrib’n 
Requests tab. A distribution request is selected from the list and can be marked shipped by 
activating the “Mark Shipped” push button. A request can only be successfully mark shipped 
when it is in the “Waiting for Shipment” state. An error dialog is displayed if the Data Distribution 
Server can not successfully execute the mark shipped operation. A request that has been 
successfully mark shipped changes its state to “Shipped." 

Table 18.4-3 presents the steps required to perform the mark for shipment process. If you are 
already familiar with the procedures, you may prefer to use this quick-step table. If you are new to 
the system, or have not performed this task recently, you should use the following detailed 
procedures: 

1 Click on the Data Distribution Operator GUI icon. This assumes that the Data 
Distribution GUI is running, if the GUI is not up, then follow the steps for bringing up the 
Data Distribution GUI outlined in section 18.2.1. 
• The Data Distribution Operator GUI tool is opened. 
• The Data Distribution - Track Activity screen is displayed. 

2 Select the “Distrib’n Requests” tab. 
• The Data Distribution - Track Activity window is displayed. 

3 Select the desired request whose state must be changed from “Waiting for Shipment." 
• The request is highlighted. 
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4 Press the Mark Shipped push button. 
•	 The action is successful if no error dialog appear with the message “DDIST Mark 

Shipped Failure." 

5 Press the Refresh push button. 
• The data distribution list is updated with the most recent request list. 

6	 Verify that the desired request’s state was changed from “Waiting for Shipment” to 
“Shipped.” 

7	 When you are finished monitoring distribution requests, select the Exit option from the 
File pull down menu to exit the GUI. 

Table 18.4-3. Mark Hard Media for Shipment - Quick-Steps 
S t e p  What to Enter or Select Action to Take 

Data Distribution Operator GUI icon double Click 

Distrib’n Requests tab single Click 

Request in “Waiting for Shipment” state single Click 

Mark Shipped push button single Click 

Refresh push button single Click 

File → Exit single Click and drag 

18.5 Recovery from a Data Distribution Failure 

When a Data Distribution error occurs, there may be a requirement for action to recover from the 
error. Recovery actions may be made necessary by an invalid fault or other errors that result in a 
Data Distribution failure. When a fault (error) occurs, the following action occur: 

• The processing of the Data Distribution request stops. 
•	 A message is sent to the Data Distribution Technician with a brief description of the 

problem. 

The Data Distribution Technician (DDT) may use the DDIST Monitor Control screen, the Data 
Distribution History Log (refer to the section on Data Distribution Status Monitoring) and/or the 
following log file (in the /usr/ecs/<mode>/CUSTOM/logs directory on the DDIST host machine) 
to review the failure event: 

• DistributionServer.Alog (data distribution server .Alog) 
• EcDsDdistGui.Alog 
• EcDsSt8MMServer.Alog 

In addition, it is possible to check the ECS Event Log (for events related to DDIST failure) using 
the ECS Event Log Browser tab on the Management Data Access (MDA) GUI. 

This section contains some examples of faults that are likely to occur, describes the notifications 
provided, and proposes operator actions in response to each fault situation. 
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The Activity Checklist table that follows provides an overview of the Recovery from a Data 
Distribution failure process. Column one (Order) shows the order in which tasks should be 
accomplished. Column two (Role) lists the Role/Manager/Operator responsible for performing the 
task. Column three (Task) provides a brief explanation of the task. Column four (Section) 
provides the Procedure (P) section number or Instruction (I) section number where details for 
performing the task can be found. 

Table 18.5-1. Recovery from a Data Distribution Failure -
Activity Checklist 

Order Role Task Section 

1 DDT Troubleshooting a Data Distribution Failure (P) 18.5.1 

2 DDT Recovering from Ddist Refresh Failure (P) 18.5.2 

3 DDT Recovering from a Ddist Cancel Failure (P) 18.5.3 

4 DDT Recovering from Ddist Set Priority Failure (P) 18.5.4 

5 DDT Recovering from Ddist Suspend/Suspend A Failure (P) 18.5.5 

6 DDT Recovering from Ddist Resume/Resume All Failure (P) 18.5.6 

7 DDT Recovering from Ddist Mark Ship Failure (P) 18.5.7 

8 DDT Checking Database Connections (P) 18.5.8 

9 DDT Display Data Distribution Error Logs (P) 18.5.9 

1 0 DDT Missing E-mail Notification Pre-Amble (P) 18.5.10 

18.5.1 Troubleshooting a Data Distribution Failure 

When troubleshooting a Data Distribution failure, use the procedure that follows. The procedure 
starts with the assumption that all applicable servers and the Data Distribution Operator GUI are 
currently running and the Data Distribution - Track Activity screen is displayed. 
Upon receipt of the operator alert, use the Data Distribution - Track Activity screen scroll bars as 

necessary to identify the faulty distribution request. 
•	 When there is a data distribution failure, the system provides the following three 

responses: 

− Logs the error. 

− Alerts the Distribution Technician. 
Review the information concerning the faulty distribution request. 
If additional information is needed, open and read the appropriate log file in the 

/usr/ecs/mode/CUSTOM/logs directory on the distribution host machine. 
• DistributionServer.Alog (data distribution server .Alog) 
• EcDsDdistGui.Alog 
• EcDsSt8MMServer.Alog 

Perform the appropriate recovery procedure depending on the nature of the problem: 
• Recovering from Ddist Refresh Failure 
• Recovering from a Ddist Cancel Failure. 
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• Recovering from Ddist Set Priority Failure. 
• Recovering from Ddist Suspend/Suspend All Failure 
• Recovering from Ddist Resume/Resume All Failure. 
• Recovering from Ddist Mark Ship Failure. 
• Checking Data Connections. 
• Missing E-Mail Notification Pre-Amble 

18.5.2 Recovering from Ddist Refresh Failure 

When the Data Distribution GUI encounters a communication loss with the Ddist Server a Ddist 
Refresh Error will occur during a requested GUI refresh. The Dialog Message GUI was not 
able to get a new request list from server. Consequently, if the GUI does not display data or if the 
display does not refresh there may not be activity within the system to report. The procedure starts 
with the assumption that all applicable servers and the Data Distribution Operator GUI are currently 
running and the Data Distribution - Track Activity screen is displayed. 
1	 Upon receipt of the operator alert, press the Reconnect button from the toolbar menu list 

to re-establish Ddist Server connection. 
2 Review the Data Distribution (EcDsDdistGui.Alog) log for additional information. 

18.5.3 Recovering from a Ddist Cancel Failure 

The DDT can cancel an incoming request using the Cancel function. An error dialog will display a 
Ddist Cancel Failure if the Distribution Server (EcDsDistributionServer) is unavailable. This is 
a problem because the GUI receives a failure from a server but the request was not canceled. The 
procedure starts with the assumption that all applicable servers and the Data Distribution Operator 
GUI are currently running and the Data Distribution - Track Activity screen is displayed. 
1	 Upon receipt of the operator alert, verify that canceling the request is a valid operation in 

the current state (e.g., Not valid if the current state is “Shipped.”) 
2	 Press the Reconnect button from the toolbar menu list to re-establish Ddist Server 

connection. 
3	 If the Distribution Server has gone down, notify the Operations Controller/System 

Administrator to have the server brought back up using HP OpenView. 
4	 After the Data Server is back on line, press the Reconnect button from the toolbar menu list 

to re-establish Ddist Server connection. 
5 Click on the GUI’s Distrib’n Requests tab. 

• The Data Distribution œ Track Activity window is displayed. 
•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size 

(Mbytes), State, Ordered Stated, Priority, Submission Time, End Time, # of Media, # 
Granules, Media # Completed, ESDT, Order ID, and Warm Start. 

6	 Select the request that produce the Ddist Cancel Failure error from the request list displayed 
in the Data Distribution – Track Activity window whose priority must be changed. 
• The request is highlighted. 

7 Press the Cancel push button on the GUI to resume processing of the request. 
• The action is successful if no error dialog appears. 
• The highlighted request‘s state has change to —Cancel.“ 
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8 Press the Refresh push button. 
• The data distribution list is updated with the most recent request list. 
• Verify that the desired request‘s state has changed to —Cancel.“ 

18.5.4 Recovering from Ddist Set Priority Failure 

The DDT can change the priority of a selected data distribution request only after the request has 
been suspended. The priority of an active data distribution request can not be changed. Priority of 
a request can be changed by selecting the request of interest, then selecting the priority, and 
clicking on the “Apply” button in the Change Priority frame. 

The Data Distribution GUI will display an error in the Operator Message window if there is a 
problem in changing the priority on a given request. A Ddist Set Priority Failure is due to 
possible communication failure (server down) with the Data Distribution Server (EcDsDistribution 
Server). The GUI has received failure from the server that the request set priority has failed. The 
procedure starts with the assumption that all applicable servers and the Data Distribution Operator 
GUI are currently running and the Data Distribution - Track Activity screen is displayed. 
1 Upon receipt of the operator alert, Press the Reconnect button from the toolbar menu list to 

re-establish Ddist Server connection. 
2 If the Distribution Server has gone down, notify the Operations Controller/System 

Administrator to have the server brought back up using HP OpenView. 
3 After the Data Server is back on line, press the Reconnect button from the toolbar menu list 

to re-establish Ddist Server connection. 
4 If the Distribution Server is up, review the Data Distribution (EcDsDdistGui.Alog) log 

for the Ddist Set Priority Failure description and additional information. 
5 Click on the GUI’s Distrib’n Requests tab. 

• The Data Distribution – Track Activity window is displayed. 
•	 Each entry displays the Request ID, Requester, Media, # of Files, Total Size (Mbytes), 

State, Ordered Stated, Priority, Submission Time, End Time, # of Media, # Granules, 
Media # Completed, ESDT, Order ID, and Warm Start. 

6 Press the Refresh push button. 
• The data distribution list is updated with the most recent request list. 

7	 Highlight the distribution request to be assigned a different priority from the request list 
displayed in the Data Distribution – Track Activity window. 

• The request is highlighted and should be in the suspended state. 
• If request is not in the suspended state, refer to outlined 18.2.5 Suspending Data 

Distribution Request. 
8 Select the new priority using the “Change Priority” button. 
9 Click on the “Apply” button to implement the priority change. 

• The action is successful if no error dialog appears. 

18.5.5 Recovering from Ddist Suspend/Suspend All Failure 

A Ddist Suspend/Suspend All failure may occur if there is a server failure when an attempt is made 
to suspend incoming data requests. Suspending data requests are only valid in staging, active, 
pending states. The Suspend All data requests only pertains to requests that have not been sent to 
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Ddist. The procedure starts with the assumption that all applicable servers and the Data 
Distribution Operator GUI are currently running and the Data Distribution - Track Activity 
screen is displayed. 
1 Upon receipt of the operator alert, ensure that the necessary hosts and servers are “up”. 
2 If the Distribution Server has gone down, notify the Operations Controller/System 

Administrator to have the server brought back up using HP OpenView. 
3 If the Distribution Server is up, review the Data Distribution (EcDsDdistGui.Alog) log 

for the Ddist Suspend Failure description and additional information. 

18.5.6 Recovering from Ddist Resume/Resume All Failure 

The Resume/Resume All Failure occurs if the database is unavailable to the Data Distribution 
Server. This procedure starts with the assumption that all applicable servers and the Data 
Distribution Operator GUI are currently running and the Data Distribution - Track Activity 
screen is displayed. 
1 Upon receipt of the operator alert, ensure that the necessary hosts and servers are “up”. 
2 If the Distribution Server has gone down, notify the Operations Controller/System 

Administrator to have the server brought back up using HP OpenView. 
3 If the Distribution Server is up, review the Data Distribution (EcDsDdistGui.Alog) log for 

the Ddist Suspend Failure description and additional information. 

18.5.7 Recovering from Ddist Mark Shipped Failure 

After the DDT completes the packaging process in preparation for shipping the media, he/she 
should use the Data Distribution Operator GUI tool to mark the tapes for shipment. An error dialog 
will display a Ddist Mark Shipped Failure if the Distribution Server (EcDsDistributionServer) 
is unavailable. This procedure starts with the assumption that all applicable servers and the Data 
Distribution Operator GUI are currently running and the Data Distribution - Track Activity 
screen is displayed. 
1 Upon receipt of the operator alert, ensure that the necessary hosts and servers are “up”. 
2 If the Distribution Server has gone down, notify the Operations Controller/System 

Administrator to have the server brought back up using HP OpenView. 
3	 If the Distribution Server is up, review the Data Distribution (EcDsDdistGui.Alog) and 

Storage Management (EcDsSt8MMServer.ALOG) logs for the Ddist Suspend Failure 
description and additional information. 

18.5.8 Checking Database Connections 

The storage management and data distribution shared database is the repository of data concerning 
data distribution requests. If applications (including the Data Distribution Operator GUI) are 
unable to connect to the database, the data distribution request data cannot be retrieved or (in the 
case of the GUI) displayed. Consequently, if the GUI does not display data or if the display does 
not refresh, checking the database connections is a logical step in trying to isolate the problem. 
The procedure for checking database connections starts with the assumption that the operator has 
logged in to the ECS system. 
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1 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host.

2 Type cd /usr/ecs/MODE/CUSTOM/cfg then press Return/Enter.

3 Type view EcDsDistributionServer.CFG then press Return/Enter.


• Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more) can be used to review the log file. 

4 Review the configuration file to identify the values for the following parameters: 
• DBName 
• DBServer 
• DBMaxConnections 

5 Type :q! then press Return/Enter to quit the view application. 
6 Log in to the APC Server (e.g., e0acg01, g0acg01, l0acg02, n0acg01) host as described in Steps 

1 through 6 of the procedure for Launching the Data Distribution GUI. 
• APC Server (e.g., e0acg01, g0acg01, l0acg02, n0acg01) typically hosts Sybase for the 

storage management/data distribution shared database. 
• The DBServer identified in the Data Distribution configuration file includes the host 

name (e.g., g0acg01_srvr). 
7 Type isql-UuserID œPassword œSDBServer then press Return/Enter. 
8 Type sp_who at the 1> prompt then press Return/Enter. 
9 Type go at the 2> prompt then press Return/Enter. 

18.5.9 Display Data Distribution Error Logs 

1	 From a SUN workstation or X-Term NCD Terminal telnet into the Data Distribution 
Operator host. Enter telnet <hostname> and press the return key. Example: telnet 
g0dis02.gsfcb.ecs.nasa.gov 

2	 Log into the Data Distribution Operator workstation using your user identifier and 
password by typing YourUserID, and then press Return. 

• A password prompt is displayed. 
3 Log into the Data Distribution Operator workstation using your user identifier and 

password by typing YourUserID, and then press Return. 
• A password prompt is displayed. 

4 Enter YourPassword, then press Return. 
• You are authenticated as yourself. 

5 Set your display environment using the following command: 
setenv DISPLAY <hostname:0.0> and press the return key 

6 Change directory to the Data Distribution GUI directory using the following 
command: 

cd /usr/ecs/<mode>/CUSTOM/logs and press the return key. 
7 To display Data Distribution .Alog use the following command: 

ls –la |grep .Alog and press the return key. 

18.5.10 Missing E-mail Notification Pre-Amble 

E-mail notification preambles are expected to be in the preamble directory "/CUSTOM/data/DSS/". 
If the file with the appropriate name is in this directory, then it will be included as the preamble of 
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the email. If the distribution server does not find the file with the appropriate name, then the email 
is sent without the preamble. Note that the server will log (in the ALOG and/or the Debug.log) the 
full file names of the preambles it would try to use. The file names for preambles of successful 
acquires are expected to be: 

"EcDsDd" + mediaType + "EMSuccessPreamble.txt" 

and for failure notifications: 

"EcDsDd" + mediaType + "EMFailurePreamble.txt" 

Note that "mediaType" must be "8MM", "D3", "FtpPull", or "FtpPush" (without the quotes, of 
course). 

Please make backups if you plan to change the preambles. And if you can please do so in a way 
that others can tell where your backups are located (e.g. in a subdirectory named embackups under 
the preamble directory.) 

You are not allowed to create a preamble with any plus (+) signs. Do not create preambles that 
contain a colon preceded by a keyword that has appeared or can appear in the server-constructed 
email body. Such keyword-colon constructs include: GRANULE:, ORDERID:, REQUESTID:, 
USERSTRING:, FINISHED:, MEDIATYPE:, FTPHOST:, FTPDIR:, MEDIAID:, UR:, ESDT:, 
FILENAME:, FILESIZE:, FTPHOST:, FTPDIR:, FTPEXPR: . 

If a file from another operating system is being placed in the preamble directory, then please view it 
with more or vi. Make sure it looks OK (e.g. it is not one long line ). 
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19. User Services 

19.1 ECS User Account Management 

All registered users of the ECS have a personal "user account" that is maintained within the ECS 
User Account database by the User Services Representative (US Rep). The account contains such 
information as the user's name, User ID, e-mail address, preferred shipping address, billing address, 
and other information regarding the user that is needed when processing user requests. This section 
provides a brief overview of the ECS User Account Management tool and gives a few examples of 
its use: 

• Section 19.1.1 explains how to retrieve a user account to validate a user. 

• Section 19.1.2 explains how to create a user account. 

•	 Section 19.1.3 explains how to complete a user account from the Universal Resource 
Locator (URL) Registration. 

• Section 19.1.4 explains how to edit/modify an existing account. 

• Section 19.1.5 explains how to delete an account. 

• Section 19.1.6 explains how to cancel/suspend an account. 

• Section 19.1.7 explains how to change a user's password. 

The Activity Checklist, Table 19.1-1, provides an overview of the User Verification process. 
Column one (Order) shows the order in which tasks should be accomplished. Column two (Role) 
lists the Role/Manager/Operator responsible for performing the task. Column three (Task) provides 
a brief explanation of the task. Column four (Section) provides the Procedure (P) section number 
or Instruction (I) section number where details for performing the task can be found. Column five 
(Complete?) is used as a checklist to keep track of which task steps have been completed. 

Table 19.1-1. ECS User Account Management - Activity Checklist 
Order Role Task Section Complete? 

US Rep Retrieve User Account/Validate User (P) 19.1.1 

US Rep Create a User Account (P) 19.1.2 

US Rep Account Creation from URL (P) 19.1.3 

US Rep Edit/Modify an Existing Account (P) 19.1.4 

US Rep Delete an ECS Account (P) 19.1.5 

US Rep Cancel/Suspend an ECS Account (P) 19.1.6 

US Rep Change an ECS User Password (P) 19.1.7 
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19.1.1 Retrieve User Account/Validate a User 

When a user contacts the User Services Representative (US Rep) with any request, the user's 
account is retrieved. User account information can be used to validate the user and/or provide 
information that will be needed to process the user's request. 

Use the following detailed procedures: 

1)	 The ECS User Account Management tool is launched with the execution of several UNIX 
commands: 

• Open the command shell. 

• Type xhost <remote_workstation_name> and then press the Enter key. 

•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

•	 At the UNIX shell prompt type /tools/bin/ssh hostname (e.g., l0mss21), and then press 
the Enter key, to start the log-in to the MSS client server. 

- If you receive the following message, "Host key not found from the list of known 
hosts. Are you sure you want to continue connecting? (yes/no)", type yes. 

- If you have previously set up a secure shell pass-phrase and executed sshremote, a 
prompt to enter the passphrase for RSA key '<user@localhost>' will appear. Go to 
the next step. 

- If you have not previously set up a secure shell pass-phrase, skip the next step. 

•	 If the following message appears: "Enter passphrase for RSA key '<user@localhost>'", 
type your Passphrase and then press the Enter key. Skip the next step. 

•	 At the "<user@remotehost>'s password:" prompt, type your Password and then press the 
Enter key. 

•	 To change to the directory containing the utility scripts to start Account Management 
GUIs, type cd /path and then press the Enter key. 

•	 For path, use /usr/ecs/mode/CUSTOM/utilities, where mode will likely be TS1, TS2, or 
OPS. 

•	 Type EcMsAcRegUserGUIStart mode, where mode is TS1, TS2, or OPS (or other) as 
se-lected in the previous step. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: "User Request", and "Profile Account". 

2) Click the "Profile Account" folder tab. 
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• Folders and fields applicable to existing accounts are displayed. 

3) Retrieve the user's profile information by entering search criteria in the "Find" field. 

• The "Find" field is located to the right of the Find button. 

4) Enter the Search Criteria, then press Return. 

• You can create a search by entering the user's Last Name, E-mail address, or user ID. 

• The scroll box displays a list of accounts that match the search criteria. 

5) Scroll through the accounts listed until the desired account is highlighted, then double 
click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Personal Information, Mailing Address, Shipping Address, Billing Address, Account 
Information, and DAR Information. 

6)	 Click on each folder you desire to display. The user account information that you need in 
order to validate the user is displayed. 

19.1.2 Create a User Account 

The User Registration process begins when the requester contacts User Services to request data. 
This request may be by mail, phone, e-mail, fax, or a user walk-in. The US Rep can either provide 
the user with the URL for registration help procedures, or the US Rep can enter the registration 
information on behalf of the user. This section describes how the US Rep would register a user. 
Most of the information needed to register the user should be contained within the fax or E-mail 
message, but if more information is needed, the US Rep calls the user directly. 

To register a user the US Rep uses the "User Request" folder of the ECS User Account 
Management tool. User information is entered into five subordinate folders: the "Personal 
Information" folder, the "Mailing Address" folder, the "Shipping Address" folder, the "Billing 
Address" folder, and the "Account Information" folder. The US Rep will normally enter the 
information into the five folders sequentially, then press the "Add Request" button. The "User 
Request" folder remains open throughout this process. If the US Rep is interrupted after the 
completion of two folders, he/she can press the "Add Request" button to save the two completed 
folders, but the remaining folders will have to be completed before an order can be placed. 
Sections 19.1.2.1 through 19.1.2.6 explain how to enter user information into the six folders when 
the information is entered sequentially. The "User Request" folder will remain open until the five 
folders have been completed. If you are already familiar with the procedures, you may prefer to 
use the quick-step table in Section 19.1.2.7 (Table 19.1-4). 
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The Activity Checklist, Table 19.1-2, provides an overview of the process used to create an ECS 
user account. Column one (Order) shows the order in which tasks should be accomplished. 
Column two (Role) lists the Role/Manager/Operator responsible for performing the task. Column 
three (Tasks) provides a brief explanation of the task. Column four (Section) provides the 
Procedure (P) section number or Instruction (I) section number where details for performing the 
task can be found. Column five (Complete?) is used as a checklist to track the completed task 
steps. 

Table 19.1-2. Create an ECS User Account - Activity Checklist 
Order Role Task Section Complete? 

US Rep Personal Information folder (P) 19.1.2.1 

US Rep Mailing Address Folder (P) 19.1.2.2 

US Rep Shipping Address Folder (P) 19.1.2.3 

US Rep Billing Address Folder (P) 19.1.2.4 

US Rep Account Information folder (P) 19.1.2.5 

US Rep DAR Information (P) 19.1.2.6 

19.1.2.1	 Use Secure Shell to Perform a Remote Log in to the Account 
Management Host at the SMC 

Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

Click the “Request Account” folder tab. 

• The window displays five folders. 

Click the “Account Information” folder. 

• The “Account Information” folder opens. 

Click on the “Expiration Date” field. 

• The cursor moves to the “Expiration Date” field. 

Enter the Expiration Date only if required by the DAAC for new accounts, then press Tab. 

• The cursor moves to the ”DCE Group” field. 

Click on the pull-down arrow next to the “Privilege Level” field. 

•	 A pull-down menu appears with choices of XPRESS, VHigh, HIGH, NORMAL, and 
LOW. 
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Click on the choice NORMAL. 

• NORMAL appears in the “Privilege Level” field. 

Click on the pull-down arrow next to the “NASA User” field. 

• A pull-down menu appears with choices of Privileged, Regular, and Non-NASA. 

Click on the choice Non-NASA. 

• Non-NASA appears in the “NASA User” field. 

Click on the pull-down arrow next to the "V0 Gateway Category" field. 

• A pull-down menu appears with the choices of USA and Non-USA. 

Click on the choice USA. 

• USA appears in the "V0 Gateway Category" field. 

If the user is to be authorized for ASTER L1B requests, click on the check box next to Authorize 
for ASTER L1B. 

• A check mark is displayed in the box. 

• The Account Information folder is complete; go to next folder. 

19.1.2.2 Personal Information 

The "Personal Information" folder contains the user name, e-mail address, organization, telephone 
number, mother's maiden name, affiliation, project, home DAAC, and primary area of study. The 
user may need to be contacted in order to obtain all the information needed. The US Rep uses this 
information when validating a user at a later date. The "User Request" folder is still open. To add 
the user's personal information, execute the following steps: 

1) Click the "Personal Information" folder. 

• The "Personal Information" folder opens. 

• The cursor defaults to the "Title" field. 

2) Enter the user's Title, then press Tab. 

• The title you have chosen appears in the "Title" field. 

• The cursor moves to the "First Name" field. 

• A dropdown menu may also be used : 

a) Point the mouse on the arrow to the right of the "Title" field. 

b) While holding the mouse down, highlight the Title you require. 
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c) Release the mouse button. 

3) Enter the user's first name, then press Tab. 

• The cursor moves to the "MI" field. 

4) Enter the user's middle initial, then press Tab. 

• The cursor moves to the "Last Name" field. 

5) Enter the user's last name, then press Tab. 

• The cursor moves to the "last name" field. 

6) Enter the user's Email address, then press Tab. 

• The cursor moves to the "User ID" field. 

7) Enter the User ID, then press Tab. 

• The cursor moves to the "Organization" field. 

8) Enter the user's organization, then press Tab. 

• The cursor moves to the "Affiliation" field. 

9) deleted 

• 10) deleted 

11) Enter the user's affiliation, then press Tab. 

• A dropdown menu may also be used: 

a) Point the mouse on the arrow at the right of the "Affiliation" field. 

b) While holding the mouse button down, highlight the affiliation required. 

c) Release the mouse button. 

• The highlighted affiliation appears in the "Affiliation" field. 

• The cursor moves to the "User verification field" field. 

12) Click on the "User Verification Key:" field. 

• The cursor moves to the “User Verification Key:” field. 

• Enter the user’s User Verification Key:, then press Tab. 

• The cursor moves to the pull-down arrow next to the “Home DAAC:” field. 
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13) Enter the user's Home DAAC, then press Tab. 

• A dropdown menu can also be used to select the Home DAAC. 

a) Point the mouse on the arrow to the right of the "Home DAAC" field. 

b) While holding the mouse button down, highlight the "Home DAAC." 

c) Release the mouse button. 

- The highlighted DAAC appears in the "Home DAAC" field. 

13.5) Click on the Project field. 

• The cursor moves to the Project field. 

• Enter the Project and press tab. 

• The cursor moves to the "Primary Area of Study" field. 

14) Enter the user's Primary Area of Study, then press Tab. 

• A dropdown menu can also be used to select the Primary Area of Study. 

a) Point the mouse on the arrow to the right of the "Primary Area of Study" field. 

b) While holding the mouse button down, highlight the "Primary Area of Study." 

c) Release the mouse button. 

• The highlighted Area of Study appears in the "Primary Area of Study" field. 

• The Personal Information folder is complete. 

• deleted 

19.1.2.3 Mailing Address 

The "Mailing Address" is used for normal correspondence. The Mailing Address is not necessarily 
the same as the shipping or billing addresses. The US Rep is responsible for maintaining up-to­
date mailing addresses. 

The "User Request" folder is still open. Locate and open the "Mailing Address" folder. To add the 
Mailing Address, execute the following steps: 

1) Click the "Mailing Address" folder tab. 

• The "Mailing Address" folder opens. 

• The cursor moves to the first "Address" field. 

2) Enter the user's mailing address, then press Tab. 
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• The cursor moves to the second "Address" field. 

3)	 If a second address field is needed to complete the user's mailing address, enter the mailing 
address, then press Tab. 

• If a second address is not needed, press Tab to bypass the field. 

• The cursor moves to the "City" field. 

4) Enter the City to which regular correspondence is sent, then press Tab. 

• The cursor moves to the "State/Province" field. 

5) Enter the State or Province for the mailing address, then press Tab. 

• The cursor moves to the "Zip/Postal Code" field. 

6) Enter the Zip/Postal Code for the mailing address, then press Tab. 

• The cursor moves to the "Country" field. 

7) Enter the Country for the mailing address, then press Tab. 

• The cursor moves to the "Telephone" field. 

8) Enter the Telephone number (area code first) used at the mailing address, then press Tab. 

• The cursor moves to the "Fax" field. 

9) Enter the Fax number (area code first) used at the mailing address, then press Tab. 

• The "Mailing Address" folder is now complete. 

19.1.2.4 Shipping Address 

The "Shipping Address" folder contains the address for shipping data. The Shipping Address is not 
necessarily the same as the mailing or billing addresses. The US Rep will always confirm the 
shipping address with the user before shipping data. 

The "User Request" folder is still open. Locate and open the "Shipping Address" folder. To add 
the shipping address, execute the following steps: 

1) Click the "Shipping Address" folder tab. 

• The "Shipping Address" folder opens. 

• The cursor moves to the first "Address" field. 

2) Enter the user's Shipping Address, then press Tab. 

• The cursor moves to the second "Address" field. 
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3) If a second address field is needed to complete the user's Shipping Address, enter the 
Shipping Address, then press Tab. 

• If a second address field is not needed, press Tab to bypass the field. 

• The cursor moves to the "City" field. 

4) Enter the City to which the data will be shipped, then press Tab. 

• The cursor moves to the "State/Province" field. 

5) Enter the State or Province for the shipping address, then press Tab. 

• The cursor moves to the "Zip/Postal Code" field. 

6) Enter the Zip/Postal Code for the shipping address, then press Tab. 

• The cursor moves to the "Country" field. 

7) Enter the Country to which the data will be shipped, then press Tab. 

• The cursor moves to the "Telephone" field. 

8) Enter the Telephone number (area code first) used at the shipping address, then press Tab. 

• The cursor moves to the "Fax" field. 

9) Enter the Fax number (area code first) used at the shipping address, then press Tab. 

• The "Shipping Address" folder is now complete. 

• Open the "Billing Address" folder. 

19.1.2.5 Billing Address 

The "Billing Address" is the address to which payment-due billings are sent. The billing address is 
not necessarily the same as the mailing and shipping addresses. The US Rep is responsible for 
maintaining up-to-date billing addresses. 

The "User Request" folder is still open. Locate and open the "Billing Address" folder. To add the 
billing address, execute the following steps: 

1) Click the "Billing Address" folder tab. 

• The "Billing Address" folder opens. 

• The cursor moves to the first "Address" field. 

2) Enter the user's Billing Address, then press Tab. 

• The cursor moves to the second "Address" field. 
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3) If a second address field is needed to complete the user's billing address, enter the Billing 
Address, then press Tab. 

• If the second address field is not needed, press Tab to bypass the field. 

• The cursor moves to the "City" field. 

4) Enter the City to which the payment-due billings will be sent, then press Tab. 

• The cursor moves to the "State/Province" field. 

5) Enter the State or Province for the billing address, then press Tab. 

• The cursor moves to the "Zip/Postal Code" field. 

6) Enter the Zip/Postal Code for the billing address, then press Tab. 

• The cursor moves to the "Country" field. 

7) Enter the Country to which the payment due billings will be sent, then press Tab. 

• The cursor moves to the "Telephone" field. 

8) Enter the Telephone number (area code first) used at the billing address, then press Tab. 

• The cursor moves to the "Fax" field. 

9) Enter the Fax number (area code first) used at the billing address, then press Tab. 

• The "Billing Address" folder is now complete. 

• Open the "Account Information" folder. 

19.1.2.6 Account Information 

The "Account Information" folder contains the date the account was created, , expiration date, 
Account Number, privilege level, NASA User, DCE password, DCE group , DCE Organization, 
V0 Gateway User Type, and V0 Gateway Password. There are no privilege restrictions until 
SeaWiFS data are available; the restriction levels will be determined at that time. The system 
deletes an account when the Expiration Date has been reached. One week prior to the expiration 
date, an e-mail message is sent to the user and US Rep saying the account will be deleted on the 
expiration date. This date is ordinarily used when an account is placed on restriction due to non­
payment of bills. To enter Account Information, execute the following steps: 

1)	 The ECS User Account Management tool is launched with the execution of several UNIX 
commands: 

• Open the command shell. 

• Type xhost <remote_workstation_name> and then press the Enter key. 
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•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

•	 At the UNIX shell prompt type /tools/bin/ssh hostname (e.g., l0mss21), and then press 
the Enter key, to start the log-in to the MSS client server. 

- If you receive the following message, "Host key not found from the list of known 
hosts. Are you sure you want to continue connecting? (yes/no)", type yes. 

- If you have previously set up a secure shell pass-phrase and executed sshremote, a 
prompt to enter the passphrase for RSA key '<user@localhost>' will appear. Go to 
the next step. 

If you have not previously set up a secure shell pass-phrase, skip the next step. 

•	 If the following message appears: "Enter passphrase for RSA key '<user@localhost>'", 
type your Passphrase and then press the Enter key. Skip the next step. 

•	 At the "<user@remotehost>'s password:" prompt, type your Password and then press the 
Enter key. 

•	 To change to the directory containing the utility scripts to start Account Management 
GUIs, type cd /path and then press the Enter key. 

•	 For path, use /usr/ecs/mode/CUSTOM/utilities, where mode will likely be TS1, TS2, or 
OPS. 

•	 Type EcMsAcRegUserGUIStart mode, where mode is TS1, TS2, or OPS (or other) as 
selected in the previous step. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: "User Request" and "Profile Account". 

2) Click the "User Request" folder tab. 

•	 Six folders are displayed that contain detailed information about the selected user's 
account: Personal Information, Mailing Address, Shipping Address, Billing Address, 
Account Information and DAR Information. 

3) Click the "Account Information" folder. 

• The "Account Information" folder opens. 

4) Click the "Expiration Date" field. 

• The cursor moves to the "Expiration Date" field. 

5) Enter the Expiration Date only if required by the DAAC for new accounts, then press Tab. 
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•	 When the Expiration Date is reached, the system automatically deletes the account from 
the system. 

• The expiration date depends on the policies at each DAAC. 

6) Click on the "Account Number" field. Enter a new Account Number, then press Tab. 

• DAAC policy will determine how new account numbers are assigned. 

7) Click on the "Privilege Level" field. Enter the Privilege Level, then press Tab.. 

• A dropdown menu can also be used to select the Privilege Level. 

a) Point the mouse on the arrow to the right of the "Privilege Level" field. 

b) While holding the mouse button down, highlight the "Privilege Level." 

c) Release the mouse button. 

• The highlighted Privilege Level appears in the "Privilege Level" field. 

• The DAACs listed in the dropdown menu are high, medium and low. 

8) Click on the "NASA User" field. Enter "Yes" or "No" for the NASA User, then press Tab.. 

• A dropdown menu can also be used to select the NASA User. 

a) Point the mouse on the arrow to the right of the "NASA User" field. 

b) While holding the mouse button down, highlight the desired Option. 

c) Release the mouse button. 

• The highlighted NASA User option appears in the "NASA User" field. 

• The options listed in the dropdown menu are Yes and No. 

9) Click on the "DCE Password" field. Enter a new password, then press Tab. 

• DAAC policy will determine how DCE passwords are assigned. 

10) Click on the "DCE Group" field. Enter a DCE Group, then press Tab.. 

• DAAC policy will determine how users are assigned to DCE groups. 

11) Click on the "DCE Organization" field. Enter the DCE Organization, then press Tab.. 

• The DCE Organization must be the one which corresponds to the selected DCE Group. 

•	 If the user needs access to the V0 Gateway, enter V0 Gateway User Type and V0 
Gateway Password. 
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12) Click on the "V0 Gateway User Type" field. Enter the V0 Gateway User Type, then press 
Tab.. 

13) Click on the "V0 Gateway Password" field. Enter the V0 Gateway Password, then press 
Tab. 

• The six folders are now complete. 

• The Account Information folder is complete. 

19.1.2.7 DAR Information 

The "DAR Information" folder contains an indication of user privileges for expedited requests and 
Aster categories. To enter DAR Information, execute the following steps: 

1)	 The ECS User Account Management tool is launched with the execution of several UNIX 
commands: 

• Open the command shell. 

• Type xhost <remote_workstation_name> and then press the Enter key. 

•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

•	 At the UNIX shell prompt type /tools/bin/ssh hostname (e.g., l0mss21), and then press 
the Enter key, to start the log-in to the MSS client server. 

•	 If you receive the following message, "Host key not found from the list of known hosts. 
Are you sure you want to continue connecting? (yes/no)", type yes. 

•	 If you have previously set up a secure shell pass-phrase and executed sshremote, a 
prompt to enter the passphrase for RSA key '<user@localhost>' will appear. Go to the 
next step. 

• If you have not previously set up a secure shell pass-phrase, skip the next step. 

•	 If the following message appears: "Enter passphrase for RSA key '<user@localhost>'", 
type your Passphrase and then press the Enter key. Skip the next step. 

•	 At the "<user@remotehost>'s password:" prompt, type your Password and then press the 
Enter key. 

•	 To change to the directory containing the utility scripts to start Account Management 
GUIs, type cd /path and then press the Enter key. 

•	 For path, use /usr/ecs/mode/CUSTOM/utilities, where mode will likely be TS1, TS2, or 
OPS. 
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•	 Type EcMsAcRegUserGUIStart mode, where mode is TS1, TS2, or OPS (or other) as 
se-lected in the previous step. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: "User Request" and "Profile Account". 

2) Click the "Profile Account" folder tab. 

3) Click the "DAR Information" folder. 

• The "DAR Information" folder opens. 

4) Click the "DAR Expedited Data" field. 

•	 The cursor moves to the "DAR Expedited Data" field. Enter "Yes" or "No" for the DAR 
Expedited Data, then press Tab. 

• A dropdown menu can also be used to select the DAR Expedited Data. 

a) Point the mouse on the arrow to the right of the "DAR Expedited Data" field. 

b) While holding the mouse button down, highlight the desired Option. 

c) Release the mouse button. 

• The highlighted DAR Expedited Data option appears in "DAR Expedited Data" field. 

• The options listed in the dropdown menu are Yes and No. 

5) Click on the "Aster Category" field. Enter an Aster Category, then press Tab. 

• A dropdown menu can also be used to select the Aster Category. 

a) Point the mouse on the arrow to the right of the "Aster Category" field. 

b) While holding the mouse button down, highlight the desired Option. 

c) Release the mouse button. 

• The highlighted Aster Category option appears in "Aster Category" field. 

• The five folders are now complete. 

6 Click the "Create Account" button to complete the creation of the new account. 

• The account is automatically logged into the database as an approved account. 

7 Exit menu path File_Exit 

8 Provide the user with his/her initial ECS account password. 

•  Follow local DAAC policy regarding password dissemination. 
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19.1.3 Create a User Account 

Once the five folders are complete, the next step in creation of the new account is achieved with 
selection of a button at the bottom of the Request Account screen. This action logs the account into 
the database as a pending account. Finally, to complete the creation of a new account, the pending 
account is selected and a click on the Create Account button results in the creation of the new 
account. It also results in automatic dispatch of an e-mail message to the user’s e-mail address with 
notification that the account has been created. The User Services representative will complete the 
account registration process by providing the user with the initial ECS account password. The 
password dissemination is done in accordance with local DAAC policy. 

1) Use secure shell to perform a remote log in to the Account Management host at the SMC. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: "User Request" and "Profile Account". 

2) Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

3) Click the “Request Account” folder tab. 

• The window displays five folders. 

•	 Above the five folders are the search criteria: 

Sort by: “Submission Date,” or “Last Name. 

Retrieve by: “Pending” or “Approved,” “Denied” or “All.” 

4) Click the Pending button. 

5) Click the Retrieve button. 

•	 The scroll box displays all the URL registration forms completed by the requesters that 
are still pending. 

6)	 Highlight one account (in this case, for Dr. Paul Fingerman) and double click to display the 
account. 

• The user registration information is automatically transferred into the five user folders. 

7) Click the “Personal Information” folder. 

• The “Personal Information” folder is opened. 

• View the folder to verify that the information is complete. 

• If the information is not complete, contact the user, then complete the folder. 
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8) Click the “Account Information” folder. 

• The “Account Information” folder is opened. 

• View the folder to verify that the information is complete. 

• If the information is not complete, contact the user, then complete the folder. 

9) Click the “Shipping Address” folder. 

• The “Shipping Address” folder is opened. 

• View the folder to verify that the information is complete. 

• If the information is not complete, contact the user, then complete the folder. 

10) Click the “Billing Address” folder. 

• The “Billing Address” folder is opened. 

• View the folder to verify that the information is complete. 

• If the information is not complete, contact the user, then complete the folder. 

11) Click the “Mailing Address” folder. 

• The “Mailing Address” folder is opened. 

• View the folder to verify that the information is complete. 

• If the information is not complete, contact the user, then complete the folder. 

12) If the information is complete, click the “Create Account” button. 

•	 A Create Account dialog box is displayed, requesting the operator to Choose one: 
DCE login and Profile Database Entry or Profile Database Entry. 

13) Click on the option button to the left of Profile Database Entry. 

• The selected option button is filled to indicate its selection. 

14) Click on the OK button in the dialog box. 

• The account is created; the entry moves from the pending list to the approved list. 

• A print dialog box is displayed. 

15) Click in the Printer field and type lp -d <printername>. 

• The typed entry is displayed in the Printer field. 

16) Click on the OK button in the dialog box. 
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•	 The print dialog box is closed and a confirmation letter form with user information is 
printed on the designated printer. 

19.1.4 Edit/Modify an Existing Account 

The US Rep has the responsibility of maintaining the ECS user accounts. Part of this responsibility 
is to stay in close contact with the user to ensure that the records containing the user's shipping and 
billing addresses, as well as the remainder of the information maintained in the user account 
folders, are up-to-date. There are six folders containing information about the user. The six folders 
are maintained in the ECS User Account Management tool. Three of the folders contain addresses: 
Mailing Address, Shipping Address, and Billing Address. All the addresses can be the same; 
however, some companies may have different addresses for accounts receivable, regular 
correspondence, and the shipment of data. When an address change requested by a user does not 
indicate which address folder to change, the US Rep must contact the user for this information. 
The US Rep may have reviewed the previous address folders and noticed that the three folders 
contained the same previous address; however, do not assume that the same circumstances apply 
now. Always contact the user to make sure. The remaining three folders contain "Personal 
Information," "Account Information" and "DAR Information." The "Profile Account" folder, 
which is located in the ECS User Account Management tool, is used for all editing and 
modifications. 

The Activity Checklist, Table19.1-3, provides an overview of the process used to edit/modify an 
existing ECS account. Column one (Order) shows the order in which tasks should be 
accomplished. Column two (Role) lists the Role/Manager/Operator responsible for performing the 
task. Column three (Tasks) provides a brief explanation of the task. Column four (Section) 
provides the Procedure (P) section number or Instruction (I) section number where details for 
performing the task can be found. Column five (Complete?) is used as a checklist to keep track of 
which task steps have been completed. 

Table 19.1-3. Edit/Modify and Existing Account - Activity Checklist 
Role Task Section Complete? 

1 US Rep Edit/Modify Mailing Address (P) 19.1.4.2 

2 US Rep Edit/Modify Shipping Address (P) 19.1.4.3 

3 US Rep Edit/Modify Billing Address (P) 19.1.4.4 

4 US Rep Edit/Modify Account Information (P) 19.1.4.5 

5 US Rep Edit/Modify DAR Information (P) 19.1.4.6 

Sections 19.1.4.1 through 19.1.4.5 explain how to edit information in the five folders. In the 
following examples, the US Rep receives a notice from the user indicating that the Shipping, 
Billing and Mailing addresses have changed, as well as the E-mail address, the DCE Password and 
Aster category. The following sections explain how the US Rep retrieves a user account, then 
changes the address in three folders (in this example the same address is used in all the address 
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folders), and also changes the e-mail Address, the Primary Area of Study, the V0 Gateway User 
Type and Aster category in three other folders. 

19.1.4.1 Edit/Modify Mailing Address 

The "Mailing Address" is used for normal correspondence. The Mailing Address is not necessarily 
the same as the shipping or billing addresses. Execute the following steps to edit/modify the 
"Mailing Address" folder. If the "Profile Account" folder of the ECS User Account Management 
icon remains open and the user's account is still displayed, skip steps 1 through 5; otherwise, begin 
with step 1 to execute the changes. 

1) Use secure shell to perform a remote log in to the Account Management host at the SMC. 

• Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

2) Click the “Profile Account” folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

3)	 Retrieve the user’s profile information by entering the search criteria (in this case, Scientist) 
in the “Find” field and then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts which match the search criteria. 

4) Scroll through the accounts listed until the desired account is highlighted, then double 
click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

5) Click the “Mailing Address” folder. 

• The “Shipping Address” folder opens. 

• The cursor moves to the first “Address” field. 

6) Enter the user’s new Mailing Address, then press Tab. 
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• The cursor moves to the second “Address” field. 

•	 Because this completes the edit for the only part of the address that changed, there is no 
need to make any additional changes in this folder. 

7) Click the “Apply Edits” button to implement the change to the “Mailing Address” folder. 

19.1.4.2 Edit/Modify Shipping Address 

The "Shipping Address" folder contains the address for shipping data. This address is not 
necessarily the same as the mailing or billing addresses. The US Rep will always confirm the 
shipping address with the user before shipping data. Execute the following steps to edit/modify the 

"Shipping Address" folder. If the "Profile Account" folder of the ECS User Account Management 
icon is still open and the user's account is still displayed, skip steps 1 through 4; otherwise, begin 
with step 1 to execute your changes. 

1) Use secure shell to perform a remote log in to the Account Management host at the SMC. 

• Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

2) Click the “Profile Account” folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

3)	 Retrieve the user’s profile information by entering the search criteria (in this case, Scientist) 
in the “Find” field and then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts which match the search criteria. 

4) Scroll through the accounts listed until the desired account is highlighted, then double 
click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

5) Click the “Shipping Address” folder. 

• The “Shipping Address” folder opens. 

• The cursor moves to the first “Address” field. 

6) Enter the user’s new Shipping Address, then press Tab. 
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• The cursor moves to the second “Address” field. 

•	 Because this completes the edit for the only part of the address that changed, there is no 
need to make any additional changes in this folder. 

7) Click the “Apply Edits” button to implement the change to the “Shipping Address” folder. 

19.1.4.3 Edit/Modify Billing Address 

The "Billing Address" is not necessarily the same as the mailing and shipping addresses. This is 
the address to which payment-due billings are sent. The US Rep is responsible for maintaining up­
to-date billing addresses. You must execute the following steps to edit/modify the "Billing 
Address" folder. If the "Profile Account" folder of the ECS User Account Management icon 
remains open and the user's account is still displayed, skip steps 1 through 5; otherwise, begin with 
step 1 to execute your changes. 

1) Use secure shell to perform a remote log in to the Account Management host at the SMC. 

• Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

2) Click the “Profile Account” folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

3)	 Retrieve the user’s profile information by entering the search criteria in the “Find” field and 
then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts which match the search criteria. 

4) Scroll through the accounts listed until the desired account is highlighted, then double 
click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

5) Click the “Billing Address” folder. 

• The “Billing Address” folder opens. 

• The cursor moves to the first “Address” field. 

6) Enter the user’s new Billing Address, then press Tab. 
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• The cursor moves to the second “Address” field. 

•	 Because this completes the edit for the only part of the address that changed, there is no 
need to make any additional changes in this folder. 

7) Click the “Apply Edits” button to implement the change to the “Billing Address” folder. 

19.1.4.4 Edit/Modify Account Information 

The "Account Information" folder contains the date the account was created, expiration date, 
Account Number, privilege level, NASA User, DCE password, DCE group, DCE Organization, V0 
Gateway User Type, and V0 Gateway Password. The following steps are required to change the 
V0 Gateway User Type. If the "Profile Account" folder of the ECS User Account Management 
icon is still open and the user's account is still displayed, skip steps 1 through 5; otherwise, begin 
with step 1 to execute your changes. 

1)  Use secure shell to perform a remote log in to the Account Management host at the SMC. 

2) Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

3) Click the “Profile Account” folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

4)	 Retrieve the user’s profile information by entering the search criteria in the “Find” field and 
then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts which match the search criteria. 

5) Scroll through the accounts listed until the desired account is highlighted, then double 
click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

6) Click the “Personal Information” folder. 

• The “Personal Information” folder is displayed. 

7) Click the “Telephone” field. 

• The cursor moves to the “Telephone” field. 

19-21 611-CD-510-001




8) Enter the new telephone number, then press Tab. 

• All changes for this folder have been completed. 

9) Click the “Apply Edits” button to implement the change to the “Personal Information” 
folder. 

19.1.4.5 Edit/Modify DAR Information 

The "DAR Information" folder contains an indication of user privileges for expedited requests and 
Aster categories. Execute the following steps to change the Aster Category on an existing account. 

1)	 The ECS User Account Management tool is launched with the execution of several UNIX 
commands: 

• Open the command shell. 

• Type xhost <remote_workstation_name> and then press the Enter key. 

•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

•	 At the UNIX shell prompt type /tools/bin/ssh hostname (e.g., l0mss21), and then press 
the Enter key, to start the log-in to the MSS client server. 

- If you receive the following message, "Host key not found from the list of known 
hosts. Are you sure you want to continue connecting? (yes/no)", type yes. 

- If you have previously set up a secure shell pass-phrase and executed sshremote, a 
prompt to enter the passphrase for RSA key '<user@localhost>' will appear. Go to 
the next step. 

- If you have not previously set up a secure shell pass-phrase, skip the next step. 

•	 If the following message appears: "Enter passphrase for RSA key '<user@localhost>'", 
type your Passphrase and then press the Enter key. Skip the next step. 

•	 At the "<user@remotehost>'s password:" prompt, type your Password and then press the 
Enter key. 

•	 To change to the directory containing the utility scripts to start Account Management 
GUIs, type cd /path and then press the Enter key. 

•	 For path, use /usr/ecs/mode/CUSTOM/utilities, where mode will likely be TS1, TS2, or 
OPS. 

•	 Type EcMsAcRegUserGUIStart mode, where mode is TS1, TS2, or OPS (or other) as 
se-lected in the previous step. 

• The ECS User Account Management window is displayed. 
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• The window shows two folders: "User Request" and "Profile Account". 

2) Click the "Profile Account" folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

3) Retrieve the user's profile information by entering the search criteria in the "Find" field. 

• The "Find" field is located to the right of the Find button. 

4) Enter the Search Criteria, then press Return. 

• The scroll box displays a list of accounts which match the search criteria. 

• Create a search by entering the user's Last Name, E-mail address, or User ID. 

5) Scroll through the listed accounts until the desired account is highlighted, then double Click. 

•	 Six folders are displayed that contain detailed information about the selected user's 
account; Personal Information, Mailing Address, Shipping Address, Billing Address, 
and Account Information. 

6) Click the "DAR Information" folder. 

• The "DAR Information" folder opens. 

7) Click the "Aster Category" field. 

• The cursor moves to the Aster Category. 

8) Enter the Aster Category, then press Tab. 

9) Click the "Apply Edits" button to implement the changes to the "DAR Information" folder. 

• Click another folder to continue editing, or 

•	 Exit ECS User Account Management by: 

Exit menu path File_Exit. 

19.1.5 Deleting an ECS Account 

An ECS user can be deleted from the ECS database through the ECS User Account Management 
tool. When the US Rep receives instructions to delete a user, he/she will retrieve the user's account, 
validate the account scheduled for deletion, then complete the deletion. The Personal Information 
folder is generally the folder used to validate an account because it has the most information about 
the user, such as Name, Title, E-mail address, Organization, Telephone Number, etc. 

1) Use secure shell to perform a remote log in to the Account Management host at the SMC. 

2) Launch the ECS User Account Management application GUIs. 

19-23 611-CD-510-001




• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

3) Click the “Profile Account” folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

4)	 etrieve the user’s profile information by entering the search criteria (in this case, Scientist) 
in the “Find” field and then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts that match the search criteria. 

5) Scroll through the accounts listed until the desired account (for Phyllis Scientist) is 
highlighted, then double click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

6) Click the “Personal Information” folder. 

• The “Personal Information” folder opens. 

• View the folder to validate the account scheduled for deletion. 

7) Click the “Delete Account” button. 

• The account is deleted. 

19.1.6 Canceling an ECS Account 

When the US Rep receives instructions to suspend a user's privileges, he/she will retrieve the user's 
account through the Profile Account folder of the ECS User Account Management icon. The US 
Rep must first review the account information to validate the account scheduled for suspension. 
The Personal Information folder has the most information about the user, such as Name, Title, E­
mail address, Organization, Telephone Number, etc.; therefore, the Personal Information folder is 
the folder generally used to validate an account. The suspension of an account is ordinarily due to 
a non payment of some type, such as payment due for services previously rendered. The US Rep 
will send the user an E-mail or letter, informing the user that the account privileges have been 
temporarily suspended and the account will be deleted if the payment has not been received by a 
specified date. 

If you are already familiar with the procedures to Cancel/Suspend an ECS Account, you may prefer 
to use the quick-step table below (Table 19.1-9). If you are new to the system or have not 
performed this task recently, you should use the following detailed procedures: 
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1)  Use secure shell to perform a remote log in to the Account Management host at the SMC. 

2) Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

3) Click the “Profile Account” folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

4) Retrieve the user’s profile information by entering the search criteria (in this case, 
Fingerman) in the “Find” field and then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts which match the search criteria. 

5) Scroll through the accounts listed until the desired account (for Paul Fingerman) is 
highlighted, then double click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

6) Click the “Personal Information” folder tab. 

• The “Personal Information” folder opens. 

• View the folder to validate the account scheduled for cancellation. 

7) Click the “Account Information” folder tab. 

• The “Account Information” folder opens. 

8) Click the “Expiration Date” field. 

• The cursor moves to the “Expiration Date” field. 

9) Enter the Expiration Date (in this case, one month from the current date), then press Tab. 

•	 When the expiration date is reached, the system automatically deletes the account from 
the system. 

10) Click the Apply Edit button. 

• An expiration date is established for the privileges on this account. 

•	 The sanction on the account privileges can be rescinded at any time up until the 
expiration date has been reached. 
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• The sanction can be rescinded by removing the expiration date. 

Canceling an account suspends the user's access until further notice. At the time that the user’s 
privileges are suspended, the US Rep must enter an Expiration date. If the account is not reinstated 
before the expiration date, it will be deleted from the system. 

19.1.7 Changing an ECS User's Password 

The user has notified the US Rep that he/she has forgotten his/her password. The US Rep uses the 
"Profile Account" folder of the ECS User Account Management tool to change a password. The 
US Rep retrieves the user's account, then reviews the information contained in the folders to 
validate the user. The "Personal Information" folder is generally the folder used to validate a user 
because it contains information about the user, such as name, title, e-mail address, organization, 
telephone number, etc. The US Rep would then issue a new password to the user. The user would 
be informed that it is a "one time" password only; therefore, the user must change the password the 
first time he/she enters the system. 

1) Use secure shell to perform a remote log in to the Account Management host at the SMC. 

2) Launch the ECS User Account Management application GUIs. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: “Request Account,” and “Profile Account.” 

3) Click the Profile Account folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

4) Retrieve the user’s profile information by entering the search criteria (in this case, 
Fingerman) in the “Find” field and then pressing Return. 

• The “Find” field is located to the right of the Find button. 

• Enter the user’s Last Name, E-mail address, or User ID to create the search. 

• The scroll box displays a list of accounts that match the search criteria. 

5) Scroll through the accounts listed until the desired account (for Paul Fingerman) is 
reached, then click on the account listing. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Account Information, Personal Information, Shipping Address, Billing Address, 
Mailing Address, and DAR Information. 

6) Click the Personal Information folder tab. 

• The Personal Information folder opens. 

• View the folder to verify the user requesting the password change. 
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7) Click the Account Information folder tab. 

• The Account Information folder opens. 

8) Click the Change V0GW Password button. 

• A Change V0 Gateway Password dialog is displayed. 

9) Click in the V0 Gateway Password field in the dialog. 

• The cursor moves to the “V0 Gateway Password” field. 

10) Enter V0Passw, noting carefully what you enter, then press OK. 

•	 Inform the user of the new password, with instructions to change the password when 
next entering the system. 

11) Click the Apply Edits button to implement the change to the Account Information folder. 

19.2Processing an Order 

This section describes how a User Services Representative (US Rep) might process an order from a 
user. The specific order of activities may vary from what is suggested here due to Operator 
preference or local DAAC policy; however, the procedures themselves will be the same for any 
order processed. 

In the example provided here, when the user contacts the US Rep with a request for data, the US 
Rep logs the request in the User Contact Log (Section 19.2.1), then launches the ECS User Account 
Management tool to validate the user (Section 19.2.2). Next, the US Rep uses the Search and 
Order tool to locate the requested data (Section 19.2.3). Once the data is located, the US Rep 
obtains a price estimate, if applicable (Section 19.2.4) and confirms the order with the user. After 
the user has approved the order, the US Rep places the order (Section 19.2.5), then notifies the user 
that the order is being processed. The US Rep then completes the process by updating the User 
Contact Log record to indicate that the order has been placed (Section 19.2.6). 

The Activity Checklist, Table 19.2-1, provides an overview of the process used when an order for 
data is received. Column One (Order) shows the order in which task should be accomplished. 
Column two (Role) lists the Role/Manager/Operator responsible for performing the task. Column 
three (Task) provides a brief explanation of the task. Column four (Section) provides the Procedure 
(P) section number or Instruction (I) section number where details for performing the task can be 
found. Column five (Complete?) is used as a checklist to keep track of which task steps have been 
completed. 
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Table 19.2-1. Processing an Order - Activity Checklist 
Order Role Task Section Complete? 

US Rep Create a User Contact Log Record (P) 19.2.1 

US Rep Retrieve User Information (P) 19.2.2 

US Rep Locate Data via Search & Order tool (P) 19.2.3 

US Rep Request Price Estimate/Confirm Order (P) 19.2.4 

US Rep Specify Order Details (P) 19.2.5 

US Rep Update User Contact Log (P) 19.2.6 

19.2.1 Create a User Contact Log Record 

A User Contact Log record is created for each unique User Services event. An "event" can be a 
registration request, a request for data, a request to track the status of an order, a complaint, a 
comment, or other. If a user contacts the US Rep for any reason, the US Rep must log the contact 
into the User Contact Log. The User Contact Log, which is located on the User Services Desktop, 
is kept as a running record of all user interactions. The US Rep uses the User Contact Log so 
frequently that, once it is launched, it is likely to be kept open during an entire shift/working 
session. 

A unique "Log-Id" is assigned to each User Contact Log record. Once the record has been created, 
if the US Rep wants to add new information to the record or review previous entries, he/she can 
retrieve the record by using the Log-Id. The record continues to be updated to show a chronology 
of activities relating to the event, until such time as the event is closed out. Once closed, the record 
can be retrieved for historical purposes, but new information cannot be added. How long closed 
records stay on the system is determined by a combination of system capacity and DAAC policy. 

In the User Contact Log, the person who contacted User Services is referred to as the "Contact." A 
log entry contains the Contact's name, phone number, E-mail address, Home DAAC, and 
Organization. Other window fields include the Contact Method, Receiving Operator, and Received 
Time. The User Contact Log also contains Short and Long description fields for recording the 
contact's reasons for placing the call. To create a User Contact Log the "Bolded" fields must be 
completed. Local DAAC policy will determine which of the remaining fields are to be completed. 
The window also contains fields that permit the US Rep to initiate a trouble ticket, if a trouble 
ticket is required. Trouble tickets are not discussed in this section; therefore, fields that relate only 
to trouble tickets will not be used in this procedure. For information about trouble tickets, refer to 
Section 8 of this document, "Problem Management." 

There are four User Contact Log screens: the "Submit" screen, the "Display" screen, the "Edit" 
screen, and the "Entry" Screen. The Submit screen is used to create new User Contact Log records, 
the Display screen is used to display already existing Contact Log records and to generate reports, 
the Edit screen is used to make changes to existing User Contact Log records, and the Entry screen 
is used as a path to the previous screens. When the User Contact Log is opened, it defaults to the 
Entry screen. An existing record can be displayed or modified by entering its unique Log-ID then 
using the menu at the top of the screen and following menu path Query ___Display or Modify 

19-28 611-CD-510-001




Individual. It is also possible to enter new account information into the Entry screen, but the 
information must be transferred to the Submit screen before the log record can be created. This is 
accomplished by using the menu at the top of the screen and following menu path Action _ Copy 
to Submit. 

Although it is fairly easy to copy information from the Entry screen to the Submit screen, it is 
recommended that the Submit screen always be used when creating new records in order to leave 
the Entry screen available for other activities. If the US Rep receives a phone call regarding a 
different activity while in the middle of creating a new User Contact Log record, he/she can switch 
to the Entry screen and query the Log for information about the other situation without disturbing 
the data already entered into the Submit screen. As long as the Entry screen remains available, it 
can be used as a pathway for opening several Submit screens or Edit screens at one time. When the 
US Rep has finished with the other activity, he/she can return to the Submit screen and finish 
creating the new log record. 

19.2.1.1 How to Create a User Contact Log Record 

The procedure that follows explains how to create a User Contact Log. This procedure will assume 
that all of the "Contact" information is needed. 

1 Access the command shell 

• The command shell prompt is displayed. 

2	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 

3	 Start the log-in to the MSS client server by typing /tools/bin/ssh hostname (e.g., l0msh03) at 
the UNIX command shell prompt, and then press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 
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5	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

6	 To change to the directory containing the Remedy application, type cd /path and then press the 
Return/Enter key. 

• For path, use /usr/ecs/OPS/COTS/remedy/bin. 

7 Type aruser & to launch Remedy. 

•	 Remedy Action Request System Window is displayed, showing default to Trouble 
Ticket screen. 

8 Follow menu path File→Open Schema. 

•	 The Open Schema dialog box is displayed, showing four choices: RelB-Contact Log, 
RelB-TT-ForwardToSite, RelB-TroubleTickets, and TroubleTicket-Xfer. 

9 Click on RelB-Contact Log to highlight it and then click on the Apply button. 

• The User Contact Log defaults to the Entry screen. 

10 From the Menu Bar, follow menu path File → Open Submit. 

• The display changes from the Entry to the Submit screen. 

• The screens look the same except for the action buttons on the bottom of the screen. 

11 Click on the “Contact Method” field. 

12 Enter the Contact Method (optional). 

• A drop-down menu may also be used: 

a Point the mouse on the arrow to the right of the Contact Method field. 

b	 While holding the mouse pointer button down, highlight the Contact Method you 
require (in this case, “Fax”). 

c Release the mouse button. 

• The highlighted affiliation appears in the “ Contact Method” field. 

•	 The Titles in the drop-down box are “Phone,” “E-mail,” “Fax,” “US Mail,” and 
“Walk-in.” 
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14 Click on the Short Description field. 

• The Short Description field is 128 characters long. 

•	 A Query field at the bottom of the main Trouble Ticket screen may be used to locate 
existing User Contact Log records and/or Trouble Tickets associated with specific 
problems/subjects. When a search string is entered into the Query field, it is the Short 
Description field of individual records that is searched. Therefore, when you enter a 
short description, enter it with “search criteria” in mind. 

15 Enter the Short Description (required). 

16 Click on the Set Received Time button (optional). 

• The current time is displayed in the Received Time field. 

17 Click on the Long Description field. 

•	 The Long Description field is used when the description requires more detail than the 
Short Description field will allow. 

•	 The Long Description field is often used when a problem exists: it can help with the 
resolution of Trouble Tickets. 

18 Enter a Long Description if needed (optional). 

19 Click on the Contact Id field. 

20 Enter the Id (User ID) of the person who contacted User Services. 

•	 The Contact Id is not required unless a Trouble Ticket is being created from the User 
Contact Log. 

21	 If a Contact Id was entered at Step 12, click the Set Contact Information button and then go 
to Step 32; otherwise, move to Step 22. 

•	 The system will automatically complete the Contact Name, Contact Phone, Contact 
E-mail, Contact Home DAAC, and Contact Organization fields, if the Contact Id 
has been entered. 

•	 If the contact is not a registered Remedy user, the contact fields must be manually 
completed. 

22 If the contact information was not automatically entered at Step 12, click on Contact Name. 

23 Enter the Contact’s Name (optional). 

24 Click on the Contact Phone field. 

25 Enter the Contact’s Phone number (optional). 

26 Click on the Contact E-mail field. 
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27 Enter the Contact’s E-mail address (optional). 

28 Click on the Contact Home DAAC field. 

29 Enter the Contact’s Home DAAC (optional). 

30 Click on the Contact Organization field. 

31 Enter the Contact’s Organization (optional). 

32 When all contact information has been entered, click on the Receiving Operator field. 

33	 In the Receiving Operator field, enter the name of the operator (User Services Representative) 
who is creating the User Contact Log record. 

34 Click on the Category field. 

35 Enter the Category. 

• A drop-down menu may also be used: 

a Point the mouse on the arrow to the right of the Category field. 

b	 While holding the mouse pointer button down, highlight the Category you require 
(in this case, Order). 

c Release the mouse button. 

• The highlighted category appears in the Category field. 

•	 The Titles in the drop-down box are Suggestion, Complaint, Concern, Order, and 
Subscription. 

36 Click the Apply button. 

•	 If you are not using the Submit screen, you must transfer to the submit screen now. 
The information you entered must be moved to the Submit screen before the log record 
can be created. This is accomplished by using the menu at the top of the screen and 
following menu path Actions → Copy to Submit. Once the information has been 
transferred to the Submit screen, click the Apply button. 

• The User Contact Log record is created and submitted to the database. 

• A unique Id is generated for the record and entered into the Log Id field. 

•	 The time and date that the User Contact Log was completed are displayed in the 
Entered Time field. 
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37 Click the Clear button. 

• The screen is cleared without closing the User Contact Log. 

• A new User Contact Log record can now be created. 

NOTES: 

Note 1:  The US Rep can use the "Query" field located at the bottom of the screen to locate 
existing User Contact Log records and/or Trouble Tickets associated with specific 
problems/subjects. When a search string is entered into the "Query" field, it is the "Short 
Description" field of individual records that is searched. Therefore, when you enter a short 
description, enter it with "search criteria" in mind. 

19.2.2 Retrieve User Information 

This section describes how a User Services Representative (US Rep) might retrieve a User's Profile 
to validate a user. When a User places a call to the US Rep, the event is logged into the User 
Contact Log. The US Rep then retrieves the User's profile to validate the user. The User's Profile 
screen contains all the vital information about the user. The User's Profile is located in the ECS 
User Account Management tool, which is located on the User Services Desktop. 

The information needed from the User may vary depending on local DAAC policies. It is 
recommended that the US Rep verify the following fields in the event that additional information is 
needed to complete the order: User Id; Name; Shipping Address for mailing hard media; Email 
Address for an ftp pull; Privilege Level, if ordering restricted data; and a Contact Phone Number. 
When the User Profile screen is opened, the information contained in the six account management 
folders is displayed on one screen. If modifications are required, see Section 19.1.4. 

1)	 The ECS User Account Management tool is launched with the execution of several UNIX 
commands: 

• Open the command shell. 

• Type xhost <remote_workstation_name> and then press the Enter key. 

•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

•	 At the UNIX shell prompt type /tools/bin/ssh hostname (e.g., l0mss21), and then press 
the Enter key, to start the log-in to the MSS client server. 

- If you receive the following message, "Host key not found from the list of known 
hosts. Are you sure you want to continue connecting? (yes/no)", type yes. 

- If you have previously set up a secure shell pass-phrase and executed sshremote, a 
prompt to enter the passphrase for RSA key '<user@localhost>' will appear. Go to 
the next step. 

- If you have not previously set up a secure shell pass-phrase, skip the next step. 
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•	 If the following message appears: "Enter passphrase for RSA key '<user@localhost>'", 
type your Passphrase and then press the Enter key. Skip the next step. 

•	 At the "<user@remotehost>'s password:" prompt, type your Password and then press the 
Enter key. 

•	 To change to the directory containing the utility scripts to start Account Management 
GUIs, type cd /path and then press the Enter key. 

•	 For path, use /usr/ecs/mode/CUSTOM/utilities, where mode will likely be TS1, TS2, or 
OPS. 

•	 Type EcMsAcRegUserGUIStart mode, where mode is TS1, TS2, or OPS (or other) as 
se-lected in the previous step. 

• The ECS User Account Management window is displayed. 

• The window shows two folders: "User Request" and "Profile Account". 

2) Click the "Profile Account" folder tab. 

• Folders and fields applicable to existing accounts are displayed. 

3) Retrieve the user's profile information by entering a search criteria in the "Find" field. 

• The "Find" field is located to the right of the Find button. 

4) Enter the Search Criteria, then press Return. 

• The scroll box displays a list of accounts that match the search criteria. 

• You can create a search by entering the user's Last Name, E-mail address, or User Id. 

5) Scroll through the accounts listed until the desired account is highlighted, then double click. 

•	 Six folders are displayed that contain detailed information about the selected account: 
Personal Information, Mailing Address, Shipping Address, Billing Address, Account 
Information and DAR Information,. 

6) Click on the "View Entire Profile" option button at the bottom of the screen. 

• The User Profile screen is displayed. 

•	 This is a read-only screen; no changes can be made without going to each individual 
folder. 

•	 The User Profile screen, displays the information contained in the Personal Information 
folder, Account Information folder, Shipping Address folder, Billing Address folder, 
and the Mailing Address folder. 

7) Click the Close button, to exit from the User Profile screen. 
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8) Exit the ECS User Account Management tool by following menu path File __Exit. 

19.2.3 Locate Data Via Search and Order Tool 

When a User Services Representative (US Rep) receives a mail message from a user who needs 
help placing an order, he/she can place the order on the user's behalf. This section provides an 
example of how the US Rep might place an order on behalf of a user. The US Rep begins by 
creating a User Contact Log (Section 19.2.1) entry, into which he/she records that a request for 
help was received from the user. The US Rep next looks up the requester's User Profile (Section 
19.2.2) to verify that the person is a registered user. After looking at the mail message from the 
user, the US Rep decides to create a search to determine if the data is held at his/her home DAAC. 
T h e  U S  R e p  l a u n c h e s  t h e  E O S  D a t a  G a t e w a y  ( U R L :  
http://lyta.gsfc.nasa.gov/~imswww/pub/imswelcome/.) 

Table 19.2-2. Locate Data Via EOS Data Gateway - Activity Checklist 
Order Role Task Complete ? 

US Rep Obtain a Spatial Summary 

US Rep Obtain a Temporal Summary 

US Rep Obtain a Discrete Attribute Summary 

US Rep Browse the Search Results 

US Rep Select Granules to Order 

US Rep Request Price Estimate 

US Rep Specify Order Details 

19.2.4 Request Price Estimate 

There is no charge for data at this time. If the time ever comes that NASA resources cannot meet 
the user demand, a standard price table shall be established across all DAACs, see (Policy #96.01). 
In general, the policy provides that the Federal Government should recoup only those costs 
associated with the dissemination of information and not those associated with its creation or 
collection. NASA Headquarters is responsible for specifying the policy with input from GSFC 
Code 170, the EOSDIS Project, and the DAACs. 

When and if NASA begins charging to recoup their costs, the DAAC User Service Representative 
(US Rep) will be responsible for direct interaction with users regarding pricing, billing, refunds, or 
any other matter regarding data costs. The DAAC User Services Representatives will be able to 
establish single accounts, or group accounts in which a number of users are allowed to charge a 
common account. 

For more information regarding the Pricing and Billing Policy see "Data and Information Policy," 
published in the 1995 MTPE/EOS Reference Handbook , EOS Project Plan (5/95). 
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19.2.5 Specify Order Details 

Once data has been marked for order, the media and format options must be selected. Select the 
Package Options button on the Order Data screen to display the Media Type and Media Format 
options screen. Each Processing Option has associated Media types and corresponding Media 
Format choices. Detailed instructions for selecting the media type can be found in the B0SOT 
Client Tutorial and the EOSDIS Users Manual, (located by the following URL: 
http://eos.nasa.gov/imswelcome). 

19.2.6 Update User Contact Log 

When a User contacts the US Rep with a request for data, the US Rep creates a User Contact Log 
record of the event. The User Contact Log remains open until the request has been completed, at 
which time the US Rep updates, then closes the log record. The User Contact Log record can be 
modified several times before the request is completed. Each time a Contact Log is modified, the 
log will display the operator that made the modification as well as the date and time of the 
modification. 

There are four User Contact Log screens: the Submit screen, the Display screen, the Edit screen, 
and the Entry Screen. The Submit screen is used to create new User Contact Log records, the 
Display screen is used to display already existing Contact Log records and to generate reports, the 
Edit screen is used to make changes to existing User Contact Log records, and the Entry screen is 
used as a path to the previous screens. When the User Contact Log is opened, it defaults to the 
Entry screen. 

To launch the User Contact Log and to retrieve/modify an individual screen, see Section 19.2.2. 

Two different methods can be used to retrieve accounts that require modifications. The US Rep 
can Modify an Individual User Contact Log record by using the menu at the top of the screen and 
following menu path Query __Modify Individual to obtain the "Edit" screen. Then he/she must 
enter the unique Log-Id, Contact Name, E-mail address, or the Short Description field to retrieve 
the individual User Contact Log record. If the US Rep needs to modify several log records he/she 
can retrieve all of the User Contact Log records created during his/her shift by following menu path 
Query __Modify all. The screen will default to the first User Contact Log record entered during 
his/her shift. At the bottom of the screen are "Previous" and "Next" action buttons, which can be 
used to toggle through the log records without inputting individual retrieval information. Pressing 
the next button will display the second User contact log record that was opened during the shift, 
and then the third, etc. Pressing the Previous button will go backwards, it will display the last User 
contact log record created during the shift. If there were 30 User Contact Log records created 
during the shift, the User Rep may not wish to toggle through 30 accounts; therefore, the Modify 
Individual would be more efficient. 

The procedure that follows explains how to Modify a User Contact Log record. This procedure 
will modify an individual User Contact Log. This procedure will change the contact E-mail 
address and will note in the "Comments Log" that the data requested has been shipped, then the 
record will be closed. 
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1	 1) Launch the User Contact Log/Trouble Ticket application. 

• The User Contact Log defaults to the Entry screen. 

2 From the Menu Bar, follow menu path Query→Modify Individual. 

• The display changes from the Entry screen to the Modify screen. 

• The screen looks the same except the action buttons on the bottom of the screen. 

3	 Click on the field to be used for finding the User Contact Log record to be updated (i.e., Log Id 
field. Contact Name field, E-mail Address field, or the Short Description field). 

• The cursor is displayed in the selected field. 

4	 Enter the information appropriate for the selected field (i.e., Log Id, Contact Name, E-mail 
Address, or something remembered from the Short Description). 

• The typed entry is displayed in the field. 

5 Follow menu path Query→Display. 

• The User Contact Log record for the data request is displayed. 

6 Click on the Comment Log field. 

7 Enter a Comment describing the update. 

•	 The comment should indicate the action(s) taken (e.g., Order for data completed; 10 
granules ordered.). 

8 Click on the Apply Edits button. 

• Edits are not implemented until the Apply Edits button is pressed. 

• The Modified-date field will display the date and time of the modification. 

•	 The Last-Modified-by field will display the name of the User Services Representative 
under whose log-in the edit is made. 

9	 To close a User Contact Log record, select the Log Status button, while holding the mouse 
button down, drag it to Close, then release the mouse button. 

• The User Contact Log record is now closed. 

19.3 Canceling an Order 

A user may choose to cancel a data order for any of a number of reasons. User Services may be 
called upon to assist by performing the cancellation on behalf of the user. The procedures for 
cancellation of an order are: 

• Create a User Contact Log record 

• Validate the User 
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• ECS Order Tracking 

• Cancel Order 

• Update the User Contact Log 

Assume a user calls to cancel an order for previously ordered data. As we have seen, this requires 
the creation of a User Contact Log record, and necessitates using the ECS User Account 
Management tool (Profile Accounts) to verify that the user is registered. Only then can you 
proceed to the next step. 

19.3.1 ECS Order Tracking and Cancellation 

To locate an order, either because a user wants to cancel it or for some other reason (e.g., a user 
wants to check on an order that has not been received), use the Order Tracking tool. 

The order Tracking tool is a view only tool. To assist you in finding an existing order, it has 
several query options: 

•	 User Name - If there is more than one order under the same first and last name, the system 
offers a Verify User Selection screen to display additional data about each order, including 
the date it was placed, to help in the verification. 

•	 Order ID - The Order ID is the unique identification number generated when the order was 
placed. 

•	 Request ID - For large orders, the Data Server may partition the order and assign more than 
one Request ID. If you use this query option, the unique Order ID will also be displayed to 
assist in tracking all parts of the order. 

The number of orders displayed can be reduced by use of the Filter by Status option. You may 
select from several status filters: 

• Pending 

• Operator Intervention 

• Staging 

• Transferring 

• Not found 

• 

• 

• 

• 

• 

Waiting for Shipment


Shipped


Aborted


Canceled


Terminated


Use the following procedure to find the user's order for previously ordered data, beginning with a 
search using the User Name query option. 
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ECS Order Tracking 

1 Access the command shell 

• The command shell prompt is displayed. 

2	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 

3	 Start the log-in to the MSS client server by typing either /tools/bin/ssh hostname (e.g., 
g0mss21) at the UNIX command shell prompt, and then press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

5	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

6	 To change to the directory containing the utility scripts to start MSS accountability GUIs, type 
cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/mode/CUSTOM/utilities, where mode will likely be TS1, TS2, 
or OPS. 

7	 Type EcMsAcOrderGUIStart mode, where mode is TS1, TS2, or OPS (or other) as selected 
in Step 6. 

• The ECS Order Tracking window is displayed. 

8 Click the Radio Box to the left of the User Name. 

• The cursor moves to the Last Name field. 

9 Enter the Last Name, then press Tab. 

• The cursor moves to the First Name field. 
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10 Enter the First Name, then press Tab. 

11 Click on the Select All button. 

• All of the status filters are selected. 

12 Press the Return/Enter key or click on the Query Order button. 

• The order is displayed in the Order List box in the ECS Data Order Tracking screen. 

•	 The Order ID, Home DAAC, Order Date, Order Type, Order Source, Status, 
Description, and Start Date are displayed. 

13	 If there are multiple requests, click on the order to highlight it in the Order List box, then click 
on the Query Request button. 

• Every request number relating to the highlighted Order is displayed. 

•	 The Order ID, Request ID, Processing DAAC, Request Type, # Files, Size, Media, 
Format, Status, Ship Date, and Description are displayed. 

14 Click on the order or the specific request to be canceled to highlight it. 

15 To cancel a highlighted request, click on the Delete Request button. 

• The request is deleted from the system. 

16 To cancel a highlighted order, first click on the Update Order button. 

• The Update dialog box is displayed. 

17 In the Update dialog box, make sure the Status checkbox has a check in it (click in the 
checkbox if necessary). 

• The Status checkbox displays a check mark. 

18	 Click on the pull-down arrow to the right of the Status New Values text field, hold the left 
mouse button and dragging to select the value "Canceled." 

• The Status New Values text field displays Canceled. 

19 Click on the Update button. 

• The order status is changed to Canceled. 

19.4Fulfilling a Subscription 

User Services may be called upon to support users in ECS functions related to subscriptions. The 
ECS subscription capability supports users' requirement to have actions taken based on the 
occurrence of future events (i.e., to be notified or have data transferred when certain conditions are 
met, such as data becoming available, or a new advertisement occurring). The ECS design 
provides the following subscription service capabilities: 
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• register new events 

- stored persistently 

- made available through Advertisement Service 

• accept subscriptions 

- accept new subscription requests that specify an action to be taken and an event to 
initiate the action 

- accept subscription update requests to update stored subscriptions 

- validate subscription requests 

• process subscriptions upon event notification 

- identify all subscriptions to the specified event 

- process the actions defined in the subscriptions 

E-mail notification 

direct program interface to other service providers 

The initial screen of the subscription services tool lists existing subscriptions and displays 
subscription identification data and other information associated with subscriptions. From the 
initial screen, the operator can access other screens that permit adding or deleting subscriptions, as 
well as screens for editing existing subscriptions. The screens for adding and editing subscriptions 
are essentially identical. The main screen for adding/editing a subscription may be accessed in two 
ways. To add a subscription, the screen may be accessed by clicking on the Add Subscription 
button. To edit a subscription, the screen may be populated with data from an existing subscription 
and accessed by first clicking on a subscription in the Subscription Information window and then 
clicking on the Edit Subscription button. 

Two major elements of a subscription are its event, or triggering circumstance, and the action to be 
taken by ECS upon occurrence of the event. The subscription service lets you identify subscribable 
events and specify actions to be taken on behalf of a user upon the occurrence of an identified 
subscribable event. Normally, the action will be to send email notification of the occurrence of the 
event. A click on the Browse Events button displays the Browse Events screen. This screen 
permits review and selection from a list of subscribable events to specify the triggering 
circumstance of a subscription being added. 

A click on the Actions button on the Add/Edit Subscriptions screen displays the Actions screen. 
This screen is employed when a user wishes to acquire a data product associated with the 
occurrence of an event. It permits entry of parameters necessary to specify an acquire action (e.g., 
ftp push, tape distribution) to be taken when the subscribable event occurs. 

Finally, a user may wish to restrict a subscription to only those instances of an event that fall within 
certain boundary constraints. For example, a science user may wish to receive notice of the 
availability of a certain type of data on a particular geographic range of the earth's surface, but only 
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if the cloud cover was less than 20% when the data collection occurred. The cloud cover restriction 
is a Qualifier that may be placed on the event using the subscription service screen. A click on the 
Qualifiers button on the Add/Edit Subscriptions screen displays this screen, which permits the 
operator to specify event qualifiers. 

The following subsections and procedures illustrate the use of the subscription service to 
accommodate various user needs for subscription support. 

19.4.1 Fulfilling a Need for a One-Time Subscription 

Suppose a user has used the DAR Tool to submit a request for ASTER expedited data, and contacts 
you with a request to acquire the data via FTP push to a specific disk directory as soon as the data 
are received at the archive. The relevant data for the necessary subscription are: 

• User ID 

• Email Address 

• Email Text 

• Start Date 

• Expiration Date 

• Event ID 

• Event Description 

• Event Name 

• Acquire 

- User Profile/ID 

- User Name 

- User Password 

- Host Name 

- Destination 

• Qualifiers 

The following procedure can be used to create the necessary subscription: 

Creating a One-time Subscription with Acquire 

1)	 Access the command shell 

• The command shell prompt is displayed. 
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2)	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press 
the Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 

3) Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., l0dms01, 
g0dms03, e0dms03, n0dms04), at the UNIX command shell prompt, and press the 
Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4) If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

5) At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

•	 NOTE: To access the Subscription Service, you will also need to perform a DCE login 
(see Steps 6 and 7). 

6)	 At the UNIX prompt, type DCE_login User ID, and then press the Return/Enter key. 

• A Password: prompt is displayed. 

7) At the Password: prompt, type DCEPassw. 

• A UNIX prompt is displayed. 

•	 NOTE: You can check that the DCE login is successful by typing klist, and the 
pressing the Return/Enter key; if the DCE login is successful, the logged in principal 
will be displayed, along with other DCE information. 

8)	 To change to the directory containing the utility scripts to start the Subscription Server GUI, 
type cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where < mode> will likely be TS1, 
TS2, or OPS. 

9)	 Type setenv MODE <mode> and then press the Return/Enter key, where <mode> is that 
selected for the path in Step 8. 

10) Type source EcCoEnvCsh and then press the Return/Enter key. 
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11) Type EcSbSubServerGUIStart <mode>, where <mode> is that selected in Step 10, and 
then press the Return/Enter key. 

• The initial screen of the Subscription Service is displayed. 

12) Click on the Add Subscription button. 

• The Add/Edit Subscriptions screen is displayed. 

13) Click on the Browse Events button. 

• The Browse Events screen is displayed. 

14) Click on the Find field. 

• The cursor appears in the Find entry field. 

15) Type ASTER DAR ID 123456789 and then click on the Find button. 

•	 The desired event (in this case, Event 109) is highlighted in the Event Information 
window. 

16) Click on the OK button. 

• The Browse Events screen is closed. 

•	 On the Add/Edit Subscriptions screen, 109 is shown as the Event ID: and Insertion of 
ASTER data is shown as the Event Description:. 

• The cursor is in the User ID: field. 

17) Type dsaster and then press the Enter key. 

• The cursor moves to the Email Address: field. 

18) Type dsaster@unh.edu and then press the Enter key. 

• The cursor moves to the Email Text: field. 

19) Type Requested data sent by ftp push to /home/dsaster/ftppush and then press the Enter key. 

• The cursor moves to the first window in the Start Date: field. 

20) Type in the current date, reflecting the format mm/dd/yyyy. 

21) Click on the first window of the Expiration Date: field to place the cursor there, and type in 
data to set the expiration date to 12/31/1998. 

•	 Set the expiration date so that the subscription duration covers the period in which the 
data are likely to reach the archive. When the user requests the subscription, it may be 
helpful to determine information about the data capture (e.g., in this case, the duration of 
the requested ASTER data acquisition). 
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22) Click on the Actions button. 

• The Actions screen is displayed. 

23) Click on the ftp Push toggle button. 

• The ftp Push button shows as depressed. 

24) Click on the User Profile: field. 

• The cursor appears in the User Profile: field. 

25) Type in dsaster and then press the Enter key. 

• The cursor moves to the User Name: field. 

26) Type in D.S. Aster and then press the Enter key. 

• The cursor moves to the User Password: field. 

27) Type in the password (in this case, sbpass1) and then press the Enter key. 

• The cursor moves to the Verify Password: field. 

28) Type in the password again (in this case, sbpass1) and then press the Enter key. 

• The cursor moves to the Host Name: field. 

29) Type in the host name (in this case, science.lib.unh.edu) and then press the Enter key. 

• The cursor moves to the Destination: field. 

30) Type in the directory to which the file is to be pushed (in this case, /home/dsaster/ftppush). 

31) Click on the OK button. 

• The Actions screen is closed and the Add/Edit Subscriptions screen is accessible. 

32) Click on the Submit button. 

•	 The Add/Edit Subscriptions screen is closed and the initial screen of the Subscription 
Service is accessible. 

• The new subscription is displayed in the Subscription Information window. 

33) Follow menu path File(Exit. 

• The Subscription Service screen is closed. 

19.4.2 Fulfilling a Need for an Open-Ended Subscription 

Suppose a user notes an advertisement for quarterly updates on an ocean biology model based on 
data obtained in the Sea-viewing Wide Field-of-view Sensor (SeaWiFS) program. She requests an 
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ongoing, regular E-mail notification when an update is available. 
subscription are: 

• User ID 

• Email Address 

• Email Text 

• Start Date 

• Expiration Date 

• Event ID 

• Event Description 

• Event Name 

• Acquire 

The relevant data for the 

•	 Qualifiers Use the following procedure to establish an ongoing subscription for the 
requested notification: 

Creating an Open-Ended Subscription 

1) Access the command shell 

• The command shell prompt is displayed. 

2)	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press 
the Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 

3) Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., l0dms01, 
g0dms03, e0dms03, n0dms04), at the UNIX command shell prompt, and press the 
Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4) If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 
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5) At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

•	 NOTE: To access the Subscription Service, you will also need to perform a DCE login 
(see Steps 6 and 7). 

6)	 At the UNIX prompt, type DCE_login User ID, and then press the Return/Enter key. 

• A Password: prompt is displayed. 

7) At the Password: prompt, type DCEPassw. 

• A UNIX prompt is displayed. 

•	 NOTE: You can check that the DCE login is successful by typing klist, and the 
pressing the Return/Enter key; if the DCE login is successful, the logged in principal 
will be displayed, along with other DCE information. 

8)	 To change to the directory containing the utility scripts to start the Subscription Server GUI, 
type cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where < mode> will likely be TS1, 
TS2, or OPS. 

9)	 Type setenv MODE <mode> and then press the Return/Enter key, where <mode> is that 
selected for the path in Step 8. 

10) Type source EcCoEnvCsh and then press the Return/Enter key. 

11) Type EcSbSubServerGUIStart <mode>, where <mode> is that selected in Step 10, and 
then press the Return/Enter key. 

• The initial screen of the Subscription Service is displayed. 

12) Click on the Add Subscription button. 

• The Add/Edit Subscriptions screen is displayed. 

13) Click on the Browse Events button. 

• The Browse Events screen is displayed. 

14) Click on the Find field. 

• The cursor appears in the Find entry field. 

15) Type SeaWiFS Model Update and then click on the Find button. 

•	 The desired event (in this case, Event 153) is highlighted in the Event Information 
window. 

16) Click on the OK button. 

• The Browse Events screen is closed. 
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•	 On the Add/Edit Subscriptions screen, 153 is shown as the Event ID: and Ocean 
Biology Model Update Insertion is shown as the Event Description:. 

• The cursor is in the User ID: field. 

17) Type pascient and then press the Enter key. 

• The cursor moves to the Email Address: field. 

18) Type pascient@engr.1.engr.hamptonu.edu and then press the Enter key. 

• The cursor moves to the Email Text: field. 

19) Type Ocean biology model quarterly update is available and then press the Enter key. 

• The cursor moves to the first window in the Start Date: field. 

20) Type in data to set the start date to 07/01/1998. 

21) Click on the first window of the Expiration Date: field to place the cursor there, and type in 
data to set the expiration date to 12/31/2005. 

•	 Set the expiration date so that the subscription duration covers a period satisfactory to 
the user and/or reflecting DAAC policy on maximum duration for subscriptions. The 
duration and any policy governing restrictions on duration should be discussed when the 
user requests the subscription. 

22) Click on the Submit button. 

•	 The Add/Edit Subscriptions screen is closed and the initial screen of the Subscription 
Service is accessible. 

• The new subscription is displayed in the Subscription Information window. 

23) Follow menu path File(Exit. 

• The Subscription Service screen is closed. 

19.4.3 Returning a List of Subscriptions 

The initial screen of the Subscription Service provides a list of subscriptions and information about 
them. This screen provides a useful resource for answering user queries concerning their 
subscriptions. The Find function may be used to search and highlight an individual subscription. 
Use the following procedure to obtain a list of subscriptions. 

Display a List of Subscriptions and Subscription Information 

1)	 Open the Subscription Service via the following UNIX commands. 

• Open the command shell. 
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• Type xhost <remote_workstation_name> and then press the Enter key. 

•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

• Open the command shell. 

• Type xhost <remote_workstation_name> and then press the Enter key. 

•	 At the UNIX shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Enter key. (Note: for "clientname", use either the IP address or machine name.) 

•	 Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., l0dms01, 
g0dms03, e0dms03), at the UNIX command shell prompt, and press the Enter key. 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears, go to the next 
step; if you have not previously set up a secure shell passphrase, skip the next step. 

•	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Enter key; skip the next step 

•	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Enter key. (NOTE: To access the Subscription Service, you will also need to perform a 
DCE login). 

• At the UNIX prompt, type DCE_login User ID, and then press the Enter key. 

• A Password: prompt is displayed; DCEPassw. 

• A UNIX prompt is displayed. 

•	 To change to the directory containing the utility scripts to start the Subscription Server 
GUI, type cd /path and then press the Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where <mode> will likely be TS1, 
TS2, or OPS. 

•	 Type setenv MODE <mode> and then press the Enter key, where <mode> is that 
selected for the path in the previous step. 

• Type source EcCoEnvCsh and then press the Enter key. 

•	 Type EcSbSubServerGUIStart <mode>, where <mode> is that selected in the 
previous step and then press the Enter key. 

• The initial screen of the Subscription Service is displayed. 

• Click on the Add Subscription button. 
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• The Add/Edit Subscription screen is displayed.


• Click on the Browse Events button.


• The initial screen of the Subscription Service is displayed.


2)	 Click on the Find field. 

• The cursor appears in the Find entry field. 

3)	 Type in the User ID for the user whose subscription(s) are of interest. 

• Any subscription for the entered User ID is highlighted. 

19.4.4 Canceling a Subscription 

Canceling a subscription is accomplished using the initial screen of the Subscription Service. 
Suppose you are a User Services representative and receive a call from a user requesting you to 
cancel her subscription for notification of Ocean Biology Model updates. The following procedure 
is applicable. 

Cancel a Subscription 

1)	 Access the command shell 

• The command shell prompt is displayed. 

2)	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press 
the Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 

3) Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., l0dms01, 
g0dms03, e0dms03, n0dms04), at the UNIX command shell prompt, and press the 
Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4) If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 
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5) At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

•	 NOTE: To access the Subscription Service, you will also need to perform a DCE login 
(see Steps 6 and 7). 

6)	 At the UNIX prompt, type DCE_login User ID, and then press the Return/Enter key. 

• A Password: prompt is displayed. 

7) At the Password: prompt, type DCEPassw. 

• A UNIX prompt is displayed. 

•	 NOTE: You can check that the DCE login is successful by typing klist, and the 
pressing the Return/Enter key; if the DCE login is successful, the logged in principal 
will be displayed, along with other DCE information. 

8)	 To change to the directory containing the utility scripts to start the Subscription Server GUI, 
type cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where < mode> will likely be TS1, 
TS2, or OPS. 

9)	 Type setenv MODE <mode> and then press the Return/Enter key, where <mode> is that 
selected for the path in Step 8. 

10) Type source EcCoEnvCsh and then press the Return/Enter key. 

11) Type EcSbSubServerGUIStart <mode>, where <mode> is that selected in Step 10, and 
then press the Return/Enter key. 

• The initial screen of the Subscription Service is displayed. 

12) Click on the Find field. 

• The cursor appears in the Find entry field. 

13) Type in the User ID for the user whose subscription(s) are of interest (in this case, pascient). 

• Any subscription for the entered User ID is highlighted. 

14) If the subscription requested for cancellation is not the highlighted one (in this case, Event 
ID 153), click on it. 

• The selected subscription information is highlighted. 

15) Click on the Delete Subscription button. 

• The highlighted subscription is cancelled. 

16) Follow menu path File(Exit. 

• The Subscription Service screen is closed. 
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19.5Data Dictionary Maintenance 

Requests for ECS services may come from the EOS Data Gateway (EDG) Web Client of Version 0 
(V0). For example, users, including those from the ASTER Ground Data System (GDS), will 
submit requests for data searches and product orders using the EDG Search and Order Tool. 
Requests for ECS products or services (e.g., Directory Search requests, Inventory Search requests, 
Browse requests, Product requests) are sent to the ECS V0 Gateway. To accommodate mapping of 
terminology between the ECS and the V0 system, the ECS V0 Gateway reads the ECS Data 
Dictionary containing the terminology mapping information, ensuring that the request can be 
directed to the appropriate science data server. A Data Dictionary Administrator builds the ECS 
Data Dictionary V0 System search parameters, ECS schema, and metadata. The V0 client must 
have ECS Valid terminology for searchable attributes (e.g., source, sensor, geophysical parameter, 
data set name, data center ID, campaign, processing level, geographical coordinates, and temporal 
intervals) in order to search ECS holdings. 

Accordingly, upon establishment of a new ECS data set, valids for the data set must be made 
available to V0. EOSDIS V0 IMS has a two-week valids update cycle: 

•	 Data centers (sites) submit their new valids, definitions, and/or package Object 
Description Language (ODL) file(s). An ODL file is a formatted ASCII text file that 
contains the keyword descriptions for the data sets. 

• Valids ODL files are transferred to the V0 IMS using anonymous FTP. 

•	 The IMS team acknowledges receipt of the new valids submission and runs a syntax 
checker on the files. 

• The files are processed and the valids are tested. 

More detailed information on the cycle and the update process may be obtained at 
http://harp.gsfc.nasa.gov/v0ims/valids/valids_procedures.html. 

There is two-way interoperability with the ASTER GDS for product search and orders. This means 
that ASTER GDS users can search, browse, and order ECS products, and ECS users can search, 
browse, and order products available at GDS. Information is also exchanged concerning price 
estimates and order status. ASTER GDS access to ECS products and services is through the EROS 
Data Center (EDC). Therefore, all ECS collection information must be available at EDC. 
Furthermore, ECS must be able to use ASTER GDS dataset valids. 

Use the following procedure to launch the Data Dictionary Maintenance Tool. 

Launch Data Dictionary Maintenance Tool 

1 Access the command shell 

• The command shell prompt is displayed. 
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2	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 

3	 Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., g0ins02) at the 
UNIX command shell prompt, and press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

5	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

6	 To change to the directory containing the utility scripts to start the Data Dictionary 
Maintenance Tool GUI, type cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where <mode> will likely be TS1, 
TS2, or OPS. 

7	 Type EcDmDdMaintenanceToolStart <mode>, where <mode> is that selected in Step 7, and 
then press the Return/Enter key. 

• The initial screen of the Data Dictionary Maintenance Tool is displayed. 

Use the following procedure to launch the Data Dictionary Maintenance Tool. 

Launch Data Dictionary Maintenance Tool 

8 Access the command shell 

• The command shell prompt is displayed. 

9	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 
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10	 Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., g0ins02) at the 
UNIX command shell prompt, and press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

1 1  If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

12	At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

1 3  To change to the directory containing the utility scripts to start the Data Dictionary 
Maintenance Tool GUI, type cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where <mode> will likely be TS1, 
TS2, or OPS. 

14	 Type EcDmDdMaintenanceToolStart <mode>, where <mode> is that selected in Step 7, and 
then press the Return/Enter key. 

• The initial screen of the Data Dictionary Maintenance Tool is displayed. 

Use the following procedure to launch the Data Dictionary Maintenance Tool. 

Launch Data Dictionary Maintenance Tool 

15 Access the command shell 

• The command shell prompt is displayed. 

16	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 
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17	 Start the log-in to the interface server by typing /tools/bin/ssh hostname (e.g., g0ins02) at the 
UNIX command shell prompt, and press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

1 8  If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

19	At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

2 0  To change to the directory containing the utility scripts to start the Data Dictionary 
Maintenance Tool GUI, type cd /path and then press the Return/Enter key. 

•	 For path, use /usr/ecs/<mode>/CUSTOM/utilities, where <mode> will likely be TS1, 
TS2, or OPS. 

21	 Type EcDmDdMaintenanceToolStart <mode>, where <mode> is that selected in Step 7, and 
then press the Return/Enter key. 

• The initial screen of the Data Dictionary Maintenance Tool is displayed. 

Use the following procedure for import of ASTER dataset valids. 

Import Valids 

1 Launch the Data Dictionary Maintenance Tool. 

2 Click on the Import Valids File tab. 

• The Import Valids File screen is displayed. 

3 Under Load Valids File., click in the File Name: field and type <validsfilename>. 

•	 <validsfilename> is the full path for the file to be imported. It is possible to click on the 
Browse . . . button and click to select the file. 

• The typed or selected entry is displayed in the File Name: field. 

4 Click on the Check button. 

• The system checks the syntax of the valids file and generates any collection messages. 
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5 Under Save Syntax Error File, click in the File Name: field and type <errorfilename>. 

•	 <errorfilename> is the full path for the file to be saved. It is possible to click on the 
Browse . . . button and click to select a file. 

6 To save the statistics or warnings to the named statistics/warning file, click on the Save button. 

• The file is saved. 

7 To submit the collection to the Data Dictionary, click on the Update button. 

• The collection is inserted. 

8 Click on the Map Attributes/Keywords tab. 

• The Map Attributes/Keywords screen is displayed. 

9 Click on the Update All Collections button. 

•	 The ECS collections are updated with the new mappings. (Note: This update may take 
several minutes.) 

Checking Data Dictionary Server Log Files 

Log files can often provide information that will identify possible sources of disruption in Data 
Dictionary server function or communications, suggesting additional checks or actions that may 
help resolve the problem. The procedure for checking a log file starts with the assumption that the 
operator has logged in to ECS. 

Checking Data Dictionary Server Log Files 

1	 To log in to the host for the server and log(s) to be examined, type /tools/bin/ssh 
<hostname> and then press the Return/Enter key. 

•	 For <hostname>, use e0ins02 at EDC, g0ins02 at GSFC, l0ins02 at LaRC, and n0ins02 
at NSIDC. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 2. 

• If you have not previously set up a secure shell passphrase; go to Step 3. 

2	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 4. 

• The prompt reflects the login to the selected host. 
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3	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

• The prompt reflects the login to the selected host. 

4 Type cd /usr/ecs/<MODE>/CUSTOM/logs and then press the Return/Enter key. 

• The prompt reflects the change to directory /usr/ecs/<MODE>/CUSTOM/logs. 

5 To view a server log, type pg filename and then press the Return/Enter key. 

•	 filename refers to the account management log file to be reviewed (e.g., EcDm 
DictServer.ALOG, EcDmDictServerDebug.log). 

•	 The first page of the log file is displayed; additional sequential pages can be displayed 
by pressing the Return/Enter key at the : prompt. 

•	 Although this procedure has been written for the pg command, any UNIX editor or 
visualizing command (e.g., vi, more, tail) can be used to review the log file. 

•	 Typically, the <server>Debug.log captures more detailed information than the 
<server>.ALOG. However, for some servers (e.g., SDSRV), there may be significant 
detail in the <server>.ALOG. It is also important to note that the DebugLevel setting 
in the <server> . C F G  file determines the level of detail captured in the 
<server>Debug.log  (0 is off, a setting of 1 captures status and errors, a setting of 2 
captures major events, and a setting of 3 is a full trace recording of all activity). If the 
DebugLevel has been set to one of the lower levels during operations, the System 
Administrator may set it to 3 during troubleshooting. 

6	 Review the log file(s) to determine if there are any indications of connection problems 
(DCE) or errors at start up. 

•	 The EcDmDictServerDebug.log file for the User Profile/User Registration server may 
contain an error message concerning PF Init or some DCE error or problem (notify the 
System Administrator/DCE Administrator). 

•	 The EcDmDictServer.ALOG file may contain evidence of a Sybase error (e.g., 
SybaseErrorCode1 =92014;SybaseErrorMesage1 ="x0ins01_srvr" o r  
SybaseErrorCode2 =16;SybaseErrorMesage2 ="") (notify the Database 
Administrator). 

7	 To exit the pg review of the log file, type q at the : prompt and then press the Return/Enter 
key. 

19.6Cross-DAAC Referral Processing 

Sometimes a user may request your help in placing an order for data that are not available at your 
DAAC. Similarly, a User Services representative at another DAAC may receive a request for help 
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in placing an order for data that are held at your DAAC, with the result that you receive a referred 
request. 

Referral to Another DAAC 

Suppose, for example, that User Services receives an E-mail request from Dr. Ima D. Geologist for 
help in finding Landsat images of an area in Africa from the NASA Landsat Data Collection. The 
User Services representative follows an established approach in response: 

• User Contact Log record – document the request. 

• User Profile – verify that the requester is a registered user. 

• Data Search and Order tool – locate the requested data. 

When the search results indicate that the data are held at the Earth Resources Observation System 
(EROS) Data Center (EDC), the User Services representative refers the request to that site. The 
referral is accomplished by 

• forwarding the original E-mail request to User Services at EDC. 

• adding some forwarding information to explain the origin of the request. 

• including the preliminary search as a desktop object attached to the E-mail. 

•	 including the original Contact Log Id record as an attachment to assist in any 
backtracking that may be necessary. 

•	 sending the requester an E-mail message explaining that the request for help has been 
forwarded to EDC and providing a contact name and phone number at EDC. 

The action is completed by updating the User Contact Log record to document the referral, and, 
because there should be no requirement for further interaction between the home DAAC and the 
requester, closing the User Contact Log. 

19.7Receiving a Referral from Another DAAC 

You may receive a cross-DAAC referral from a User Services representative at another DAAC who 
has received a request for help in locating and ordering data that is stored at your DAAC. In that 
case, you follow an established procedure that should seem familiar by now: 

• User Contact Log record – document receipt of the referral. 

• User Profile – verify for yourself that the requester is a registered user. 

• Data Search and Order tool – locate the requested data. 

•	 Review the E-mail – verify that the search is complete or add search parameters, 
contacting the user if more information is necessary. 

19-58 611-CD-510-001




• Submit the order.


• Update User Contact Log record – indicate completion of order; close the record.


19.8Cross-DAAC Order Tracking 

If a user has placed an order that required a cross-DAAC referral, there may arise a requirement for 
order tracking that involves more than one DAAC. For example, you may have referred an order to 
another DAAC, and if you receive a request for help from the user in tracking the status of the 
order, you may have to contact the other DAAC to provide the needed help. Similarly, you may be 
requested by another DAAC to provide the status of an order that has been referred. 

19.9Tracking to Another DAAC 

Suppose you receive a request from Dr. Ima D. Geologist to provide the status of her order for 
Landsat Images. You may recall having referred the order to EDC, but you may not, or, if another 
User Services representative handled the initial request and referral, you may not know about it. 
Just as with any user contact, you follow established steps in providing the requested assistance: 

• User Contact Log record – document the request. 

• User Profile – verify that the requester is a registered user. 

Now, however, if you do not recall or know about the referral, you may try to trace the order using 
the ECS Order Tracking Tool, without success because it is not pending in the system at your 
DAAC. The user has assured you that an order was placed. As a resourceful User Services 
representative, your next thought could be that the order has been fulfilled by your DAAC, and 
therefore has a status of completed. A reasonable check, then, is to examine the User Contact log 
records for a closed action related to the user’s request. Use the following procedure. 

Query User Contact Log


1 Launch the User Contact Log application GUI.


• The User Contact Log defaults to the Entry screen. 

2 Click on the Query field. 

3 Click on the Fields button, highlight Contact Name, and release the mouse button. 

• The Query field shows ’Contact Name’. 

4 Click the = button. 

• The Query field shows ’Contact Name’ =. 

5 Enter the Contact Name, using quotation marks (in this case, ”Geologist”). 

• The Query field shows ’Contact Name’ = “Geologist”. 
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6 Click the AND button. 

• The Query field shows ’Contact Name’ = “Geologist” AND. 

7 Click on the Fields button, highlight “Log Status,” and release the mouse button. 

• The Query field shows ’Contact Name’ = “Geologist” AND ‘Log Status’. 

8 Click the = button. 

• The Query field shows ’Contact Name’ = “Geologist” AND ‘Log Status’ =. 

9 Enter “”Closed”” (using quotation marks). 

•	 The Query field shows ’Contact Name’ = “Geologist” AND ‘Log Status’ = 
“Closed”. 

10 Choose List from the Query menu (follow menu path Query→List). 

•	 A list box is displayed showing the User Contact Log records that match the Query 
conditions. 

11 Highlight the desired record and follow menu path Query→Display . . . . 

• The Entry screen fields display the data for the selected record. 

•	 The Comment Log field displays the comment that the request was forwarded to 
another DAAC (in this case, EDC). 

19.10Responding to a Tracking Request from Another DAAC 

Given that the Comment Log in the User Contact Log record indicates that the request was 
forwarded, the next step is to use the telephone or E-mail to contact the DAAC to which the request 
was forwarded to check on the status of the request. That DAAC will then proceed with 
established steps to determine the status of the order: 

• User Contact Log record – update the record to document the current status check. 

• User Profile – verify that the requester is still a registered user. 

• ECS Order Tracking tool – check on the status of the user’s data request. 

• telephone or E-mail to the user – provide the status of the data request. 

•	 telephone or E-mail to the original DAAC – permit closing of the User Contact Log 
record there. 

• User Contact Log record – update the record to document that the status was provided. 
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19.11On-Demand Product Requests 

As of Release 5B, authorized users can use an HTML interface to submit requests for the creation 
of ASTER high-level products, Digital Elevation Models (DEMs), and non-standard Level 1B 
products. To provide these on-demand products, the Client, Planning, Data Processing, and System 
Management Subsystems of ECS at the EROS Data Center (EDC) include specific support 
capabilities. 

•	 Client (CLS) provides an On-Demand Form Request Manager (ODFRM), which is an 
HTML interface to collect the user-specified parameters for the ASTER on-demand 
request. 

•	 Planning (PLS) provides a server, the On-Demand Product Request Manager 
(ODPRM), for creating and queuing on-demand production requests. 

•	 Data Processing (DPS) updates the status for high-level processing of on-demand 
requests. 

•	 System Management Subsystem (MSS) includes on-demand requests in its Order 
Tracking Database and Data Order Tracking Tool. 

User Services at EDC may be called upon to assist users in use of the ODFRM, and to use the Data 
Order Tracking Tool to provide the status of on-demand product requests or cancel them. Error! 
Reference source not found. illustrates the Welcome screen of the ODFRM, which is used to log 
in as a registered user authorized to use the ODFRM. For those users who need the authorization, it 
is granted using the User Registration GUI as part of the user registration process. 

Using the On-Demand Form Request Manager (ODFRM) 

The following procedure is applicable for using the ODFRM to prepare an On-Demand Product 
Request. 

Using the On-Demand Form Request Manager (ODFRM) 

1 Access the command shell. 

• The command shell prompt is displayed. 

2	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 
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3	 Start the log-in to a Netscape host by typing /tools/bin/ssh hostname (e.g., g0ins02, e0ins02, 
l0ins02, n0ins02) at the UNIX command shell prompt, and press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

5	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

• You are logged in and a UNIX command shell prompt is displayed. 

6 Type netscape and then press the Return/Enter key. 

• The Netscape web browser is displayed. 

7 Click in the Netsite: field. 

• The field is highlighted. 

8	 Type http://<x>0ins02u.ecs.nasa.gov:10000/ClOdHome.html and then press the Return/Enter 
key. 

• The ASTER On-Demand Form Request Manager page is displayed. 

9	 Log in as a registered ECS user authorized to order an ASTER L1B product by typing a valid 
user ID in the User ID: field and a valid password in the Password: field. (Note: Leave the E­
mail Address: field blank; E-mail Address is not required for an ECS user.) 

• The typed entries appear in the fields. 

10 Click on the Continue button to continue. 

• The Select Products page appears. 

11	Select the product to be requested (for this exercise, select AST_09T Surface Radiance --
TIR) by clicking on the selection button to the left of the product name. 

• The selection is indicated. 

12 Click in the Identify Inputs: text box. 

• The cursor is displayed in the Identify Inputs: box. 
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13	 The granule ID for the relevant input granule may now be typed, or, more appropriately, if you 
have used the ECS Data Gateway (EDG) web client to search and locate the input granule, the 
granule ID may be entered by using the Copy and Paste functions to copy it from the EDG 
inventory search result screen. 

• The granule ID of the input granule is displayed in the Identify Inputs: text box. 

14 Click on the Continue button to continue. 

•	 The ODFRM page displays valid values and defaults for AST_09T processing 
parameters. 

15 Click on the Continue button to accept the defaults and continue. 

• A Shipping Information page is displayed permitting selection of media options. 

16	 Click on the appropriate selection button to identify the preferred method for transferring the 
product (no click is needed to accept the default) and then click on the Continue button. 

• The Order Review page is displayed. 

17	 When satisfied with the selections indicated on the Order Review page, click on the Submit 
button. 

•	 The Product Results window is displayed showing that the order was submitted and 
providing tracking information. 

18 To exit from Netscape, follow menu path File→Exit. 

19.12Data Acquisition Request (DAR) Tool 

This topic addresses the Data Acquisition Request (DAR) tool, an ECS client tool for which 
science users may request assistance from User Services at the EROS Data Center (EDC). It is 
essential, therefore, that EDC User Services representatives be familiar with the tool, and be able to 
perform the functions necessary to create and submit a DAR, as well as to create and submit a 
query to the XAR database. 

19.12.1 Purpose of the DAR Tool 

The DAR tool permits users to submit DARs, or requests for scheduling data acquisitions by the 
Advanced Spaceborne Thermal Emissions and Reflection (ASTER) Radiometer. The requests are 
submitted through the ECS client to the ASTER Ground Data System (GDS), located in Japan. 
The ASTER GDS controls scheduling of the ASTER instrument and provides the collected data as 
level 1A and level 1B data to the EDC. 

19.12.2 The DAR Tool User Interface 

The window of the DAR tool is a screen with three tabs. When the DAR Tool is initially launched 
from the desktop, the DART tool opens with the first tab, called Summary, selected. There are two 
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main functional areas on the Summary tab, which allows the user to view a condensed presentation 
of DAR work, query parameters, and the returned results of submitted DAR request that are stored 
locally (on a hard drive or LAN): 

• the Project Folders area, and 

• the Parameters area. 

The Project Folders area is intended to function as a file manager. In this area, DAR work that is 
stored locally (a hard drive or LAN) is displayed. This includes DAR requests upon which a user is 
still working, the parameters of DARs that have been sent, and the header data for DARs that have 
been returned from previous requests or DAR Database searches. It is intended that when a user 
selects a particular DAR, the Parameters field becomes populated with data entries that are relevant 
to the highlighted request. 

If the user wishes to edit the contents of a DAR stored locally (i.e., finish an incomplete DAR that 
was saved or edit a previous DAR for which the parameters had been saved), the user can select the 
desired item from the Project Folders list by clicking on it and then on the pushbutton below the 

Project Folders area labeled "Copy parameters of highlighted item to Create/Edit Request Tab." 
The action will cause all parameters stored for the highlighted item to populate the appropriate 
fields in the "Create/Edit Request" functional group where the user can inspect and/or edit them. 

19.12.3 Create/Edit Request 

To edit the parameters, or to create a new DAR, the user clicks on the Create/Edit Request tab, 
bringing up the screen which provides access to all the functions necessary to create a new DAR or 
to edit existing DAR parameters. Some of these are immediately available, and others are in 
secondary dialog screens launched from pushbuttons at the right (i.e., Spatial Requirements, 
Temporal Requirements, Advanced Viewing Geometry, and Special Requests. Spatial and 
Temporal requirements must be entered to complete a DAR. Advanced Viewing Geometry and 
Special Requests options are not required. When a user visits one of these screens, makes entries 
or edits, and accepts the changes in that screen, a checkmark is placed in a box next to the 
pushbutton on the Create/Edit Request screen, providing a visual aid reminding the user of 
completed actions in preparing the DAR. 

A Resource Estimate button, labeled Calculate & Display, executes an algorithm that estimates the 
number of good scenes that will be returned from the XAR request in progress, and a Submit button 
initiates sending the DAR to the ASTER Ground Data System (GDS) in Japan. 

The Create/Edit Request screen permits selection of one or a combination of the telescopes that are 
part of the ASTER instrument. The three telescopes are: 

• VNIR (Visible and Near-Infrared spectrum). 

• SWIR (Short-wave and Infrared spectrum). 

• TIR (Thermal Infrared spectrum). 
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Five possible selections are available through activation of an option button: 

•	 Full Mode -- The full activation of the all bands of the VNIR, SWIR, and TIR telescopes 
together. 

• VNIR Only -- The activation of all bands of the VNIR telescope only. 

•	 V3N/V3B Stereo -- The activation of the V3N & V3B bands (a stereo pair) of the VNIR 
telescope. In this mode, V1 and V2 are not activated. 

•	 SWIR & TIR -- The activation of all bands of the SWIR and TIR telescopes. In this mode, 
no bands of the VNIR telescope are activated. 

•	 TIR Only -- The activation of the TIR telescope only. In this mode, no bands of the VNIR 
and SWIR telescopes are activated. 

The user may click to choose to display or not to display Gain Settings for the available bands of 
each telescope. For each band of the VNIR telescope, the user can use the option button to select 

high, normal, or low gain settings. For each band of the SWIR telescope, the user can use the 
option button to select high, normal, low, or very low gain settings. These option buttons are 
desensitized when the telescope to which the affected bands belong is not selected. 

19.12.4 Spatial Requirements 

The Spatial Requirements screen allows the user to define an Area of Interest (AOI) and specify 
coverage criteria such as sampling, cross track fragmentation and area of interest duration for the 
query. The user can pan the map by dragging it with the mouse or by using the controls on the Pan 
& Zoom tab at the right side of the screen. Zoom controls are also found on this tab. 

Immediately below the map display is a group of widgets labeled Area of Interest Polygon 
Selection. Clicking on the Create AOI button enables the user to enter data adding four geographic 
points in sequence to define a polygon on the map, either using data entry fields or using the 
mouse to click on the desired points on the map. Clicking on Apply and then Dismiss completes 
the entry of Spatial Requirements and returns to the Create/Edit Request screen. 

19.12.5 Temporal Requirements 

The Temporal Requirements screen allows the user to select the times at which observations for a 
specific DAR are to occur. First, the user must enter the start and end dates/times for the DAR 
Lifetime (the time over which all observations for the DAR are taken, within the year specified at 
the top of the screen). The next two parameters, "repeat interval" and "acquisition window" are 
somewhat interdependent. If the user decides that it is not necessary to have a steady stream of data 
about a particular AOI, but wants image data from the same AOI at regular time intervals, then the 
user must use the repeat interval and acquisition window controls to specify the number of evenly 
spaced intervals or the duration of time between the starts of evenly spaced intervals and the 
duration of those intervals. Clicking on Apply and then Dismiss completes the entry of Temporal 
Requirements and returns to the Create/Edit Request screen. 
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19.12.6 Optional Screens 

Two other screens of the DAR Tool provide capability for the user to specify additional 
requirements for the ASTER data acquisition request. The Advanced Viewing Geometry screen 
allows the user to specify an Acceptable Sun Angle Range and either the Look Angle or View 
Swath for the query. The user may specify an instrument Look Angle in degrees relative to nadir 
or select a View Swath from up to 40 possible choices, or alternatively, specify an Acceptable Look 
Angle Range. For the Sun Angle and Look Angle, minimum and maximum degree angles can be 
specified. This is done by either numeric text entry or by using the arrow buttons to the right of the 
text field to set numeric values within the field. Clicking on Apply and then Dismiss completes the 
entry of Advanced Viewing Geometry Requirements and returns to the Create/Edit Request screen. 

The Special Requests screen allows the user to identify any need and justification for special 
treatment of the request being prepared. Here the user can note any planned Ground Campaign 
(signifying a need to assign priority to the request to assure collection of data by satellite concurrent 
with data collection by scientists on the ground), identify any implementation urgency for the 
request, or request that the delivery of data be expedited and/or that data be delivered via a direct 
downlink. Text areas are provided to permit entry of appropriate justification for these special 
requests. Clicking on Apply and then Dismiss completes the entry of Special Requests and returns 
to the Create/Edit Request screen. 

19.12.7 Resource Estimate 

The Resource Estimate option executes an algorithm that estimates the number of good scenes that 
will be returned from the DAR being prepared. The result of the calculation is displayed in an 
information dialog. After viewing the results, the user can click OK to dismiss the dialog. 

Clicking on the Submit button on the Create/Edit Request screen initiates the submission of the 
request. However, if the user has not visited and/or applied data entries for all of the screens of the 
DAR Tool, a warning dialog informs the user of the items for which parameters or data have not 
been entered and asks whether to submit the request anyway. If the user elects to continue the 
submit operation and the mandatory DAR request parameters have been supplied, a DAR ID is 
returned from Ground Data System several seconds later. 

The following procedure illustrates an example DAR preparation and submission for collection of 
thermal infrared imagery of the Lake Tahoe area: 

Prepare and Submit a Data Acquisition Request (DAR) 

1 Access the command shell 

• The command shell prompt is displayed. 

2	 At the UNIX command shell prompt, type setenv DISPLAY clientname:0.0 and then press the 
Return/Enter key. 

•	 For clientname, use either the local terminal/workstation IP address or its machine 
name. 
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3	 Start the log-in to the client server by typing /tools/bin/ssh hostname (e.g., e0ins02, g0ins02, 
l0ins02, n0ins02), at the UNIX command shell prompt, and press the Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone does not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with 
Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 

4	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase and then press the Return/Enter key. Go to Step 6. 

5	 At the <user@remotehost>'s password: prompt, type your Password and then press the 
Return/Enter key. 

6 Type netscape and then press the Return/Enter key. 

• The Netscape browser window is displayed. 

7	 Type the entry for the Java DAR Tool (JDT) Uniform Resource Locator (URL) 
(http://e0ins02.ecs.nasa.gov:10402/JDTApplet_plugin.html) directly into the Location: field, 
and then press the Return/Enter key. 

• A Netscape: The Java DAR Tool window is displayed. 

• A Java Console dialog box with scrolling information is displayed. 

• A dialog box is displayed with Username: and Password: fields. 

•	 Note: If you have not loaded the latest Java plugin for your browser, you will be 
prompted to do so. Download the plugin and follow the instructions. On UNIX, run 
<(sh plugin_file_name.sh) on the plugin file and answer the questions. Once the plugin 
is installed, restart the browser. 

8	 Click on the Username: field and type <DAAC_login_name>, click on the Password: field 
and type <DAAC_password>, and then click the OK button or press the Return/Enter key. 

•	 Note: An ECS DAAC account username and password allowing submission of a DAR 
must be created prior to performing this procedure. As an alternative, it is possible to 
access the Java DAR tool as "ECSGuest" to explore how most of the screens work, but 
it will not be possible to submit a DAR or receive a DAR ID. 

•	 A Java DAR tool "Welcome to the Data Acquisition Tool" dialog is displayed, with 
introductory information to the user. If the login is as "ECSGuest," the information 
indicates that submission of a DAR is not authorized, and information is given on how 
to apply for authorization. 
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9 Click on the OK button in the "Welcome" dialog box. 

• The dialog box is removed. 

•	 A large new window, The Java DAR Tool window, is displayed, with the Organizer 
tab as the default, showing a list of folders and the names of any previously saved or 
submitted DARs. 

10 Click on the Create/Edit DAR tab. 

•	 The Create/Edit DAR functions are displayed, with the General nested tab displayed 
as default and Untitled xAR showing as the default in the XAR Title: field. 

11 Highlight the title Untitled xAR in the XAR Title: field and type JDARC/O_<date>. 

• The typed title appears in the XAR Title: field. 

12 Click on the arrow to the right of the Investigation Class: field. 

• A pop-up window displays valid classes. 

13 Click on Soils in the pop-up window. 

•	 The pop-up window disappears and the selection (Soils) is displayed in the 
Investigation Class: field. 

14 Click in the Scientific Objective: field and type a scientific objective. 

•	 Note: Information to be entered in this field should be obtained from the scientist for 
whom the DAR is being created. 

15	 Verify that the Maximum Cloud Coverage is <20% (if necessary, click on the option button 
to display a pop-up window and, holding down the left mouse button, drag the cursor to select 
<20%). 

• The selected value is displayed on the option button. 

16	 Click on the option button for Telescope Selection and, holding down the left mouse button, 
drag the cursor to select TIR Only. 

• The selection is displayed on the option button. 

17 C lick on the Update DAR >>> button at the bottom of the window. 

•	 A dialog box is displayed with a field for naming the new DAR, and showing Copy of 
JDARC/O_<date> as the default name. 

18 Highlight the words Copy of in the New Name: text entry field and press the Delete key. 

• The name JDARC/O_<date> is displayed in the field. 
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19 Click on the OK button of the New Name dialog box. 

• The New Name window is removed and the parameters are saved. 

•	 Note: The new values of parameters may be observed by clicking on the Primary 
Attribute toggle icon in the DAR Summary window on the right side of the form. 

20 Click on the Spatial nested tab. 

•	 The Spatial nested tab is displayed with a map showing no designated areas of interest 
(AOIs). 

21 Click on the AOI Mode button. 

•	 Note: A button name is displayed when the cursor is moved over the button. The AOI 
Mode button is the one with the irregularly-shaped polygon icon. 

• The button is displayed in the depressed position. 

22 Move the cursor into the map area. 

• The cursor changes to the crosshairs shape when moved into the map area. 

23 Click on the View Coordinates button (just to the right of the AOI Mode button). 

• A View Coordinates dialog box is displayed with no lat/long coordinates entered. 

24	Add four points to the map by clicking on the map four times to form a small, four-sided 
polygon. 

• Four points are displayed on the map, connected with red lines. 

•	 Lat/long coordinates for the selected points are displayed in the View Coordinates box. 
Note: An AOI may be created with precise coordinates by entering the coordinates in 
the View Coordinates box instead of clicking the points on the map. 

25 Click on the Update DAR >>> button. 

•	 The changed spatial parameters are updated in the DAR Summary display area under 
the Spatial heading. 

26 Click on the Temporal nested tab 

• The Temporal nested tab is displayed. 

27	 In the XAR Lifetime: area, highlight one of the numbers in the Begin field and use the arrow 
keys or type an entry to specify a desired number; then do the same for other numbers in the 
Begin field until the desired beginning date is identified. 

•	 Note: The fields represent Month, Day, and Year. For this exercise, change the date to 
the current date plus one day. 
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• The Begin date is displayed as the current date plus one day. 

28	 In the XAR Lifetime: area, highlight one of the numbers in the End field and use the arrow 
keys or type an entry to specify a desired number; then do the same for other numbers in the 
End field until the desired ending date is identified. 

•	 Note: The fields represent Month, Day, and Year. For this exercise, change the date to 
the current date plus ten days. 

• The End date is displayed as the current date plus ten days. 

29	 Click on the Repeat Interval (Days) field and use the arrow keys or type an entry to change the 
number to the desired number of days for the repeat interval. 

• For this exercise, change the number to 2 days. 

• The numeral 2 is displayed in the Repeat Interval (Days) field. 

30 Click on the Update DAR >>> button. 

•	 The changed spatial parameters are updated in the DAR Summary display area under 
the Temporal heading. 

31	 (See important note below!) On the Create/Edit DAR tab, click on the Submit DAR >>> 
button. 

•	 Note - Important: If you are logged in with authorization to submit a DAR, for this 
training exercise you must check with the System Administrator to ensure that this 
JDAR will be sent to the local simulator unless prior coordination has been made with 
ASTER. The IP address and port are set in the EcGwDARServer.CFG file on the CSS 
primary server (e0ins01). 

•	 A confirmation dialog box is displayed with the information that "The DAR is about to 
be submitted to GDS." 

32 To confirm the DAR submit action, click on the Yes button in the warning box. 

• The confirmation dialog box is removed. 

• The ASTER reply XAR ID dialog box is displayed. 

33 Click on the OK button in the XAR ID dialog box. 

•	 The XAR ID dialog box is removed and the Java DAR Tool window is displayed as 
the active window. 

•	 The user receives email confirming that the DAR was received and containing a 
subscription ID. 
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34 To exit from the Java DAR Tool, select the Netscape window; then follow menu path 
File→Exit. 

• The Java DAR Tool windows and the browser window are removed. 

19.12.8 Modifying a DAR 

After a DAR has been submitted and prior to its fulfillment, it is possible to submit a modification 
for limited changes to the request. The modification is accomplished using the DAR Modify 
Request screen. 

There are only two modifications that are permitted. One is to specify a less restrictive 
specification of the maximum cloud cover that will be tolerated (it is not possible to specify a lower 
percentage for maximum cloud cover than submitted for the original request). The other is to 
change the status of the DAR. You may change the status of an active request from Active to 
Suspended, or change the status of a suspended request from Suspended to Active. That is, a DAR 
will not be removed from the system, but it may be suspended indefinitely if the data is no longer 
wanted, or a suspended DAR may be reactivated. Presume that the DAR you submitted for the 
Lake Tahoe area thermal infrared imagery is active, and that you wish to modify it by changing the 
maximum cloud cover percentage to 40%. Use the following procedure: 

Modify an Active DAR 

• Double click on the icon for the DAR Tool on the desktop. 

•	 The DAR Tool window is displayed, with the Project Folders field listing any DARs 
for which you have DAR IDs, including the Tahoe one you created. 

• Click on the Modify Request tab. 

•	 The Modify Request functions are displayed, with the Tahoe DAR ID displayed in 
the xAR ID: display field and the Maximum Cloud Coverage (%): option button 
showing <20%. 

• Click on the Maximum Cloud Coverage (%): option button. 

• A pop-down menu is displayed with additional percentage choices. 

• Drag the cursor to 40% and release the mouse button. 

• The Maximum Cloud Coverage (%): option button shows <40%. 

• Optional: To change the status of the DAR, click on the Suspended toggle button. 

• The Active toggle button is deselected and the Suspended toggle button is selected. 

• To activate a suspended DAR, click on the Active toggle button. 

• The Suspended toggle button is deselected and the Active toggle button is selected. 
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•	 To provide an explanation or justification for the change, click in the Requester 
Comments: field to place the cursor there, and then type the desired comments to 
explain or justify the change. 

• Click on the Submit button. 

• The DAR modification is submitted to the Ground Data System (GDS) in Japan. 

•	 After a few seconds, another window is displayed confirming receipt of the 
modification. 

• Click on the OK button in the confirmation window. 

• The confirmation window is closed. 

• Click on the Summary tab. 

• The Summary functions are displayed. 

• Follow menu path File (Exit. 

• The DAR tool is closed. 

19.13 Earth Science On-Line Directory 

The Earth Science On-Line Directory (ESOD) is a combination of HTML web pages and a number 
of Common Gateway Interface (CGI) programs that are called from the HTML web pages in order 
to communicate through the Advertising Server to Data Server and Communications subsystems 
within the ECS. The web pages provide an interface that allows users to Search for 
advertisements. General users can search for Earth Science related data and services through the 
web interfaces of the ESOD. Searches can be done in a variety of ways that include wild card text 
searches. 

ESOD permits users to query the on-line directory over the World Wide Web. Users can download 
an installable advertised service directly to their supported Unix workstations. 

NOTE:	 Special care should be taken to guard against computer viruses when 
accepting installable advertised services. 

On-site M&O is responsible for ESOD Administration to ensure that ESOD runs smoothly and that 
users can access the information they want. 
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20. Library Administration 

20.1	 Systems Operation Support Baselined (CDRL/DID) Document 
Maintenance 

20.1.1 Library Administration Overview 

The ECS Library Administration consist of several entities within the ECS project. This 
methodology was developed to utilize processes already established. Library Administration 
covers two areas, maintenance and distribution of Baselined ECS (CDRL/DID) documents, 
COTS/Custom Software and documentation, and Non-Contractual Documentation to be 
delivered the DAACs and other Government facilities. There three Web sites that these 
documents can be accessible. The ECS Data Handling System, ECS Baseline Information 
System and System Monitoring Center. 

Figure 20.1.1-1. EDHS Home Page, ECS Baseline Information, and 
System Monitoring Center 

20.1.2 Authoring Documents 

Systems Operation Support (SOS) sassing engineer will create all source material (text, graphics 
files, etc.) per CDRL/DID preparation instructions and be accountable for the accuracy of its 
content. The Document Management Organization will assist the author by providing word 
processing and graphics support such as templates and fonts. 

20.1.3 Formatting Documents 

All documents submitted to the Systems Operation Support  Book Boss by a SOS Engineer staff 
should be in Microsoft Word format which will be sent to Document Management Organization 
(DMO). The DMO numbers the document, reviews it for completeness and format accuracy. 
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20.1.4 Importing Documents 

All documents submitted to the Systems Operation Support Book Boss should be in soft copy. 
Soft copy should be sent via electronic mail as an attachment . 

20.1.5 Exporting Documents 

Requests for documents may be made by telephone, in person, or by electronic mail. 

20.1.6 Metadata Maintenance 

See Chapter 10 Metadata Administration. 

20.2 On-Site (DAAC) Baselined (CDRL/DID) Document Maintenance 

20.2.1 Authoring Documents 

The assigned engineer will create all source material (text, graphics files, etc.) per CDRL/DID 
preparation instructions & be accountable for the accuracy of its content. The DAAC's Book 
Boss will oversee the development of the documents and act as the interface between DMO and 
the DAAC's assigned engineers. 

The Document Management Organization will assist the author by providing word processing 
and graphics support such as templates and fonts. 

20.2.2 Formatting Documents 

All documents submitted to the DAAC's Book Boss should be in MS Word format which will be 
sent to Document Management Organization (DMO). The DMO numbers the document, 
reviews it for completeness and format accuracy. 

20.2.3 Importing Documents 

All documents submitted to the DAAC's Book Boss should be in soft copy and if possible in 
hard copy. Soft copy should be sent via electronic mail as an attachment and hard copy can be 
hand delivered to Systems Operation Support Library. 

20.2.4 Exporting Documents 

Requests for documents may be made by telephone, in person, or by electronic mail. 

20.2.5 Metadata Maintenance 

Science Coordinator technically interfaces with the Science Computing Facilities by updating 
Interface Control Documents (ICD). 
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20.3 Maintenance of Baselined ECS Documents in Baseline Manager 
Tool 

The Baseline Manager Tool (XRP-II) will be used to record the change history and updates to 
post current revisions to the Baselined ECS documents. This tool will also be used to provide 
the Master Index for the Systems Operation Support Library. 

20.4 Document Metadata Insertion Subscription 

The Systems Operation Support Library is the repository for all Systems Operation Support 
Maintained documents (both hard copy and electronic). COTS documentation will be physically 
located in the library in it's own section. Documentation available on CD ROM will be located 
in a separate cabinet. Documentation available on-line will be posted in the Systems Operation 
Support Library and on the Document Management Server. 

20.5 Document Repository and Maintenance 

20.5.1 Data Management Organization (DM0) 

Data Management Organization administering the project requirements for data management and 
for providing efficient and cost-effective distribution, storage, maintenance, and retrieval of these 
data. The documents and data managed by this function consist of Contract Data Requirements 
List (CDRL) items and other documents required by contract; materials that support milestone 
reviews and other presentations; technical papers and white papers; and other pertinent data such 
as contract correspondence, progress reports, and background information. 

To make documentation readily available, DMO has established a data management process 
including electronic distribution via the ECS Data Handling System (EDHS), 
(http://edhs1.gsfc.nasa.gov. ) 

20.5.1.1 Posting/Retrieval of Documents from ECS Data Handling System (EDHS) 
Server 

Baselined ECS Document will be posted in two format Word and PDF. 

20.5.2 System Monitoring Center (SMC) 

The SMC servers as the distribution point for: 

1. Staging area and distribution for ECS Custom/COTS Software deliveries. 

2.	 Medium for the distribution of non-contractual documentation to the sites. Documents such 
as  README file , COTS electronic instructions, Technical white papers, CCRs, NCR 
Workaround instructions, database scripts repository etc.… 

3.	 Maintains a copies of all Deliverables can include, but are not limited to, binaries, 
executables, Toolkit deliveries, test data, NCR workarounds, README files, general 
instructions, etc. 
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Information can be retrieved from the SMC by accessing the Website. The URL is as follows 
(http://m0mss01.ecs.nasa.gov/smc/) 

20.5.2.1 Posting/Retrieval of Documents/Software from System Monitoring Center 
(SMC) Server 

The Systems Monitoring Center Staff SMC will be responsible for the dissemination of 
information provide to the SMC. Information can be provide from a variety of sources such as 
EDF, DAACs, and others. The submitter will notify the SMC staff (via phone, pager, E-mail, or 
CC Mail) that the files are ready. The software and the supporting documentation can neither be 
pushed to the sites or pulled by the sites for installation. 

Documents will be posted in two format PDF and Word. 

20.5.3 Configuration Management and Data Management 

CM organization will serve as the central point for the dissemination of Baselined COTS 
Documentation, Technical Directives, Pre-Ship Review Documentation, Version Description 
Documents, Site Specific Build Plan etc… 

Information can be retrieved from the CM by accessing the Website. The URL is as follows 
(http://cmdm.east.hitc.com/baseline/) or (http://pete.hitc.com) 

20.5.3.1 Posting/Retrieval of Documents/Software from Configuration 
Management and Data Management Server 

Information being disseminated by this site must have been approved by the CCB. 

Documents will be posted in two format PDF and Word. 

20.6 Retrieval of HTTP Formatted Documents 

Baselined (CDRL/DID) ECS Documents can be retrieved in PDF and Word format. 

20.7 Systems Operation Support COTS Document & Software 
Maintenance 

20.7.1 COTS Library Database 

The COTS library database designed in Microsoft Access is a means of controlling and 
maintaining Commercial Off the Shelf (COTS) documentation and software residing in the 
library. Systems Operation Support personnel have access to the library database through the 
Document Management Server (DMS). The database enables Systems Operation Support 
personnel to locate and retrieve document information. By using any of the available fields in 
the database, the user has the ability to search the contents of it. The library database search 
provides the user adequate information to retrieve the most current version of a document. 
Requesting COTS documentation may also be made via the database in which the Systems 
Operation Support Librarian will receive notice as soon as the request is sent. 
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20.7.2 Document Access Control 

The Libraries database enables Systems Operation Support personnel to locate and retrieve 
document information. Only the librarian has the capability to add, edit, and delete. Systems 
Operation Support personnel will have access to this database for visualization purposes via the 
Document Management Server. 

20.7.3 COTS Library Reports 

COTS Library inventory reports are generated as requested. 

20.7.4 On-Site COTS Document & Software Maintenance 

ECS products deployed to the operational sites that has been released for operational use is 
maintained in the M&O Documentation and Software COTS Library maintained at each site 
(On-Site SW Library). Site personnel maintain partitioned libraries to facilitate access control of 
science software and other software not developed by ECS. Site personnel are responsible for 
any CM activities concerned with this library 
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21. COTS Hardware Maintenance 

In this section, discussion of commercial-off-the-shelf (COTS) hardware maintenance support 
includes COTS hardware procured for the ECS Project and some Government furnished property 
(GFP). 

The following documents are referenced in this section: 

• Property Management Plan for the ECS Project 602-CD-001-002 

• Functional and Performance Requirements Specifications, 423-41-02 

• ECS Performance Assurance Implementation Plan 501-CD-001-004 

• Environmental Control Plan for the ECS Project 532-CD-002-001 

• Maintenance and Operations Management Plan, 601-CD-001-004 

• Version 2.0 Operations Tool Manual 609-CD-003-001 

• Version 2.0 COTS Maintenance Plan for the ECS Project, 613-CD-003-001 

• Version 2.0 Integrated Support Plan for the ECS Project, 616-CD-002-001 

• Replacement Parts List and Spare Parts List 618-CD-002-001 

21.1COTS Hardware Maintenance - General 

Overall Responsibility for the management of COTS hardware maintenance rests with the ILS 
Office. Daily implementation of hardware maintenance policy is the LMC's responsibility. 
Issues regarding COTS hardware maintenance policy are to be addressed to the ILS manager 
through the ILS Maintenance Coordinator, using the contact procedures found in the last 
sentence of this section. 

COTS hardware maintenance consists of preventive and corrective maintenance. COTS 
hardware preventive maintenance is the responsibility of the contracted COTS hardware 
maintenance providers. COTS hardware corrective maintenance is the responsibility of the 
contracted COTS hardware maintenance providers, and/or the Local ILS Maintenance 
Coordinator (LMC ) using local DAAC resources. The LMC is the DAAC’s local point of 
contact for directing and coordinating corrective maintenance of ECS COTS hardware. COTS 
hardware maintenance support is available from the contracted COTS hardware maintenance 
providers according to the terms specified in each maintenance contract. Some COTS hardware 
is not covered under a maintenance contract. This equipment is supported with spares located on 
site at the DAAC, or with centralized EDF spares; or by time and materials contract support. 
Generally, this spare equipment consists of Monitors, Keyboards, Mice, and a variety of boards. 
To facilitate easy tracking of maintenance spares at each DAAC, the following method of 
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identification will be used: in ILM, the ECSNAM for the spares will be the site name with 
“MAINT” added to the end [EDCMAINT, NSIDCMAINT, etc.]. The LMC ensures that 
requirements of this section are complied with by all COTS hardware maintenance providers and 
that accurate and timely information from the DAAC is entered in the Inventory-Logistics-
Maintenance (ILM) System. Instructions on the use of ILM are in chapter 27 of this manual. 
The integrated logistics support (ILS) Maintenance Coordinator is a staff position in the ILS 
office, which is under the Maintenance and Operations (M&O) manager’s area of responsibility. 
The ILS Maintenance Coordinator is available during East Coast normal work hours to provide 
assistance and guidance to the LMC in obtaining COTS hardware maintenance when normal 
efforts have been unsatisfactory. The ILS Maintenance Coordinator may be reached via the 
Internet, telephone, or FAX with the Internet being the preferred method. The Internet address is 
ilsmaint@eos.hitc.com; the telephone number is 1-800-ECS-DATA, select option #3 then dial 
0727 or 4180. The FAX number is 1-301-925-0741. 

21.1.1 Corrective Maintenance 

Corrective maintenance is the unscheduled repair of equipment, to include fault detection, 
diagnosis, isolation, and resolution through line replaceable unit (LRU) repair or replacement. 
The maintenance of hardware items may be performed on site by the LMC or the contracted 
maintenance provider, or by returning the failed component to the maintenance depot for repair 
or replacement. COTS hardware corrective maintenance will be documented using procedures 
in this section and Section 8.1, Problem Management; Section 9, Configuration Management 
Procedures and the safety requirements of Section 21.1.4 

21.1.2 Preventive Maintenance 

EMASS and Storage Technology automated tape library robots are currently the only hardware 
requiring scheduled preventive maintenance. Preventive maintenance is performed by the 
original equipment manufacturer (OEM) on this equipment. OEMs are expected to coordinate 
preventive maintenance visits to the DAAC with the LMC. LMCs will record on the 
maintenance work orders (MWO) any downtime experienced as a result of preventive 
maintenance. 

21.1.3 Configuration Management 

Configuration Management (CM) requirements are addressed in Section 9 of this document. The 
LMC ensures compliance with the CM requirements resulting from a hardware maintenance 
action. 

21.1.4 COTS Hardware Maintenance Safety 

Hardware maintenance will be accomplished in a manner that ensures personnel and equipment 
are protected from harm. Guidance for establishment of safety practices, standards, and 
procedures is found in Section 6 of the ECS Performance Assurance Implementation Plan 
(PAIP), 501-CD-001-004. The LMC will ensure that these safety procedures, as well as 
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applicable local safety requirements, are known and observed by local site support personnel or 
COTS hardware maintenance providers during COTS hardware maintenance. 

COTS hardware safety practices include electrostatic discharge (ESD) protection. The ESD 
program will be locally developed by the LMC using the ECS Environmental Control Plan, 532-
CD-002-001 and applicable DAAC procedures for guidance. When not being worked on or 
when outside protected areas, electronic parts and assemblies are to be covered by ESD 
protective covering or packaging. During installation or removal of electronic parts or LRUs, a 
common ground will be established between the technician, work area, the part, and the 
equipment it is to be installed in/removed from. It is the responsibility of the LMC to ensure 
compliance with these safety procedures by the hardware maintenance provider and site 
personnel. 

21.2COTS Hardware Maintenance - Contract Information 

The ECS procurement organization is located at the ECS development facility (EDF) and is 
responsible for contracting for COTS hardware maintenance. Cost and support considerations 
may result in COTS HW maintenance being provided by a third party provider. Questions or 
comments concerning COTS hardware maintenance are to be directed to the ILS Maintenance 
Coordinator, who can be contacted using contact information contained in Section 21.1, COTS 
Hardware Maintenance - General. 

21.2.1 COTS Hardware Maintenance Contract Database 

Information related to COTS hardware maintenance contracts is contained in a database at the 
ILS Office and is used to manage maintenance contracts. The LMC can obtain extracts of 
maintenance contract information via the Internet on the ILS web page at 
http://dmserver.gsfc.nasa.gov/ils/intro.htm. Information fields in the ILS web page are updated 
periodically by the ILS Maintenance Coordinator. 

Generally, COTS hardware maintenance providers require an access, or site, code and/or the 
serial number of the host equipment to verify that the failed item is covered under a maintenance 
contract. For example, if maintenance were requested for a terminal/monitor or disk drive, the 
serial number of the parent workstation or server would need to be provided to the maintenance 
provider. The serial number may also be the access code for that provider. The information 
needed by the various COTS HW maintenance providers to verify that maintenance is authorized 
is specified on the ILS web page. DAAC site-specific site access numbers/site codes/contract 
numbers, if required, are also listed on the ILS web page. For some COTS HW maintenance 
providers, names of authorized contact persons are required. The number of authorized contact 
persons varies with the different maintenance providers. The ILS Maintenance Coordinator, in 
coordination with the LMC, arranges with the COTS HW maintenance provider for specified 
personnel to become an authorized contact person. It is the responsibility of the LMC to provide 
to the ILS Maintenance Coordinator the name changes to the authorized contact list as soon as 
known. The LMC will identify changes as a permanent or temporary change and, if temporary, 
the inclusive dates of the change. A temporary change may occur when the authorized contact 
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person is ill, on vacation, in training, or other short-term change of work availability status has 
occurred or is expected to occur. 

21.3Hardware Repairs - Standard 

Users/operators of ECS hardware should report hardware/system problems to the site’s LMC for 
resolution. Users, operators, and support personnel who encounter a HW problem will report the 
problem according to Section 8: Problem Management. LMCs will create the MWO in ILM 
using procedures contained in Chapter 27. The LMC will provide timely feedback to the 
user/operator on the resolution of the problem The maintenance role of the LMC includes: the 
following: 

(1) receiving notification of HW problems, 

(2) opening and closing the MWO, 

(3) dispatching the appropriate repair person [system administrator (SA), network administrator 
(NA), or vendor repair technician]. 

(4) updating MWO with repair efforts in a timely manner as soon as possible following 
resolution the problem. 

(5) capturing, recording and reporting problems and solutions for future reference - including 
part numbers, serial numbers, location, and EIN number. 

The ILS Maintenance Coordinator: is responsible for: 

(1) tracking MWO status, 

(2) reviewing MWO and repair actions for appropriateness and completeness


(3) requesting missing MWO information from LMC


(4) updating ILM based on property record actions from the MWO.


(5) identifying support problem areas. 

21.3.1 Hardware Problem Reporting 

Once a failure occurs, the operator, SA and/or NA will isolate the problem to its source (i.e., 
Operating System, COTS application software, ECS custom software, science software, network, 
or COTS hardware) using the actions in Table 21.3-1, DAAC Hardware Problem Reporting 
Procedures. 
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Table 21.3-1. DAAC Hardware Problem Reporting Procedures 
Step Occurrence Action 

1 System 
problem 
discovered by 
an SA, NA, or 
operator, 

a. Review error message against the applicable hardware operator 
manual. 

b. Verify that power, network, and interface cables are connected 
and functioning properly. 

c. Run internal systems and/or network diagnostics. 
d. Review system logs for evidence of previously related problems or 

configuration changes that may be contributing to the problem. 
e. Attempt to reboot the system 
f. If the problem is fixed, complete a Remedy Trouble Ticket using 

Section 8 procedures. 
g. If the problem is not fixed, and is determined to be hardware 

related, either prepare an MWO or notify the LMC. The LMC will 
prepare an MWO with status code “O” for open and either notifies 
the maintenance contractor or replaces the failed component with 
on-site spare (if available). 

21.3.2 Hardware Corrective Maintenance Actions 

Hardware problems are forwarded to the LMC. The LMC will attempt to identify the cause of 
the problem and employ DAAC resources to resolve the problem. If unable to correct the 
problem using DAAC resources, the LMC arranges for on-site maintenance by the appropriate 
maintenance provider in accordance with Section 21.3.4, Contract On-Site Hardware 
Maintenance 

Table 21.3-2. Hardware Corrective Maintenance Actions (1 of 2) 
Step Occurrence Action 

1 COTS HW 
problem not 
resolved by 
initial 
troubleshooting 
by operator, SA 
or NA. 

a. LMC contacted or notified via MWO or by operator, SA or NA 
b. LMC opens MWO and adds any cross-reference information for 

related open Remedy Trouble Ticket (if existing) 

2 LMC attempts 
to identify 
cause of 
problem. 

a. Reviews the MWO (if operator, SA or NA initiated one). 
b. Verifies actions and results to date by contacting SA and/or NA. 
c. Performs initial troubleshooting, including that described in the 

equipment manuals. 
d. Records result in the MWO. 
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Table 21.3-2. Hardware Corrective Maintenance Actions (2 of 2) 
Step Occurrence Action 

3 Problem 
resolved by 
LMC or local 
staff. 

a. If problem can be resolved without hardware replacement (e.g. re­
seat component, cable, etc): 
1) Correct problem, and verify resolution. 
2) Record actions taken and enter status code “A” in the MWO. 

b. If problem can be resolved by replacement of failed LRU with 
maintenance spare: 

1) Replace failed LRU and record following in MWO: 
a) Part number, serial number, and model/version number of 

replaced LRU 
b) Part number, serial number, and model/version number of 

new LRU 
c) Down time (elapsed hours/minutes) 
d) Delay time identified by reason 

2) CM requirements are accomplished following procedures in 
Section 9. 

3) Order replacement of failed LRU in accordance with Section 
21.4.1. 

4) Route failed LRU in accordance with Section 21.4.2. 
5) LMC records actions taken to resolve the problem in the MWO 
6) LMC forwards completed MWO by recording status code “A” 

4 Problem not 
resolved by 
LMC or local 
staff. 

a. LMC notifies the maintenance contractor using the information 
from the ILS web page, providing the telephone number of the 
vendor and access code needed to obtain support or 

b. LMC invokes return-to-depot support where appropriate, 
c. LMC request authorization from ILS Maintenance Coordinator for 

use of Time and Materials support if that is needed. 
d. LMC will record all the information in the MWO, to include: make, 

model, serial number, description of problem, and repair priority of 
the problem. 

21.3.3 Contract On-Site Hardware Maintenance 

When on-site hardware maintenance support is necessary, the LMC will notify the applicable 
maintenance contractor and request assistance. The call for support will be documented in the 
MWO by the LMC, noting the date and time the contractor was called. It is important that all 
vendor maintenance activities start and stop times associated with the activities are recorded in 
the MWO. This is the only means of measuring, and managing the maintenance vendor’s 
contractual performance in support of the ECS system availability goals. Data fields have been 
specifically created in the MWO to capture this information. Refer to Table 21.3.4-1 for more 
information about obtaining on-site COTS hardware maintenance support. 
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Table 21.3.4-1. Obtaining On-Site Hardware Maintenance Support (1 of 3) 
Step Occurrence Action 

1 Local support 
effort did not 
resolve the 
problem. 

a. LMC gathers information needed to obtain contract maintenance support 
and records it in the MWO. 
1) Make, model, serial number, and location of failed systems. 
2) Description of problem and symptoms. 
3) Criticality of the COTS hardware experiencing the problem. 

b. Using information from the ILS web page the LMC determines: 
1) Name of maintenance provider 
2) Telephone number of the maintenance provider’s technical support 

center 
3) Access code needed to obtain support. 
4) Site authorized contact person(s). 

2 LMC calls the 
appropriate 
support 
provider’s 
technical support 
center for 
maintenance. 

a. Provides information from Step 1a above to the maintenance provider to 
establish a need for on-site support. 

b. Obtains a case reference number from the COTS hardware maintenance 
provider 

c. Informs the providers technician to supply a copy of dispatch trouble ticket 
with company name, date/time of arrival and departure, PN and SN of all 
equipment removed and or installed, and a narrative of problem and action 
taken, or 

d. Updates the MWO to reflect date/time of the call, all actions, and case 
reference 

3 LMC actions a. Jointly determine between maintenance contractor and site operations 
staff an acceptable time to bring the equipment down for maintenance 
[only applicable when entire device is down. Coordination to schedule 
down time is only required for a functional, but impaired, device] 
1) Obtain tentative time from operations, then obtain concurrence from 

appropriate maintenance contractor. 
2) Obtain information from the maintenance vendor such as availability 

window of technician and actions needing to be accomplished prior to 
the technicians arrival. 

3) Repeat process until an agreed upon maintenance time is obtained. 
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Table 21.3.4-1. Obtaining On-Site Hardware Maintenance Support (2 of 3) 
Step Occurrence Action 

4 Maintenance 
technician arrives 
at the site. 

a. LMC arranges for site access using local established procedures. 
b. Records arrival time in MWO.LMC request for a copy of dispatch trouble 

ticket with company name, date/time of arrival and departure, part number 
& serial number of all equipment removed and or installed and narrative of 
problem and action taken. 

c. If required, LMC requests System Administrator site Help Desk, or other 
appropriate and authorized personnel to shut down the machine at the 
predetermined time so that corrective action(s) can begin. Note that any 
user affected by this action must be notified prior to the machine/system 
shutting down. 

d. LMC escorts maintenance technician to the hardware 
e. Ensures maintenance provider's technician places LRU's on an anti-static 

mat when working on them. 
f. Ensures the maintenance provider technician places anti-static strap on 

wrist and connect to a common ground when handling LRU's that can be 
adversely effected by an electrical charge 

g. LMC assists the maintenance technician in resolving the problem. This 
includes: 
1) Arranging for a demonstration of the problem (if possible) 
2) Arranging for the equipment to be shut down. 
3) Obtaining site available technical references, when needed 

4a Maintenance 
technician 
corrects the 
problem by 
replacement of 
parts. 

a. If a part is replaced, the LMC accomplishes the following: 
1) Obtains from the failed part or the maintenance technician: 

a) serial number, equipment identification number (the EIN number 
on the silver label), and model/version 

2)  Obtains from the new part: 
a) part number, serial number, and manufacturer’s model number (if 

different from part removed, a configuration change request [CCR] 
is required) 

3) Updates the MWO with following information: 
a) actions taken to correct the problem. 
b) part number, serial number, and model/version, and EIN (if 

applicable) of the old and new item 
c) name of the item replaced 
d) arrival date and time 
e) time and date corrective action started 
f) time and date corrective action completed 
g) any delay time experienced in completing the corrective action and 

reason for delay time to repair 
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Table 21.3.4-1. Obtaining On-Site Hardware Maintenance Support (3 of 3) 
Step Occurrence Action 

4b Maintenance 
technician 
corrects the 
problem without 
replacement of 
parts 

a. If no parts were replaced, the LMC updates the MWO with: 
1) Actions taken to correct the problem. 
2) Time and date technician arrived 
3) Time and date repair was started and completed [these times are 

required to determine RMA data]. 

4c LMC requests the 
SA to make the 
system functional 

a. Sysadmin to restores data, operating system, patches or other SW 
items to render the system functional. 

b. Annotates in the MWO that the sysadmin has been notified to restore 
data. 

c. Sysadmin notifies LMC upon completion of the requirement 

4d Maintenance 
technician does 
not resolve the 
problem 

a.  LMC request the Maintenance vendor provide additional technical and 
or managerial resource to resolve the problem after repair efforts have 
been underway for 24 hours without resolution 

b. LMC notifies ILS Maintenance Coordinator that problem repair effort as 
been delayed, and escalated. 

c. LMC documents all escalation activity in the MWO until further action is 
taken. 

4e LMC ensures a. Receipt of a completed copy of the dispatch trouble ticket from the 
vendor 

b. The information from the vendor's ticket is consistent with the 
information in the MWO 

5 LMC a. Update the MWO with the following information: 
1) When the call was made, and to which support provider. 
2) Date and time technician made initial contact. 
3) Date and time technician arrives. 
4) ALDT reason and duration. 
5) When repair is complete and support technician leaves. 
6) Hours chargeable to hard down time and soft down time. 

6 LMC reports 
actions taken 

a. Obtains the authorization of the operation supervisor to make the 
change. 

b. Ensures the Configuration Control Board is properly notified of the 
configuration alterations and requests a formal change using 
procedures in Section 8. 

7 LMC forwards a. A completed MWO to the ILS Maintenance Coordinator via nightly 
updates to the SMC by changing status code on MWO to "A". 

b. A copy of MWO and the vendor’s dispatch trouble ticket. 

8 LMC files a. A copy of vendors dispatch sheets, and related documents in a 
permanent file and references the MWO or files them with copy of the 
MWO. 

9 LMC verifies a. Property changes resulting form the MWO are recorded in subsequent 
updates to the property inventory report. 
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21.3.4 Return-to-Depot Support 

In some cases the OEM does not provide on-site maintenance. [Refer to the ILS web page for 
details.] Instead, return-to-depot maintenance support is provided whereby an advance 
replacement LRU is requested from the vendor by the LMC prior to returning the failed repair. 
If advance replacement is not provided, then the LMC must return the failed item to the 
appropriate repair center using procedures contained in Section 21.4-2. 

Table 21.3.5-1. Procedures for Obtaining Return to Depot Service 
Step Occurrence Action 

1 LMC contacts a. The appropriate hardware maintenance provider, using 
information from the ILS WEB page (reference Section 21.2.1 
COTS Hardware Maintenance Contract Database 

2 LMC requests a. Advance replacement LRU form the appropriate hardware 
maintenance provider with shipping instructions prior to returning 
the failed unit. 

3 LMC annotates a. The expected delivery time, RMA#, carrier information, and the 
PN, SN, EIN, and suspected problem of the failed item 

b. Add/move items into MWO as they become available. 
4 LMC receives a. New LRU with RMA authorization. 

5 LMC packs a. The failed LRU using the carton containing the new item following 
b. The instructions received with the advance replacement part. 

6 LMC removes a. The NASA Property Sticker (silver in color, also called EIN Tag 
Number) prior to packing the item for shipment. The sticker will be 
attached to the work order paperwork, and forwarded to the ILS 
Property Manager for accountability in ILM. 

7 LMC applies a. Address label furnished with the advance replacement to the 
carton. 

8 LMC enters a. In the MWO, the RMA number from the carton containing the part 
to be returned 

9. LMC packs a. The box with failed item and provides a brief description of the 
problem. 

10 LMC annotates a. In the MWO the RMA#, date shipped to vendor, and expected 
receipt or return of item; as well as a description of the problem 

b. .In the MWO the updated inventory changes to the hardware 
following receipt and reinstallation of the repaired unit. 

11 LMC forwards a. The MWO to the ILS MC by entering status code “A” on the 
MWO. 
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Table 21.3.5-2. Procedure for Equipment Advance Replacement (1 of 2) 
Type 1: Swap [Original LRU not returned following repair] 

Step Occurrence Action 

1 LMC requests a. The appropriate hardware maintenance provider, using 
information from the ILS WEB page (reference Section 21.2.1 
COTS Hardware Maintenance Contract Database), to provide 
advance replacement if on-site support is not contracted. 

2 LMC assures a. MWO is annotated with failed items PN, SN, EIN, and actions as 
they become available. 

3 LMC obtains a. RMA number and shipping instructions from the repair vendor. 

4 LMC receives a. New advance replacement with RMA authorization. 

5 LMC attaches a. New EIN sticker on replacement LRU, and creates new item in 
ILM. 

6 LMC installs a. Advance replacement LRU 

7 LMC packs a. The failed LRU using the carton containing the new item following 
instructions received with the advance replacement part. 

b. Remove the NASA Property sticker (also called EIN Tag number, 
and silver in color) prior to packing the item for shipment. 

8 LMC attaches a. Removed EIN sticker to MWO so LRU can be properly archived. 

9 LMC applies a. Address label furnished with advance replacement to the carton. 

10 LMC enters a. RMA number to the carton containing the part to be returned (if 
not already entered on the address label). 

11 LMC logs a. Updated information in the MWO (cite RMA#, return address, 
date shipped to vendor). 

12 LMC packs a. The box(es) of the failed items, and includes a brief description of 
the problem. 

13 LMC updates a. The MWO status to “A” for Audit with the new information. 

14 LMC forwards a. The MWO, with the updated inventory hardware changes to the 
SMC. 
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Table 21.3.5-2. Procedure for Equipment Advance Replacement (2 of 2) 
Type 2: Loaner [Original LRU repaired and returned] 

Step Occurrence Action 

1 LMC requests a. The appropriate hardware maintenance provider, using 
information from the ILS WEB page (reference Section 21.2.1 
COTS Hardware Maintenance Contract Database), to provide 
advance replacement if on-site support is not contracted. 

2 LMC assures a. MWO is annotated with failed items PN, SN, EIN, and actions as 
they become available. 

3 LMC obtains a. RMA number and shipping instructions from the repair vendor. 

4 LMC receives a. New advance replacement with RMA authorization. 

5 LMC installs a. Advance replacement / Loaner LRU. Note: This LRU is NOT 
government property, it is only a loaner. Do NOT place an EIN 
sticker on this loaner. 

6 LMC packs a. The failed LRU using the carton containing the new item following 
instructions received with the advance replacement part. 
Remove the NASA Property sticker (also called EIN Tag number, 
and silver in color) prior to packing the item for shipment 

7 LMC attaches a. Removed EIN sticker to MWO so LRU can be properly archived. 
Note: Even though this LRU will be returned when fixed, the EIN 
will be removed. Following return a new EIN will be attached to 
the device, and in the note section of ILM annotate both old and 
new EIN for historical reference. 

8 LMC applies a. Address label furnished with advance replacement to the carton. 

9 LMC enters a. RMA number to the carton containing the part to be returned (if 
not already entered on the address label). 

10 LMC logs a. Updated information in the MWO (cite RMA#, return address date 
ship to vendor). 

11 LMC packs a. The boxes of the failed items and includes a brief description of 
the problem 

12 LMC updates a. The MWO status to “A” for Audit with the new information. 

13 LMC forwards a. The MWO with the updated inventory hardware changes to the 
SMC. 

14 LMC receives a. The repaired LRU back from the vendor. A new EIN will be 
attached, and annotated into ILM. 

15 LMC reinstalls a. Original LRU, and removes loaner unit for return to vendor 
following procedures 8-13 above for shipment of loaner 

21.4 Maintenance Spares 

The maintenance contractor performing the maintenance normally provides replacement LRUs. 
However replacement LRUs will typically be obtained from within the metropolitan area where 
the DAAC is located, and will seldom be stocked on the DAAC site. The ECS ILS Office may 
procure selected maintenance spares to provide a more rapid return to service for failed critical 
units and to guarantee their availability. These spares are to be used as a last resort and must be 
replaced quickly. The use of a spare in order to keep a system operational does NOT remove 
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responsibility for having the original LRU repaired. The ECS ILS Office will also procure 
selected spares for hardware items that do not have contracted on-site maintenance. Project 
spares may be centrally stocked at the EDF, stored on-site in the DAAC property room, or reside 
as installed spares in equipment. 

Maintenance spares are procured and replenished by the ECS ILS Office using the process 
identified in Paragraphs 4.6.3 and 4.6.4 of Release B COTS Maintenance Plan, document 613-
CD-003-001; and Section 23, Property Administration of the 611 document. Spares allocated to 
the DAACS will be managed at the DAAC by the LMC using guidance from the above 
referenced documents and appropriate local DAAC policies and procedures. 

21.4.1 Use of Maintenance Spares 

The LMC will control the use of on-site maintenance spares. Centrally stocked spares can be 
requested from the ILS Maintenance Coordinator using procedures in Section 21.1. Installation 
of maintenance spares is performed by the LMC (if qualified) or the COTS hardware 
maintenance contractor under oversight of the LMC, who ensures procedures in Section 21.3 are 
followed. 

Table 21.4.1-1. Centrally Stocked Spares 
Step Occurrence Action 

1 LMC opens a. An MWO to request a spare with a reason and description of the 
problem. 

2 LMC enters a. An “O” as OPEN in the MWO 

3 LMC sends a. An email to ILS MC 

4 LMC receives a. An email from the ILS MC authorizing the shipment of the spare from 
the the ILS PA 

b. The spare from the ILS PA, and ships the failed LRU to the ILS PA or 
the repair vendor as described by the ILS PA or ILS MC. 

5 LMC ensures a. Individuals installing and deinstalling the spare adhere to the 
Electrostatic standards by standing on an anti-static mat with anti-static 
wrist connection with a common ground 

6 LMC prepares a. The shipping label on the carton, clearly displaying the RMA# if 
required. NOTE the shipping address may differ from the maintenance 
contractor’s main address 

7 LMC updates a. MWO with repair information, such as start, end, and delay time, PN, 
and SN of removed/installed items. 

8 LMC ensures a. System is returned to operational status, and notes time. System admin 
restores data, operating system, patches or other SW items to render the 
system functional. 

9 LMC receives a. The original, and now repaired, spare from the ILS PA or vendor. 

10 LMC returns a. Loaned spare to ILS PA. 

11 LMC updates a. The MWO, to include spare location, with the EIN and replacement 
component information such as start, end and delay time, part number 
and serial number of item removed/installed and forwards the MWO by 
entering status code “A”. 
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21.4.2 Return of Failed LRUs 

The LMC is responsible for the return of failed LRUs to maintenance contractors providing 
advanced replacement depot maintenance support (e.g., systems under return-to-depot support). 
In such agreements the maintenance provider sends to the site a replacement for a failed 
component under the condition that the site will return the failed component within a reasonable 
time, usually not greater than 10 days. If the failed component is not returned the contract is 
charged the full purchase price for the item not returned. Refer to Table 21.3.5-2. for return 
instructions. 

21.5Non-standard Hardware Support 

Non-standard COTS hardware support consists of: 

a) maintenance support outside the PPM (Principal Period of Maintenance), 

b) support covered under a Time and Materials contract, or 

c) escalated support actions by the maintenance support provider. 

Table 21.5-1. Procedure for Time and Material Support 
Step Occurrence Action 

1 LMC contacts a. The ILS MC and requests Time and Material support. 

2 ILS MC 
determines 

a. If the problem is critical enough to justify Time and Material 
Support, and then gives the LMC verbal and written approval to 
use Time and Material support. Not that approval may contain a 
dollar limit, time limit, and/or approval reference number 

3. LMC contacts a. The appropriate vendor for Time and Material support (refer to 
the ILS web page) 

4 LMC monitors a. Time and Material support costs and time for repair, then faxes or 
emails the information on the service calls to the ILS MC. 

5 ILS MC creates a. Quarterly reports of Time and Material support including funding 
used. 

6 ILS briefs a. The CCB on the T&M funds status [done quarterly]. 

21.5.1 Escalation of COTS Hardware Support Problem 

Hardware support providers have escalation policies. These escalation policies direct increased 
management attention and/or resources to a problem, based on elapsed time from start of the 
corrective effort. The LMC may also request a support provider escalation any time the 
corrective effort is not progressing satisfactorily, by calling the maintenance contractor’s 
technical support center and providing the case number generated when the problem was first 
reported. The LMC may request assistance from the ILS Maintenance Coordinator in obtaining 
a satisfactory resolution by using procedures in paragraph 21.1. 
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21.5.2 Low Cost Equipment – Not Repaired 

Wyse terminals, keyboards, and mice are low cost items that are not repaired, because the repair 
costs would exceed the cost of a new item, but are replaced on a one-to-one basis from either the 
manufacturer or the ILS Office. Items when supported by a maintenance vendor are replaced as 
part of the contract. The ILS Office through spare replenishment will replace those items not 
covered under maintenance contract. Maintenance spares, because they are Government 
property, will not be disposed of without the direction of the Government. LMCs will request 
disposition instructions for these items from the ILS Office. They will not be discarded without 
specific direction from the ILS Office. The disposition request will be made by the LMC 
following procedures in Section 23 and Property Management Plan for the ECS Project , 
document 194-602-OPI-001. 
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22. COTS Software Maintenance 

Software maintenance procedures are current to Drop 5B functionality. 

22.1 Introduction 

The ECS organization provides maintenance and operations for ECS, software, and firmware 
systems delivered under the ECS contract to the ECS sites. The functions performed by each of 
the M&O organizations are described in the M&O Management Plan, CDRL 601-CD-001-001. 
M&O tasks for COTS software support are described in Section 22.1, based on 613-CD-003­
001, “Release B COTS Maintenance Plan for the ECS Project” and 194-602-OP1-001, “Property 
Management Plan for the ECS Project.” 

In general, ECS organizations procure, produce, deliver, and document the modifications, and 
enhancements made to ECS software and firmware. No custom firmware has been identified as 
part of the ECS program. Commercial off-the-shelf software (COTS SW), firmware, and 
hardware will be maintained in accordance with the COTS Maintenance Plan, CDRL 613-CD­
001-001. The Project maintenance philosophy for software is to provide ECS centralized 
support for developed items and vendor support for COTS SW. 

Specific software support procedures are discussed in this section. ECS Project software consists 
of COTS, custom-developed, and science software. Science software, developed for use on the 
ECS project, is the responsibility of the science community (see Section 22.1.3 

COTS software maintenance includes: 

•	 License to use COTS support contract with the software vendor for; telephone assistance 
in resolving COTS SW problems, as well as obtaining patches and upgrades. 

•	 Services required to produce, deliver, integrate, install, validate and document 
modifications of existing ECS software and firmware. [The DAAC maintenance activity 
includes: software configuration management (CM) including support for change control, 
configuration status accounting, audit activities, and software quality assurance (QA). 
Each site is the CM authority over its own resources subject to EOSDIS delegation of 
roles for ECS management.] 

The site’s LMC, System Administrator (SA) and Network Administrator (NA) will be advised 
by the ILS Maintenance Coordinator and COTS Software License Administrator on the 
procedures for handling COTS software upgrades and vendor liaison. 

The ECS System Support Office (SSO) provides assistance when COTS software issues exceed 
the capabilities of the site System Administrator or the Network Administrator to resolve. 

22.1.1 COTS Software Maintenance 

Operations personnel at the sites accomplish installation of patches, upgrades and software 
problem isolation. The COTS software vendors support COTS software procured for the ECS 
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contract. (The term software vendor refers to the company having the legal right to authorize 
software use and to modify the software code.) COTS software vendor support consists of 
telephone support for resolution of usage and interface problems, access to an on-line solution 
database, providing upgrades and patches and resolving COTS software code problems. 

The Activity Outline in Table 22.1-1 is an overview of COTS Software Support procedures and 
the section number where details for performing the tasks can be found. . 

Table 22.1-1. COTS Maintenance - Activity Outline 
Task Section 

Assist System Administrator in obtaining COTS 
SW support 

22 

Manage COTS Software Maintenance 
Contracts 

22.1.3 

Manage Software Licenses 22.1.4 

Interface with CCB 
(SW License Admin. may go before CCB 
whenever there is an upgrade in current 
software version, new patches, or a need to 
purchase additional software licenses in order to 
satisfy project requirements. SW License 
Admin. Should be informed and involved in any 
overall change to the baseline.) 

22.1.4-22.1.5 

Obtain COTS Software Support 22.1.6 

22.1.2 Management of COTS Software Maintenance Contracts 

The ECS procurement office at the EDF contracts COTS software vendor support. After the first 
year of warranty support, support is contracted for a period of one or more years and extended or 
modified as operationally required. Information related to COTS software support contracts is 
maintained in a database used by the COTS Software License Administrator to monitor the 
expiration dates and contract terms. 

For drop 5A, the COTS SW License Administrator will track software licenses via the Inventory 
database. As a COTS SW vendor support requirement nears its expiration date, the COTS SW 
License Administrator determines through consultation with the responsible organization, the 
need for continued COTS software support. The SW License Administrator will issue a CCR to 
the CCB organization. When the CCR is approved the SW License Administrator will 
coordinate with the ECS procurement office for extension/modification of the support contract. 
Requested changes to COTS SW support contracts should be provided by the site System 
Administrator to the COTS SW License Administrator. The COTS SW License Administrator 
may be contacted by email at rcastle@eos.hitc.com or by dialing 1-800-ECS-DATA, Option #3, 
then dial extension 0726. 
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22.1.3  Management of COTS Software Licenses 

Functions of the COTS SW License Administrator include the following: 

a . 	 Maintain accountability for all COTS SW licenses procured for the ECS contract. 
Accountability includes tracking and reporting the as-installed location of all licenses 
procured. This information is generated from the findings of the software physical 
configuration audit. Once the software configuration audit has been performed, the 
software licenses will be tracked by monitoring the status of COTS SW CCRs as they are 
implemented and through configuration data maintained in Inventory Database. 

b.	 Assist the SSO organization with the help of the SE/EDS organization in impact analysis 
of proposed COTS SW upgrades and patches on other COTS SW applications 
incorporated in the ECS system design. Maintain a database containing license keys of 
project-purchased COTS SW. The COTS SW installation team (or site) will provide the 
host identifications to the COTS SW License Administrator, who will then obtain the 
necessary license keys from vendors for SW installation and populating the COTS SW 
database. 

c. The SSO organization will distribute SW upgrades, with vendor-provided release notes. 

d . 	 Keep SSO and all other ECS sites informed by providing them with the vendor 
maintenance necessary to access vendor patch libraries for use in resolution of software 
problems. COTS software licenses vary by the type of software and the software vendors’ 
policies. 

COTS software license types include: floating, per site, specific number of concurrent users, 
unlimited users, and lifetime use without regard to number of users or location. The quantity and 
type of COTS software licenses initially required are identified to the ECS procurement office by 
ECS design engineers. COTS software licenses are received and entered into the Inventory 
Database by the ILS Property Administrator. The ILS Property Administrator maintains the 
master copy of COTS SW license agreements (hardcopy). The COTS Software License 
Administrator will update the COTS software license database. 

22.1.4 COTS Software Installation and Upgrades 

The COTS software upgrades are subject to appropriate CCB approval before they may be 
loaded on any platform. The COTS Software Librarian, using procedures contained in Section 9, 
“Configuration Management,” notifies the SSO organization of the upgrades that have been 
received. The SSO distributes the COTS software upgrades as directed by the CCB. The site 
System Administrators are responsible for upgrading the software on the host machine and 
providing follow-up information to the Configuration Management Administrator (CMA), COTS 
Software Librarian and the COTS SW License Administrator. The site LMC will notify the 
appropriate personnel when the COTS software is received. 

COTS software patches may be provided by the COTS software vendor in response to a 
DAAC’s call requesting assistance in resolving a COTS software problem. The problem may or 
may not exist at other locations. When a COTS software patch is received directly from a COTS 
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software vendor (this includes downloading the patch from an on-line source), the DAAC’s CCB 
shall be informed via CCR prepared by the appropriate site personnel. It is the responsibility of 
the appropriate site personnel to notify the CCB of the patch’s receipt, purpose, and installation 
status, using procedures contained in Section 9, “Configuration Management,” and to comply 
with the CCB decisions. The appropriate site personnel will install the COTS SW patches as 
directed by the CCB. In addition to providing patches to resolve problems at a particular site, the 
software vendor will periodically provide upgrades of COTS software in order to improve the 
product. These upgrades are issued to all licenses covered by a software maintenance contract. 
Therefore, the COTS software upgrades will be shipped to the ILS PA who receives and enters 
them into inventory and then forwards the media to the COTS Software Librarian and the 
licenses/keys to the COTS Software License Administrator. The COTS Software License 
Administrator coordinates with the appropriate DAAC personnel the installed location, which 
includes the host name, host id and EIN number of the system. COTS SW License 
Administrator will update the software license database. When there is a desire to upgrade to a 
more current version of the software, a CCR must be submitted by the responsible Organization 
for approval by the appropriate CCB. Once the upgrade is approved and installed, the DAAC 
personnel will notify the COTS software license administrator of the configuration change. The 
COTS software license administrator will notify the ILS PA to update the ECS records and will 
update the software license database. The Configuration Management records will be updated 
per the as-installed status of Engineering Change Order attached with each CCR. 

22.1.5 Obtaining COTS Software Support 

COTS SW support involves both site capability and contracted support. The site System 
Administrator (SA), Network Administrator (NA), and site Software Maintenance Engineer 
provides site capability. The COTS SW vendor provides contracted support. When the 
appropriate site personnel confirms that a problem is attributed to the COTS SW, the COTS SW 
vendor’s technical support center is contacted by authorized personnel at the site. 

The software vendor’s technical support center will verify contract support authorization and 
then assist in pinpointing the COTS SW problem to provide a recommended solution. The 
solution may comprise of a patch, work-around, or include the fix in a future release. If a patch 
exists to correct the problem, the patch will be identified and provided by the software vendor 
over the Internet or mailed to the requester. If a patch is required but unavailable, the site and 
vendor together determine the seriousness of the problem. In cases where the problem is critical, 
a temporary patch or work-around may be provided. If non-critical, the solution to the software 
problem may be scheduled by the software vendor to be incorporated in a future update or 
release. (NB: The DAAC and ESDIS CCBs must authorize the patch to be installed as a 
permanent installation. This decision may be made after-the-fact. That is, if the patch is needed 
in order to proceed with operations, notify the appropriate DAAC personnel of the requirement 
in accordance with Section 9, “Configuration Management.” Applicable requirements of Section 
8.1, “Trouble Ticket System Procedures,” must be followed.) LMC at each site will receive the 
software and log it appropriately in the Software Inventory. 

The COTS Software License Administrator obtains the support authorization codes from the 
vendors and arranges for specified personnel to become an authorized contact person, based 
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upon the limitations imposed by the vendor, and the needs of individual DAACs. The software 
vendor’s technical support telephone numbers, the names of personnel authorized to contact the 
vendor, and the authorization codes will be provided to the site’s LMC by the COTS Software 
License Administrator through the M&O web site entitled “COTS Hardware- Software 
Maintenance via the following URL" 

http://dmserver.gsfc.nasa.gov/ils/html/maintsw.htm. 

Changes to the information in the “COTS Software Support” web site are to be provided to the 
COTS Software License Administrator as they occur, for updating the web site. Specifically, the 
need to identify or replace the authorized contact person must be provided by the LMC to the 
COTS Software License Administrator. 

E-mail is the preferred notification method. The site will follow these steps: 

a. Send e-mail to ilsmaint@eos.hitc.com. 

b. If e-mail is not available, call 1-800-ECS-DATA, Option 3; then dial extension 0726 

c. Identify the change as either a permanent or temporary change. A temporary change may 
occur when the authorized contact person is ill, on vacation, in training, or other short-term 
change of work availability status has occurred or is expected to occur. 

d. Provide the COTS Software License Administrator the change information as soon as it is 
known. 

22.1.6 COTS Software Problem Reporting 

The first person experiencing or observing a potential COTS SW problem will initiate a trouble 
ticket according to the procedures found in Section 8.1, “Trouble Ticket System Procedures” 
then forward it to the assigned site person to review the problem. This person will attempt to 
isolate the source of the problem to system configuration, hardware, network, COTS SW, custom 
SW, or science SW. 

If it is confirmed to be a COTS SW problem, the authorized contact person should contact the 
vendor’s technical support center for assistance. Information on contacting the software 
vendor’s technical support center is in Section 22.1.4.1, “COTS Software Problem Reporting.” 
The appropriate site personnel must annotate all actions inclusive of dates, time, resolutions, and 
comments in the Remedy Trouble Ticket as the repair progresses. COTS software corrective 
action reporting follows the procedures contained in Section 8, “Problem Management” and the 
configuration control requirements contained in Section 9, “Configuration Management,” when a 
configuration item is removed and/or replaced with a different version or release. 

One method to troubleshooting the COTS SW problem is to scan the software vendor’s web site 
solutions database to learn of any solutions for similar problems. The software vendor’s web site 
address can be obtained as stated in Section 22.1.6. Another manner to troubleshooting the 
COTS SW problem is to exercise any software diagnostic routine embedded or down-loadable 
that will determine the status of the COTS SW on the equipment by reviewing the 
troubleshooting-diagnostics and corrective actions taken to date. These troubleshooting, 
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diagnostics, and/or isolation procedures may be contained in the vendor’s operational manuals or 
in locally devised troubleshooting procedures. 

COTS SW problems that cannot be corrected using site and contracted software support may be 
escalated to the ECS SSO. The SSO is staffed with Senior Systems Engineers knowledgeable on 
COTS SW that can assist in diagnosing the problem. 

The site Local Maintenance Coordinator may go directly to the software vendor or to the ILS 
SW Administrator to obtain an escalation of software vendor support if the software vendor’s 
efforts have not produced satisfactory results within a reasonable period of time. The escalation 
may result in increased vendor management review of the problem resolution, the assignment of 
additional resources to resolve the problem, and/or a more highly qualified technician assigned to 
resolve the software problem. 

22.2Custom Software Maintenance 

Multiple baselines may exist throughout the ECS contract. After Version 2, Release 2.0 is 
operational, the M&O organization may need to modify the configuration as established at each 
center. The M&O master library was delivered by the release development organization at 
launch. The Software Change Manager (ClearCase) provides the vehicle to store and maintain 
the library. The governing policies and minimum developed software component level that may 
be removed from or reintroduced to (checked-out for maintenance) the master library are defined 
by the developers’ determination of code modules. This topic is detailed in the description of the 
Software Change Manager and Baseline Manager (XRP-II) tools, (Sections 9.6 and 9.9 of this 
document, respectively). Software changes are distributed on the basis of Software 
Configuration Items to the sites’ copy of the Software Change Manager and recorded in the sites’ 
copy of Baseline Manager following configuration management procedures defined in the M&O 
CM Plan (102-CD-001-002) and Section 9 of this document. 

Maintenance changes to the ECS baseline may come from any of several sources, e.g., 

• ESDIS CCB directed changes 

•	 Site-level CCB directed changes to Configuration Items (CIs)-- ESDIS will delegate or 
define which items are to be under site-level control and to what extent those parameters can 
be changed. 

• Developer scheduled modifications or upgrades. 

• User or operator initiated Trouble Tickets. 

Trouble Tickets (TTs) are written by ECS users, operators, and system administration to address 
any level of problem they may encounter with a minimum required level of documentation. This 
topic is addressed in more detail by the ECS Developed SW Maintenance Plan (614-CD-001­
002) at section 4.3 and in this document at section 8 “Problem Management.” Most of these 
problems will be fixed locally with minimum overhead requirements for tracking and analysis. 
The TT Telecon will be used by the SEO to discuss system-level issues that may 
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(a) coordinate groups of TTs, 

(b) affect more than a single site, 

(c) will be referred back to the ESDIS Project Office and the ECS development organization, 

(d) and will be worked-off with the necessary coordination and formality of multi-site change or 
implementation. 

The Software Maintenance Engineer records all actions to resolve a problem on the associated 
trouble ticket within the TT System tool (Remedy). ClearCase serves as the Software Change 
Manager, providing utilities to maintain a software master library (the operational baseline) and 
supporting CM functions for version control. The Software Maintenance Engineer can check­
out software components for maintenance and check them in for baselining. The Software 
Change Manager tracks versions of software used in builds as well as provides a tool to perform 
builds. 

Updates to baselined custom software are submitted with the Version Description Documents 
(VDD) and go through the CCB review process. The software also goes through M&O testing 
prior to installation. All changes to the operational baseline are recorded and tracked in the 
Baseline Manager by the CM Administrator (see Section 9 of this document). 

The Activity Checklist table that follows provides an overview of Custom Software Support 
procedures. Column one (Order) shows the order in which tasks might be accomplished. 
Column two (Role) lists the Role/Manager/Operator responsible for performing the task. 
Column three (Task) provides a brief explanation of the task. Column four (Section) provides 
the Procedure (P) section number or Instruction (I) section number where details for performing 
the task can be found. Column five (Complete?) is used as a checklist to keep track of which 
task steps have been completed. 

Table 22.2-1. Custom Software Maintenance - Activity Checklist (1 of 2) 
Order Role Task Section Complete? 

1 Software Maintenance 
Engineer/CMA 

Implementation of Modifications (I) 22.2.1 

2 SEO Test Plans & Procedures (I) 22.2.2 

3 M&O Test Team Custom SW Installation (I) 22.2.3 

4 CCB Scheduling the Release (I) 22.2.3.1 

5 CMA Operations & User Notification (I) 22.2.3.2 

6 SW Maintenance 
Engineer 

Maintenance Changes to the SW 
Change Manager (ClearCase) Library 

(I) 22.2.3.3 

7 SW Maintenance 
Engineer 

Creating SW Build Using the SW 
Change Manager 

(I) 22.2.3.4 

8 CMA & 
SW Maintenance 
Engineer 

Promoting SW Using the SW Change 
Manager 

(I) 22.2.3.5 
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Table 22.2-1. Custom Software Maintenance - Activity Checklist (2 of 2) 
Order Role Task Section Complete? 

9 SW Maintenance 
Engineer 

Installing the New Release (I) 22.2.3.6 

10 M&O Team Obtaining SW Support (I) 22.2.4 

11 User Services, CMA, 
Operators 

SW Problem Reporting (I) 22.2.4.1 

12 Problem Investigator Troubleshooting (I) 22.2.4.2 

13 SW Maintenance 
Engineer 

Corrective Action Reporting (I) 22.2.4.3 

14 Science SW Team Resolve problems, as required (I) 22.2.5 

22.2.1 Implementation of Modifications 

Implementation of changes is performed using a controlled build procedure. For each build, each 
ECS organization selects a responsible engineer (RE). The SEO RE establishes the set of CCRs 
to be included in the system build. The ECS On-Site, SMC and EOC REs determine which, if 
any, site-unique extensions are to be applied to the system build. Schedules for implementation, 
integration, and test at the system and center levels are established. The SEO RE maintains the 
integrated system and center-specific CCR list and schedule. 

The SEO RE maintains the Version Description Document (VDD) that contains: 

• The CCRs incorporated into the build and their operational and/or user features 

• The build schedule, 

• ECS external interfaces affected by the build, 

• ECS CIs affected by the build, 

•	 List of ECS documentation (e.g., design documents, procedures, help files, etc.) affected 
by the build, 

• Test program results summary, and 

• Test team recommendation. 

The initial VDD is provided with Version 2, Release 2.0 by the Independent Acceptance Test 
Organization. It is then maintained by the Sustaining Engineering Office (SEO) as described in 
the Developed SW Maintenance Plan, 614-CD-001-003 at Sections 4.3.6 and 4.3.7. It contains 
not only the as-built documentation, but is supplemented by the as-tested, verified, and accepted 
documentation as discussed in the Acceptance Testing Management Plan. The document is 
described in the System Implementation Plan for ECS Turnovers, ECS #301-CD-003-001 which 
addresses the overall ECS system turnover process (HW, SW, and documents). The SEO RE 
updates depend on authorized changes. 

Appendices are added as necessary to the system level VDD by each center’s RE to describe any 
center-unique additions/modifications to the build. The VDD is published in draft form well in 
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advance of the build using ECS bulletin boards and electronic distribution. Updates are published 
as information is gathered. The final VDD is published just prior to installation of the new build 
into operations. 

For a given CCR, the RE (or designated team) to whom implementation of the CCR is assigned 
uses the configuration controlled local library to obtain the correct version of the source 
code/files. Using ECS-provided editors, compilers, and build procedures, the RE implements the 
change, performs programmer testing, and updates the documentation including design, 
interface, and procedure documents. 

The RE may discover that the approved incorporation schedule cannot be met because of 
unforeseen complexity, changes in priority, or conflicting assignments. Revised 
implementations, priorities and schedules are brought to the CCR Telecon for discussion. If 
necessary, a revised CCR and/or incorporation schedule is forwarded to the ESDIS CCB for 
impact assessment. Typical CCR discussion topics are outlined in Figure 22.2-1. 

CCR Discussion Topics 

• Review and prioritize each CCR opened at each center 

• Review and re-prioritize older CCRs (as required) 

• Review status of open CCRs 

• Review distribution of CCRs by organization, status, priority and age 

• Recommend new/revised assignments of CCRs to organizations/centers 

• Discuss CCR issues with development organizations 

Figure 22.2-1. Typical CCR Telecon Agenda 

Upon completion of the modification, the revised source files, data bases/ structures, and 
documentation are impounded and controlled by the Integration and Test organization at the 
RE’s site using the CM tool. The impounded material is forwarded (if developed at a DAAC, the 
SMC or EOC) to the SEO for system integration and test. In the case of FOS SW CIs, system 
integration and test is performed within the EOC. 

The golden copy of ECS SW is maintained by the SMC. Required access to the golden copy as 
well as changes will be guaranteed by logging changes and backing up modifications for later 
access as required by users, developers, and maintenance personnel under CM guidelines 
delineated by the ECS CM Plan. SW will also be maintained by local CM at the DAACs. 

22.2.2 Test Plans and Procedures 

The objective of the test program is to ensure that the CCRs are properly implemented and that 
defects have not been introduced as a result of the changes. Therefore, both feature (has the CCR 

22-9 611-CD-510-001




been properly implemented) and regression (revalidation of proper operation of the CI and 
system) testing at both the system and center levels are critical parts of the test program. 

The test function exists within each of the M&O organizations. In the larger organizations, 
individuals may be dedicated to testing of M&O builds. In the smaller organizations, testing may 
be an performed by personnel who have additional assignments. The test team can include 
maintenance programmers, vendors, users — any personnel who reported the problem that 
initiated the upgrade or who use the software. Regardless, the guiding principle is that the 
maintenance programmer who made a change is not allowed to be the only person who 
revalidates the program or provides feature testing. 

The methodology employed in testing includes: 

•	 Inspection — formal verification by examination of the assembled CI and its design 
documentation. 

•	 Analysis — formal verification by examination and study of the CI/data base/data 
structure design and coding. 

• Demonstration — formal verification by operating the computer program. 

•	 Review of test data — review of test records and data after the execution of the computer 
program. 

These are categories of testing procedures. The specifics cannot and should not be pre­
determined, but rather should be responsive to the individual requirements determined by the 
extent/ impact of changes made to the original CI. M&O testing shall consist of recreating in 
whole or in-part the same scenarios used in the original acceptance testing. 

Using the information in the Version Description Document (VDD) described in Section 22.2.1, 
the system and center test teams develop test plans for the build. The plans describe: 

• The CCRs to be tested; 

• The CM baseline(s) to be used; 

• The requirements and features to be verified; 

• The method of verification including identification of test cases/data sets; 

• Acceptance criteria; 

• Resource requirements; and 

• Schedule of testing. 

that are to be used for both feature and regression testing. Test procedures provide the detailed 
scenarios and test cases/data sets, steps, operator/user actions, analyses, etc., that implement the 
test plan. 

Feature testing is performed through either the development of new test cases and data or the 
modification of existing test cases and data. Regression testing is performed using standard test 
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cases with expected test results. When possible, the same test cases and data as were used when 
the program was originally developed are used. Test cases developed for prior feature testing are 
also used as part of the test program. 

When possible, center-specific testing of system-level change builds will be performed in 
conjunction with the system test. If this is not possible, center-specific testing will precede the 
system level testing to allow a controlled increase in complexity during the test program. Should 
center-specific modifications to the system build be required, center level testing will be 
performed at the center first and then included in either the initial or follow-on system-level 
testing. 

Test results and analyses which are developed by the test organization(s) are provided to the 
SEO and center REs. Unacceptable performance during the test program may result in delaying 
of the entire build or removal of a CCR from the build. Because the test team functions as an 
independent assessment of the build, it provides its recommendation on the quality and 
performance of the build to the SEO. A summary of the test program and the test team’s 
recommendation are added to the VDD. 

The SEO RE is responsible for review of the test plans and procedures to ensure the adequacy of 
the test program. Center REs support the SEO RE in this assessment. Status of the test program 
is also provided to ECS and center management at the weekly status meetings described in 
Appendix B of the Maintenance and Operations Management Plan. 

22.2.3 Custom Software Installation 

The Version Description Document (VDD) provides the summary documentation package for 
each build. The material in the VDD is presented by the ECS M&O test function to the 
appropriate individual(s) within ESDIS. The VDD material is also presented by the ECS M&O 
test organization to the appropriate individual(s) within each operational center. If required by 
ESDIS or the center, results of IV&V or center-unique testing results will be presented by the 
appropriate organization. Upon review and approval by ESDIS and center management, the build 
as baselined in the center-specific VDD is authorized for system-wide and center operations. 

The following sequence then occurs: 

•	 The VDD undergoes final updates for system and center-specific material identified by 
ESDIS or the operational centers (e.g., IV&V test results and recommendations, center by 
center operational installation schedule, etc.). 

• The final VDD is published. 

•	 In accordance with the installation schedule, the build is installed at each center along 
with operational and user documentation updates. 

•	 Controlled Document updates are provided to Document Maintenance and entered into 
the CM system. 

• The CM system is updated to indicate the M&O system and center-specific baselines. 
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22.2.3.1 Scheduling the Release 

Scheduled maintenance should be emphasized as a method of controlling the maintenance 
function in which the new-release concept already applied to systems is also applied to typical 
application programs. Emergency fixes are applied as required, but all other repairs or changes 
are assessed for the determination of an appropriate new-release schedule. There are several 
benefits to this approach: 

--By consolidating the changes to be made to a CI, modifications can be performed more 
efficiently, e.g., documentation is updated only once, minimizes unnecesary disruptions to ops, 
decreases costs, etc. 

--Since users know their changes will not be acted on immediately, they can give more 
consideration to which changes they actually need. 

--Batched changes can be assessed holistically and more thoroughly evaluated. 

--Knowing which applications will be maintained during the monthly/yearly cycle enables 
management to more effectively prioritize maintenance projects 

--Positive control of baseline management between the M&O and Development organizations 

22.2.3.2 Operations and User Notification 

The Version Description Document (VDD) is the vehicle for communicating the contents, status, 
feature, schedule, and test results to the ECS stake holders. It is supplemented by test plans, test 
procedures and test results. Draft and final versions of the VDD and test program documentation 
are published and distributed to interested organizations internal (e.g., the ECS Development 
Offices, System Management Office, Quality Office, Science Office, etc.) and external (e.g., 
ESDIS, DAAC, other Customer, external systems, IV&V contractor, SCFs, user groups, etc.) to 
the ECS Contractor using ECS bulletin boards and electronic distribution. 

22.2.3.3 Maintenance Changes to the On-Site SW Change Manager Library 

The golden copy of ECS custom software is maintained at the SMC by the SEO CM 
Administrator. Required access to the golden copy as well as changes will be guaranteed by 
logging changes and backing up modifications for later access as required by users, developers, 
and maintenance personnel under CM guidelines delineated by the M&O CM Plan. Custom 
software will also be maintained by the CMA at the ECS deployment sites. 

The Software Maintenance Engineer (SME) will use the Software Change Manager (ClearCase) 
to maintain the current software baseline. The CMA and SME will maintain the records in 
Baseline Manager so that they are synchronized with the Software Change Manager maintenance 
changes. 
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SMC provides the upgraded or new custom software to the sites. Each site specifies a temporary 
directory (a ClearCase VOB) that will receive the software. The site CCB must approve the 
installation of the software into the site's master library. 

When notified by the CMA that the source code has been received and baselined, the Software 
Maintenance Engineer creates branches in the Software Change Manager, which are created for 
bugfixes, enhancements, and new development that are under CM control. The Software 
Maintenance Engineer also sets the configuration specification for the operational environment. 
Lastly, the Software Maintenance Engineer merges the files. 

Refer to the procedures in ECS Work Instruction CM-1-016-1 to manage the branch and merge 
process. 

22.2.3.4 Creating the SW Build Using SW Change Manager (ClearCase)\ 

Refer to the procedures in ECS Work Instruction CM-1-023-1 to manage creation of the software 
build using ClearCase. 

22.2.3.5 Promoting Software Using SW Change Manager (ClearCase) 

Tables of SW states (Table 22.2-2 for ECS SW and Table 22.2-5 for Science SW); valid SW 
state transitions (Table 22.2-3 for ECS SW and Table 22.2-6 for Science SW); and SW 
promotion levels (Table 22.2-4 for ECS SW and Table 22.2-7 for Science SW) govern the 
promotion of ECS custom and science SW from developer or maintenance engineering activities 
into operational strings. SW Change Manager (ClearCase) scripts execute the transition queries, 
notification and changes under CM control as explained in Sections 22.2.3.5.1 and 22.2.3.5.2. 

22.2.3.5.1 "Change State Script" Description 

The Change State script is designed to provide configuration management support of software 
undergoing change. Software versions will have a state attribute assigned to facilitate the 
tracking of a version as it proceeds through its lifecycle stages. This script will give its user the 
capability to change the value of the state attribute of a file version as the version proceeds from 
one state to another. This script checks the entered state attribute value and allows only valid 
state values to be processed. It checks the user's identification and allows only designated user(s) 
to change the state attribute value. It checks to ensure that the entered state value is a valid 
transition from the file version's current state attribute’s value, informs the user of unexpected 
transitions, and gives the user the option to proceed with the transition, anyway. It notifies 
appropriate personnel that the version is ready for system test, acceptance test, or production. It 
will also assign a state value of ready for supersession and superseded for those versions of files 
that are being or have been replaced. Valid state values, valid state transitions, personnel 
authorized to change state values, and personnel to be notified of state changes are stored in files. 

22.2.3.5.2 Promotion_level Script Description 

The Promotion_level script is designed to provide configuration management support of 
software undergoing change. Software versions will have a Promotion Level attribute assigned 
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to facilitate the tracking of a version as it proceeds through its lifecycle stages. This script will 
give its user the capability to change the value of the Promotion Level attribute of a file version 
as the version proceeds from one promotion level to another. It checks the entered Promotion 
Level attribute value and allows only valid promotion level values to be processed. 
Maintenance, system test, acceptance test, and Production are the valid promotion level values. 
This script also checks the user's identification and allows only designated user(s) to change the 
promotion level attribute value. It allows the designated user to promote the software version 
and it sets the initial state attribute value for the entered promotion level value. Valid promotion 
level values and personnel authorized to change these values are stored in files. 

Table 22.2-2. ECS Software Oriented Tables State Table 
State Authority 

to Change State 
Person to be 

Notified 
In Promotion 

Level 

In_Work Developer Maintenance 

Ready for Inspection Developer Lead Engineer Maintenance 

Inspected Lead Engineer Maintenance 

Ready for System Test Lead Engineer Tester Maintenance 

In Sys_Testing Tester System_Test 

Sys_Tested Tester System_Test 

Ready for Acceptance Test Tester Accept. Tester System_Test 

In_Accept_Testing Accept. Tester Accept_Test 

Accept_Tested Accept. Tester Accept_Test 

Ready for Release Accept. Tester 

CM_Admin 

CM_Admin Accept_Test 

Released CM_Admin Accept_Test 

Ready for Production CM_Admin Sys_Admin Accept_Test 

In_Production Sys_Admin Production 

Ready for Supersession CM_Admin, Production 

Superseded CM_Admin 
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Table 22.2-3. Valid State Transitions 
Current State New State 

In_Work Ready for Inspection 

Ready for Inspection Inspected 

Inspected Ready for Sys_Test 

Ready for Sys_Test In_Sys_Testing 

In_Sys_Testing Sys_Tested 

Sys_Tested Ready for Accept_Test 

Ready for Acceptance_Test In_Acceptance_Test 

In_Acceptance_Test Acceptance_Tested 

Accept_Tested Ready for Release 

Ready for Release Released 

Released Ready for Production 

Ready for Production In_Production 

In_Production Ready for Superseding 

Ready for Superseding Superseded 

Superseded (No Transition) 
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Table 22.2-4. Valid State Assignment Given Current Promotion Level 
Promotion Level State 

Maintenance In_Work 

Maintenance Ready for Inspection 

Maintenance Inspected 

Maintenance Ready for System Test 

Sys_Test In_Sys_Testing 

Sys_Test Sys_Tested 

Maintenance 

Sys_Test 

Ready for Accept_Test 

Accept_Test In_Accept_Testing 

Accept_Test Accept_Tested 

Accept_Test 

Sys_Test 

Maintenance 

Ready for Release 

Accept_Test 

As_Delivered 

Released 

As_Delivered 

Accept_Test 

Sys_Test 

Maintenance 

Ready for Production 

Production In_Production 

As_Delivered 

Production 

Accept_Test 

Sys_Test 

Maintenance 

Ready for Supersession 

Production Superseded 
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Table 22.2-5. Science Software Oriented State Table 
State Authority 

to Change State 

Person to be 

Notified 

In Promotion Level 

in work SDPS/W maintenance 

ready for stand-alone test SDPS/W SDPS/W maintenance 

in stand-alone testing SDPS/W stand-alone test 

stand-alone tested SDPS/W stand-alone test 

ready for integrated test SDPS/W SSI&T stand_alone test 

in integrated testing SSI&T received by DAAC 

integration tested SSI&T received by DAAC 

ready for acceptance SSI&T CM_admin received by DAAC 

impounded for acceptance CM_admin delivered from SSI&T 

ready for production CM_admin delivered from SSI&T 

in commissioning CM_admin production 

in full production CM_admin production 

ready for superseding CM_admin production 

superseded CM_admin production 

Table 22.2-6. Science Software Oriented Valid State Transitions 
Current State New State 

in work ready for stand-alone test 

ready for stand-alone test in stand-alone testing 

in stand-alone testing stand-alone tested 

stand-alone tested ready for integrated test 

ready for integrated test in integrated testing 

in integrated testing integration tested 

integration tested ready for acceptance 

ready for acceptance impounded for acceptance 

impounded for acceptance ready for production 

ready for production in commissioning 

in commissioning in full production 

in full production ready for superseding 

ready for superseding superseded 

superseded (no transition) 

22-17 611-CD-510-001




Table 22.2-7. Science Software Oriented Promotion Table 
Promotion Level Authority to Promote State 

from SCF CM_admin or SDPS/W 

maintenance SDPS/W (checkout & checkin) in work 
ready for stand-alone test 
in stand-alone testing 
ready for integrated test 
in integrated testing 
ready for acceptance 
ready for production 

stand-alone test SDPS/W in stand-alone testing 
stand-alone tested 
ready for integrated test 
ready for acceptance 
ready for production 

received by DAAC SSI&T in integrated testing 
integration tested 
ready for acceptance 
ready for production 

delivered from SSI&T CM_admin impounded for acceptance 
ready for production 

production CM_admin in commissioning 
in full production 
ready for supersession 
superseded 

22.2.3.6 Installing the New Release 

This procedure describes the steps that are executed to perform a SW upgrade on an ECS Host. 
The personnel involved are Sustaining Engineer (SE), Resource Manager (RM), Production 
Monitor (PM), and Host Operator (HO). The RM notifies the affected operators that there is an 
upgrade scheduled and the resources will be coming down for the installation activity. The RM 
then checks with the production montior to begin unloading the target resources (if Autosys has 
already scheduled this event, it will happen automatically). The Production Monitor then checks 
the current load on target resources and informs the RM that the production jobs are complete. 
The RM then takes the initiative to shut down any processes that may still be running and begins 
shut-down procedures. Then by monitoring HP OpenView, the RM and SE are notified that the 
host has gone off-line. The SE uses the install script to install the upgrade, verifies the path and 
directory structures, and runs all diagnostic tests. The SE then informs the RM that the 
installation is complete. The RM then initiates the host start-up commands. HP OpenView then 
indicates that the host is back on line. 

The assumptions underlying this procedure are as follows: 

(1) The upgrade has been previously scheduled and noted in the resource plan. 
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(2) The SW upgrade package was obtained from Tivoli Courier including any associated install 
scripts/makefiles. 

(3) The detailed steps for installation have been provided in the VDD accompanying the SW 
package. 

(4) The reconfiguration to minimize impact to existing operational resources has been defined. 

The following table contains detailed steps of the on-site SW installation procedure. 

Table 22.2-8. Detailed Steps of SW Installation (1 of 2) 
Step Operator Action System 

1 Resource Manager composes an information 
message to the affected operators stating that 
the affected resources will be taken down as 
scheduled. 

2 Displays information message on consoles. 

3 RM asks production monitor to verify that the 
production has completed on the resource as 
planned. 

4 PM checks current load on target resources. Provides display of current jobs running on 
requested production resources. 

5 PM informs RM that production jobs are 
complete. 

6 RM now takes control and shuts down any 
processes still running on impacted host(s). 

7 RM begins shut down procedures to take host 
off-line. 

The host receives the command and goes off�
line. 

8 HP OpenView detects the change and 
changes the state to “off-line.” 

9 HP OpenView sends a status message to all 
of the affected operators indicating that the 
host has gone down and changes the 
corresponding icon to the down state. 

10 RM receives a message from HP OpenView 
indicating that the desired host has gone off�
line. All operators monitoring the host receive 
a message from HP OpenView indicating that 
the designated host has gone off-line. 
Sustaining Engineer receives a message from 
HP OpenView indicating that the designated 
host has gone off-line. 

11 RM views the change in HP OpenView and 
notifies the Sustaining Engineer that the host 
is available for upgrade. 
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Table 22.2-8. Detailed Steps of SW Installation (2 of 2) 
Step Operator Action System 

12 SE uses the developers’ install script stored in 
SW Change Manager (Clearcase). 

ClearCase executes the named install script 
which applies controlled file system changes 
to the specified host. 

13 SE verifies that all of the paths and directories 
structures have been created and are correct. 

Host lists its file system contents. 

14 SE runs all of the diagnostic tests to verify that 
the new upgrade is operating as expected. 

15 SE informs the RM that the upgrade is 
completed 

16 RM acknowleges the message from the SE 
that the installation is completed. 

17 RM initiates the host start-up commands. Host receives the commands and begins 
start-up. 

18 Start-up completed. 

19 HP OpenView detects the state change and 
changes the icon to the up status and sends a 
status message to all users indicating that the 
host is back on-line. 

20 RM, Operators, and SE receives message 
from HP OpenView indicating that the host is 
back on-line. 

22.2.4 Obtaining Software Support 

The Baseline Manager tool will contain the list of Responsible Engineers for the SW CIs. On­
site Maintenance Engineers will consult with experts from the Sustaining Engineering 
Organization who perform system-level SW maintenance activities and REs who will lead 
troubleshooting activities of specific CIs. This point of contact information will be currently 
maintained in the databases. Prioritized Trouble Tickets will be used to coordinate this activity 
and provide emergency fixes and related Configuration Change Requests will sponsor permanent 
changes. 

22.2.4.1 SW Problem Reporting 

Anomalies, the apparent incorrect execution of an ECS CI, and inefficiencies, sub-optimal use of 
system resources, are documented using TTs. A TT may be submitted by users, operations, 
customer, analysis, maintenance and management staff. At the time of TT submittal, supporting 
information and data is captured by the ECS staff. SW problems will be reported via the Trouble 
Ticket system discussed in Section 8. 

22.2.4.2 Troubleshooting 

Troubleshooting will be conducted on an ad hoc basis. The site-level activity will be initiated by 
the Operations Supervisor assigning a Trouble Ticket to the Problem Investigator as discussed in 
section 8.2 Problem Resolution procedures. This process is supported by SEO Maintenance 
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Programmers, REs, and ECS Developers at the ECS Development Facility (EDF). The EDF 
will have the same SW and computer equipment variants available at the sites. They may be 
capable of duplicating anomalies experienced in the on-site’s system to derive effective 
resolutions and/ or work-arounds as required until a permanent resolution is implemented. 

At the TT telecon, the TT is prioritized and assigned by the Failure Review Board to an 
organization for work-off. A Responsible Engineer (RE) is assigned to work-off the TT. Using 
the captured data, a technical investigation is performed to attempt to isolate the source of the 
reported anomaly or inefficiency. 

If the problem is caused by a non-ECS element (e.g., an interface problem with an external 
system, poor resource usage by a science algorithm, poor performance by a non-ECS service, 
etc.), the TT and supporting material is provided to the maintainer of that element. An ECS CCR 
may also be proposed to protect ECS from potential threats of future problems identical or 
similar to that documented in the TT. CCRs are discussed in detail at section 9 of this document. 

If the TT is properly written against an ECS element, one or more of the following actions are 
taken: 

•	 Describe the source of the problem and the recommended design/implementation change. 
Procedure modifications may also be appropriate. 

•	 Modify procedures. Describe the source of the problem and modify procedures to 
eliminate or reduce the number of occurrences of the documented problem. Modifications 
may be temporary (i.e., work-arounds) or permanent. If the change is permanent, the TT 
can be closed and/or a User Recommendations Data Base (URDB) input generated. 

•	 Track. The technical investigation focuses on collection of additional data from new 
occurrences to support additional analyses into the root of the problem and/or the 
frequency of occurrence. As a result of tracking, further technical investigations may 
result in any of the other actions. 

•	 Re-prioritize. Describe the results of the technical investigation and recommend a priority 
change at the TT Telecon. A lowered priority may result in the TT going into backlog 
status or being closed. A higher priority may result in additional resources being applied 
to the technical investigation. 

•	 Close with URDB input. The technical investigation may discover that what is being 
reported as a problem is actually the proper implementation of the feature based on the 
requirements baseline. A URDB input documents a recommended requirements change. 

•	 Close TT into existing TT or CCR. If the TT documents a known problem for which no 
solution has been identified, the new TT can be closed into the existing TT. Supporting 
material from the new TT is added to that previously collected. The TT may also be 
closed into a CCR that has been previously written but not yet installed into the 
operational baseline. 

The originator of the TT is kept informed throughout the process via minutes from the TT 
telecon and voice/ e-mail status reports from the RE. 
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22.2.4.3 Corrective Action Reporting 

Trouble Tickets will be used to document SW problems as noted in Section 22.2.4.2. The results 
are tallied against SW Configuration Items to determine critical maintenance concerns related to 
frequency of occurrence, criticality level, and the volume of problems experienced. The 
maintainability analysis will guide critical changes, volume and type of support components to 
be utilized, and focus of further ECS release development. 

22.2.5 Science Software 

The maintenance of science software and data items provided by the Science Computing 
Facilities (SCFs) is not the responsibility of the ECS on-site maintenance engineers. Problem 
resolutions and changes to science software sponsored by the SCFs shall be introduced under the 
auspices of local DAAC configuration management activities and the Earth Science Data and 
Information System (ESDIS) (GSFC Code 505) CCB in the same manner as new releases to 
baselined science software. On-site changes or updates shall be integrated and tested by the 
Science Software Team. Ongoing CM of ECS integrated science software will be accomplished 
by the same tool set used for ECS developed software as explained in the Developed SW 
Maintenance Plan at Section 3.3 Standardization of Support Procedures under local DAAC 
control. 
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23. Property Management 

This section describes procedures for the receipt, control, and accountability of ECS property at 
ECS sites. The “Property Management Plan" 602-CD-001-002 is the base document that 
addresses the process and policies regarding how ECS property is to be managed. The site Local 
Maintenance Coordinator (LMC) at each site is the site’s property administrator. LMCs should 
be thoroughly familiar with and adhere to the contents and policies contained within that 
document. 

The LMCs support the activities of receiving, inspection, storage, issue, inventory recording, 
accounting, and reporting of ECS property at ECS sites. Generally, LMCs should follow the 
processes, procedures and policies specified in the Property Management Plan. Locally 
developed procedures should be forwarded to and reviewed by the ECS ILS Office for 
consistency with this plan. 

23.1Receipt of Equipment and Software from Vendor 

Some equipment, software, consumables, and media will be shipped direct from vendors to the 
sites. In such cases, the ILS PA will fax a copy of the Purchase Order to the LMC to serve as a 
due-in notice. Upon receipt of the equipment, the LMC will perform a receiving inspection to 
verify correctness of delivery, quantity received and to determine if items were damaged during 
shipment. The LMC will utilize the following tables as guidance for Receipt of Incoming Items. 

• Table 23.1-1 for the Receipt of Equipment 

• Table 23.1-2 for the Inventory Worksheet 

• Table 23.1-3 COTS Non-Conforming Product Report Checklist 

• Table 23.1-4 Receiving Process Checklist 

The worksheet for documenting inventory as well as the checklists can be located on the Web at 
http://dmserver.gsfc.nasa.gov/forms/formindex.html under Project forms. Inventory Worksheet 
form number is Mo05ja99.doc. The Property Checklists form number Mo06ja99.doc, which 
includes the Loading Dock Checklist, System Verification Checklist and Receiving Process 
Checklist. The ILS Property Administration (PA) has incorporated these two forms together as 
one document to reduce paperwork. When all checklists are signed and verified, the LMC will 
fax or email all forms to the ILS Property Administration and ILS Property Administration will 
update the Inventory Database. When a product is received that does not conform to the 
purchase order the Non-Conforming Product Report (NCR) form located at the same URL with 
the following form number Mo08ja99.doc can be accessed for use. Work flow process charts 
A, A-1, and A-2 illustrate Receipt of Hardware/Software, Inventory Worksheet and Non-
Conforming Product Reporting and can be located at the end of this chapter. 
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Table 23.1-1. Procedure for the Receipt of Property 
Step Action 

1. LMC completes the Loading Dock checklist document with the following information: 
Printed name of receiving individual 
Signature of receiving individual 
Date of receipt 
Name of the carrier 
Shippers bill of lading or tracking number 
Customer reference number (when appropriate) 
Number of boxes received 
Condition of boxes with a notation of Satisfactory or Damaged 

2 LMC Verifies damage, shortage, overage or other discrepancies and annotates these findings on 
both the carrier’s and site’s copy. An NCR will be completed as listed in Table 23.1-4 

2a If damages are noted obtain a signature of the carrier's representative on the shipping carrier's 
document and notify the ILS PA for further information 

3 Begin the process of moving equipment into a controlled storage area and completing the 
inventory worksheet as described Table 23.1-2 

Table 23.1-2. Procedure for Completion of the Inventory Worksheet 
Step Action 

1. LMC removes the equipment from the loading dock to controlled storage area. 

2. Verifies the items received against purchase orders and vendor’s packing list. Inspects visual 
condition of material and documents information on Inventory Worksheet, 

3. Documents the serial, model numbers and other appropriate markings on the Inventory 
Worksheet. Performs final visual inspection of product to ensure no damage or non conforming 
items have been received.. 

Places silver EIN tags on equipment per the instructions listed in section 23.2 

5 Assembles equipment for burn-in to be performed for 72 hours and documents the burn-in 
process on the System Verification Checklist. 

6. If required, completes the COTS NCR using the procedure in Table 23.1-3. 
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Table 23.1-3. Procedure for Completion of the 
Non Conforming Product Report 

Step Action 

1 LMC verifies shipment discrepancies (include shortages, overages, and incorrect 
items/quantities/models. 

2. Completes COTS NCR per instructions on the back of the form 

3. Sends the completed COTS NCR to the ILS PA via fax or EMAIL 

4. ILS PA sends the NCR form to the appropriate group for vendor notification and resolution. 

5. The resolving group will communicate periodic status from the vendor to the ILS PA, who will 
notify the LMC. 

6. The ILS PA will receive the completed NCR from the appropriate group and files in the Property 
Purchase Order files. The ILS PA will send a copy of the completed NCR via fax or EMAIL to the 
LMC for their records. 

Table 23.1-4. Receiving Process Checklist 
Step Action 

1. Verify that Loading Dock Checklist has been completed with all the appropriate information 

2. Annotate Purchase Order number or Returned Material Authorization (RMA) on the Inventory 
Worksheet. 

3. Verify that COTS NCR has been completed and processed, if required as in Table 23.1-3. 

4. If the material is partial receipt, verify that it is segregated, labeled, marked and in a controlled 
storage area 

5. If the order has a COTS NCR, verify that it is segregated, labeled and documented in a controlled 
storage area. 

6. Verify the Inventory Worksheet, System Verification, and Receiving Process Checklist have been 
completed and documented. Fax or Email to the ILS PA 

23.2Receipt of Equipment and Software from the ILS Property 
Administrator 

The LMC will also receive equipment from the ILS PA. Table 23.2-1 defines the process of 
receiving equipment at the DAACS from the ILS PA and actions required. In addition the ILS 
PA will be the lead for the COTS NCR. The information listed in Table 23.1-3 explains the 
process to follow when completing a COTS NCR. 
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Table 23.2-1. LMC Actions for Property Received from the 
ILS Property Administrator 

Step Action 

1. LMC receives shipment with Installation Receipt (IR) report from the ILS PA. 

2. LMC inspects and verifies for shipping damage, completeness using the IR report. 

3. Notifies the ILS PA immediately of any discrepancies. If discrepancies exist, annotate the IR 
report accordingly. 

4. Sign for the property where indicated and redline location and site specific changes on the top 
right header information. 

5. LMC retains a copy for files and mails the original back to ILS PA 

6. The ILS PA enters the redline changes into the ILM Property Database. 

7. The original signed redlined IR report and a copy of the Installation Report will be filed in the ECS 
equipment folder. 

8. The site copies of the IR report and installation report will be filed in the site equipment folders 

9. The LMC will coordinate installation of the equipment in accordance with approved CCR and 
DAAC procedures. 

23.3Equipment Tagging 

ECS equipment (e.g., contractor-acquired and GFP) that is separately identifiable and meets the 
criteria for controlled equipment as described in the Property Management Plan 194-602-OP1­
001, will be tagged with ECS property tags. Figure 23.2-1 illustrates ECS property tags. The ILS 
PA prior to shipment will tag ECS equipment reserved at the EDF for staging and subsequent 
shipment to the sites. Tags will be placed on the equipment so that they are visible and easily 

O
accessible by bar-code scanners. Vendor-loaned and RSC capital equipment will not be tagged 
with ECS property tags. 

Ce ntrally  Re portable  Equipme nt Tag Non-re portable  Prope rty Tag 

PROPERTY OF NASA/GSFC E T 

/P
 

Y F N S

A

R SNAS5-60000 

P F C
 

N 0OOOOO126 AS5 - 6 00
0

Equipment Identification Number (EIN) 

Figure 23.2-1. ECS Property Tags (actual size) 

Components of major equipment that are not separately identifiable or stocked for use, such as 
spares/repair parts will not be assigned an EIN. Items not given an EIN sticker will be 
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controlled as inventory items and recorded by manufacturer, description, model/version, serial 
number (if applicable), location, quantity and with the parent EIN. 

Property tags of loaned GFP equipment containing a NASA equipment control number (ECN) 
will not be removed by the LMC. At the time of receipt of such property, the ILS PA will affix 
an ECS property tag with EIN next to the government tag. The NASA ECN will be recorded in 
the property record and cross-referenced to the EIN. 

Prior to disposing of ECS equipment, to include transfer to the Government, ECS property tags 
will be removed. Removed ECS property tags will be retained with the property turn-in 
document. Turn-in documents will be forwarded to the ILS PA for retention in the property 
records. 

23.4 Property Records and Reporting 

The ECS Project will use the Inventory Logistics and Maintenance (ILM) system to support the 
property management, control and reporting functions for contractor-acquired and GFP 
equipment. Property records are created and maintained in this system by the ILS PA. LMCs 
will be able to do queries and prepare reports using the system. Note: Instructions for the use of 
ILM are in Section 27 of this document. 

Property records will contain a line for each item having an EIN (e.g., workstation monitor) and 
each of its major components (e.g., network interface cards, RAM chips, graphics card). Refer 
to the IR Report provided at the time of site installation. It is the responsibility of the LMC to 
notify the ILS PA of inventory, configuration, and location changes so that site property 
records will be maintained current. See Paragraph 23.5 for specific instructions. 

23.4.1 Maintaining Property Records 

LMCs will document inventory and configuration changes in local property records within one 
business day of the change and appropriately notify the ILS PA. 

Support documentation for posting changes to property records include the following: 

•	 Installation Receipt Report -- This report is provided by the installation team at the time 
equipment is installed and is used to record receipts and changes of equipment at the site. It 
can be used to update site property records with installed location, date, and name of the 
person accepting receipts. This report is signed by the LMC to acknowledge receipt of 
equipment at the site. 

•	 Maintenance Work Orders (MWO) -- Prepared by the site LMC to report equipment 
changes resulting from maintenance or relocation actions (e.g., serial/model changes, 
component replacements, and relocation/reconfiguration at the site). MWOs are used by the 
ILS PA or the ILS Maintenance Controller to update the ILM property records. 

23.4.2 Reporting Loss, Theft, Damage or Destruction 

If ECS or GFP property at the site is lost or stolen, the LMC will notify the security as soon as 
the theft is discovered and the ILS PA within one business day. The initial written report will 
contain all information related to what was lost/stolen, when, where, how, and the circumstances 
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regarding the loss/theft. The final report, due 30 days later, will contain all information required 
by the ECS Property Management Plan and will be signed by the DAAC Operations Manager. If 
a report was prepared by local security personnel/police, a copy of the report should be attached 
to the report. 

If equipment is damaged or destroyed through circumstances that indicate inappropriate use, 
negligence, or improper care, the LMC will likewise notify the ILS PA of the specifics of the 
damage/destruction and its circumstances via Internet as soon as known. 

The ILS PA will review such incidents and report, as required, to the ECS Contracts Manager, 
who will notify the Government Property Administrator (e.g., DCMC ) within one business day. 

23.5Equipment Relocation 

This section provides instructions for equipment relocation within a DAAC (intra-site 
relocation); between ECS sites, and between ECS sites and non-ECS sites (inter-site relocation); 
to a vendor (off-site relocation); and transfer to outside the contract (external transfer). ). Work 
flow process charts B, B-1, and B-2 illustrate Equipment Relocation and can be located at 
the end of this chapter. 

23.5.1 Intra-site Relocation 

Requirements for equipment reallocations within the facility or between facilities at the same site 
will be processed through the LMC to maintain control and accountability of equipment 
inventories. A Maintenance Work Order (MWO) should be used to document and forward the 
relocation request to the LMC. The LMC reviews the request and schedules the relocation when 
approved by the local management or configuration control board. When completed, the LMC 
will report the location change in the MWO and forward the MWO to the ILS PA by entering 
status code “A”. 

23.5.2 Inter-site Relocation 

Inter-site relocation requests require a CCR approved by the ECS CCB. Such requests will 
identify by EIN and equipment description what is to be moved, where and when it is to be 
moved, and the reason for the relocation. The losing site LMC will coordinate the relocation 
resources and schedule with the gaining site and the ILS PA which will document the action in 
and MWO. Once completed, the gaining site’s LMC will report completion of the relocation to 
the ILS PA by recording status code “A” in the MWO. The ILS PA will then update the property 
record with the new location and date of the action. Any loss or damage to the equipment will be 
reported using the procedure described in Section 23.3.3 when it occurs or is first discovered. 
Configuration management authorization is required prior to relocating equipment or software 
between DAACs. 

23.5.3 External Transfers 

LMCs will not transfer any ESC property to persons or organizations outside of the ECS 
contract. The ECS Contracting Officer is the only approving authority for such transfers. When 
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the ILS PA receives written authorization from the ECS Contracting Officer, transfers of ECS 
property to the Government or to other contracts will be accomplished. The ILS PA will 
provide written instructions and the necessary documentation to the LMC authorizing the 
property transfer. 

23.6 Inventories and Audits 

LMCs will complete a 100 percent physical inventory of controlled ECS property and GFP at the 
site at least annually and not later than July 31. Notification of the scheduled date of the 
inventory will be provided to the ILS PA 45 days prior to the inventory start date. ECS 
personnel responsible for maintaining property records will provide technical assistance but will 
not be part of any inventory count teams. Inventories will be designed to achieve the following 
objectives: 

• Verify that accountable equipment is still on hand 
•	 Confirm or determine current locations and custodial responsibility for equipment and 

material 
• Identify unrecorded equipment which qualifies for control 
• Locate or identify missing equipment. 
•	 Identify unused or under utilized equipment and equipment or material in need of repair or 

rehabilitation. 

The LMC will, at the time of completion of the annual inventory, forward a copy of the 
Inventory Reconciliation Report to the ILS PA. The Inventory Reconciliation Report will be 
signed by the site’s ECS Manager attesting that a 100 percent inventory was conducted and that 
all equipment is accounted for except for those indicated as not on hand. All discrepancies will 
be explained. 

23.7 Storage 

Access to equipment and software in storage will be limited to authorized personnel and 
controlled by the LMC. LMCs will ensure that storage areas are kept in a clean, orderly manner. 
Material will be stored on shelves, in bins or drawers as appropriate, and its storage location 
entered into the site property record. Special storage areas or controls will be provided for items 
subject to corrosion, humidity, and temperature. LMC should ensure that Electrostatic Discharge 
(ESD) procedures are used for all items requiring ESD protection. See paragraph 23.9 for 
specific ESD instructions. Such items will be inspected semi-annually by the LMC. Serviceable 
property does not require any special color tag. 

23.7.1 Segregation Requirements 

Contractor-owned and vendor-loaned property will be segregated from ECS Government-owned 
property during storage. Unserviceable equipment will also be segregated from serviceable 
equipment and will be tagged. Unserviceable/reparable equipment will have a yellow tag affixed 
to it; unserviceable/non-reparable equipment will have a red tag affixed. Unserviceable 
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equipment tags will indicate reason item is unserviceable, date it became unserviceable, parent 
EIN it came from, and signature of person declaring the item unserviceable. 

23.7.2 Stock Rotation 

Material designated as “stock,” such as computer tapes, cleaning tapes, CDs, labels, etc., should 
be used on a first-in, first-out basis. LMCs will notify the ILS PA of its consumable and media 
requirements at least 90 days in advance of the need date and will not have in stock greater than 
a 6-month supply. LMCs will consider space available for storing such material prior to placing 
its order with the ILS PA. Consumable items are recorded as "C" in the ‘type item’ status field of 
the ILM system. 

23.7.3 Physical Security 

ECS property will be stored in secured areas where access will be limited to authorized 
personnel and controlled by the LMC. 

23.8 Packing and Shipping 

Prior to shipping centrally reportable equipment to the EDF or other ECS sites, the LMC will 
notify via Email the receiving LMC of the site’s intent to ship. This will include the expected 
shipment date, carrier, shipping document number, estimated weight and cube, number of pieces, 
shipper and ship-to-address. Prior to shipment, a pre-shipment inspection will be performed to 
verify the following: 

•	 Correct identification of equipment on packing lists and shipping documents including 
configurations, serial numbers, number of containers, and ship-to address. 

• Adherence to packing, packaging and marking standards. 
• Inclusion of appropriately prepared documents within shipping containers. 
• LMC will notify the ILS PA via Email or phone when the item shipped has been received. 

ECS property being shipped from vendors and the EDF will be shipped to the DAAC facility to 
the attention of the ILS Local Maintenance Coordinator. Local policy at some sites may require 
delivery to a site central receiving point. In such cases, written procedures will be developed 
between the LMC and the site’s central receiving office regarding notification of receipts, 
documentation required, and provisions for local delivery to the DAAC facility. The delivery of 
ECS equipment to site central receiving points versus direct delivery to the DAAC facility will 
be determined based on agreements and procedures established between the host facility and the 
DAAC. 

23.9Electrostatic Discharge (ESD) Program 

An Awareness program on Electrostatic Discharge (ESD) and operations and maintenance 
practices will be followed to eliminate ESD hazards to HW, SW, or people. Procedures for the 
program will be developed using DOD-HDK-263 and DOD-STD-1686 as guides. Included in 
the program will be policies and procedures for prevention and safe dissipation of static 
electricity: Workplace common grounding requirements; and parts handling and protection when 
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in storage, outside the manufacturer's protective packaging, and being readied for installation or 
removal and packaging for delivery. ESD hazard awareness and prevention will be an 
appropriate part of the training and certification process of ECS operations and maintenance 
personnel. All ESD hazard awareness and prevention requirements will be passed through as 
requirements to all operations or maintenance subcontractors. 

LMC receives a copy of the 
purchase order from ILS PA 
to serve as a due-in notice. 

YES NO 

LMC completes the loading dock checklist document 
with the following information: 
• S i gnature of receiving individual 
• D a t e  of receipt 
• N ame of carrier 
• S h ippers bill of lading or tracking number 
• C ustomer re ference number (when appropriate) 
• N umber of boxes received 
• Condition of boxes with a notation of satisfactory 

or damaged 

Is there a 
discrepancy? 

A-1Re fer 
to A-2 

Figure 23.9-1. Receipt of Equipment and Software from Vendor 
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p y

ECS Equipment GFP Equipment Spares/Repairs 

A-1 

LMC removes the equipment 
from the loading dock to 
controlled storage area. 

LMC verifies the items received 
against  purchase orders and 

vendor‘s packing l ist. 

LMC documents the SN, model #, and 
other appropriate markings on the 

Inventory Worksheet. 

LMC assembles equipment for burn-in to 
be performed for 72 hours and documents 

the burn-in process on the System 
Verification C hecklist. 

LMC inspects visual condi tion of 
m aterial and documents information 

on Inventory Worksheet. 

Do not remove NASA‘s ECN. 
LMC pl aces the si lver EIN tags 

next to the NASA‘s ECN 

LMC determines the type of equipment, 
such as ECS equipment, GFP 
equipment, or spares/repairs. 

Control these inventory items and 
recorded by manufacture, 

description, model/version, SN (if 
appropriate), location, quantity with 

parent EIN 

Items that are not separately 
identifiable or stocked for use, 

will not  be assigned an EIN  tag 
otherwise they are assigned an 

EIN Tag 

LMC places a silver 
EIN tag on the new 

equipment so that it is 
visible and easily 

accessible by bar code 
scanners. 

Complete the Inventory 
Worksheet 

A repaired item is assigned a new 
silver EIN tag 

Figure 23.9-2. Procedure for Completion of the Inventory Worksheet 
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LMC annotates the 
discrepancies on both the 
carrier’s and site’s copy 

LMC obtains a signature of 
the carrier’s representative 
on the shipping document. 

LMC completes COTS 
NCR per instructions on 

the back of the form. 

LMC sends the completed COTS 
NCR to the ILS PA via fax or 

EMAIL 

ILS PA sends the COTS NCR 
form to procurement for vendor 

notification and resolution 

ILS PA sends a copy of the completed NCR via 
fax or email to the LMC for their records. 

LMC files the NCR in 
the appropriate files 

A completed COTS NCR 

ILS PA notifies LMC periodically of 
the status until NCR is complete 

A-2 

Figure 23.9-3. Procedure for Completion of the 
Non Conforming Product Report (NCR) 
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Equipment Relocation (1 of 3)


Intra œSite Inter-Site External-Transfer 

Equipment relocation 
requested 

Re que ster determine s the type of relocation, 
such as: a n Intra-site relocation, an Inter-site 
relocation, or an External Transfer (outside 

the ECS control 

Re quester opens a new 
MWO in the ILM 

database to request the 
relocation to the LMC. 

Inter-site relocation requests require a 
CCR approved by the ECS CCB. The 
CCR should contain the following 
information of the item to be relocated: 
〈 EIN,  and description 
〈 

Requester obtains 
approval from the ECS 
Contracting Officer to 
transfer ECS property 
outside the c ontract. 

Where and when it is to be moved 
〈 The reason for the r elocation. 

O nce complet ed, the gaining site LMC 
reports the c ompletion of the 

relocation by changing the  MWO‘s 
status to — A“ for —Audit“ 

The losing site LMC will coordinate 
the relocation resources and schedule 

with the gaining site LMC and 
document the action in the MWO 

R equester sends the 
approved CCR to the LMC. 

When completed, LMC w ill 
report the location change in the 
MWO and c hanges the MWO‘s 

status to —A“ for —AUDIT“ 

LMC reviews the request and 
schedules the relocation whe n 

a pproved by local mana gement or 
configuration control board. 

B-1 

Requester sends the 
written Instructions to 

the ILS PA. 

Requeste r receives a written 
a uthorization from the ECS 

Contracting Officer. 

ILS PA w ill comple te the 
necessary documentation 

a uthorizing the transfer and 
provides direction to the site 

LMCs affected 

B 

Figure 23.9-4. Equipment Relocation (1 of 3) 
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Equipment Relocation (2 of 3)


YES NO 

YES NO 

ILS MC updates the MWO upon 
receipt of requested information 

ILS MC Emails the 
appropriate LMC requesting 

missing information 

ILS MC assures 
MWO is complete 

and accurate? 

ILS MC changes MWO 
status to — P — fpr 
—PROPERTY“ 

ILS PA reviews the 
MWO 

ILS P A enters the new part 
information into ILM 

Is MWO 
c omplete and 

accurate? 

ILS PA Emails the 
appropriate LMC requesting 

missing information 

ILS PA updates the MWO upon 
receipt of requeste d information 

B-2 

ILS PA archives the old 
part information into ILM 

B-1 

Figure 23.9-5. Equipment Relocation (2 of 3) 
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Equipment Relocation (3 of 3)


A failed part is replaced A failed part is replaced 
by a n ECS site spare by a ve ndor spare 

ILS PA assigns the unit dollar to 
the replacement item and archive 

the failed unit at zero dollar. 

ILS PA archives the failed part with 
the same unit dollar value a nd enters 

the new part at its purchase price. 

Change the unit dollar 
value of the part in the 

database 

A completed 
MWO 

B-2 

Figure 23.9-6. Equipment Relocation (3 of 3) 

ILS PA cha nges MWO 
status to — R“ for — RETIRE“ 

23-14 611-CD-510-001




24. Installation Planning 

The ECS Facilities Plans (DID 302-CD-003-001 to DID 302-CD-008-001) and the Installation 
Plans developed for each ECS release are the products of the facility and installation planning 
process. DAAC Facilities Plans are distributed 30 days after each Release Critical Design Review 
(CDR). These plans identify space, power, and cooling requirements based on design information 
available at CDR. The Installation Plans are distributed two months prior to installation of 
equipment at each ECS Release. As such, the Facilities Plan identifies facility preparation 
requirements and general installation planning that is based on final design information. The 
Installation Plans provide the detailed planning required by installation teams and the sites to make 
final preparation for installing Release equipment. Both documents are provided in draft to the 
DAACs for review and comment prior to publication. 

24.1 Responsibilities 

Installation planning and coordination is the responsibility of the ILS Installation Coordinator, who 
is part of the Integrated Logistics Support (ILS) Office within M&O. Using information obtained 
during site surveys, the Installation Coordinator prepares the Facility Plans and the Installation 
Plans and coordinates actions needed to prepare for and conduct the installations. DAAC M&O 
personnel support the Installation Coordinator by providing information to complete the Site 
Survey Questionnaire; reviewing the Facility Plan and the Installation Plan. They also ensure that 
site preparations/coordination are completed on schedule; facilitating receipt and installation of the 
hardware; and accepting installation of the hardware and software by signing the Installation 
Receipt Report. Work flow process charts A, A-1, and A-2 illustrate Installation 
Planning and can be located at the end of this chapter. 

24.2 Process Description 

DAAC site surveys have been previously conducted to obtain DAAC-specific information needed 
to begin the installation planning process. This information was documented in a Survey 
Questionnaire prepared for each DAAC and is used in the preparation of the Facility Plans and the 
Installation Plans. This information, plus design and equipment specifications, is used to prepare 
the Facilities Plans, which project facility requirements and provide a preliminary plan for the 
placement of systems within the DAACs. DAACs review this information and provide requested 
changes, which are considered in the preparation of the Installation Plans. 

Two months prior to the installation of hardware, a detailed Installation Plan is produced to identify 
the planned placement of hardware in the facility and how the hardware will be configured and 
networked, and to identify site preparations necessary to support the installation. Installation teams 
use the Installation Plan to install the systems and networks. After the equipment is installed and 
tested, the installation team leader obtains the DAAC Manager’s signature on the Installation 
Receipt Reports, which details the locations and equipment that have been installed and networked. 
Within three weeks following the installation, the Installations Coordinator will update the facility 
diagrams and network diagram to reflect the as-installed configuration at the site. These diagrams 
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are submitted to the ECS CCB and, when approved, becomes part of the operations baseline for 
the site and are available for viewing on the web. The baselined diagrams are provided to the site in 
the “As-Built” document provided to the DAAC shortly after the installation of hardware has been 
completed. It is the responsibility of the LMC to notify the Installation Coordinator as changes to 
the baseline documentation occur. 

Table 24.1-1. Installation Planning Activity Outline 
S t e p  Responsible Person ACTION 

1 Installation Coordinator Receive a copy of installation survey 

2 Installation Coordinator Contact vendors, define and arrange load to be 
delivered to installation site 

3 Installation Coordinator Briefing with DAAC SE and coordinate schedule 

4 Installation Team Install hardware based on Installation schedule 

5. Installation Team Test equipment 

6 Installation Coordinator Update Installation plan with revisions 

7 Installation Team Test connectivity of all devices by Pinging 

8 Installation Coordinator Update information to the plan and create a As-Built 
document consisting of SCSI Cable Management 
Schemme, Floor Plan, VCATS Hardware Report, LAN 
Cable Management Scheme, Network diagram and 
the Hardware Diagram 

9 Installation Coordinator Sends the As-Built document to DAAC Liaison while 
creating a CCR for the CCB 

10 DAAC The DAAC Liaison should provide any changes, 
deletions or addition to the As-Built document as 
quickly as possible. 

1 1 Installation Coordinator will revise and submit the CCR to the CCB 

12 Installation Coordinator Incorporate changes from CCB 

13 Installation Coordinator Send publication to Web Document Control Group 

24.3 Maintenance of Facility and Hardware Diagrams 

Facility and hardware diagrams reflect the as-installed configuration. The baseline version of these 
diagrams is maintained by the ILS Installations Coordinator. As changes to these diagrams occur 
(e.g., relocation of equipment within the site, additions/deletions to the LAN), the LMC will 
inform the ILS Installations Coordinator by redlining the diagrams. The Installations Coordinator 
will update the Computer Aided Drawing (CAD) system to reflect the change(s) and provide an 
updated facility drawing to the site’s LMC. The Installation Coordinator will create a CCR and 
present the changed documents to the CCB for approval to change the baselined document. 
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24.4 Maintenance of LAN Cable Management Scheme 

Within three weeks of the completed hardware installation, a LAN Cable Management Scheme is 
supplied to the DAAC LMC by the ILS Installations Coordinator. This matrix will identify the 
cable number, type, length, decibel loss rating, and location of cables installed; and will identify 
the IP addresses of the equipment connected by the cables. The LMC will update this matrix as 
LAN changes occur and send the changes to the Installations Coordinator. The Installation 
Coordinator will create a CCR and present the changed documents to the CCB for approval to 
change the baselined documents. 

24.5 Maintenance of SCSI Cable Management Scheme 

Within three weeks of the completed hardware installation, a SCSI Cable Management Scheme is 
supplied to the DAAC LMC by the ECS Installations Coordinator. This matrix will identify the 
cable number, length, location of cables installed; and will identify the equipment connected to the 
cables. The LMC will update this matrix as LAN changes occur and send the changes to the 
Installations Coordinator. The Installation Coordinator will create a CCR and present the changed 
documents to the CCB for approval to change the baselined documents. 
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Installation Process (1 of 3)Ä

Daac Liason reviews the documents and 
schedule for approval or a request  to 
change and sends to ILS Installation 

Coordinator. 

ILS Installation Coordinator sends 
the approved documents and 

schedule to the Installation Team 

ILS nstallation Coordinator 
incorporates the 

and sends to the Daac Liason 

A-1 

ILS Installation Coordinator uses the information 
from the Site Survey, plus design and equipment 
specifications to prepare the Facility and 
Installation Plans. 

ILS Installation Coordinator provides a preliminary 
plan of the project facility requirements and 
placement of systems and schedule to the Daac 
personnel. 

Documents and schedule are 
approved? 

YES NO 

Daac Liason sends approval 
back to ILS Installation 
Coordinator 

DAAC personnel assists with a DACC specific Site 
Survey stionnaire and sends to the ILS Installation 
Coordinator. 

I
changes/requests 

Que

A 

Figure 24.5-1. Installation Process (1 of 3) 
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Installation Process (2 of 3)Ä

Installation Team installs the 
systems and networks at the DAAC 
based on the Installation Plan and 
schedule 

Installation Team tests the installed 
equipment at the DAAC 

Does the installation 
work? 

After the equipment is installed and tested, 
the Installation Team's Leader obtains the 
DAAC Manager's signature on the 
Installation Receipt Reports. 

Installation Team informs ECS 
Installation Coordinator of the 
discrepancies and revisions needed.. 

ILS Installation Coordinator updates information to 
the plan and creates a As-Build document consisting 
of the following information 
SCSI Cable Management 
Floor Plan 
Hardware Report 
Cable Management Plan 
Network Diagram 
Hardware Diagram 

ILS Installation Coordinator updates 
the Installation Plan with revisions. 

ILS Installation coordinator sends the 
revised Installation Plan and schedule 
to the Installation Team 

Refer 
to A-1

A-2 

A-1 

Figure 24.5-2. Installation Process (2 of 3) 
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Installation Process (3 of 3)Ä

Installation Coordinator sends the 
As-Built document to DAAC 

Liaison and creates a CCR for the 
CCB 

DAAC Liaison reviews the As-Built 
document and provides any changes, 
deletions or addition to the As-Built 

document as quickly as possible 

DAAC Liaison sends the revised 
As-Built document to the ILS 

Installation Coordinator. 

ILS Installation Coordinator revises the As-
Built document to board the floor plan, 

cable management plan, hardware diagram 
and SCSI cable management plan to the 

CCB 

ILS Installation  Coordinator 
incorporates changes from CCB 

ILS Installation Coordinator sends 
publication to Web Document 

Control Group 

Installation Completed 

A-2 

Figure 24.5-3. Installation Process (3 of 3) 
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25. COTS Training 

The procedures to request COTS training have been developed based on these sources: DID 622 
ECS Training Plan DID 611-CD-001-005 ECS Mission Operations Procedure, M&O Certification 
Plan 626-CD-001-005, Section 3, 4 of the ECS M&O Position Description DID 607-CD-001-002. 
The ECS System Support Office (SSO) Operations Trainer arranges for COTS training by working 
with the COTS Training Coordinator, the ILS Manager, as well as the potential students. 

The Activity Checklist in Table 25.1-1 outlines the role of the COTS Training Coordinator and the 
section number where details for performing the tasks can be found. 

Table 25.1-1. COTS Training - Activity Checklist 
Task Section 

DAAC’s SMC. SSO, ILS, and ECS Development submit requests 
for COTS Training 

25.1 

Forward request to ILS Manager 25.2 

Arrange for equipment and classroom space 25.2 

Ensure that initial registration will be filled or arrange for 
cancellation without penalty 

25.3 

Maintain COTS training records 25.4 

Monitor DAAC COTS training budget 25.5 

25.1 Requesting COTS Training 

The COTS Training Coordinator must request training to initiate the following procedures at least 
30 days prior to the desired training date. The procedures are accomplished in the following 
order: 

a. The COTS Training Coordinator requests training using COTS Training Request Format 
via cc:mail to the ECS (SSO) Operations Trainer, the COTS Training Request Format must 
include the following information: 

• Student(s) name and DAAC representation 
• Training need 
• COTS course requested 
• Dates preferred 
• Price of COTS course 
• Manager approving purchase of training 
• Course location 
• Duration of course 
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b. EDS (SSO) Operations Trainer) verifies that the training request meets the following 
criteria: 
• Relates to an ECS M&O function 
• Relates to COTS product in the ECS system design 
• Is cost effective and within budget constraints 

c. COTS Training Coordinator determines the proposed training details, including the 
following: 
• Training vendor 
• Individual or group training, based on cost effectiveness 
• On-site or off-site class location 
• Available vendor training dates 

d. (All COTS training must be approved by both the ECS (SSO) Operations Trainer and the 
ILS Manager prior to procurement.) COTS Training Coordinator forwards the training 
request to the ECS (SSO) Operations Trainer for approval, once approved by the ECS 
(SSO) Operations Trainer, it is then forwarded to the ILS Manager. The ILS Manager will 
either approve or deny the request. 

e. COTS Training Coordinator maintains record of approval of training purchase. 

25.2 Coordinating COTS Training 

If the ILS Manager approves the request for COTS training, the COTS Training Coordinator will 
provide all vendor training details to the COTS Purchasing Manager. The COTS Purchasing 
Manager produces the purchase order and provides a copy to the COTS Training Coordinator, who 
will then order the training from the vendor. The procedures to coordinate training are 
accomplished in the following order: 

a. When approved, the COTS Training Coordinator submits all training details to the COTS 
Purchasing Manager. 

b. The COTS Training Coordinator orders training from the vendor. 

c. Purchasing Manager processes the purchase order and provides a copy to the COTS 
Training Coordinator. 

d. The COTS Training Coordinator forwards the purchase order to the vendor to reserve 
training. 

e. The COTS Training Coordinator generates a notice to students that includes training 
vendor, course, date(s), other relevant information. 

f. For on-site training, COTS Training Coordinator makes necessary arrangements for 
classroom space and equipment configuration; coordinates use of any operational 
equipment required for course, with on-going operations; forwards site location details to 
vendor instructor. 

g. Students attend training. 
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h. Prior to Group COTS training, the COTS Training Coordinator provides students with a 
COTS Training Evaluation Form, which evaluates the effectiveness of the course. In cases 
when COTS training is found to be substandard or ineffective, the COTS Training 
Coordinator contacts the ECS (SSO) Operations Trainer, ILS Manager, and the DAAC or 
site manager, together they come to a consensus as to whether or not to pursue 
compensation for the training. 

i. Depending upon the decision rendered, the COTS Training Coordinator seeks refund, 
replacement training seat, or training credit from the vendor. 

j. The COTS Training Coordinator maintains training records for the DAACs, SMC. SEO, 
ILS and ECS Development in accordance with DIDs 622 and 525. Required record fields 
include: price, student name, vendor name, course name and number, course dates, and 
location. 

k. The (COTS Training Coordinator) will forward a copy of the training record to the ECS 
(SSO) Operations Trainer in format specified by DID 622. 

25.3 Canceling/Rescheduling COTS Training 

COTS training vendors generally withhold all or part of registration fees for course seats canceled 
too close to the start date of training. The deadline for cancellation without penalty varies between 
vendors, but the maximum deadline is three weeks prior to course start date. In 
order to preserve ECS COTS training funds, any cancellations of COTS training by ECS personnel 
must be made before three weeks of the start date to avoid these financial penalties. 

•	 If student(s) need to cancel within this three-week deadline, the (DAAC or site manager) will 
be responsible for substituting an equally qualified individual to attend the course, and for 
notifying the COTS Training Coordinator to ensure proper record keeping and registration with 
the vendor. 

25.4 Maintenance of COTS Training Records 

The (COTS Training Coordinator) will maintain records of all training accomplished as specified in 
Training Plan DID-622-CD-001-005. COTS training records are maintained by the COTS 
Training Coordinator which monitors the allocation of funds and reports back to ECS (SSO) 
Operations Trainer to adjust the budget. The COTS Training Coordinator will submit training 
record information to the ECS (SSO) Operations Trainer for DID 625-CD-001-001 as specified in 
the Training Plan DID 622-CD-001-005. 

25.5 Contractor COTS Training Funds Accounting 

COTS training funds will be allocated to each ECS M&O organization, based upon staffing levels 
and functions performed at the site. The COTS Training Coordinator maintains the training budget 
spreadsheets for each of the DAAC’s, SMC, SEO, ILS and ECS M&O Development Facility. The 
COTS Training Coordinator updates the spreadsheets as training is complete and submits quarterly 
balance reports to the ECS (SSO) Operations Trainer for planning purposes. 

25-3 611-CD-510-001




While the coordination and purchasing responsibilities for COTS training fall primarily with the 
ECS COTS Training Coordinator, the ECS (SSO) Operations Trainer will be responsible to the 
M&O organization for spending the allocated COTS training budget judiciously. 

Travel funds are not included in the COTS training budget. These must be secured from the 
organization to which each student belongs. 
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26. SSIT Operational Procedures 

The SSI&T operational procedures are given in this section. They are organized by activity. The 
order in which the procedures appear loosely follows the order in which they will usually be 
performed. 

These procedures present the use of GUIs supplied in Release 4. Some procedures may have a 
command line equivalent; these are documented in the corresponding GUI help screens but are 
not presented here in the interest of simplicity. Version 2.0 Operations Tools Manual 609-CD­
003-004 should be referred to for more detailed information on how to use GUI’s and command 
line equivalent usage. 

A Note about the Order of Procedures 

The science software I&T operational procedures contained within this document are ordered. 
The order is intended to loosely suggest a logical sequence which, when used as a "road map", 
represents an overall, sensible end-to-end SSI&T activity at the Release 4 DAACs. The ordering 
cannot, however, be interpreted as a detailed, step-by-step guide to SSI&T activities. In addition, 
since there are many factors that affect the actual SSI&T activities during Release 4 (e.g. 
Instrument Team deliveries, DAAC policies, agreements between the Instrument Teams and the 
DAACs, etc.), the ordering in this document can only be suggestive. 

Many of the procedures outlined in this document are inter-related. A procedure may assume that 
another procedure has been completed. In general, the ordering of the procedures reflects this. 
The user should be aware, however, that this is not the case for all procedures. Therefore, 
depending on the SSI&T activity, the ordering suggested may not apply. Procedures may require 
other procedures that appear after the procedure requiring them. 

Assumptions 

All procedures in this paper assume the following: that the Instrument Team has delivered the 
science software to the DAAC and that Release 4 ECS is available at the DAAC. 

Conventions 

The following conventions are followed for explaining procedures: 

Text that should be typed literally in the "Action" column of the procedures is displayed in 
courier font. Text within a literal command that represents a fill-in-the-blank object is 
displayed in italic courier font. (Example: cd mydir means type "cd" and then type the 
name of the correct directory.) 

A command line in the "Action" column that should be typed in without a line break will be 
indicated by an indent in any following lines. The end of the command is indicated by 
<ENTER>, which stands for pressing the ENTER or RETURN key. 
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26.1Science Software Integration and Test (SSI&T) Preparation and 
Setup 

26.1.1 Key Operator Roles 
Science Coordinator: Provide support to Instrument Teams for the integration and testing of 
science software in the ECS system at the DAAC. Perform standard checking on all delivered 
software including source code, scripts, process control files and related documentation. 

Science Data Specialist: Serves as a point-of-contact for planning, integrating, testing, and 
operating science software. 

CM Administrator: Record, report, manage and distribute new and updated science software. 

Science Software I & T Support Engineer: Provide support to Instrument Teams for the 
development, integration, test and problem resolution of science software. 

Production Planner: Populate, maintain and schedule the production planning database for 
science software. 

MODIS Science Data Processing Software Version 2.0 System Description Manual 

This manual should be referred to for more detailed information on how to perform the SSI&T 
operational procedures as they apply to MODIS PGE’s. It covers the specific attributes for each 
individual PGE and setup criteria. 

26.1.2 COTS Software Tools 

ClearCase:  This tool is used as the ECS software configuration management tool. ClearCase 
provides a mountable file system which is used to store version-controlled data, such as source 
files, binary files, object libraries and spreadsheets. 

Distributed Defect Tracking System (DDTS): This tool is used to electronically process 
configuration change requests (CCRs). DDTS will prompt the user for relevant information, 
identify the request and will mail these requests to pre-designated personnel. 

26.1.3 General Process 

The SSI&T process consist of two activities: 
− Pre-SSI&T Activity - During this activity the Delivered Algorithm Package 

(DAP) is inspected, and tested in a non-production environment. 
− Formal SSI&T Activity - During this activity, the Product Generation 

Executives (PGEs) are integrated with the DAAC version of the SDP Toolkit 
and executed on the ECS PDPS platform. 

Key Terms: 

•	 Product Generation Executives (PGEs) - The smallest scheduled unit of science 
software. 
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•	 Delivered Algorithm Package (DAP) - An ensemble of PGE source code, 
makefile, documentation, and other related files delivered in a package from the 
SCF to the DAAC for SSI&T.. 

•	 Process Control File (PCF) - Relate logical identifiers to physical files and other 
parameters required by the PGE. 

• Strings - The processing hardware on which the science software runs. 
•	 Archive - A File Storage Type indicating that granules that will be inserted Data 

Server are intended for long term storage and acquisition for 
distribution. 

•  Collection - A related group of data granules. 
• Granule - The smallest data element which is identified in the inventory tables. 
•	 Product - A set of output values generated by a single execution of a PGE for 

archival by ECS. A PGE may generate one or more products whose attributes are 
defined by the data provider. 

• Reliability - Software reliability means that the software runs to normal 
completion repeatedly over the normal range of data inputs and running 

conditions. 
•	 Safety - Software safety means that the software executes without interfering 

with other software or operations. 

The science software in the DAPs will be integrated onto the PDPS and be used to produce the 
output data as determined by the algorithms. The refined and updated DAPs and data produced 
by the science software will eventually be provided to the subscribing user. Before the PGE is 
integrated into a production environment, extensive testing on the software must be performed. 

The following list provides a suggested, logical “road map” for getting science software tested 
and integrated into the ECS. This list is not intended to cover every situation and variations may 
be required. 

26.1.3.1 General 

•	 Science Software Integration and Test (SSI&T) is the process by which the science 
software is tested for production readiness in the DAACs in order to assure its (1) 
reliability and (2) safety. Prior to the delivery of the ECS software to the DAACs, 
SSI&T Checkout is conducted on early versions of the Products Generation Executives 
(PGEs) using separate system modes in the ECS Mini-DAAC, VATC (Verification and 
Acceptance Test Configuration), or the DAAC environments. 

•	 SSI&T activities can be broadly separated into two categories: pre-SSI&T and formal 
SSI&T. Pre-SSI&T activities are those which do not involve the ECS Planning and Data 
Processing (PDPS) or the Science Data Server (SDSRV), but the formal SSI&T activities 
do involve the full ECS including the PDPS and the SDSRV. 

•	 Most steps in the SSI&T process are inter-related and some steps may assume that 
another step has been completed. The ordering of the steps is very important but it 
cannot, however be interpreted as a detailed, step-by-step guide to SSI&T activities. 
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•	 Science Software Integration and Test consists of the following activities most of which 
are fully detailed in Science Software Integration & Test Operational Procedures for the 
ECS Project (162-TD-001). 

•	 The activities described in the following list are also depicted in a (SSI&T Process Flow 
Diagrams 1 and 2) see Figure 26.1.3.1-1 and Figure 26.1.3.1-2. For a better quality 
depiction of these diagrams, refer to the Science Office Instruction No. SO-1-003 at the 
Web site listed in the next section below. 

Figure 26.1.3.1-1. SSI&T Process Flow Diagrams 1 

26.1.3.2 Science Office Project Instructions 

The following are procedures listed from Science Office Project Instructions as they apply to the 
building of Science Data Products and SSI&T. A review of these documents is highly 
recommended at this time . They can be accessed from the Web using the following URL: 

http://dmserver.gsfc.nasa.gov/proj_instr/sopi_index.html 
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Science Office ECS Project InstructionsÄ

Number Subject Issue DateÄ

SO-1-002 Earth Science Data Type Generation Procedures PDF 5/11/98 

SO-1-003 Science Software Integration and Test (SSI&T) PDF 9/14/98 

SO-1-004 Science Office Science Support Internal Processes PDF, 

Science Office Science Support Internal Processes (161-IT-003-001)PDF 6/30/98 

SO-1-005 Product Specific Attribute (PSA) Analysis PDF 7/23/98 

SO-1-006 PGE Testing PDF 7/07/98 

SO-1-007 Earth Science Data Types Testing and Integration PDF 7/24/98 

SO-1-008 QA Metadata Update Tool (QAMUT) PDF 7/23/98 

SO-1-009 Metadata Works PDF 7/23/98 

SO-1-010 ECS Science Metadata Valids Update Procedures PDF 7/24/98 

SO-1-011 Metadata-Process Established with MODIS PDF 8/20/98 

26-5 611-CD-510-001




Figure 26.1.3.1-2. SSI&T Process Flow Diagrams 2 

26.1.3.3 Pre-SSI&T Activities 

1	 As the DAP is delivered to a DAAC by the Instrument Team for SSI&T, the PGE listing 
documentation is reviewed. 
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2	 The DAP is acquired and unpack and the documentation (i.e., packing list, readme, etc.) 
checked. The DAP contents are further checked by the Science Data Specialist to verify that 
the contents match the packing list, agreed-upon directory structures are employed, location 
of files are correct, and all intended files and directories are present. 

3	 The Science Data Specialist requests that the CM Administrator place the DAP under 
Configuration Management control using ClearCase. 

4	 The SSI&T team checks the science software for standards compliance using the Process 
Control File Checker to check process control files (PCF), and the Prohibited Function 
Checker to check source files. Extract and check prologs. 

5	 The SSI&T team builds the science software into PGEs using the SCF version of the SDP 
Toolkit. Compile all source code. Link object code with appropriate libraries. . If the SMF 
files compile successfully, then proceed to Step 11 below; otherwise. the problem needs to be 
fixed and a successful compile must occur before proceeding further. This may require one 
or more of the following: 

6 Note any error messages and review the included documentation to ensure a proper compile; 

7 Check environmental variables; 

8 Review the setup files for proper directories and variables; 

9 Make corrections and recompile. 

10	 If the executable builds successfully, proceed to Step 12. If the build fails, it may necessary 
to do one or more of the following before proceeding: 

11 Check environmental variables; 

12 Make corrections and repeat the build. 

13 Run the PGE from the Command Line. 

14	 If it the execution is successful, then the output files (products) are checked using the SSIT 
Manager file comparison tools; otherwise, one or more of the following needs to be done 
before proceeding: 

15 Check error logs; 

16 Check environmental variables; 
17 Review and source the setup files; 
18	 If necessary files are missing, then review the PCF file to ensure the existence of correct 

reference directories. 

19	 The SSI&T team runs and profiles the PGEs from the UNIX command line on the SGI, 
saving the profiling results. They will be used later when entering operational metadata into 
the PDPS. 

20 The SSI&T team collects performance statistics for the PGEs. 
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21	 The SSI&T team examines the output log files from the PGE runs for any anomalous 
message. The SSI&T team compares the output product data with the delivered test data 
using the file comparison tools. If the products do not match the delivered test outputs 
(expected outcome), the outputs should be analyzed and the PGE must be re-run. If the 
products match the delivered test outputs then 

22	 Steps 10 through 13 are repeated once using the DAAC Toolkit. If the products generated 
with the DAAC Toolkit match the delivered test output, formal SSI&T may begin. 

23 SSI&T team reports any science software problems using the DDTS NCR process. 

24  The SSI&T team reports any ECS problems using the DDTS NCR process. 

25  The SSI&T team collects and logs all lessons learned. 

26.1.3.4 Formal SSI&T Activities 
1	 For each ESDT used by the PGE, construct an ESDT ODL file for updating the PDPS or 

verify that they already exist. ESDT ODL files are also needed for all input and output data 
granules. 

2	 Construct a PGE ODL file for updating the PDPS database. This involves using the 
delivery PCF to construct an initial PGE ODL template file, which must then be hand edited 
to add required metadata. A mapping between logical IDs in the PCF and ESDT 
ShortNames must be known before this step is done. 

3	 Install ESDTs on the Science Data Server if verification indicates that they do not already 
exist. Installation links the PGE to all input and output ESDTs which allows the PGE to run 
within the PDPS. The Advertising Server must also receive notification of the update. If this 
fails then the ESDT’s must be re-installed again after removing original ESDT’s from the 
SDSRV. Note: While installing ESDT’s the SDSRV intermittently coredumps. To clean-up 
you must remove the ESDT from ADSRV, SBSRV and DDICT and then try again. 

4	 The SSI&T Metadata is updated (PGE & ESDT Object Description Language or ODLs are 
created). This supplies metadata to the PDPS database 

5	 If the Metadata update is successful, then the Operational Metadata is updated; otherwise, the 
ESDT ODL files may have to be checked for correctness before updating the Operational 
Metadata. 

6	 Register the PGEs with associated data in the PDPS database. This step uses the PGE ODL 
from step 22 above. 

7	 For each input dynamic data granule needed by the PGE, construct a Target MCF and insert 
it to the Science Data Server. 

8	 For each input static granule needed by the PGE, construct a Target MCF and insert it to the 
Science Data Server. 

9 Assemble the SSEP (as a tar file) and Insert it to the Science Data Server. 

10 Initiate a Production Request (PR) that will result in one or more DPRs. 
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11 Use the Planning Workbench to plan the PR and hence, run the PGE. 

12	 Monitor the PGE run using AutoSys. The PGE’s progress is monitored using the AutoSys 
COTS. The distinct steps that are visible on the AutoSys GUI and whose success is evident 
are Resource Allocation (.Al), Staging (.St), Pre-Processing (.Pr), Execution of the PGE 
(.EX), Post-processing (.Ps), De-staging (.Ds), and De-Allocation of resources (.Da). 

13	 If any of the steps in the execution is not successful, then each failure must be identified and 
corrected before proceeding to the next step. 

14	 Examine the output Production History File from the PGE runs for any anomalous messages. 
Compare the output product data with the delivered test data using the file comparison tools. 
. If any of the steps in the execution is not successful, then each failure must be identified and 
corrected before proceeding to the next step. 

15	 If the output files match the test output files and they are in Hierarchical Data Format (HDF), 
they are visualized using the EOSView tool, or the Interactive Display Language (IDL) tool. 
If the files are not HDF, then IDL is used. 

16	 Using the Planning subsystem, initiate more complex Production Requests if chaining is 
required. 

17	 Using electronic or hard media transfer methods, distribute the data products to the 
Instrument Teams for their review. 

RECORDS 

A weekly SSI&T status report is provided to NASA. This report contains the Performance 
Measurement Data. 

PERFORMANCE MEASUREMENTS 

SSI&T PGEs planned vs. actually delivered, pre-tested, and integrated is the metric used to 
monitor the effectiveness of the process described in the Procedure. Additionally, the Duration of 
Effort Required to Integrate in Work Days is used. 

26.1.4 Preparation and Setup 

1 Log into one of the AIT Sun workstations by typing: username then press the Enter key. 

2 Enter the password then press the Enter key. 

Prior to the remote login, enter setenv DISPLAY <local workstation IP address>:0.0 where 
the local workstation IP address represents the IP address you where you are located. 

You may need to setup the terminal so that the remote host is displayed on your screen. (Sun 
machine) This is done by clicking on the Application Manager icon (the file drawer 
located at the bottom of the screen), followed by the Desktop Tools icon, followed by the 
Terminal Console icon 

3 Perform a remote login by typing rlogin [host] then press the Enter key. 

The Enter Password prompt is displayed. 
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4 Enter the password then press the Enter key. 

5	 Enter the directory where the setup script is located by typing cd [directory name] then press 
the Enter key. 

6 Source the setup script by typing source [script name] then press the Enter key. 

The setup script contains directory paths, sets of alias commands, and tools for SSI&T. 

•	 For example, source the SSI&T script: Type source 
/usr/ecs/{MODE}/CUSTOM/utilities /.buildrc <RETURN> 
Note: This step only needs to be done once per login. 

•	 source .buildrc may not be supported on a particular software drop. Therefore the 
SSI&T scripts will be built into other another script. 

7	 To ensure access to the multi server environment when needed, the following generic login 
commands have been established and should be used routinely: 

• From a terminal: xterm -n (host) & 

• From the xterm invoked: telnet (host) 

• login cmts1 

• pw: ecsu$er 

•	 dce_login DCE_user_name DCE_password and then press Enter Key. 
DCE is an acronym for a Distributed Computing Environment. 

• setenv DISPLAY …..:0.0 

8	 Listed are some of the GUI tools, typical servers (examples and their Host that need to be 
considered for activation when conducting SSI&T: 

• ECS Assistant, ADSRV/DM/IOS, p0ins02, 

• ECS Assistant, SDSRV/DSS, p0acs03 

• ECS Assistant, DPS, p0sps06 

• ECS Assistant, SBSRV/CSS/IOS, p0ins01 

• SSIT Manager tools, AITTL/DPS t1ais01 

• Production Request, PLS, odyssey 

•	 Planning Workbench, PLS, odyssey 
Note: NETSCAPE should be closed to allow for a full screen GUI to be 
activated. 

• Monitor PGE, odyssey 

9	 A second xterm should be activated with the same login procdures so as to monitor the (log 
files) when entering SSI&T files from GUI’s. 

10	 Servers can be brought down in any order. To bring them backup requires that they be 
brought up in a sequential order to ensure connectivity, the order is listed as follows: 
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• STMGT, MSS, DDIST, IOS, SDSRV, PDPS 
11	 The above servers have unique hosts assigned. Each host needs to be logged into the generic 

login: ID, pw:, dce_login DCE_user_name DCE_password and then press Enter Key. 
before activating ECS Assistant to carryout the downing and bringing up of servers assigned 
to their respective hosts. 

26.1.5 SSIT Software Operating Instructions: 

Starting the SSIT Manager GUI: 

On workstation x0ais##, at the UNIX prompt in a terminal window, type as in step 1 
below your user id and password. 

NOTE: The x in the workstation name will be a letter designating your site: 
g = GSFC, m = SMC, l = LaRC, e = EDC, n = NSIDC, o = ORNL, a = ASF, j = JPL; the 

## will be an identifying two-digit number (e.g.,g0ais01 indicates a Data Processing 
Subsystem (DPS) workstation at GSFC). 

Prior to the rlogin, enter setenv DISPLAY <local_workstation IP address>:0.0. The 
<ipaddress> is the ip address of x0ais##, and xterm is required when entering this 
command on a Sun terminal. 

1	 Example: Log into an Algorithm and Test Tools (AITTL) environment using using a 
machine so configured. At the PVC this machine is p0ais01. A special host has been 
established using the id: and password:. Type: setenv DISPLAY ….:0.0 

2  Login to DCE (dce_login <DCE_user_name DCE_password and then press Enter 
Key.>) 

What the user must do before trying SSIT functionality: 

3	 setenv <mode> : (cd /usr/ecs/<MODE>/CUSTOM/utilities Note that this only has to be 
done once per login. 

4	 This directory should contain scripts pertaining to setting the environment for SSIT 
Manager. Type in: EcDpAtMgrStart <mode> & 

• This invokes the SSIT Manager GUI which should be displayed. 

What must be done via SSIT tools: 

Since SSIT is just a calibration of various tools, there is no specific order for 
which they must be run. Most tools can be brought up from the SSIT Manager 
GUI as well as started on their own. 

The File menu provides the capability to exit the manager. The Tools menu provides access 
to the various tools that make up SSIT. The Run menu is customizable (allowing you to add 
your own scripts and tools) by editing the file ssit_run_menu in the data/DPS directory. 

The checklist (first window on the GUI) allows you to check off various activities by double 
clicking on them. You may enter a commentary on the activity in the second window when 
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checking off a particular item. The file checklist.sample in the data/DPS directory can be 
edited to change the items in the checklist or its’ location. 

26.1.6 Updating the Leap Seconds and the Earth Motions files 
The toolkit requires Leap Second and Earth Motion updates, weekly and twice weekly 
respectively, to accurately compute most time conversions. The following scripts have been 
established to accomplish these tasks as part of ECS support. 

• update_leapsec.sh 
This script updates the leapsec.dat file by ftp-ing to USNO and reformatting the information into 
the leap seconds file: $PGSHOME/database/common/TD/leapsec.dat 
The present script, after obtaining the required file “tai-utc.dat” in the same Series 7 mentioned 
above, invokes PGS_TD_NewLeap, a C program that performs the actual update work. The 
function puts the current date in the header of the new leapsec.dat, with a remark that the file was 
either "Checked" (no new leap second) or "Updated" (new leap second). The date at which the 
USNO file used in the updating process was put on their server is also listed in the header. 

• update_utcpole.sh 
This script updates the utcpole.dat file on the basis of new data obtained by ftp to the U.S. Naval 
Observatory in Washington, D.C (USNO). Their data file is excerpted and the required fields are 
reformatted and written into the utcpole file: $PGSHOME/database/common/CSC/utcpole.dat 

• The Leap Seconds file: 
leapsec - 	file ID: $PGSHOME/database/common/TD/leapsec.dat 

(Atomic time from International Earth Rotation Service) 

Introduced every 12 to 24 months, announced almost 6 months in advance or as little as 
90 days notice. Update available from U.S Navy Observatory (USNO). 

Interval of update recommend: weekly, except Sundays 17:45 hours to 17:55 
Eastern US time. Runtime is approximately 30 seconds. 

• The Earth Motion file: 
utcpole – file ID: $PGSHOME/database/common/CSC/utcpole.dat 

(Record of the Earth’s variable of slowing rotation with respect to UTC Time.) 
Interval of update recommended: Twice weekly except Sundays 17:45 hours 
to 17:55 Eastern US time. Recommended scripts be run in the afternoon or 
evening each Tuesday and Thursday. 

26.1.7 Script Name: update_leapsec.sh 

The following processing tasks are carried out automatically by the use of this 
script: 

•	 Update via: Ftp to USNO, “maia.usno.navy.mil” file accessed for leapsec: tai- 
utc.dat. (Tests connectivity by using “ping’) 
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•	 Function to be applied: PGS_TD_NewLeap, excerpts and reformats the new 
information and appends new data and date to leapsec.dat file. A remark that the 
file was either “Checked” (no new Leap second) or “Updated” (new leap second). 
26.2.2 Script Name: update_utcpole.sh 

The following processing tasks are carried out automatically by the use of this script 

•	 Update via: Ftp to USNO, “maia.usno.navy.mil” file accessed for utcpole: 
finals.data. (Tests connectivity by using “ping’) 

Function to be applied: PGS_CSC_UT1_update, excerpts and reformats the new 
information and appends new data to utcpole.dat file. 

Guidelines: 
1	 The script must be run on a machine that has the Toolkit mounted and which can access the 

USNO site via ftp and access e-mail. (p0spg01 used at the Performance Verification Center 
(PVC)) 

2	 For each installed Toolkit (including all modes, such as debug, F77, F90, etc.) the scripts 
need to be run only once, even if different platforms or operating systems are run. However, 
if entirely separate Toolkits exist at your installation, with different $PGSHOME home 
directories, then either the scripts need to be run in each, or the data files can be propagated 
from a primary Toolkit to the others. 

3	 It is highly desirable to have outgoing e-mail mounted on the machine of choice, so that error 
messages may be issued automatically from the scripts in case of failure. 

4	 If the updating process fails, then the script must be rerun. The Toolkit team should be 
contacted anytime the scripts are not giving the correct or accurate It is highly desirable to 
have outgoing e-mail mounted on the machine of choice, information. The 2 sets of scripts 
do also send an email message to SDP Toolkit mail address when a script fails 

5	 The Toolkit requires that the two data files not be too stale. Therefore the useful lifetime of 
the utcpole.dat and leapsec.dat files is 83 days. The Toolkit will issue an error message if no 
update was performed beyond 83 days. If this occurs you can expect geolocation accuracy to 
deteriorate to an extent that could require re-running for some of the more stringent users. If 
Tookit requires a leap second value after this date, an error message will be returned. This 
generally means that production will cease. 

6	 Keep the Latest files until your updates are completed! They are useful for a backup should 
they be needed. 
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Hardware Needed and Setup Procedures 

The user’s environment needs to be set up by running the script $PGSBIN/pgs-dev-env.csh or 
$PGSBIN/pgs-dev-env.ksh, depending on the shell being used. $PGSBIN stands for 
$PGSHOME/bin/mach, where “mach” stands for one of: sun5, sgi64, sgi, sgi32, ibm, dec, or hp. 
In other words it is a shorthand for the machine “flavor” you are using, and for sgi, the compiler 
option. Not all versions are necessarily at each DAAC or SCF, and in some cases the path may 
be more complicated. For example, at Goddard Space Flight Center DAAC, typical binary 
directories are /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/bin/sgi64_daac_f77/, or 
/usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/bin/sgi64_daac_f90_debug/, for example. 

Once the setup script is located and sourced, $PGSBIN is defined and your path includes it. 
Furthermore, a “PCF”, or process control file, $PGS_PC_INFO_FILE is defined, which allows 
the executable functions invoked by the scripts to find the old data files, which are needed for the 
updates. 

To run the scripts successfully, you must have write permission on the data files. 

After the setup is done, just run the scripts. Both scripts (update_utcpole.sh and 
update_leapsec.sh) are located in the directory $PGSBIN, which will be in your path after the 
Setup script has been run. 

On workstation x0spg##, at the UNIX prompt in a terminal window, type source 
/data3/ecs/TS1/CUSTOM/daac_toolkit_f90/TOOLKIT/bin/sgi64/pgs-dev- 
env.csh . This will set up the various environment parameters, such as PGSHOME, 
to enable the 64 bit version of the FORTRAN 90 compiler to be run. 

NOTE: The x in the workstation name will be a letter designating your site: 
g = GSFC, m = SMC, l = LaRC, e = EDC, n = NSIDC, o = ORNL, a = ASF, j = JPL; the 

## will be an identifying two-digit number (e.g.,g0spg03 indicates a Science 
Processor Subsystem workstation at GSFC). 

Prior to the rlogin, enter setenv DISPLAY <local_workstation IP address>:0.0. The 
<ipaddress> is the ip address of x0spg 

Example: To Update the Latest Leapsec.dat and Utcpole.dat files perform the following 
steps: 

telnet to a machine that supports the Toolkit. (telnet p0spg01)

login: ID, Password:Ä
setenv DISPLAY ….:0.0Ä
setenv PGSHOME /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkitÄ
cd /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/bin/sgi_daac_f77 then

source pgs_dev-env.cshÄ
For leapsec: cd /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/database/common/TDÄ
cp leapsec.dat leapsec.dat_oldÄ
Know thread for Leap Second run: 
cd /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/src/TD  then do ls – select: 

update_leapsec.sh or run script for Leap Second type in: update_leapsec.sh 
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A successful update will look like the following 
P0spg01{cmops}[288]->update_leapsec.sh 
Status of PGS_TD_NewLeap call was (0) 
Status of MOVE command was (0) 

1 For utcpole:Ä
2 cd /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/database/common/CSCÄ
3 utcpole.dat utcpole.dat_oldÄ
4 Know thread for utcpole run:

5  cd /usr/ecs/OPS/CUSTOM/TOOLKIT/toolkit/src/CSC  then do ls – select:


update_utcpole.sh or run script for utcpole type in: update_utcpole.sh 
6 A successful update will look like the following: 

p0spg01{cmops}[294]->update_utcpole.sh 
Status of PGS_CSC_UT1_update call was (0) 
Status of MOVE command was (0) 

26.2Science Software Integration and Test (SSIT) Manager 

26.2.1 SSIT Manager Overview 

The principal tool used during SSI&T is the SSIT Manager. The SSIT Manager is the top-level 
graphical user interface (GUI) environment presented to SSI&T personnel. Its purpose is to bring 
together the tools needed for SSI&T into a single, graphical environment. 

Across the top of the SSIT Manager are the toolbar items File, Tools, and Run. Clicking on each 
of these invokes a pull-down menu. 

Under the File pull-down menu, the only item is Exit. Clicking on this causes the SSIT Manager 
to terminate. 

The Tools pull-down menu has most of the SSIT Manager’s tools. The menu items are: 

• Code Analysis contains 

•	 SPARCwork - A COTS package provided by Sun that allows for various coding 
activities including memory checking and debugging. 

• Office Automation contains 

•	 MSWindows - a Microsoft Windows emulator with MS Office (Word, Excel, 
PowerPoint) installed. 

• Ghostview - for viewing PostScript formatted documents. 

• Netscape - WWW browser and useful for viewing HTML formatted documents. 

• Acrobat - for viewing PDF formatted documented. 

• DDTS - for entering and tracking science software problems. 
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• Standards Checkers contains 

•	 FORCHECK - for standards checking for FORTRAN 77 and Fortran 90 science 
software source code. 

•	 Prohibited Function Checker - for checking science software source code for 
prohibited functions. 

•	 Process Control File Checker - for checking Process Control Files (PCFs) 
delivered with science software. 

• Prolog Extractor - for extracting prologs from science software source code. 

• Product Examination contains 

• IDL - Interactive Data Language tool supported by Sun. SSIT puts the user in the 

IDL environment. 

• EOSView - for viewing HDF and HDF-EOS files. 

• File Comparison contains 

• ASCII - for comparing two output products that are in ASCII format. 

• Binary - for comparing two output products that are in binary format. 

•	 HDF (GUI) - for comparing two output products that are in HDF or HDF-EOS 
format, GUI version. 

•	 HDF (hdiff) - for comparing two output products that are in HDF or HDF-EOS 
format, command line tool. 

• Text Editors contains 

• Emacs 

• Xedit 

• vi 

• PDPS Database contains 

•	 PCF ODL Template - for converting delivered PCFs into ODL during PGE 
registration. 

• Check ODL - for verifying ODL syntax of ODL files. 

•	 SSIT Science Metadata Update - for updating the PDPS database with PGE 
information during PGE registration. 

•	 SSIT Opnl Metadata Update - GUI for updating the PDPS database with PGE 
information during PGE registration. 
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•	 Copy SSIT -> Production - for copying PGE registration database information 
from SSI&T mode to Production mode. 

• Data Server contains 

• Acquire DAP - for acquiring a Delivered Algorithm Package (DAP). 

•	 Get MCF - Source MCF is a Metadata Configuration File used to create a Target 
MCF (.met) for a Dynamic/Static Granule 

• Insert Static - for inserting a static data file to the Data Server. 

• Insert Test Dynamic - for inserting a dynamic test data file to the Data Server. 

•	 Insert EXE TAR - for inserting a Science Software Executable Package (SSEP) 
to the Data Server. 

•	 SSAP Editor - for editing and creating a Science Software Archive Package 
(SSAP) and inserting it to the Data Server. 

The Run pull-down menu initially contains no menu items. Its purpose, however, is to allow a 
place for SSI&T personnel to place their own custom tools and scripts. 

26.2.2 SSIT Manager GUI 

This GUI (Figure 26.2-1) is the starting point for SSI&T activities. It provides access to a 
collection of tools that will be useful for this purpose. 
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Figure 26.2-1. SSIT Manager Window 

26.2.2.1 General Set Up of the SSIT Manager 

The SSIT Manager requires a configured environment within which to run; it runs only on the 
AIT Suns. The set up steps described in this section need only be done the first time a SSI&T 
operator uses the SSIT Manager 

To set up the environment for the SSIT Manager, execute the procedure steps that follow. 
(This procedure was tested by telnet p0ais01, ID: cmts1, PW: ecsu$er, setenv DISPLAY 

155.157.123.34:0.0 or setenv DISPLAY p0ais01:0.0 . 
1 login to: dce_login DCE_user_name DCE_password and then press Enter Key. 
2 setenv ECS_HOME /usr/ecs & setenv <mode> 

26-18 611-CD-510-001




3 cp /usr/ecs/mode/CUSTOM/data/DPS/DpAtMgrInternal.pcf $HOME/mySSITpcf, 
press Return. 
1. The mode is the ECS mode in which you are operating. This mode should be TS1. 
2.	 The mySSITpcf is the file name of the private copy of the PCF that the SSI&T 

operator will use when running the SSIT Manager. The $HOME is the environment 
variable for the user’s home directory. For example, cp 
/usr/ecs/TS1/CUSTOM/data/DPS/DpAtMgrInternal.pcf $HOME/myPCF, press 
Return. 

4	 At the UNIX prompt on the AIT Sun, type setenv PGS_PC_INFO_FILE 
$HOME/mySSITpcf, press Return. (Check env for proper home path) 
3.	 The mySSITpcf is the full path name to the private copy of the PCF to be used with 

the SSIT Manager when you run it (from step 1). 
4.	 It may be useful to add this line to your .cshrc (or other start up script) so that it is set 

every time you login. 
5	 At the UNIX prompt on the AIT Sun, type cd /usr/ecs/mode/CUSTOM/utilities, press 

Return. 
5. The mode is the ECS mode in which you are operating. This mode should be TS1 or 

another mode assigned beforehand to operate in. 
6 At the UNIX prompt on the AIT Sun, type EcDpAtMgrStart <mode> & 

• This invokes the SSIT Manager GUI which should be displayed. 
• The checklist displayed within the GUI will be the default. 
6.	 This sets environment variables and other settings needed for running the SSIT 

Manager. 

26.2.2.2 Set Up of a Checklist for the SSIT Manager 

The SSIT Manager offers the capability of maintaining user-defined checklist of SSI&T 
activities. The checklist is presented in the main window of the SSIT Manager. A default 
checklist is displayed unless a new checklist is specifically created. This procedure explains how 
to set up a customized checklist. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Creating a User-Defined Checklist for the SSIT Manager: 

1 a	 From the SSIT Manager, click on the Tools menu, then choose Product Examination, then 
EOSView. 
• The EOSView GUI will be displayed. 

1 b Alternately, if EOSView isn’t available from the SSIT Manager GUI, invoke EOSView 
from the command-line. 
Go to the proper area by typing cd /usr/ecs/TS1/CUSTOM/eosview <RETURN> 
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Start EOSView by typing EOSView <RETURN> 

2	 In the GUI labeled EOSView - EOSView Main Window, click on the File menu and select 
Open. 
• The Filter GUI will be displayed. 

3	 In the subwindow labeled Filter, enter full path name and file name wildcard template. 
For example, enter /home/MyDirectory/MySubdirectory/*. 
•	 The /home/MyDirectory/MySubdirectory/* represents the location to the 

directory containing the HDF-EOS files to examine. 
•	 The asterisk (*) is a wildcard template that represents all files in that directory; 

other wildcard templates can narrow the search further, e.g. *.hdf. 
• Use the Directories field to further select the correct directory. 
•	 Files found matching the wildcard template in the chosen directory will be 

displayed in Files subwindow. 
4	 In the Files subwindow, click on the file name of the HDF-EOS file to examine. Then 

click on the OK button. 
•	 A GUI labeled EOSView - MyOutputFile.hdf will be displayed where 

MyOutputFile.hdf is the file name of the file chosen in step 3. 
• Be patient - this GUI may take some time to appear, particularly for large files. 
•	 Once displayed, a list of HDF objects will appear in the main window. If nothing 

is listed, it means that no HDF objects were found within the file. 
5	 In the GUI labeled EOSView - MyOutputFile.hdf, click on an object listed for which 

metadata is to be inspected. 
• The object selected will be highlighted. 
•	 Do not double click on object since this will cause a Dimension GUI to be 

displayed instead. 
6	 In the GUI labeled EOSView - MyOutputFile.hdf, click on the Attributes menu and select 

Global. 
• A GUI labeled EOSView - Text Display will be displayed. 
•	 The global metadata associated with the object selected (in step 5) will be 

displayed in a scrollable field. 
• If instead, the message “Contains no Global Attributes” appears, then the selected 

object contains no global metadata. 
7 Repeat steps 5 and 6 for each HDF object within the selected HDF-EOS file for which 

metadata is to be examined. 
8 In the GUI labeled EOSView - MyOutputFile.hdf, click on the File menu and select Close. 

• The EOSView - MyOutputFile.hdf GUI will disappear. 
• Be patient - this GUI may take some time to disappear, particularly for large files. 

9	 In the GUI labeled EOSView - EOSView Main Window, click on the File menu and select 
Exit. 
• The EOSView - EOSView Main Window GUI will disappear. 
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26.2.3 SSIT Manager Tools 

There are several tools that are accessible through the SSIT Manager GUI. After selecting the 
TOOLS menu option of the menu bar, a set of options is available. See Figure 26.2.3-1, which 
indicates the use of the Tool menu item. 

Figure 26.2.3-1. SSIT Manager Window - Tools Menu 

26.2.4 Using the SSIT Manager: 
The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 
2. The source file(s) are available, accessible, and have read permissions. 
3.	 The below listed formatted text (ASCII) files containing the list of prohibited functions exist 

in the directory stored in the environment variable DPATMGR_DAT: 
4. prohibitedFunctionsAda.txt 
5. prohibitedFunctions.C++.txt 
6. prohibitedFunctions.C.txt 
7. prohibitedFunctions.F77.txt 
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8. prohibitedFunctions.F90.txt 
9.	 If the source code files to be checked are in a VOB in ClearCase, a view has been set before 

the SSIT Manager was started. 

26.3Delivered Algorithm Package (DAP) - Acquiring, Unpacking, 
Subscription 
The Delivered Algorithm Package (DAP) is the vehicle by which the PGE, source code, 
supporting files, documentation, etc. are delivered to a DAAC for SSI&T. Typically, the DAP is 
a compressed TAR file with a file name of form string.tar.Z . After initial processing, the DAP is 
broken apart into its components and those components will be subsequently processed and used 
based on their intended function. 

The delivery mechanism for DAPs can be electronic (e.g. via UNIX ftp) or physical media (4 
mm or 8 mm digital audio tapes). 

26.3.1 Acquiring the Delivered Algorithm Package (DAP) 
The following procedures are used by the SSIT team to acquire DAPs. 

26.3.1.1 Acquiring the DAP via FTP 

FTP is another method that the SSIT team uses in order to receive the science software. The 
following example demonstrates the FTP of the tar file from a remote machine. 

Acquiring the DAP via FTP 
1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 

key. 
2 Enter the password then press the Enter key. 
3	 At a UNIX prompt, type cd DeliveryPathname, then press the Enter key. 

7. The DeliveryPathname is the full path name to the directory that has been set aside 
for ftp pull of DAPs from the Instrument Team. For example, cd /home/user where 
user  is the user’s login directory, then press the Enter key. 

8. If the DAP is to be copied into a subdirectory, change to this subdirectory. 
4 At a UNIX prompt, type ftp machineIPaddress, then press the Enter key. 

The machineIPaddress is the IP address or fully qualified domain name of the remote 
SCF machine. For example, ftp 192.266.53.2, then press the Enter key. 

Or for example, ftp aitg2sun.gsfc.ecs.nasa.gov, then press the Enter key. The remote 
machine will likely display some messages and then prompt for a login name. 

An ftp session is established. 
5	 At the ftp prompt on the remote machine, enter user login name, then press the Enter 

key. 
The remote machine will typically respond with 331 Password required for username: 

6 At the ftp prompt on the remote machine, enter user password, then press the Enter key. 
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9.	 The remote machine will typically respond with 230 User username logged in and 
display the ftp> prompt for further ftp commands. 

7	 At the ftp prompt on the remote machine, type cd DAPpathname then press the Enter 
key. 
10. The DAPpathname is the full path name to the directory on the remote machine 

containing the DAP to retrieve. For example, cd /home/mac , then press the Enter 
key. The directory location should be known. 

8 At the ftp prompt on the remote machine, type binary, then press the Enter key. 
11. The binary command causes subsequent file transfers to be in binary mode, 

preserving the integrity of the file to retrieve without interpretation (as would be done 
in ASCII mode. 

12. The system will typically respond with the message 200 Type set to I indicating that 
binary mode has been set. 

9	 At the ftp prompt on the remote machine, type get DAPfilename, then press the Enter 
key. 
13. The DAPfilename is the file name of the DAP to retrieve. 
14. • For example, type get TestPGE.tar, then press the Enter key. 
15. The user may need to type dir then press Enter to display a listing of the files in the 

current directory. The system will likely display several lines of messages once the 
transfer has completed. For large files, this may take a long time (minutes to hours 
depending upon the size of the DAP and the bandwidth of the connection). 

10	 At the ftp prompt on the remote machine, repeat step 9 or type quit, then press the Enter 
key. 
16. Typing quit and pressing Enter closes the ftp connection with the remote machine. 
17. Retrieve other DAP files by repeating step 9. The DAPs retrieved will reside in 

DeliveryPathname on the local machine. 
11 At the UNIX prompt type cp /home/mac/TestPGE.tar, then press the Enter key. 

18. This step will copy the DAP tar file into their working directory. 

26.3.1.2 Acquiring the DAP from the Archive after Ingest 

The insert service is used to put the DAP into the Data Server after it is ingested. Once the DAP 
is in the Data Server, the acquire service is used to retrieve it. 

DAP is acquired from Data Server and placed in the specified directory. Note there will be 2 
files, the DAP itself (a big tar file) and the metadata associated with the DAP. The metadata may 
be helpful in the creating the SSAP. 

When a DAP is inserted into the Data Server by Ingest, an email is sent to all users who 
subscribe to that event (Section 26.3.2). 

26.3.1.3 Performing a DAP Acquire Using SSIT Manager 

Generally, the preferred approach to accomplishing a DAP acquire will be through the use of the 
SSIT Manager GUI. 
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Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1	 The following servers/services are up and operational: 
Data Server, Subscription Server, Storage management 

2 The following must have occurred between those Servers/Services: 
3	 Ingest must have ingested DAP and Inserted it into the Data Server. Subscription Server 

must have gotten notification from the Data Server of the Insert. Subscription Server 
must send email to the SSIT operator notifying him/her of DAP Insertion and giving him 
(in the email) the UR of the DAP. 

4 The SSIT Manager is available

5 The X Window DISPLAY environment variable is pointing to your screen


DAP Acquire Procedures: 

1 If not already on an AIT Sun, log onto one from your current machine. 

2	 Bring up the SSIT Manager GUI. At the UNIX prompt, type mgr (if alias has been 
established) 

3	 After a short while, the SSIT Manager GUI will appear. From the SSIT Manager top menu 
bar, select Tools -> Data Server -> Acquire DAP 
See figure 26.2.3-1. If the SSIT Manager GUI is used to initiate the DAP processing, Step 4 
can be skipped. 

4 Alternately, one can initiate the DPA processing sequence from the command line. To do this 

5	 Type source /usr/ecs/TS1/CUSTOM/bin/DPS/.buildrc <RETURN> 
Note: This step only needs to be done once per login 

6 Type /usr/ecs/TS1/CUSTOM/bin/DPS/DpAtStageAlgorithmPackage.sh <RETURN> 

7 The user will be prompted with: 

** DAP Staging Tool ** 
Configuration filename? (enter for default: DpAtAA.CFG) 

To respond, type <RETURN> 

8 The user will be prompted with: 

ECS Mode of operations? (enter for default: OPS) 
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To respond, type TS1 <RETURN> 

9	 The user will be prompted with: 

Name of email message file (including path)? 

To respond, type the required file name plus the path, e.g., 
/home/diascone/emessage01.asc <RETURN> 

The user will be prompted with:


Directory to receive staged file?


To respond, type the required directory, e.g.,

/home/diascone/staged <RETURN> 

26.3.2 Unpacking a DAP 

Once a DAP has been acquired via electronic means or physical media, it typically needs to be 
unpacked before its contents are accessible for SSI&T. Several mechanisms are available under 
standard UNIX for packing and unpacking files to and from a file archive, the most common 
being UNIX tar. Another fairly typical utility is gzip and its companion, gunzip. 

The file name extension is usually an indication of the packing utility used and DAP files should 
use this convention. DAP files that have been packed using the UNIX tar utility will usually 
have .tar as a file name extension indicating a tar file. If the DAP has been further compressed 
using the UNIX compress utility, the file name extension is typically .tar.Z indicating a 
compressed tar file. For DAP files packed with the gzip utility, the .zip file name extension is 
generally used. 

When unpacking is performed on a DAP, the contents of the packed file are moved from the tar 
archive to local disk. If the DAP tar file contains directories as well as files, these directories will 
be created in the same structure as in the tar file. This structure typically reflects the directory 
structure from which the tar file was created in the first place at the SCF. Once a tar file has been 
unpacked, the original tar file will still exist unaltered. 

Unpacking a DAP 
1 Log into one of the AIT Sun workstations by typing: username then press the Enter key.

2 Enter the password then press the Enter key.

3 At a UNIX prompt, type cd UnpackPathname, then press the Enter key.

4 The UnpackPathname is the path name of the directory that has been set aside for


unpacking of DAPs. 
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5	 This directory now contains the DAP tar file. For example, cd /home/user, where user is 
the user’s login directory, then press the Enter key. 

6	 If the tar file is compressed, at a UNIX prompt, type uncompress PackedDAP.Z, then 
press the Enter key. 

7 The PackedDAP.Z is the file name of the compressed DAP file. 
•	 The file name extension of .Z is a convention indicating UNIX compressed files. 

The uncompress utility expects this file name extension by default. A resulting 
error may indicate that the DAP file was not compressed or that another 
compression utility was used. If the file name extension was .Z, the uncompressed 
version will have the same file name but without the .Z, for example PackedDAP. 

• The tar file for the SSI&T Training will not be compressed. 
8 At the UNIX prompt, type tar xvf PackedDAP, then press the Enter key. 

• The PackedDAP is the file name of the uncompressed DAP file. 
•	 The tar archive will be unpacked in the current directory. If the archive contained 

directories and subdirectories, these will be created by the tar utility and populated 
by the files that belong. 

26.4Science Software Configuration Management 
The CM Administrator and System Administrator are key players in the SSI&T process. The 
CM Administrator receives the science software from the Science Data Specialist, places these 
files into a directory and request that the System Administrator place the files under 
configuration control by using the ClearCase tool. The science software is then tested by the 
SSI&T team and once the science software has successfully been tested, and upon direction from 
the CCB, the files are distributed to the Production Planner for placement on production server. 

The CM and System Administrator need a good understanding of the ClearCase tool. ClearCase 
will be used to create a view, create a new directory, import files into the temporary 
subdirectories, and check-in and check-out files. 

26.4.1 ClearCase Overview 

All data managed under ClearCase are stored in Versioned Object Bases (VOBs), which are the 
“public” storage areas and Views, which are the “private storage areas. VOBs are data structures 
that can only be created by the CM administrator using the mkvob (“make vob”) command. A 
VOBs is mounted as a file system and when viewed through a view, it appears as a standard 
UNIX directory tree structure. This file system, accessed through its mount point, has a version­
control dimension which contains file elements and versions of file elements. Once reviewed, 
the System Administrator will place these files under configuration control. In order to 
accomplish this task, a view must be created in ClearCase. A view is necessary in order to make 
visible and accessible files and directories that have been checked in to a VOB. 

Data that are under configuration management in ClearCase are said to be “checked in”. In order 
to alter a checked-in data element (e.g. a file) to make a newer version of it, the data element 

26-26 611-CD-510-001




must first be “checked out”. Once the change has been made to the checked- out version, it is 
checked in again. The VOB will then contain both versions of the data element and either can be 
retrieved at a later date. 

In general, executable binary files, object files, and data files should not be checked into 
ClearCase. Binary and object files are not stored efficiently in ClearCase; data files for software 
may be extremely large and a VOB is typically not sized for this. 

Files that should be checked into ClearCase include source code, scripts, makefiles, assorted 
build and run scripts, documentation and other ASCII files. 

A Versioned Object Base is defined by the following characteristics: 

A mountable file system which stores version-controlled data, such as source files, binary 
files, object libraries, WYSIWYG documents, spreadsheets and anything which can 
be stored in the UNIX file system. 

Can be mounted on some or all workstations 
Several VOBs may exist on a machine or on different machines on a network. 
When mounted as a file system of type MFS, a VOB can be accessed with standard 

UNIX and ClearCase tools. 
The ClearCase file system is transparent. 
Created by the CM administrator 

A VOB is comprised of: 

Storage area for versioned files, derived objects and cleartext files. 
Database (live, shadow and log file). 

26.4.2 Creating a View in ClearCase 

In order to make files and directories that are in a ClearCase VOB visible and accessible a 
ClearCase view must set. A ClearCase view need only be created once. Once created, the view 
can be set at the beginning of each user session. Multiple views for a single user may be created. 

In order for the SSI&T tools under the SSIT Manager to have access to the ClearCase VOB, the 
ClearCase view must be set before the SSIT Manager is run. 

A view is defined by the following characteristics: 

A working context for an individual developer or closely coordinated group.

Can be used to access any VOB or multiple VOBs.

Selects versions of VOB directories and files to display.

Allows developer to work without interfering with other developers.

Not a set of files but a way of seeing shared elements.

Each user may have multiple views for new development, bug fixing or porting activities.


A view is comprised of: 

View storage area (typically in a local machine) - private storage for checked-out files, 
derived objects and private files. 
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Configuration Specification - set of rules which determine the version of a file the view 
will see. 

View-tag - Name given to the view (ex. angies_view), view-tags are registered in 
/urs/adm/atria/view_tags. 

Objects stored in a view: 
Checked-out versions of file elements. 
Unshared derived objects. 

The ClearCase procedures can either be run from the UNIX command line or from the File 
Browser Screen. The SSI&T Training will only cover the UNIX command line procedures. The 
corresponding GUI procedures are included in the Training Material for future reference. 

The following procedure not only will create a view, but will also allow creation of a 
subdirectory where new science software files may be stored. 

Assumptions: 

1. ClearCase is available. 
2. A Versioned Object Base (VOB) has been created 

26.4.2.1 Creating a View in ClearCase Using Command Lines 
1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 

key. 

2 Enter the password then press the Enter key. 

3 At a UNIX prompt type cleartool lsview, then press the Enter key. 

19. The lsview command displays the pathname to the storage location of the views. 

4	 At a UNIX prompt type cleartool mkview -tag ViewName ViewPath/ViewName.vws, 
then press the Enter key. 

The ViewPath is the full path to the directory where views are stored. 

The ViewName is the user selected name for the view. The file name for the view must 
end in “.vws”. 

For future reference, the corresponding ClearCase GUI procedures are included in the following 
section. 

26.4.2.2 Creating a View in ClearCase using the File Browser Screen 

Selecting a view listed in the View Tag Browser screen brings up the File Browser, or main 
screen, shown in Figure 26.4.2-1. 

Displays the directory name of the current VOB, just below the toolbar. 
Displays the content of the directory in the space below the directory’s name. 
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Figure 26.4.2-1. ClearCase File Browser Screen (Main Screen) 
Procedures 
1	 The user should log into one of the AIT Sun workstations by typing: username then 

press the Enter key. 
Cursor moves to the Password field. 

2 Type the password then press the Enter key. 
3	 Invoke ClearCase by typing xclearcase & on the UNIX command line then press the 

Enter key. 
• The ClearCase Transcript screen is displayed as the View Tag Browser loads. 
• The ClearCase View Tag Browser screen is displayed listing available views. 

4	 To create a view for checking in the software change package, select a known View and 
press the Enter key. 
• The File Browser window is displayed. 

5 Select File→Execute→Single Command. 
• The String Browser window is displayed. 
The prompt Enter shell command to run is displayed. 

6	 Invoke the make view command by typing mkview [filename] on the UNIX command 
line and press the Enter key. 
• The tempdisp window appears. 
• The View [filename] Created Successfully and the Cache Updated for View 

[filename] prompts are displayed. 
7 Close the tempdisp window by clicking on the window and press the Enter key. 

• The tempdisp window closes. 
8 Select View →List from the menu. 

• The View Tag Browser is displayed. 
9 Find the new view by scrolling through the list until the new view is observed. 
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26.4.3 Setting a View in ClearCase 

In order to make files and directories that are in a ClearCase VOB visible and accessible, a 
ClearCase view must be set. Only one view can be set (active) at a time. 

26.4.3.1 Setting a View in ClearCase Using Command Lines 
1 Log into one of the AIT Sun workstations by typing: username then press the Enter 

key. 

2	 At a UNIX prompt type cleartool setview ViewName where ViewName is the user’s 
view created in the previous section, then press the Enter key. 

26.4.3.2 Setting a View Using the File Browser Screen in ClearCase 
1 Log into one of the AIT Sun workstations by typing: username then press the Enter 

key. 

Cursor moves to the Password field. 
2 Type the password then press the Enter key. 
3 Invoke ClearCase by typing xclearcase & on the UNIX command line then press the 

Enter key.

The ClearCase Transcript screen is displayed as the View Tag Browser loads.

The ClearCase View Tag Browser screen is displayed listing available views.


4	 To set a view, select a known View and press the Enter key. 
The File Browser window is displayed. 

5	 Select File→Execute→Single Command. 
The String Browser window is displayed. 
The prompt Enter shell command to run is displayed. 

6	 Invoke the set view command by typing setview ViewName on the UNIX command line 
and press the Enter key. 
ViewName is the name of the view to set. 

26.4.4 Creating a New Directory 

In cases where a new directory needs to be created and placed in ClearCase, the user will activate 
ClearCase and create a new directory. This type of procedure is necessary only if a new 
directory is required. 

The following is a list of tools, and or assumptions: 

1. A VOB has been created at the UNIX directory. 

2. A view has been created. 

• Creating a New Directory in ClearCase Using Command Lines 
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1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 
key. 

2 Enter the password then press the Enter key. 

3 At a UNIX prompt type cleartool setview ViewName, then press the Enter key. 

The ViewName is the user’s view. 

4 At a UNIX prompt type cleartool lsvob, then press the Enter key. 

This command lists all the VOBs and allows the identification of the SSI&T VOB. 

5 At a UNIX prompt type cd pathname, then press the Enter key. 

The pathname is the full path name of the parent directory in the VOB in which the new 
directory is to be added. 

6 At a UNIX prompt type cleartool checkout -nc . then press the Enter key. 

This command checks out the current directory. Note the dot for the directory. 

The -nc is a keyword used when no comments are to be made for this action. 

7 At a UNIX prompt type cleartool mkdir -nc dirname, then press the Enter key. 

The dirname is the name of the new directory being created. 

8 At a UNIX prompt type cleartool checkin -nc dirname, then press the Enter key. 

This command checks in the new directory named dirname. 

9 At a UNIX prompt type cleartool checkin -nc . then press the Enter key. 

This command checks in the current directory. 

26.4.4.2 Entering a New Directory Using the File Screen Browser into ClearCase 

1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 
key. 

Cursor moves to the Password field. 

2 Type the password then press the Enter key. 

3	 Invoke ClearCase by typing xclearcase & on the UNIX command line then press the 
Enter key. 

• The ClearCase Transcript screen is displayed as the View Tag Browser loads. 

• The ClearCase View Tag Browser screen is displayed listing available views. 
4	 Select File→Execute→Single Command. 

The String Browser window is displayed. 
The prompt Enter shell command to run is displayed. 
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5	 Invoke the make directory element by typing mkdir [filename] on the UNIX command 
line and press the Enter key. 

6	 Invoke the make element command by typing mkelem [directory name] on the UNIX 
command line and press the Enter key. 

7	 Type into the directory input box of the File Browser the name of the directory in the 
VOB to be checked out, press the Enter key, then follow the menu path 
Version→Checkout→Reserved: no comment. 

•	 In order to add new files to ClearCase, the directory in which the files are to be added 
must be checked out first. 

•	 ClearCase forces the checkout onto a maintenance branch to isolate the maintenance 
activity. 

•	 If someone else has already checked out the directory, permission to check out the 
directory is denied. A separate shell window is displayed. 

8	 Cancel the checkout of the element if it is decided that no changes are to be made by 
typing into the directory input box of the File Browser the name of the directory to be 
checked in, press the Enter key, then follow the menu path 
Version→Uncheckout→Unreserved: no comment, 

9	 On the File Browser screen, follow the menu path File→Exit. 
The ClearCase Graphical User Interface session is closed. 

26.4.5  Importing files into ClearCase 

Once the user has created a directory to place the science software files, ClearCase can be used 
to place a single file or multiple files in a UNIX directory structure under CM. 

The following is a list of tools, and or assumptions: 

1. A VOB and subdirectory are created to hold these files. 
2. No object files or executables exist in the source code directory. 
3. The PGE was received with a directory structure that contains various types of files. 
4.	 These files will be entered into ClearCase and will maintain the same directory structure 

as the delivery structure. 

26.4.5.1 Importing a Single File into ClearCase 
Procedure: 
1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 

key. 
Cursor moves to the Password field. 

2 Type the password then press the Enter key. 
3	 At a UNIX prompt, type cleartool setview ViewName, press Enter 

The ViewName is the name of the ClearCase View. 
4 At the UNIX prompt, type cd pathname, then press the Enter key. 
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The pathname is the full path name of the subdirectory in the VOB into which the file is 
to be checked in. 

If the desired directory cannot be seen, it could mean that the view has not been set or the 
properties of the view do not allow the directory to be seen; check with the CM 
Administrator. 

5	 At a UNIX prompt, type cp pathname/filename ., press Enter (note the space and then 
“dot” at the end of the command). 
The pathname is the full path name to the directory where the file to be checked in exists 

and filename is the file name of the file to be checked in. 
This command copies a file over into the VOB area in preparation for checking it in. 

6	 At the UNIX prompt, type cleartool checkout -nc ., press Enter (note the space and then 
“dot” at the end of the command). 
This command checks out the current directory (represented by the “dot”) from 

ClearCase. 
Adding a new file (or element) to a directory represents a modification of the directory. 

Hence, the directory must be checked out before a file can be checked in. 
7 At a UNIX prompt, type cleartool mkelem -nc filename, then press the Enter key. 

The filename is the name of the file that was copied over in step 5 and is the file that will 
be checked into ClearCase. 

This command creates a ClearCase element from the file in preparation for checking it in. 
The -nc flag means “no comment”; it suppresses ClearCase from prompting for a 

comment to be associated with the make element step. 
8	 At the UNIX prompt, type cleartool checkin -nc filename, then press the Enter key. 

The filename is the name of the file to be checked into ClearCase. 
This command performs the check in of the file. 
The -nc flag means “no comment”; it suppresses ClearCase from prompting for a 

comment to be associated with the checkin step. 
9	 At the UNIX prompt, type cleartool checkin -nc ., press Enter (note the space and then 

“dot” at the end of the command). 
This command checks in the current directory (represented by the “dot”) into ClearCase. 
The adding of an element (here, a file) represents a modification to the directory and 

hence, the new version of the directory must be checked back in. 
The -nc flag means “no comment”; it suppresses ClearCase from prompting for a 

comment to be associated with the checkin step. 

26.4.5.2 Importing Multiple Files into ClearCase 

The DAP for the synthetic PGE contains only one source code module and a minimal number of 
other files. A real PGE will generally contain many source files, header files, and multiple other 
types of files stored in a standard type of directory structure which is retained when the PGE is 
packed into the tar file. The script provided by ClearCase is used for the purpose of making 
another load script to enter all of the DAP files along with the directory structure at one time. 
The final step of running the load script can only be performed by the DAAC Administrator. 
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The following procedure explains how to place the entire contents of a UNIX directory structure 
under ClearCase. A UNIX directory structure refers to all the files and subdirectories under some 
top-level directory. 

This procedure is geared toward science software deliveries. In such cases, science software is 
delivered in the form of a UNIX tar files. A tar file has been unpacked (untar-red) and the 
contents are to be placed under ClearCase configuration management. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

The following is a list of tools, and or assumptions: 

1. A VOB and subdirectory are created to hold these files. 
2. A ClearCase view is not required to perform this procedure. 

Importing Multiple Files Into ClearCase 

1 At a UNIX prompt, type cd ParentPathname, then press the Enter key 

The ParentPathname is the path name of the directory that contains the directory 
structure to be brought into ClearCase. This is not the VOB. 

2 At the UNIX prompt, type clearcvt_unix -r DirName, then press the Enter key. 

The DirName is the name of the directory in which it and everything below it is to be 
brought into ClearCase. 

A conversion script will be then be created. The -r causes all subdirectories to be 
recursively included in the script created. 

3	 Contact the VOB Administrator and request that the utility script cvt_script be run on the 
script created in step 2. 

The VOB Administrator is the only one who can run the cvt_script because it modifies 
the VOB. 

4	 At this time the user logs out from this workstation. The VOB Administrator completes 
the procedure. 
The remaining steps are accomplished by the VOB Administrator. 

5	 The VOB Administrator logs into the AIT Sun workstation by typing username then 
press the Enter key. 
Cursor moves to the Password field. 

6 Type the password then press the Enter key. 

7	 Invoke ClearCase by typing xclearcase & on the UNIX command line then press the 
Enter key. 
The ClearCase Transcript screen is displayed as the View Tag Browser loads. 
The ClearCase View Tag Browser screen is displayed listing available views. 

8	 To create a view for checking in the software change package, select a known View and 
press the Enter key. If you are using an existing view, select the desired existing view 
and proceed to step 14. 
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The File Browser window is displayed. 
9 Select File→Execute→Single Command. 

The String Browser window is displayed. 

The prompt Enter shell command to run is displayed. 

10	 Invoke the make view command by typing mkview [filename] on the UNIX command 
line and press the Enter key. 

The tempdisp window appears. 

The View [filename] Created Successfully and the Cache Updated for View 
[filename] prompts are displayed. 

11 Close the tempdisp window by clicking on the window and press the Enter key. 

The tempdisp window closes. 

12	 Select the VOB where the software change package is to be imported then press the 
Enter key. 

13	 To create a subdirectory for the software change package in that VOB, which is a 
modification to the parent directory (for the VOB) the parent directory must be checked 
out by following the menu path Version→Checkout→Reserved: no comment. 
In order to add new files to ClearCase, the directory in which the files are to be added 

must be checked out first. 

ClearCase forces the checkout onto a maintenance branch to isolate the maintenance 
activity. 

If someone else has already checked out the directory, permission to check out the 
directory is denied. 

A separate shell window is displayed. 

14	 Start a shell process in a separate window by clicking on the shell icon button of the File 
Browser toolbar. 

A separate shell window is displayed. 

15 To run the script, type cvt_script then press the Enter key. 

The VOB Administrator is the only person who can run the cvt_script because it 
modifies the VOB. 

16	 To check in the new directory, type into the directory input box of the File Browser 
screen: path [where path is the full path identification for the new directory 
(directoryname)], then press the Enter key. Then select Versions→Checkin from the 
menu. 

17	 To check in the parent directory (for the VOB), type into the directory input box of the 
File Browser screen: VOBpath (where VOBpath is the full path identification for the 
parent directory), then press the Enter key. Then select Versions→Checkin from the 
menu. 

18 On the File Browser screen, follow menu path File→Exit. 

The ClearCase Graphical User Interface session is closed. 
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26.4.6 Checking Out a File From ClearCase 

If a configured file requires modification, then the file needs to be checked out of the configured 
directory and placed in a user directory. This will allow the file(s) to be modified. 

The following is a list of tools, and or assumptions: 

1. The file or directory must be an element created in ClearCase. 
2.	 The view should be configured to ensure the correct version of the file or directory is 

seen. 

Checking Out an Element/File from the Command Line 
1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 

key. 
2 Enter the password then press the Enter key. 
3	 At a UNIX prompt type cleartool setview ViewName, then press the Enter key. 

The ViewName is the name if the user’s view. 
4 At a UNIX prompt type cleartool checkout -nc element then press the Enter key. 

20. The element  is the name of the file or directory that is to be checked out. 
21. The -nc flag means “no comment” which will suppress the ClearCase prompting for a 

comment to be associated with the check out step. 

Checking Out an Element/File from the File Screen Browser 
1 Log into one of the AIT Sun workstations by typing: username then press the Enter key. 

Cursor moves to the Password field. 
2 Type the password then press the Enter key. 
3 Invoke ClearCase GUI by typing xclearcase & on the UNIX command line then press 

the Enter key.

The ClearCase Transcript screen is displayed as the View Tag Browser loads.

The ClearCase View Tag Browser screen is displayed listing available views.


4	 To check out the directory where the controlled files were place, type into the directory 
input box of the File Browser screen: path [where path is the full path identification for 
the directory (directoryname)], then press the Enter key. Then select 
Versions→Checkout from the menu. 

5	 Select File→Execute→Single Command. 
The String Browser window is displayed. 
The prompt Enter shell command to run is displayed. 

6 To determine editing privileges, type ls -l, then press the Enter key. 
A prompt displaying read/write/execute privileges will be displayed. There will be three 

groupings: 
• User Group Others 
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• r=read, w=write, x=execute 
7	 If you have editing/execute privileges, you can revise the contents of the file with any 

text editor. 
8	 To checkin a controlled file, select Versions→Checkin from the menu. 

The file/directory will be checked in to ClearCase and the version will be updated. 

26.4.7 Checking a Modified Element into ClearCase 

This procedure explains how to check in a modified element to ClearCase. An element refers to 
a directory or file in ClearCase, that is, under configuration management. Modifications made to 
a file or directory cannot be saved in ClearCase unless the file or directory had been checked out 
first. 

The following is a list of tools, and or assumptions: 

1. A VOB exits and is mounted at a known UNIX directory. 
2. A ClearCase view exists for the SSI&T operator. 
3. The element or file has been checked out and modified. 
4.	 The modified file is now in the user’s directory on the VOB from which it was checked 

out. 

26.4.7.1 Checking a Modified Element/File into ClearCase 

1	 Log into one of the AIT Sun workstations by typing: username then press the Enter 
key. 

Cursor moves to the Password field. 

2 Type the password then press the Enter key. 

3	 At a UNIX prompt, type cleartool setview ViewName, then press the Enter key. 

The ViewName is the name of the user’s view. 

4 At the UNIX prompt, type cleartool checkin -nc filename, then press the Enter key. 

The filename is the name of the file (full path name allowed) that is to be checked out 
(and later modified). 

The -nc flag means “no comment”; it suppresses ClearCase from prompting for a 
comment to be associated with the check out step. 

This command checks in the current directory. 
5	 This step is optional; it is performed when ClearCase does not accept a checkin because 

the element was not modified. In this case, the check out must be canceled. At a UNIX 
prompt, type cleartool uncheckout -nc filename, then press the Enter key. 

The filename is the name of the file or directory (full path name allowed) checked out. 

This command cancels the check out of an element/file. 
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26.5Standards Checking of Science Software 
The purpose of standards checking is to verify that the source files of the science software are 
compliant with the ESDIS Data Production Software Computing Facility (SCF) Standards and 
Guidelines document. 

26.5.1 Checking FORTRAN 77 ESDIS Standards Compliance 
The ESDIS Data Production Software Computing Facility (SCF) Standards and Guidelines 
document requires all FORTRAN 77 code to be compliant with the ANSI FORTRAN 77. The 
COTS used for this task is FORCHECK. 

The following is a list of tools, and or assumptions: 

Assumptions: 

1.	 The FORTRAN 77 science software source code is available, accessible, and has read 
permissions for the user. 

2. SSIT Manager is available for use. 

FORCHECK is available only on the AIT Suns. 

To check for ESDIS standards compliance in FORTRAN 77 code, execute the procedure 
steps that follow: 

1 If not already on an AIT Sun, log into one from your machine. 
22. Once logged onto proper Sun, remember to set the DISPLAY environmental variable 

to point to your X Window screen. 
2	 If required, at the UNIX prompt on the AIT Sun, type cleartool setview ViewName, 

press Return. 
23. The ViewName is the name of a view allowing the FORTRAN 77 source files to be 

accessible. 
24. This step is only necessary if any of the FORTRAN 77 source files are in ClearCase 

(in the VOB under configuration management). 

3 If your general environment setup does not include transparent access to the SSIT 
Manager GUI, then you need to set that up. One way to do it is as follows: 
25. Set up an alias, manually or from shell script, to set up preliminary environment. At 

UNIX prompt, type alias do_buildrc “source 
/usr/ecs/TS1/CUSTOM/bin/DPS/.buildrc” 

26. Set up an alias, manually or through shell script, to invoke SSIT Manager. At UNIX 
prompt, type alias do_ssit_man “/usr/ecs/TS1/CUSTOM/bin/DPS/EcDpAtMgr 
ConfigFile /usr/ecs/TS1/CUSTOM/cfg/EcDpAtMG.CFG ecs_mode TS1& “ 

4	 Set up the preliminary environment (do_buildrc). This only needs to be done once per 
session. Then, run SSIT Manager (do_ssit_man). 
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27. Type do_buildrc 
28. Type do_ssit_man 

5	 Once the SSIT Manager comes up, the following steps need to be taken to invoke 
FORCHECK 
29. From the top menu bar, select Tools. 
30. From the Tools menu, select Standards Checkers. 
31. From the Standards Checkers menu, select FORCHECK. 
32. See Figure 26.8.5-2. for a screen snapshot of this step. 

6 A separate FORCHECK window will now open. 
33. The user will be prompted for input. The first prompt will be 

global option(s) and list file? 
34. The second prompt will be 

local option(s) and file(s)? 
35. The second prompt will be repeated until there is a blank line and carriage return. 
36. In order to understand what the proper responses should be, the user is encouraged to 

find hardcopy documentation for FORCHECK or to use the UNIX man facility and 
type man forchk . 

7 At the UNIX prompt on the AIT Sun, type vi FORCHECKoutput, press Return. 
37. The FORCHECKoutput is the file name for the output file produced in step 6. 
38. The FORCHECKoutput file will contain any warnings, errors, and other messages 

from FORCHECK. A summary will be at the bottom of the file. 
39. Any text editor may be used for this procedure step. 

8 At the UNIX prompt on the AIT Sun, type vi ListFile, press Return. 
40. The ListFile is the file name for the list file specified at the FORCHECK prompt. 
41. The ListFile file will contain FORCHECK messages similar to the 

FORCHECKoutput file embedded in the source code listing. 
Any text editor may be used for this procedure step. 

26.5.2 Checking for ESDIS Standards Compliance in Fortran 90 
This procedure describes how to use the Fortran 90 compiler flags on the SPR SGI machines to 
check science software written in Fortran 90 for ESDIS standards compliance. 

Unlike with FORTRAN 77, no COTS tool is used to check Fortran 90 science software. Instead, 
this procedure describes how to use the compiler to perform the checking (ESDIS standards for 
Fortran 90 are ANSI). Since the Fortran 90 compiler is used, the checking for standards 
compliance can be naturally tied in with building the science software (since this procedure will 
produce object files suitable for linking). However, in this procedure, the building of the 
software (compiling and linking) is deferred to a later procedure. 
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Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1.	 The Fortran 90 science software source code is available, accessible, and has read 
permissions for the user. 

2. Required Status Message Facility (SMF) files have been compiled. 

3. The C shell (or a derivative) is the current command shell. 

4. The Fortran 90 compiler is available on the SPR SGI. 

To check for ESDIS standards compliance in Fortran 90 code, execute the procedure steps 
that follow: 

1 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SPR SGI. 

• Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SPR SGI. 

2 At the UNIX prompt on the SPR SGI, set up the proper environment for the compiler to be 
used by typing source ToolkitPathname /bin/sgiXX/pgs-dev-env.csh . 

• ToolkitPathname is the home directory of the desired SDP Toolkit version . 
• The directory sgiXX should be replaced with sgi32 or sgi64 as appropriate for the 

specific compiler desired. 
•	 For example, on the mini-DAAC platform p0spg01, type source 

/data3/ecs/TS1/CUSTOM/daac_toolkit_f90/TOOLKIT/bin/sgi64/pgs-dev­
env.csh . This will set up the various environment parameters, such as 
PGSHOME, to enable the 64 bit version of the FORTRAN 90 compiler to be run. 

3 If required, at the UNIX prompt on the SPR SGI, type cleartool setview ViewName, press 
Return. 

• The ViewName is the name of a view allowing the Fortran 90 source files to be 
accessible. 

• This step is only necessary if any of the Fortran 90 source files are in ClearCase (in 
the VOB under configuration management). 

4 At the UNIX prompt on the SPR SGI, type cd SrcPathname, press Return. 
• The SrcPathname is the full path name to the location of the Fortran 90 source 

files to be checked. 
• The SrcPathname will be in the ClearCase VOB is the Fortran 90 source files are 

checked into ClearCase. 
5 At the UNIX prompt on the SPR SGI, type f90 -c -ansi [-I$PGSINC] [-I$HDFINC] [[-

IOtherIncFiles]…] SourceFiles >& ReportFile, press Return. 
•	 The terms in square brackets ([ ]) are used to optionally specify locations of 

include and module (.mod) files. The $PGSINC already contains the SDP Toolkit 
include directory and $HDFINC already contains the HDF include directory. The 
OtherIncFiles represents one or more additional include or module directories. 
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• The SourceFiles is a list (space delimited) of Fortran 90 source files or a wildcard 
template (e.g. *.f90). 

• The >& is a C shell construct that causes standard error (where the output from the 
Fortran 90 compiler normally emerges) to be redirected to a file. 

• The ReportFile is the file name under which to save the results of the compile 
process. 

• The -c flag causes only compilation (no linking). 
• The -ansi flag enables ANSI checking. 
• Apply the terms in square brackets only as necessary. Do not include the brackets 

in the actual command. See example below. 
• Do not use the -I option for include or module files that are in the standard 

directories or in the current directory. 
• The makefile for the science software may contain the names of additional include 

files needed by the software. 
• For example, type f90 -c -I$PGSINC -I$HDFINC -I/ecs/modis/pge5/include/ 

*.f90 >& pge10.report, press Return. 
6 At the UNIX prompt on the SPR SGI, type vi ReportFile, press Return. 

• The ReportFile is the file name for the compilation results as produced in step 5. 
• Any text editor may be used for this procedure step. 

26.5.3 Checking for ESDIS Standards Compliance in C 
This procedure describes how to use the C compiler flags on the SPR SGI machines to check 
science software written in C for ESDIS standards compliance. 

Unlike with FORTRAN 77, no COTS tool is used to check C science software. Instead, this 
procedure describes how to use the compiler to perform the checking (ESDIS standards for C are 
essentially ANSI). Since the C compiler is used, the checking for standards compliance can be 
naturally tied in with building the science software (since this procedure will produce object files 
suitable for linking). However, in this procedure, the building of the software (compiling and 
linking) is deferred to a later procedure. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1.	 The C science software source code is available, accessible, and has read permissions 
for the user. 

2. Required Status Message Facility (SMF) files have been compiled. 

3. The C shell (or a derivative) is the current command shell. 

• The C compiler is available on the SPR SGI. 
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To check for ESDIS standards compliance in C code, execute the procedure steps that 
follow: 

1	 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SPR SGI. 
Alternatively, in any currently available xterm window, spawn a new session: type xterm 
&, press Return. Then telnet to the SPR SGI. 

2 	 At the UNIX prompt on the SPR SGI, type setenv PGSHOME ToolkitPathname, press 
Return. Then type, source $PGSHOME/bin/sgiX/pgs-dev-env.csh, press Return. 
The ToolkitPathname is the home directory of the desired SDP Toolkit version. 
The sgiX refers to the appropriate processor. For example, type source 
$PGSHOME/bin/sgi/pgs-dev-env.csh, press Return. 

3	 If required, at the UNIX prompt on the SPR SGI, type cleartool setview ViewName, 
press Return. 
The ViewName is the name of a view allowing the C source files to be accessible. 
This step is only necessary if any of the C source files are in ClearCase (in the VOB 
under configuration management). 

4	 At the UNIX prompt on the SPR SGI, type cd SrcPathname, press Return. 
The SrcPathname is the full path name to the location of the C source files to be 
checked. 
The SrcPathname will be in the ClearCase VOB is the C source files are checked into 
ClearCase. 

5	 At the UNIX prompt on the SPR SGI, type cc -c -ansi [-I$PGSINC] [-I$HDFINC] [[-
IOtherIncFiles]…] SourceFiles >& ReportFile, press Return. 
The terms in square brackets ([ ]) are used to optionally specify locations of include and 
module (.mod) files. The $PGSINC already contains the SDP Toolkit include directory 
and $HDFINC already contains the HDF include directory. The OtherIncFiles 
represents one or more additional include directories. 
The SourceFiles is a list (space delimited) of C source files or a wildcard template (e.g. 
*.c). 
The >& is a C shell construct that causes standard error (where the output from the C 
compiler normally emerges) to be redirected to a file. 
The ReportFile is the file name under which to save the results of the compile process. 
The -c flag causes only compilation (no linking). 
The -ansi flag enables ANSI checking. 
Apply the terms in square brackets only as necessary. Do not include the brackets in the 
actual command. See example below. 
Do not use the -I option for include files that are in the standard directories (e.g. 
/usr/include) or in the current directory. 
The makefile for the science software may contain the names of additional include files 
needed by the software. 
For example, type cc -c –ansi-I$PGSINC -I$HDFINC -I/ecs/modis/pge5/include/ *.c 
>& pge10.report, press Return. 

6	 At the UNIX prompt on the SPR SGI, type vi ReportFile, press Return. 
The ReportFile is the file name for the compilation results as produced in step 5. 

26-42 611-CD-510-001




Any text editor may be used for this procedure step. 

26.5.4 Checking for ESDIS Standards Compliance in Ada 
This procedures describes how to use Ada compilers on the SPR SGI machines to check science 
software written in Ada for ESDIS standards compliance. 

Unlike with FORTRAN 77, Fortran 90, or C, Ada compilers are subjected to a validation process 
by the DoD Ada Committee. Thus, any code that compiles successfully by a validated compiler 
is, by definition, fully ANSI compliant. Since the Ada compiler is used, the checking for 
standards compliance can be naturally tied in with building the science software (since this 
procedure will produce object files suitable for linking). However, in this procedure, the building 
of the software (compiling and linking) is deferred to a later procedure. 

26.5.4.1 Checking for ESDIS Standards Compliance in Ada: Verdix COTS 

This procedure describes compiling Ada software using the COTS Verdix Ada Development 
System (VADS) which provides a complete environment for building (and developing) Ada 
software. See the gcc compiler in compiling Ada code. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1 . 	 The Ada science software source code is available, accessible, and has read 
permissions for the user. 

2. The C shell (or a derivative) is the current command shell. 

• The Ada compiler is available on the SPR SGI. 

To check for ESDIS standards compliance in Ada code, execute the procedure steps that 
follow: 

1 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SPR SGI. 

• Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SPR SGI. 

2	 If required, at the UNIX prompt on the SPR SGI, type cleartool setview ViewName, 
press Return. 

•	 The ViewName is the name of a view allowing the Ada source files to be 
accessible. 

•	 This step is only necessary if any of the Ada source files are in ClearCase (in the 
VOB under configuration management). 
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3 At the UNIX prompt on the SPR SGI, type setenv SGI_ABI -32, press Return. 
• This command sets the environment variable SGI_ABI for 32-bit mode 

compilation. 
4 At the UNIX prompt on the SPR SGI, type cd SrcPathname, press Return. 

•	 The SrcPathname is the full path name to the location of the Ada source files to be 
checked. 

• The SrcPathname will be in the ClearCase VOB if the Ada source files are 
checked into ClearCase. 

5 At the UNIX prompt on the SPR SGI, type a.mklib, press Return. 
•	 This command creates a VADS library directory. All Ada compilation must occur 

in a VADS Ada library. 
6	 At the UNIX prompt on the SPR SGI, type a.make -v -f SourceFiles >& ReportFile, 

press Return. 
•	 The SourceFiles is a list (space delimited) of Ada source files or a wildcard 

template (e.g. *.ada). 
•	 The >& is a C shell construct that causes standard error (where the output from the 

Ada compiler normally emerges) to be redirected to a file. 
•	 The ReportFile is the file name under which to save the results of the compile 

process. 
• The -v flag enables verbose output. 
• The -f flag indicates that what immediately follows are the source files. The order 

of the flags is therefore important. 
7 At the UNIX prompt on the AIT Sun, type vi ReportFile, press Return. 

• The ReportFile is the file name for the compilation results as produced in step 6. 
• Any text editor may be used for this procedure step. 

26.5.4.2 Checking for ESDIS Standards Compliance in Ada: GNU gcc 
Compiler 
This procedure describes compiling Ada software using the GNU C compiler, gcc. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1 . 	 The Ada science software source code is available, accessible, and has read 
permissions for the user. 

2. The C shell (or a derivative) is the current command shell. 

The GNU gcc compiler is available on the SPR SGI. 
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To check for ESDIS standards compliance in Ada code, execute the procedure steps that 
follow: 

1	 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SPR SGI. 

•	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SPR SGI. 

•	 It is recommended that this procedure begin within a new command shell on the 
SPR SGI. 

2	 If required, at the UNIX prompt on the SPR SGI, type cleartool setview ViewName, 
press Return. 

•	 The ViewName is the name of a view allowing the Ada source files to be 
accessible. 

• This step is only necessary if any of the Ada source files are in ClearCase (in the 
VOB under configuration management). 

3 At the UNIX prompt on the SPR SGI, type setenv SGI_ABI -32, press Return. 
• This command sets the environment variable SGI_ABI for 32-bit mode 

compilation. 
4 At the UNIX prompt on the SPR SGI, type cd SrcPathname, press Return. 

•	 The SrcPathname is the full path name to the location of the Ada source files to be 
checked. 

•	 The SrcPathname will be in the ClearCase VOB is the Ada source files are 
checked into ClearCase. 

5	 At the UNIX prompt on the SPR SGI, type gcc -c -gnat83 SourceFiles >& ReportFile, 
press Return. 

•	 The SourceFiles is a list (space delimited) of Ada source files or a wildcard 
template (e.g. *.ada). 

•	 The >& is a C shell construct that causes standard error (where the output from the 
gcc compiler normally emerges) to be redirected to a file. 

•	 The ReportFile is the file name under which to save the results of the compile 
process. 

• The -c flag causes only compilation (no linking). 
• The -gnat83 enables compilation of Ada using the 1983 Ada Standard. Note that 

without this flag, the compiler would assume the 1995 Ada proposed Standard. 
6 At the UNIX prompt on the SPR SGI, type vi ReportFile, press Return. 

• The ReportFile is the file name for the compilation results as produced in step 5. 
• Any text editor may be used for this procedure step 

26.5.5 Prohibited Function Checker 
The use of certain functions in the PGE is prohibited. The Prohibited Function Checker (Figure 
26.5.4-1) is used to check C, FORTRAN 77, FORTRAN 90, and Ada language source files for 
the occurrence of functions that are prohibited in the ECS DAAC production environment. 
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26.5.5.1 Checking for Prohibited Functions: Command-Line Version 

This procedure describes using the command-line version of the Prohibited Function Checker to 
check science software for the prohibited functions. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1.	 The source files to be checked are available, accessible, and have read permissions 
for the operator. 

2.	 Source files to be checked are Ada, C, FORTRAN 77, Fortran 90, C shell, Korn shell, 
Bourne shell, or Perl and have recognizable file name extensions. 

To check for prohibited functions in delivered source files, execute the procedure steps that 
follow: 

1	 If required, at the UNIX prompt on an AIT Sun, type cleartool setview ViewName, press 
Return. 

• The ViewName is the name of a view allowing the source files to be accessible. 
• This step is only necessary if any of the source files are in ClearCase (in the VOB 

under configuration management). 
2 At the UNIX prompt on the AIT Sun, type cd SrcPathname, press Return. 

•	 The SrcPathname is the full path name to the location of the source files to be 
checked. 

•	 The SrcPathname will be in the ClearCase VOB if the source files are checked 
into ClearCase. 

•	 The SrcPathname can contain other directories that contain source files and/or 
more directories. The Prohibited Function Checker will search out all source files 
in subdirectories recursively. 

3	 At the UNIX prompt on the AIT Sun, type 
/data3/ecs/TS1/CUSTOM/bin/DPS/EcDpAtMgrBadFunc ConfigFile 
/data3/ecs/TS1/CUSTOM/cfg/EcDpAtBA.CFG FilesOrDirectories > ResultsFile, 
press Return. 

•	 The FilesOrDirectories is a list of source file names or directory names of 
directories containing source files. 

• The ResultsFile is the file name for the results that are output. 
•	 For example, type /data3/ecs/TS1/CUSTOM/bin/DPS/EcDpAtMgrBadFunc 

ConfigFile /data3/ecs/TS1/CUSTOM/cfg/EcDpAtBA.CFG main.c utils/ > 
myOutput, press Return. Here, main.c is a source file and utils/ is a directory 
that contains other source files. 

4 At the UNIX prompt on the AIT Sun, type vi ResultsFile, press Return. 
• The ResultsFile is the file name for the output results as produced in step 3. 
• Any text editor may be used for this procedure step. 
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Figure 26.5.5-1. Prohibited Function Checker 
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Prohibited Function Checker GUI 
1	 From the SSIT Manager, select Tools → Standards Checkers → Prohibited Function 

Checker from the menu. 
The Prohibited Function Checker GUI will be displayed. 

2 In the Prohibited Function Checker GUI, click on the Analyze button. 
The File Selector GUI will be displayed. 

3 Within the Directories subwindow, double click on the desired directory. 
Repeat this step until the directory with the source files to be checked are displayed in the 

Files subwindow. 
4 Within the Files subwindow, click on the source files to be checked. Each file clicked on 

will be highlighted. 
To choose groups of contiguous files, hold down the left mouse button and drag the 

mouse. 

To choose non-contiguous files, hold down the Control key while clicking on file names. 
5 In the File Selector GUI, click on the OK button. 

The File Selector GUI will disappear. 

The files selected in step 5 will be displayed in the Prohibited Function Checker GUI 
window as they are being checked. 

6 In the Prohibited Function Checker GUI, click on the Report button. 
The Report GUI will be displayed. 

For each file, a list of prohibited functions found will be displayed. 
7 Optionally, click on the Print button or the Save button. 

Choose Save to save the results to a file; choose Print to have the results printed on the 
default printer. 

Choosing Save will bring up a GUI labeled Save To File. Specify the directory and file 
name in which to save the results file. 

8	 Optionally, in the Prohibited Function Checker GUI, highlight one of the source files 
listed. Then click on View. 
The Source Code GUI will be displayed. 

Occurrences of prohibited functions found in that source file will be highlighted. 

Click on the Next button to bring into the window successive occurrences of prohibited 
functions (the Next button does not bring in the next source file). 

Click on the Done button to close the Source Code GUI. Other source files may be 
examined similarly, one at a time. 

9 In the Prohibited Function Checker GUI, click on the Quit button. 
The Prohibited Function Checker GUI will disappear. 

This ends the session. 
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Figure 26.5.5-2. Invoking the Prohibited Function Checker 

26.5.6 Checking Process Control Files 
The next task to accomplish is to check that the PCFs are syntactically correct and contain all 
necessary information for PGEs to run within the ECS DAAC production environment. Only 
one PCF can be associated with a PGE. The following procedure describes how to check PCFs 
for valid syntax and format, both using the GUI and the command line interface. 

26.5.6.1 Checking Process Control Files GUI 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 
2. The Process Control File(s) are available, accessible, and have read permissions. 

If the source code files to be checked are in a VOB in ClearCase, a view has been set before the 
SSIT Manager was started. 
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Checking Process Control Files GUI 
1	 From the SSIT Manager, select Tools → Standards Checkers → Process Control File 

Checker from the menu, see Figure 26.5.6-1. 

Figure 26.5.6-1. Process Control File Checker GUI 

The Process Control File Checker GUI will be displayed. 

2 In the Directories subwindow, double click on the desired directory. 

Repeat this step until the directory with the PCF(s) to be checked are displayed in the 
Files window. 

Use the Filter subwindow to limit which files are displayed. 

3 Within the Files subwindow, click on the PCF to be checked. 

The file clicked on will be highlighted. 

Only one PCF can be checked at a time. 

4	 Click on the Check PCF button. 

A GUI labeled PCF Checker Results will be displayed. 

Results will be displayed in this window. 

5 Optionally, click on the Save button or on the Print button. 

Choose Save to save the results to a file; choose Print to have the results printed on the 
default printer. 

Choosing Save will bring up a GUI labeled Save To File. Specify the directory and file 
name in which to save the results file. 
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Choosing Print and then clicking on the OK button will send the results to the default 
printer. 

6 Click on the Check Another button or on the Quit button. 

Choosing Check Another allows another PCF to be checked. Repeat steps 2 through 5. 

Choosing Quit causes the Process Control File Checker GUI to disappear and ends the 
session. 

26.5.6.2 Checking Process Control Files: Command-Line Version 

This procedure describes using the command-line version of the Process Control File Checker to 
check process control files delivered with the science software. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1.	 The PCF files to be checked are available, accessible, and have read permissions for 
the operator. 

2.	 You will need the command pccheck.sh. One way to see if this is available is to type 
which pccheck.sh, press Return. If a path is displayed, then the directory is in your 
path. On the mini-DAAC Sun platform p0ais01, the pathname for the command is 
/ecs/formal/TOOLKIT/bin/sun5/pccheck.sh . In this case, you will have to set a 
ClearCase view to access that area. 

To check Process Control Files, execute the procedure steps that follow: 

1	 If required, at the UNIX prompt on an AIT Sun, type cleartool setview ViewName, press 
Return. 

•	 The ViewName is the name of a view allowing the Process Control File(s) to be 
accessible. 

•	 This step is only necessary if any of the Process Control Files are in ClearCase (in 
the VOB under configuration management). 

2 At the UNIX prompt on AIT Sun, type cd PCFpathname, press Return. 
•	 The PCFpathname is the full path name to the location of the Process Control 

File(s) to be checked. 
•	 The PCFpathname will be in the ClearCase VOB if the Process Control Files are 

checked into ClearCase. 
3	 At the UNIX prompt on an AIT Sun, type /ecs/formal/TOOLKIT/bin/sun5/pccheck.sh 

-i PCFfilename > ResultsFile, press Return. 
•	 The PCFfilename is the full path name (directory and file name) to the Process 

Control File to check. 
• The ResultsFile is the file name for the results that are output. 
•	 The PCF Checker is also available on the SPR SGI machines. The easiest way to 

access it is to set a SDP Toolkit environment (any will do for purposes here, see 
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Section 9.2) and type $PGSBIN/pccheck.sh -i PCFfilename > ResultsFile, press 
Return. 

4 At the UNIX prompt on the SPR SGI, type vi ResultsFile, press Return. 
• The ResultsFile is the file name for the output results as produced in step 4. 
• Any text editor may be used for this procedure step. 

26.5.7 Extracting Prologs 
The Project standards and guidelines are contained in the latest version of the document Data 
Production Software and Science Computing Facility (SCF) Standards and Guidelines (423-16­
01). This ESDIS document mandates that science software delivered to the DAACs to be 
integrated into the ECS contain prologs in the source files. Prologs are internal documentation 
containing information about the software. The details are specified in the ESDIS document. 
Prologs must be at the top of every function, subroutine, procedure, or program module. 

This procedure describes using the Prolog Extractor to extract prologs into a file. Note that the 
prolog extractor only extract the prologs it finds. It does not check the contents of prologs. 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 
2.	 Prologs are assumed to be delimited by particular delimiters depending on the 

language type. Delimiters are listed in the table below: 

Prolog Delimiters 

Language Type Delimiter 

FORTRAN 77 source !F77 

Fortran 90 source !F90 

C source !C 

Ada source !Ada 

FORTRAN 77 include !F77-INC 

Fortran 90 include !F90-INC 

C include !C-INC 

Any Language any !PROLOG 

All Languages The end delimiter is always !END 
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The Prolog Extractor recognizes the language type of the file by its file name extension. 
The table below lists assumed file name extensions: 

File Name Extensions 

File Type File Name Extensions 

FORTRAN 77 f, f77, ftn, for, F, F77, FTN, FOR 

Fortran 90 f90, F90, f, F 

FORTRAN 77/Fortran 90 include inc, INC 

C c 

C/C++ header h 

Ada a, ada 

26.5.7.1 Extracting Prologs 

The Prolog Extractor can be started from the UNIX prompt. To do this, at the UNIX prompt on 
the AIT Sun, type /data3/ecs/TS1/CUSTOM/bin/DPS/EcDpAtMgrPrologs, press Return 

or 

1	 From the SSIT Manager, select the Tools → Standards Checkers → Prolog Extractor 

from the menu. 

An xterm will be displayed on the AIT Sun. 

Select the default ConfigFile. The output goes to a file called Prologs.txt in the directory 
from which the SSIT Manager was started. 

The Prologs.txt file can be viewed by changing directories to the SSIT Manager directory 
and invoking a text editor. The file may also be sent to a printer. 

2	 At the Files(S)? (-h help) prompt, type in the file names and/or directory names 
containing the files. 

Separate items with spaces. 

The contents of the directory will be search recursively for files with valid file name 
extensions. 

Use ./ to indicate current directory. 

The time needed for the Prolog Extractor could be very long for large numbers of files 
and directories. 

When extraction is complete, the message Output written to file: ./prologs.txt will be 
displayed. 
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3 At the program prompt Hit Enter for another, ”q <Enter>“ to quit: , press Enter to 
repeat process with another set of source files or type q and press Enter to quit. 

• The xterm will disappear. 

4 At a UNIX prompt on the AIT Sun, type vi prologs.txt, then press the Enter key. 

The extracted prologs file, named prologs.txt, will be brought into the editor. 

The default location of the prologs.txt file is the directory from which the SSIT Manager 
was invoked. 

5 Once the extracted prologs file has been examined, exit the editor. 

Figure 26.5.7-1. Prolog Extractor Sample Run. 

26.6Compiling and Linking Science Software 
Science software to the DAACs is in the form of source files. In order to be run and tested 
within the ECS, this science software has to be compiled and linked to form the binary 
executables that run within the PGEs. Science software is developed at independent Science 
Computing Facilities (SCFs) using the SDP Toolkit. The SDP Toolkit allows science software 
to be developed for ECS at independent SCFs. Once delivered to the DAACs for SSI&T, 
science software needs to be compiled and linked to one of the SDP Toolkit versions resident at 
the DAAC. The (PCFs) Process Control Files provide the interface between the science 
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software and the production system in the ECS. Since the process control files delivered to the 
DAACs for SSI&T were created and used at the SCFs, the path names in the PCF will need to be 
checked and revised to work at the DAACs. 

To save time for the SSI&T Training Lesson, the compile and link with the SCF Version of the 
Toolkit will be omitted. The procedures are included in the student guide for future reference. 

The next step is to set up a DAAC version SDP Toolkit environment, compile the PGE, and link 
to the DAAC Toolkit. This procedure will be performed at the SSI&T Training. The procedure 
steps for the two processes are the same except for the set up for the Toolkit environment and 
link with the corresponding Toolkit library. 

26.6.1 Updating the Process Control File 
Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1.	 A PCF for the PGE has been delivered and is available, accessible, and has read 
permissions. 

To update the PCF, execute the procedure steps that follow: 

1 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SGI. 

•	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SGI. 

2	 If required, at the UNIX prompt on the SGI, type cleartool setview ViewName, press 
Return. 

• The ViewName is the name of a view allowing the PCF to be accessible. 
• This step is only necessary if the PCF is in ClearCase (in the VOB under 

configuration management). 
3 At the UNIX prompt on the Sun or on the SGI, type cd PCFpathname, press Return. 

•	 The PCFpathname is the full path name to the location of the PCF. This location 
will be in the ClearCase VOB if the PCF is under configuration management. 

4	 At the UNIX prompt on the Sun or on the SGI, type cleartool checkout -nc 
PCFfilename, press Return. 

•	 The PCFfilename is the file name of the PCF that is to be checked out (and later 
modified). The -nc flag means “no comment”; it suppresses ClearCase from 
prompting for a comment to be associated with the check out step. 

5 Run the Process Control File Checker on the delivered PCF. 
• This will verify that the delivered PCF is correct before editing. 

6 At a UNIX prompt on the Sun, type vi PCFfilename, press Return. 
• The PCFfilename is the file name of the PCF to update. 
•	 Any text editor may be used such as emacs. For example, emacs AST02.pcf, press 

Return. 
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7	 In the file, make changes to the default directories specified in each section of the PCF. 
All path names specified in the PCF must exist on the SGI. 

•	 Each section begins with a line consisting of a ? in the first column followed by a 
label: 
? PRODUCT INPUT FILES

? PRODUCT OUTPUT FILES

? SUPPORT INPUT FILES

? SUPPORT OUTPUT FILES

? INTERMEDIATE INPUT

? INTERMEDIATE OUTPUT

? TEMPORARY I/O


•	 Each of the above section heading lines will then be followed (not necessarily 
immediately; there may be comment lines) by a line that begins with a ! in the first 
column. These lines specify the default path names for each section. 
•	 If the line reads: 

! ~/runtime 
leave it unchanged. The tilde (~) is a symbol that represents $PGSHOME. 
•	 If another path name is listed instead, it will probably need to be changed 

to a path name that exists at the DAAC on the SGI. When specifying a 
path name, use an absolute path name, not a relative path name. 

8	 In the file, look for science software specific entries in each section and make changes to 
the path names (field 3) as necessary. All path names specified in the PCF must exist on 
the SGI. 

•	 The science software specific entries will have logical IDs (first field) outside of 
the range 10,000 to 10,999. 

•	 Where necessary, replace the path names in the third field of each entry with the 
path names appropriate to the DAAC environment. 

•	 Do not alter file entries that are used by the SDP Toolkit itself. These have logical 
IDs in the range 10,000 to 10,999. 

•	 For example, if the following entry was found in the PCF: 
100|A.granule|/MODIS/run/input||||1 

change /MODIS/run/input to the appropriate path name in the DAAC where the 
file A.granule is stored. 

• When specifying a path name, use an absolute path name, not a relative path name. 
•	 Do not include the file name with the path name. The file name belongs in field 2 

by itself. 
9	 In the file, verify that the SUPPORT OUTPUT FILES section contains an entry to the 

shared memory pointer file. 
•	 Look for the entry: 

10111|ShmMem|~/runtime||||1 
The third field may be blank; this will work too. 

• If this entry is not within this section, add it. 
10 Once changes have been made to the PCF, save the changes and exit the editor. 

•	 The specifics depend upon which editor is being used. If using vi, the command 
sequence to enter is :wq, press Return. 
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• For other editors, refer to that editor’s documentation. 
11 Again, run the Process Control File Checker on the PCF. 
12 If the PCF had been checked out of ClearCase, at the UNIX prompt on the SGI, type 

cleartool checkin -nc PCFfilename, press Return. 
•	 The PCFfilename is the file name of the modified PCF. The -nc flag means “no 

comment”; it suppresses ClearCase from prompting for a comment to be 
associated with the check in step. 

26.6.2 Setting up a SDP Toolkit Environment 

The purpose of the SDP Toolkit is to allow science software to be developed for ECS at 
independent SCFs and to provide: 

•	 An interface to the ECS system, including PDPS and CSMS and information 
management. 

• A method for Science software to be portable to different platforms at the DAAC. 
• A method to reduces redundant coding at the SCF. 
• Value added functionality for science software development. 

The SDP Toolkit is divided into two groups of tools: 

26.6.2.1 Mandatory Tools 
•	 Error and Status Message Facility (SMF) - provides general error handling, status 

log messaging, and interface to CSMS services. 
•	 Process Control Tools - provides the primary interface to the PDPS. Allows 

access to physical filenames and file attributes and retrieval of user defined 
parameters. 

•	 Generic Input/Output - provides the means to open and close support, temporary 
and intermediate duration files. 

•	 Memory Allocation Tools - simple wrappers on native C functions which track 
memory usage in the SDPS, and shared memory tools which enable the sharing of 
memory among executables within a PGE. 

26.6.2.2 Optional Tools 
•	 Ancillary Data Access - provides access to NMC data and Digital Elevation 

(DEM) data. 
• Celestial Body Position - locates the sun, moon and the planets. 
•	 Coordinate System Conversion - coordinate conversions between celestial 

reference. 
• Constant and Unit Conversion - physical constants and unit conversions. 
• IMSL - mathematical and statistical support. 

In the description of the Toolkit routines, descriptive information is presented in the following 
format: 
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TOOL TITLE 
NAME: Procedure or routine name 
SYNOPSIS: C: C language call 
FORTRAN: FORTRAN77 or Fortran90 language call 
DESCRIPTION: Cursory description of routine usage 
INPUTS: List and description of data files and parameters input to the 

routine 
OUTPUTS: List and description of data files and parameters output from the 

routine 
ENTERS: List of returned parameters indicating success, failure, etc. 
EXAMPLES: Example usage of routine 
NOTES: Detailed information about usage and assumptions 
REQUIREMENTS: Requirements from PGS Toolkit Specification, Oct. 93 which the 

routine satisfies 

The science software delivered to the DAACs is expected to work with either the SCF SDP 
Toolkit or the DAAC SDP Toolkit which are both installed each DAAC. During the pre-SSI&T 
initial testing, the SCF Toolkit should be used. 

There are several versions of the SCF/DAAC SDP Toolkit installed on the SGI Power 
Challenges at the DAACs for the Release 4 system. The toolkit versions at the DAACs differ 
according to: 

Object Type - The operating system on the SGI Power Challenges on Release 4 is IRIX 
6.2, a 64-bit operating system. To be backward compatible, the SGI operating 
system will allow new 64-bit and 32-bit objects to be built as well as the older 32­
bit machines. Each of these object types are designated by placing a cc flag on the 
command line to enable a particular mode with the SGI C compiler. 

New 64-bit: cc flag = -64

New 32-bit: cc flag = -n32

Old 32-bit: cc flag = -32 (SCF’s only)


Library Type - The SDP Toolkit uses different libraries depending upon whether 
FORTRAN 77 or FORTRAN 90 source code is being linked. If C source code is to 
be linked, then either language version of the library will work. 

The following Table summarizes the available SDP Toolkits used by the SGI science processors. 

26-58 611-CD-510-001




Table 26.6.2-1. SDP Toolkits used by the SGI science processors. 
SDP 

Version 

Language 
Type 

Library 
Object 
Type 

$PGSHOME $PGSBIN 

SCF FORTRAN 77 
or C 

Old 32-bit 
mode 

$CUSTOM/TOOLKIT/toolkit 
/bin/sgi_scf_f77/ 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi_scf_f77/ 

SCF Fortran 90 
or C 

Old 32-bit 
mode 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi_scf_f90/ 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi_scf_f90/ 

SCF FORTRAN 77 
or C 

New 32-bit 
mode 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi32_scf_f77/ 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi32_scf_f77/ 

SCF Fortran 90 
or C 

New 32-bit 
mode 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi32_scf_f90/ 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi32_scf_f90/ 

SCF FORTRAN 77 
or C 

64-bit mode $ CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_scf_f77/ 

$ CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_scf_f77/ 

SCF Fortran 90 
or C 

64-bit mode $CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_scf_f90/ 

$CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_scf_f90/ 

DAAC FORTRAN 77 
or C 

64-bit mode $CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_daac_f77/ 

$CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_daacf77/ 
/ 

DAAC Fortran 90 
or C 

64-bit mode $ CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_daac_f90/ 

$CUSTOM/TOOLKIT/toolkit 
/bin/sgi64_daac_f90/ 

26.6.2.3 Setting Up the SDP Toolkit Environment 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The C shell (or a derivative) is the current command shell. 

To check set up a SDP Toolkit environment, execute the procedure steps that follow: 

1	 At the UNIX prompt on the SGI, type setenv PGSHOME ToolkitPathname, press 
Return. 

•	 The ToolkitPathname is the home directory of the particular SDP Toolkit version 
being used. Refer to Table 26.6.2-1. Note that the setting of PGSHOME shown in 
this table may differ in your local DAAC. 

•	 Korn shell users, type PGSHOME=ToolkitPathname; export PGSHOME, press 
Return. 

2	 At the UNIX prompt on the SGI, type source $PGSHOME/bin/sgiX/pgs-dev-env.csh, 
press Return. 

•	 The sgiX is one of: sgi for 32-bit version of the Toolkit or sgi64 for 64-bit version 
of the Toolkit. Refer to the last column of Table 26.6.2-1. for path names to the 
file to source. 
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•	 Korn shell users, type . $PGSHOME/bin/sgiX/pgs-dev-env.ksh, press Return 
(note the “dot” and then space at the beginning of this command). 

3	 This step is optional. Edit the file $HOME/.cshrc and add the line alias aliasname 
‘setenv PGSHOME ToolkitPathname; source $PGSHOME/bin/sgiX/pgs-dev­
env.csh; echo “textmessage” ‘. 

•	 The aliasname is the name of the alias. For example, to set up an environment for 
the DAAC version of the Toolkit for FORTRAN 77 (or C), you might use 
DAACf77 as an aliasname. 

•	 The ToolkitPathname is the home directory of the particular SDP Toolkit version 
being used. Refer to Table 26.6.2-1. Note that the setting of PGSHOME shown in 
this table may differ in your local DAAC. 

•	 The sgiX is one of: sgi for 32-bit version of the Toolkit or sgi64 for 64-bit version 
of the Toolkit. 

•	 The textmessage is a message that will be echoed to the screen signifying that a 
new Toolkit environment has been set up. It must be enclosed within 

•	 double quotes (“). An example may be, “DAAC F77 Toolkit environment is now 
set.” 

• A complete example (it should be all on one line in the .cshrc file): 
alias DAACf77 ‘setenv PGSHOME 

/$CUSTOM/TOOLKIT/bin/sgi64_daac_f77/; source 
$PGSHOME/bin/sgi/pgs-dev-env.csh; echo “DAAC F77 
Toolkit environment is now set” ‘ 

• Other aliases for other versions of the Toolkit can be set up similarly. 

26.6.2.4 An example of Compile procedures used to produce a PGE.exe : 
Setup for PGE07: 

/home/emcleod/MODIS/STORE/PGE07/MOD_PR10/source 
rm MOD_PR10.exe 
rm *.o 
setenv PGSHOME /usr/ecs/OPS/CUSTOM/TOOLKIT/sgi32_daac_f77/ 
source $PGSHOME/bin/sgi32/pgs-dev-env.csh 
source 
/home/emcleod/MODIS/STORE/PGE07/MOD_PR10/source/MODIS_setup.csh.pge07 
alias 
n32_f77 
env 
make -f MOD_PR10.mk & 
ls -l *exe 
setenv PGS_PC_INFO_FILE 
/home/emcleod/MODIS/STORE/PGE07/MOD_PR10/source/MOD_PR10.pcf 
ls 
MOD_PR10.exe & 
confirm execution when done by looking at file : vi 
MOD_PR10_ClopyL1BmetaToSnow.c 
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see if job is running: ps -u emcleod "time updating for MOD_PR10"

p0spg01{emcleod}88: ps -u emcleod


PID TTY TIME CMD

267 ? 3:13 biod


25825 pts/11 0:01 csh

21994 pts/10 0:01 csh

23215 pts/16 0:00 csh

26242 pts/10 0:07 MOD_PR10.

26089 pts/11 0:01 xedit

26318 pts/10 0:00 ps

p0spg01{emcleod}105: pwd

/tmp_mnt/home/emcleod/MODIS/STORE/PGE07/MOD_PR10/source

p0spg01{emcleod}106: ls

MODIS_setup.csh.pge07 MOD_PR10_CopyL1BmetaToSnow.c

MODIS_setup_OPS MOD_PR10_CopyL1BmetaToSnow.o

MOD_PR10.exe MOD_PR10_MakeMeta.c

MOD_PR10.h MOD_PR10_MakeMeta.o

MOD_PR10.mcf MOD_PR10_Process_Cloud.c

MOD_PR10.mk MOD_PR10_Process_Cloud.o

MOD_PR10.pcf MOD_PR10_Process_GEO.c

MOD_PR10_AAmain.c MOD_PR10_Process_GEO.o

MOD_PR10_AAmain.o MOD_PR10_Process_L1B.c

MOD_PR10_Compute_Snow.c MOD_PR10_Process_L1B.o

MOD_PR10_Compute_Snow.o MOD_PR10_Process_SnowFile.c

MOD_PR10_CopyGEOmetaToSnow.c MOD_PR10_Process_SnowFile.o

MOD_PR10_CopyGEOmetaToSnow.o compile_smf.csh

p0spg01{emcleod}107:


26.6.2.5 Example of a PGE Executables Tar File Insertion Script 

This example was produced in Drop 4 and is provided for review only. Go to the section Placing

the Science Software Executable (SSEP) on the Data Server which includes the Insertion of a

PGE Tar file..


Configuration filename? (enter for default:

../../cfg/EcDpAtInsertExeTarFile.CFG)

ECS Mode of operations? (enter for default: OPS)

Name of PGE? (enter for default: PGE07)

Science software version of PGE? (enter for default: 2)

Staged filename to insert (including FULL path)? (enter for default:

/home/emcleod/SSEP/PGE07.tar)

Associated ASCII metadata filename to insert (including FULL path)? (enter for

defaul /home/emcleod/SSEP/PGE07.tar.met)

Top level shell filename within tar file? (enter for default: PGE07.csh)

PGE07.csh

Warning: Could not open message catalog "oodce.cat"
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/usr/ecs//OPS/CUSTOM/bin/DPS/EcDpAtInsertExeTarFile: Process Framework:

ConfigFile ..//cfg/EcDpAtInsertExeTarFile.CFG ecs_mode OPS

Performing INSERT......

Retrieved from IOS for ESDT = PGEEXE the DSS UR =

UR:15:DsShSciServerUR:13:[MDC:DSSDSR

Trying to make a request to [MDC:DSSDSRV]

Trying to make a request to [MDC:DSSDSRV]

Insert to Data Server and PDPS database update successful for:


PGE name = 'PGE07'

Ssw version = '2'

ESDT = 'PGEEXE'

ESDT Version = ''001”

staged file = '/home/emcleod/SSEP/PGE07.tar'

metadata file = '/home/emcleod/SSEP/PGE07.tar.met'

Top level shell name = 'PGE07.csh'


Inserted at UR:

'UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]:14:LM:PGEEXE:94'

Hit return to run again, 'q <return>' to quit:


26.6.3 Compiling Status Message Facility (SMF) Files 
Status Message Facility (SMF) files are used by the SDP Toolkit to facilitate a status and error 
message handling mechanism for use in the science software and to provide a means to send log 
files, informational messages, and output data files to DAAC personnel or to remote users. 

Science software making use of the SMF need particular header (include) files when being built 
and also need particular runtime message files when being run. Both the header and message 
files are produced by running a SMF “compiler” on a message text file. These message text files 
should be part of the science software delivery to the DAAC. They typically have a .t file name 
extension. 

This procedure describes how to compile the SMF message text files to produce both the 
necessary include files and the necessary runtime message files. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The C shell (or a derivative) is the current command shell. 

To check compile status message facility (SMF) files, execute the procedure steps that 
follow: 
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1	 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SGI. 

•	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SGI. 

•	 It is recommended that this procedure begin within a new command shell on the 
SGI. 

2	 If required, at the UNIX prompt on the SGI, type cleartool setview ViewName, press 
Return. 

• The ViewName is the name of a view allowing the SMF files to be accessible. 
•	 This step is only necessary if any of the SMF files are in ClearCase (in the VOB 

under configuration management). 
3	 At the UNIX prompt on the SGI, type setenv PGSHOME ToolkitPathname, press 

Return. Then type, source $PGSHOME/bin/sgiX/pgs-dev-env.csh, press Return. 
• The ToolkitPathname is the home directory of the desired SDP Toolkit version. 
• The sgiX refers to the appropriate processor. For example, type source 

$PGSHOME/bin/sgi/pgs-dev-env.csh, press Return. 
4 At the UNIX prompt on the SGI, type cd pathname, press Return. 

• The pathname is the full path name to the directory containing the SMF text files. 
• The SMF text files will typically have .t file name extensions. 

5 At the UNIX prompt on the SGI, type smfcompile -f textfile.t -lang , press Return. 
•	 The -lang is a flag that indicates for what language to compile. This flag can be 

one of -c to produce C header files, -f77 to produce FORTRAN 77 include files, 
and -ada to produce Ada include files. The default is for C include files. For 
example, type smfcompile -f77 PGS_MODIS_39123.t, press Return. 

•	 The textfile is the file name of the SMF text file delivered with the science 
software. 

• The SMF text files will typically have .t file name extensions. 
•	 File names for SMF text files usually have the “seed” value used by the file as part 

of its file name (e.g. PGS_MODIS_39123.t where 39123 is the seed number). 
• Only one such SMF text file can be compiled at a time; wildcards cannot be used. 
•	 The SMF compiler may be run with the additional flags -r and -i as in, 

smfcompile -f textfile.t -r -i. The -r automatically places the runtime message file 
in the directory given by the environment variable PGSMSG. The -i automatically 
places the include file in the directory given by the environment variable PGSINC. 
For example, type smfcompile -ada -r -i -f PGS_MODIS_39123.t, press Return. 
Note that the -f flag must always be immediately followed by the name of the text 
file. 

6 If necessary, at the UNIX prompt on the SGI, type mv IncludeFilename $PGSINC, 
press Return. Then, type mv RuntimeFilename $PGSMSG, press Return. 

• This step is only required if either the -r or the -i flag were not used in step 5. 
• The IncludeFilename is the name of the include file created in step 5. 
• The RuntimeFilename is the name of the runtime message file created in step 5. 
•	 For example, type mv PGS_MODIS_39123.h $PGSINC, press Return. And then 

type, mv PGS_MODIS_39123 $PGSMSG, press Return. 
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26.6.4 Building Science Software with the SCF Version of the SDP Toolkit 

In order to be tested at the DAAC, science software must be compiled and linked to produce 
binary executables. These binary executables are then packaged into one or more shell scripts as 
defined by the science software developer (Instrument Team). These science software packages 
are the Product Generation Executives (PGEs) delivered to the DAACs during SSI&T. PGEs are 
the smallest schedulable unit of science software in the ECS. 

Building science software into PGEs should be done in accordance with supplied documentation. 
Such documentation should describe the process in detail. In general, science software deliveries 
will come with make files or other build scripts to automate the build process. 

In general, science software will be built, run, and tested with the SCF version of the SDP 
Toolkit to ensure that the software has been successfully ported to the DAAC. Once this test has 
been completed successfully, the science software will be re-built, rerun, and re-tested with the 
DAAC version of the SDP Toolkit. Only with the DAAC Toolkit can the PGE be run within the 
ECS. 

This procedure describes some general principals that may or may not be applicable to a 
particular science software delivery for building a PGE with the SCF version of the SDP Toolkit. 
See Section for Building a PGE with the DAAC version of the SDP Toolkit. 

Building Science Software with the SCF Version of the SDP Toolkit - Activity Detailed 
procedures for tasks performed by the SSI&T operator are provided in the sections that follow. 

Assumptions: 

1 The C shell (or a derivative) is the current command shell. 

To build science software with the SCF version of the SDP Toolkit, be aware of the 
“typical” procedure steps that follow: 

Read all instructional material supplied with the science software delivery. Such material 
should be the primary source of information on how to build the science software. 

• Read the Systems Description document and the Operations Manual. Both of these 
or their equivalent should be in the delivery. 

•	 Typically, there will be “readme” files accompanying each PGE in the directory 
structure, perhaps in a doc directory. 

•	 Text files (ASCII) may be viewed with the UNIX command, more or with the vi 
editor. 

•	 PostScript documents may be viewed with ghostview, which is accessible via the 
SSIT Manager. 

•	 PDF formatted documents may be viewed with acroread, the Acrobat Reader, also 
accessible via the SSIT Manager. 

•	 Documents in Microsoft Word and related formats may be viewed through the 
Microsoft Windows™ 3.1 emulator. The MS Windows emulator may be accessed 
from the SSIT Manager. 
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2	 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SGI. 

•	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SGI. 

•	 It is recommended that this procedure begin within a new command shell on the 
SGI. 

3	 At the UNIX prompt on the SGI, type setenv PGSHOME ToolkitPathname, press 
Return. Then type, source $PGSHOME/bin/sgiX/pgs-dev-env.csh, press Return. 

•	 The ToolkitPathname is the home directory of the desired SDP Toolkit version, in 
this case, an SCF version. 

•	 The sgiX refers to the appropriate processor. For example, type source 
$PGSHOME/bin/sgi/pgs-dev-env.csh, press Return. 

4	 If make files are in ClearCase, at the UNIX prompt on the SGI, type cleartool setview 
ViewName, press Return. Then, cd pathname, press Return. And cleartool checkout ­
nc makefile, press Return. 

• The ViewName is the name of a view allowing the make files to be accessible. 
•	 The pathname is the full path name of the directory (in the VOB) where the make 

file has been checked in. 
• The makefile is the name of the make file to examine and possibly modify. 
• This step is only necessary if any of the make files (or build scripts) are in 

ClearCase (in the VOB under configuration management). 
5 Examine and alter (if necessary) any make files using any text editor (vi, emacs). 

• There may be several make files for a particular PGE. 
•	 Verify that compiler, compiler flag settings, and other environment variable 

settings are appropriate. 
•	 The Toolkit set up (from step 3) will set many environment variables which can be 

used in the make files. To see the current environment variable settings, at the 
UNIX prompt on the SGI, type env, press Return. 

6	 Compile any required status message facility (SMF) files and place the header file(s) in 
the proper directory for building. 

7 Verify that the directory structure for the PGE source files matches the directory structure 
expected by the make files or build scripts. 

• Deliveries may come with install scripts that place files into various directories 
according to some predefined structure. 

8	 If necessary, at the UNIX prompt on the SGI, type cleartool checkout -nc filename, 
press Return. 

•	 The filename is the file name of the executable, object file, or make file to be 
checked out of ClearCase. The -nc flag means “no comment”; it suppresses 
ClearCase from prompting for a comment to be associated with the check out step. 

• Note that checking in executable or object files is not recommended in the first 
place. 

9 Build the software in accordance with instructions delivered. 
•	 Science software deliveries may come with a single, top-level script to do the 

entire build or the build process could involve a series of steps, each of which 
should be described fully in the delivered documentation. 
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•	 Choose the most appropriate optimization/debugger flag. During testing, the "-g" 
is often used. This results in larger and slower executables, but assists in 
debugging. For production, the "-O" flag may be used to optimize execution time. 
Variants of the "-g" and "-O" flags may be incompatible. 

10	 If necessary, at the UNIX prompt on the SGI, type cleartool checkin filename -nc, press 
Return. 

•	 The filename is the file name of the executable, object file, or make file to be 
checked into ClearCase. The -nc flag means “no comment”; it suppresses 
ClearCase from prompting for a comment to be associated with the check in step. 

• Note that checking in executable or object files is not recommended. 

26.6.5 Building Science Software with the DAAC Version of the SDP Toolkit 

In general, science software will be built, run, and tested with the SCF version of the SDP 
Toolkit to ensure that the software has been successfully ported to the DAAC. Once this test has 
been completed successfully, the science software will be re-built, rerun, and re-tested with the 
DAAC version of the SDP Toolkit. Only with the DAAC Toolkit can the PGE be run within the 
ECS. 

This procedure describes some general principals that may or may not be applicable to a 
particular science software delivery for building a PGE with the DAAC version of the SDP 
Toolkit. 

Building Science Software with the DAAC Version of the SDP Toolkit - Activity Detailed 
procedures for tasks performed by the SSI&T operator are provided in the sections that follow. 

Assumptions: 

The C shell (or a derivative) is the current command shell. 

To build science software with the DAAC version of the SDP Toolkit, be aware of the 
“typical” procedure steps that follow: 

Read all instructional material supplied with the science software delivery. Such material 
should be the primary source of information on how to build the science software. 

• Read the Systems Description document and the Operations Manual. Both of these 
or their equivalent should be in the delivery. 

•	 Typically, there will be “readme” files accompanying each PGE in the directory 
structure, perhaps in a doc directory. 

•	 Text files (ASCII) may be viewed with the UNIX command, more or with the vi 
editor. 

•	 PostScript documents may be viewed with ghostview, which is accessible via the 
SSIT Manager. 
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•	 PDF formatted documents may be viewed with acroread, the Acrobat Reader, also 
accessible via the SSIT Manager. 

•	 Documents in Microsoft Word and related formats may be viewed through the 
Microsoft Windows™ 3.1 emulator. The MS Windows emulator may be accessed 
from the SSIT Manager. 

2	 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SGI. 

•	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SGI. 

•	 It is recommended that this procedure begin within a new command shell on the 
SGI. 

3	 At the UNIX prompt on the SGI, type setenv PGSHOME ToolkitPathname, press 
Return. Then type, source $PGSHOME/bin/sgiX/pgs-dev-env.csh, press Return. 

•	 The ToolkitPathname is the home directory of the desired SDP Toolkit version, in 
this case, a DAAC version. 

•	 The sgiX refers to the appropriate processor. For example, type source 
$PGSHOME/bin/sgi/pgs-dev-env.csh, press Return. 

4	 If make files are in ClearCase, at the UNIX prompt on the SGI, type cleartool setview 
ViewName, press Return. Then, cd pathname, press Return. And cleartool checkout ­
nc makefile, press Return. 

• The ViewName is the name of a view allowing the make files to be accessible. 
•	 The pathname is the full path name of the directory (in the VOB) where the make 

file has been checked in. 
• The makefile is the name of the make file to examine and possibly modify. 
•	 This step is only necessary if any of the make files (or build scripts) are in 

ClearCase (in the VOB under configuration management). 
5	 Examine and alter (if necessary) any make files using any text editor (vi, emacs). If the 

software had already been built and tested with the SCF version of the SDP Toolkit, this 
step may be unnecessary. 

• There may be several make files for a particular PGE. 
•	 Verify that compiler, compiler flag settings, and other environment variable 

settings are appropriate. 
•	 The Toolkit set up (from step 3) will set many environment variables which can be 

used in the make files. To see the current environment variable settings, at the 
UNIX prompt on the SGI, type env, press Return. 

6	 Compile any required status message facility (SMF) files and place the header file(s) in 
the proper directory for building. 

7 Verify that the directory structure for the PGE source files matches the directory structure 
expected by the make files or build scripts. 

• Deliveries may come with install scripts that place files into various directories 
according to some predefined structure. 

8	 If necessary, at the UNIX prompt on the SGI, type cleartool checkout -nc filename, 
press Return. 
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•	 The filename is the file name of the executable, object file, or make file to be 
checked out of ClearCase. The -nc flag means “no comment”; it suppresses 
ClearCase from prompting for a comment to be associated with the check out step. 

• Note that checking in executable or object files is not recommended in the first 
place. 

9 Build the software in accordance with instructions delivered. 
•	 Science software deliveries may come with a single, top-level script to do the 

entire build or the build process could involve a series of steps, each of which 
should be described fully in the delivered documentation. 

1. 	 Choose the most appropriate optimization/debugger flag. During testing, the "-g" 
is often used. This results in larger and slower executables, but assists in 
debugging. For production, the "-O" flag may be used to optimize execution time. 
Variants of the "-g" and "-O" flags may be incompatible. 

10	 If necessary, at the UNIX prompt on the SGI, type cleartool checkin filename -nc, press 
Return. 

•	 The filename is the file name of the executable, object file, or make file to be 
checked into ClearCase. The -nc flag means “no comment”; it suppresses 
ClearCase from prompting for a comment to be associated with the check in step. 

• Note that checking in executable or object files is not recommended. 

26.7 Running a PGE in a Simulated SCF Environment 
Science software delivered to the DAACs for SSI&T was developed and tested at individual 
SCFs using the SCF version of the SDP Toolkit. Before linking the software with the DAAC 
version of the Toolkit and integrating it with the ECS, it is prudent to first link the software to the 
SCF version of the Toolkit and run it as it was run at the SCF. This type of testing can reveal 
problems associated with the process of porting the software to another platform whose 
architecture may be quite different from the one on which the software was developed. 

A simulated SCF environment means that the software is built using the SCF version of the 
Toolkit and is run from the UNIX command line. The Planning and Data Processing System 
(PDPS) and the Data Server are not involved. 

The procedures which follow describe how to run the science software in a simulated SCF 
environment. 

26.7.1 Setting Up the Environment for Running the PGE 
Running a PGE that has been built with the SCF version of the SDP Toolkit requires some 
environment set up as it does at the SCF. This procedure describes how to set up a simulated 
SCF environment. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 
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•	 The Process Control File (PCF) exists and has been tailored for the DAAC 
environment. 

• The C shell or a derivative (e.g. T shell) is the current user shell. 

To set up an environment for running the PGE, execute the procedure steps that follow: 

1	 From the SSIT Manager, click on the Tools menu, then choose Xterm. Then telnet to the 
SPR SGI. 

•	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the SPR SGI. 

•	 It is recommended that this procedure begin within a new command shell on the 
SPR SGI. 

2	 At the UNIX prompt on the SPR SGI, type setenv PGSHOME ToolkitPathname, press 
Return. Then type, source $PGSHOME/bin/sgiX/pgs-dev-env.csh, press Return. 

•	 The ToolkitPathname is the home directory of the desired SDP Toolkit version, in 
this case, an SCF version. 

• The sgiX refers to the appropriate processor (see Section 9.2 ?). For example, type 
source $PGSHOME/bin/sgi/pgs-dev-env.csh, press Return. 

At the UNIX prompt on the SPR SGI, type setenv PGS_PC_INFO_FILE 
PCFpathname/PCFfilename, press Return. 

•	 The PCFpathname is the full path name to the location of the Process Control File 
(PCF) to be associated with this PGE. 

• The PCFfilename is the file name of the PCF. 
•	 For example, setenv PGS_PC_INFO_FILE /disk2/PGE32/PCF/PGE32.pcf, 

press Return. 
3	 Optionally, at the UNIX prompt on the SPR SGI, type rm LogPathname/LogFilename, 

press Return. 
•	 The LogPathname is the full path name to the location of the PGE log files for this 

PGE. 
•	 The LogFilename is the file name of the PGE log file to remove from a previous 

run of the same PGE. PGE log files can be Status, User, or Report. 
•	 The LogFilename may use wildcard characters to remove all of the log files at the 

same time. 
•	 This step is optional. If log files from a previous run of the same PGE are not 

removed, they will be appended with the information from the current run. 
• The environment will then be set up. Continue on the next Section. 

4	 If necessary, set any other shell environment variables needed by the PGE by sourcing 
the appropriate scripts or setting them on the command line. 

•	 For example, for a PGE requiring IMSL, at the UNIX prompt on the SPR SGI, 
type source /usr/ecs/TS1/COTS/imsl/vni/ipt/bin/iptsetup.cs, press Return 

•	 For some PGEs, the environment variables to be set will be specified in the 
documentation or the files to source will be supplied in the delivery. Refer to 
documentation included in the delivery. 
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26.7.2 Running and Profiling the PGE 
Profiling a PGE refers to the process of gathering information about the runtime behavior of a 
PGE. The information includes the wall clock time, user time and system time devoted to the 
PGE; the amount of memory used; the number of page faults; and the number of input and 
output blocks. 

The Planning and Data Processing System (PDPS) database must be populated with the above 
information when the PGE is registered with the PDPS during the integration phase of SSI&T. 
This information may be delivered with the PGE or it may need to be determined at the DAAC 
during SSI&T. This procedure addresses the latter need. 

Note that profiling, as used here, does not involve altering the binary executable to produce 
instrumented code. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

• The PGE has been built successfully with the SCF version of the SDP Toolkit . 

•	 The required SMF runtime message files have been produced and placed in the 
correct locations. 

•	 The Process Control File (PCF) exists and has been tailored for the DAAC 
environment. 

• The required environment for running the PGE has been set up. 

• The required input files are available and accessible. 

• The C shell or a derivative (e.g. T shell) is the current user shell. 

To run and profile the PGE, execute the procedure steps that follow: 

1 At the UNIX prompt on the SPR SGI in the window containing the set up environment, 
type cd PGEbinPathname, press Return. 

• The PGEbinPathname is the full path name of the directory containing the built 
PGE binary executable. For example, cd /disk3/PGE32/bin/, press Return. 

2	 At the UNIX prompt on the SPR SGI, type 
/usr/ecs/<mode>/CUSTOM/bin/DPS/EcDpPrRusage PGE >& ResultsOut, press 
Return. 

• The PGE is the name given to the PGE binary executable. 
•	 The ResultsOut is the file name in which to capture the profiling results as well as 

any messages from standard output (stdout) and standard error (stderr) that may be 
produced by the running PGE. Note that PGEs should not write to stdout or stderr. 
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•	 The EcDpPrRusage is the profiling program that outputs information about the 
runtime behavior of the PGE. 

• Depending upon the PGE, it may take some time before the UNIX prompt returns. 
3 At the UNIX prompt on the SPR SGI, type echo $status, press Return. 

•	 The $status is an environment variable that stores the exit status of the previous 
program run, in this case, the PGE. 

•	 A status of zero indicates success; a status of non-zero indicates an error of some 
kind. 

•	 The meaning of a non-zero exit status should be documented and included with the 
DAPs. 

• This command must be run immediately after the EcDpPrRusage command. 
4 At the UNIX prompt on the SPR SGI, type vi ResultsOut, press Return. 

•	 The ResultsOut is the file name under which the profiling output was saved. Other 
output of the PGE may also be in this file. 

•	 The EcDpPrRusage results may then be recorded and used when the PGE is 
registered in the PDPS. 

• Any text editor/viewer may be used. 

Sample of an Rusage File produced: 
p0spg01{emcleod}6: more Profile.out 

# source .cshrc 
# cd TEST/MOD* 
# ls 
# /usr/ecs/OPS/CUSTOM/bin/DPS/EcDpPrRusage MOD_PR10.exe > Profile.out 

p0spg01{emcleod}9: more profile.out 

# Resource Usage Information 

COMMAND=MOD_PR10.exe 

EXIT_STATUS=0 

ELAPSED_TIME=233.583145 

USER_TIME=10.046158 

SYSTEM_TIME=7.555547 

MAXIMUM_RESIDENT_SET_SIZE=4080 

AVERAGE_SHARED_TEXT_SIZE=0 

AVERAGE_UNSHARED_DATA_SIZE=0 

AVERAGE_UNSHARED_STACK_SIZE=0 

PAGE_RECLAIMS=151 

PAGE_FAULTS=0 

SWAPS=0 
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BLOCK_INPUT_OPERATIONS=2 

BLOCK_OUTPUT_OPERATIONS=2710 

MESSAGES_SENT=0 

MESSAGES_RECEIVED=0 

SIGNALS_RECEIVED=0 

VOLUNTARY_CONTEXT_SWITCHES=1095 

INVOLUNTARY_CONTEXT_SWITCHES=2 

p0spg01{emcleod}10: 

26.8File Comparison and Data Visualization 
The purpose of File Comparison is to verify that the output files produced at the DAAC are 
identical (within tolerances) to the test output files delivered with the DAPs. A successful 
comparison is a strong indication that the porting of the science software from the development 
facility at the SCF to the operational facility at the DAAC has not introduced any errors. 

A number of file comparison tools are available during SSI&T via the SSIT Manager GUI or 
they can be invoked from the UNIX command line. Two tools are available for comparing HDF 
or HDF-EOS files, one tool for comparing ASCII files, and another tool for assisting in 
comparing binary files. 

26.8.1 Using the GUI HDF File Comparison GUI 
The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 
2. Two HDF or HDF-EOS files exist with similar structures. 
3. The Instrument Team has delivered test output files. 
4.	 If either of the two HDF/HDF-EOS files is in the ClearCase VOB, a ClearCase view 

was set before the SSIT Manager was started. 

Comparing Two HDF or HDF-EOS Files Using the HDF File Comparison GUI 

1	 From the SSIT Manager, select Tools→ Product Examination → HDF from the menu. 

The HDF File Comparison GUI window will be displayed. 

2 In the HDF File Comparison Tool GUI, click on the File 1 button. 

•	 Read the Systems Description document and the Operations Manual. Both of 
these or their equivalent should be in the delivery. 
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26.8.2 Using the hdiff HDF File Comparison Tool 
The hdiff File Comparison Tool is a text-oriented tool run from the command line. It allows 
comparison of two HDF or HDF-EOS files 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2. Two HDF or HDF-EOS files exist with similar structures. 

3. The instrument Team has delivered test output files. 

4.	 If either of the two HDF/HDF-EOS files is in the ClearCase VOB, a ClearCase view was 
set before the SSIT Manager was started. 

Comparing two HDF or HDF-EOS Files Using the hdiff File Comparison Tool 

1	 From the SSIT Manager, select Tools→ Product Examination → File Comparison → 
HDF from the menu. 

The HDF File Comparison Tool window will be displayed. 

• An xterm window running hdiff will be displayed. 

2	 In the xterm window at the prompt Options? (-h for help), type in any desired options 
then press the Enter key. 

•	 To see the list of available options, type -h then press the Enter key. to the 
prompt. 

3	 In xterm window at the prompt 1st file to compare?, type filename1, then press the 
Enter key. 

•	 The filename1 is the file name of the first of two HDF or HDF-EOS files to be 
compared. 

•	 If filename1 is not in the current directory (the directory from which the SSIT 
Manage was run), include the full path name with the file name. 

4	 In xterm window at the prompt 2nd file to compare?, type filename2, then press the 
Enter key. 

•	 The filename2 is the file name of the second of two HDF or HDF-EOS files to be 
compared. Select another studentsÕ file. 

•	 If filename2 is not in the current directory (the directory from which the SSIT 
Manage was run), include the full path name with the file name. The two files will 
be compared and the output will be displayed in the xterm window. 
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26.8.3 Using the ASCII File Comparison Tool 
Most output files (products) from PGEs run in the DAAC will be in HDF-EOS format. A small 
minority may be in ASCII (text) format. The ASCII File Comparison Tool is a front-end to xdiff 
UNIX X Window tool for comparing two ASCII files. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2. Two ASCII files exist and have read permissions. 

3. The instrument Team has delivered test output files. 

4.	 If either of the two ASCII files are in the ClearCase VOB, a ClearCase view was set 
before the SSIT Manager was started. 

Comparing Two ASCII Files 

1	 From the SSIT Manager, select Tools→ Product Examination → File Comparison → 
ASCII from the menu. 
An xterm window running xdiff will be displayed. 

2	 In xterm window at the prompt 1st file to compare?, type filename1, then press the 
Enter key. Select a descriptor or mcf file in the directory with the PGE. 
The filename1 is the file name of the first of two ASCII files to be compared. 
If filename1 is not in the current directory (the directory from which the SSIT Manage 

was run), include the full path name with the file name. 
3	 In xterm window at the prompt 2nd file to compare?, type filename2, then press the 

Enter key. 
The filename2 is the file name of the second of two ASCII files to be compared. Select 

another studentÕs corresponding file. 
If filename2 is not in the current directory (the directory from which the SSIT Manager 

was run), include the full path name with the file name. 
A window labeled xdiff will be displayed. 

4 In the window labeled xdiff, view the differences between the two files displayed. 
File filename1 will be displayed on the left side of the window. File filename2 will be 

displayed on the right. 
Only sections of file in which there are differences will be displayed. A “bang” character 

(!) at the beginning of a line indicates that a difference was found. 
For further help on xdiff, type man xdiff, in an xterm window then press the Enter key. 
Close the display window by using the pull down menu from the X window in the upper 

left corner. 
5 In the xterm window at the prompt Hit Enter for another diff, ‘q <Enter>’ to quit:, 

type q press Enter to quit or just press Enter to perform another comparison. 
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26.8.4 Using the Binary File Difference Assistant 
Most output files (products) from PGEs run in the DAAC will be in HDF-EOS format. A small 
minority may be in some binary format. The Binary File Difference Assistant aids the user in 
constructing code that allows comparison of binary output files. Since there is an unwieldy 
number of possibilities for binary file formats, this tool cannot compare two binary files without 
some custom code written at the DAAC, hence, the “Assistant” in the name. The Binary File 
Difference Assistant aids the user by generating a makefile, a driver module, and a template 
comparison module in C, FORTRAN 77 or IDL (Interactive Data Language). The user then 
edits these templates to read the particular binary format in question according to a SCF-supplied 
format specification. 

The binary file comparison will not be performed during the SSIT training lesson. 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2. Two Binary files exist and have read permissions. 

3. The instrument Team has delivered test output files. 

4.	 If either of the two Binary files are in the ClearCase VOB, a ClearCase view was set 
before the SSIT Manager was started. 

Comparing two Binary Files 

1	 From the SSIT Manager, select Tools→ Product Examination → File Comparison → 
Binary from the menu. 
The Binary File Difference Assistant tool GUI will be displayed. 

2	 In the Binary File Difference Assistant tool GUI, click on one of the languages listed 
under the Select Language label. The choices are C, FORTRAN, or IDL. 
The choice of language depends largely on preference. It does not necessarily have to be 

the language that was used to create the files being compared. 
3	 Optionally, click on either the Image button or the Structure button located under the 

label Compare Function. 
Clicking on the Image button will display a code example for comparing binary files 

containing images. 
Clicking on the Structure button will display a code example for comparing binary files 

containing structures or records. 
The displayed listing well documented and should be read. 
The language of the code will depend on the language selection made in step 2. 

4	 Optionally, click on either the Image button or the Structure button located under the 
label Driver. 
Clicking on the Image button will display a code example for a driver invoking the 

compare function for binary files containing images. 
Clicking on the Structure button will display a code example for a driver invoking the 

compare function for binary files containing structures or records. 
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The displayed listing well documented and should be read.

The language of the code will depend on the language selection made in step 2.


5 Optionally, click on either the Help button. 
A Help window will be displayed. 
To end help, click on the Dismiss button. 
The Help window may remain displayed while using the Binary File Difference 

Assistant. 
6 Once familiar with the code examples (steps 3 and 4), click on the Copy button. 

• A window labeled Enter Unique ID will be displayed. 

•	 In the field labeled Enter unique file identifier:, type fileID, click on the OK 
button. 

• The fileID will be used in the file names of the files copied over. These files will 
be: 

C: 

DaacBinDiff_fileID.c 

DaacBinDiff_fileID_driver.c 

DaacBinDiff_fileID.mak 

FORTRAN: 

DaacBinDiff_fileID.f 

DaacBinDiff_fileID_driver.f 

DaacBinDiff_fileID.mak 

IDL: 

DaacBinDiff_fileID.pro 

DaacBinDiff_fileID_driver.pro 

DaacBinDiff_fileID.sh 
document 

Compare function


Driver


Makefile


Compare function


Driver


Makefile


Compare function 

Driver 

Shell script with here 

•	 The files will be copied into the directory from which the SSIT Manager is 
being run. 

1.	 Using any desired text editor, customize the files for the job at hand. Then build the 
executable using the customized makefile provided (for C and FORTRAN). Then 
run the program to perform the binary file comparison. 
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26.8.5 Data Visualization 

In order to view the success of science software in producing scientifically valid data sets, the 
data needs to be displayed in forms that convey the most information. Data visualization enables 
this to be done. 

There are two visualization tools provided to the DAAC: EOSView and Interactive Data 
Language (IDL). These tools are both accessible via the SSIT Manager. EOSView is user 
friendly GUI for creating two-dimensional displays from HDF-EOS objects(Grid, Swath) as well 
as the standard HDF objects (SDS, Vdata, Image, Text). It has additional features such as 
thumbnail-panning, colorization, zooming, plotting, and animation. Only some aspects of data 
visualization will be addressed in this training material. For further information, see the related 
references. 

IDL is a COTS display and analysis tool widely applied in the scientific community, It is used to 
create two-dimensional, three dimensional (volumetric), and surface/terrain displays from binary, 
ASCII, and many other formats in addition to HDF. 

Only a limited number of file types will be available during SSIT training. 

26.8.5.1 Data Visualization with EOSView 

26.8.5.1.1 Viewing Product Metadata with the EOSView Tool 

This procedure describes how to use the EOSView tool to inspect the metadata in the HDF-EOS 
output file from a PGE. To view product metadata with the EOSView tool, execute the 
procedure steps that follow: 

Viewing Product Metadata **** The SSIT Manager does not support Data Visulization at 
the time of Drop 4.***** A backup example is as follows for EOSView: 

Log into an Algorithm and Test Tools (AITTL) environment using using a machine so 
configured. At the mini-daac this machine is p0ais01 

1 Telnet into p0ais01. 

2 logon using your own ID and Password 

3 cd /usr/ecs/TS1/CUSTOM/eosview. 

4 Select EOSView, The EOSView GUI will be displayed. 

5 Use the select buttons to guide you toward the view desired 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2.	 The output file is HDF-EOS and has been created and populated with metadata using the 
SDP Toolkit metadata tools. 
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Viewing Product Metadata 

1	 From the SSIT Manager, select Tools→ Product Examination → EOSView from the 
menu. 

• The EOSView GUI will be displayed. 

2	 In the GUI labeled EOSView - EOSView Main Window, click on the File menu and 
select Open. The Filter GUI will be displayed. 

• In the subwindow labeled Filter, select the appropriate directory and file to open. 

3	 A GUI labeled EOSView - MyOutputFile.hdf will be displayed where MyOutputFile.hdf 
is the file name of the file chosen in step 2. Once displayed, a list of HDF objects will 
appear in the main window. If nothing is listed, it means that no HDF objects were found 
within the file. 

4	 In the GUI labeled EOSView - MyOutputFile.hdf, click on an object listed for which 
metadata is to be inspected. The object selected will be highlighted. 

•	 Do not double click on object since this will cause a Dimension GUI to be 
displayed instead. 

5	 The global metadata associated with the object selected will be displayed in a scrollable 
field by clicking on the Attributes menu and selecting Global in the GUI labeled 
EOSView - MyOutputFile.hdf. 

•	 If instead, the message “Contains no Global Attributes” appears, then the selected 
object contains no global metadata. 

6	 Repeat steps 4 and 5 for each HDF object within the selected HDF-EOS file for which 
metadata is to be examined. 

7	 In the GUI labeled EOSView - MyOutputFile.hdf, click on the File menu and select 
Close to close the EOSView - MyOutputFile.hdf GUI. 

8	 In the GUI labeled EOSView - EOSView Main Window, click on the File menu and 
select Exit to exit EOSView - EOSView Main Window GUI. 

26.8.5.1.2 Viewing HDF Image Objects 
This procedure describes how to use the EOSView tool to view science Images in the HDF-EOS 
output file from a PGE. 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2.	 The output file is HDF-EOS and has been created and populated with metadata using the 
SDP Toolkit metadata tools. 

3. At least one object is an HDF image (RIS8, RIS24, i.e. Browse data). 

Viewing HDF Image Objects 
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1	 From the SSIT Manager, select Tools→ Product Examination → EOSView from the 
menu. 
The EOSView GUI will be displayed. 

2	 In the GUI labeled EOSView - MyOutputFile.hdf, double click on an Image object listed 
for which data is to be inspected. 
A GUI labeled EOSView - Image Display Window - MyImageObject will be displayed 

where MyImageObject is the name of the object selected. 
3	 Optional colorization. In the GUI labeled EOSView - Image Display Window -

MyImageObject, click on the Palette menu, then select one of the palettes listed: 
Default, Greyscale, Antarctica, Rainbow, or World Colors. 
This selection may be repeated until the desired palette is chosen. 

4	 Optional zooming. In the GUI labeled EOSView - Image Display Window -
MyImageObject, click on the Zooming menu, then select and then select one of the 
resampling methods listed: Bilinear Interpolation or Nearest Neighbor. Then click on 
the Zoom In or Zoom Out buttons to apply the method. 

5	 Optional panning while zooming. In the GUI labeled EOSView - Image Display 
Window - MyImageObject, click on the Options menu, then select Pan Window, a 
thumbnail representation of the entire Image will be displayed in the subwindow labeled 
Pan Window. The portion of the zoomed Image shown in the main window will be the 
portion indicated by the hollow rectangle on the thumbnail image. Use the mouse left 
button to click and drag the rectangle to a new location on the thumbnail image. 
The panning option may be repeated as desired. 

6 To end the session with colorization, zooming, or panning, in the GUI labeled EOSView 
- Image Display Window - MyImageObject, click on the File menu and select Close. 

7	 Optional animation. In the GUI labeled EOSView - MyOutputFile.hdf, click on the 
Options menu, then select Animated images. 
A GUI labeled EOSView - Image Animation Window - MyOutputFile.hdf will be 

displayed. 
Optionally, click on the Options menu select Mode to select how the animation is to be 

run. Choose Stop at end, Continuous run, or Bounce. 
To end animation session, click on the File → Close. 

26.8.5.1.3 Viewing HDF-EOS Grid Objects 

This procedure describes how to use the EOSView tool to view science data in the HDF-EOS 
output file that are in HDF-EOS Grid format. These are generally the science data and not 
browse images. 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2.	 The output file is HDF-EOS and has been created and populated with metadata using the 
SDP Toolkit metadata tools. 

3. At least one object is an HDF-EOS Grid. 
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Viewing HDF-EOS Grid Objects 

1	 From the SSIT Manager, select Tools→ Product Examination → EOSView from the 
menu. 
The EOSView GUI will be displayed. 

2	 In the GUI labeled EOSView - MyOutputFile.hdf, double click on an Grid object listed 
for which data is to be inspected. A GUI labeled EOSView - Grid Select will be 
displayed. 
Information on Grid Information, Projection Information, Dimensions, Attributes for 

the selected object can be displayed by clicking on the appropriate checkboxes. 
3 In the GUI labeled EOSView - Grid Select, click on the Data Fields checkbox and then 

click on the OK button. Then double click on one of the data fields listed. 
•	 A GUI labeled EOSView - Grid - GridObjectName - Start/Stride/Edge will be 

displayed where GridObjectName will be replaced by the name of the Grid object 
selected in step 1. 

4	 To display the data in the form of a table of values, in the GUI labeled EOSView - Grid -
GridObjectName - Start/Stride/Edge, click on the checkboxes for both YDim and 
XDim and then click on the OK button. 

•	 A GUI labeled MyDataField will be displayed where MyDataField will be 
replaced by the name of the data field selected in step 2. 

5	 To display the data field in image form, in the GUI labeled MyDataField, click on the 
File menu and then select Make Image. A GUI labeled EOSView - Swath/Grid Image 
will appear, 

6	 Optional colorization, zooming, panning while zooming can be used to obtain your 
desired output. 

3	 To end the session with displaying Grid object, in the GUI labeled EOSView -
Swath/Grid, click on the File menu and select Close. The EOSView - Swath/Grid 
GUI will disappear. 

26.8.5.1.4 Viewing HDF-EOS Swath Objects 

This procedure describes how to use the EOSView tool to view science data in the HDF-EOS 
output file that are in HDF-EOS Swath format. These are generally the science data and not 
browse images. 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 

2.	 The output file is HDF-EOS and has been created and populated with metadata using the 
SDP Toolkit metadata tools. 

3. At least one object is an HDF-EOS Swath. 
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Viewing HDF-EOS Swath Objects 

1	 From the SSIT Manager, select Tools→ Product Examination → EOSView from the 
menu. 
The EOSView GUI will be displayed. 

2	 In the GUI labeled EOSView - MyOutputFile.hdf, double click on a Swath object listed 
for which data is to be inspected. 
A GUI labeled EOSView - Swath Select will be displayed. 
Information on Dimensions, Geolocation Mappings, Indexed Mappings, Geolocation 

Fields, Attributes for the selected Swath Object can be displayed by clicking on 
the corresponding checkboxes. 

3	 In the GUI labeled EOSView - Swath Select, click on the Data Fields checkbox and 
then click on the OK button. Then double click on one of the data fields listed. 
A GUI labeled EOSView - Swath - SwathObjectName - Start/Stride/Edge will be 

displayed where SwathObjectName will be replaced by the name of the Swath 
object selected in step 1. 

4	 To display the data in the form of a table of values, in the GUI labeled EOSView -
Swath - SwathObjectName - Start/Stride/Edge, click on the checkboxes for both 
ScanLineTra and PixelsXtrac and then click on the OK button. 

5	 To display the data field in image form, in the GUI labeled MyDataField, click on the 
File menu and then select Make Image. 
A GUI labeled EOSView - Swath/Grid Image will appear. 

6	 Optional colorization, zooming, panning while zooming features can be used in the GUI 
labeled EOSView - Swath/Grid Image to obtain your desired image. 

−	 To end the session with displaying Swath object, in the GUI labeled 
EOSView - Swath/Grid, click on the File → Close. 

26.8.5.1.5 Viewing HDF SDS Objects 

This procedure describes how to use the EOSView tool to view science data in the HDF-EOS 
output file that are in HDF SDS (standard HDF science data set) format. To view an HDF SDS 
object with the EOSView tool, execute the procedure steps that follow: 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 
2.	 The output file is HDF-EOS and has been created and populated with metadata using 

the SDP Toolkit metadata tools. 
3. At least one object is an HDF-SDS. 

Viewing HDF SDS Objects 
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1	 From the SSIT Manager, select Tools→ Product Examination → EOSView from the 
menu. 

The EOSView GUI will be displayed. 

2	 In the GUI labeled EOSView - MyOutputFile.hdf, double click on a SDS object listed 
for which data is to be inspected. 

A GUI labeled EOSView - Multi-Dimension SDS will be displayed. 

A number of checkboxes will be displayed, one for each of the dimensions in the selected 
SDS (there will be at least two, an X and a Y). 

3	 In the GUI labeled EOSView - Multi-Dimension SDS, click on two of the dimension 
checkboxes and then click on the Table button. Then double click on one of the data 
fields listed. 

A GUI labeled MySDS will be displayed where MySDS will be replaced by the name of 
the SDS object selected in step 1. 

4	 To display the data field in image form, in the GUI labeled MySDS, click on the File 
menu and then select Make Image. 

A GUI labeled EOSView - Image Display Window - MySDS will appear, 

5	 Optional colorization, zooming, panning while zooming can be used to obtain your 
desired output. 

6	 To end the session with displaying Swath object, in the GUI labeled EOSView - Image 
Display Window - MySDS, select File → Close from the menu. 

• The EOSView - Image Display Window - MySDS GUI will disappear. 

26.8.5.2 Data Visualization with the IDL Tool 

26.8.5.2.1 Viewing Product Data with the IDL Tool 

The following procedures describe how to use the IDL (Interactive Data Language) COTS tool

to inspect the data in the output file from a PGE. These procedures are geared toward binary and

ASCII formats, but can be extended to other formats supported by IDL including HDF, NetCDF,

and PGE. Consult the IDL references for details on these other formats.


The major activities addresses here include creating an image display, saving an image display,

creating a plot display, and saving a plot display.


The following is a list of tools, and or assumptions:

1.The SSIT Manager is running.

2.The output file is binary, ASCII, or one of the other IDL supported data formats.

3.IDL has been properly installed and is accessible to the user.


Viewing Product Data with the IDL Tool 

26-82 611-CD-510-001




1	 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 
An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 

will be run. 
2 Select the procedure depending upon the activity to perform. 
3 To end the IDL session, close any display windows remaining, then at the IDL prompt 

type quit, then press the Enter key. 
The IDL session will be closed. 

26.8.5.2.2 Creating an Image Display Using IDL 

The following procedure describes how to use the IDL Tool to create an image display. 

The following is a list of tools, and or assumptions:

1.The SSIT Manager is running.

2.The PGE output file to be examined is of an IDL-supported type/format (if in doubt, consult


the IDL Reference Guide 
3.IDL has been properly installed and is accessible to the user. 
4.For binary files, data is assumed to be 8-bit characters 

Creating an Image Display Using the IDL Tool - Binary Data 

1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 
An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 

will be run. 
2 At the IDL prompt, type OPENR,1,‘MyBinaryFilename’, press the Enter key. 

The MyBinaryFilename is the full path name and file name of the binary data file of 
known dimensions to read in. 

The single quotes (‘) must be included around the path/file name. 
The 1 is the logical unit number. 

3	 At the IDL prompt, type MyImage=BYTARR(dim1, dim2), press the Enter key. 
The MyImage is the name to be given to the image once created. 
The dim1 and dim2 are the dimensions of the input data. 

4 At the IDL prompt, type READU,1,MyImage, press the Enter key. 
5 At the IDL prompt, type TV,MyImage, press the Enter key. 

The image, MyImage, should then be displayed. 
6 At the IDL prompt, type LOADCT,3, press the Enter key. 

This command loads color table number 3. Other color tables are available 
7	 At the IDL prompt, type CLOSE,1, press the Enter key. 

This closes logical unit 1. 
Always close logical units or an error will result the next time an access is attempted. 

Creating an Image Display Using the IDL Tool - ASCII Data 
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1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 
An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 

will be run. 

2 At the IDL prompt, type OPENR,1,(‘MyASCIIfilename’), then press the Enter key. 

The MyASCIIfilename is the full path name and file name of the ASCII data file of 
known dimensions to read in. 

The single quotes (‘) must be included around the path/file name. 
The 1 is the logical unit number. 

3 At the IDL prompt, type MyImage=BYTARR(dim1,dim2), then press the Enter key. 

The MyImage is the name to be given to the image once created. 
The dim1 and dim2 are the dimensions of the input data. 

4 At the IDL prompt, type READF,1,MyImage, then press the Enter key. 

5 At the IDL prompt, type TV,MyImage, then press the Enter key. 

The image, MyImage, is displayed. 

6 At the IDL prompt, type LOADCT,3, then press the Enter key. 

This command loads color table number 3. Other color tables are available; refer to the 
IDL Reference Guide for more details. 

7 At the IDL prompt, type CLOSE,1, then press the Enter key. 

This closes logical unit 1.

Always close logical units or an error will result the next time an access is attempted.


Creating an Image Display Using the IDL Tool - PGM Data: 
1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 

An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 
will be run. 

2	 At the IDL prompt, type READ_PPM,”MyPGMfilename”,MyImage,r,g,b, then press 
the Enter key. 
The MyPGMfilename is the full path name and file name of the PGM formatted data file. 
The double quotes (“) must be included around the path/file name. 
The MyImage is the name to be given to the image created. 

3 At the IDL prompt, type TVLCT,r,g,b, then press the Enter key. 
Note that r,g,b color table syntax is used for most formatted file types in IDL. 

4 At the IDL prompt, type TV,MyImage, then press the Enter key. 
The image, MyImage, should then be displayed. 
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26.8.5.2.3 Saving an Image Display Using IDL 

The next procedure describes how to save an image display (once created) to either a data file or 
a graphic file. 

The following is a list of tools, and or assumptions: 
1. The SSIT Manager is running, IDL is running 
2.	 The PGE output file to be examined is of an IDL-supported type/format (if in doubt, 

consult the IDL Reference Guide 
3. For binary files, data is assumed to be 8-bit characters 
4.	 The image display is to be saved in a binary (8-bit) or ASCII (comma-delimited 

characters) format. 

Save an image display using IDL - Binary Data 

1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 
An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 

will be run. 
2	 At the IDL prompt, type OPENW,1,(‘MyBinaryFilename.bin’), then press the Enter 

key. 
The MyBinaryFilename.bin is the full path name and file name of the binary data file to 

write out. 
The single quotes (‘) must be included around the path/file name. 
The 1 is the logical unit number. 

3 At the IDL prompt, type WRITEU,1,MyImage, then press the Enter key. 
The MyImage is the name of the image to save. 

4 At the IDL prompt, type CLOSE,1, then press the Enter key. 
This closes logical unit 1.

Always close logical units or an error will result the next time an access is attempted.


26.8.5.2.4 Save an image display using IDL - ASCII Data 

1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 

An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 
will be run. 

2 At the IDL prompt, type OPENW,1,(‘MyASCIIfilename.asc’), then press the Enter key. 

The MyASCIIfilename.asc is the full path name and file name of the binary data file to 
write out. 

The single quotes (‘) must be included around the path/file name. 
The 1 is the logical unit number. 
3 At the IDL prompt, type PRINTF,1,MyImage, then press the Enter key. 
The MyImage is the name of the image to save. 
4 At the IDL prompt, type CLOSE,1, then press the Enter key. 
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This closes logical unit 1.

Always close logical units or an error will result the next time an access is

attempted.


26.8.5.2.5 Save an image display using JPEG Data

1 At the IDL prompt, type

WRITE_JPEG,”MyJPEGfilename.jpg”,MyImage, press Return.

• The MyJPEGfilename.jpg is the full path name and file name of the JPEG 
data file to write out. 

26.8.5.2.6 Creating a Plot Display Using IDL 
The procedures for creating a plot display are clearly described in the IDL 

manuals; some exceptions are clarified below. 
Setting axis limits for a plot: 
1 At the IDL prompt, type 
SURFACE,MyPlot,AX=70,AZ=70,xrange=[0,20],yrange=[0,20]zrange=[0,30], 
and press Return. 
• The MyPlot is the IDL session variable (to which you have assigned some 
math function, program output, image, etc.). 
• AX sets the displayed rotation about the X axis. 
• AZ sets the displayed rotation about the Z axis. 
• The values of xrange set the displayed portion of the X axis. 
• The values of yrange set 

he displayed portion of the Y axis. 
• The values of zrange set the displayed portion 
f the Z axis. 

• The plot will then be displayed to the screen.

26.8.5.2.7 Setting axis titles for a plot:

1 At the IDL prompt, type SURFACE,MyPlot,AX=70,AZ=70,xtitle=’this is X’,

ytitle=’this is Y’,ztitle=’this is Z’, and press Return.

•	 The MyPlot is the IDL session variable (to which you have assigned some math 

function, program output, image, etc.). 
• The value of xtitle sets the displayed title of the X axis. 
• The value of ytitle sets the displayed title of the Y axis. 
• The value of ztitle sets the displayed title of the Z axis. 
• The plot will then be displayed to the screen. 
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26.8.5.2.8 Saving a Plot Display Using IDL 
Saving a displayed plot to a permanent file: 

1 	 At the IDL prompt, type MyPlotDisplay=SURFACE,MyPlot,AX=80,AZ=20, and press 
Return. 
• The MyPlotDisplay is session name for the displayed plot of MyPlot. 
• The MyPlot is the IDL session variable (to which you have assigned some math 

function, program output, image, etc.). 
2 At the IDL prompt, type SAVE,MyPlotDisplay,4,’MyPlotOutput.ps’, press Return. 

• The MyPlotDisplay is the session name of the plot display . 
• The MyPlotOutput.ps is the desired name for the saved file. 
3. 	 The SAVE option number 4 sets the output file type to PostScript (ps). There are 

other options, of course (consult the IDL manuals). 

26.8.5.3 Raster Mapping Fundamentals 

This procedure describes how to use the IDL Tool to perform basic raster mapping functions. 
These are spatial functions involving map projections, but do not include surface modeling (also 
called “2.5D”) or two-dimensional spectral functions. 

The following is a list of tools, and or assumptions: 
1. The SSIT Manager is running. 
2. IDL is running 

26.8.5.3.1 Raster Mapping - Global Data Set Image 
1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 

An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 
will be run. 

2	 At the IDL prompt, type TV,MyImage, then press the Enter key. 
The MyImage is the image name of the global image data set. 
The image, MyImage, should then be displayed. 

3	 At the IDL prompt, type MAP_SET,/ORTHOGRAPHIC, then press the Enter key. 
IDL also supports other map projections. Refer to IDL Reference Guide. 

4	 At the IDL prompt, type MyNewImage=MAP_IMAGE(MyImage,startx,starty,/BILIN), 
then press the Enter key. 
The MyNewImage is the name to assign to the resulting image. 
The MyImage is the name of the original global image data set. 

5	 At the IDL prompt, type TV,MyNewImage,startx,starty, then press the Enter key. 
The image MyNewImage should then be displayed. 

6	 Optional overlay Lat/Long. At the IDL prompt, type MAP_GRID, then press the Enter 
key. 
This overlays Lat/Long graticule onto MyNewImage. 

7	 Optional overlay world coastlines. At the IDL prompt, type MAP_CONTINENTS, press 
the Enter key. 
This overlays world coastlines onto MyNewImage. 
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For a sub-global data set image, one having geocentric-LLR coordinates defined for subintervals

of longitude and latitude (e.g. from -88 to -77 degrees East Longitude and 23 to 32 degrees North

Latitude.


The following is a list of tools, and or assumptions:

1.The SSIT Manager is running.

2.IDL is running


26.8.5.4 Raster Mapping - Sub-Global Data Set Image 

1 From the SSIT Manager, select Tools→ Product Examination → IDL from the menu. 

An xterm (on the AIT Sun) will be displayed within which the IDL command interpreter 
will be run. 

2 At the IDL prompt, type TV,MyImage, then press the Enter key. 

The MyImage is the image name of the sub-global image data set. 

The image, MyImage, should then be displayed. 

3	 At the IDL prompt, type MAP_SET,/MERCATOR,LIMIT=[lat1,lon1,lat2,lon2], then 
press the Enter key. 

The lat1, lon1, lat2, and lon2 specify the latitude and longitude intervals of the sub­
global image data set. 

4	 At the IDL prompt, type 
MyNewImage=MAP_IMAGE(MyImage,startx,starty,/BILIN.LATMIN=lat1,LATMAX 
=lat2,LONMIN=lon1,LONMAX=lon2), then press the Enter key. 

The MyNewImage is the name to assign to the resulting image. 

The MyImage is the name of the original global image data set. 

The lat1, lon1, lat2, and lon2 specify the latitude and longitude intervals of the sub­
global image data set. 

5 At the IDL prompt, type TV,MyNewImage,startx,starty, then press the Enter key. 

The image MyNewImage should then be displayed. 

6	 Optional overlay Lat/Long. At the IDL prompt, type MAP_GRID, then press the Enter 
key. 

This overlays Lat/Long graticule onto MyNewImage. 

7	 Optional overlay world coastlines. At the IDL prompt, type MAP_CONTINENTS, then 
press the Enter key. 

This overlays world coastlines onto MyNewImage. 
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26.9Science Software Integration and Test (SSI&T) Release RELEASE 
4. 
The process of SSI&T or integration of EOS Instrument Science Software into the ECS has been 
developed and refined over three iterations of ECS. IR1, the Pre-Release B Testbed and Release 
RELEASE 4. The latter will be the at-launch system supporting EOS-AM1 instruments. 
Although every attempt has been made to keep integration procedures for science software 
consistent through succeeding releases, basis architectural differences have led to significant 
variances. This section describes the architecture of the last iterations of ECS. 

26.9.1 RELEASE 4 Architecture: Overview 

The Release RELEASE 4 architecture can be grouped into the following four categories: 

•	 Data storage and management is provided by the Data Server Subsystem (DSS), 
with the functions needed to archive science data, search for and retrieve archived 
data, manage the archives, and stage data resources needed as input to science 
software or resulting as output from their execution. The Data Server Subsystem 
provides access to earth science data in an integrated fashion through an 
Application Programming Interface that is common to all layers. 

•	 Information search and data retrieval is provided by the science user interface 
functions in the Client Subsystem (CLS), by information search support functions 
in the Data Management Subsystem (DMS), and by capabilities in the 
Interoperability Subsystem (IOS) which assist users in locating services and data. 

•	 Data processing is provided by the Data Processing Subsystem (DPS) for the 
science software; and by capabilities for long and short term planning of science 
data processing, as well as by management of the production environment 
provided by the Planning Subsystem (PLS). Routine data processing and re­
processing will occur in accordance with the established production plans. In 
addition ECS will provide “on-demand processing”, where higher level products 
are produced only when there is explicit demand for their creation. 

•	 Data ingest is provided by the Ingest Subsystem (INS), which interfaces with 
external applications and provides data staging capabilities and storage for an 
approximately 1-year buffer of Level 0 data (so that reprocessing can be serviced 
from local storage).The number of external interfaces which ECS will have is 
potentially very large, and the interfaces can serve very diverse functions, such as 
high-volume ingest of level 0 data and low-volume ingest of data from field 
campaigns. 

Table 26.9.3-1 provides procedural differences: Testbed to RELEASE 4. 

26.9.1.1 ECS Subsystems 

The following sub-sections provide brief overviews for each of these subsystems. More detailed 
discussions of their design breakdown can be found in 305-CD-020-002. 
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26.9.1.2 Client Subsystem (CLS) 

The Client provides users with an interface through which they can access ECS services and 
data. It also gives science software access to the ECS services, as well as direct access to ECS 
data. Access is provided through graphic user interface (GUI) application tools for displaying the 
various kinds of ECS data (e.g., images, documents, tables), and libraries representing the client 
APIs to ECS services. The client subsystem follows an object oriented design. The design is built 
around a core set of ‘root’ objects from which all other software will inherit its behavior. 

26.9.1.3 Interoperability Subsystem (IOS) 

The Interoperability subsystem provides an advertising service. It maintains a database of 
information about the services and data offered by ECS, and provides interfaces for searching 
this database and for browsing through related information items. For example, ESDTs are made 
visible through the advertising service. The Client Subsystem provides the user interface which 
enables access to the IOS. 

26.9.1.4 Data Management Subsystem (DMS) 

The Data Management subsystem provides three main functions: 

•	 Provide end-users with a consolidated logical view of a distributed set of data 
repositories. 

•	 Allow end-users to obtain descriptions for the data offered by these repositories. 
This also includes descriptions of attributes about the data and the valid values for 
those attributes. 

•	 Provide data search and access gateways between ECS and external information 
systems. 

26.9.1.5 Data Server Subsystem (DSS) 

The Data Server subsystem provides the management, cataloging, access, physical storage, 
distribution functions for the ECS earth science data repositories, consisting of science data and 
their documentation. The Data Server provides interfaces for other ECS subsystems which 
require access to data server services. The Data Server Subsystem consists of the following 
principal design components: 

•	 Database Management System - The Data Server subsystem will use database 
technology to manage its catalog of earth science data, and for the persistence of 
its system administrative and operational data. 

•	 Document Management System - Web server and database technology are used to 
implement a document management system to provide storage and information 
retrieval for guide documents, science software documentation, and ECS earth 
science related documents. 

•	 Data Type Libraries - The Data Server will use custom dynamic linked libraries 
(DLLs) to provide an extensible means of implementing the variety of ECS earth 
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science data types and services, and will provide a consistent interface for use by 
other ECS subsystems requiring access to those services and data. 

•	 File Storage Management System - This component provides archival and staging 
storage for data. 

•	 Distribution System - The Data Server provides the capabilities needed to 
distribute bulk data via electronic file transfer or physical media. 

26.9.1.6 Ingest Subsystem (INS) 

This subsystem deals with the initial reception of all data received at an EOSDIS facility and 
triggers subsequent archiving and processing of the data. The ingest subsystem is organized into 
a collection of software components (e.g., ingest management software, translation tools, media 
handling software) from which those required in a specific situation can be readily configured. 
The resultant configuration is called an ingest client. Ingest clients can operate on a continuous 
basis to serve a routine external interface; or they may exist only for the duration of a specific ad­
hoc ingest task. The ingest subsystem also standardizes on a number of possible application 
protocols for negotiating an ingest operation, either in response to an external notification, or by 
polling known data locations for requests and data. 

26.9.1.7 Data Processing Subsystem (DPS) 

The main components of the data processing subsystem - the science algorithms or Product 
Generation Executives (PGEs) - will be provided by the science teams. The data processing 
subsystem provides the necessary hardware resources, as well as a software environment for 
queuing, dispatching and managing the execution of these algorithms. The processing 
environment will be highly distributed and will consist of heterogeneous computing platforms. 
The AutoSys COTS tool is used as the scheduling engine. The tool is designed to manage 
production in a distributed UNIX environment. The DPS also interacts with the DSS to cause the 
staging and de-staging of data resources in synchronization with processing requirements. 

26.9.1.8 Planning Subsystem (PLS) 

The Planning Subsystem provides the functions needed to plan routine data processing, schedule 
on-demand processing, and dispatch and manage processing requests. The subsystem provides 
access to the data production schedules at each site, and provides management functions for 
handling deviations from the schedule to operations and science users. The Planning subsystem 
provides several functions to account for: 

•	 a processing environment which eventually will be highly distributed and consist 
of heterogeneous computing platforms 

• existence of inter-site and external data dependencies 

• dynamic nature of the data and processing requirements of science algorithms 

• need for high availability 
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•	 providing a resource scheduling function which can accommodate hardware 
technology upgrades 

•	 support for on-demand processing (as an alternative to predominantly routine 
processing) 

•	 ability to provide longer-term (e.g., monthly) processing predictions as well as 
short term 

(e.g., daily) planning and scheduling 

26.9.1.9 Communications Subsystem (CSS) 

The CSS helps manage the operation of distributed objects in ECS, by providing a 
communications environment. The environment allows software objects to communicate with 
each other reliably, synchronously as well as asynchronously, via interfaces that make the 
location of a software object and the specifics of the communications mechanisms transparent to 
the application. 

In addition, CSS provides the infra-structural services for the distributed object environment. 
They are based on the Distributed Computing Environment (DCE) from the Open Software 
Foundation (OSF). DCE includes a number of basic services needed to develop distributed 
applications, such as remote procedure calls (rpc), distributed file services (DFS), directory and 
naming services, security services, and time services. 

Finally, CSS provides a set of common facilities, which include legacy communications services 
required within the ECS infrastructure and at the external interfaces for file transfer, electronic 
mail, bulletin board and remote terminal support. The Object Services support all ECS 
applications with inter-process communication and specialized infra- structural services such as 
security, directory, time, asynchronous message passing, event logging, lifecycle service, 
transaction processing and World Wide Web (WWW) service. 

26.9.1.10 Management Subsystem (MSS) 

The Management Subsystem (MSS) provides enterprise management (network and system 
management) for all ECS resources: commercial hardware (including computers, peripherals, 
and network routing devices), commercial software, and custom applications. With few 
exceptions, the management services will be fully decentralized, such that no single point of 
failure exists. 

MSS provides two levels of an ECS management view: the local (site/DAAC specific) view, 
provided by Local System Management (LSM), and the enterprise view, provided by the 
Enterprise Monitoring and Coordination (EMC) at the SMC. Enterprise management relies on 
the collection of information about the managed resources, and the ability to send notifications to 
those resources. For network devices, computing platforms, and some commercial of the shelf 
software, MSS relies on software called “agents” which are usually located on the same 
device/platform and interact with the device’s or platform’s control and application software, or 
the commercial software product. However, a large portion of the ECS applications software is 

26-92 611-CD-510-001




custom developed, and some of this software - the science software - is externally supplied. For 
these components, MSS provides a set of interfaces via which these components can provide 
information to MSS (e.g., about events which are of interest to system management such as the 
receipt of a user request or the detection of a software failure). These interfaces also allow 
applications to accept commands from MSS, provided to MSS from M&O consoles (e.g., an 
instruction to shut down a particular component). Applications which do not interact with MSS 
directly will be monitored by software which acts as their “proxies”. For example, the Data 
Processing Subsystem (DPS) acts as the proxy for the science software it executes. DPS notifies 
MSS of events such as the dispatching or completion of a PGE, or its abnormal termination. 

MSS uses HP OpenView as the centerpiece of its system management solution. The information 
collected via the MSS interfaces from the various ECS resources is consolidated into an event 
history database, some on a near real-time basis, some on a regular polling basis (every 15-to 30 
minutes) as well as on demand, when necessitated by an operator inquiry. The database is 
managed by Sybase, and Sybase query and report writing capabilities will be used to extract 
regular and ad-hoc reports from it. Extracts and summaries of this information will be further 
consolidated on a system wide basis by forwarding it to the SMC (also on a regular basis). 

MSS provides fault and performance management and other general system management 
functions such as security management (providing administration of identifications, passwords, 
and profiles); configuration management for ECS software, hardware, and documents; Billing 
and Accounting; report generation; trending; request tracking; and mode management 
(operational, test, simulation, etc.). 

26.9.1.11 Internetworking Subsystem (ISS) 

The ISS provides local area networking (LAN) services at ECS installations to interconnect and 
transport data among ECS resources. The ISS includes all components associated with LAN 
services including routing, switching, and cabling as well as network interface units and 
communications protocols within ECS resources. 

The ISS also provides access services to link the ECS LAN services to Government-furnished 
wide-area networks (WANs), point-to-point links and institutional network services. Examples 
include the NASA Science Internet (NSI), Program Support Communications Network (PSCN), 
and various campus networks “adjoining” ECS installations. 
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Figure 26.9.1-1. ECS Communications /Interetworking Subsystems 

26.9.2 Implications for SSI&T Functions. 

Table 26.9.3-1 lists the major Functions that will be encountered by SSI&T staff. These 
architectural functions characterize the RELEASE 4 systems. The major functions are due to the 
presence of Ingest and Data Server Subsystems in RELEASE 4. 
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Table 26.9.3.1. Major SSI&T Functions within VERSION 2.0 
Function Release RELEASE 4 

System Operation All servers must run and 
communicate with each 
other; bring up manually, or 
use ECS Assist tool. 

Ingest Ancillary Data 
Granules 

Ingest GUI, ESDTs must be 
visible to ADV server. 

ESDT Insert Use Ingest 
ESDT Verification verify through ADV 
DAP, SSAP Insert Use Ingest 
PDPS Database Population More attributes, production 

rules 

PGE Operation When all data is available; 
DPR activated. 
No automatic reprocessing 
Complex chaining through 
production rules. 

File Access verify presence through 
ADV; ftp from SDSRV; 
access to multiple sites 

Multi-file Granule Support Files inserted together, 
accessed as a single granule. 

Subscription Management Subscription Manager 

26.10 Using ECS Assistant to View ECS Science Data Server 
Database 
ESDTs and their granules stored in the archive are managed using an ECS Science Data server 
database. ECS Assistant provides an easy way to review the records stored in this database by 
using the ECS Assistant DB Viewer. There are two main windows in the DB Viewer. The first 
is called Collections and is used to display ESDT information included in the Collection database 
table. Information listed in this table includes ESDT short names, times last updated, types, etc. 
If an ESDT is added to the Science Data Server, its record will be shown in this window. The 
other window is called Granules and is used to display information included in the Granule 
database table. If a granule is inserted for an ESDT, the granule information will be listed in this 
window if its ESDT is highlighted in the Collection window. In addition to these two main 
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windows, this DB Viewer GUI can also show ESDT database validation rules, Product Specific 
Attributes, (PSA) information, and summary information about the database reviewed. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1 The ECS Assistant has been properly installed. 

2 The ECS Subsystem Manager is running. 

3 The environment variables for using the database have been set correctly. 

26.10.1 Starting ECS monitor GUI: 
1 Invoke the ECS Assistant GUI. 

• The ECS Assistant GUI will be launched. 

2 At the ECS Assistant GUI, select ESDT Manager GUI by clicking the ESDT Manager. 

• The ESDT manager GUI will appear. 

3	 At the ECS ESDT Manager GUI, select the DB Viewer by clicking the DB Viewer 
button. 

• The Database Login GUI will appear as shown in Figure 26.10-1. 

• Fill in the fields to point to the specific database for the mode used. 

• Click Login to open the DB Viewer. 

• The DB Viewer GUI will appear as shown in Figure 26.-10-2 

• ESDTs are listed in the Collections window. 

Figure 26.10-1. Database Login GUI 
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Figure 26.10-2. DB Viewer GUI 

4	 To view the inserted granules for a selected ESDT, first select an ESDT by clicking its 
short name in the Collections window. 

• The selected ESDT is highlighted. 
• Granule information for that ESDT, if there is any, will be listed in the Granules 

window. 
5 To exit, click the EXIT button. This will end the DB Viewer GUI. 
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26.10.2 Using ECS Assistant to View Database 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The ECS Assistant has been properly installed. 

2. The ECS Subsystem Manager is running. 

To routinely start up the ECS monitor GUI, execute the procedure steps that follow: 

1	 At the ECS Subsystem Manager GUI, select a mode by clicking a mode in the mode 
list. 

• The mode should be the one to be used for SSI&T. 
• Once the mode is selected, the color of the subsystem name list is changed. 

2	 Select a subsystem by clicking the radio button next to the subsystem name under the 
subsystem component window. 

• The selected subsystem radio button will be highlighted. 
• The components corresponding to that the subsystem will be displayed in the 

component window. 
3 Select a component by clicking a component name under the component window. 

• All the servers for that selected component will be displayed in the server window. 
4 Click the monitor button from the common tasks. 

• This will invoke the Server Monitor GUI window as shown in Figure 26.10-3. 
• The status “UP/DOWN” indicates whether the server is running. 

5 To see which host each server running on, click the cdsping all servers… button. 
• This will invoke the cdsping GUI as indicated in Figure 26.10.4. 
• The host name for each running server is listed 

6	 Both Server monitor GUI and cdsping GUI can be updated by clicking the update 
button in the GUI. 
This will cause the list to update to the current status. 

7 To monitor other servers, repeat steps 1-6.

8 To exit, click the EXIT button. This will end the monitor GUI.
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Figure 26.10-3. Server Monitor GUI 
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Figure 26.10-4. cdsping GUI 

26.10.3 Using Browser to View ECS Science PDPS/IOS Database 
Connect to the SDSRV database with login information as follows: 

Server Name: p0acg01_srvr 

User Name: sdsrvApp 

Password: welcome 

The Browser lets you view all the tables in the SDSRV database with the mode you have 
selected. 

The following tables are useful to track down the problems in insert *.met: 

1. DsDeDictionaryAttribute 

2. DsMdAddtionalAttributes 

3. DsMdCollections 
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4. DsMdGranules 

26.11 Installing ESDTs and Inserting Granules on the Science Data 
Server 

26.11.1 Required Servers for Installing ESDT’s 

The following servers need to be started and running before installing ESDTs (with GDAAC 
machine names as examples): 

• Science Data Server (g0acs03) 

• Storage Management Servers (g0icg01, g0drg01, g0dps02) 

• Data Distribution Servers (g0dps02) 

• Subscription Server (g0ins01) 

• Advertising Server (g0ins02) 

• Data Dictionary Server (g0ins02) 

26.11.2. Installing/Removing (ESDT/DLL) using the Science Data Server Operator 
GUI 

Before the ECS can process data, an Earth Science Data Type must be installed into the system 
via the Science Data Server (SDSRV). The ESDT allows the system to recognize a particular 
data type and also provides services for accessing the data in the form of a Dynamic Link 
Library (DLL). The following procedures give step-by-step instructions on configuring the 
ESDT and installing the ESDT using the Science Data Server GUI., see Figure 26.11.1. Science 
Dataserver Operator GUI. 

Installing a single Earth Science Data Type (ESDT) or Dynamic Link Library (DLL) 
1	 Copy the ESDT descriptor file and ESDT/DLL file from the source directory to the 

directory under the current mode of operations, The ESDT descriptor files are installed in 
the specified mode. 

DLL’s located : /usr/ecs/<mode>/CUSTOM/lib/ESS 

ESDT Descriptors Located: /usr/ecs/<mode>/CUSTOM/data/ESS 

2	 Ensure that the following servers are currently executing: Advertising Service on the 
appropriate ADSHW HWCI server machine, Data Dictionary Service on the appropriate 
DMGHW HWCI server machine, Science Data Server on the appropriate ACMHW 
HWCI server machine and the Subscription Service that operates on the appropriate 
CSS server machine. 

3	 Start the SDSRV GUI by entering the following at the UNIX prompt on the SDSRV GUI 
workstation: 
a) telnet to (SDSRV) p0acs03 [e.g.] 
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b)	 login: ID 
password: 

c) Login to DCE (dce_login <name> <Password>), setenv DISPLAY ….:0.0 

d) cd /usr/ecs/<mode>/CUSTOM/utilities/EcDsSdSrvGuiStart <mode> 
4	 On the main screen select the Data Types tab. A list of the ESDTs that have already 

been installed on the SDSRV will be displayed. 
5 Click the Add button below to bring up the Add Data Type window. 
6 Descriptor Filename: enter path to where the ESDT/DLL is located, including the full 

ESDT descriptor. Archive ID: field. Note: The descriptor filename and DLL Filename 
will require the complete directory path name as part of the file name which is the same 
directory as was specified in step 1 above. (isolate the particular Data Type from the 
larger List, by using a unique sequence of letters or numbers at the end of the full 
path to better identify the Data Types ie;/*___*).  To specify specific directories, the 
File.. button to the right of the Descriptor Filename and DLL Filename data entry fields 
will bring up a standard file selection GUI for this purpose. Also note that the Archive 
ID field will be constructed using the DSS Storage Management Staging Server UR that 
is found in the Science Data Server configuration file. The Science Data Server 
Configuration file is located in: 
/usr/ecs/<mode>/CUSTOM/cfg/EcDsScienceDataServer.CFG. 

Example: If the DSSSTMGSTAGEINGSERVERUR field was set to 
DRP1_OPS then the Archive ID fields would be set to DRP1_OPS. 

7 Click the Ok button, this will cause the Add Data Type window to initiate installation of 
the ESDT/DLL into the Science Data Server. 

−	 The Science Data Server GUI will respond in a short time with a window 
stating that MM/DD/YY HH/MM Finished adding ESDT’s.Also, the 
ESDT will appear alphabetically on the Science Data Server - Data 
Types list under the Data Types tab. 
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Figure 26.11.1. Science Dataserver Operator GUI. 
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26.11.3 Granule Insert into Science Data Server 

The Science Data Server subsystem includes a utility that will allow users to manually insert a 
data granule into the ECS. The tool will prompt the user for key inputs for The Science Data 
Server subsystem includes a utility that will allow users to manually insert a data granule into the 
ECS. The tool will prompt the user for key inputs for inserting the granule. The following 
procedures describe this process. 

1	 Ensure that the Science Data Server subsystem is currently executing on the appropriate 
ACMHW HWCI server machine. Tested on p0acs03. 

2	 Start the Science Data Server test utility by entering the following at the UNIX prompt on 
the SDSRV workstation: 

• setenv MODE TS1 
• cd /usr/ecs/<mode>/CUSTOM/bin/DSS/ 
• source ../ ../utilities/EcCoEnvCsh 
•	 /usr/ecs/<mode>/CUSTOM/bin/DSS/dttest6 ConfigFile 

/usr/ecs/<mode>/CUSTOM/cfg/EcDsScienceDataServerClient.CFG 
• ecs_mode <mode> 

3 The following selection menu is displayed: 
• INSERT granule 
• INSERT granule with browse file 
• ACQUIRE granule with date 
• ACQUIRE granule with a UR 
• DELETE granule 
• Exit 

Please make selection=> 
• Choose option 1 to perform the search and acquire. 

4	 The program indicates that the search process will take place first by displaying the message 
“Executing insert ..... “. The user is prompted to enter the datatype of the data that will be 
inserted. For example: 

• Enter data type=> AST_L1B 
5 The program will then prompt the user for the full path name of the data file. For example: 

• Enter datafile name (full path)=>/tmp/:SC:AST_L1BT:1391:1.EOSHDF 
6 The program will then prompt the user for the full path name of the metadata file. 

For example: Enter data metafile name(full path)=>/tmp/AST_L1BT.MCF 
7	 The program will then give status on the success of the insert. The following messages 

should appear on the successful insert: 
• Insert science data only… 
• Trying to make a request to {:DSSDSRV} Success. 

8	 The user should hit return at this prompt and the program will redisplay the first menu 
that was given in step 3. The user can then choose option 6 to exit. 
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26.11.4 Acquire a Granule from Science Data Server 

The Science Data Server subsystem includes a utility that will allow users to manually search 
and retrieve (acquire) a data granule from the ECS. The tool will prompt the user for key inputs 
for acquiring the granule. The following procedures describe this process. 

Acquiring a Granule from the Science Data Server 
1 Ensure that the Science Data Server subsystem is currently executing on the appropriate 

ACMHW HWCI server machine. Tested on p0acs03. 
2 Start the Science Data Server test utility by entering the following at the UNIX prompt on 

the SDSRV workstation: 
• setenv MODE TS1 
• cd /usr/ecs/<mode>/CUSTOM/bin/DSS/ 
• source ../ ../utilities/EcCoEnvCsh 
•	 /usr/ecs/<mode>/CUSTOM/bin/DSS/dttest6 ConfigFile 

/usr/ecs/<mode>/CUSTOM/cfg/EcDsScienceDataServerClient.CFG 
• ecs_mode <mode> 

3 The following selection menu is displayed: 
• INSERT granule 
• INSERT granule with browse file 
• ACQUIRE granule with date 
• ACQUIRE granule with a UR 
• DELETE granule 
• Exit 
Please make selection=> 

• Choose option 3 to perform the search and acquire. 
4	 The program indicates that the search process will take place first by displaying the 

message “Executing search ..... “. The user is prompted to enter a hostname. Enter the 
hostname of the machine on which the Science Data Server process is executing: 

• Enter hostname=> dss2 
5	 The user is prompted to enter a data type. Enter the ESDT short name of the type of data 

that is to be acquired. An example: 
• Enter data type=> AST_L1BT 

6	 The user is prompted to enter a start and end date. These dates indicate a range over 
which the user would like to search the database for data of the given type. The start and 
end dates will narrow the search to those data granules that were collected within that 
time range. Times are given in the format mm/dd/yy. For example: 

• Enter starting date(mm/dd/yy)=> 07/04/97 
• Enter end date(mm/dd/yy)=> 07/05/97 

7	 After the start and end dates are entered the utility will make a request of the Science 
Data Server and the following message will be displayed: 

• Trying to make a request to [:DSSDSRV]Ä
A table of data granules will be displayed to the user if any were found within the given

time range. For example, if the user had requested to display all of the data granules for
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the ESDT AST_L1BT within a certain time range, the following table would be 
displayed: 

• UR Type Create Date Size 
• AST_L1BT SC:AST_L1BT:1390 
• AST_L1BT SC:AST_L1BT:1391 
• AST_L1BT SC:AST_L1BT:1322 
• AST_L1BT SC:AST_L1BT:1289 
• AST_L1BT SC:AST_L1BT:1299 

The table displays the data type (AST_L1BT) and UR (i.e., SC:AST_L1BT:1390) for 
each granule found. 
In addition to the table, a list of the granules with a corresponding numerical index will 
be displayed with a prompt to the user to enter the index of the granule that they wish to 
acquire. An example of the indexed list follows: 
NOW ENTERING ACQUIREÄ
There is(are)5 in the collectionÄ
Index = 0 AST_L1BT SC:AST_L1BT:1390 Index = 1 AST_L1BTÄ
SC:AST_L1BT:1391 Index = 2 AST_L1BT SC:AST_L1BT:1322 Index = 3Ä
AST_L1BT SC:AST_L1BT:1289 Index = 4 AST_L1BT SC:AST_L1BT:1299Ä
Please enter the index of the associated URÄ

8 At this time the user should enter the numerical index of the granule that they wish to 
acquire and hit enter. 

9 The SDSRV utility will prompt the user for a media type, the type of media on which the 
data will be retrieved: 

• Valid Media Types: 
• FtpPull 
• FtpPush 
• 8MM 
• 4MM 
• CDROM 
• 9TRK 
• Enter media type (case sensitive)=> 

The user should enter one of the values of the valid media 
types. If the user entered FtpPush, the user will expect the data to be ftp’d to a given 
directory. 

10 After the user has entered the Media type, the utility will prompt the user for the media 
format. The media format should be entered as “FILEFORMAT” 

Enter mediaformat=> FILEFORMAT 
11 After the user has entered the Media format, the utility will prompt the user for the user 

profile id. This entry can be any alphanumeric character. 
Enter userProfID => a 

12	 After the user has entered the user profile id, the utility will prompt the user for a user id 
and associated password. The user id/password will be used for authorization to perform 
the ftp of the data file from the archive area to the user-specified directory. The password 
field will not be echoed to the screen. The following is only an example. The user 
should use a valid user id/password within the current environment. 
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Enter username=> sdsrv 
Enter password=> 

13 The next entry that the user must enter is the host id of the machine to which they want 
the data ftp’d. Enter a valid host name as follows: 

Enter host=> dss2 
14 After the host id, the user must enter the fully qualified destination directory to which the 

file will be ftp’d: 
Enter destination=> /tmp 

15 After the destination directory has been entered, the utility will give the following 
message: 

Trying to make a request to [:DSSDSRV] 
If the acquire operation is successful, the utility will give the following message: 
Acquire successful. 
Please <CR> to continue. 

16 The user should hit return at this prompt and the program will redisplay the first menu 
that was given in step 3. The user can then choose option 5 to exit. 

26.11.5 Removing ESDTs using the Command Line: 

Procedures: 
1 telnet to (SDSRV) p0acs03[e.g.] 
2 login: id, password: 

3 Login to DCE (dce_login <name> <Password>), setenv DISPLAY ….:0.0 

4 cd dbr 
5 source dx.csh 
%dbr 
First delete ESDT”s from the Advertisement Subsystem: 
************************************************************************ 
6 rlogin p0ins02-l cmts1Ä
7 Login to DCE (dce_login <name> <Password>), setenv DISPLAY ….:0.0�
8 rlogin p0ins02 -l iosÄ
1. Login to DCE (dce_login <name> <Password>), setenv DISPLAY ….:0.0�
10 cd /usr/ecs/OPS/CUSTOM/utilitiesÄ
11 setenv MODE OPSÄ
12 source EcCoEnvCshÄ
13 cd /usr/ecs/OPS/CUSTOM/bin/IOSÄ

ContributionDriver OPSÄ
awhiteleÄ
awhiteleÄ
3 
2 

14 your_short_name_here 
• y 
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# Success is when the "<" prompt returns

# To make sure the advertisements are deleted from the database

15 incagold% isql -Uios_role -Pwelcome –Sp0ins02_srvr


• [If not OPS mode] 
•	 1> use IoAdAdvService_MODE 

[where MODE is your mode, e.g. TS1] 
• [if OPS mode} 

1> use IoAdAdvService 
2> go 
1> select * from IoAdAdvMaster where title like "%your_short_name_here%" 
2> go 

Result should be no rows returned. 
If you do get rows returned, the delete from advertisement did not work. 
************************************************************************ 
Then delete ESDT 
************************************************************************ 
16 rlogin [p0acs03] -l id, pw: 
17 Login to DCE (dce_login <name> <Password>), setenv DISPLAY ….:0.0 
18 cd /usr/ecs/OPS/CUSTOM/utilities 
19 EcDsSrRmesdt OPS your_short_name_here 
# Success is no error msgs 
************************************************************************ 
Kill servers -- AFTER WARNING EVERYONE WORKING IN YOUR MODE! 
************************************************************************ 
20 Using ECS Assistant : # kill Sdsrv & HdfEosSrv & AdSrvr 
************************************************************************ 
#This will clean up DCE ‘s. Using ECS Assistant : # Restart serversl Sdsrv & HdfEosSrv 
& AdSrvr 
************************************************************************ 
• # start Sdsrv & HdfEosSrv on [p0acs03] 
• # start SubSrvr on [p0ins02] 
# (cleanup done automatically) 
• sdsrv.startup OPS 
• ios-dm-mss.startup OPS 
************************************************************************ 
Now reinstall the ESDT on SDSRV 

26.12 Production Planning Considerations 
1	 During normal operations it is expected that the Production Planner will not have to add PRs 

to the PDPS database very frequently. The frequency of this activity is, to some extent, 
determined by the SCF responsible for the science software. 
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•	 The PR is a template request to generate a particular data product and results in a 
production run of the associated SCF-provided PGE. 

•	 PR specifies a range (temporal, orbit, or tile) over which the data products are to be 
produced or the PGEs are to be scheduled. 

• PR might request that the data product be produced for only a single day’s data. 

•	 PR might request that data products be produced for every opportunity of input 
data for several months, resulting in several hundred jobs being planned and run as 
the input data become available. 

•	 Early in a mission the SCF may prefer to request processing for a short time period 
only (e.g., a week or less). 

•	 At that time the SCF is gaining an understanding of the on-orbit behavior of the 
instrument, the resulting data, and the interaction of the science processing 
software with real data. 

•	 SCF reviews the quality of the products and notifies the Production Planner of the 
need for any changes to the PR (e.g., discontinue the PR, change time ranges, or 
modify input parameters). 

•	 When the SCF has developed a good understanding of the instrument’s behavior, 
the team may be comfortable requesting processing for months at a time. 

•	 DAAC operations may have operational reasons for wanting to issue processing 
requests for a more limited time period. 

2	 The Production Planner has to balance the various considerations when determining whether 
or not to create or update a PR. 
Planning decisions are made on the basis of locally defined planning strategies for supporting 
the SCFs’ data processing needs. The production planning tools are intended to be flexible 
enough in their design to support the particular planning and scheduling cycles of the 
operations organization at each DAAC. 
Before planning production the Production Planner must coordinate with the Resource 
Planner to resolve all resource allocation issues. The Resource Planner notifies the 
Production Planner of the resources available for use in processing. Furthermore, the 
Production Planner may well have direct access to the Resource Plan. 
The Production Planner prepares monthly and weekly production plans. In addition, the 
Production Planner develops a daily production schedule from the most current weekly plan. 
However, the first step in the planning process is creating production requests using the 
Production Request Editor. 

26.12.1 DPREP Considerations 
DPREP (data preprocessing) is a set of three PGEs that are supplied by ECS, unlike most PGEs, 
which are provided by the Science Computing Facilities that ECS supports. DPREP consists of 
the following three PGEs: 

• EcDpPrAm1EdosEphAttDPREP_PGE (Step 1). 
• EcDpPrAm1FddAttitudeDPREP_PGE (Step 2). 
• EcDpPrAm1FddEphemerisDPREP_PGE (Step 3). 
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The PGEs run separately and in a particular sequence. 
Three files describe the PGEs and how to run them: 

• “DPREP_README” 
• “HowToCreateDprepTarFile” 
• “HowtoRunDPREP” 

The files are installed on the science processor hosts (e.g., e0spg01, g0spg01, l0spg01, n0spg03) 
in the /usr/ecs/MODE/CUSTOM/data/DPS directory. 
The DPREP PGEs process Level Zero (L0) Terra (AM-1) spacecraft data (e.g., ESDT 
AM1ANC) provided by EDOS. The output files/granules of the DPREP PGEs are subsequently 
used in the processing of data from various instruments on the satellite. They provide the 
following types of ancillary (non-science) data: 

• Ephemeris 

•	 Spacecraft location: ephemeris (or orbit) data include: latitude, longitude, and 
height. 

• Attitude 

•	 Orientation of the satellite, including yaw, pitch, and roll angles; and angular rates 
about three axes. 

• There are two profiles for DPREP PGEs: 
•	 Profile 1 runs routinely at the DAACs using previous DPREP output in addition to 

new Terra ancillary (e.g., AM1ANC) data. 
•	 Profile 2 (the boot-up procedure) takes in the Terra ancillary data only and is run 

under two sets of conditions: 

•	 First run of DPREP (because there is no previous output) to initialize DPREP 
processing. 

•	 Following any long period of time during which EDOS L0 ancillary data are 
unavailable. (Short gaps in the ephemeris data are filled by 
EcDpPrAm1EdosEphemerisRepair, one of the executables in the 
EcDpPrAm1EdosEphAttDPREP_PGE.) 

In order to run Profile 2 successfully following a long period of data unavailability, DPREP must

be told where to resume orbit counting. The initial orbit number in the Step 1 process control

file (PCF), must be set to the orbit number corresponding to the timestamp at which data

availability resumes.

Until an automated process can be implemented, whenever there is a telemetry drop-out, a

member of the DAAC science support team takes the following actions:


• Calls the Flight Operations Team (FOT). 
• Asks for the on-line engineer. 
•	 Requests the orbit number that coincides with the start time of the first L0 ancillary 

data set that follows the data drop-out. 
• Sets the orbit number in the Step 1 PCF. 

Then Profile 2 can be run successfully. Afterward, routine operations can be resumed using 
Profile 1 PGEs. 
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26.13PGE Registration and Test Data Preparation 
The integration of science software with ECS requires that information about the Product 
Generation Executives (PGEs) be made known to the PDPS in its database. In addition, the 
PGEs themselves and the test files that they use (both input and output) need to be placed on the 
Data Server. These steps must be accomplished before the science software can be run and tested 
within the ECS. 

The following procedures describe how to register a new PGE with ECS. This involves updating 
the PDPS database with information needed to plan, schedule, and run the PGE. The first step in 
the PGE registration process is to determine which ESDTs are needed for the PGE. You must 
Verify that an ESDT metadata ODL file exists for each ESDT or generate an ODL file. The next 
step in the process is to create a PGE metadata ODL file using the delivered PCF. Finally, 
additional operational information (resource requirements and runtime statistics) must be input 
into the PDPS database. This is the last step in the PGE registration process. The order in which 
these procedures are done is important and should be done as indicated. Please reference 
Appendix C. for Examples of PGE and ESDT ODL Files for Each Instrument Team. 

26.13.1 PGE ODL Preparation 
. This section describes how to prepare PGE ODL files. It is assumed that the SSIT 
Manager is running . 

1	 From the SSIT Manager, click on the Tools menu, then choose PDPS Database and then 
PCF ODL Template. 

• An xterm with title “SSIT: Science Metadata ODL Template Creation” will be 
displayed. 

2 At the program prompt Configuration Filename (enter for default: 
../../cfg/EcDpAtCreatODLTemplate.CFG)? 

• Press Enter for the default configuration file 
3 At the program prompt ECS mode of operations?, type mode, press Return or just press 

Return if the default shown is correct. 
• The mode refers to the database used and will typically be OPS or TS1. 

4	 At the program prompt Process Control file name (PCF to generate template from)?, type 
PCFpathname/PCFfilename, press Return. 

•	 The PCFpathname is the full path name to the location of the PCF. If not 
specified, the directory from which the SSIT Manager was run will be assumed. 

• The PCFfilename is the file name of the PCF. 
5 At the program prompt PGE name (max 10 characters)?, type PGEname, press Return. 

• The PGEname is the name of the PGE that will be registered. 
6	 At the program prompt PGE version (max 10 characters)?, type PGEversion, press 

Return or just press Return if the default shown is correct. 
• The PGEversion is the version of the PGE that will be registered. 

7 At the prompt PGE Profile ID ( 0 for Null, max 999)?, type 1 or any valid profile ID. 
•	 After a brief time, the message “Successfully created ODL template file” should be 

displayed if the task was successful. 
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• The program will output a file with the filename 
PGE_PGEname#PGEversion#ProfileID.tpl. 

•	 For example, if the PGE name was PGE35, and the version and profile ID were 
both 1  this output file will be named PGE_PGE35#001#01.tpl. 

8	 At the program prompt Hit return to run again, ”q <return>‘ to quit:, press Return to 
repeat process with another PCF or type q and press Return to quit. 

• The xterm will disappear. 
9 At a UNIX prompt on an AIT Sun, type cd SSITrunPathname, press Return. 

•	 The SSITrunPathname is the full path to the directory from which the SSIT 
Manager was run, for example /usr/ecs/TS1/CUSTOM/bin/DPS. This will be the 
directory where the file PGE_PGEname#PGEversion#ProfileID.tpl will reside. 

10	 At a UNIX prompt on the AIT Sun, type cp PGE_PGEname#PGEversion#ProfileID.tpl 
PGE_PGEname#PGEversion#ProfileID.odl, press Return. 

•	 The PGE_PGEname#PGEversion#ProfileID.tpl is the file name of the ODL 
template file created in step 7. 

•	 The PGE_PGEname#PGEversion#ProfileID.odl is the file name of a copy which 
can be safely edited. This file name convention must be used. 

11	 At a UNIX prompt on the AIT Sun, type 
mv PGE_PGEname#PGEversion#ProfileID.odl 
/usr/ecs/<mode>/CUSTOM/data/DPS/ODL 

•	 This will place the ODL file in the directory where the executable that populates 
the PDPS database will read from. PGE_PGEname#PGEversion#ProfileID.odl is 
the file name of the copy created in step 10. 

12	 At a UNIX prompt on the AIT Sun, change the directory to the one in step above and 
type vi PGE_PGEname#PGEversion#ProfileID.odl, press Return. 

•	 The PGE_PGEname#PGEversion#ProfileID.odl is the file name of the copy 
created in step 10. 

• Any text editor may be used such as emacs. For example, emacs 
PGE_PGE35#001#01.odl, press Return. 

13 In the file, add required metadata to the ODL template. 
•	 For an explanation of what metadata is required, see file 

/usr/ecs/<mode>/CUSTOM/data/DPS/PGE_ODL.template. 
•	 Note that the ShortNames typed into this file must each have a corresponding 

PDPS ESDT metadata ODL file (sec. 26.13.2). 
•	 All objects corresponding to output ESDTs will automatically have the 

SCIENCE_GROUP and YIELD set during the generation of PGE ODL. 
•	 All objects corresponding to output ESDTs will have an attribute 

“ASSOCIATED_MCF_ID. Place here the Logical Unit Number (LUN) listed in 
the PCF for the associated MCF listing. 

•	 All objects corresponding to static input ESDTs must have the SCIENCE_GROUP 
set. Objects corresponding to dynamic input ESDTs should NOT have the 
SCIENCE_GROUP set. 

• See Appendix E for an example of PCF and corresponding PGE ODL files. 
14 Save the changes made to the ODL template file and exit the editor. 
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• The specifics depend upon which editor is being used. If using vi, the command 
sequence to enter is :wq, press Return. 

• For other editors, refer to that editor’s documentation. 
4. 	 If you make a mistake entering any values, press Return here; your previous 

enteries are restored as defaults and you won’t have to retype them. 
5. 	 A comment should be received: “Update of PDPS/SSIT database with PDPS 

SCIENCE METADATA SUCCESSFUL” 

26.13.2  ESDT ODL Preparation 

Assumption: 

The PGE ODL file has been created and edited for the required PGE. 

Follow the steps below to prepare ESDT ODL files for each ESDT required by the PGE. 

1	 Determine ShortName for required ESDTs corresponding to a Logical Unit Number 
(LUN) in the PGE ODL file. 

2	 At a UNIX prompt on an AIT Sun, type ls 
/usr/ecs/<mode>/CUSTOM/data/DPS/ODL/ESDT_ShortName#Version.odl, press 
Return. 

•	 The ESDT_ShortName#Version.odl  is the file name of the ESDT ODL file you 
are looking for where ShortName is the ESDT’s ShortName and Version is the 
ESDT version. If a file for the desired ESDT is listed, then it has already been 
prepared and this procedure can be exited now. 

•	 For example, if the desired ESDT has the ShortName MOD03 and version 001, 
type ls /usr/ecs/TS1/S/CUSTOM/data/DPS/ODL/ESDT_MOD03#001.odl, 
press Return. 

• If the desired file is not listed, continue on to step 3. 
3 At a UNIX prompt on the AIT Sun, type cd WorkingPathname, press Return. 

•	 The WorkingPathname is the full path name to a working directory for which the 
user has write permissions. 

• For example, cd /home/jdoe/working/, press Return. 
4	 At a UNIX prompt on the AIT Sun, type 

cp /usr/ecs/<mode>/CUSTOM/data/DPS/ESDT_ODL.template 
ESDT_ShortName#Version.odl, press Return. 

• For <mode> enter the mode you are working in, for example OPS or TS1. 
•	 The ESDT_ShortName#Version.odl is the file name of the ESDT ODL file to be 

created. 
•	 This command copies a template ESDT ODL file to the ESDT ODL file to be 

created. The template is well commented. 
•	 For example, type cp 

/usr/ecs/<mode>/CUSTOM/data/DPS/ESDT_ODL.template 
ESDT_MOD03#001.odl, press Return. 
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• The ESDT_ShortName#Version.odl file naming convention must be observed. 
5	 At a UNIX prompt on the AIT Sun, type vi ESDT_ShortName#Version.odl, press 

Return. 
•	 The ESDT_ShortName#Version.odl represents the file name of the ESDT ODL 

template file created in step 4. 
• Any text editor may be used such as emacs. For example, emacs 

ESDT_MOD03#001.odl, press Return. 
6 In the file, add required metadata to the ODL template. 

•	 Use the internal documentation contained in the ODL file (from the original 
template) to aid in populating with metadata. 

•	 Note that the ShortName specified within the file must match the ShortName of 
the file name itself. 

• In addition, the ShortNames used in the PDPS PGE metadata ODL file must match 
the ShortNames in these files. 

7 Save the changes made to the ESDT metadata ODL file and exit the editor. 
•	 The specifics depend upon which editor is being used. If using vi, the command 

sequence to enter is :wq, press Return. 
• For other editors, refer to that editor’s documentation. 

8 Next type mv ESDT_ShortName#Version.odl 
/usr/ecs/<mode>/CUSTOM/data/DPS/ODL. 

• This will place the just created ESDT ODL file in the directory where PDPS will 
read it from. 

9	 Repeat steps 1 through 8 for each ESDT required by a particular PGE. When all ESDT 
metadata ODL files have been completed, continue on to next section. 

26.13.3 Update PDPS/SSIT Database with PGE Science Metadata 

In order to update the PDPS Database with PGE metadata, the ESDT metadata ODL files must 
first be prepared for each ESDT required by the PGE. This section describes how to perform the 
next step, running the SSIT Science Update program. 

Assumptions: 

1. The SSIT Manager is running. 

2. The directory used for containing the PDPS PGE metadata ODL files. Nominally, 
this is /usr/ecs/<mode>/CUSTOM/data/DPS/ODL. 

Updating the PDPS Database with PGE Metadata 

The following is a list of tools, procedures and or assumptions: 
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The directory used for containing the PDPS ESDT metadata ODL files can be accessed by 
the following commands: 

1 telnet to (AITTL/DPS) p0ais01 or a machine that matches the SSIT Manager host. 
2 login: ID, password: 

3  Login to DCE (dce_login <name> <Password>), setenv… :0.0 

4	 The directory used for containing the PDPS ESDT metadata ODL files. is 
/usr/ecs/<mode>/CUSTOM/data/DPS/ODL 

5	 From the SSIT Manager, click on the Tools menu, then choose PDPS Database and then 
SSIT Science Metadata Update. 
• An xterm with title “SSIT: Science Metadata Database Update” will be displayed. 

6 At the program prompt Configuration Filename ( enter for default: 
../../cfg/EcDpAtRegisterPGE.CFG)? 

• Press Return. 
7	 At the program prompt ECS mode of operation?, type mode, press Return or just press 

Return if the default shown is correct. 
• The mode refers to the database used and will typically be OPS or TS1. 

8 At the program prompt PGE name (max 10 characters)?, type PGEname, press Return. 
•	 The PGEname is the name of the PGE that will be registered. This name must 

match the PGE name specified. 
9 At the program prompt PGE version (max 10 characters1)?, type PGEversion, press 

Return or just press Return if the default shown is correct. 
• The PGEversion is the version of the PGE that will be registered. This version 

must match the PGE version specified. 
10 At the program prompt PGE Profile ID (0-999, 0 means null)? Type in a valid profile ID 

and press Return, or if already listed just press Return. 
• The PDPS database will then be updated with the information contained in the file 

PGE_PGEname#PGEversion#ProfileID.odl 
11	 At the program prompt Hit return to run again, q <return> to quit:,  press Return to update 

the PDPS database with another PGE ODL metadata file or type q  and press Return to 
quit. 

•	 If you make a mistake entering any values, press Return here; your previous 
entries are restored as defaults and you won’t have to retype them. 

•	 NOTE: If you make mistakes while editing the PGE and ESDT ODL files, you can 
run the ODL checker (Tools ‚ PDPS Database ‚ Check ODL) via the SSIT 
manager to locate any errors. 
ODL files must have been created to define the PGE to PDPS. Examples of the 
ODL files are under the data directory: PGE_ODL.template, 
ESDT_ODL.template, ORBIT_ODL.template, TILE_ODL.template and 
PATHMAP_ODL. A tool can be run to generate a template ODL file for the PGE 
from the SSIT Manager via Tools->PDPS Database->PCF Odl Template script. 
This then has to be populated with all information that can not be garnered from 
the PCF. The CheckOdl tool from the SSIT Manager via Tools->PDPS Database­
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>Check ODL can be used to flag any errors in ODL before trying to put it in the 
database. 

Sample of ESDT.odl files being established in ECS 
home/emcleod/MODIS/STORE/PGE07

p0ais01{emcleod}10: ls

ESDT_MD10L2#001.odl MOD_PR10 pge_cfg

ESDT_MD35L2#001.odl MOD_PR10.mk scf_cfg

ESDT_MOD02H#001.odl PGE07.mk script

ESDT_MOD03#001.odl doc

p0ais01{emcleod}11: cp ESDT_MD10L2#001.odl ESDT_MD35L2#001.odl

ESDT_MOD02H#001.odl ESDT_MOD03#001.odl /usr/ecs/OPS/CUSTOM/data/DPS/ODL/


26.13.3.1 AlternativeTool for SSIT Metadata Update: 
Source the buildrc file for the mode in which you are working (source .buildrc). 

/usr/ecs/<MODE>/CUSTOM/utilities, Note that this only has to be done once per login. 
Then (cd /usr/ecs/<MODE>/CUSTOM/bin/DPS) 

(The tool can also be executed by being in the /usr/ecs/<MODE>/CUSTOM/bin/DPS and 
executing EcDpAtDefinePGE..) 

Shell script prompts user for information. 
1 Enter in the location of the configuration file (../../cfg/EcDpAtRegisterPGE.CFG). 
2 Filename Enter the MODE of operation (<MODE>). 
3 Enter name of PGE (it must match what is in the PGE ODL file). 
4 Enter the version of the PGE (it must match what is in the PGE ODL file). 
5 Enter the Profile ID (it must match what is in the PGE ODL file). Note that the ODL file 

for the PGE must have the of: PGE_<PGE NAME>#<PGE VERSION>#<PROFILE 
ID>. 

•	 Each ODL file is displayed as it is processed. A good status message should be 
displayed as a result. Information about the PGE (inputs and outputs, Production 
Rules, etc) should be entered in the Database. 

26.13.3.2 Examples of PGE and ESDT ODL Files for Each Instrument Team 

This section is taken from the latest Green Book 162-TD-001-005 and are listed in Appendix C. 
Depicted are examples of ODL files in SSI&T activities. Then, examples of specific ODL files 
are listed by instrument (ASTER, MISR or MODIS). 

Template ODL Files 

There are five Template ODL files listed therein. The specific or tailored ODL files listed were 
derived from these templates by appropriate editing and filling-in of values. The three ODL 
Template files listed reside, on the AIT Sun host, at /usr/ecs/<mode>/CUSTOM/data/DPS  . 
They are 

PGE_ODL.template 
ESDT_ODL.template 
ORBIT_ODL.template 
PATHMAP_ODL.template 
TILE_ODL.template 
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Example of a successful PDPS Science Metadata Update:

PDPS/SSIT SCIENCE Metadata Database Update **

Configuration filename? (enter for default: ../../cfg/EcDpAtRegisterPGE.CFG)

ECS Mode of operations? (enter for default: OPS)

OPS 
PGE name (max 10 characters)? 
PGE07 
PGE version (max 10 characters)? 
001 
PGE Profile ID (0-999, 0 means null)? (enter for default: 1) 
1 
Warning: Could not open message catalog "oodce.cat" 
EcDpAtRegisterPGE: Process Framework: ConfigFile 
../../cfg/EcDpAtRegisterPGE.CFG ecs_mode OPS 
' PGE profile id = '1' ... 
Do you wish to overwrite the previous PGE PGE07( (y)es or (n)o): 
y

FILES PROCESSED

: PGE SCIENCE ODL file =/usr/ecs//OPS/CUSTOM/data/DPS/ODL/PGE_PGE07#0#001.odl


ESDT SCIENCE ODL file = /usr/ecs//OPS/CUSTOM/data/DPS/ODL/ESDT_MOD02H#001.odl 
ESDT SCIENCE ODL file = /usr/ecs//OPS/CUSTOM/data/DPS/ODL/ESDT_MD35L2#001.odl 
ESDT SCIENCE ODL file = /usr/ecs//OPS/CUSTOM/data/DPS/ODL/ESDT_MOD03#001.odl 
ESDT SCIENCE ODL file = /usr/ecs//OPS/CUSTOM/data/DPS/ODL/ESDT_MD10L2#001.odl 

********** Update of PDPS/SSIT database with PDPS SCIENCE metadata SUCCESSFUL ********** 
Hit return to run again, 'q <return>' to quit: 

26.13.4 Operational Metadata 

The SSIT version of the PDPS database is initialized and updated with SSIT Operational 
Metadata so that the Planning and Processing Subsystem can schedule and run PGEs. Here, 
PDPS Operational Metadata refers to PGE information which is supplied to the DAAC/SSIT 
Operator and may change frequently. 

The operator enters this data directly into the SSIT Operational Metadata Update GUI. The 
program then writes the data directly to the SSIT version of the PDPS database. 

Before running the SSIT Operational Metadata Update from the SSIT Manager, you must first 
update the PDPS with SSIT Science Metadata. In addition, to get initial PGE Performance data 
which will be entered into the GUI, you need to run the profiling utility, EcDpPrRusage on the 
PGE or have the information on profiling provided. See section 26.13.2. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 
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1. The required UNIX environment variables have been set. 

2. The Science metadata has been updated to the PDPS database for this PGE. 

To update the SSIT version of the PDPS database with operational metadata, execute the 
steps that follow: 

1 From the SSIT Manager, click on the Tools menu, then choose PDPS Database and then 
SSIT Opnl Metadata Update. 

• The PDPS/SSIT Database Update GUI will be displayed. 
2 Click on the radio button labeled NEW PGE in the lower left quadrant. 

• The PGE that you are working on should appear in the subwindow labeled PGE 

Names along with its version number in the subwindow labeled PGE Versions. 

3	 In the subwindow labeled PGE Names, click on a PGE name. Then in the subwindow 
labeled PGE Versions, click on the PGE version for that PGE. Then click on the button 
labeled EDIT. 

• The PGE name and version will be highlighted when you click on them. 
• The page tabs PROFILE, RUNTIME, and ESDT will change from gray (indicating 

disabled) to black (indicating enabled). 
• To see the contents of PGE Metadata, click on the button labeled DISPLAY and 

then click on the button labeled DONE. 

• If the PGE name and/or version does not appear in the lists, it means that updating 
of PDPS database with PGE metadata was not successful. 

4 Click on the PROFILE page tab. 
• The Profile page will be displayed. 

5 In the fields under the label Performance Statistics, enter the information specified. 
•	 In the field labeled Wall clock time, enter the amount of wall clock time it takes for 

one execution of the PGE, in seconds. The tab PROFILE will change from black 
(indicating enabled) to red (indicating database needs to be updated by APPLY 
button). 

• In the field labeled CPU time (user), enter the so-called user time of the PGE, in 
seconds. This value should come from profiling the PGE . 

• In the field labeled Max memory used, enter the maximum amount of memory used 
by the PGE, in megabytes (MB). This value should come from profiling the PGE . 

•	 In the fields labeled Block input ops and Block output ops, enter the integer 
number of block inputs and block outputs, respectively. These values should come 
from profiling the PGE . 

• In the field labeled Swaps, enter the integer number of page swaps from the PGE. 
This value should come from profiling the PGE . 

• In the field labeled Page faults, enter the integer number of page faults from the 
PGE. This value should come from profiling the PGE . 

6 In the fields under the label Resource Requirements, enter the information specified. 
•	 In the field labeled DISK SPACE used for PGE run, enter the maximum amount of 

disk used by the PGE during execution, in megabytes (MB). Space should be 
allowed for the executable(s), input files, output files, ancillary files, static files, 
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MCFs, and the PCF. (This number should also be in the PGE metadata ODL file; 
yes, there is duplication here.) 

• Click on the radio button labeled Proc. String (if not already clicked on). 
• A list of processing strings should appear in the scrollable window to the left of the 

two radio buttons Proc. String and Computer Name. Nominally, only one item 
should be listed and should be highlighted. 

• In the field labeled Number of CPUs, the number 1 should appear. 
7 Once the fields on the PROFILE page have been completed, click on the APPLY button. 

•	 This will update the PDPS database with the information just entered. The tab 
PROFILE will change from red (indicating database needs to be updated) to black 
(indicating enabled). 

• An information box will be displayed; click on Ok. 
• To start over, click on the RESET button. This will clear all fields. 

8 Click on the File menu and select Exit. 
• This will end the session with PDPS/SSIT Database Update and the GUI will 

disappear. 

26.13.5 SSIT Operational Metadata Update GUI 

The SSIT version of the PDPS database is initialized and updated with SSIT Operational 
Metadata so that the Planning and Processing Subsystem can schedule and run PGEs. Here, 
PDPS Operational Metadata refers to PGE information which is supplied to the DAAC/SSIT 
Operator and may change frequently. 

The operator enters this data directly into the SSIT Operational Metadata Update GUI (Figure 
26.13.5-1). The program then writes the data directly to the SSIT version of the PDPS database. 
The SSIT Operational Metadata Update GUI is used to view or update the following operational 
parameters for a particular PGE: 

− Performance parameters for the PGEs. 
− Resource parameters for the PGEs. 
− PGE user-defined static parameter. 
− View the PGE science metadata file. 
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Figure 26.13.5-1. SSIT Database Operational Metadata Update GUI – SELECT view 

26.13.6 Test Data Preparation and Insertion of Data Granules 

This section describes how to prepare test data for use by registered PGEs. When PGEs are first 
delivered to the DAAC and registered within the PDPS, they will typically be run in isolation. 
That is, they will be run without any PGE dependencies. For this testing to be possible, test input 
data granules required by the PGE need to be pre-Inserted to the Data Server. 

Data granules can be dynamic or static. Dynamic data granules are those whose temporal locality 
differs for each instance of the granule. Examples of dynamic granules are Level 0, Level 1, and 
Level 2 data sets. Static data granules are those whose temporal locality is static over long 
periods of time. Examples of static granules are calibration files which may only change with a 
new version of a PGE. For any granule to be Inserted to the Data Server, a Target MCF is needed 
(also known as an ASCII metadata ODL file or a .met file). 

In the actual production environment, a Target MCF is produced by the PGE during execution. 
Thus, the data granule can be Inserted. In isolation testing of a PGE, however, the inputs needed 
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by it will not have been Inserted by a previous PGE in the chain. This Insertion must be done 
manually. The next two sections describes how to use the Source MCF for a dynamic data 
granule to create a Target MCF. and then describes how to do the Insert. In this way, a dynamic 
data granule can be Inserted to the Data Server as if a PGE had produced it. 

26.13.6.1 Generating a Metadata Configuration File ( Source MCF) 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

• The SSIT Manager is running. 

• ESDT’s are installed onto the Science Data Server. 

To Generate the Metadata Configuration File (Source MCF) for the input and output 
ESDT’s, execute the steps that follow. 

1 From the SSIT Manager, click on the Tools menu, then choose Data Server and then Get 

MCF. 

• An xterm in which EcDpAtGetMCFis running will be displayed as SSIT: Acquire 
MCF.. 

• Alternatively, the same tool can be invoked by typing at a UNIX prompt on an 
AIT Sun EcDpAtGetMCF.sh, press Return. 

2 At the program prompt Configuration Filename (default defaultConfigFile)? 
• Type in ../../cfg/ defaultConfigFile and press Return. 
• The defaultConfigFile will be replaced by the full path name and file name of the 

default configuration file. The file name will be EcDpAtGetMCF.CFG where 
daac will be replaced by one of {GSFC, EDC, LARC, NSIDC}. 

3 At the program prompt ECS mode of operation (enter for default: defaultMode)?, type 
mode, press Return or just press Return if the default shown is correct. 

• The mode refers to the database used and will typically be TS1. 
4 At the program prompt ESDT Short Name?, type ESDT ShortName, press Return. 

• The ESDTShortName is the name of the ESDT that the EcDpAtGetMCF tool will 
use to generate the MCF. 

5 At the program prompt ESDT Version?, type ESDTversion, press Return or just press 
Return if the default shown is correct. 

• The ESDTversion is the version of the ESDT. 
6 At the program prompt Directory to receive MCF (must be full path)?, type 

MCFpathname, press Return. 
• The MCFpathname is the full path name to the location where the source MCF 

will be placed. For example, /home/jdoe/ssit. 
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7 To the final prompt Hit return to run again, ‘q <return> to quit:, press Return to generate 
another Source MCF or type q and press Return to quit. 

• If you make a mistake entering any values, press Return here; your previous 
entries are restored as defaults and you won’t have to retype them. 

Example of a successful installation of a Source MCF: 

Configuration filename? (enter for default: ../../cfg/EcDpAtGetMCF.CFG) 
ECS Mode of operations? 
OPS 
ESDT Short Name? 
MOD03EM 
ESDT Version? 

Directory to receive MCF? (must be full path) 
/home/emcleod/MCF/ 
Warning: Could not open message catalog "oodce.cat"

EcDpAtGetMCF: Process Framework: ConfigFile ../../cfg/EcDpAtGetMCF.CFG

ecs_mode

OPS 

incomplete group entries in the configfile,using default G1 
Request for MCF successful for: 

ESDT name = 'MOD03EM' 
ESDT version = '0' 
directory = '/home/emcleod/MCF/' 

Hit return to run again, 'q <return>' to quit: 

26.13.7 Creating a Target MCF (.met) for a Dynamic/Static Granule 

A Target MCF file for a corresponding data granule can be created based on the information 
provided in the Source MCF file and the involved science software package (PGE). 

In standalone or isolation testing of a PGE, the inputs needed by it will not have been Inserted by 
a previous PGE in the chain. This Insertion must be done manually. A Target MCF file for a 
corresponding data granule is required to run a standalone PGE. This way a dynamic data 
granule can be Inserted to the Science Data Server as if a PGE had produced it. 

26.13.7.1 Creating a Metadata ODL File for a Static Granule 
1 At the UNIX prompt on the AIT Sun, type cd WorkingPathname, then press the Enter 

key. 
• Example: cd /usr/ecs/{MODE}/CUSTOM/data/DPS/ODL/ 
• The WorkingPathname is the full path name of the working directory containing 

the template metadata ODL file. 
2 At the UNIX prompt on the AIT Sun, type cp StaticODLmet.tpl filename.met, then press 

the Enter key. 
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• The StaticODLmet.tpl is the file name of the template Target MCF. 
• The filename.met is the file name of the Target MCF for this static file. The file 

name extension must be .met. 
•	 This command will copy the template Target MCF to filename.met. For 

example, type cp StaticODLmet.tpl CER11T.mcf.met, then press the Enter 
key. 

3 At a UNIX prompt on the AIT Sun, type vi filename.met, then press the Enter key. 
• This command invokes the vi editor and reads in the Target MCF created above. 

4	 Edit the Target MCF with the specific information for the static data granule to be 
Inserted. The following guidelines should be followed when editing on the template 
MCF: 
• The value for the ShortName object should be filled out with proper instrument 

name. 
• The value for the Version ID object should be filled out with the proper version 

number. 
• In the INFORMATIONCONTENTCONTAINER object enter the following: 

•	 The value for the PARAMETERNAME object of the class “1” should be 
filled out with the name of static data file. 

•	 The value for the PARAMETERVALUE object of the class “2” should 
be filled out based on the following guideline: 

•	 If the data granule is a coefficient file, a “C” followed by a 
numerical number n (n=1,2,….) will be used. Here n stands for the 
number of the coefficient file. 

•	 If the data granule is a MCF file, a “M” followed by a numerical 
number n (n=1,2,….) will be used. Here n stands for the number 
of the MCF file. 

5 Save the changes made to the Target MCF ( filename.met) and exit the editor. 
•	 The specifics depend upon which editor is being used. If using vi, the command 

sequence to enter is :wq, then press the Enter key. 

26.13.8 Inserting Static Data Granules into the Data Server 

Inserting a Static Data File: 
• The following Servers/Services must be up and operational: 
• Science Data Server, Storage Management. 
• The following must have occurred between those Servers/Services: 
• The ESDT of the static file must have been installed at the Data Server. 

What the user must do before trying SSIT functionality: 
•	 Create a metadata file for the static file to insert. To do this, an MCF (See 

“Getting an MCF in this section”) must be gotten from the Data Server for 

26-123 611-CD-510-001




the ESDT of the file to insert. Mandatory fields are filled into the MCF, 
creating a metadata file. 

• If the tool is NOT run from the SSIT Manager then go to the executables 
directory (cd /usr/ecs/<MODE>/CUSTOM/utilities) 

• Source the buildrc file for the mode in which you are working (source 
.buildrc). Note that this only has to be done once per login. 

• If the tool is NOT run from the SSIT Manager then go to the executables 
directory (cd /usr/ecs/<MODE>/CUSTOM/bin/DPS) 

From the SSIT Manager choose Tools menu and then Data Server submenu. Choose InsertÄ
Static File.Ä
The tool can also be executed by being in the /usr/ecs/<MODE>/CUSTOM/bin/DPS andÄ
executing EcDpAtInsertStaticÄ
Shell script prompts user for information. 
1 Enter in the location of the DpAtInsertStaticFile configuration file 

(../../cfg/EcDpAtInsertStaticFile.CFG). 
2 Enter the MODE of operation (<MODE>). At the program prompt mode (default ops)?, 

or press Enter to take default. 
3 Enter the short name of the ESDT (for the static file). This value is in the pdps 

database under the PlDataTypeMaster table and must be in the PGE ODL file. 
• At the program prompt ESDT name? type ESDTShortName, then press the 

Enter key. For example type: MOD02LUT. 
4 Enter the version of the ESDT for the static file. This value is also in the pdps database 

under the PlDataTypeMaster table and must be in the PGE ODL file. 
• At the program prompt PGE version (default 1)?, type PGEVersion, then press 

the Enter key. 
• The PGEVersion must match exactly the PGE version entered into the PDPS for 

this PGE. 
5 Enter the science group for this static (this will be from the ODL created during 

Populating the PGE information in the Database). 
• At the program prompt Science group for Static file(one of{C,L,D,O} followed 

by a 3 digit number)?, type ScienceGroupID, then press the Enter key. 
•	 The ScienceGroupID is an identifier used to define the file type as a coefficient 

file, a lookup table file, or a MCF. It distinguishes static granules of different 
types which share the same ESDT. For instance, for a coefficient file, use Cn, 
where number n could be 0, 1, 2…; this number n needs to be matched with the 
number n in the PGE_PGEName#Version.odl file. For an MCF. For example, 
type C001, press Return. 

•	 The Science Group ID must match what was edited into the PGE metadata ODL 
file for that PCF entry. 

6	 At the program prompt Is there more than one data file for this Static (Y = Yes, N = No)? 

(enter for default: N). If there is only one data file, press Return and go to next step. If 
there are more than one data files, type Y, press Return and go to step 10. 

7	 At the program prompt Single Static Filename to Insert (including FULL path)?, type 
pathname/GranuleFileName, press Return 
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•	 The pathname/GranuleFileName is the full path name and file name of the static 
data granule to be Inserted. For example, type 
/home/MODIS/PGE10/MOD_PR28/coeff/emissivity.dat, press Return. 

8	 At the program prompt Associated ASCII Metadata Filename to Insert (including FULL 

path). Type pathname/GranuleFileName.met)?, press Return. 
•	 The pathname/GranuleFileName.met is the full path name and file name of the 

.met file for the associated static data granule to be Inserted. For example, type 
/home/MODIS/PGE10/MOD_PR28/MOD28LUT.met press Return. 

9 At the program prompt Directory where all data files and .met file exist (FULL path)? Type 
pathname press Return. 

• where pathname is the full path of the directory where all data files and .met file 
exist. 

• Note for a multifile granule, the data files and .met file should be placed in the 
same working directory. 

10 At the program prompt Name of MFG file (enter to end list)? Type in the 
GranuleFileName, one at a time and press Return. To end the list press Return. 

• Where GranuleFileName is the names of the multifile granules. 
11 At the program prompt Associated ASCII Metadata Filename to Insert? Type 

GranuleFileName.met, press Return. 
• Where GranuleFileName.met is the name of one .met file that is used with all 

data granules in the even of a multifile granule. 
• The dynamic data granule will be Inserted to the Data Server. For reference, the 

Data Server Universal Reference (UR) will be printed on the screen. 
12 At the program prompt Hit return to run again, ”q <return>‘ to quit: type q and press 

Return to quit or just press Return to insert additional dynamic granules. 
• If continuing, repeat steps 2 through 9. 

26.13.9 Inserting Dynamic Data Granules to the Science Data Server 

In order for dynamic data files to be used both during the SSI&T and in production, this file must 
exist in the Data Server and be accessible by the local machine. A program called the Insert Test 
Dynamic File can be used for Inserting a dynamic data granule into the Data Server. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The ESDT’s have been installed on the Data Server. 

2. The Target MCF for this data granule has been created for the Insert. 

To Insert a dynamic granule to the Data Server, execute the following steps: 
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1 From the SSIT Manager, click on the Tools menu, then choose Data Server and then 
Insert Test Dynamic. 

• An xterm with title “SSIT: PGE Test Dynamic Input File Insertion” will be 
displayed. 

2 At the program prompt Configuration filename? (enter for default: 
../..cfg/EcDpAtInsertTestFile.CFG), press Return. 

3 At the program prompt ECS Mode of operations? 

• Type in the <mode> you are working in. For example, TS1 or OPS. Press 
Return. 

4 At the program prompt ESDT short name for the file(s) to insert? type ESDTShortName, 
press Return 

•	 The ESDTShortName is the ShortName of the ESDT descriptor file 
corresponding to this granule to be Inserted. For example, type MOD021KM press 
Return. 

5	 At the program prompt ESDT Version for the file(s) to insert? Type in the ESDT version 
and press Return. 

6	 At the program prompt Is there more than one data file to this Dynamic Granule (Y = Yes, 
N = No)? (enter for default: N)? If there are no multifiles for this ESDT, press Return and 
go to step 7. If there are more than one file for this granule go to step 9. 

7	 At the program prompt Single Filename to Insert? (including FULL path) type 
pathname/GranuleFilename, press 

•	 The pathname/GranuleFileName is the full path name and file name of the data 
granule to be Inserted. For example, type 
/home/MODIS/PGE10/MOD021KM.A1996217.0014.002.hdf, press Return. 

8 At the program prompt Associated ASCII Metadata Filename to Insert (including FULL 

path) , Type pathname/GranuleFileName.met and press Return. 
• pathname is full name of the path and GranuleFileName.met is the name of the 

associated .met file. For example, /home/MODIS/PGE10/MOD021KM.met 
• The dynamic data granule will be Inserted to the Data Server. For reference, the 

Data Server Universal Reference (UR) will be printed on the screen. 
9 At the program prompt Directory where all data files and .met file exist (FULL path)? Type 

pathname press Return. 
where pathname is the full path of the directory where all data files and .met file exist. 
Note for a multifile granule, the data files and .met file should be placed in the same working 
directory. 
10 At the program prompt Name of MFG file (enter to end list)? Type in the 

GranuleFileName, one at a time and press Return. To end the list press Return. 
where GranuleFileName is the names of the multifile granules. 
11 At the program prompt Associated ASCII Metadata Filename to Insert? Type 

GranuleFileName.met, press Return. 
where GranuleFileName.met is the name of one .met file that is used with all data granules in 

the even of a multifile granule. 
• The dynamic data granule will be Inserted to the Data Server. For reference, the 

Data Server Universal Reference (UR) will be printed on the screen. 
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12 At the program prompt Hit return to run again, ”q <return>‘ to quit: type q and press 
Return to quit or just press Return to insert additional dynamic granules. 

• If continuing, repeat steps 2 through 8. 

Example of a successful insertion of a Dynamic Input Data Granule into the Data Servers:

PGE Test Dynamic Input File Insertion **

Configuration filename? (enter for default:

../../cfg/EcDpAtInsertTestFile.CFG)

ECS Mode of operations? (enter for default: OPS)

OPS 
ESDT name 
MOD02H 
ESDT Version (enter for default: 1) 

Staged Filename to Insert? (including FULL path) 
/home/emcleod/MCF/MOD02HKM.A1997217.1730.002.hdf 
Associated ASCII Metadata Filename to Insert? (including FULL path) 
/home/emcleod/MCF/MOD02H.met 
Warning: Could not open message catalog "oodce.cat" 
EcDpAtInsertTestFile: Process Framework: ConfigFile 
../../cfg/EcDpAtInsertTestFile.CFG ecs_mode OPS 
incomplete group entries in the configfile,using default G1 
Trying to make a request to [MDC:DSSDSRV] 
incomplete group entries in the configfile, using default 
Trying to make a request to [MDC:DSSDSRV] 
incomplete group entries in the configfile, using default 
Insert to Data Server successful: 

ESDT Version = '0' 
staged file = '/home/emcleod/MCF/MOD02HKM.A1997217.1730.002.hdf' 
metadata file = '/home/emcleod/MCF/MOD02H.met' 

Inserted at UR: 
'UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]:16:SC:M 
OD02H:1757' 
Hit return to run again, 'q <return>' to quit: 

26.13.10 Science Server Archive Package (SSAP) 

The SSAP is used to provide a record of the science software, documentation, and other related 
files stored at the DAAC. The SSIT SSAP GUI provides a method for grouping required data 
about a PGE. 

The SSAP is not to be confused with the Delivered Algorithm Package (DAP) received from the 
SCF. Much of what is in the DAP will make it into the SSAP. The key difference is that SSAP 
data is prepared after initial testing of the science software and will include data that reflects site 
integration as well as fixes required for performance at the DAAC. 
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The SSAP is made up of 2 different data types. The first data type is the Algorithm Package 
which contains metadata (name of the PGE, name of the instrument, date accepted, etc...) about 
the SSAP. The second data type is the source code, documentation, and test data which will be 
stored as a SSAP, with its own metadata in addition to the files. SSAP components such a 
source code will be tared to retain the directory structure. 

The executables and static files are stored separately from the SSAP and will have their own data 
types (ESDTs). 

The following is a list of tools, and or assumptions: 

1. The SSIT Manager is running. 
2. The PGE has been successfully built with the SCF and DAAC version of the Toolkit. 

26.13.10.1 Creating an SSAP 

The following Servers/Services must be up and operational:


Science Data Server, Storage Management.


The following must have occurred between those Servers/Services:


NONE. 

What the user must do before trying SSIT functionality: 

1	 From the SSIT Manager choose Tools menu and then Data Server submenu. Choose 
SSAP Editor. 
The GUI starts. Note that it will first query Data Server for a list of SSAPs that have

previously been created. This list will appear in the window at the center (if any SSAPs

already exist). Current SSAP field will be blank, and only Refresh and Create buttons

will be active. All three tabs (Main, Files, and Metadata) will be active.

The SSAP GUI will be displayed.


2 Click on the Create to create a new SSAP. 
• The Create SSAP window appears. If no OK button is visible, resize the window 

such that the OK button is visible. 
3 Enter the name of the SSAP in the first field . Enter SSAP version in the second field. 

Note that version has a limit of 20 characters. 
4 Click OK and the window disappears 

On the main GUI, the SSAP created (what was entered in the step above) will appear. 
Current SSAP is now set to that value. All buttons are now active. 

5 To set up the SSAP components, click on the File List tab. 

• The File List Tab displays files in the local directory to the left and files in the 
selected SSAP component to the right. On the bottom left is a directory listing and a 
method to move through the directory tree on the local machine. Delete and Reset 
buttons—both active – are to the right. 
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6	 To select a file in the left column, click on the File Type button, highlight a file (or files) 
and click on the Add arrow button to add the files.. 
The files selected to be added will be displayed in the right column. 
T o change directories (and thus add files from other directories to the SSAP 

component), click on the listing in the window on the bottom left of the GUI. The 
“..” is to go up one directory level. A single click with move to the directory 
chosen and change the display to show the directories under the new current 
directory. Note that the list of files in the upper left window changes to show the 
files within the current directory. 

7	 To add metadata for the new SSAP, select the Metadata tab. 
The Metadata window will be displayed. 
The Metadata Tab displays the metadata for the new SSAP. Only the Name and Version 

will be filled in automatically. The rest of the fields will have default information. 
While the SSAP can be submitted with the default information, it is wise to fill in 
valid values. To change a value: 

8 To change the default information, click on the Edit Assoc Collections button. 
The Edit Associated Collections window displays a list of associated collections and 

fields for the entry of new ShortNames and Versions. 
9 Enter a ShortName, and version (of the ESDT that has been installed in the Data Server) 

- must be eight or fewer characters. Note that the Data Server will verify if the Shortname 
exists. 

10 Enter the version (of the installed ESDT). 
Then select the OK button. Select Done to close the window. 

11 To save the updated metadata, click Save on the Metadata tab. 
12 To get back to the Main tab, select the Main tab button. 
13 To submit the new SSAP to the Data Server, select the Submit button. 

When the SSAP has been submitted, the SSAP Successfully inserted to the Data Server 
prompt will appear. 

26.12.10.2 Updating an SSAP 

The following Servers/Services must be up and operational:


Data Server, Storage Management.


The following must have occurred between those Servers/Services:


An SSAP must have already been inserted to the Data Server.


What the user must do before trying SSIT functionality:


The SSAP Editor has been used to insert an SSAP to the Data Server.


What must be done via SSIT tools:
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If SSAP Editor is not running, use the directions from the first 2 paragraphs of (Creating an 
SSAP) to bring up the SSAP GUI. Note that the added SSAP should appear in the window 
of the Main tab. 

If the SSAP Editor is already running, the added SSAP should appear in the window of the 
Main tab. 

1 Click on added SSAP in the main display. 
2 Click on the Metadata tab to update the SSAP. 

The Metadata Tab displays the metadata for the SSAP. All fields will be set to the values 
entered when the SSAP was created, and the Algorithm Name field will be grayed 
out (because it may not be updated). If you want to create a new SSAP from the an 
existing one, go back to the Main tab and hit the Create With button. 

3	 Click on the Algorithm Version field (currently called Algorithm Description) and enter a 
new version (different from what is in the field when the tab is clicked). 

4	 Update any other fields that you wish to change. You can even add a new Associated 
Collection by clicking on the Assoc Collection button and following the steps described 
in Creating an SSAP. 

5 Before you leave the Metadata tab, click Save to save the updated metadata. 
6 Click on the File List tab to set up new SSAP components. 

The File List Tab displays files in the local directory to the left and files in the selected 
SSAP component to the right. On the bottom left is a directory listing and a method 
to move through the directory tree on the local machine. Delete and Reset 
buttons—both active –are to the right. 

7	 Click on the File Type button to select the additional SSAP component to manipulate. 
Choose one of the menu items. 
Select a file (or files) from the left window to add to the component. 
Click the Add Arrow button to add the files. They will appear in the right window 

because they are now part of that SSAP Component. 
Click Main to get back to the Main tab. 
On the Main tab: 
Click Submit to send the new SSAP to Data Server. When finished, a message should 

pop up that says “SSAP Successfully inserted to the Data Server”. 

26.13.11 PGE Checkout 
The following Servers/Services must be up and operational: 

NONE. 

The following must have occurred between those Servers/Services: 

NONE. 
What the user must do before trying SSIT functionality: 

In normal SSIT (at the DAACs) the DAP would be untared, and the source code 
recompiled and tested. 

What must be done via SSIT tools: 
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Since SSIT is just a calibration of various tools, there is no specific order for

which they must be run. All tools can be started from the SSIT Manager and can

be executed on their own.

For SparcWorks (for code analysis and debugging), choose Tools menu and then

Code Analysis submenu. See SparcWorks manuals for SparcWorks operation.

For various office tools, choose Tools menu and the Office Automation submenu.

Choose from MS Windows (a simulator to allow the user to run Windows

programs), Ghostview (a viewer), Netscape (for web access), Acrobat (for

document viewing), and DDTS (for problem reporting).

For Standards checkers, choose Tools and then the Standards Checkers submenu.


FORCHECK is a COTS Fortran language checking program.

The Prohibited Function Checker will examine source code for functions

that are not permitted On Prohibited Function Gui, choose Analyze to

select files to examine. Hit the Ok button once selections are made and a

message at the top of the Gui will indicate if prohibited functions have

been found. If prohibited functions HAVE been found, use the View

button to view the source code with the prohibited call. The Help button

gives further information on how to work the Gui.


The Process Control File Checker examines selected PCFs and highlights any errors. The 
Process Control File Gui allows the user to work through the directory structure on the local 
machine and select PCFs to be checked. Click the Check PCF button to check a selected PCF. 
Again, the Help button provides more information. 

26.13.12 Placing the Science Software Executable (SSEP) on the Data Server 

In order to be able to run a PGE within the ECS system, the EXE TAR file has to be inserted to 
the Science Data Server. This tar file consists of all files needed to run a PGE, except for input 
data files. This includes the executables, any scripts, and the SDP Toolkit message files. 

26.13.12.1 Assembling a Science Software Executable Package (SSEP) 

This section describes how to assemble a Science Software executables Package (SSEP) and 
create a corresponding Target MCF. A SSEP is a UNIX tar file which contains PGE executables 
and SDP Toolkit message files. 

In order to Insert a PGEEXE tar file into the Science Data Server, a corresponding Target MCF 
(.met) must be generated before insertion. Such an ASCII metadata ODL file can be obtained by 
editing an existing template ODL file with the information of the specific PGE. The following 
procedures describe how to assemble a PGEEXE tar file and create an ASCII metadata ODL file. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. PGE executables and message files required by this PGE are available to make a 
SSEP. 
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To create an SSEP, execute the steps that follow: 

1 At the UNIX prompt on an AIT Sun, type mkdir SSEPpathname, press Return. 
• The SSEPpathname is the full path name of a new directory which will contain all 

the files to be placed into the SSEP as well as the SSEP itself. 
•	 It is recommended that SSEPpathame be named with a convention that indicates 

the PGE for which a SSEP will be created. For example, type mkdir PGE35.ssep, 
press Return. 

2 At the UNIX prompt on the AIT Sun, type cd SSEPpathname, press Return. 
• The SSEPpathname is the directory name of the new directory created in step 1. 

3	 At the UNIX prompt on the AIT Sun, type cp pathname/file1 pathname/file2 … 
pathname/filen ., press Return (note the “dot” and then space at the end of the 
command). 

•	 The pathname/file1, pathname/file2,…pathname/filen  represents a list of path 
names and file names (delimited by spaces) to copy into the current directory, 
SSEPpathame (the “dot” represents the current directory and must be last in the 
command). 

•	 For example, type cp /data/MODIS/pge/PGE35.exe 
/data/MODIS/mcf/mod35.mcf /data/MODIS/MOD_13453 ., press Return (note 
the space and then “dot” at the end of the command). 

•	 The files copied into this directory should be the PGE executable, any shell scripts 
or other executables that are part of the PGE and SDP Toolkit message files. 

•	 Files can be individually copied into the SSEPpathame directory. For example, 
type cp /data/MODIS/pge/PGE35.exe ., press Return (note the space and then 
“dot” at the end of the command). Repeat for each file needed in the SSEP for this 
PGE. 

4 At the UNIX prompt on the AIT Sun, type tar cvf SSEPfilename.tar *, press Return. 
• The SSEPfilename.tar is the file name for the SSEP tar file. The file name 

extension .tar is recommended but not required. 
• The asterisk (*) is a file name wildcard that represents all files in the current 

directory. This will place all files in the SSEP tar file. 
• Once created, the contents of the SSEP tar file can be viewed by typing tar tvf 

SSEPfilename.tar, press Return. 
• Do not apply compression (e.g. UNIX compress or gzip) to the tar file. 

5 At the UNIX prompt on the AIT Sun, type cp filename.met.tpl filename.met, press 
Return. 

• The filename.met.tpl is the file name of the template Target MCF for this SSEP. 
If a template is not available, see Appendix D or use one used for another SSEP. 

• The filename.met is the file name of the Target MCF to be tailored for this SSEP. 
6 At the UNIX prompt on the AIT Sun, type vi filename.met, press Return. 

• The filename.met is the Target MCF for this SSEP. 
• This command invokes the vi editor. Edit the filename.met with the specific 

information for the SSEP to be inserted. 
• The following guidelines should be followed when editing on the Target MCF 

(filename.met): 
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• The value for the VERSIONID object should be filled out with the proper 
PGE version. For example: “1” . 

• In the INFORMATIONCONTENTCONTAINER object, 
• The value for the PARAMETERNAME object of the class “1” 

should be filled out with the PGE name. For example: “BTS”. 
•	 The value for the PARAMETERNAME object of the class “2” 

should be filled out with the PGE Science Software Version. For 
example: “1”. 

• The value for the PARAMETERNAME object of the class “3” 
should be filled out with the Platform Name. For example: “IRIX”. 

• The value for the PARAMETERNAME object of the class “4” 
should be filled out with the Platform Version. For example: “6.2”. 

•	 The value for the PARAMETERNAME object of the class “5” 
should be filled out with the date to perform the Insertion. For 
example: “970319”. 

•	 The value for the PARAMETERNAME object of the class “6” 
should be filled out with the time to perform the Insertion. For 
example: “14:45:00”. 

7 Save the changes made to the SSEP’s Target MCF ( filename.met) and exit the editor. 
• The specifics depend upon which editor is being used. If using vi, the command 

sequence to enter is :wq, press Return. 

For other editors, refer to that editor’s documentation 

Procedures continued 

1	 At the UNIX prompt on the AIT Sun, type mkdir SSEPpathname then press the Enter 
key. For example, type mkdir MOD35.ssep, press Enter. 
The SSEPpathname is the full path name of a new directory which will contain all the 

files to be placed into the SSEP as well as the SSEP itself. 
2 At the UNIX prompt on the AIT Sun, type cd SSEPpathname, then press the Enter key. 

The SSEPpathname is the directory name of the new directory created in step 1. 
3	 At the UNIX prompt on the AIT Sun, type cp pathname/file1 pathname/file2 … 

pathname/filen ., then press Enter (note the space then the “dot” at the end of the 
command). 
The pathname is the location of the files. The file1, file2,…filen represents a list of file 
names (delimited by spaces) to copy into the current directory, SSEPpathame (the “dot” 
represents the current directory and must be last in the command). For example, type cd 
/data/MODIS/pge/MOD35.pge /data/MODIS/mcf/MOD35.mcf 
/data/MODIS/MOD_13453 ., press Enter. (note the space then the “dot” at the end of 
the command). 
For the synthetic PGE, only the executable needs to be copied. 

4	 At the UNIX prompt on the AIT Sun, type tar cvf SSEPfilename.tar *, then press the 
Enter key. 
The SSEPfilename.tar is the file name for the SSEP tar file. 
The file name extension .tar is recommended but not required. 
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The asterisk (*) is a file name wildcard that represents all files in the current directory 
which will place all files in the SSEP tar file. 

Once created, the contents of the SSEP tar file can be viewed by typing tar tvf 
SSEPfilename.tar, then press the Enter key. 

5 At the UNIX prompt on the AIT Sun, type cp filename.met.tpl filename.met, then press 
the Enter key. 
The filename.met.tpl is the file name of the Target MCF for this SSEP. 
For the synthetic PGE, the met file has already been renamed and modified for use by the 

student when the file was unpacked. 
6 At the UNIX prompt on the AIT Sun, type vi filename.met, then press the Enter key. 

The filename.met.tpl is the Target MCF for this SSEP. 
7 Edit the filename.met with the specific information for the SSEP to be inserted. 

The value for the VERSIONID object should be filled out with the proper PGE 
version. 

In the INFORMATIONCONTENTCONTAINER object enter the following: 
The value for the PARAMETERNAME object of the class “1” should 

be filled out with the PGE name. The synthetic PGE should be 
“userid”. 

The value for the PARAMETERNAME object of the class “2” should 
be filled out with the PGE Science Software Version. 

The value for the PARAMETERNAME object of the class “3” should 
be filled out with the Platform Name. 

The value for the PARAMETERNAME object of the class “4” should 
be filled out with the Platform Version. 

The value for the PARAMETERNAME object of the class “5” should 
be filled out with the date to perform the Insertion. 

The value for the PARAMETERNAME object of the class “6” should 
be filled out with the time to perform the Insertion. 

8 Save the changes made to the SSEP’s Target MCF ( filename.met) and exit the editor. 

The specifics depend upon which editor is being used. If using vi, the command 
sequence to enter is :wq, then press the Enter key. 

26.13.12.2 Inserting a Science Software Executable Package onto the Data 
Server 

. Science software, like any other data that are managed in the ECS, must be placed on the 
Science Data Server. A program called the Insert EXE TAR Tool can be used for Inserting a 
Science Software Executable Package into the Data Server. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The ESDT called PGEEXE has been installed on the Science Data Server. 
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2. A Target MCF (.met) for this PGEEXE tar file has been created for the Insert. 

1. The PGEEXE tar file has been created .\ 

2. The following Servers/Services must be up an operational: 

Science Data Server, Storage Management. 

To Insert the SSEP to the Science Data Server, execute the steps that follow: 

1 From the SSIT Manager, click on the Tools menu, then choose Data Server and then 
Insert EXE TAR. 

• An xterm with title “SSIT: PGE Executable Tar File Insertion” will be displayed. 
2 At the program prompt Configuration filename? (enter for default: 

../../EcDpAtInsertExeTarFile.CFG), press Return. 
3 At the program prompt ECS mode of operations?, Type <mode> press Return. 

• <mode> can either be OPS or TS1. 
4 At the program prompt Name of PGE?, type PGEName, press Return. 

•	 The PGEName is the name of the PGE for which this static granule is being 
Inserted. For example, type PGE01, press Return. 

•	 The PGEName must match exactly the PGE name entered into the PDPS for this 
PGE. 

5	 At the program prompt Science software version of PGE?, type SSWversion, press 
Return. 

•	 The SSWversion is the version of the science software which is being Inserted in 
this SSEP. Press Return to accept the default or enter in a version and press 
Return. 

6	 At the program prompt Staged filename to insert (including Full path)?, type 
pathname/SSEPFileName, press Return 

•	 The pathname/SSEPFileName is the full path name and file name of the SSEP tar 
file to be Inserted. For example, type /data/MOD35/ssep/PGE35_1.tar, press 
Return. 

• The SSEP tar file must not be compressed (e.g. with UNIX compress or gzip). 
7	 At the program prompt Associated ASCII metadata filename to insert (including Full 

Path)? pathname/SSEPFileName.met)?, press Return. 
•	 The default is the file name of the granule to insert with the .met file name 

extension. If the default is not correct, then the file name of this file must be 
entered. 

8	 At the program prompt Top level shell filename within tar file?, type ExecFileName, 
press Return. 

•	 The ExecFileName is the file name of the top level executable or script within the 
SSEP tar file. It should be the same as was entered into the PDPS/SSIT Database 
Update GUI. 

• The SSEP will be Inserted to the Science Data Server. 
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9 At the program prompt Hit return to run again, ”q <return>‘ to quit: type q and press 
Return to quit or just press Return to insert additional dynamic granules. 

• If continuing, repeat steps 3 through 8. 

Example of a successful insertion of a SSEP EXE TAR: 

PGE Executable Tar File Insertion Script 
Configuration filename? (enter for default:../../cfg/EcDpAtInsertExeTarFile.CFG) 

ECS Mode of operations? (enter for default: OPS) 

OPS 

Name of PGE? (enter for default: PGE07) 

PGE07 

Science software version of PGE? (enter for default: 0) 

Staged filename to insert (including FULL path)? (enter for default: 

/home/emcleod/SSEP/MODPGE07.tar) 

Associated ASCII metadata filename to insert (including FULL path)? (enter for 

default: /home/emcleod/SSEP/MOD_PR10.tar.met) 

Top level shell filename within tar file? (enter for default: 

/home/emcleod/SSEP/MOD_PR10.exe) 

MOD_PR10.exe (note: this entry is done a second time) Note: If you get core dump, execute using 
“dbx command: type in: dbx filename .exe. This will help isolate error message that caused core dump. 

Warning: Could not open message catalog "oodce.cat" 

EcDpAtInsertExeTarFile: Process Framework: ConfigFile 

../../cfg/EcDpAtInsertExeTarFile.CFG ecs_mode OPS 

Performing INSERT...... 

incomplete group entries in the configfile,using default G1 

Trying to make a request to [MDC:DSSDSRV] 

incomplete group entries in the configfile, using default 

Trying to make a request to [MDC:DSSDSRV] 

incomplete group entries in the configfile, using default 

Insert to Data Server and PDPS database update successful for: 

PGE name = 'PGE07' 

Ssw version = '0' 
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 ESDT = 'PGEEXE'


ESDT Version = '0'


staged file = '/home/emcleod/SSEP/MODPGE07.tar'


metadata file = '/home/emcleod/SSEP/MOD_PR10.tar.met'


Top level shell name = 'MOD_PR10.exe'


Inserted at UR: 

'UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]:14:LM:PGEEXE:1787' 

Hit return to run again, 'q <return>' to quit: 

26.14 PGE Planning Processing and Product Retrieval 

26.14.1 Using the Production Request Editor 

When standalone tests (Run from the command line) have completed successfully and 
information about the PGE has been entered into the PDPS Database (through PGE registration), 
the PGE is ready to be run through the automated ECS PDPS environment. 

To process Science data, a Production Request (PR) must be submitted to the ECS system. The 
Production Request Editor GUI accomplishes this function. Only one PR may be submitted at a 
time. A single PR is exploded by the PDPS into one or more jobs called Data Processing 
Requests (DPRs). The number of DPRs that are created for a single PR is determined by the 
number needed to cover the requested time interval, orbital extent and tile schema. Some PRs 
may only require one DPR. 

26.14.2 Invoking the Production Request 

Currently, the Production Request Editor is invoked from a command line script. In the future, 
this will be done by clicking on the icon for the PR Editor on the ECS Desktop. Once the 
Production Request Editor is invoked, it brings up a screen with five tabs at the top for selection 
(as shown in Figure 26.14.3-1). The first tab is labeled “Planning”. Selection of this tab displays 
a list of four capabilities available for the PR Editor by selecting the other tabs at the top of the 
primary GUI screen: PR Edit, PR List, DPR View, and DPR List. 

******* Please be advised: Only one user per mode can be executing a DPR at a time. If 
more than one occurs the system will cancel the remaining DPR’s. Problem discovered 
when chained PGE’s failed to kickoff. ******* 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The PGE has been registered in the PDPS Database. 

2. The PGE has been successfully compiled and linked with the DAAC version of the 
SDP Toolkit. 
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3. The required servers are up and running. 

To invoke the Production Request Editor GUI, execute the procedure steps that follow: 

1 In any currently available xterm window, spawn a new session: type xterm &, press 
Return. Then telnet to the PLS host. 

•	 It is recommended that this procedure begin within a new command shell on a PLS 
Host. 

2 Set the DISPLAY environment variable. At the UNIX prompt on the PLS host (e.g. 
p0pls01), type setenv DISPLAY terminal_id, press Return. 

3	 Set the DCE environment variable. At the UNIX prompt on the PLS host (e.g. odyssey), 
type dce_login DCE_user_name DCE_password, press Return. 

4	 Set the UNIX environment variable. At the UNIX prompt on the PLS host, change to the 
directory where the scripts are located (e.g. cd /usr/ecs/TS1/CUSTOM/utilities), then 

• Type setenv MODE mode (e.g. TS1). 
• Type source environment_setup_file (e.g. EcCoEnvCsh for C shell users). 

5	 At the UNIX prompt on the PLS host (e.g. odyssey), under the directory where the scripts 
are located (e.g. cd /usr/ecs/TS1/CUSTOM/utilities), type EcPlPRE_IFStart mode 
application_id &, then press Return. 
• The mode is the operations mode (e.g. TS1). 
• The application_id is a numerical number (e.g. 1). 
• For example, type EcPlPRE_IFStart TS1 1 &, press Return. 
•	 Various messages from the Production Request Editor may appear in this 

window as it is running. For this reason, avoid using this window for other tasks 
until the Production Request Editor has terminated. 

6	 In the Production Request Editor, click on one of the tabs PR Edit, PR List, DPR View, 
or DPR List corresponding to desired task. 
•	 To define a new Production Request or edit a Production Request, click on PR 

Edit. Proceed to Section Defining a New Production Request. 
• To review or list a Production Request, click on PR List. 
• To view or inspect a Data Processing Request, click on View. 
• To review or inspect a Data Processing Request, click on List. 

7	 When tasks are completed in the Production Request Editor GUI, click on the File menu, 
then choose Exit. 

• The Production Request Editor will disappear. 
•	 Refer to Section (Troubleshooting and General Investigation) if fail to bring up 

the Production Request Editor GUI. 
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Figure 26.14.3-1. Production Request Editor Introductory GUI 

26.14.3 Defining a New Production Request 

A Production Request (PR) is a request for data production of granules between a start date/time 
and an end date/time. A PR will explode into one or more Data Processing Requests (DPR) 
depending upon the time interval involved. Each DPR corresponds to the execution of a PGE. 
Therefore, a PR results in the execution of a PGE one or more times. Only one PGE is involved 
in a single Production Request. 
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Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

• The user has selected the PR Edit tab from the Production Request Editor . 

•	 The PGE involved in the Production Request has been registered in the PDPS 
database. 

On workstation x0pls##, at the UNIX prompt in a terminal window, type as in step 1 
below your user id and password. 

NOTE: The x in the workstation name will be a letter designating your site: 
g = GSFC, m = SMC, l = LaRC, e = EDC, n = NSIDC, o = ORNL, a = ASF, j = JPL; the 

## will be an identifying two-digit number (e.g.,g0pls02 indicates a Planning 
Subsystem (PLS) workstation at GSFC). 

Prior to the rlogin, enter setenv DISPLAY <local_workstation IP address>:0.0. The 
<ipaddress> is the ip address of x0pls##, and xterm is required when entering this 
command on a Sun terminal. 

To define a new Production Request, execute the procedure steps that follow: 

1 From the Production Request Editor GUI, click on the PR Edit tab. 
• The PR Edit page will be displayed as shown in Figure. 26.14.3-2. 

2­ In the field labeled PR Name:, enter New or verify that New is already entered as the 
default. 

3­ The PGE for the Production Request must be selected from a list. To do this, click on the 
PGE… button. 

•	 A GUI labeled PGE Selection will be displayed within which registered PGEs will 
be listed. The appropriate PGE can then be selected by clicking on it and then on 
the OK button. 

•	 The selected PGE will then be used to populate Satellite Name, Instrument Name, 
PGE Name, and PGE Version fields of the main GUI. 

4 In the field labeled Priority:, enter priority. 
•	 The priority is the priority to be assigned to this Production Request in the range 0 

through 999 with 0 being the highest priority and 999 the lowest. For example, 
enter 40. 

5­ In the Production Request Editor GUI, a Duration option is selected automatically based 
on the PGE registered into the PDPS. Two options are provided: 

• UTC Time for time range. 
• Orbit for orbit number range. 
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6­ In the Production Request Editor GUI, enter StartDate and StartTime in fields labeled 
Begin, respectively. 

•	 The StartDate and Starttime are the start date and time of the Production Request 
and should be entered in the mm/dd/yy and hh:mm:ss formats. 

7­ In the case of UTC Time duration, enter EndDate and EndTime in fields labeled End, 
respectively. 

•	 The Enddate and EndTime are the end date and time of the Production Request 
and should be entered in the mm/dd/yy and hh:mm:ss formats. 

8­ In the case of Orbit duration, enter StartOrbit and EndOrbit in fields labeled From and 
To, respectively. 

• The StartOrbit and EndOrbit are the orbit range of the Production Request. 
9 Optionally, enter Comment in field labeled Comment:. 

•	 This comment will be displayed whenever this Production Request is brought up 
and viewed. 

10 When Production Request is complete, click on File menu and select Save As…. 
• A GUI labeled File Selection will be displayed. 
•	 In the field labeled Selection, enter a user-defined name to be assigned to the 

Production Request. Then click on the OK button. A message box will be displayed 
stating “Production Request Explosion into DPRs ok, n DPRs Generated”, where n 
will be the number of DPRs (e.g. a 2-hr PR time will generate 24 DPRs for the 5­
min processing period). Click on the Ok button. A second message box stating 
“Write to Database of Production Request ok”; again click Ok. 

Note that you will not be allowed to enter a PR name that already exists. PR names that 
already exist will be displayed in the main window. The Production Request will 
then be saved under the name specified. 

•	 Refer to Section (Troubleshooting and General Investigation) if fail to generate 
the DPRs. 

11­ When tasks are completed with the Production Request Editor GUI, click on the File 
menu, then choose Exit. 

• The Production Request Editor GUI will disappear. 
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Figure 26.14.3-2. Production Request Editor GUI(Planning) 

26.14.4 Processing 

Once a candidate plan has been activated, each of the DPRs will result in subscriptions to the 
Data Server for the data needed. A request will go to the Data Server asking for notification 
when the required input data arrives. 
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Planning knows what data to request from the Data Server because the PDPS database stores this 
information as determined by the ESDT for each PGE. When the Data Server receives new data, 
it routinely checks to see if there are any outstanding subscriptions. If there are subscriptions, 
Planning will be notified. Once the input data required by a DPR becomes available, the DPR 
can be queued for processing. 

Staging - The Data Processing Subsystem requests that the required input data, PGE (binary 
executables and shell scripts) and SDP Toolkit files be placed on a disk set aside for processing. 

Process Control File (PCF) - establishes a linkage between logical Ids that the science software 
uses and the physical files that exist on the staging disk. 

After the PGE has completed, the DPS will deallocate resources. 

A Production History file will be created and will contain information concerning the conditions 
that the data products were generated by the PGE. 

26.14.4.1 Viewing Production Requests 

A Production Request (PR) is a request for data production of granules between a start date/time 
and an end date/time. A PR will explode into one or more Data Processing Requests (DPR) 
depending upon the time interval involved. Each DPR corresponds to the execution of a PGE. 
Therefore, a PR results in the execution of a PGE one or more times. Only one PGE is involved 
in a single Production Request. 

This procedure describes how to view PRs that have already been defined . It assumes that the 
PR List tab has been selected from the Production Request Editor. 

The information listed for each PR is: 

• PR Name - The name assigned to the Production Request when it was defined. 

• PGE ID - The name of the PGE involved in the PR. 

• Priority - The priority (0 - 99) of the PR assigned when it was defined. 

• Start - The start date and time of the PR. 

• End - The end date and time of the PR. 

• Comment - Any comment that was entered when the PR was defined. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The user has selected the PR List tab from the Production Request Editor. 

1 From the Production Request Editor GUI, click on the PR List tab. 
• The PR List page will be displayed as shown in Figure 26.14.4-1. 
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2	 View the listed PRs. Optionally, find a PR by entering a search string in the field next to 
the Find button and then clicking on the Find button. 

3	 To modify a PR listed, click on the PR in the list and from the File menu select Save 
As…. 
•	 In the File Selection GUI, replace the current PR name shown in the Selection 

field with a new PR name. Then click on the OK button. 
• When modifying an existing PR, it must be saved under a new PR name. 
•	 Next, click on the PR Edit tab. The PR Edit page will be displayed with fields 

populated from the existing PR name, but having the new PR name chosen above. 
• See Section on using the PR Edit page and saving any changes made 

Figure 26.14.4-1. PR List GUI. 
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26.14.4.2 Viewing Data Processing Requests 

Clicking on the DPR View GUI tab displays a list of all DPRs for all PRs entered into the 
system. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

1	 From the PR Editor GUI, click on DPR View tab. The following information will be 
displayed: 

• Data Processing Request Identification. 

• PGE ID and its parameters. 

• Request Data and Status. 

26.14.4.3 Listing Data Processing Requests 

Selection of one PR on the PR List by highlighting it and then clicking on the DPR List tab, 
brings up a detailed display of all DPRs associated with the selected PR. These may be examined 
in order to develop production plans and schedule jobs. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

1 From the PR Editor GUI, click on DPR List tab. The following information is displayed: 
• DPR Id. 
• PGE Id. 
• PR Name. 
• Data Start Time. 
• Data Stop Time. 

26.14.5 Using the Production Planning Workbench 

The Production Planner uses the Production Planning Workbench to create new production plans 
and display a planning timeline. 

26.14.5.1 Using the Planning Workbench to Run a PGE 

Once a PGE has been fully registered, its test data files have been inserted to the Science Data 
Server, and a single Data Processing Request (DPR) has been generated, the Planning 
Workbench can be used to plan for one execution run of a single PGE. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The required UNIX environment variables have been set properly. 

2. The required servers of the ECS System are up and running. 
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3. A DPR has been generated successfully. 

1	 Telnet to (PDPS) odyssey  or from the SSIT Manager, click on the Tools menu, then 
choose Xterm. Then telnet to a PLN Host. 
•	 Alternatively, in any currently available xterm window, spawn a new session: type 

xterm &, press Return. Then telnet to the PLN Host. 

• It is recommended that this procedure begin within a new command shell on a 
PLN Host. 

2 login: ID 
password: 

3	 Login to DCE (dce_login DCE_user_name DCE_password and then press Enter 
Key.), setenv DISPLAY ….:0.0 
6. 	 Change the working directory to the location where the script for starting the Autosys 

is stored. (e.g. cd /usr/ecs/<mode>/CUSTOM/utilities). 
7. Type: source EcCoEnvCsh 

4	 At the UNIX prompt on an PLN Host, Type EcPlAllStart <mode> <application_id>, 
press Return. 
• The mode is one of modes used in the ECS system. e.g. TS1. 
• The application_id is a numerical number. e.g. 1. 
• For example: EcPlAllStart TS1 1, Return. 
• A Planning Workbench GUI will be appeared as shown in Figure 26.14.6-1. 

5 In the Planning Workbench GUI, go to the subwindow labeled Unscheduled and click on 
a Production Request name. 

• The Production Request name is the name under which the PR was saved. 
• The PR name entry will be highlighted. 

6	 In the Planning Workbench GUI, click on the button next to the label Schedule (the 
button has an inverted triangle on it). 

• The PR highlighted in step 3 will appear in the subwindow labeled Scheduled. 
7 In the Planning Workbench GUI, click on the Activate button 

• A small GUI labeled Plan Activation will be displayed. 

8	 In the Plan Activation GUI, set the time in the time field forward to allow ample time for 
the PGE to run. Then click on the Ok button. 
•	 All that is necessary is for there to be sufficient time for the PGE run. There is no 

penalty for allowing too much time. 
•	 The Production Request thus planned will be submitted to processing and its 

progress can be monitored with AutoSys. 

10	 When tasks are completed with the Planning Workbench GUI, click on the File menu, 
then choose Exit. 
• The Planning Workbench GUI will disappear. 
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Important Note : The creation of Production Requests and Plans requires close coordination 
among all who are using the same mode in SSIT. Otherwise, the submittal of a Plan may prevent 
a waiting DPR from starting. In particular, when submitting a new Plan in a mode being shared 
with others, one should: 

• Ask everyone else if they have a DPR awaiting data as part of a chain. 
• Check the PDPS database table PlDataProcessingRequest for any DPRs that are in 

state CQ_HOLD and include these in the new Production Request and Plan. 
• Also, include any DPRs (except those marked SUCCESS) upon which the given 

DPR depends in the new Production Request and Plan. 

26.14.6 Creating and Activating of a Production Plan 

The Production Planner creates a plan for production data processing at the DAAC by selecting 
specific PRs whose DPRs are to be run. The planning tool provides a forecast of the start and 
completion times of the jobs based upon historical experience in running these PGEs. Through 
the planning tool, when the generated plan is “activated,” the information included in the plan is 
transferred to the Data Processing subsystem and loaded into the Platinum AutoSys tool where 
production processing is managed. 

The Production Planner creates the plan by selecting PRs from two lists of PRs, i.e., the list of 
available “Unscheduled” PRs and the list of “Scheduled” PRs. Using arrow buttons, the 
Production Planner moves the PRs between lists until the “Scheduled” list contains the desired 
set of PRs that define the new plan. Only one user can use the Planning Work Bench at a time. 
It is recommended for SSI&T that only one person do the planning for the group. 

Before creating a new production plan the Production Planner must have available the following 
information: 

Name of the plan.

Comments (if any).

PRs to be included in the new production plan.


1 Log into one of the pln sun workstations by typing: username then press the Enter key. 

2 Enter the password then press the Enter key. 
Prior to the remote login, enter setenv DISPLAY <local workstation IP address>:0.0 

where the local workstation IP address represents the IP address you where you are 
located. 

You may need to setup the terminal so that the remote host is displayed on your screen 
(Sun machine). This is done by clicking on the Application Manager icon (the file 
drawer located at the bottom of the screen), followed by the Desktop Tools icon, 
followed by the Terminal Console icon 

3 At a UNIX prompt type cd to the directory where the scripts are located. (e.g. 

/usr/ecs/TS1/CUSTOM/utilities). 

4 At a UNIX prompt type setenv DISPLAY hostname:0.0 
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5	 At a UNIX prompt on the PLN host (e.g. p0pls01), type EcPlPRE_IFStart mode 3 a 
Planning Workbench GUI is displayed (Figure 26.14.6-1) 

Figure 26.14.6-1. Planning Workbench GUI 
Data concerning the currently active production plan are displayed. 
If you want to “kill” (deactivate) the currently active production plan without activating a 

replacement, click on the Kill button. 
Whenever you activate a plan (by clicking on the Activate button), you automatically 

“kill” the currently active plan. 
6 Select File → New from the pull-down menu. 

The “New” window appears. 

7 Type a name for the new plan, then press the Tab key on the keyboard. 

The Planning Workbench GUI is displayed.

The Plan Name is displayed.

The Status displayed is Candidate.


8 Type the desired date (in MM/DD/YY format), then press the Tab key on the keyboard to 
advance to the next field. 

9 Type the desired time (in hh:mm format), then press the Tab key on the keyboard. 
The Rollover Time is displayed. 

10 Type any relevant comments (up to 255 characters) in the Comments field. 

11	 Move PRs between the Unscheduled and Scheduled lists as necessary by selecting 
(highlighting) the PR to be moved by clicking on the PR in the list from which it is to be 
moved then clicking on the up or down arrow button (as applicable) to move the PR to 
the other list. Highlighted PR disappears from one list and appears on the other. 
The unscheduled and scheduled PR lists are scrollable. 
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12	 When the Scheduled list accurately reflects the PRs to be scheduled in the production 
plan, select File → Save (or File → Save As) from the pull-down menu to save the new 
production plan. 
The new production plan is saved. 

13	 If the new plan is to be activated immediately, click on the Activate button to activate the 
new plan. 
The currently active plan is killed (deactivated) and the new plan is activated. 
• The Production Planning Timeline GUI is displayed. 

14	 If the new production plan is to be used as a baseline plan, click on the Baseline button. 
The “New” window appears. 
The plan is recorded as well as the time of baselining so that it can be used in comparing 

future processing results with planned objectives. 
15	 If the production plan being displayed is active and should be deactivated, click on the 

Kill button. The “New” window appears. 
The plan is deactivated without activating another plan. 

The progress of one or more PGEs running within the PDPS may be monitored. The COTS tool 
used for this purpose is AutoSys by Atria Software. Each Data Processing Request results in 
seven AutoSys jobs that are boxed together. An AutoSys job name follows the template: 

PGEname#Suffix 
where PGEname is replaced by the name of the PGE, and Suffix is a character indicating the job 
phase of the DPR 
For example, for a scheduled PGE named MOPITT4, the AutoSys jobs making up that DPR 
would be: 

MOPITT4#A 
MOPITT4#S 
MOPITT4#P 
MOPITT4#E 
MOPITT4#p 
MOPITT4#I 
MOPITT4#D 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The required servers of the ECS System are up and running. 

2. A DPR has been scheduled successfully. 

To monitor production, execute the procedure steps that follow: 

1 In any currently available xterm window, spawn a new session: type xterm &, press 
Return. Then telnet to the DPS host. 

•	 It is recommended that this procedure begin within a new command shell on a 
DPS Host. 
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•	 Set the DISPLAY environment variable. At the UNIX prompt on the DPS host 
(e.g. p0pls01), type setenv DISPLAY terminal_id, press Return. 

2	 Set the DCE environment variable, at the UNIX prompt on the DPS host (e.g. p0pls01), 
type dce_login DCE_user_name DCE_password, press Return. 

3	 Set the UNIX environment variable,at the UNIX prompt on the DPS host, change to the 
directory where the scripts are located (e.g. cd /usr/ecs/TS1/CUSTOM/utilities), then 

• Type setenv MODE mode (e.g. TS1). 
• Type source environment_setup_file (e.g., EcCoEnvCsh for C shell users). 

4	 At the UNIX prompt on the DPS Host, under the directory where the scripts are located 
(e.g. cd /usr/ecs/TS1/CUSTOM/utilities), type EcDpPrAutosysStart mode
application_id &, then press Return. 

• The mode is one of modes used in the ECS system (e.g., TS1). 
• The application_id is a numerical number (e.g., 1). 
• For example: EcDpPrAutosysStart TS1 1, Return. 
• A GUI labeled AutoSys will be displayed. 
•	 This GUI will contain eight buttons for invoking various tools available under 

AutoSys. 
5 In the AutoSys GUI, click on the Ops Console button. 

• A GUI labeled AutoSys Job Activity Console GUI will be displayed. 
•	 The main subwindow of this GUI will contain a dynamically updated list of 

AutoSys jobs (seven jobs make up one DPR) currently scheduled. 
•	 To disable dynamic updating of the main subwindow (which may be distracting), 

click on the View menu, then choose Select Jobs. A GUI labeled Job Selection 
will be displayed. Under the label Select by Name, click on the square labeled All 
jobs, then click on the OK button. 

•	 DPRs will be listed in the column labeled Job Name and their statuses (e.g. 
SUCCESS) will be listed in the column labeled Status. 

•	 To view job status information for a particular DPR, click on a DPR. Below the 
main subwindow, available job status information will be displayed. 

•	 To view the existing event report, under the label Reports, click on the middle 
diamond labeled Event. The current event status for the selected DPR will be 
displayed in the subwindow labeled Event Report. Alternatively, the summary 
report for the selected DPR will be displayed by clicking on the middle diamond 
labeled Summary. 

•	 To view the job definition, under the label Show, click on the Job Definition tab. A 
GUI labeled Job Definition will be displayed. The selected DPR is shown in Job 
Name. To kill the DPR, click on the Delete tab. (Warning: Be very careful to 
avoid deleting wrong DPR!) 

• Exit the AutoSys Job Activity Console by clicking on the Exit button. 
6 In the AutoSys GUI, click on the JobScape button. 

• A GUI labeled JobScape will be displayed. 
•	 The main subwindow of this GUI will contain a dynamically updated list of 

AutoSys jobs (seven jobs make up one DPR) currently scheduled. The colors 
indicate the job statuses for DPRs and their jobs at present. 
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•	 There are eleven job statuses: ACTIVATED, STARTING, RUNNING, SUCCESS, 
FAILURE, TERMINATED, RESTART, QUE_WANT, ON_ICE, OFF_HOLD, and 
INACTIVE. The color chart is on the left of GUI. 

•	 To view job status information for a particular DPR (or job) in detail, click on a 
DPR (or job), then click on the Job Console button. A GUI labeled Job Console 
will be displayed. The information shown here is similar to that shown in Ops 
Console as mentioned above. 

•	 To change the status of a job for a particular DPR, click on a job under that DPR, 
then press the right button of the mouse. Choose one of the functions in the lower 
part of the menu. For example, to hold a job, choose On Hold, then click the Yes 
button. 

•	 Suggestion:  For a scheduled DPR, hold all jobs for that DPR except the first one 
(Allocation). After the first job runs successfully, release the next job (Staging) by 
choosing Off Hold. Repeat until all jobs are done. Therefore, if a job fails, it can 
be fixed and rerun without interfering with the others. 

• To exit the JobScape, click on the File menu, then choose Exit. 
7 In the AutoSys GUI, click on the TimeScape button. 

• A GUI labeled TimeScape GUI will be displayed. 
•	 The main subwindow labeled Job Name of this GUI will contain a dynamically 

updated list of AutoSys jobs (seven per DPR) currently scheduled. 
•	 To disable dynamic updating of AutoSys jobs (which may be distracting), click 

on the Freeze Frame button. 
•	 The color of each job indicates its status according to the legend on the left side of 

the GUI. 
•	 The time line is shown on the right side of the GUI with time marked at the top. A 

red vertical line (dashed) indicates the current time. 
• Exit the TimeScape GUI by clicking on the File menu and selecting Exit. 

8 To quit AutoSys, in the AutoSys GUI, click on the Exit button. 
• The AutoSys GUI will disappear. 
•	 Refer to Section (Troubleshooting and General Investigation) if any job fails on 

AutoSys. 

On workstation x0pls##, at the UNIX prompt in a terminal window, enter steps as in step 
1 below. 

NOTE: The x in the workstation name will be a letter designating your site: 
g = GSFC, m = SMC, l = LaRC, e = EDC, n = NSIDC, o = ORNL, a = ASF, j = 
JPL; the ## will be an identifying two-digit number (e.g.,g0pls01 indicates a 
Planning and Data Processing subsystem(PLS) workstation at GSFC). 

Prior to the rlogin, enter setenv DISPLAY <local_workstation IP address>:0.0. The 
<ipaddress> is the ip address of x0pls##, and xterm is required when entering this 
command on a Sun terminal. 
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26.14.7 Monitoring Production in PDPS Subsystem 
Example of monitoring production usisng above procedures: 

1	 telnet to (PDPS) p0sps06  or from the SSIT Manager, click on the Tools menu, then 
choose Xterm. Then telnet to a PLN Host. 

11 login: ID, password: 
3	 Login to DCE (dce_login DCE_user_name DCE_password and then press Enter 

Key.), setenv DISPLAY ….:0.0 
4	 Change the working directory to the location where the script for starting the Autosys 

is stored. (e.g. cd /usr/ecs/<mode>/CUSTOM/utilities). 
5 setenv MODE <MODE> 
6 source EcCoEnvCsh 

4	 At the UNIX prompt on the PLN Host, type: EcDpPrAutosysStart <MODE> 
<Autosys Instance>, example: TS1 1, &, press Return. 

• A GUI labeled AutoSys will be displayed. 
•	 This GUI will contain eight buttons for invoking various tools available under 

AutoSys. 
5 In the AutoSys GUI, click on the Ops Console button. 

− The AutoSys GUI will be displayed. 

6 Select the desired display and view the contents. 

− Selections include: 

1. Autosys Job Activity Ops Console 

2. HostScape 

3. TimeScape 

4. JobScape 
•	 The main subwindow of this GUI will contain a dynamically updated list of 

AutoSys jobs (seven jobs make up one DPR) currently scheduled. 
•	 To disable dynamic updating of the main subwindow (which may be distracting), 

click on Freeze Frame in the small subwindow labeled Show. 
•	 DPRs will be listed in the column labeled Job Name and their statuses 

(SUCCESS, FAILURE, TERMINATED) will be listed in the column labeled 
Status. 

•	 To view job status information for a particular DPR, click on a DPR. Below the 
main subwindow, available job status information will be displayed. 

•	 To view the existing event report, under the label Reports, click on the middle 
diamond labeled Event. The current event status for the selected DPR will be 
displayed in the subwindow labeled Event Report. 

• Exit the AutoSys Job Activity Console by clicking on the Exit button. 
Suggestion:  For a scheduled DPR, hold all jobs for that DPR except the first one 
(Allocation). After the first job runs successfully, release the next job (Staging) by 
choosing Off Hold. Repeat until all jobs are done. Therefore, if a job fails, it can 
be fixed and rerun without interfering with the others. 
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This is especially important for the Postprocessing job. If the PGE fails and the 
Postprocessing job is not On Hold, the DPR will have to be deleted and a new one 
created. This happens because PDPS will have deleted all references to the output 
granules in the PDPS database 

7 In the AutoSys GUI, click on the TimeScape button. 
• A GUI labeled TimeScape GUI will be displayed. 
•	 The main subwindow labeled Job Name of this GUI will contain a dynamically 

updated list of AutoSys jobs (seven per DPR) currently scheduled. 
•	 To disable dynamic updating of AutoSys jobs (which may be distracting), click 

on the Freeze Frame button. 
•	 The color of each job indicates its status according to the legend on the left side of 

the GUI. 
•	 The time line is shown on the right side of the GUI with time marked at the top. A 

red vertical line (dashed) indicates the current time. 
• Exit the TimeScape GUI by clicking on the File menu and selecting Exit. 

8 To quit AutoSys, in the AutoSys GUI, click on the Exit button. 
7 The AutoSys GUI will disappear. 

9	 Use the “tail -f em.log” to create a permanent record of a log file if debugging is 
necessary. Note: the xx.log file has to be created first: “vi em.log” 

10 To look at the Data Base type: setenv MODE <MODE>, cd utilities 
source EcCoEnvCsh, cd dbr, dbrowser-syb <MODE> 2 & 

11 Scrips to restart the servers and subsystems are located in: /home/cmts1/restart/drop4/ 

26.14.8 Using the Q/A Monitor 
The Q/A Monitor allows the output products produced during a PGE run to be accessed and 
examined. Input test data granules and Production History files can be retrieved in the same 
manner. The Q/A Monitor retrieves output products based on the collection name (i.e. the ESDT) 
and time of Insertion to the Science Data Server. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. The Q/A Monitor is discussed in more detail in Section 15. 

Assumptions: 

1. The required UNIX environment variables have been set properly. 

2. The desired output products have been successfully Inserted to the Science Data 
Server. 

To use the Q/A Monitor, execute the procedure steps that follow: 

1	 telnet to (PDPS) p0sps06  or from the SSIT Manager, click on the Tools menu, then 
choose Xterm. Then telnet to a PLN Host. 
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8. 	 Alternatively, in any currently available xterm window, spawn a new session: type 
xterm &, press Return. Then telnet to the PLN Host. 

9. 	 Set the DISPLAY environment variable: setenv DISPLAY terminal_id, press 
Return. 

10. Type setenv <mode> (e.g..,TS1). 
11. Type source environment_setup_file (e.g., EcCoEnvCsh for C shell users). 

2 login: ID, password: 
3	 Login to DCE (dce_login DCE_user_name DCE_password and then press Enter 

Key.), setenv DISPLAY ….:0.0 
•	 Change the working directory to the location where the script for starting the 

Autosys is stored. (e.g. cd /usr/ecs/<mode>/CUSTOM/utilities). 
4	 At the UNIX prompt on the PLN Host, type: EcDpPrQaMonitorGUIStart <MODE> 

<Q/A Monitor Instance>, example: TS1 1, &, press Return. 
• The mode is the operations mode. 
• The Q/A Monitor GUI will be displayed. 
•	 Various messages from the Q/A Monitor will appear in this window as it is 

running. 
5	 In the Q/A Monitor subwindow labeled Data Types, select an ESDT from the list 

presented and click on it. 
• Use the scroll bars if necessary to locate desired ESDT. 
• Optionally, use the Find field and button to locate an ESDT. 

6	 In the Q/A Monitor, under the label Data Granule Insert Date (mm/dd/yy), set the date 
range within which the search for granules of the ESDT selected will be conducted. 
•	 The date range can be made arbitrarily large to select all granules of a particular 

collection (ESDT). 
• The dates refer to date of granule Insert to the Science Data Server. 

7 In the Q/A Monitor, click on the Query button. 
•	 The results of the query will be displayed in the bottom window, labeled Data 

Granules. 
•	 All granules having the ESDT selected in step 3 and having Insert times within 

the date range specified in step 4 will be listed in this window. 
8	 In the Q/A Monitor subwindow labeled Data Granules, click on one of the data granules 

listed to be examined. 
• The data granule selected will be highlighted. 

9	 To retrieve the data granule’s Production History file, click on the Retrieve Prod History 
button. 
•	 The Production History (PH) tar file corresponding to the selected data granule 

will be retrieved from the Science Data Server and placed on the local machine (a 
PLN Host) in the directory /var/tmp. 

•	 The PH can then be moved or copied manually from the /var/tmp directory to a 
user working directory for examination. 

• Only the PH file is retrieved with the Retrieve Prod History button. 
•	 If only the PH is desired, exit this procedure. To retrieve the data granule itself, 

continue on to step 8. 
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10	 To retrieve the data granule, click on the Retrieve Data Granule button and note its file 
name (listed in the entry for the granule; you may have to scroll over to the right to see 
it). 
•	 The data granule selected will be retrieved from the Science Data Server and 

placed on the local machine (a PLS Host) in the directory /var/tmp. 
•	 A granule of any format (binary, ASCII, HDF, HDF-EOS) may be retrieved in 

this manner. Only HDF and HDF-EOS granules, however, may be further 
visualized using EOSView as described in the next steps. 

11 To examine the data granule, click on the Visualize data tab. 
• The Visualize data page will be displayed. 

12	 In the main subwindow on the Visualize data page, locate the file name of the granule 
retrieved in step 8 and click on it. 
•	 The item selected will be highlighted and will appear in the Selection subwindow 

below. 
13 Click on the Visualize button. 

• This action will invoke EOSView with the granule selected. 
• The granule must be HDF or HDF-EOS format. 

14	 When tasks are completed with the Q/A Monitor GUI, click on the File menu, then 
choose Exit. 

26.15  Postprocessing and General Investigation 
An important part of SSI&T is verifying that the output files produced at the DAAC are identical 
(within particular tolerances) to the test output files delivered with the DAPs. A successful 
comparison is a strong indication that the porting of the science software from the development 
facility at the SCF to the operational facility at the DAAC has not introduced any errors. 

A number of file comparison tools are available during SSI&T via the SSIT Manager GUI or 
they can be invoked from the UNIX command line. Two tools are available for comparing HDF 
or HDF-EOS files, one tool for comparing ASCII files, and another tool for assisting in 
comparing binary files. 

It is assumed that the Instrument Team has delivered test output files (produced at their SCF) 
with which to perform the comparison. 

26.15.1 Examining PGE Log Files 

Three log files are produced by PGEs during runtime: the Status log, User Log, and the Report 
log. These log files are written by the SDP Toolkit and by the science software using the 
Toolkit’s Status Message Facility (SMF). The location of these log files is specified in the 
Process Control File (PCF). When the PGE is built and run with the SCF version of the SDP 
Toolkit, the location and file names of the log files can be set as desired. When the PGE is built 
with the DAAC version of the SDP Toolkit and run within the PDPS, the location and file names 
of the log files is set by the system in the instantiated PCF. 
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The Status log file captures all error and status information. The User log file captures a subset of 
messages which are more informational. The Report log file captures arbitrary message strings 
sent by the PGE. 

The section aforementioned describes how to examine log files produced by PGEs that have 
been built with the SCF version of the SDP Toolkit and run from the command line. 

The section aforementioned describes how to examine log files (within the Production History) 
produced by PGEs that have been built with the DAAC version of the SDP Toolkit and run 
within the PDPS. 

26.15.1.1 Log Files From PGEs Run Outside of the PDPS 

When the PGE is run outside of the PDPS, the PCF specifies the location and file names of the 
log files produced. This procedure describes how to locate that information from the PCF and 
use it to examine the log files. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The PGE has been successfully built with the SCF version of the SDP Toolkit. 

2. The PGE’s PCF has been updated properly for the DAAC environment . 

1 At the UNIX prompt on an AIT Sun or on the SPR SGI, type cd PCFpathname, press 
Return. 
• The PCFpathname is the full path name to the location of the PCF used by the 

PGE for which log files are to be examined. 
2 At the UNIX prompt on the AIT Sun or on the SPR SGI, type vi PCFfilename, press 

Return. 
• The PCFfilename is the file name of the PCF used by the PGE for which log files 

are to be examined. 
• This brings up the file named PCFfilename in the vi editor. 
• Any text editor may be used such as emacs. For example, emacs MOD35.pcf, 

press Return. 
3 In the editor, search for logical IDs (beginning in the first column) 10100, 10101, and 

10102. These are the PCF entries for the LogStatus, LogReport, and LogUser 
respectively. For each, note the file names in field 2 and the path names in field 3. Then 
quit the editor. 
• If field 3 is blank, then the location is given by the default location specified in a 

line above the entries beginning with the “!” character. 
4 At the UNIX prompt on the SPR SGI, type vi StatusLogPathname/filename, press 

Return. 
• The StatusLogPathname/filename is the full path name and file name of the 

Status log file noted in step 3 associated with PCF logical ID 10100. When 
finished, quit the editor. 
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• Note any error or warning messages in file. 
• Any text editor may be used such as emacs. For example, emacs 

/PGE/MOD35/LogStatus, press Return. 
5	 At the UNIX prompt on the SPR SGI, type vi UserLogPathname/filename, press 

Return. 
• The UserLogPathname/filename is the full path name and file name of the Status 

log file noted in step 3 associated with PCF logical ID 10101. When finished, quit 
the editor. 

• Note any error or warning messages in file. 
• Any text editor may be used such as emacs. For example, emacs 

/PGE/MOD35/LogUser, press Return. 
6	 At the UNIX prompt on the SPR SGI, type vi ReportLogPathname/filename, press 

Return. 
• The ReportLogPathname/filename is the full path name and file name of the 

Status log file noted in step 3 associated with PCF logical ID 10102. When 
finished, quit the editor. 

• Note any anomalous messages in file. 
• Any text editor may be used such as emacs. For example, 

/PGE/MOD35/LogReport, press Return. 

26.15.1.2 Production History Log Files From PGEs Run Within the PDPS 

The Production History (PH) is created during PGE execution within the PDPS and then Inserted 
into the Data Server upon PGE completion. The PH is a UNIX tar file that includes the PGE log 
files. 

Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 
1. The PDPS archive configuration area is properly set up. 
2. The environment variable DataServer contains the full path name to the archive. 
This is typically /imf/archive/ or /imf_data/archive/ and varies at each DAAC. 
1 At the UNIX prompt on the SPR SGI, type cd $DataServer/PH, press Return. 

•	 The $DataServer is an environment variable containing the full path name of the Data 
Server archive and PH is a subdirectory under $DataServer containing the Production 
History tar files. 
• For example, type cd $DataServer/PH, press Return. 
2 At the UNIX prompt on the AIT Sun or on the SPR SGI, type ls -al, press 
Return. 

•	 A list of the current contents will be displayed. These will be Production History tar files. 
• The file names of PH files are named 
PGEname#versionMMDDYYhhmm_runtime.tar_UR where PGEname is replaced by the 
PGE name, version is replaced by the PGE version, MMDDYY is replaced by the Insert 
date in the month-day-year format, hhmm is replaced by the Insert time in the hours­
minutes format, and UR is replaced by the Universal Reference. For example, the PH file 
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name for Release 4.1 of a SAGE III PGE named sage_1t Inserted on December 14, 1999

at 2:00pm could be:

sage_1t#2.11214991400_runtime.tar_YAAa005Li_19991214135815.

• Look for the PH of interest.

3 At a UNIX prompt on the AIT Sun or on the SPR SGI, type cp PHtarFilename	
WorkingPathname, press Return.

• The PHtarFilename is the file name of the Production History tar file.


• The WorkingPathname is the full path name to some working directory in

which the Production History tar file is to be placed and examined.

4 At the UNIX prompt on the AIT Sun or on the SPR SGI, type cd

WorkingPathname, press Return.

• The WorkingPathname is the full path name to the working directory

specified in step 3.

5 At the UNIX prompt on the AIT Sun or on the SPR SGI, type tar xvf

PHtarFilename, press Return.

• The PHtarFilename is the file name of the Production History tar file in

the working directory.

• This command will untar the Production History tar file, extracting its

component files into the current directory.

6 At the UNIX prompt on the AIT Sun or on the SPR SGI, type vi

StatusLogFilename, press Return.

• The StatusLogFilename is the file name of the Status log file within the

PH. When finished, quit the editor.

• Note any error or warning messages in file.

• Any text editor may be used such as emacs. For example, emacs

LogStatus, press Return.

7 At the UNIX prompt on the AIT Sun or on the SPR SGI, type vi

UserLogFilename, press Return.

• The UserLogFilename is the file name of the User log file within the PH.

When finished, quit the editor.

• Note any error or warning messages in file.

• Any text editor may be used such as emacs. For example, emacs LogUser,

press Return.

8 At the UNIX prompt on the AIT Sun or on the SPR SGI, type vi

ReportLogFilename, press Return.

• The ReportLogFilename is the file name of the Report log file within the

PH. When finished, quit the editor.


• Note any error or warning messages in file. 
•	 Any text editor may be used such as emacs. For example, emacs LogReport, press 

Return. 

26.15.1.3 History Log Files From Failed PGEs Run Within the PDPS 

The History Log(HL) is created during PGE execution within the PDPS and then Inserted into 
the Data Server upon failure of the PGE. The HL is a UNIX file that includes the PGE log files, 
the PCF and PH. 

26-158 611-CD-510-001




Detailed procedures for tasks performed by the SSI&T operator are provided in the sections that 
follow. 

Assumptions: 

1. The PDPS archive configuration area is properly set up. 

2. The environment variable DataServer contains the full path name to the archive. 

1 At the UNIX prompt on the SPR SGI, type cd $DataServer/FAILPGE, press Return. 
•	 The $DataServer is an environment variable containing the full path name of the 

IMF Data Server archive and FAILPGE is a subdirectory under $DataServer 
containing the History Log files. 

• For example, type cd $DataServer/FAILPGE, press Return. 
2	 At the UNIX prompt on the SPR SGI, type ls -al, press Return. 

• A list of the current contents will be displayed. These will be History Log files. 
• The file names of HL files are named 

PGEname#versionMMDDYYhhmm_runtime.tar_UR where PGEname is replaced 
by the PGE name, version is replaced by the PGE version, MMDDYY is replaced 
by the Insert date in the month-day-year format, hhmm is replaced by the Insert 
time in the hours-minutes format, and UR is replaced by the Universal Reference. 
For example, the HL file name for Release 4.1 of a SAGE III PGE named sage_1t 
Inserted on December 14, 1999 at 2:00pm could be: 
sage_1t#2.11214991400_runtime.tar_YAAa005Li_19991214135815. 

• Look for the HL of interest. 
3	 At a UNIX prompt on the SPR SGI, type cp HLFilename WorkingPathname, press 

Return. 
• The HLFilename is the file name of the History Log file. 
• The WorkingPathname is the full path name to some working directory in which 

the History Log file is to be placed and examined. 
4 At the UNIX prompt on the SPR SGI, type cd WorkingPathname, press Return. 

• The WorkingPathname is the full path name to the working directory specified in 
step 3. 

5 At the UNIX prompt on the SPR SGI, type vi HLFilename, press Return. 
• The HLFilename is the file name of the History Log. When finished, quit the 

editor. 
• Note any error or warning messages in file. 
• Any text editor may be used such as emacs. For example, emacs HLFilename, 

press Return. 

26.15.2 The Production History 
The Production History (PH) is a UNIX tar file that is produced and

archived for every run of a PGE in the PDPS. Each PH can be uniquely

retrieved from the Data Server.

PH files are located in the $DataServer/PH directory and have the

following naming convention:

PGEname#versionMMDDYYhhmm_runtime.tar_UR
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where PGEname is replaced by the PGE name, version is replaced by the

PGE version, MMDDYY is replaced by the Insert date in the month-day­

year format, hhmm is replaced by the Insert time in the hours-minutes

format, and UR is replaced by the Universal Reference.

For example, a PH file name for Release 4.1 of a SAGE III PGE named

sage_1t Inserted on December 14, 1999 at 2:00pm would be:

sage_1t#2.11214991400_runtime.tar_YAAa005Li_19991214135815.

Detailed procedures for tasks performed by the SSI&T operator are

provided in the sections that follow.

Assumptions:

1. The PDPS archive configuration area is properly set up.

2. The environment variable DataServer contains the full path name

to the archive.

1 At the UNIX prompt on an AIT Sun or on the SPR SGI, type cd

$DataServer/PH, press Return.

• The $DataServer is an environment variable containing the full

path name of the IMF Data Server archive and PH is a subdirectory under

$DataServer containing the Production History tar files.

• For example, type cd $DataServer/PH, press Return.

2 At the UNIX prompt on the AIT Sun or on the SPR SGI, type ls ­

al, press Return.

• A list of the current contents will be displayed. These will be

Production History tar files.

• The file names of PH files are named

PGEname#versionMMDDYYhhmm_runtime.tar_UR where PGEname is

replaced by the PGE name, version is replaced by the PGE version,

MMDDYY is replaced by the Insert date in the month-day-year format,

hhmm is replaced by the Insert time in the hours-minutes format, and UR

is replaced by the Universal Reference. For example, the PH file name for

Release 4.1 of a SAGE III PGE named sage_1t Inserted on December 14,

1999 at 2:00pm could

be:sage_1t#2.11214991400_runtime.tar_YAAa005Li_19991214135815.

• Look for the PH of interest.

3 At a UNIX prompt on the AIT Sun or on the SPR SGI, type cp

PHtarFilename WorkingPathname, press Return.

• The PHtarFilename is the file name of the Production History tar

file.

• The WorkingPathname is the full path name to some working

directory in which the Production History tar file is to be placed and

examined.

4 At the UNIX prompt on the AIT Sun or on the SPR SGI, type cd

WorkingPathname, press Return.

• The WorkingPathname is the full path name to the working

directory specified in step 3.

5 At the UNIX prompt on the AIT Sun or on the SPR SGI, type tar
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xvf PHtarFilename, press Return.

• The PHtarFilename is the file name of the Production History tar

file in the working directory.

• This command will untar the Production History tar file, extracting

its component files into the current directory.

6 At the UNIX


mpt on the AIT Sun or on the SPR SGI, type vi PHcomponentFile, press Return. 
• The PHcomponentFile is the file name of one of the PH 
component files. The component files are: 
• PGEname#versionMMDDYYhhmm.Log - Contains the DPR ID, 
the actual command used to run the PGE, resource usage information, the 
PGE exit status, and files used by the PGE. 
• PGEname#versionMMDDYYhhmm.Pcf - The actual instantiated 
PCF used when running the PGE. 
• PGEname#versionMMDDYYhhmm.ProdLog - Contains the DPR 
ID, the PGE ID, and resource usage information (same as 

in the .Log file). 
• PGEname#versionMMDDYYhhmm.Profile - Contains the 
environment variables defined during the execution of the PGE including 
the contents of the PATH environment variable. 
• PGEname#versionMMDDYYhhmm.TkR 

eport - The Report log file, same as is produced when run outside of the PDPS. 
• PGEname#versionMMDDYYhhmm.TkStatus - The Status log file, 
same as is produced when run outside of the PDPS. 

•	 PGEname#versionMMDDYYhhmm.TkUser - The User log file, same as is 
produced when run outside of the PDPS. 

•	 ESDTmmddyyHHMM.met - All target MCFs for all Inserts on behalf of 
the PGE. The ESDT is the ESDT ShortName into which the file was 
Inserted, mmddyy is the month, day, and year of the Insert and HHMM is 
the time of the Insert. 

26.16 Examining PDPS-Related Scripts and Message Files 
This section describes how users may access files, in addition to the PGE-produced log files, 
which are created during the execution of a DPR job and which may hold information useful in 
tracing processing problems. 

Some of these files are written by default to directory paths that can only be accessed on either 
the SGI processor machine or one of the Sun workstations. More detailed descriptions of these 
files and the conditions under which they are generated will be supplied in future Green Book 
versions. 
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26.16.1 Examining AutoSys JIL Scripts 

JILxxxxxxxxx is the Job Information Language (JIL) script that defines the DPR job to AutoSys 
and which must be submitted to the AutoSys Database before a DPR job can be run. The name 
of the file created is system-generated and begins with the characters ‘JIL’ followed by nine 
characters (e.g. JILAAAa0066c). 

Sample file content: 
insert_job: 5251_823122483_1

job_type: command

command: /usr/ecs/{mode}/CUSTOM/data/bin/sgi/EcDpAtExecutionMain

5251_823122483_1

machine: spr1sgigsfc

std_out_file: /home/cboettch/mockpge_msfc/out/dpat_std.out

std_err_file: /home/cboettch/mockpge_msfc/out/dpat_std.err

profile: /usr/ecs/<MODE>/CUSTOM/data/bin/sgi/EcDpAtRunProfile.sh


To examine JILxxxxxxxx scripts on the AIT Sun, execute the procedure steps that follow: 

1 At the UNIX prompt on an AIT Sun, type cd JILscriptPathname, press Return. 

• The JILscriptPathname is the full path name to the location of the JILxxxxxxxx 
scripts to be examined. 

2 At the UNIX prompt on the AIT Sun, type vi JILscriptFilename, press Return. 
• The JILscriptFilename is the file name of the JILxxxxxxxx script to be 

examined. 
• This brings up the file named JILscriptFilename  in the vi editor. 
• Any text editor may be used such as emacs. For example, emacs 

JILscriptFilename, press Return. 

26.16.2 Examining Application Log Files (ALOG) 

Most of the custom code used during SSI&T routinely produce log files. For example, the SSIT 
Manager produces a log file named EcDpAtMgr.log and the tool used to Insert SSEPs to the 
Data Server (EcDpAtInsertExeTarFile.sh) produces a log file named 
EcDpAtInsertExeTarFile.log. These files are placed in the directory in which the tool was 
executed. If the SSIT Manager is run from the user’s home directory, then the log files for each 
of the associated tools will be found in the user’s home directory. Log files are produced at the 
first invocation of the tools, even if no messages are written to them. During subsequent use of 
the tools, the associated log files will be appended. 

Log files are generally named according to the convention: 

ApplicationName.log 

where ApplicationName is replaced with the name of the tool’s executable binary. For tools that 
are shell scripts (e.g. .sh files), the shell name is left out of the log file name. For example, the 
tool EcDpAtInsertStaticFile.sh produces a log file named EcDpAtInsertStaticFile.log and not 
EcDpAtInsertStaticFile.sh.log. 
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Where an SSIT Manager application has been run using login cmts1, pw: ecsu$er with 
dce_login,the log files will be found using path: /usr/ecs/{MODE}/CUSTOM/logs/. 

DCE failures have been encountered when installing ESDT’s , MCF’s and .met files. The 
term bounce the servers has been widely used in conjunction with the effort to re-install or 
delete files. Bounce means to shut down a server and then bring them back up to rid the 
servers of unwanted or old bindings. The nature of what needs to be done is outlined as follows: 

1 Install or Delete ESDT’s - the SDSRV and ADSRV need to be bounced after installation 
or removal of ESDT’s to allow for a refresh of the DCE cell management. 

2 For PGE…..odl, MCF’s and .met files, bouncing the servers SDSRV and ADSRV need 
to done after installation and reinstallation. 

3 This can be done by loging into ECS Assistant for each server. The login should be with 
generic ID: and PW:, and dce_login DCE_user_name DCE_password and then press Enter 
Key.. 

26.17 PDPS Troubleshooting - The PGE Job has Failed

• The PGE Job has failed, but the DPR has not gone into "Failed-PGE" processing

• The Post-Execute Job has failed

• The PGE Job and Post-Execute Job have both failed, but the DPR has not gone into


"Failed-PGE" processing 
• The PGE Job has failed and the DPR has gone into "Failed-PGE" processing 

26.17.1 The PGE Job has failed 

This condition is indicated when the PGE job only is red in AutoSys. This is hard to do, because 
the AutoSys job definition for this job says to allow any exit code to indicate success. This is 
because we want the next job, the post-execute job, to continue even if this job fails. This job 
will "succeed" even if the PGE Wrapper job, EcDpPrRunPGE, doesn't exist. This job can fail if 
AutoSys cannot see the machine machine. 

26.17.2 The Post-Execute Job has failed 

This condition is indicated when the Post-Execute Job only is red in AutoSys. This happens 
when the PGE job never ran or if for some other reason (such as a mount point problem) the 
Execution Manager job cannot read the log file created by EcDpPrRunPGE. 

Check that /usr/ecs/B302TS1/CUSTOM/bin/DPS/EcDpPrRunPGE and EcDpPrRusage exist 
on the science processor and that they are not links. 

Check that /usr/ecs/DEV04/CUSTOM/data/DPS on the science processor is mounted or linked 
to /usr/ecs/DEV04/CUSTOM/data/DPS on the queuing server machine. 
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26.17.3 The PGE Job and Post-Execute Job have both failed 

This condition is indicated when both the PGE and Post-Execute Jobs are red in AutoSys, but no 
other jobs are red. This indicates that the Post-Execute job has read the log file created by 
EcDpPrRunPGE in the runtime directory and has found an exit status not equal to 0. However, 
it failed to de-stage the failed pge tar file. 

26.17.4 The PGE Job has failed and the DPR has gone into "Failed-PGE" 
processing 

This condition is indicated when the entire job box has turned red along with post-execute, de­
staging and de-allocation jobs. A Failed PGE Tar File has been created and archived. 

A PGE may fail for many reasons. Some of the possible causes are documented here: 

11 The PGE is the wrong architecture. 

This happens when the PGE was miss-defined as New32, Old32 or 64 from the SSIT 
Operational Metadata GUI. The PGE will core dump because of this problem. To fix this you 
need to go back to the SSIT Operational Metadata GUI and enter the correct architecture, then 
delete any DPRs created for that PGE and recreate them. 

• One of the expected inputs for the PGE is missing 

The first reason for this is that an expected input of the PGE is NOT defined in the PGE ODL. 
Check the error messages for something about a missing Logical Id and then check the PGE 
ODL for the expected Logical Id. 

This can also happen when a miscommunication causes Subscription Manager to release a PGE 
despite it missing one (or more inputs). To find out if this is the case, verify that all inputs to the 
DPR have their availability flag set to 1 in PlDataGranuleShort and the corresponding entries in 
PlDprData have the accepted field set to 1. 

• The leapseconds file is incorrect. 

26.17.5 PDPS Troubleshooting - A single DPS job has failed or is hanging 

The entire Job Box is hung 
A DPS Allocation job is hanging


A DPS Allocation job has failed


A DPS Staging job is hanging

A DPS Staging job has failed

A DPS Preprocessing job is hanging

A DPS Preprocessing job has failed

A DPS PGE job is hanging

A DPS PGE job has failed

A DPS Post-processing job has failed

A DPS De-staging job is hanging
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A DPS De-staging job has failed

A DPS De-allocation job has failed

All known problems are corrected and the re-start of the job fails again


Non-PDPS servers are down 
Back to the PDPS Troubleshooting home page 

26.17.5.1 The entire Job Box is Hung 

This condition is determined by noting that the entire Job Box (all 8 job steps) are the same 
color, and it is either the one indicated for "Inactive" jobs or the one for "On Hold" jobs. Check 
the legend to the left on the Jobscape display for the job box color meanings. 

• The AutoSys Event server or one of the AutoSys clients could be down. See 
• Attempt to re-start the Job Box by selecting the top of the Job Box. 

26.17.5.2 A DPS Allocation job is hanging 

This condition is determined by noting that the Allocation job has turned green to indicate that it 
is running, but that it never turns red (failed) or blue (success). If you "tail" the DPR .err file (eg: 
"tail -f /usr/ecs/OPS/CUSTOM/logs/MODPGE08#s28035000OPS.err") you see that nothing 
is happening, or that the job is in a retry loop. 

•	 The Science Data Server (SDSRV) may be waiting for a request to Data Distribution 
(DDIST) to distribute the PGE tar file, but it can't because Storage Management (STMGT) is 
down. Go to where the DDIST GUI is running. Refresh the GUI. Check to see if the 
requestor source is EcDpPrEM and that the state is "Suspended with Errors". If this is the 
case, then you will have to bounce STMGT. After this is done, select the request on the 
DDIST GUI and click on "resume". 

•	 The Science Data Server (SDSRV) may be waiting for a request to Data Distribution 
(DDIST) to distribute the PGE tar file, but it can't because Storage Management can't FTP 
the file to the data directory on the science processor disk. Go to where the DDIST GUI is 
running. Refresh the GUI. Check to see if the requestor source is EcDpPrEM and that the 
state is "Suspended with Errors". Does the target directory exist? Can you FTP a file to the 
directory on the science processor? If the answer to these questions is no, then fix the 
problem, and resume the request. 

•	 If you observe that the Allocation Job is in a retry loop, then the SDSRV may be down. See 
Non-PDPS servers are down. Note that the first retry is designed to fail, because the software 
is retrieving server-side information to refresh the client-side at this point. 

•	 The request may be waiting on the archive to stage the file. If there are several other requests 
in progress, the PGE acquire may have to wait until one or more of them completes. Check 
the state in the DDIST GUI - if it is in "staging" state, then the request should eventually 
complete. 
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26.17.5.3 A DPS Allocation job has failed 
This condition is determined by noting that the Allocation job has turned red. 

• Look at the .ALOG file (in /usr/ecs/{MODE}/CUSTOM/logs). If it is there, then look 
for the following: 

A message of "Error: unable to update Machine in Autosys" means that DPS 
is unable to access the AutoSys database. The auto.profile in 
/usr/ecs/MODE/CUSTOM/bin/DPS has the wrong settings for AUTOSYS 
and AUTOUSER parameters. Although they may differ from DAAC to 
DAAC, the expected values are: 
AUTOSYS = /usr/ecs/MODE/COTS/autotreeb/autosys 

AUTOUSER = /usr/ecs/MODE/COTS/autotreeb/autouser 

•	 To fix the problem, you either need to run the AutoSys Mkcfg again or go into the 
auto.profile file and change the values by hand. 

•	 A message of "Unable to determine type of UR" means that the PGE tar file has not been 
inserted. To verify this is the problem check the PlResourceRequirement table in the 
PDPS database. There should be a non-null entry for the field exeTarUR. If that field is 
null, you need to go back to the SSIT procedure and insert the EXE Tar File. Then you 
should be able to re-start the job and watch it complete successfully. 

If the .ALOG file is NOT present. Then do the following: 

• Bring up the Autosys Ops Console and select the Allocation Job that has failed. 

•	 Check the return code. A value of 122 means that owner of the job DOES NOT HAVE 
WRITE PERMISSION to the log files directory. You need to find out the user account 
that was used to bring up Autosys and verify that it is correct and should have write 
permission to the logs directory. 

26.17.5.4 A DPS Staging job is hanging 

See A DPS Allocation job is hanging 

26.17.5.5 A DPS Staging job has failed 

This condition is determined by noting that the Staging job has turned red. Look at the .ALOG 
file (in /usr/ecs/{MODE}/CUSTOM/logs) for the DPRID of the job that has failed. 

•	 A message of "ESDT Acquire Failed for UR...." means that SDSRV had trouble 
processing one of the acquire requests. In this case re-starting the job should allow the 
acquire to succeed. 

26.17.5.6 A DPS PreProcess job has failed 
This condition is determined by noting that the Pre-Process job has turned red. 

Look at the .ALOG file (in /usr/ecs/{MODE}/CUSTOM/logs) for the DPRID of the job that has 
failed. If it is there, then look for the following: 
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•	 A message of "NOFREECPUS" means that all of the Science Processor CPUs are busy 
and the PreProcess job went through its maximum number of retries to find an available 
CPU. You can just start the job again and it will work its way through its retries until a 
CPU is available. 

Possible reasons for a job to run out of CPU resources: 

•	 PGEs are taking longer to run than expected. DPS plans for execution times specified 
during SSIT, and if those times are exceeded by a large margin (by an executing PGE) it 
is possible that a PGE that is "ready to run" will be CPU starved. 

26.17.5.7 A DPS PGE job is hung 

This condition is determined by noting that the Execution job has turned orange or ossilates 
between orange and green. 

•	 The AutoSys client is most likely down. See Checking the Status of AutoSys for how to 
verify AutoSys is up and happy. 

26.17.5.8 A DPS PGE job has failed 

This condition is determined by noting that the Execution job has turned red or the entire job box 
has turned red (failedPGE scenario). 

See Troubleshooting - The PGE Job has Failed. 

26.17.5.8 A DPS De-staging job has failed 
The destaging job icon on the JobScape GUI will have turned red. Look at the .err log file. 

•	 Typically, you will see a message such as "Error archiving metadata into catalog". You 
may also see some warning messages in the returned GlParameter list. You can disregard 
the warnings. If the problem occurred for an existing ESDT which has previously worked 
within the past day or two, then most likely STMGT is the culprit. Have someone from 
STMGT look at their log files, paying particular attention to changes/defects in their 
stored procedures. 

•	 If you see the "Error archiving metadata into catalog" message and the ESDT is new or 
has recently been installed, then look at the .MCF file in the runtime directory. Get 
somebody from SDSRV to help you compare the values of the mandatory parameters in 
the metadata file with "valids" from the SDSRV database. 

•	 "Error archiving metadata into catalog" may also be associated with a SDSRV temporary 
directory getting filled up. 

A message that indicates "Error archiving files" means that SDSRV is having trouble getting 
Storage Management to place the file(s) in the archive. Contact a Storage Management 
person: 

• to Verify that the Archive (AMASS) is up and functional. 
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• Check through their logs to see why the request for archiving failed. 

It is possible that the mount point between the science processor and the Storage

Management machine has been lost. Check to make sure that the file that is being de-staged

can be seen on the Storage Management machine. The typical path for the mount point is:

Name}

/usr/ecs/{MODE}/CUSTOM/pdps/{science processor name}/data/DpPrRm/{Disk


•	 A message that indicates "Error modifying file usage" means that the numberOfUsage 
column in DpPrFile for a particular file is at 0 and the software is trying to decrement it. 
This column is an increment/decrement counter and is not normally decremented more 
times than it is incremented when under software control. However, if someone manually 
changes the database then the value may get out of sync and need to be manually reset to 
1. 

•	 If you see science data files in the disk partition, but no metadata files, then 
DDIST/STMGT is okay and SDSRV is not okay. Otherwise, suspect STMGT. 

• When the problem is corrected, re-start the job from AutoSys. 

26.17.5.9 All known problems are corrected and the re-start fails again 

The retry information in DpPrRpcID may now be out of sync between one or more servers. Find 
the appropriate entry in the table by inspecting the readableTag column and remove the entry 
before trying to re-start the job again. 

26.17.5.10 Non-PDPS servers are down 
Always verify that the Science Data Server, Storage Management Servers and Data Distribution 
Servers are up. 

1.Bring up ECS ASSIST 
2.Select the correct mode 
3.Click on the "monitor" button 
4.Click on "cdsping all servers" 
5.Observe that the status for the following servers is "Listening": 

EcDmDictServer

EcDpPrDeletion

EcDpPrJobMgmt

EcDsDistributionServer

EcDsScienceDataServer (all instances)

EcDsStArchiveServer

EcDsStFtpDisServer

EcDsStPullMonitorServer

EcDsStStagingDiskServer


26-168 611-CD-510-001




 EcDsStStagingMontitorServer 
EcIoAdServer 
EcPlSubMgr 
EcSbEventServer 
EcSbSubServer 

6.If any of these servers are down, contact the MSS operator to bring them up. 

26.17.6 PDPS Troubleshooting - Job Activation Fails from the Planning 
Workbench 
Error reported is "DPR Validation Failed" 

1.Check to make sure that Performance data has been entered for the PGE 
1.Use the database browser or isql to get access to the PDPS database. 
2.Look at the entries for PlPerformance. 
3.For the PGE(s) that are schedule, verify there is a non-zero value for the entries in this 

table. 

4.If entries are 0, then run the SSIT Operational Metadata GUI to enter correct performance 
values. 

5.Delete the DPRs and then re-create them. Activation will succeed on the next attempt. 

26.17.6.1 PDPS Troubleshooting - Input Data Problems 
General description of the problem: 

• The Production Request fails due to too many granules 

• The Staging Job has failed due to too many granules 

A Failure Due to Too Many Granules 

A failure of this sort is caused by too many granules meeting the criteria for input granules for a 
particular DPR. At PGE registration, the number of granules we expect for each input ESDT is 
defined. We define the minimum number and the maximum number of granules we expect. If the 
number of granules found is not between the minimum and maximum number, the request fails. 
This will fail either during production request time, or when the PCF File is generated (Autosys 
PreProcessing step). 

The Production Request fails due to too many granules 

The Production Request fails. The ALOG displays an error message as follows: 

Msg: PlPge::GetInputForDpr - Extr input to process DPR MoPGE01#2007081600OPS, for data 
type id MOD000#001, with logical id 599001. PlDataTypeReq has a scienceGroup of for this 
datatype. Expected 2 max inputs, but got 3. Priority : 2 

Time : 07/09/99 17:10:52 
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The problem in this case was that the Production Request Editor queried the PDPS database for 
granules that would satisfy the data needs for this DPR and found 3 granules instead of 2 like it 
expected. When we inspected the PDPS database (PlDataGranuleShort) we found only two 
entries that satisfied the data needs for this DPR. After some investigation, the true problem was 
discovered. 

The DPR was for 16:00:00 - 18:00:00. This particular DPR takes in the current input granule 
(16:00:00-18:00:00) and the previous input granule (14:00:00- 16:00:00). When it inspects the 
PDPS Database for data granules, it "pads" the timeframe with a (5A) configurable percentage or 
(4PY) a hardcoded percentage - 50%. This was 4PY, so the PRE added 50% of the granule's 
expected time to each side of the time-range of the granules. This means that the PRE queried the 
PDPS database for granules that had start and stop times within 15:00:00 - 19:00:00. In this case, 
there was an invalid data granule with a start time of 15:30:00 - 15:59:59. This granule was 
found during the query and caused the PRE to find one too many granules and fail the PR. 

The Workaround: 

Delete the offending granule and recreate your production request. 

The Fix: 

For 5A, the padding that is added to each side of the range for the query is configurable. If the 
padding is decreased, these kinds of granules will not be found. In addition, there is a minimum 
size that a granule must be before the Planning system will recognize it as a valid granule. This is 
a percentage, and is hardcoded in 4PY to 20% (or so), but this is configurable in 5A. So in 5A 
we can set this value to 50% which will filter out all granules less than 1 hour long, and we can 
set the padding to 50% which will filter out granules that do not start before 15:00:00. Since our 
granules must be an hour long, and we can assume they do not overlap, we would not get any 
invalid granules such as this one. 

The PreProcessing Job has Failed due to Too Many Granules 

This condition is indicated when the Staging Job is red in AutoSys. This happens due to the same 
condition as noted above with the PRE, but the data granules came in after the Production 
Reqeust was generated. The error message appears in the PGE log files and comlains about not 
being able to generate the PCF file due to too many granules for a particular logical id. 

The Workaround: 

Delete the offending granule and the production request and recreate the production request. 

The Fix: 

See fix for the previous scenario. 

26.17.6.2 PDPS Troubleshooting - Jobs are activated, but do not get started in 
AutoSys 

The Job Management Server is down 
The DPR is waiting in the AutoSys queue (never got released) 
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 Subscription Server Problems

The DPR was released but failed due to a JIL failure

The DPR was released but failed due to a AutoSys ID failure

The DPR was released but failed to be received by Job Management Server


AutoSys is not functional 
AutoSys is full 

The Job Management Server is down 

1.Bring up ECS ASSIST

2.Select the correct mode

3.Select DPS for the subsystem

4.Click on the "monitor" button

5.Observe that the status for the EcDpPrJobMgmt server is "UP"

6.If it is "down", then do steps 7 - 8

7.Click on the "start" button

8.Repeat steps 1-5


The DPR is waiting in the AutoSys queue (never got released) 

The Job Management server may have never received a ReleaseDprJob command from the PLS 
Subscription Manager 

1.Check the database table, DpPrCreationQueue, to see if the job is still waiting to into AutoSys. 
If it's in this table then it probably never got a ReleaseDprJob command get from the PLS 
Subscription Manager, unless AutoSys is full) 

2.Check the Job Management error log file to see if the ReleaseDprJob command was sent 
3.If it was, then there may have been a JIL (AutoSys Job Information Language) processor 

problem -- a JIL FAILURE 
4.If you can't find any evidence that the command was sent to Job Management, then the PLS 

Subscription Manager didn't send the ReleaseDprJob command. It won't send this command if 
it doesn't think all of the DPR's required inputs have been received. Verify this for yourself as 
follows: 

a. For regular DPRs (ie. one without optional inputs), check to see if all of the required 
inputs are present. First look at the PlDprData table and find all of the granule Ids with 
an ioFlag of 0 (an input granule) for this DPR. Then look at the UR column for each 
granule Id in PlDataGranule. If all of the input granules have URs (as opposed to granule 
Ids), then the Subscription Manager should have sent a ReleaseDprJob command to Job 
Management. 

Look at the Subscription Manager log file to verify that it never, in fact, sent the 
ReleaseDprJob command. 

b.While you're looking at the Subscription Manager log file, check to see if it got a 
subscription notification from the 
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Subscription Server for any dynamic data that the DPR needs. If you believe that all of

the necessary input files for

the DPR have been inserted by another DPR, then there may be Subscription Server

Problems

c.If there are no Subscription Server Problems, all of the input granules for the DPR have

URs and/or Subscription Manager received notification for all dynamic granules, then

something may be wrong with the Subscription Manager. Check with somebody in the

PLS subsystem.


The DPR was released but failed due to a JIL failure 
A "JIL Failure" means that the Job Management Server had some problem placing the DPR in 
AutoSys. The Job Interface Language processor rejected the create job command sent to it by the 
Job Management Server. If you look at the completionState column for the DPR in the PDPS 
PlDataProcessingRequest table, you will see "JIL_FAILUR". There are 2 main reasons for this: 

1.There is already a job with an identical name in AutoSys. Check this by going to the Ops 
Console, select View->Select Jobs and type a portion of the job name in the "Job Name" box, 
bracketed by the "*" or "%" wildcard character. If the job is already in AutoSys, it must be 
removed by using the Production Request Editor or by using the Job Management Server 
Client tool (selectable from the Ops Console). Never delete a job from AutoSys using the job 
definition GUI. This will corrupt the PDPS database. 

2. The event processor is down - AutoSys is not functional. 
3. The job had a problem when it was loaded into AutoSys and a malformed or mutant job box is 

the result. This is a job box which will stay dark blue (meaning that it was not activated) and 
will be missing one of the seven job steps. To correct this problem you must do the following: 

•	 Delete the job from AutoSys by hand. To do this select the job from JobScape and right 
click. Select the Job Definition and then select Delete from the pop-up window. In general, it 
is bad practice to delete a job from Autosys using the Job Definition GUI. This can cause 
corruption in the PDPS database. But for this problem there is no other solution. 

•	 Update the completionStatus of the DPR in the PDPS database for which the mutant job box 
was created. Youmust do this via isql and set the completionStatus = NULL (using the isql 
update command). 

•	 Delete the DPR that maps to the job via the Production Request Editor. Note that you do not 
want to delete the entire Production Request, only the DPR that had the mutant Job Box. Any 
DPRs that depend on this DPR will also have to be deleted. 

• Re-create this DPR and any subsequent DPRs via the Production Request Editor. 

The DPR was released but failed due to a AutoSys ID failure 
An "AutoSys ID" failure is indicated if the following messages appear in the Job Management 
ALOG file: 

PID : 7668:MsgLink :0 meaningfulname :DpPrAutosysMapList::GetAutosysIDByDpr 
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 Msg: unable to find autosys id for dpr: ACT#syn1#004130123DEV02 Priority: 2 Tim 
e : 03/09/99 11:33:51 
PID : 7668:MsgLink :9 meaningfulname :CantFindAutoSysId 
Msg: Unable to find autosys id Priority: 2 Time : 03/09/99 11:33:51 
PID : 7668:MsgLink :10 meaningfulname :DpPrSchedulerDObjSmainCreateFailed 
Msg: RqFailed=CreateDpr DprID=ACT#syn1#004130123DEV02 Priority: 2 Time : 03/09/99 
11:33:51 

An "AutoSys ID" Failure means that the Job Management server could not associate the AutoSys 
ID with the DPR that was activated. When the Job Management server is started it reads various 
tables in the PDPS database that provide the linkage between processing resources and AutoSys 
instance. If data is missing from these tables, or was added after the Job Management server was 
started, then the error shown above can occur when any jobs are activated by the Planning 
Workbench. 

The following actions should be taken when an "AutoSys ID" failure error is reported: 

1. Verify that the PlResource table in the PDPS database has at least 1 entry for a processing 
string and at least one entry for an AutoSys Instance. If either of these are missing, then you 
need to re-do Resource Planning and add them via the Resource Editor GUI. 

2.Verify that the PlRscString table in the PDPS database has at least 1 entry and that 
autosysIdKey matches the entry in the PlResource table. Again, if information is missing or 
wrong, you need to re-do Resource Planning. 

3.Verify that the DpPrAutosysMapList table in the PDPS database has at least 1 entry and that 
resourceString and autosysIdKey matches the entry in the PlRscString table. Yet again, if 
information is missing or wrong, you need to re-do Resource Planning. 

4.If Resource Planning has been done after the Job Management server was brought up, then 
bounce the server. Since the server reads this information at start up, any changes since it was 
brought up will NOT have taken affect. 

The DPR was released but failed to be received by Job Management Server 

In this case, the Planning Workbench thinks it successfully activated the DPR(s) but the Job 
Management Server had trouble receiving the notification. 

Look for the following in the EcDpPrJobMgmtDebug.log: 

Failed in CdsEntryRead 

This indicates a problem with the communication and needs to be resolved by RTSC as a 
"problem with DCE". Things that you can do to confirm that this is a DCE problem: 

•	 Run dce-verify on the machine where Job Management and Planning Workbench are 
executed. This should check the DCE communication service and find any errors. 
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•	 Check the Debug logs of other servers. If it is a global DCE problem, there should be errors 
in other server's logs such as "Invalid Bindings". When the above problem happened in the 
Functionality lab, all of the servers had multiple "Invalid Bindings" errors. 

AutoSys is not functional 
1.Set the AutoSys environment variables by sourcing something that looks like 

/data/autotreeb/autouser/AS1.autosys.csh, 
where AS1 is an autosys instance name. 

2.type chk_auto_up and verify that you see the message: "Primary Event Processor is 
RUNNING on machine: 
machine-name" 

3.If you don't see that a Primary Event Processor is running, check with your AutoSys 
administrator. 

Note that if Autosys will not stay up (Autosys administrator brings it up and it goes down 
right away) the following could be occuring: 

•	 It may be possible that too many events were queued up to AutoSys while it was down. If 
Autosys detects a certain number of events in a short time period, it brings itself down. The 
only way to handle this is to keep bringing Autosys back up. Each time it will work through a 
few of the events before it detects "too many" and shuts down. Eventually the events will be 
cleared out and Autosys will stay up. 

•	 It may be the sql server is not up for AutoSys (this may be a different server than the one 
needed for the PDPS database). Look for the following error messages in the AutoSys log or 
when you attempt to bring up JobScape: 

Couldn't create DBPROCES 
Unable to get encoded and plaintext passwords for l0sps03_srvr:FMR 

AutoSys is full 

This is an unlikely problem, and would only occur under the following conditions: 

•	 The number of job boxes in the AutoSys instance > DpPrAutoSysMaxJobs/8. Look in 
EcDpPrJobMgmt.CFG to get this number. 

•	 The DPR completionState in PlDataProcessingRequest is CQ_RELEASE. 
What this means is that the Job Management Server got the command from Subscription 
Manager to release the job, but that no more jobs can fit into AutoSys at present. Wait for a DPR 
to finish, so that the next waiting one can be put into AutoSys. 

26.17.6.3 PDPS Troubleshooting - SDSRV Troubleshooting 
How to examine the SDSRV Database 

1.Log into the Science Data Server (SDSRV) machine 
2.Bring up ECS Assist 
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 3.Select "Subsystem Manager" 
4.Select "ESDT Manager" 
5.Select "DB Viewer" 
6.Click on Login 

7.A list of data types will appear. Click on the data type and information about all granules in 
the archive will be displayed. 

PDPS Troubleshooting - Quick Tips 

Job Management fails with a "JIL FAILURE" in the .ALOG file when trying to cancel a job in 
AutoSys 

Use AutoSys Job Definition to see who owns the job. 
Then select "Adv Features" to see if the user who is trying to delete the job is in the same 
group for "Edit Dfn" as the user who owns the job. 

A quick fix is to give the job world "Edit Dfn", but generally, whoever starts the Job 
Management Server should be in the same group as the person using the tool to cancel the DPR. 

26.18 DPREP 

26.18.1 Introduction 
This section contains information to schedule and run Terra DPREP. 

4	 Terra DPREP is made up of three PGE’s that this document refers to and each are run 
separately. The PGE’s are titled Step1 DPREP, Step 2 DPREPand Step 3 DPREP. 

5	 The input files come from INGEST. These files are depicted in the three step DPREP process 
in Figure 26.18.1-1 

6	 The output files generated from each of the DPREP PGE’s contains Ancillary Attitude, and 
Ephemeris data that becomes new inputs to Instrument PGE’s. These Instrument PGE’s will 
then process its satellite data with similar time span files created by DPREP. 

7	 The DPREP registration process for each of the three PGE’s creates in the Science Data 
Server Archive a subscription for each of the DPREP PGE’s. PGE execution then takes place 
in the PDPS. 

8	 The SSI&T effort for DPREP PGE’s is similar in effort to what would be required to register 
any other PGE. 

26.18.2 SSI&T Activity for DPREP 

The Level Zero datasets are received in 2 hour chunks. The file processes in Figure 26.18.1-1 
depicts the minimal time span allowable for a DPREP run. In a normal operation of DPREP, a 
twenty four hour time span would be prepared for. This would require additional 2 hour chunks 
and thus additional files of data would need to be registered. Before the registration process can 
take place a number of files will have to be updated to process a block of data for a particular 
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time period.  
the SSI&T process will require annotation.

The sections that follow have been highlighted with notations as to what SSI&T process applies
in the preparation of each template and the function required to register each section. With a
particular function identified, other portions of this manual can be referred to for more detailed
precedures to be used to carry out the full SSI&T process.

Whenever new input files are introduced or updated executables are re-introduced it is wise to
set up the PGE to run from  
will run error free.  
SSI&T effort to run from the PDPS.  
in the Science Data Server.  
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Figure 26.18.1-1.  

Therefore, DPREP input files will have to be identified and various templates for

the Command Line. This will determine if what has been introduced
After a successful Command Line run it is advisable then to complete the

the PCF to run fromCommand Line Runs include the use  
PDPS runs include ESDT’s and ODL files to generate internal

DPREP File Processes



26.18.3 DPREP Processes and Procedures 
Processes and procedures are provided in the following files on an SGI machine used to support 
SSI&T: 

DPREP README and HowToRunDPREP files located at 
:/usr/ecs/OPS/CUSTOM/data/DPS/ 

DPREP binary located: :/usr/ecs/OPS/CUSTOM/bin/DPS/ 
The following files are taken from an SSI&T SGI machine using the /data/DPS/ thread for 
referencing DPREP files in this section. 
: 

p0spg01:/usr/ecs/OPS/CUSTOM/data/DPS[45] > ls -lrt 

total 10080


-rwxr-xr-x 1 cmops cmops 15390 Dec 15 04:02 PGS_101


-rwxr-xr-x 1 cmops cmops 16315 Dec 15 04:02 HowToRunDPREP


-rwxr-xr-x 1 cmops cmops 3371 Dec 15 04:02 HowToCreateDprepTarFile


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_1.A


-rwxr-xr-x 1 cmops cmops 450048 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_1.B


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_1.A


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_2


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_1.B


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_3


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_2


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_4
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-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_3


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_4


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_3


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_2


-rwxr-xr-x 1 cmops cmops 225280 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_1.B


-rwxr-xp0spg01:/usr/ecs/OPS/CUSTOM/data/DPS[45] > ls -lrt


total 10080


-rwxr-xr-x 1 cmops cmops 15390 Dec 15 04:02 PGS_101


-rwxr-xr-x 1 cmops cmops 16315 Dec 15 04:02 HowToRunDPREP


-rwxr-xr-x 1 cmops cmops 3371 Dec 15 04:02 HowToCreateDprepTarFile


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_1.A


-rwxr-xr-x 1 cmops cmops 450048 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_1.B


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_1.A


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_2


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_1.B


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_3
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-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_2


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_4


-rwxr-xr-x 1 cmops cmops 384 Dec 15 04:02


EDOS_LEVEL_ZERO_00.Profile_3


-rwxr-xr-x 1 cmops cmops 449984 Dec 15 04:02


EDOS_LEVEL_ZERO_01.Profile_4


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_3


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_2


-rwxr-xr-x 1 cmops cmops 225280 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_1.B


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_1.A


-rwxr-xr-x 1 cmops cmops 411600 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_2


-rwxr-xr-x 1 cmops cmops 411600 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_1


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_4


-rwxr-xr-x 1 cmops cmops 411600 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_3


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_4.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_3.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_2.met
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-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_1.B.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_1.A.met


-rwxr-xr-x 1 cmops cmops 1679 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_4.met


r-x 1 cmops cmops 225248 Dec 15 04:02


AM1_DEFINITIVE_ATT.fdd.Profile_1.A


-rwxr-xr-x 1 cmops cmops 411600 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_2


-rwxr-xr-x 1 cmops cmops 411600 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_1


-rwxr-xr-x 1 cmops cmops 225248 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_4


-rwxr-xr-x 1 cmops cmops 411600 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_3


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_4.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_3.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_2.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_1.B.met


-rwxr-xr-x 1 cmops cmops 1655 Dec 15 04:03 AM1ANC.Profile_1.A.met


-rwxr-xr-x 1 cmops cmops 1679 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_4.met


-rwxr-xr-x 1 cmops cmops 1679 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_3.met


-rwxr-xr-x 1 cmops cmops 1679 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_2.met


-rwxr-xr-x 1 cmops cmops 1679 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_1.B.met
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-rwxr-xr-x 1 cmops cmops 1679 Dec 15 04:03


AM1_DEFINITIVE_ATT.fdd.Profile_1.A.met


-rwxr-xr-x 1 cmops cmops 5909 Dec 15 04:03 ReplaceEphemeris.tar.met


-rwxr-xr-x 1 cmops cmops 5909 Dec 15 04:03 FDDAttitude.tar.met


-rwxr-xr-x 1 cmops cmops 29206 Dec 15 04:03


EcDpPrAm1EdosEphAttDPREP_PGE.Steps1ab.PCF.Profile_3


-rwxr-xr-x 1 cmops cmops 29299 Dec 15 04:03


EcDpPrAm1EdosEphAttDPREP_PGE.Steps1ab.PCF.Profile_2


-rwxr-xr-x 1 cmops cmops 29818 Dec 15 04:03


EcDpPrAm1EdosEphAttDPREP_PGE.Steps1ab.PCF.Profile_1.B


-rwxr-xr-x 1 cmops cmops 29818 Dec 15 04:03


EcDpPrAm1EdosEphAttDPREP_PGE.Steps1ab.PCF.Profile_1.A


-rwxr-xr-x 1 cmops cmops 1663 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_3.met


-rwxr-xr-x 1 cmops cmops 1663 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_2.met


-rwxr-xr-x 1 cmops cmops 1663 Dec 15 04:03


AM1_REPAIR_EPH.fdd.Profile_1.met


-rwxr-xr-x 1 cmops cmops 5909 Dec 15 04:03


AM1_Ancillary_DPREP.tar.met


-rwxr-xr-x 1 cmops cmops 27664 Dec 15 04:03


EcDpPrAm1FddEphemerisDPREP_PGE.Step3.PCF.Profile_2


-rwxr-xr-x 1 cmops cmops 27944 Dec 15 04:03


EcDpPrAm1FddEphemerisDPREP_PGE.Step3.PCF.Profile_1


-rwxr-xr-x 1 cmops cmops 26902 Dec 15 04:03


EcDpPrAm1FddAttitudeDPREP_PGE.Step2.PCF.Profile_4


-rwxr-xr-x 1 cmops cmops 27257 Dec 15 04:03
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EcDpPrAm1FddAttitudeDPREP_PGE.Step2.PCF.Profile_3


-rwxr-xr-x 1 cmops cmops 27184 Dec 15 04:03


EcDpPrAm1FddAttitudeDPREP_PGE.Step2.PCF.Profile_2


-rwxr-xr-x 1 cmops cmops 27543 Dec 15 04:03


EcDpPrAm1FddAttitudeDPREP_PGE.Step2.PCF.Profile_1.B


-rwxr-xr-x 1 cmops cmops 27543 Dec 15 04:03


EcDpPrAm1FddAttitudeDPREP_PGE.Step2.PCF.Profile_1.A


-rwxr-xr-x 1 cmops cmops 28695 Dec 15 04:03


EcDpPrAm1EdosEphAttDPREP_PGE.Steps1ab.PCF.Profile_4


-rwxr-xr-x 1 cmops cmops 26584 Dec 15 04:03


EcDpPrAm1FddEphemerisDPREP_PGE.Step3.PCF.Profile_3


-rwxr-xr-x 1 cmops cmops 5617 Dec 15 04:03 DPREP_README


-rw-rw-r-- 1 cmshared cmshared 433 Dec 15 15:35 ODL


p0spg01:/usr/ecs/OPS/CUSTOM/data/DPS[46] >


data3/ecs/OPS/CUSTOM/data/DPS


26.18.3.1 DPREP consists of three PGE’s each run separately.

1 The first step is a ksh script called EcDpPrAm1EdosEphAttDPREP_PGE, which serves


as a driver for three executables: 
EcDpPrAm1EdosAncillary 
EcDpPrAm1EdosEphemerisRepair 
EcDpPrAm1ToolkitHdf 

2 The second step is EcDpPrAm1FddAttitudeDPREP_PGE. 
3 The third step is EcDpPrAm1FddEphemerisDPREP_PGE. 

STEP ONE

EcDpPrAm1EdosAncillary reads in AM-1 L0 (EDOS) Ancillary Dataset (logical id 1000,

ESDT AM1ANC). It also reads another set of AM-1 L0 (EDOS) Ancillary Dataset (logical id

1010, ESDT AM1ANC). The second set of L0 data is required to insure that incomplete orbits in

the first data set get complete orbit metadata records. The only data that will be extracted from

the second data set is the descending node time and longitude.

EcDpPrAm1EdosAncillary also reads in ephemeris and attitude data (toolkit native format)

under logical ids 1700 (ESDT AM1EPHN0) and 1800 (ESDT AM1ATTN0). These would be the

last ephemeris/attitude data sets generated from a previous run of this PGE.
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EcDpPrAm1EdosEphemerisRepair 
If EcDpPrAm1EdosAncillary signals a short gap was detected then 
EcDpPrAm1EdosEphemerisRepair reads the scratchfile created by EcDpPrAm1EdosAncillary 
and performs the gap fill and writes a gap filled native format ephemeris file. If no short gap is 
signaled then the scratch file is simply renamed to the native format ephemeris file. 

EcDpPrAm1ToolkitHdf 
This process takes the native format ephemeris file and produces a corresponding HDF file and a

metadata file.

This PGE produces Toolkit and HDF format attitude and ephemeris data sets. The attitude data

sets are produced using logical ids 1001 (ESDT AM1ATTN0) and 1100 (ESDT AM1ATTH0).

The ephemeris data sets are produced using logical ids 1101 (ESDT AM1EPHN0) and 1102

(ESDT AM1EPHH0). The corresponding MCFs are accessed using logical ids 1400 (ESDT

AM1EPHH0), 1401 (ESDT AM1ATTH0), 1402 (ESDT AM1EPHN0) and 1403 (ESDT

AM1ATTN0).

The PGE produces an ASCII report file under logical id 2000

EcDpPrAm1EdosEphAttDPREP_PGE. Steps1ab.PCF.curr is a sample pcf used by this PGE.

This pcf has directory locations and file names which may not be valid in all environments. Be

careful before directly using this pcf. A sample set of input files for this PGE are

1000 EDOS_LEVEL_ZERO_00.curr

1000 EDOS_LEVEL_ZERO_01.curr

1010 EDOS_LEVEL_ZERO_00.next

1010 EDOS_LEVEL_ZERO_01.next

and a copy of each of these files is provided. The files in this group do contain small data gaps

which will cause EcDpPrAm1EdosEphemerisRepair to be run.

The remaining pcfs for Step 1 DPREP:

EcDpPrAm1EdosEphAttDPREP_PGE.Steps1ab.PCF.next 
EcDpPrAm1EdosEphAttDPREP.Steps1ab.PCF.next_1 
will move through the sequence of the Level Zero files provided.

example; EDOS_LEVEL_ZERO_00.next is treated as current and

EDOS_LEVEL_ZERO_00.next_1 is treated as next etc...

These pcfs can be utilized at the testers discretion and are not necessary for the running of steps 2

and 3. The input files indicated in EcDpPrAm1EdosEphAttDPREP.Steps1ab.PCF.next_1 contain

no gaps so testers shouldn't be concerned that EcDpPrAm1EdosEphemerisRepair is not invoked

when using this pcf.

Note:

The Level Zero datasets are received in 2 hour chunks but processing can't be performed on the

most recently available 2 hour chunk. Step 1 processing needs to look forward in the time stream

in order to complete orbit metadata processing.


STEP TWO

EcDpPrAm1FddAttitudeDPREP_PGE reads in the current FDD Attitude Dataset under

logical ID 1000 and the next FDD Attitude Dataset under logical ID 1010. It also reads in the

attitude data set it produced with it's last run under logical ID 1502. The output of this process is

a native format attitude file (logical ID 1001) and an HDF format attitude file (logical ID 1100).

A .met file is also produced for each.
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EcDpPrAm1FddAttitudeDPREP_PGE.Step2.PCF.curr is a sample pcf used by this PGE. This

pcf has directory locations and file names which may not be valid in all environments. Be careful

before directly using this pcf. A sample set of input files for this PGE are

1000 AM1_DEFINITIVE_ATT.fdd.curr

1010 AM1_DEFINITIVE_ATT.fdd.next

(IMPORTANT: These files contain incorrect data and were delivered only as a placeholder.

EcDpPrAm1FddAttitudeDPREP_PGE will not run with these files as input. When valid FDD

Definitive Attitude files become available they should be moved to these filenames and

EcDpPrAm1FddAttitudeDPREP_PGE should run successfully. )

and a copy of each of these files is provided.


Note: Step 2 processing must follow 2 hours behind step 1 processing.


STEP THREE 
If step1 finds too many missing data points in the ephemeris data it signals that a definitve

ephemeris file is needed from FDD which EcDpPrAm1FddEphemerisDPREP_PGE will use to

replace the ephemeris dataset that was generated from the Level Zero data.

EcDpPrAm1FddEphemerisDPREP_PGE reads in the definitive Ephemeris dataset received

from FDD (logical ID 1000) and the EOS_AM1 Ephemeris data (logical id 1001) in toolkit

native format.

It produces Replacement ephemeris datasets (logical id 1101, ESDT AM1EPHH0) and (logical

id 1100, ESDT AM1EPHN0). The corresponding MCFs are accessed using logical ids 1400

(ESDT AM1EPHH0) & 1402 (ESDT AM1EPHN0)


EcDpPrAm1FddEphemerisDPREP_PGE.Step3.PCF.curr is a sample pcf used by this PGE.

This pcf has directory locations and file names which may not be valid in all environments. Be

careful before directly using this pcf. A sample FDD input file for this PGE is

1000 AM1_REPAIR_EPH.fdd

and a copy of this file is provided.

Toolkit Initialization Settings

SGI Application Binary Interface New 32

Disk Space Used for PGE Run 50.000 MB

Shared Memory ON

Use Test Files if SM Fails ON

Use Log Files ON

Continue if Logging Fails OFF


26.18.4 Creating DPREP Tar Files 
If tar files are not available for registering the three AM-1 DPREP PGEs, 

Follow the instructions found in the HowToCreateDprepTarFiles file to generate the 

necessary tar files. 

26.18.4.1 HowToCreateDprepTarFiles 
p0spg01:/usr/ecs/OPS/CUSTOM/data/DPS[46] > more HowToCreateDprepTarFile 
This file provides information to create the DPREP pge tar files 
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Objective : To create AM1_Ancillary_DPREP.tar & FddAttitude.tar 
and using SSIT Manager archive the PGE tar files 

Files needed : 
PGS_101 
EcDpPrAm1EdosEphAttDPREP_PGE 
EcDpPrAm1EdosAncillary 
EcDpPrAm1EdosEphemerisRepair 
EcDpPrAm1ToolkitToHdf 
EcDpPrAm1FddAttitudeDPREP_PGE 
EcDpPrAm1FddEphemerisDPREP_PGE 

Steps to create AM1_Ancillary_DPREP.tar 

1. Login to the science processing machine (SGI) 
2. Check to make sure that the executables 

EcDpPrAm1EdosEphAttDPREP_PGE 
EcDpPrAm1EdosAncillary 
EcDpPrAm1EdosEphemerisRepair 
EcDpPrAm1ToolkitToHdf 
are delivered and reside in $ECS_HOME/<MODE>/CUSTOM/bin/DPS 

3. Check to make sure that the data file PGS_101 is delivered and 
resides in $ECS_HOME/<MODE>/CUSTOM/data/DPS 

4. cd to $ECS_HOME/<MODE>/CUSTOM/data/DPS 
5. /bin/tar cvf AM1_Ancillary_DPREP.tar PGS_101 -C 
$ECS_HOME/<MODE>/CUSTOM/bin/DPS EcDpPrAm1EdosAncillary 

EcDpPrAm1EdosEphAttDPREP_PGE 
EcDpPrAm1EdosEphemerisRepair EcDpPrAm1ToolkitToHdf 

Step 5 will create the AM1_Ancillary_DPREP.tar file in 
$ECS_HOME/<MODE>/CUSTOM/data/DPS 
This file then needs to be ftped to the SSIT machine from where it

will be archived

The corresponding met file for this tar file is AM1_Ancillary_DPREP.tar.met

and is delivered to $ECS_HOME/<MODE>/CUSTOM/data/DPS

This file then needs to be ftped to the SSIT machine from where it

(and the tar file itself) will be archived


Steps to create FddAttitude.tar 

1. Login to the science processing machine (SGI) 
2. Check to make sure that the executable EcDpPrAm1FddAttitudeDPREP_PGE 

is delivered and resides in $ECS_HOME/<MODE>/CUSTOM/bin/DPS 
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3. Check to make sure that the data file PGS_101 is delivered and 
resides in $ECS_HOME/<MODE>/CUSTOM/data/DPS 

4. cd to $ECS_HOME/<MODE>/CUSTOM/data/DPS 

5. /bin/tar cvf FDDAttitude.tar PGS_101 -C $ECS_HOME/<MODE>/CUSTOM/bin/DPS 
EcDpPrAm1FddAttitudeDPREP_PGE 

Step 5 will create the FDDAttitude.tar file in 
$ECS_HOME/<MODE>/CUSTOM/data/DPS 
This file then needs to be ftped to the SSIT machine from where it

will be archived

The corresponding met file for this tar file is FDDAttitude.tar.met and

is delivered to $ECS_HOME/<MODE>/CUSTOM/data/DPS

This file then needs to be ftped to the SSIT machine from where it

(and the corresponding tar file) will be archived.


Steps to create ReplaceEphemeris.tar 

1. Login to the science processing machine (SGI) 
2. Check to make sure that the executable EcDpPrAm1FddEphemerisDPREP_PGE 

is delivered and resides in $ECS_HOME/<MODE>/CUSTOM/bin/DPS 
3. Check to make sure that the data file PGS_101 is delivered and 

resides in $ECS_HOME/<MODE>/CUSTOM/data/DPS 
4. cd to $ECS_HOME/<MODE>/CUSTOM/data/DPS 
5. /bin/tar cvf ReplaceEphemeris.tar PGS_101 -C 

$ECS_HOME/<MODE>/CUSTOM/bin/DPS 
EcDpPrAm1FddEphemerisDPREP_PGE 

Step 5 will create the ReplaceEphemeris.tar file in 
$ECS_HOME/<MODE>/CUSTOM/data/DPS 
This file then needs to be ftped to the SSIT machine from where it 
will be archived 

The corresponding met file for this tar file is ReplaceEphemeris.tar.met and 
is delivered to $ECS_HOME/<MODE>/CUSTOM/data/DPS 
This file then needs to be ftped to the SSIT machine from where it 
(and the corresponding tar file) will be archived. 

26.18.4.2 HowToRunDPREP 
p0spg01:/usr/ecs/OPS/CUSTOM/data/DPS[48] > more HowToRunDPREP 
This document contains information on how to schedule and run AM-1 DPREP 
AM-1 DPREP is made up of 3 PGEs that this document refers to as Step 1 DPREP, 
Step 2 DPREP, and Step 3 DPREP: 

Step 1 DPREP is the EDOS-supplied ephemeris and attitude preprocessor. 
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 Step 2 DPREP is the FDD-supplied attitude preprocessor.

Step 3 DPREP is the FDD-supplied ephemeris preprocessor.


Operationally, Steps 1 and 2 are scheduled daily and run independently of one

another. Step 3 is scheduled and run on an as-needed basis.

In order to run, DPREP processing expects data to be available not only from

the current segment, but also from the preceding and following segments as

well. Data from the preceding and following segments are used to consistency

check ephemeris and attitude data streams when the data streams bridge segment

boundaries. The availability of data from the preceding and following segments

is not guaranteed, however. Four data processing profiles have been developed

to handle the various permutations of preceding and following data segments

that could be available to DPREP:


Profile 1 expects data from the preceding, current, and following segments.

Profile 2 expects data from the current and following segments only.

Profile 3 expects data from the preceding and current segments only.

Profile 4 expects data from the current segment only.


These profiles are recognized by all DPREP Steps. The ESDT that is provided to

DPREP from the preceding, current, and following data segments depends on the

Step being run, however.


Profile 2 (no preceding data, but following data is available) initializes

DPREP's processing of a given Step's ephemeris and/or attitude data stream.

Once Profile 2 has been run on a data segment, Profile 1 (preceding and

following data available) assumes processing responsibility on all data

segments thereafter until data dropout or mission end is encountered.  Profile

3 (preceding data available, but no following data) then processes data

segment that immediately precedes data dropout and, therefore, terminates

processing on a given Step's ephemeris and/or attitude data stream.


In the big picture then, DPREP processing requires a single Profile 2

to run on the first data segment, is followed by an indeterminant number of

Profile 1 processes, and is terminated by a single Profile 3 process.


Profile 4 processes isolated data segments and is not likely to be scheduled

operationally.


More information on the AM-1 DPREP can be found in document "TERRA Spacecraft 
Ephemeris and Attitude Data Preprocessing" (document number 184-TP-001-001). 

Note: Each PGE will use both the Science Metadata update tool and the Operational 
Metadata Update tool, which are located in the SSIT Manager, to incorporate the specific 
parameters listed in each of the direction sections below. 
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26.18.4.3 Registering DPREP PGEs 
So that the following tests can be conducted, all four Profiles must be 
registered for all three DPREP Steps. Each DPREP PGE is registered once. 

Step 1 DPREP Test Instructions 

For Step 1, current and following granules are EDOS-supplied L0 Ancillary (APID

4, ShortName AM1ANC), the preceding granule is the output Toolkit format

ephemeris and attitude products produced by the preceding run of Step 1

(ShortNames AM1EPHN0, AM1ATTN0). DPREP expects both the L0 Ancillary header

granule and the data granule (hence, 2 granules) for the current and following

L0 Ancillary. Step 1 requires 2 preceding data sets, one ephemeris product and

one attitude product from the preceding Step 1 run (two granules, one for

ephemeris and one for attitude).


Step 1 DPREP Specifications 
Tar File Name : $ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_Ancillary_DPREP.tar 
Contents : EcDpPrAm1EdosEphAttDPREP_PGE 

EcDpPrAm1EdosAncillary 
EcDpPrAm1EdosEphemerisRepair 
EcDpPrAm1ToolkitToHdf 
PGS_101 

PGE Met File : 
$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_Ancillary_DPREP.tar.met 

Top Level Exe : EcDpPrAm1EdosEphAttDPREP_PGE 

PGE Name : AM1Eph 
Version Number : 20202 

Profile 1 ODL : PGE_AM1Eph#2020101.odl 
Profile 2 ODL : PGE_AM1Eph#2020102.odl 
Profile 3 ODL : PGE_AM1Eph#2020103.odl 
Profile 4 ODL : PGE_AM1Eph#2020104.odl 

Test Scenario 
The Step 1 DPREP test is divided into two parts. The first part exercises 
Profiles 1, 2, and 3 over four consecutive data segments. The first data 
segment is scheduled for Profile 2 processing, the next two segments are 
scheduled for Profile 1 processing, and the last scheduled for Profile 3 
processing. The data segments to be processed follow. 
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 Segment 1: 1997 July 31 04:00:00 to 1997 July 31 06:00:00 (Profile 2) 
Segment 2: 1997 July 31 06:00:00 to 1997 July 31 08:00:00 (Profile 1) 
Segment 3: 1997 July 31 08:00:00 to 1997 July 31 10:00:00 (Profile 1) 
Segment 4: 1997 July 31 10:00:00 to 1997 July 31 12:00:00 (Profile 3) 

The second Step 1 DPREP test exercises Profile 4 on an isolated data segment. 

Segment 5: 1997 July 31 18:00:00 to 1997 July 31 20:00:00 (Profile 4) 

There is one dynamic granule (2 files for each granule) for each of the 
data segments described above. Insert all five dynamic granules into the 
archive using the SSIT Manager's insert dynamic data tool. 

Segment 1: 

ESDT Short Name : AM1ANC

File Names : EDOS_LEVEL_ZERO_00.Profile_2


EDOS_LEVEL_ZERO_01.Profile_2 
Met file : AM1ANC.Profile_2.met 
Time Range : 1997 July 31 04:00:00 to 1997 July 31 06:00:00 

Segment 2: 

ESDT Short Name : AM1ANC

File Names : EDOS_LEVEL_ZERO_00.Profile_1.A


EDOS_LEVEL_ZERO_01.Profile_1.A 
Met file : AM1ANC.Profile_1.A.met 
Time Range : 1997 July 31 06:00:00 to 1997 July 31 08:00:00 

Segment 3: 
ESDT Short Name : AM1ANC 

File Names : EDOS_LEVEL_ZERO_00.Profile_1.B 
EDOS_LEVEL_ZERO_01.Profile_1.B 

Met file : AM1ANC.Profile_1.B.met 
Time Range : 1997 July 31 08:00:00 to 1997 July 31 10:00:00 

Segment 4: 
ESDT Short Name : AM1ANC 
File Names : EDOS_LEVEL_ZERO_00.Profile_3 

EDOS_LEVEL_ZERO_01.Profile_3 
Met file : AM1ANC.Profile_3.met 
Time Range : 1997 July 31 10:00:00 to 1997 July 31 12:00:00 

Segment 5: 
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 ESDT Short Name : AM1ANC

File Names : EDOS_LEVEL_ZERO_00.Profile_4


EDOS_LEVEL_ZERO_01.Profile_4 
Met file : AM1ANC.Profile_4.met 
Time Range : 1997 July 31 18:00:00 to 1997 July 31 20:00:00 

Create three production requests for the following time ranges. The number of 
DPRs that should be created are given below. 

Request Timespan Profile DPRs 
1 1997 July 31 04:00:00 to 06:00:00 2 1 
2 1997 July 31 06:00:00 to 10:00:00 1 2 
3 1997 July 31 10:00:00 to 12:00:00 3 1 

Schedule all three production requests to run as a single production plan. This 
completes the first part of the Step 1 DPREP test. 

Next, create one production request that for the time range that follow. 

Request Timespan Profile DPRs 
1 1997 July 31 18:00:00 to 20:00:00 4 1 

Schedule this a seperate production plan. This completes the second part of the 
Step 1 DPREP test. 

Results 
Find output granules for each of the timespans described above for ESDTs

AM1EPHN0, AM1EPHH0, AM1ATTN0, and AM1ATTH0. ESDT AM1EPHN0 is the Toolkit

format ephemeris granule, while ESDT AM1EPHH0 is the HDF format ephemeris

granule. ESDT AM1ATTN0 is the Toolkit format attitude granule, while ESDT

AM1ATTH0 is the HDF format attitude granule.


Step 2 DPREP Test Instructions 

For Step 2, current and following granules are FDD-supplied attitude (ShortName 
AM1ATTF), the preceding granule is the output Toolkit format attitude product 
produced by the preceding run of Step 2 (ShortName AM1ATTNF). 

Step 2 DPREP Specifications 

Tar File Name : $ECS_HOME/<MODE>/CUSTOM/data/DPS/FDDAttitude.tar 
Contents : EcDpPrAm1FddAttitudeDPREP_PGE 

PGS_101 
PGE Met File : $ECS_HOME/<MODE>/CUSTOM/data/DPS/FDDAttitude.tar.met 
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Top Level Exe : EcDpPrAm1FddAttitudeDPREP_PGE 

PGE Name : FddAtt 
Version Number : 20201 

Profile 1 ODL : PGE_FddAtt#2020101.odl 
Profile 2 ODL : PGE_FddAtt#2020102.odl 
Profile 3 ODL : PGE_FddAtt#2020103.odl 
Profile 4 ODL : PGE_FddAtt#2020104.odl 

Test Scenario 

The Step 2 DPREP test, like the Step 1 test scenario, is divided into two 
parts. The first part exercises Profiles 1, 2, and 3 over four consecutive 
data segments. The first data segment is scheduled for Profile 2 processing, 
the next two segments are scheduled for Profile 1 processing, and the last 
scheduled for Profile 3 processing. The data segments to be processed follow. 

Segment 1: 1997 July 31 04:00:00 to 1997 July 31 06:00:00 (Profile 2) 
Segment 2: 1997 July 31 06:00:00 to 1997 July 31 08:00:00 (Profile 1) 

Segment 3: 1997 July 31 08:00:00 to 1997 July 31 10:00:00 (Profile 1) 
Segment 4: 1997 July 31 10:00:00 to 1997 July 31 12:00:00 (Profile 3) 

The second Step 2 DPREP test exercises Profile 4 on an isolated data segment. 

Segment 5: 1997 July 31 18:00:00 to 1997 July 31 20:00:00 (Profile 4) 

There is one granule for each of the data segments described above. Insert all 
five granules into the archive using the SSIT Manager's insert dynamic data 
tool. 

Segment 1:


ESDT Short Name : AM1ATTF

File Names : AM1_DEFINITIVE_ATT.fdd.Profile_2

Met file : AM1_DEFINITIVE_ATT.fdd.Profile_2.met

Time Range : 1997 July 31 04:00:00 to 1997 July 31 06:00:00


Segment 2:


ESDT Short Name : AM1ATTF

File Names : AM1_DEFINITIVE_ATT.fdd.Profile_1.A

Met file : AM1_DEFINITIVE_ATT.fdd.Profile_1.A.met
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 Time Range : 1997 July 31 06:00:00 to 1997 July 31 08:00:00 

Segment 3: 

ESDT Short Name : AM1ATTF

File Names : AM1_DEFINITIVE_ATT.fdd.Profile_1.B

Met file : AM1_DEFINITIVE_ATT.fdd.Profile_1.B.met

Time Range : 1997 July 31 08:00:00 to 1997 July 31 10:00:00


Segment 4:

ESDT Short Name : AM1ATTF

File Names : AM1_DEFINITIVE_ATT.fdd.Profile_3

Met file : AM1_DEFINITIVE_ATT.fdd.Profile_3.met

Time Range : 1997 July 31 10:00:00 to 1997 July 31 12:00:00


Segment 5:

ESDT Short Name : AM1ATTF

File Names : AM1_DEFINITIVE_ATT.fdd.Profile_4

Met file : AM1_DEFINITIVE_ATT.fdd.Profile_4.met

Time Range : 1997 July 31 18:00:00 to 1997 July 31 20:00:00


Create three production requests for the following time ranges. The number of 
DPRs that should be created are given below. 

Request Timespan Profile DPRs 
1 1997 July 31 04:00:00 to 06:00:00 2 1 
2 1997 July 31 06:00:00 to 10:00:00 1 2 
3 1997 July 31 10:00:00 to 12:00:00 3 1 

Schedule all three production requests to run as a single production plan. This 
completes the first part of the Step 2 DPREP test. 

Next, create one production request that for the time range that follow. 

Request Timespan Profile DPRs 
1997 July 31 18:00:00 to 20:00:00 4 1 

Schedule this a seperate production plan. This completes the second part of the 
Step 2 DPREP test. 

These plans can be scheduled and run completely independently of the Step 1 
DPREP plans described earlier. 
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Results 
Find output granules for each of the timespans described above for ESDTs

AM1ATTNF and AM1ATTHF. ESDT AM1ATTNF is the Toolkit format attitude granule,

while ESDT AM1ATTHF is the HDF format attitude granule.


Step 3 DPREP Test Instructions 

For Step 3, the current granule is FDD-supplied ephemeris (ShortName AM1EPHF),

the preceding granule is the output Toolkit format ephemeris product produced

by preceding run of Step 1, and the following granule is EDOS-supplied L0

Ancillary (ShortName AM1ANC).


Step 3 DPREP Specifications

Tar File Name : $ECS_HOME/<MODE>/CUSTOM/data/DPS/ReplaceEphemeris.tar

Contents : EcDpPrAm1FddAttitudeDPREP_PGE


PGS_101 
PGE Met File : $ECS_HOME/<MODE>/CUSTOM/data/DPS/ReplaceEphemeris.tar.met 

Top Level Exe : EcDpPrAm1FddEphemerisDPREP_PGE 

PGE Name : RepEph 
Version Number : 20201 

Profile 1 ODL : PGE_RepEph#2020101.odl 
Profile 2 ODL : PGE_RepEph#2020102.odl 
Profile 3 ODL : PGE_RepEph#2020103.odl 
Profile 4 ODL : PGE_RepEph#2020104.odl 

Test Scenario 

Operationally, Step 3 AM-1 DPREP will most likely be scheduled to run on 
single data segments. Hence, the Step 3 test scenario consists of scheduling 
and running four plans that exercise the four Profiles individually on a single 
data segments. The data segments to be processed follow. 

Segment 1: 1997 July 31 04:00:00 to 1997 July 31 06:00:00 (Profile 2) 
Segment 2: 1997 July 31 08:00:00 to 1997 July 31 10:00:00 (Profile 1) 
Segment 3: 1997 July 31 10:00:00 to 1997 July 31 12:00:00 (Profile 3) 
Segment 4: 1997 July 31 18:00:00 to 1997 July 31 20:00:00 (Profile 4) 

There is one granule for each of the data segments described above. Insert all 
four granules into the archive using the SSIT Manager's insert dynamic data 
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tool. 

Segment 1: 

ESDT Short Name : AM1EPHF

File Names : AM1_REPAIR_EPH.fdd.Profile_2

Met file : AM1_REPAIR_EPH.fdd.Profile_2.met

Time Range : 1997 July 31 04:00:00 to 1997 July 31 06:00:00


Segment 2: 
ESDT Short Name : AM1EPHF 

File Names : AM1_REPAIR_EPH.fdd.Profile_1 
Met file : AM1_REPAIR_EPH.fdd.Profile_1.met 
Time Range : 1997 July 31 08:00:00 to 1997 July 31 10:00:00 

Segment 3: 
ESDT Short Name : AM1EPHF 
File Names : AM1_REPAIR_EPH.fdd.Profile_3 
Met file : AM1_REPAIR_EPH.fdd.Profile_3.met 
Time Range : 1997 July 31 10:00:00 to 1997 July 31 12:00:00 

Segment 4: 
ESDT Short Name : AM1EPHF 
File Names : AM1_REPAIR_EPH.fdd.Profile_4 
Met file : AM1_REPAIR_EPH.fdd.Profile_4.met 
Time Range : 1997 July 31 18:00:00 to 1997 July 31 20:00:00 

Create four individual production plans consisting of a single DPR for each of 
the time ranges that follow. Schedule and allow a given plan to complete before 
scheduling the next. 

Request Timespan Profile DPRs 
1 1997 July 31 04:00:00 to 06:00:00 2 1 
2 1997 July 31 06:00:00 to 10:00:00 1 1 
3 1997 July 31 10:00:00 to 12:00:00 3 1 
4 1997 July 31 18:00:00 to 20:00:00 4 1 

These plans can be scheduled and run only after the Step 1 AM-1 DPREP test has 
been successfully completed. The Step 1 DPREP test scenario must be completed 
before CONTINUING with the Step 3 test scenario. Continuation of the Step 3 
test scenario requires the archive environment that was produced from the 
successful completion of the Step 1 DPREP test scenario. 
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Results 
Find output granules for each of the timespans described above for ESDTs

AM1EPHN0 and AM1EPHH0. ESDT AM1EPHN0 is the Toolkit format ephemeris granule,

while ESDT AM1EPHH0 is the HDF format ephemeris granule. Output from Step 3

processing is placed in the same ESDTs as the Step 1 products.


26.18.5 Results of DPREP processing from earlier work 

26.18.5.1 Step1 DPREP directions taken from earlier work: 
There are 2 profiles for DPREP. Profile 1 takes in previous DPREP output and is expected to be

run most of the time at the DAACs. Profile 2 takes in only the AM1 Ancillary data and will be

run only for the first run of DPREP (because there is no previous output). Both profiles should be

registered and executed.

PGENAME : AM1Eph

PGEVERSION : 2.0

PROFILE : 1

TopLevelShellName : EcDpPrAm1EdosEphAttDPREP_PGE

PGENAME : AM1Eph

PGEVERSION : 2.0

PROFILE : 2

TopLevelShellName : EcDpPrAm1EdosEphAttDPREP_PGE (same executable, only insert it

once)

PGE Tar file location :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_Ancillary_DPREP.tar

PGE Met file location :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_Ancillary_DPREP.tar.met

Science Software Release 4

The PGE tar file contains the executables: EcDpPrAm1EdosEphAttDPREP_PGE,

EcDpPrAm1EdosAncillary, EcDpPrAm1EdosEphemerisRepair, EcDpPrAm1ToolkitHdf.and the

toolkit message file PGS_101

This PGE has no static data. This means Insert Static from SSIT can be skipped for this PGE.


However, there are 4 dynamic granules (2 files each) that this PGE needs as input. These 4

granules can be inserted from SSIT Insert Test Dynamic Tool


Granule 1:

ESDT Short Name : AM1ANC

Version : 001

Multi File granule : Y

Directory  : $ECS_HOME/<MODE>/CUSTOM/data/DPS

File Names : EDOS_LEVEL_ZERO_00.curr, EDOS_LEVEL_ZERO_01.curr

Met file : AM1ANC.curr.met


Granule 2:

ESDT Short Name : AM1ANC
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Version : 001

Multi File granule : Y

Directory  : $ECS_HOME/<MODE>/CUSTOM/data/DPS

File Names : EDOS_LEVEL_ZERO_00.next, EDOS_LEVEL_ZERO_01.next

Met file : AM1ANC.next.met


Granule 3:

ESDT Short Name : AM1ANC

Version : 001

Multi File granule : Y

Directory  : $ECS_HOME/<MODE>/CUSTOM/data/DPS

File Names : EDOS_LEVEL_ZERO_00.next_1, EDOS_LEVEL_ZERO_01.next_1

Met file : AM1ANC.next_1.met


Granule 4:

ESDT Short Name : AM1ANC

Version : 001

Multi File granule : Y

Directory  : $ECS_HOME/<MODE>/CUSTOM/data/DPS

File Names : EDOS_LEVEL_ZERO_00.next_2, EDOS_LEVEL_ZERO_01.next_2

Met file : AM1ANC.next_2.met

3 PRs need to be created, two for Profile 1 and one for Profile 2. Create the PR for Profile 2 first

(it runs on earlier data) and then create the PR for Profile 1.


The time frame for Production request editor for Profile 2 is 1998 June 30 00:00:00 to 
1998 June 30 02:00:00 

The time frame for Production request editor for Profile 1 is 1998 June 30 02:00:00 to 
1998 June 30 04:00:00 

The time frame for Production request editor for the second Profile 1 is 1998 June 30 
04:00:00 to 1998 June 30 06:00:00 

26.18.5.2 Step2 DPREP directions: 
************************************************************************

Step 2 DPREP can run ONLY after all three PRs for Step 1 DPREP have completed

************************************************************************

There are 2 profiles for Step 2 DPREP. Profile 1 takes in previous Step 2 DPREP output and is

expected to be run most of the time at the DAACs. Profile 2 takes in only the Fdd Att data and

will be run only for the first run of DPREP (because there is no previous output). Both profiles

should be registered and executed.


PGENAME : FddAtt

PGEVERSION : 1.0

PROFILE : 1

TopLevelShellName : EcDpPrAm1FddAttitudeDPREP_PGE
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PGENAME : FddAtt

PGEVERSION : 1.0

PROFILE : 2

TopLevelShellName : EcDpPrAm1FddAttitudeDPREP_PGE (same executable, only insert it

once)


PGE Tar file location : $ECS_HOME/<MODE>/CUSTOM/data/DPS/FDDAttitude.tar

PGE Met file location : $ECS_HOME/<MODE>/CUSTOM/data/DPS/FDDAttitude.tar.met

Science Software Version: 1.0


The PGE tar file contains the executable EcDpPrAm1FddAttitudeDPREP_PGE and the toolkit

message file PGS_101

This PGE has no static data. This means Insert Static from SSIT can be skipped for this PGE.

However, there are 3 dynamic granules that this PGE needs as input. These 3 granules can be

inserted from SSIT insert test dynamic tool


Granule 1:

ESDT Short Name : AM1ATTF

Version : 001

Multi File granule : N

File Name :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_DEFINITIVE_ATT.fdd.curr

Met file :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_DEFINITIVE_ATT.fdd.curr.met


Granule 2:

ESDT Short Name : AM1ATTF

Version : 001

Multi File granule : N

File Name :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_DEFINITIVE_ATT.fdd.next

Met file :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_DEFINITIVE_ATT.fdd.next.met


Granule 3:

ESDT Short Name : AM1ATTF

Version : 001

Multi File granule : N

File Name :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_DEFINITIVE_ATT.fdd.next_1

Met file :

$ECS_HOME/<MODE>/CUSTOM/data/DPS/AM1_DEFINITIVE_ATT.fdd.next_1.met


2 PRs need to be created, one for Profile 1 and one for Profile 2. Create the PR for Profile 2 first

(it runs on earlier data) and then create the PR for Profile 1.
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 The time frame for Production request editor for Profile 2 is 1998 June 30 02:00:00 to 
1998 June 30 04:00:00 

The time frame for Production request editor for Profile 1 is 1998 June 30 04:00:00 to 
1998 June 30 06:00:00 

Note: The Data files and tar files are delivered only to the Science Data Server and cannot be 
directly accessed by SSIT. In order to insert these files they must be moved to the SSIT server 
manually. 

26.18.5.3 DPREP Step1 profile1 PCF 
PRODUCT INPUT FILES 
######################################################################## 

(Initial Construction Record:) 
1000|P0420004AAAAAAAAAAAAAA98300080000000.PDS|/net/p0drg01/dss_amass/testdata/ 
instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<A) insert UR here>||2 

(Current 2 hour Data File) 
1000|P0420004AAAAAAAAAAAAAA98300080000001.PDS|/net/p0drg01/dss_amass/testdata/ 
instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<B) insert UR here>||1 
: 

(Future 2 hour Construction Record) 

1010|P0420004AAAAAAAAAAAAAA98300100000000.PDS|/net/p0drg01/dss_amass/testdata/

instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<C)

insert UR here>||2


(Future 2 hour Data File) 
1010|P0420004AAAAAAAAAAAAAA98300100000001.PDS|/net/p0drg01/dss_amass/testdata/ 
instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<D) 
insert UR here>||1 
# ----------------------------------------------------------------------­
# The last ephemeris/attitude data sets generated. (Found in PGE template) 
# ----------------------------------------------------------------------­
# Ephemeris (Toolkit native format) (Previous Time Range) 
1500|EOS_AM1_Ephemeris.21206.step1b.eph|/home/cmts1/DPREP/demooutput||<E) insert UR 
here>||1 
# Attitude (Toolkit native format) 
1502|EOS_AM1_Attitude.21206.step1.att|/home/cmts1/DPREP/demooutput||<F) insert UR 
here>||1 
: 
? PRODUCT OUTPUT FILES 
######################################################################## 

(Current Time Range) 
# ----------------------------------------------------------------------­
# Toolkit attitude datasets (output of EcDpPrAm1EdosAncillary). 
# ----------------------------------------------------------------------­
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1001|EOS_AM1_Attitude.21208.step1.att|/home/cmts1/DPREP/demooutput||||1

1100|EOS_AM1_Attitude.21208.step1.hdf|/home/cmts1/DPREP/demooutput||||1

# ----------------------------------------------------------------------­

# Toolkit ephemeris datasets (output of EcDpPrAm1EdosAncillary).

# ----------------------------------------------------------------------­

1102|EOS_AM1_Ephemeris.21208.hdf|/home/cmts1/DPREP/demooutput||||1

# ----------------------------------------------------------------------­

# Gap-filled HDF ephemeris dataset (output of EcDpPrAm1EphemerisGapFill).

# ----------------------------------------------------------------------­

1151|EOS_AM1_Ephemeris.21208.step1b.eph|/home/cmts1/DPREP/demooutput||||1

# ----------------------------------------------------------------------­

# Gap-filled Toolkit ephemeris dataset (output of

# EcDpPrAm1FormatNativeEphemeris).

# ----------------------------------------------------------------------­

1152|EOS_AM1_Ephemeris.21208.step1b.hdf|/home/cmts1/DPREP/demooutput||||1

:

SUPPORT OUTPUT FILES

########################################################################

10100|LogStatus|/home/cmts1/DPREP/logs||||1

10101|LogReport|/home/cmts1/DPREP/logs||||1

10102|LogUser|/home/cmts1/DPREP/logs||||1

10103|TmpStatus|||||1

10104|TmpReport|||||1

10105|TmpUser|||||1

10110|MailFile|||||1

:

? USER DEFINED RUNTIME PARAMETERS

#########################################################################

999|No Previous Data Set; 1=true, 0=false.|0 (Profile 1 set to 0, Profile 2 set to 1)

# ----------------------------------------------------------------------­

# Toolkit version for which this PCF was intended.

# DO NOT REMOVE THIS VERSION ENTRY!

# ----------------------------------------------------------------------­

10220|Toolkit version string|DAAC B.0 TK5.2.4 (Caution: May need to change to higher

level Toolkit)

END


26.18.5.4 DPREP Step1 profile2 PCF (Profile 2 is start up PCF) 
PRODUCT INPUT FILES 
######################################################################## 
1000|P0420004AAAAAAAAAAAAAA98300060000000.PDS|/net/p0drg01/dss_amass/testdata/ 
instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<A) insert UR here>||2 
1000|P0420004AAAAAAAAAAAAAA98300060000001.PDS|/net/p0drg01/dss_amass/testdata/ 
instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<B) insert UR here>||1 
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1010|P0420004AAAAAAAAAAAAAA98300080000000.PDS|/net/p0drg01/dss_amass/testdata/

instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<C) insert UR here>||2

1010|P0420004AAAAAAAAAAAAAA98300080000001.PDS|/net/p0drg01/dss_amass/testdata/

instrument_data/AM1/EDOS_HK_ANC/EDOSL0_ANC_PDS_0002||<D) insert UR here>||1

# ----------------------------------------------------------------------­

# The last ephemeris/attitude data sets generated.

# ----------------------------------------------------------------------­

# Ephemeris (Toolkit native format)

#1500|EOS_AM1_Ephemeris.prev.eph|.||<E) insert UR here>||1

# Attitude (Toolkit native format)

#1502|EOS_AM1_Attitude.21206.step1.att|/home/cmts1/DPREP/output||<F) insert UR here>||1

:

? PRODUCT OUTPUT FILES

########################################################################

# ----------------------------------------------------------------------­

# Toolkit attitude datasets (output of EcDpPrAm1EdosAncillary).

# ----------------------------------------------------------------------­

1001|EOS_AM1_Attitude.21206.step1.att|/home/cmts1/DPREP/demooutput||||1

1100|EOS_AM1_Attitude.21206.step1.hdf|/home/cmts1/DPREP/demooutput||||1

# ----------------------------------------------------------------------­

# Toolkit ephemeris datasets (output of EcDpPrAm1EdosAncillary).

# ----------------------------------------------------------------------­

1102|EOS_AM1_Ephemeris.21206.hdf|/home/cmts1/DPREP/demooutput||||1

# ----------------------------------------------------------------------­

# Gap-filled HDF ephemeris dataset (output of EcDpPrAm1EphemerisGapFill).

# ----------------------------------------------------------------------­

1151|EOS_AM1_Ephemeris.21206.step1b.eph|/home/cmts1/DPREP/demooutput||||1

# ----------------------------------------------------------------------­

# Gap-filled Toolkit ephemeris dataset (output of EcDpPrAm1FormatNativeEphemeris).

# ----------------------------------------------------------------------­

1152|EOS_AM1_Ephemeris.21206.step1b.hdf|/home/cmts1/DPREP/demooutput||||1

? SUPPORT OUTPUT FILES

########################################################################

10100|LogStatus|/home/cmts1/DPREP/logs||||1

10101|LogReport|/home/cmts1/DPREP/logs||||1

10102|LogUser|/home/cmts1/DPREP/logs||||1

10103|TmpStatus|||||1

10104|TmpReport|||||1

10105|TmpUser|||||1

10110|MailFile|||||1

:

? USER DEFINED RUNTIME PARAMETERS

########################################################################

999|No Previous Data Set; 1=true, 0=false.|1

# ----------------------------------------------------------------------­
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# Toolkit version for which this PCF was intended.

# DO NOT REMOVE THIS VERSION ENTRY!

# ----------------------------------------------------------------------­

10220|Toolkit version string|DAAC B.0 TK5.2.4

? END
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26.18.5.5 DPREP Step2 profile1 PCF 
PRODUCT INPUT FILES

########################################################################

1000|AM1_DEFATT_080000_212_1997_01.FDD|/home/cmts1/DPREP/am1defatt||<A) insert

UR here>||1

:

1010|AM1_DEFATT_100000_212_1997_01.FDD|/home/cmts1/DPREP/am1defatt||<B) insert

UR here>||1

# ----------------------------------------------------------------------­

# The last ephemeris/attitude data sets generated.

# ----------------------------------------------------------------------­

# Attitude (Toolkit native format)

1502|EOS_AM1_Attitude.21206.step2.att|/home/cmts1/DPREP/demooutput||<C) insert UR

here>||1

:

#1400|AM1EPHMH.mcf|.||||1

1401|AM1ATTHF.MCF|/home/cmts1/DPREP/mcf||||1

#1402|AM1EPHMN.mcf|.||||1

1403|AM1ATTNF.MCF|/home/cmts1/DPREP/mcf||||1

10250|MCF|||||1

10252|GetAttr.temp|||||1

10254|MCFWrite.temp|||||1

:

10501|EOS_AM1_Ephemeris.21208.step1b.eph|/home/cmts1/DPREP/demooutput||||2

10501|EOS_AM1_Ephemeris.21210.step1b.eph|/home/cmts1/DPREP/demooutput||||1

10502|INSERT_ATTITUDE_FILES_HERE|||||1

:

? PRODUCT OUTPUT FILES

########################################################################

:1001|EOS_AM1_Attitude.21208.step2.att|/home/cmts1/DPREP/demooutput||||1

1100|EOS_AM1_Attitude.21208.step2.hdf|/home/cmts1/DPREP/demooutput||||1

:

? USER DEFINED RUNTIME PARAMETERS

########################################################################

:

999|First Mission Data Set; 1=true, 0=false.|0

:10220|Toolkit version string|DAAC B.0 TK5.2.4

:END


26.18.5.6 DREP Step2 profile2 PCF 
PRODUCT INPUT FILES 
######################################################################## 
1000|AM1_DEFATT_060000_212_1997_01.FDD|/home/cmts1/DPREP/am1defatt||<A) insert 
UR here>||1 
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:

1010|AM1_DEFATT_080000_212_1997_01.FDD|/home/cmts1/DPREP/am1defatt||<B) insert

UR here>||1

# ----------------------------------------------------------------------­

# The last ephemeris/attitude data sets generated.

# ----------------------------------------------------------------------­

# Attitude (Toolkit native format)

1502|EOS_AM1_Attitude.21206.step1.att|/home/cmts1/DPREP/demooutput||<C) insert UR

here>||1

:

1400|AM1EPHMH.mcf|.||||1

1401|AM1ATTHF.MCF|/home/cmts1/DPREP/mcf||||1

1402|AM1EPHMN.mcf|.||||1

1403|AM1ATTNF.MCF|/home/cmts1/DPREP/mcf||||1

10250|MCF|||||1

10252|GetAttr.temp|||||1

10254|MCFWrite.temp|||||1

:

10501|EOS_AM1_Ephemeris.21206.step1b.eph|/home/cmts1/DPREP/demooutput||||2

10501|EOS_AM1_Ephemeris.21208.step1b.eph|/home/cmts1/DPREP/demooutput||||1

10502|INSERT_ATTITUDE_FILES_HERE|||||1

:

? PRODUCT OUTPUT FILES

########################################################################

1001|EOS_AM1_Attitude.21206.step2.att|/home/cmts1/DPREP/demooutput||||1

1100|EOS_AM1_Attitude.21206.step2.hdf|/home/cmts1/DPREP/demooutput||||1

:

? USER DEFINED RUNTIME PARAMETERS

########################################################################

:999|First Mission Data Set; 1=true, 0=false.|1

:

10220|Toolkit version string|DAAC B.0 TK5.2.4

:

? END


26.18.5.7 Setups for DPREP 
set path = ( /usr/ecs/TS1/CUSTOM/TOOLKIT/toolkit/bin/sgi_daac_f90 $path )

setenv PGS_PC_INFO_FILE /home/cmts1/DPREP/pcf/Step1DP21206.PCF

setenv PGSMSG /home/cmts1/DPREP/msg

setenv PGSHOME /usr/ecs/TS1/CUSTOM/toolkit

setenv PGS_PC_INFO_FILE /home/cmts1/DPREP/pcf/Step1DP21208.PCF

setenv PGSMSG /home/cmts1/DPREP/msg

setenv PGSHOME /usr/ecs/TS1/CUSTOM/toolkit

setenv PGS_PC_INFO_FILE /home/cmts1/DPREP/pcf/Step1DP21210.PCF

setenv PGSMSG /home/cmts1/DPREP/msg
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setenv PGSHOME /usr/ecs/TS1/CUSTOM/toolkit 
setenv PGS_PC_INFO_FILE /home/cmts1/DPREP/pcf/Step2DP21206.PCF 
setenv PGSMSG /home/cmts1/DPREP/msg 
setenv PGSHOME /usr/ecs/TS1/CUSTOM/toolkit 
setenv PGS_PC_INFO_FILE /home/cmts1/DPREP/pcf/Step2DP21208.PCF 
* setenv PGSMSG /home/cmts1/DPREP/msg 
* setenv PGSHOME /usr/ecs/TS1/CUSTOM/toolkit

Note: The setenv parameters are used for the Command Line PGE test. Only the (*) are used

for PDPS PGE runs.


26.18.6 FDD Ephemeris Reprocessing Due To QA Failure 

The following events occur when FDD-supplied ephemeris fails QA checking: 

1 1 	 A subscription is placed on ESDT AM1EPHNF for replacement data (ESDT 
AM1EPHF) when QaPercentMissingData or QaOutOfBoundsData is greater than or 
equal to 1. 

12	 The AM1 DPREP FDD ephemeris processor (“RepEph” or “Step 3” DPREP PGE) 
detects a data gap or an out-of-bounds data point in the FDD-supplied ephemeris 
timeline (supplied through ESDT ShortName AM1EPHF). Assuming that no fatal errors 
are otherwise encountered, the PGE exits with status code 216, a success condition that 
indicates that the FDD-supplied ephemeris data set must be replaced by a re-delivery of 
the same data set. The QaPercentMissingData or QaOutOfBoundsData metadata has 
been set to a value greater than or equal to 1. 

13	 A subscription triggers when the DPREP output data set (i.e. AM1EPHNF) that is 
generated in step 2 is inserted into the archive. The subscription triggers because of 
QaPercentMissingData or QaOutOfBoundsData being greater than or equal to 1. 

14	 The GDAAC operator receives an E-mail notification indicating that the subscription 
has triggered. The universal reference (UR) of the AM1EPHNF granule that triggered 
the subscription is provided in the E-mail. 

15	 The GDAAC operator uses the database ID imbedded within the UR to identify the 
AM1EPHNF granule in the archive using EcCoDbViewer. Retrieve the start and end 
times of this granule. 

16 	 The GDAAC operator telephones the FOT (telephone number 301-614-5431) and 
requests an FDD ephemeris data set (ESDT ShortName AM1EPHF) be sent for the time 
period spanned by the start and end times determined in step 5. The operator explicitly 
states what the replacement granule’s start and end time must be, to the second. The 
replacement ephemeris data set will be sent to both the GDAAC and the LDAAC. 

17	 The GDAAC operator notifies LDAAC operations (telephone number 757-864-9197) 
that a new AM1EPHF ephemeris data set is going to arrive for the time period 
determined in step 5. 

18 	 The GDAAC and LDAAC operators schedule the AM-1 DPREP FDD ephemeris 
processor (“RepEph” or “Step 3” DPREP PGE) to process the time interval determined 
in step 5. If data replacement occurs on the first granule following a period of data 
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dropout, Profile 2 processing must be scheduled. Otherwise, Profile 1 can be scheduled 
to run. 

26.18.6.1 Boot-up of EDOS Ephemeris Processing 

AM-1 DPREP EDOS ephemeris processor (“AM1Eph” or “Step 1” DPREP) Profile 2 requires a 
special procedure in order to achieve boot-up processing at the start of the mission and following 
periods of data dropout. The required steps follow: 

1.	 Wait for the first EDOS-supplied AM1ANC data set that follows the interval of data dropout 
to be ingested. 

2. Use the EcCoDbViewer archive browser to determine the start and end time of the granule. 
3. Call the FOT (telephone number 301-614-5431) and ask to speak with the on-line engineer. 
4.	 Ask the on-line engineer to provide the orbit number at the granule start time determined in 

step 2. 
5.	 Telephone LDAAC operations (telephone number 757-864-9197). Pass-on the orbit number 

determined in step 4 to the operator so the LDAAC can proceed with steps 6 through 9. This 
avoids having both the LDAAC and the GDAAC perform steps 1 through 4. 

6.	 In directory /usr/ecs/OPS/CUSTOM/data/DPS, locate ODL file 
PGE_AM1EphVVVVV02.odl. VVVVV is the version number of the operational AM-1 
DPREP. 

7.	 Edit this file using vi. Locate logical ID 998 (PGE_PARAMETER_NAME 
InitialOrbitNumber) within the ODL file and insert the orbit number provided by the FOT 
on-line engineer into the line beginning with PGE_PARAMETER_DEFAULT. This step 
requires allmode privileges in order to edit the ODL file. 

8. Register the “AM1Eph” AM-1 DPREP. 
9.	 Schedule “AM1Eph” AM-1 DPREP, Profile 2 to process the interval given by the start and 

end times determined in step 2. 

26.18.6.2 FDD Replacement Ephemeris Processing 

The following events occur in FDD replacement ephemeris processing: 

1.	 A subscription is placed on ESDT AM1EPHN0 for replacement data (ESDT AM1EPHF) 
when QaPercentMissingData is greater than or equal to 1. 

2.	 The AM1 DPREP EDOS ephemeris processor (“AM1Eph” or “Step 1” DPREP PGE) detects 
a long data gap in the EDOS-supplied ephemeris timeline (supplied through ESDT 
ShortName AM1ANC). Assuming that no fatal errors are otherwise encountered, the PGE 
exits with status code 216, a success condition that indicates the replace ephemeris condition 
has been detected. The QaPercentMissingData metadata is set to a value greater than or 
equal to 1, depending on the size of the data gap that is detected. 

3.	 A subscription triggers when the DPREP output data set (i.e. AM1EPHN0) that is generated 
in step 2 is inserted into the archive. The subscription triggers because of 
QaPercentMissingData being greater than or equal to 1. 
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4.	 The GDAAC operator receives an E-mail notification indicating that the FDD replacement 
ephemeris data set subscription has triggered. The universal reference (UR) of the 
AM1EPHN0 granule that triggered the subscription is provided in the E-mail. 

5 . 	 The GDAAC operator uses the database ID imbedded within the UR to identify the 
AM1EPHN0 granule in the archive using EcCoDbViewer. Retrieve the start and end times of 
this granule. 

6.	 Given the start and end granules times, the GDAAC operator derives the replacement time 
range. The procedure will be demonstrated by example. If the 2-hour AM1EPHN0 granule 
ideally spans 22h – 24h of day 2000-06-07, the replacement ephemeris granule time span is 

Start time = 2000-06-07 22:00:00.000 
End time = 2000-06-07 23:59:59.000 

Replacement data starts on the hour and ends one second prior to the start of the subsequent 
2-hour granule. 

7.	 The GDAAC operator telephones the FOT (telephone number 301-614-5431) and requests 
an FDD replacement data set (ESDT ShortName AM1EPHF) be sent for the time period 
spanned by the start and end times determined in step 6. The operator explicitly states what 
the replacement granule’s start and end time must be, to the second. The replacement 
ephemeris data set will be sent to both the GDAAC and the LDAAC. 

8.	 The GDAAC operator notifies LDAAC operations (telephone number 757-864-9197) that a 
replacement ephemeris data set (AM1EPHF) is going to arrive for the time period 
determined in step 6. 

9.	 The GDAAC and LDAAC operators schedule the AM-1 DPREP replacement ephemeris 
processor (“RepEph” or “Step 3” DPREP PGE) to process the time interval determined in 
step 6. If data replacement occurs on the first granule following a period of data dropout, 
Profile 2 processing must be scheduled. Otherwise, Profile 1 can be scheduled to run. 

26.18.6.3 FDD Attitude Reprocessing Due To QA Failure 

The following events occur when FDD-supplied attitude fails QA checking: 

a.	 A subscription is placed on ESDT AM1ATTNF for replacement data (ESDT AM1ATTF) 
when QaPercentMissingData or QaOutOfBoundsData is greater than or equal to 1. 

b.	 The AM1 DPREP FDD attitude processor (“FddAtt” or “Step 2” DPREP PGE) detects a 
data gap or an out-of-bounds data point in the FDD-supplied attitude timeline (supplied 
through ESDT ShortName AM1ATTF). Assuming that no fatal errors are otherwise 
encountered, the PGE exits with status code 216, a success condition that indicates that 
the FDD-supplied attitude data set must be replaced by a re-delivery of the same data set. 
The QaPercentMissingData or QaOutOfBoundsData metadata has been set to a value 
greater than or equal to 1. 

c . 	 A subscription triggers when the DPREP output data set (i.e. AM1ATTNF) that is 
generated in step 2 is inserted into the archive. The subscription triggers because of 
QaPercentMissingData or QaOutOfBoundsData being greater than or equal to 1. 

d.	 The GDAAC operator receives an E-mail notification indicating that the subscription has 
triggered. The universal reference (UR) of the AM1ATTNF granule that triggered the 
subscription is provided in the E-mail. 
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e.	 The GDAAC operator uses the database ID imbedded within the UR to identify the 
AM1ATTNF granule in the archive using EcCoDbViewer. Retrieve the start and end 
times of this granule. 

f.	 The GDAAC operator telephones the FOT (telephone number 301-614-5431) and 
requests an FDD attitude data set (ESDT ShortName AM1ATTF) be sent for the time 
period spanned by the start and end times determined in step 5. The operator explicitly 
states what the replacement granule’s start and end time must be, to the millisecond. The 
replacement attitude data set will be sent to both the GDAAC and the LDAAC. 

g.	 The GDAAC operator notifies LDAAC operations (telephone number 757-864-9197) 
that a new AM1ATTF attitude data set is going to arrive for the time period determined 
in step 5. 

h.	 The GDAAC and LDAAC operators schedule the AM-1 DPREP FDD attitude processor 
(“FddAtt” or “Step 2” DPREP PGE) to process the time interval determined in step 5. If 
data replacement occurs on the first granule following a period of data dropout, Profile 2 
processing must be scheduled. Otherwise, Profile 1 can be scheduled to run. 

26.19 PGE Chaining 

26.19.1 Chaining PGE’s 
1. Create PRs (so that DPRs) for the PGEs to be chained. 

This can be done by using PR Editor. Follow the same procedure as creating 
independent PR. 

A few points need to be noticed. Let's say among the chained PGEs, the output of PGE A 
will be the input of PGE B.1) In ESDT odl for this shared granule, "DYNAMIC_FLAG" 
has to be set to "I", i.e., dynamic internal. 2) First create PR for PGE A, then for PGE B. 
Otherwise PGE B PR may not be able to be generated. 

2.  Create the plan for a bunch of PRs which are chained. 

In Work Bench GUI, 1) pull down "file" menu and select "new" to create the new plan; 
2) highlight all PRs that are chain by clicking on their names on "unscheduled" area of 
Production Request area; 3) click schedule button to schedule these PRs. 

3. Activate the plan. 

In the Workbench GUI, click "activate" button, a GUI will pop up to ask for saving the 
plan. Answer "yes". Then another GUI will pop up to confirm whether to really activate 
the plan. Answer "yes" and the lowest level of DPR(s) in the chain will kick off. 

In the pdps database, the PlDataProcessingRequest table is where the PRs are 
successfully generated, the "completionState" for all DPRs in the chain are "NULL". 
When the plan is successfully activated, the "CompletionState" for lowest level of 
DPR(s) is changed from "NULL" to "STARTED". The high level of DPR(s) in the chain 
is changed from "NULL" to "CQ_HOLD". Eventually, the low level of DPR(s) finish so 
that the input for high level of DPR(s) become available, Then the high level DPR(s) kick 
off and the "CompletionState" then changes from "CQ_HOLD" to "STARTED". 
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26.20 Updating the Orbit Model 

26.20.1 Introduction to Updating the Orbit Model 
To determine realtime the latest Orbit Start times, Orbit Period, Path Number and Orbit 
Number, PDPS takes in specific information about the orbit of the satellite during initial 
SSI&T. This information then becomes the basis for predictions of future orbit start times 
and numbers. Because this value is accurate within a fraction of a second of time, the 
satellite may “drift” or a correction to orbit, known as a “burn” may have been applied. 
Therefore, the satellite Orbit Start Time can get out of sync either +/- with reality. The 
consequences are an elapse in time that will affect the Production Request Editor’s ability to 
find a granule that should match with a DPR, or an incorrect Orbit Time could be passed to 
the PGE. The update of Orbit parameters will be done weekly at a specific time with scrips 
specifically written to extract the new Orbit Parameters from the most recent DPREP output 
file. These parameters intern will be inserted manually to the ORBIT.ODL file and then the 
re-registration of the Orbit.ODL file into the PDPS by SSI&T personnel. The M&O support 
Help Desk Team is responsible for knowing when changes to Orbit location have taken place 
from the Flight Dynamics Systems (FDS). A KnowledgeBase with backup procedures will 
be maintained by M&O for contingencies concerning Orbit Model updates. DPREP 
processing will be the most likely place to experience a failure due to Orbit time sync error 
encounters. The restoration of Orbit parameters with new values from FDS will most likely 
be necessary. The following procedures are provided to bring about an updated Orbit Model 
within ECS. 

26.20.2 Procedures to Update the Orbit Model 
Upon receipt of updated orbit parameters:	 ORBIT_ NUMBER, 

ORBIT_PERIOD, 
ORBIT Path Number and 
ORBIT_START Time. 

Proceed with the following steps. 

1	 Telnet or Rlogin to location (ais) system where ODL files are stored. ie; 
“/usr/ecs/OPS/CUSTOM/data/DPS/ODL” 

2 Select the ORBIT.odl that is currently being used. 
3	 Using vi, update the following files with the new parameter values received: 

• ORBIT_AM1.odl and/or ORBIT_EOSAM1.odl if they both are in use. 
4	 Have someone double check your entries for accuracy before preoceeding to the SSIT 

Manager for registering the new ODL file in the PDPS system. 
5	 For Test Data only; determine the Instrument PGE ODL that will be updated. MISR, 

MODIS etc. 
•	 Using vi, update the corresponding PATHMAP_Instrument_.odl file with the new 

parameter values received. 
•	 Ensure that the ABSOLUTE_PATH and MAPPED_PATH parameters agree with those 

in the new ORBIT_XXXX.odl. 
6	 SSI&T personnel will execute an Orbit Model Update by running a Dummy PGE 

established for this purpose at each of the DAAC’s. Note: A dummy PGE is ran since a 
normal PGE cannot be re-registered if any DPRs exist in the system. 
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7	 Notify DAAC Operations Supervisor that the Orbit Model has been updated. He will make a 
log entry of such action taken and may request the old computed values and the new 
replacement values be provided. The Supervisor will ensure that the orbital change is within 
several seconds, the expected change and not minutes! 

26.21. Learn more about SSI & T 

26.21.1 References: 
PDPS Home Page: http://dmserver.gsfc.nasa.gov/ecsdev/relb/pdps/index.html 

` URL for ECS Project Training Material Volume 16: SSI&T December 1997: 

http://m0mss01.ecs.nasa.gov/smc/dc master.html 

MISR Science Data Processing Software Test Plan, Volume 2, Detailed Procedures and 
Facilities Version 2.0, Part 1 (PGE 1) June 1998. 

http://dmserver.gsfc.nasa.gov/relbit/relbit.html 
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V0 Web Client (DAAC


MODE TS1)
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Business Manual Tab


Job Description Tab


Organization Charts Tab


Process Directives Tab


Training Tab


Miscellaneous Tab


Frequently Asked questions


EDHS


Raytheon Company


ESDT Basics http://dmserver.gsfc.nasa.gov/esdt/EsdtSection1/index.html 

GDAAC Directory for SSI&T:http://gsfcsrvr8.gsfcmo.ecs.nasa.gov/SSIT/ 

The ESDT Process (updated for drop 4) by Karl W. Cox, 22 December 1997 

DCE Cell Manager Common User Tasks provided by IDG, February 6, 1998 

1 Tools and Techniques for Diagnosing Potential DCE Problems 

MODIS - Science Data Processing Software Release 4 System Description 

SDST-104, May 19, 1998 

ECSINFO: http://ecsinfo.hitc.com/iteams/Science/science.html 

PDPS howto are located on the EDF machines at: /home/PDPS/docs/ 

PDPS Web Page: http//dmserver.gsfc,nasa.gov/ecsdev/relb/pdps/index.html 
For Troubleshooting or use the following EDF machines: 
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PDPS Troubleshooting Techniques are located on the EDF machines at : 
/home/PDPS/troubleshooting/ 

DPREP README files located at :/usr/ecs/TS1/CUSTOM/data/DPS/ 

DPREP binary located: :/usr/ecs/TS1/CUSTOM/bin/DPS/ 

26.21.2 Server Node Names Convention: 
The naming convention is as follows:


Machine names are defined to be equivalent to the network hostname of the


machine. Network hostnames are limited to eight characters. On ECS we are now formatting

these hostnames as svcimnni

Wheres : Site


g – GSFC 
e – EDC 
l – LaRC 
n – NSIDC 
a – ASF 
j – JPL 
p- PVC 
t – VATC 

v : Version 
0 -- Release 4 At-Launch COTS design 
1 -- Stood for B.1 COTS design; OBE, but still used in VATC 
s -- Used for special SSI&T machines set up at GSFC and EDC 

ci : Hardware Configuration Item 

sp -- Science Processing (SPRHW) 

ai -- Algorithm Integration and Test (AITHW) 

aq -- Algorithm Quality Assurance (AQAHW) 

pl -- Planning (PLNHW) 

ms -- Management Subsystem (MSSHW) 

cs -- Communications Subsystem (CSSHW) 

in -- Interface (INTHW) 

dm -- Data Management (DMGHW) 

dr -- Data Repository (DRPHW) 

ac -- Access Control Management (ACMHW) 

ic -- Ingest Client (ICLHW) 

wk -- Working Storage (WKSHW) 
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 di -- Distribution (DIPHW)


as -- ASTER (ASTHW) [Occurs only at EDC]


te -- Test Equipment


m : Manufacturer 

s -- Sun 

g -- SGI 

h -- HP 

x -- X Terminal 

p -- PC 

nn : One-up number (01, 02, et cetera -- should be unique for the CI) 

i : Interface type 

<null> -- Production network 

u -- User network 

h -- HiPPI 

Note that the machine name leaves off the last letter (the interface); hence, we 

generally refer to machines as "g0spg01", vice "g0spg01h". A machine may have 

multiple interfaces -- production, user, and HiPPI. So a single machine may show 

up in network documentation multiple times (g0spg01, g0spg01h, g0spg01u). 

26.21.3 A Handy Alias file to use while conducting SSI&T:

p0spg01{emcleod}51: alias

+  pushd

- popd

More  more !* |grep -v "Msg: Caught dce error: No more bindings (dce / rpc)"

|grep -v "MsgLink :0 meaningfulname :EcAgManager::Recovery" |grep -v "MsgLink

:0 meaningfulname :DsShSRequestRealSetStateSettingState" |grep -v "Command 1/1

execution complete"

cdstagebin  cd /ecs/formal/STAGE/DSS/bin/sun5.5

dbg  debugger -bg NavajoWhite -fn 12x24 !* &

dbs  /home/jzhuang/bin/dbrowser-syb &

disp  setenv DISPLAY !*

mgr  DpAtMgr ConfigFile /usr/ecs/TS1/CUSTOM/cfg/DpAtMG.CFG ecs_mode TS1&

ops  cd /usr/ecs/OPS/CUSTOM

ts1  cd /usr/ecs/TS1/CUSTOM

xslq_autosys  isql -Uautosys -Pautosys -Sp0sps06_srvr

xsql_css  isql -Ucss_role -Pwelcome -Sp0ins01_srvr
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xsql_dss  isql -UsdsrvApp -Pwelcome -Sp0acg01_sqs222_srvr

xsql_ios  isql -Uios_role -Pwelcome -Sp0ins02_srvr

xsql_pdps  isql -UpdpsUsers -Pwelcome -Sodyssey_srvr


# alias for browser

Note: On Performance Verification Center (PVC), dbbrowser has to originate from

workstation ODYSSEY to execute alias db_pdps to reach PDPS DB on p0pls02.

alias db_dss '/home/opscm/dbr/dbrowser-syb -UsdsrvApp -Pwelcome -Sp0acg01_sqs222_srvr

&'

alias db_ios '/home/opscm/dbr/dbrowser-syb -Uios_role -Pwelcome -Sp0ins02_srvr &'

alias db_css '/home/opscm/dbr/dbrowser-syb -Ucss_role -Pwelcome -Sp0ins01_srvr &'

alias db_autosys '/home/opscm/dbr/dbrowser-syb -Uautosys -Pautosys -Sp0sps06_srvr &'

alias db_pdps '/home/opscm/dbr/dbrowser-syb -UpdpsUsers -Pwelcome -Sp0pls02_srvr &'

alias db_ing '/home/opscm/dbr/dbrowser-syb -UEcInPolling -P3nWK0fG1 -Sp0icg01_srvr &'

alias db_stmgt '/home/opscm/dbr/dbrowser-syb -UEcDsStFtpDisServer -PS71Oq4y3 -

Sp0icg01_srvr &'


ls -laF look at root and .cshrc, .alias 

26.21.4 HOWTO_SSIT HELPFUL NOTES 

Xterm format to bring up xterm windows for servers all at once 

This list of xterm identifiers should be assigned a file name and placed into your home 
directory. Then invoke the file name when you want to create the entire list of xterms. 

Example of filename: - xterm_pls 

xterm -sb -sl 10000 -fg green -bg black -name "Resource Editor" &


xterm -sb -sl 10000 -fg green -bg black -name "Resource Model" &

xterm -sb -sl 10000 -fg green -bg black -name "Production Request Editor" &

xterm -sb -sl 10000 -fg green -bg black -name "Planning Workbench" &

xterm -sb -sl 10000 -fg green -bg black -name "Database" &

xterm -sb -sl 10000 -fg green -bg black -name "Planning Timeline" &

xterm -sb -sl 10000 -fg green -bg black -name "Logs" &

xterm -sb -sl 10000 -fg green -bg black -name "ECS Assist" &

xterm -sb -sl 10000 -fg green -bg black -name "g0sps06" &

xterm -sb -sl 10000 -fg green -bg black -name "g0ais01" &

xterm -sb -sl 10000 -fg green -bg black -name "g0spg01" &

xterm -sb -sl 10000 -fg green -bg black -name "g0drg01" &

xterm -sb -sl 10000 -fg green -bg black -name "g0pls02" &

# setenv ECS_HOME /usr/ecs

# setenv MODE TS2


26.21.5 howto_setup_orbits_and_pathmaps 
ORBITS & PATHMAPS 
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The Path is a an orbit swath, defined for Landsat-7 ("WRS"),

which MISR uses in its processing.

Because the earth rotates under it, the path the satellite

traverses for its next orbit is not path 2, but path 17.

This mapping of orbit number to path number is found in the

PATHMAP ODL file.

In that file ABSOLUTE_PATH is what we call orbit number here,

and MAPPED_PATH is the path number.

Now, this mapping is fixed, and never changes.

What does change is the time each orbit starts.

This is because the orbit may drift and be subject to

maneuvers.

Periodically (say, every 2 weeks), the Flight Dynamics

Facility (FDF) at GSFC issues a new Orbit Start Time,

with corresponding Orbit Number.

When this happens, the PDPS ORBIT ODL must be updated,

with a new ORBIT_MODEL object, containing the new

ORBIT_START and corresponding ORBIT_NUMBER.

The new ORBIT_PATH_NUMBER is determined manually by

the operator, using the lookup table in the PATHMAP ODL file.

1. Example (MISR PGE7 test data)

FDF issues a bulletin stating that imaginary platform MPGE7

orbit number 27 starts at 14:37:39Z 07-Jan-96.

SSIT operator receives the bulletin, looks up in

the corresponding PATHMAP_WRS7.odl file to find that

ABSOLUTE_PATH XX corresponds to MAPPED_PATH XX.

NEED TO FIX THIS

The SSIT operator then creates a new ORBIT_MODEL object in the

ORBIT ODL file as follows:

OBJECT = ORBIT_MODEL


CLASS = 2

ORBIT_NUMBER = 27

ORBIT_PERIOD = "SECS=5932"

ORBIT_START = "01/07/1996 14:37:39Z"

ORBIT_PATH_NUMBER = 90


END_OBJECT = ORBIT_MODEL 
****************************************************************************** 

26.21.6 howto_register_pge 
# First prepare PGE and ESDT ODL files

# Update database

xterm -sb -sl 256 -bg maroon -fg "papaya whip" -cr "papaya whip" -fn

"*l*s*type*b*r*140

*" -T 'SSIT: Science Metadata Database Update' -n 'Science Metadata Update' -e

/usr/ecs
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//OPS/CUSTOM/bin/DPS/EcDpAtDefinePGE &

# Update performance info

/usr/ecs//OPS/CUSTOM/bin/DPS/EcDpAtOpDbGui ConfigFile

/usr/ecs//OPS/CUSTOM/cfg/EcDpAtOp

DbGui.CFG ecs_mode OPS &

************************************************************************


26.21.7 howto_register_dpr 
#########################################################################

# Make sure STMGT and SDSRV are up

#########################################################################

# Use either ECS Assist on p0acs03 *and* p0drg01,

# Alternatively, use ps:

p0acs03:> ps -ef | grep EcDsScienceDataServer | grep TS1


sdsrv 24410 1 0 10:17:57 pts/3 0:33 
/usr/ecs//TS1/CUSTOM/bin/DSS/EcDsScience 
DataServer ConfigFile /usr/ecs//TS1/CUS 
p0drg01:> ps -ef | grep Server | grep TS1 | grep ConfigFile 

stmgt 3786 1 0 Dec 30 ? 10:39 
/usr/ecs/TS1/CUSTOM/bin/DSS/EcDsStStaging 
DiskServer ConfigFile /usr/ecs/TS1/CUS 

stmgt 3803 1 0 Dec 30 ? 10:31 
/usr/ecs/TS1/CUSTOM/bin/DSS/EcDsStStaging 
MonitorServer ConfigFile /usr/ecs/TS1/ 

stmgt 3770 1 0 Dec 30 ? 16:18 
/usr/ecs/TS1/CUSTOM/bin/DSS/EcDsStArchive 
Server ConfigFile /usr/ecs/TS1/CUSTOM/ 

stmgt 3815 1 0 Dec 30 ? 10:59 
/usr/ecs/TS1/CUSTOM/bin/DSS/EcDsStFtpDisS 
erver ConfigFile /usr/ecs/TS1/CUSTOM/c 
# If any of these are not present, that server is down. 
# You must arrange to have it up before continuing 
************************************************************************* 

26.21.8 Using Production Request Editor and Planning Workbench 
PRE:

telnet p0pls01, cmops, dce_login

ops, cd utilities,

then invoke EcplStartPRE_IF OPS 3 &

PWB: telnet p0pls01, cmops, dce_login

ops, cd utilities, invoke EcPlSlayAll prior to using PWB.


then invoke EcPlStartAll OPS 3 & or 2 
times used for plan activation: 01/01/1990 time 00:00:00 

AutoSys- To Monitor DPS , telnet to: p0sps06_srvr 
######################################################################### 
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26.21.9 howto_Make a Production Request 
######################################################################### 
rlogin p0pls01 -l pls

dce_login

awhitele

cd /usr/ecs/TS1/CUSTOM/utilities

set path = ( /usr/bin )

source .buildrc

setenv DISPLAY mojave:0.0

# Make sure no one else is running PREditor, then run it 
/usr/ucb/ps -auxwww | grep -i pre | grep TS1

EcPlStartPRE_IF TS1 1

Click PREdit

Click PGE, select it, OK

Set time to input, e.g. (CPGE1)

06 12 1997 00 00 00

06 14 1997 00 00 00

**********************************************************************


26.21.10 Additional SSI&T Howto_procedures and Production rules taken from 
PDPS tests documented in the following files last updated 01/14/00: 
SCF: cd /home/PDPS/docs - look through list of 'howto_s'

production_rules_wp.doc*

Drop3Scen2.txt

HowToCompileAndRunSyntheticPGE

HowToDealWithDPSDeadLocks

HowToFakeSubscriptionNotification

HowToInstallOnComanche

HowToStartAutosysAndViewJobStates

HowToActivateAPlan

HowToDeleteAndRecreateJobs

HowToSetUpPlanning

Tiling.txt

HowToRunProductionStrategyGUI

SpatialQuery.txt

HowToInsertMultiFileGranules

HowToStartDPS

ModisDataList

HowToUseSubscriptionServerDriverToSendSubscriptionNotification

HowToReactivateReplan

VerifiedList

HowToStartQaMonitor

HowToTestFaultRecovery

HowToTestGroundEventJobs

HowToCleanAutoSys

HowToInstall-General
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HowToInsertData

MergeList

HowToEnterGroundEvents

HowToTestDynamicMetaDataQuery

HowToReacquireAGranule

ReacquireGranule.sql

HowToAdHocReprocessPRs

HowToTestDatabaseCleanupScript

HowToDoProfiling

HowToRunMulti-GranuleESDTsTest

HowToRunSSITAcquireTool#

HowToRunResourcePlanning

HowToCreateDprepTarFile*HowToRunBROWSETest~

HowToRunBROWSETest

HowToRunSpatial

mailfile

HowToRunDataDay-InterimFilesTest~

HowToTest

HowToInstallPlanning~

HowToRunDataDay-InterimFilesTest

HowToInstallPlanning

HowToRunSSIT

HowToRunOptionalDPRs~

EndToEnd

HowToRunASTER

HowToRunOptionalDPRs

HowToRunTiling~

HowToRunMostRecentGranule~

HowToRunMostRecentGranule

HowToRunTiling

HowToTestAlternateInput~

HowToTestAlternateInput

HowToRunASTER#

HowToRunModis

HowToRunMISRLIKE~

HowToRunModisPlus

HowToRunMISRLIKE


HowToRunASTERRoutine


HowToRunDPREP

HowToRunMostRecentGranule#

HowToRunTiling.odl

HowToTestAlternateInput~

HowToRunASTERRoutine

WhatTestsWhat
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HowToRunSSIT

datadepend_dprep

HowToCreateDprepTarFile.old

HowToRunModis.old

HowToRunModisPlus#

HowToRunMRG+MetadataCombo~

HowToRunMRG+MetadataCombo

EndToEnd

HowToTestOutputMFG~

HowToTestOutputMFG

HowToRunSpatial

HowToRunDPREP_Func_Lab~

HowToTestGroundEventJobs

HowToTestDatabaseCleanupScript

HowToRunASTERRoutine

HowToTestDatabaseCleanupScript

HowToRunBROWSETest

HowToRecoverNotifications

LaRC_Synthetic_EndToEnd_Performance Verification Center (PVC)~

LaRC_Synthetic_EndToEnd_Performance Verification Center (PVC)

HowToRunMISRISH

HowToRunMISRSIM

HowToRunMISRLIKE~

HowToRunDataDay-InterimFilesTest

foo

HowToTestAlternateInput

HowToTestAlternateWithInternalDynamics_bad

HowToRunMISRLIKE

xemacs

HowToRunResourcePlanning

HowToTestAlternateWithInternalDynamics*

error.log

HowToRunMRG+MetadataCombo#

hgj_spatial

HowToRunASTER

HowToRunCG+MetadataComboOLD

dead.letter

HowToRunSpatialPad#*

HowToRunMISRLIKE#.NeedAnsToQuesAboutMISRLIKEprofile2

HowToRunSpatialPad~*

HowToRunAIRSLIKE~

HowToRunModis#

HowToRunShortModis

HowToRunShortModis#

HowToRunMulti-GranuleESDTsTest.short~
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HowToRunMulti-GranuleESDTsTest.short

HowToCreateDprepTarFile.bh.update.oct8

#HowToRunMulti-GranuleESDTsTest.short#

HowToRunAIRSLIKE

HowToRunASTER1

HowToRunMulti-GranuleESDTsTest.jutout~

HowToRunMulti-GranuleESDTsTest.jutout

HowToRunMISRLIKE

HowToRunASTER#

HowToRunSSITforOnDemand~

HowToRunOnDemandPge~

HowToRunSpatialPad*

HowToRunClosestGranule

HowToRunCG+MetadataCombo

HowToRunModis

HowToRunDPREP_Func_Lab

HowToRunASTERnew.html~

HowToRunMulti-GranuleESDTsTest

HowToRunSSIT.html~

HowToRunResourcePlanning.html~

HowToRunASTER.html~

HowToRunDPREP#

HowToRunModis.html~

HowToRunResourcePlanning.html

HowToRunQAMonitor.html~

HowToRunMISRLIKE.html~

HowToRunModis.html

HowToRunSSIT.html

pdpsTestIndex.html~

TestIndex.html~

HowToRunMulti-GranuleESDTsTest.html~

HowToRunQAMonitor.html

HowToRunMulti-GranuleESDTsTest.html

HowToRunMISRLIKE.html

HowToRunOnDemandPge

HowToDeleteAndRecreateJobs.html

LabIndex.html~

HowToRunASTER.html

SCCS/

LabIndex.html


26.21.11 Technical Notice concerning Leap Second/DPREP 
Notice of Change to Toolkit Ephemeris and 

Attitude Interpolation 
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March 15, 1999 

Effective with a late patch to Drop 4PY, the time interval 
over which the Toolkit will interpolate spacecraft ephemeris 
or attitude is reduced from 121 seconds to 60 seconds. (The 
normal interval between packets for AM1 is 1.024 seconds, 
except for FDD replacement ephemeris, which will use 1 second 
time intervals.) 

Impact of this Change 

For reasons explained below, the only impact on real data

processing would be to avoid the possibility of a less­

than-ideal interpolation.


The impact on I&T would be that test data should always

be generated or obtained with packet interval 60 seconds

or less. There are a few inputs for the Toolkit test

drivers, which are not a deliverable, but are occasionally

supplied to Toolkit users, which (to save file space) are

set up to work with 120 second packets. These lie in

the file "orbsim.in" (which is, as explained, a PDPS add­

on which is unsupported software when it is provided to

users). To conduct tests without new and annoying failures,

if you use this input file for "orbsim", you should edit it

to replace "120" by "60" or less, globally. Results will

not change significantly from the expected test results.


Rationale for this Change 

The SDP Toolkit uses an analytic, cubic polynomial method 
to interpolate ephemeris that is extremely fast, but which 
could generate undesirable and spurious variations if 
applied across too large a time interval, or to data that 
are not smooth. 

DPREP, which will process all incoming ephemeris data, has 
a robust method for patching gaps up to 60 seconds, based 
on a least squares quartic fit, component by component, to 
position and velocity. Although this method is undesirably 
slow for repeated use within the Toolkit, it is ideal for 
DPREP, which runs only once on a data set. The existence 
of any gaps not repairable by DPREP (i.e. > 60 seconds) will 
trigger procedures to obtain replacement data files from FDD. 
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It is therefore unwise to allow the Toolkit to interpolate 
gaps which DPREP cannot fill, so it is being changed. The 
same limit is set for attitude. We expect no gaps whatever 
in FDD attitude, and the attitude is not of much use without 
the ephemeris, so this change was made consistently. 

26.22 Using IQ Software to Create Reports 

26.22.1 Creating Reports Using IQ Software 

ECS no longer plans to offer a Report Generator GUI. Consequently, DAAC operations 
personnel must use other means to generate various types of reports. 

IQ (Intelligent Query) software is a set of commercial off-the-shelf (COTS) products that 
provides flexible access to the PDPS database from which data for reports can be retrieved. The 
cost of that flexibility is a somewhat complicated process for initially setting up reports. 
However, once a particular type of report has been set up, reports can be generated fairly 
quickly. 

The procedure for creating reports using IQ software starts with the assumption that the 
Production Planner has logged in to the system. 

Creating Reports Using IQ Software 

NOTE:	 If using an X-Terminal, it may be necessary to add the following line to the 
.Xdefaults file in the home directory before performing the task for the first time: 
iqx*background: grey 

NOTE: Commands in Steps 1 through 8 are typed at a UNIX system prompt. 
1	 Type rlogin hostname refers to the host (e.g., e0mss21, g0mss21, l0mss21, or n0mss21) 

on which GUIs are to be launched during the current operating session. Multiple 
hostnames can be specified on the same line. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
•	 Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
•	 When using secure shell, the DISPLAY variable is set just once, before logging in 

to remote hosts. If it were to be reset after logging in to a remote host, the 
security features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Applications Server host by typing /tools/bin/ssh hostname (e.g., 

e0mss21, g0mss21, l0mss21, or n0mss21) in the new window then press the 
Return/Enter key. 

•	 If you receive the message, Host key not found from the list of known 
hosts. Are you sure you want to continue connecting (yes/no)?  type 
yes (“y” alone will not work). 
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•	 If you have previously set up a secure shell passphrase and executed 
sshremote, a prompt to Enter passphrase for RSA key 
'<user@localhost>' appears; continue with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6	 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type setenv ECS_HOME /usr/ecs/ then press the Return/Enter key. 
• When logging in as a system user (e.g., cmshared), the ECS_HOME variable 

may be set automatically so it may not be necessary to perform this step. 
8 Type cd /usr/ecs/MODE/COTS/iqx5 then press Return/Enter. 

•	 Change directory to the directory containing the IQ software (directory 
path may vary from site to site). 

• The MODE will most likely be one of the following operating modes: 

• OPS (for normal operation). 

• TS1 (for Science Software Integration and Test (SSI&T)). 

• TS2 (new version checkout). 

• Note that the separate subdirectories under /usr/ecs apply to (describe) 
different operating modes. 

9 Type iqx & then press Return/Enter. 
•	 If the GUIs are not displayed when the command iqx is given, try using 

./iqx instead. 
•	 The iqx IQView GUI (Figure 26.19.6-1) and either the iqx Sybase 

Database Logon GUI (Figure 26.19.6-2) or iqx Open IQView GUI 
(Figure 26.19.6- 3) are displayed. 

	 If IQViews have been defined previously, they are listed on the iqx Open 
IQView GUI (Figure 26.19.6-3); otherwise, a list of database tables is 
displayed. 
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Figure 26.22.1-1. iqx IQView GUI


Figure 26.22.1-2. iqx Sybase Database Logon GUI
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Figure 26.22.1-3. iqx Open IQView GUI 

•	 If the iqx License dialogue box (Figure 26.22.1-4) is displayed, click on the 
Cancel button. 

	 The iqx IQView GUI (Figure 26.22.1-1) and either the iqx Sybase Database 
Logon GUI (Figure 26.22.1-2) or iqx Open IQView GUI (Figure 26.22.1-3) 
are displayed. 

10 If the iqx Sybase Database Logon GUI (Figure 26.22.1-2) is displayed, go to Step 16. 
11 If the iqx Open IQView GUI (Figure 26.22.1-3) is displayed and the desired IQView has 

been defined previously, perform Steps 12 through 14; otherwise, go to Step 15. 
• If IQViews have been defined previously, they are listed on the iqx Open 

IQView GUI (Figure 26.22.1-3); otherwise, a list of database tables is 
displayed. 

12	 If the desired IQView has been defined previously, highlight the IQView to be opened by 
clicking on its entry in the list of IQViews. 

13 Click on the OK button. 

 The iqx Sybase Database Logon GUI (Figure 26.22.1-2) is displayed. 

14 Go to Step 16. 
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Figure 26.22.1-4. iqx License Dialogue Box 

15	 If the iqx Open IQView GUI (Figure 26.22.1-3) is displayed and the desired IQView has 
not been defined previously, click on the Add Database… button. 

 The iqx Sybase Database Logon GUI (Figure 26.22.1-2) is displayed. 
16	 When the iqx Sybase Database Logon GUI (Figure 26.22.1-2) is displayed, type the 

appropriate entries in the following fields: 
• User: 
 For example: pdpsUsr 

 The DAAC Database Administrator can provide the actual values to be entered. 

 Password: 
 For example: dbpa$$wd 
 Database: 
 For example: pdps_TS1 
 Server: 
 For example: x0pls02_srvr 
 Click on the OK button. 
 Either the iqx Open IQView GUI (Figure 26.22.1-3) or the iqx IQView GUI (Figure 

26.22.1-1) is displayed. 
 If the iqx Open IQView GUI (Figure 26.22.1-3) is displayed, continue with Step 19; 

if the iqx IQView GUI (Figure 26.22.1-1) is displayed, go to Step 22. 
 Click on the New IQView… button. 
 The iqx Table Selection GUI (Figure 26.22.1-5) is displayed. 
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	 Move database table names between the Available Tables: and Selected Tables: 
lists as necessary by selecting (highlighting) the name of the table to be moved, then 
clicking on either the Select or Remove button (as applicable) to move the table name 
to the other list. 

	 Database tables and the columns within each table are described in the 311-series 
documents (e.g., 311-CD-503-001, Release 5A Planning and Data Processing 
Subsystem Database Design and Schema Specifications for the ECS Project). The 
documents are available on the ECS Data Handling System (i.e., at 
http://edhs1.gsfc.nasa.gov). 

21 When the desired table(s) has/have been moved to the Selected Tables: list, click on the 
OK button. 

• The iqx IQView GUI (Figure 26.22.1-1) is displayed. 
22 Select Output → Columnar from the pull-down menu. 

• The iqx Columnar Output GUI (Figure 26.22.1-6) is displayed. 
23 Move database table column names between the Available columns: and Selected 

columns: lists as necessary by selecting (highlighting) the column to be moved, then 
clicking on either the Select or Remove button (as applicable) to move the column name 
to the other list. 

• The order in which columns are listed in the Selected columns: list is the 
order in which the columns will be listed in the eventual report. 

• Database tables and the columns within each table are described in the 
311-series documents (e.g., 311-CD-503-001, Release 5A Planning and 
Data Processing Subsystem Database Design and Schema Specifications 
for the ECS Project). The documents are available on the ECS Data 
Handling System (i.e., at http://edhs1.gsfc.nasa.gov). 

24	 If changing the order in which columns are listed in the Selected columns: list, select 
(highlight) the column to be moved, then click on the Up or Down button as necessary to 
reposition the selected column. 
12. Highlighted column changes position in the Selected columns: list. 

25	 When the desired columns have been moved to the Selected columns: list, click on the 
OK button. 

• The iqx IQView GUI (Figure 26.22.1- 7) is displayed. 
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Figure 26.22.1-5. iqx Table Selection GUI
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Figure 26.22.1-6. iqx Columnar Output GUI


Figure 26.22.1-7. iqx IQView GUI
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• The columnar selections are listed on the iqx IQView GUI as shown in 
Figure 26.22.1-7. 

26 To generate a report make one of the following selections from the pull-down menu: 
•	 Execute → to Display – to display the report on the terminal screen. 

 The iqx IQ Output GUI (Figure 26.22.1-8) is displayed. 

 Go to Step 35 after viewing the report. 

•	 Execute → to Printer – to print the report. 

 The iqx Execute to Printer GUI (Figure 26.22.1-9) is displayed. 

 Go to Step 29. 

•	 Execute → to File – to save the report in a file. 

 The iqx Execute to File GUI (Figure 26.22.1-10) is displayed. 

 Continue with Step 27. 
27	 Type a valid path/filename in the Name: field of the iqx Execute to File GUI (Figure 

26.22.1-10). 
• For example: /home/cmshared/reportfile 

	 Where /home/cmshared/ represents the path and reportfile is the file 
name. 

28 Click on the OK button. 
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Figure 26.22.1-8. iqx IQ Output GUI 

Figure 26.22.1-9. iqx Execute to Printer GUI 
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Figure 26.22.1-10. iqx Execute to File GUI 

• Go to Step 35. 
29 Click on the Printer… button on the iqx Execute to Printer GUI (Figure 26.22.1- 9). 

• The iqx  Print Setup GUI (Figure 26.22.1- 11) is displayed. 
30	 To list the available printers, first click on the option button associated with the Printer 

field. 
• An option menu of printers is displayed. 

31 Highlight the desired printer in the option menu. 
• The desired printer is shown in the Printer field. 
• For example: Postscript printer one. 

32 If a report in landscape format is desired, click on the Landscape button. 
33 Click on the OK button. 

• The iqx  Print Setup GUI (Figure 26.22.1- 11) is dismissed. 
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Figure 26.22.1-11. iqx  Print Setup GUI 

• The iqx Execute to Printer GUI (Figure 26.22.1-9) is displayed. 
34 Click on the OK button. 
35 To save the procedure/IQView, continue with Step 36; otherwise go to Step 43. 
36 Select File → Save Procedure As… from the pull-down menu. 

• The iqx Save IQView GUI (Figure 26.22.1- 12) is displayed. 
37 Type a file name for the IQView in the name field. 
38 Click on one of the following buttons if applicable: 

• Public. 
• Public read only. 
• Private. 

39 Click on the OK button. 
• The iqx Save Procedure GUI (Figure 26.22.1-13) is displayed. 

40 Type a file name for the procedure in the name field. 
41 Click on one of the following buttons if applicable: 

• Public. 

26-233 611-CD-510-001




Figure 26.22.1-12. iqx Save IQView GUI 

Figure 26.22.1-13. iqx Save Procedure GUI 

• Public read only. 
• Private. 

42 Click on the OK button. 
43 Select File → Exit from the pull-down menu to exit from the iqx IQView GUI (Figure 

26.22.1- 1). 
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26.22.2 Formatting IQ Software Reports 
[TBS] 
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27. Inventory Logistical Management (ILM) 

27.1 XRP-II (Inventory Logistical Management {ILM}) 

ILM helps the M&O staff at the DAACs, EOC, and SMC to maintain records that describe all 
inventory components and their assembly structures and interdependencies. The database 
maintained by this tool, keeps chronological histories (a record of the transactions) of receipt, 
installation, and relocation of inventory items. ILM limits DAAC staff to accessing only those 
records, which correspond to equipment at their DAAC. 

ILM is a set of automated tools that will assist the Procurement, Property Management, 
Maintenance, and Logistics teams in managing the tangible property of NASA’s EOSDIS 
project. ILM is a heavily customized application developed utilizing the commercially available 
package XRP-II (Product Information and Inventory Management Modules). XRP-II is a 
manufacturing management system and its customization supports the required capabilities and 
functions of ILS. The application contains other functions beside the ILM tools. The ECS 
Management System Main Menu has selections for the Baseline Management tools which is not 
part of ILM. 

XRP-II is a legacy base application. The application consists of a hierarchical menu screen 
structure and an imbedded COTS database (UNIFY). The hierarchical menu structure is built 
upon character oriented. Once selected entered or deleted the actions cannot be reversed. In 
addition XRP/ILM is case sensitive. The vendor has customized the original screens to be ECS 
specific. The menu screens must be navigated to reach the appropriate ILM function. The 
lowest level of the structure is a function data screen that displays data and/or accepts data input 
for the function selected through the menu navigation process. While an operator is logged into 
the XRP-II program he/she is engaged in a database session. 

Use of the ILM tool involves considerations of the ECS business rules and general logistics 
concepts as applied on the ECS project. Some basic logistics definitions are provided below. 

Each inventory item is identified by a unique Equipment Inventory Number (EIN), and in case of 
hardware items a physical silver sticker with the EIN is placed on the item. The most significant 
relationship maintained among inventory items is product structure. Product structure is the 
XRP-II term for the parent-component pairings that define the ingredients – or bill of material -­
for an assembly. Product structures have corresponding active and inactive dates that establish 
the time frame during which the pairing is in effect. 
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27.2 ILM Operator Functions 

Each user/operator is assigned to a work group and the ILM menu options available are 
controlled based on the individual’s role. Note: roles can be added or changed according to user 
need. The following roles currently exist within ILM: 

• ILMADMIN All functions within the ILM 

• ILMADMND All functions require by DAAC System Administrator 

• ILMUSER All ILM operator privileges only 

• ILMLOG ILM Logistics User 

• ILMMAINT ILM Maintenance User 

• ILMMNTD ILM DAAC Maintenance User 

• ILMQUERY ILM User with query privileges only 

• ILMUPDT ILM User with update privileges only 

Additionally there is an XRP administrator (XRPADM) who will have all privileges and is 
responsible for the operation of the XRP application. Customization of individual operator 
privileges is done on an as needed basis by an ILM system Administrator. The system tools 
provide the functions to revise the user privileges. 

27.3 General Information 

27.3.1 Using XRP 

•	 The XRP application is case sensitive. It interprets data exactly as it is entered and takes 
the case of your input string into account. If something is in UPPER CASE, follow 
convention and put the request or data entry into UPPER CASE too. 

•	 Pressing the <ENTER> key after each entry is required. Otherwise, the data entered may 
not be processed. 

•	 The XRP application user interface is character based (not GUI). Keys handle 
navigation, selection, and moving. Each user interface screen has a set of active bottom 
line commands defining the keyboard letters, or function keys for activating functions or 
commands. 

•	 The mouse has limited capability with in ILM. ILM is not GUI driven; consequently, 
there is no cutting or pasting, placing the mouse pointer on an item and double clicking, 
etc. ILM is a character base system that requires the user to enter information, use 
bottom line commands, and press keys to start functions or commands. 
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27.3.2 ILM System 

•	 The ILM System was designed to assist in the tracking of Government Property items for 
each site and in a consolidated manner. 

•	 The ILM System is a character based, menu driven system based upon the UNIFY 
database. 

•	 Each screen provides the user with simple and quick one or two keystroke commands to 
control entry and editing of data. 

•	 System administrators have the ability to easily modify screens, menus, and reports to 
meet changing requirements and individual user needs. 

• Included are functions for transferring data between sites and the SMC. 

•	 Reports and screens at the SMC can provide consolidated views of material and 
requirements. 

27.4 Quick Start Using ILM 

ILM inherited a character-based user interface from the XRP-II application, employs screens for 
data entry and report generation, and menus for navigating to the screens. Data is entered via the 
keyboard in fields that are traversed from left to right, row by row. On data entry screens, labels 
for fields whose values can be modified are displayed in upper case; those that can not be 
modified have only the first letter capitalized. The database is updated every time a field’s value 
changes, and a record of that change is written to a transaction log. 

Most data entry screens have a form and a table view. Form views offer full screen layouts of a 
data record’s fields, whereas table views offer rows of records in a window that is panned to see 
columns of fields. Some screens’ table views, however, contain fewer fields than their 
corresponding form views. This is caused by system limitations on a table view’s panes. 

Numerous functions can be performed on the data entry screens. Commands available to an 
operator are screen-dependent and are listed near the bottom of each screen (hence their name: 
bottom-line commands). The more command helps the operator cycle through them. The 
terminology used can be confusing. “Mode” is used in two different ways: 1) as used in the next 
paragraph to describe data impact (Add, Insert, or Modify) and 2) the F4-mode of keyboard 
impact on the selected field in the display. 

It is important to note that the UNIFY database management system XRP-II uses does not 
support rules requiring entries in specific fields. ILM attempts some enforcement via the data 
entry screens, either by establishing default values where feasible when new records are created, 
or by blocking an operator from advancing the cursor past a null field when in Add, Insert, or 
Modify modes. However, database updates can occur in ways that bypass these mechanisms, so 
operators must ensure required data is entered. 

27.4.1 Invoking ILM from the Command Line Interface 
To invoke the ILM program the operator must be logged in to the appropriate server and be 
registered with XRP for the appropriate privileges. 
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To execute ILM from the command line prompt use: 
ilmusr 

This script solicits the identity of the operator’s workstation. When prompted the operator must 
provide either the workstation name or its IP address. This information is normally posted on a 
sticker on the workstation monitor. The script then starts XRP-II, and passes to the operator’s 
userid it obtained from the system. The screen that is displayed after the XRP-II login is 
determined by XRP-II based on the user’s ID and password. 

Upon entering a valid userid and password the initial screen for the user will be displayed. The 
initial screen is associated with a specific userid/password. ILM users will be assigned to 
Groups according to the role for which their userid/password is valid. ILM privileges are 
dependent on the Group assignment. ILM privileges include function selections, data 
modification capability and report selection. The configuration of the initial screen, screen 
modes, and function selection may result in the display of a data screen that is not exactly as 
shown in the presentation below. 

Table 27.4.1-1. Procedures to Log into ILM 

Remember to press <ENTER> after each field. 

27.5 Commands and Functionality 

The bottom line commands for each menu screen functions the same as the main menu. Each 
data screen also has bottom line commands. Generally, the bottom line commands that are 
invoked with the single letter in bold print. For commands with an “already used” first letter, a 
slash, “/”, is used as part of the command an example this would be /s command. A period, “.” is 
used for the third occurrence of a leading letter. 

Note that the bottom line commands appearing on any screen are dependent on the user’s 
attributes. Not all the commands listed for a screen may be appropriate to specific users. 

A set of “standard” bottom line commands occurs on nearly all the ILM data screens. 

While entering data into ILM you may notice that /zoom appears at the bottom of the screen for a 
given field. This is an indication that a ZOOM list is available to assist with data entry 
selections. 

The following sections discuss each of the command and function keys in ILM. Table 27.5-1 
describes menu function keys. 

PERFORM ACTION 

Log on to XRP server at local site At the Unix prompt type ‘telnet <XRP server at local site>’ 

Provide log in information At the login prompt 
A. Enter login name and press ‘enter’ 
B. Enter password and press ‘enter’ 

Invoke ILM and display on 
the screen 

A. Type ‘ilm’ and press ‘enter’ 
B. Type ‘ilmusr’ and press ‘enter’ 
C. Enter hostname, or IP address of the machine you are 

working on, so XRP knows where to display the screen 
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All ILM menus are similar in appearance and function the same way. Only the titles and 
selections vary. 

Table 27.5-1. XRP-II menu Function Key bottom commands 

F1 Function Key 1 - help Get a description for the highlighted option


F3 Function Key 3 or control p - prior menu Move back to the previous menu


F5 Function Key 5 or control b - select Select the highlighted option


F8 Function Key 8 or control d - exit Exit the tool (XRP-II to the Unix command line)


27.5.1 Cursor Motion 

The four arrow keys (UP, DOWN, LEFT and RIGHT) are used to move the cursor to various 
fields of the screen. A number may be entered before depressing an arrow key in order to move 
to the cursor multiple fields at once. The current number that has been entered is displayed at the 
bottom left hand corner of the screen. If a DOWN arrow is entered when the cursor is at the 
bottom of a table view screen, then, assuming there is more data in the file, the screen is redrawn 
to display the data shifted a half page down. Similarly, the display may be shifted a half page 
upwards by entering an UP arrow at the top of the screen. Cursor motion via the arrow keys is 
limited to the current page plus a half-page shift. 

27.5.2 Next or Prior 

The bottom line “n” (Next) and “p” (Prior), when in the form view (one record on the screen) 
these commands move the display to the next or prior record. When in the table view (multiple 
records per screen) these commands move to the next or prior page of records. A number may 
be entered prior to the command as in “10n” which advances the display 10 records when in the 
form view or ten pages when in the table view. 

27.5.3 View Command 

This command toggles the display between the form and table views of the data. The table view 
shows basic information for several records at once. The form view shows all of the fields of the 
current record. For records with too many fields to fit across the screen when in the table view, 
the Left, Right, and justify commands described later may be used to move the display to the left 
or right. 

27.5.4 Find Command 

This command is used to find a record based on data entered. Data may be entered at one or 
more fields of the display and a partial string may be entered. Datalook (is a utility that searches 
the database for specified information) to clear the screen and allows the user to enter data into 
one or more fields to find. Pressing “F5” begins the search. 
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27.5.5 Go Command 

The Go command allows the user to go to the First record, Last record, or the specified record 
number. To use the Go command type ‘g’ for Go. A prompt will come up stating “GO: First, 
Last, or Record Number, or Quit?” Type in the first letter to specify where to go (i.e. enter ‘ f’ 
for first record). The entry of a number followed by ‘g’ for Go causes the display to shift to the 
specified record number. For example: 

0g or g or 1g moves to the start of the file 
10g moves the cursor to record 10 
1000g moves the cursor to record 1000 

27.5.6 Select Command 

The bottom line ‘s’ (Select) command allows you to select a subset of all the records in order to 
view, edit, or report on them. Once a set has been selected, the select command may be used 
again to select a subset of the set. 

27.5.7 Selection Criteria 

Data may be entered at one or more fields in order to specify the records to be selected. The 
selection function may be initiated either from the table or form views, but sometimes it is 
necessary to first switch to the form view if there is insufficient room to enter the desired 
selection specifications when in the table view. 

There are two basic kinds of selection capability: 
a . 	 Exact matching, where the user types exactly what the selected records are to 

contain. 
b.	 Inexact matching, where special characters are entered which are expanded into 

patterns during the matching process. The inexact matching provisions described 
below also apply to range fields (i.e. Account Number or Range). 

Some examples of inexact matches are numeric and date ranges ( for example, numbers from 1 
to 100, dates before 1/1/87, or dates from 3/1/87 to 4/1/87), or substring matching (all the strings 
that contain the name “Smith”). 

27.5.7.1 Exact Matches 

To specify an Exact match, simply fill in the field or fields on the screen with the exact data to 
select for. 

27.5.7.2 Inexact matches on String Fields 

To specify an inexact match on string fields, use the following special characters. 

?	 The “wild character”. The question mark matches any single character. Thus to find all 
the Smith’s whether spelled “Smith” or “Smyth”, use the specification “Sm?th” 

*	 The “wild string’. The asterisk matches any string of characters of any length, including 
zero length strings (also called “null strings”). A * is automatically appended to the end 
of all string specifications. 
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[…]	 The character class framed by the brackets matches any single character that is a member 
of the class. For example, [apq] matches any of the letters a, p or q. Ranges of characters 
may be specified by separating 2 characters by a dash (“-“). All upper case letters could 
be represented by the class [ABCDEFGHIJKL-MNOPQRRSTUVWXYZ] or more 
conveniently as [A-Z]. All letters, upper and lower case together, can be represented as 
[a-Z]. Other classes can be similarly constructed. 

If the string field contains numbers (eg. H0002) and the user wishes to inexact match on a 
range of these numbers it is important to understand that ranges within strings behave 
differently than ranges within numeric fields. For example a good range for a numeric 
field could be 1-9999. This is defined by the system to be all numbers >=1 and <=9999. 
However, the range of [H00001-H99999] for a string would be defined as all strings 
starting with the letter H, or the numbers 0 and 9, or characters falling in the range of 1-
H. If the user wanted to select all fields of H00001 through H9999, he could use H[0­
9][0-9][0-9][0-9][0-9] if space permits. 

27.5.7.3 Inexact Matches on Numeric Fields 

Inexact matches on numeric fields, including dates and times, can be constructed by the 
Following set of expressions. 

>f1 The “greater than” operation. All fields with values greater than the entered value will 
match. 

<f1 The “less than” operation. All fields with values less than the entered value will match. 
!f1 The logical “not” operation. All fields that do not match the entered value will match. 
F1-f2 The “range” operation. All field values that match the entered values, or are between the 

entered values will match. This is equivalent to >=f1 AND <=f2. 
!f1-f2 This expression matches all field values that are outside the range of entered values. This 

is equivalent to <f1 OR >f2. 

Any number of fields on the screen can be filled in as described above. The result is to select 
from the records of the file those which match all of the entered values. Once a set of records 
has been selected in this manner, Datalook displays the selected records. 

27.5.8 Sort Command 

The bottom line “/S” (Sort) command allows the current records to be sorted via any field or 
fields of the screen. Enter a number (1, 2,…) at each of the fields to be included in the sort, in 
the order they are to be included. Then press “F5” command to initiate the sort. 

If a negative number is entered at a field, that field is sorted in descending order instead of the 
default ascending order. 

27.5.9 Note Command 

This command activates a text area for the user to write notes about the displayed screen. The 
information is retrieve by the same user when in the same screen. 

27.5.10 Add/Insert 
These commands are used to add new records. The bottom line “/I” (Insert) command adds a 
new record or records before the current record while the bottom line “/a” (Add) command adds 
a new record or records after the current record. 
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27.5.11 Modify Command 
The bottom line “/m” (Modify) command is used to modify one or more fields of existing 
records. After modifying each field the cursor moves to the next field in the default direction, 
down in form view, or right in table view. Press “F3” to exit modify mode. 

27.5.12 Delete Command 
The bottom line “/d” (Delete) command offers a choice of deleting “line-by-line” or multiple 
records at once. If the “line-by-line” option is selected each entry of a down arrow deletes the 
current record. If, instead, a number is entered, the logic deletes the specified number of records. 

27.5.13 Write, Execute Command 

These commands appear only on screens that can drive an executable function. The bottom line 
“w” (Write) command is used to save the current record of the screen in a file named by the user. 
This file may then be referenced in a UNIX script that executes the function in BATCH mode. 
The bottom line “e” (Execute) command is used once the screen data is edited in order to start 
execution of the underlying function. 

27.5.14 Items Command 

The bottom line “I” (Items) command appears only on header-line item combination screens, 
such as are used for Purchase order or Work Order. When on the EIN menu (header record) 
pressing “I” activates the item screen. 

27.5.15 Help Command 

The bottom line “h” (Help) command on the main menu provides information concerning the 
screen, the fields of the screen, or Datalook commands. If the commands option is selected you 
may enter the letter or prefix plus letter that activates the command to see the help information 
for that command. 

27.5.16 More Command 

The “m” (More) command cycles the bottom line prompt through all of the available menu 
choices. 

27.5.17 Quit Command 

The bottom line “q” (Quit) command exits the screen. 

27.5.18 Zoom Command 

When the cursor is at a field which is related to data in a different table of the database, the 
bottom line “/z” (Zoom) command appears at the right of the screen. If the command is 
executed, Datalook opens a window to a different screen which displays the related data. The 
standard commands (Find, Go, Next, Prior, or arrows) may be used on the data in the window. 
If the user tags the field (the tag command is described later) and exits the zoom screen, the 
tagged value is returned to the initial screen. The “/z” (Zoom) option also appears when it is 
applicable while adding records or modifying fields. 
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27.5.19 Left, Right, Justify Commands 

They allow the data window to be shifted left or right for screens, which have, too may fields to 
be shown on one page. The bottom line “j” (Justify) command causes the page to start with the 
current field at the left. 

27.5.20 Tag, Untag Command 

Tagged fields are used to identify default field values to be used when adding records or copying 
data into one or more records. If the user enters the “t” (Tag) command when the cursor is at a 
specified field, the field is tagged. This highlighted field in a manner (such as reverse video, or 
half intensity, depending on how the screen has been interfaced to the UNIX operating system). 
Only one field in a specific column of fields may be tagged at a time. A tagged field may be 
untagged either by entering the “t” (Tag) command again when the cursor is at that field, or by 
tagging some other field in the same column, or by entering the “u” (Untag) command which 
untags tagged fields. A tagged field remains tagged whether or not it is on the current screen 
until it is untagged. 

27.5.21 Report Command 

The bottom line “/r” (Report) command has a series of submenus which identify the report, its 
parameters, and the destination of the report. Every database maintenance screen has three built­
in reports: 

a. a “Table Report” which follows the format of a table view screen, but adds a report 
header and pagination 

b. a “Form Report” which provides a single-page report of the form view for the current 
record 

c. An “ASCII Report” which displays the data in ASCII form without headers and 
pagination, suitable for loading into a spreadsheet or transmitting to another computer. 

27.5.21.1 Selecting Records for Printing 

Before printing a Table Report or an ASCII Report, the user may select a subset of records via 
the Select function. If no preselection has been performed, Datalook displays the numbers of the 
first and last records in the file and allows the user to accept these as the range of records to be 
reported on, or to modify them in order to report on a subset of the records. The first page of a 
table report shows the criteria used to select the records. 

27.5.21.2 Column Selection 

On Entering the Report Command, the user has the option of specifying the columns and the 
order in which they should be printed in a Table Report. If you do not specify the columns, the 
report starts with the left-most field screen and includes as many columns to the right as 
specified. The left-most field of the report may be controlled via the Left, Right, and Justify 
commands. 
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27.5.21.3 Report Format 

The default ASCII Report format consists of data in ASCII form with fields separated by pipe (|) 
symbols. To generate a formatted report on a subset of the records, execute the select function 
before executing report. 

27.5.21.4 Report Destinations 

Once a report has been specified, Datalook offers the user a choice of report destinations. These 
choices may be 1) screen, 2) file, or 3) local printer. 

If the report is not being sent to the screen, the user can specify whether or not it is to be run in 
background. 

Once a report and destination have been chosen, the logic verifies that the width of the report is 
supported by the destination. If necessary, it retrieves the control characters necessary to put the 
output device into a mode such that it can support the width. If the report is too wide for the 
maximum width supported by the output device, the user is cautioned and may alter the 
destination or choose to proceed regardless. 

27.6 ECS Management System Main Menu 

The XRP top-level menu is ECS Management System Main Menu. The userid/password 
configured initial screen will generally be different for the operator. The ECS Management 
System Main Menu contains selections that are not ILM functions. Baseline Management is 
cover in a separate document. 

Figure 27.6-1. ECS Management System Main Menu 

27-10 611-CD-510-001




Table 27.6-1. Main Menu Functions


Menu item Function Section 

Baseline Management Provides access to XRP-II functions for maintaining 
control item and bill of material information 

Refer to BLM 
section of 609 

ILM Main Menu Provides access to XRP-II functions for maintaining 
inventory, logistics, and maintenance information 

27.6.2 

System Utilities Menu Provides access to XRP-II functions for maintaining 
system information that spans functional domains 

27.12 

System Tools Provides access to aids for registering XRP-II users, 
assigning permission, customizing data entry screens 
and menus, and performing general-purpose database 
dumps and loads. 

27.13 

27.6.1 ILM Main Menu 

This menu (Figure 27.6.1-1) provides access to ILM functions for maintaining inventory, 
logistics, and maintenance information. The sections following focus on the functions and 
features that are part of the ILM main menu. 

Figure 27.6.1-1. ECS Management System ILM Main Menu 

The ILM Main Menu lets the operators navigate to the following submenus: 
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Table 27.6.1-1. ILM Main Menu Functions


Menu item Function Section 

EIN Menu For browsing the catalog of EIN-controlled items 27.7 

EIN Transactions For browsing the log of all inventory transactions 
performed on items in the database 

27.8 

ILM Report Menu For producing pre-defined reports 27.9 

Maintenance Menu For managing maintenance actions and data 27.10 

ILM Master Menu For browsing ILM parameters and reference information 27.11 

27.7  EIN Menu 

Options provided on this menu allow the operator to navigate to a set of screens for accessing the 
inventory information. 

Figure 27.7-1. EIN Menu 

The EIN menu is broken down into the following functions. 

Table 27.7-1. EIN Menu options 
Menu item Function Section 

EIN Structure Manager For browsing EIN structures for items at the local site 27.7.1 

EIN Manager For browsing data describing EINs at the local site 27.7.2 

The following pages describe the screens, the data, and the process for reviewing EIN Controlled 
items data. Each selection item on the EIN menu is discussed, in the order on the menu screen. 
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27.7.1 EIN Structure Manager 

This screen is designed to display structure for a machine and items attached to it. This screen 
will only be presented to the user in INQUIRY mode. All changes to the database via this screen 
are reserved to the ILS Property Administrator and will not be active at the DAACs. 

Figure 27.7.1-1. EIN Structure Manager Screen


Table 27.7.1-1. EIN Structure Manager Field Descriptions

Field Name Data Type Size Description 

PARENT EIN String 20 Parent EIN for the installation/structure. 

Engineering 
Change 

String 8 Engineering change number assigned when the record was 
added to the database. 

OEM Part String 34 OEM part number of the parent EIN 

OEM Desc String 40 OEM Description of the Parent EIN. 

ECS Name String 30 Name of the machine with which the item is associated. 

Installation Report Number 4 Installation report number assigned by the system when an 
installation had occurred. 

Ship Report Number 3 Shipping report number assigned by the system when the item 
was shipped. 

PO NUMBER String 10 Purchase order number against which the parent EIN was 
received. 

VENDOR String 6 Vendor code from whom the item was purchased 

Date Entered Date 2 Date when this record was added to the database 

Operator ID String 8 Login ID of the user who added this item to the database and is 
not modifiable by the user. 

ACTIVE DATE Date 2 Date the item is received and entered into inventory. 

INACTIVE DATE Date 2 Date to make the structure ineffective. 
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27.7.1.2 Item Page of the Structure Manager 

This screen is designed to view children items for the Parent EIN entered on the header page. 
This screen always comes up in Table view. 

Figure 27.7.1-2. EIN Structure Manager Items page screen 

Table 27.7.1-2. Items Page Field Descriptions 
Field Name Data Type Size Description 

EIN CHILD String 20 Child EIN number of the item assigned to the Parent EIN. 

OEM PART String 34 OEM Part Number reflected from the EIN record of the child. 

OEM DESC String 40 OEM Description reflected from the EIN record of the child. 

MOD/VER String 24 Model/Version reflected from the EIN record of the child. 

QTY PER Number 3 This field is used more for consumable material application the 
parent items and reflects the quantity of the item that had been 
applied to the parent. This field defaults to quantity of one when 
the record is added. Database changes are reserved to the ILS 
PA 

ACTIVE DATE Date 2 Effective date on which the EIN child is assigned to the Parent 
EIN. NOTE: **/**/** = earliest system date. 

INACTIVE DATE Date 2 Effective date on which the EIN child is no longer assigned to the 
Parent EIN. NOTE: **/**/** = latest system date. 

27.7.1.3 Checking the relationship status between Parent and its Children 

The EIN Structure Manager enables the user to check and verify all the parts associated with a 
parent equipment. It lets the user identify whether a particular part is in use or inactive specified 
by the component’s active and inactive date. It is also a pathway to gaining information about 
each child. 
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* 	Information needed beforehand: 

-Parent EIN 

Table 27.7.1-3. Procedure to Check relationship between Parent and its Children 
Perform Action 

Navigate to EIN Manager 
screen 

A. Select ILM Main Menu – press ‘enter’ 
B. Select EIN Menu – press ‘enter’ 
C. Select EIN Structure Manager – press ‘enter’ 

To find the parent EIN of 
interest and view its structure 

A. Press ‘f’ to invoke the find command 
B. Enter the Parent EIN to find 
C. Press ‘F5’ to start the search 
D. Press ‘I’ to view the components 

Exit Press ‘F3’ to exit the item page 

Remember to press <ENTER> after each field. 

27.7.2 EIN Manager 

This screen is designed to view ILM EIN controlled items. This screen is always presented in 
the INQUIRY mode. The operator may sort and select on any field on the screen and print ad 
hoc reports of sorted data, if desired, using XRP-II’s report command. Refer to section 27.5.21 
for instruction to generate ad hoc reports. All changes to the database via this screen are 
reserved to the ILS Property Administrator and that function will not be active at the DAAC's 

Figure 27.7.2-1. EIN MANAGER Screen 
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Table 27.7.2-1. EIN Manager Field Description (1 of 2)

Field Name Data 

Type 
Size Description 

EIN String 20 Identifier for an EIN-controlled inventory item. 

ECS NAME String 30 Name of the machine with which the item is associated 

SERIAL NUMBER String 30 Serial number of the item 

HDWSFT CODE String 10 Code for classifying inventory items by type. 

MODEL/VERSION String 24 Model or version of the item 

MFG String 6 Code used for the manufacturer. 

OEM PART 
NUMBER 

String 34 Manufacturer or Vendor’s part number. 

OEM 
DESCRIPTION 

String 40 Description of the OEM PART NUMBER entered in the field 
above. 

YEAR MFG String 4 Year the item was manufactured. 

RECEIVE DATE Date 2 Date item was received from vendor 

VENDOR String 6 Vendor code whom the item was purchased from. 

SOFTWARE LIC 
NUM 

String 10 License number for a software type license item. 

MAINT VENDOR String 6 Code for the vendor who is the maintenance vendor. 

WARRANTY EXP 
DATE 

Date 8 End date for the warranty period. This field default to 365 days 
from the date of entry. 

MAINT 
CONTRACT 

String 15 Maintenance Contract number for maintenance on this 
particular item. 

STATUS CODE String 1 Status of the item and is controlled by transactions within the 
system. The following codes are included : R - Received; S – 
Shipped; I - Installed; A – Archived, and T-Transferred; 

CONTROL ITEM ID String 20 Identifier of the corresponding, version-controlled item in the 
Baseline Management system. 

NASA CONTRACT String 11 NASA contract number used for this item. The default number 
is NAS5-60000. 

PO Number String 10 Purchase order number against which the item was received. 

Tran Code Number 3 This field designates the transaction code. The value will 
always be set to ‘03’ 

Report Number Number 4 Installation report number assigned by the system when an 
installation had occurred. 

LOCATION String 8 The actual location or site of where the item is. 

BUILDING String 6 Building number within the site where the item is. 

ROOM String 6 Room number where the item is or will be shipped to. 

RMA# String 6 Reliability Maintainability Availability number. 

RELEASE CODE String 10 Code for distinguishing the release status of the item. 
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Table 27.7.2-1. EIN Manager Field Description (2 of 2)

Field Name Data 

Type 
Size Description 

Installation Date Date 2 The actual date this item was installed. The system sets the 
value during EIN installation processing. 

Shipping Report 
Number 

Number 2 Report number assigned to this item when the item was 
shipped. 

USER String 8 The user code of the person who has the item. 

COMMENT String 60 Miscellaneous information specific to the item. 

NOTE String 60 A message that can be associated with the item. 

Table 27.7.2-2. Procedure to Inquiry for EIN

Perform Action 

Navigate to EIN Manager 
screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select EIN Menu – press ‘enter’ 
C. Select EIN Manager – press ‘enter’ 

To look for records of interest A. Press ‘f’ to do a Find or ‘s’ to do a Select 
B. Enter the selection parameters (refer section 27.5.6 for a more detail 

instruction on advance selection) 
C. Press ‘F5’ to start the search 

To view the Bill of Material of 
the selected record 

There is a command on the bottom of the screen call ‘Bom’ (Bill of 
Material). The Bom command lists the components of the selected item. If 
the selected item does not have any component attached to it, ILM will 
state that ‘No records available’. To invoke the Bom command, press ‘b’. 

To find the parent EIN of the 
selected item 

The ‘Where’ command at the bottom of the screen lists all the parents that 
the selected item has been assigned to and the associated active and 
inactive date. 

Exit out of the current function 
or screen 

Press ‘F3’ to 

Remember to press <ENTER> after each field. 

27.8 EIN Transactions 

The EIN Transactions menu (Figure 27.8-1) provides access to a screen for browsing the log of 
past inventory transactions. 
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Figure 27.8-1. EIN Transactions 

27.8.1 Inventory Transaction Query Screen 

This screen allows operators to browse the log of all inventory transactions performed on items 
in the database. The operator may sort and select on any field on the screen and print ad hoc 
reports of sorted data, if desired, using XRP-II’s report command. Table 27.8.1-1 describes the 
screen’s fields. 

Figure. 27.8.1-1. Inventory Transaction Query Screen 
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Table 27.8.1-1. Inventory Transactions Query Field Descriptions

Field Name Data Type Size Description 

Site String 6 Code for the site that entered the transaction. 

Number Numeric 8 Record number of database record being observed. 

Type of 
Transaction 

String 3 Code assigned to the type of transaction being performed. 
INS – Installation; REL = Relocation; TR = Transfer; ARC = 
Archive; SHP = Shipment; RX = Receipt; 

Date Date 2 Date the transaction was entered. 

Time Time 2 Time the transaction was entered. 

Dest Site String 6 Code for the inventory location gaining the item. 

EIN String 20 EIN of the item involved in the transaction. The operator 
may zoom to the EIN table and choose an EIN, if it had been 
entered there previously. (See the EIN Manager screen.) 

Dest Bldg String 6 Identifier for the building gaining the item. 

Transaction Id Numeric 6 Number assigned to a particular transaction 

Room String 6 Number for the room gaining the item. 

Vendor Id String 6 Code for the vendor from whom the item was purchsed. 

Parent EIN String 20 EIN of the parent item involved in the transaction. 

Order Type String 2 Code for the type of order, if any, involved in the transaction. 
PO = purchase order; SO = sales order; WO = work order; 
VR = Return to vendor; CR = return from customer. 

From Site String 6 Identifier for the building losing the item. 

Order String 6 Identifier for the order, if any, involved in the transaction. 

From Bldg String 6 Identifier for the building losing the item. 

Line No. Numeric 4 Line number of the item on the order if an order is associated 
with the transaction. 

Room String 6 Number of the room losing the item. 

Parent EIN String 20 EIN of the parent item losing the item. The operator may 
zoom to the EIN table and choose an EIN, if it had been 
entered there previously. (See the EIN Entry Manager 
screen.) 

Quantity Floating 10.1 Number of items in the transaction. 

CCR # String 30 Identifier for the CCR authorizing the transaction. 

Tt String 15 Identifier for the trouble ticket associated with the transaction. 

Operator Id String 8 Login ID of the operator performing the transaction. 

Reason Code String 4 Code for the reason for the transaction. 
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27.9 ILM Report Menu 

ILM Report Menu provides access to display and report controlled items in the database. This 
section of ILM is mainly used for reporting purposes. The ILM Report menu lets the users 
navigate to the following screens: 

Figure 27.9-1. Report Menu 

Table 27.9-1. ILM Reports Menu options 
Menu item Function Section 

EIN Structure 
reports 

For printing all designated parents and components in a 
multi-level bill report. 

27.9.1 

Install/Receipt 
Report 

For printing a report of a parent EIN configuration and send 
the hard copy to the receiving organization for sign off. 

27.9.2 

Installation Summary 
Report 

For printing a list of EINs installed during a specified time 
frame 

27.9.3 
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27.9.1 EIN Structure Reports 

This screen is designed to retrieve and print all designated parents and components in a multi­
level bill report. Table 27.9.1-1 describes the screen’s fields. Table 27.9.1-2 provides 
instruction how to generate the report. Refer to figure 27.9.1-2 for a sample report. 

Figure 27.9.1-1. EIN Structure Reports Screen 

Table 27.9.1-1. EIN Structure Reports Field Descriptions 
Field Name Data Type Size Description 

EIN or RANGE String 20 Field can accept two 20 character strings. E.g. 00001234­
00003456 for a range 

NUMBER OF 
LEVELS TO 
EXPLODE 

Number 2 Number of levels to display for a particular parent structure. 

EXPLOSION 
QUANTITY 

Number 2 Quantity of each EIN to reflect in the report 

DATE OF BILL Date 2 “As of” date used in selecting records from configuration 
history of the item 

TYPE OF SORT String 1 Null = part, S=Sort string N = Sort number 

NOTE 1, NOTE 2 String 40 A 40 character note to include in the report. 

EIN MULTI-
LEVEL REPORT 

Number 2 Number of copies of this report to generate. 

27-21 611-CD-510-001




Table 27.9.1-2. Procedures to generate EIN structure reports

PERFORM ACTION 

Navigate to EIN Structure Reports 
screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select ILM Report Menu – press ‘enter’ 
C. Select EIN Structure Reports – press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Enter parameters for the report Fill in the necessary information 
A. Enter EIN number or zoom to the EIN data file to pick the EIN 

to report. To do this, press (‘/z’, ‘t’, ‘F3’). 
B. Enter Number of levels to display 
C. Enter explosion quantity of each EIN to reflect in the report 
D. Enter the date of Bill used in selecting records 
E. Enter the type of sort. 

-null = part 
-‘s’ = sort string 
-‘n’ =sort # 

F. Enter any note to appeal on the report header 
G. Enter number of copies of the report to generate 

Exit the add mode Press 'F3' to exit adds mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
A. Enter 1 and press ‘enter’– to view the report on the screen 
B. Enter 2 and press ‘enter’ – to save the report into a file. 

Enter the file name to be saved as. The file will be saved in 
the user’s home directory. 

C. Enter 3 and press ‘enter’ – to print the report to the defaulted 
printer 

Navigate through the report output A. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hardcopy of the report 

B. After finished making the selection, press ‘q’ to exit the report 
screen. A message will come up specifying the number of 
reports generated, press ‘enter’. 

C. Another message will prompt “Another?” 
-Press ‘y’ to generate more reports. This will go back to the 
EIN Structure Reports screen, or 
-Press ‘n’ to go back to the ILM Report Menu. 

Remember to press <ENTER> after each field. 
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 (einstrep) DATE: 
ECS Development Facility PAGE: 
EINs: 00001029 Number of levels: 99 
Explosion quantity: 1 Date of bill: **/**/** 

------------------------------------------------------------------------------------------------------------------------------------------------------------
Parent EIN: 00001029 Desc: SPARCStation 20-50 SX 
MFG Part: S20SX-50-32-P46 SPARCStation 20-50 SX 
Active date: **/**/** 

QUANTITY 
LEVEL PER DATE 
============ =========== 
1 0.0000 

Tape Stacker - 8 MM 
.2 0.0000 

BAR CODE READER/EXB-210 & 218 
.2 0.0000 

8MM Tape Drive 
.2 0.0000 

Terminator 
.2 0.0000 

Tape Cartridge - 8 MM 
.2 0.0000 

Cable - SCSI 
.2 0.0000 

Tapes - 5 GB - 8 MM 
.2 0.0000 

8 MM Tape Drive - w/ Carrige Instal 
1 0.0000 

20 Inch Color Monitor 
1 0.0000 

Yamaha External 4X Write/4X Read CD-Rom 
1 0.0000 

2.1 GB HD MultiPack (1 of 2 X 2.1=4.2GB) 
.2 0.0000 

2.1 GB HD Internal 
1 0.0000 

Solaris 
There are 38 components in this bill. 

15:20 TIME 01/05/00 
EIN STRUCTURE REPORT 1 

Desc: 
Inactive date: **/**/** 

INACTIVE ACTIVE 
MODEL/VERSION CONTROL ITEM ID MFG PART EIN DATE 

========================= ==================== ================================== ==================== ======== ======== 
210 EXB-210TW 00000751 **/**/** 04/12/99 

315570-001 C0003845 **/**/** 04/12/99 

872013-025 C0003846 **/**/** 04/12/99 

EXB-303220 C0003847 **/**/** 04/12/99 

EXB-30726 C0003848 **/**/** 04/12/99 

EXB-307627 C0003849 **/**/** 04/12/99 

TDKP6-1200Q C0003850 **/**/** 04/12/99 

872013-025 C0162102 **/**/** 09/01/99 

365-1324-01 00001086 **/**/** 04/12/99 

4X CDE-100 00003089 **/**/** 04/12/99 

X5511A 00004692 **/**/** 04/12/99 

540-2730-03 C0021164 **/**/** 04/12/99 

2.4 SOL C0147699 **/**/** 04/22/99 

Figure 27.9.1-2. EIN Structure Report
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27.9.2 Install/Receipt Report 

This screen is designed to allow the user to print a report of a parent EIN configuration and send 
the hard copy to the receiving organization for sign off. Refer to Figure 27.9.2-2 for a sample 
report. Table 27.9.2-1 describes the screen’s fields, and Table 27.9.2-2 gives the procedure on 
how to generate the report. 

Figure 27.9.2-1. Install/Receipt Report Screen 

Table 27.9.2-1. Install/Receipt Report Field Descriptions 
Field Name Data Type Size Description 

PARENT EIN String 20 EIN for the parent item in an EIN structure. The operator may 
zoom to the EIN table and choose the EIN, if it had been 
entered there previously. (See the EIN Entry section.) 

ECS Name through 
Old User 

Multi 
Fields 

30 These fields reflect according to the Parent EIN entered. 

INSTALL/RECEIPT 
REPORT 

Number 2 Number of copies of this report to generate. 
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 Table 27.9.2-2 Procedures to generate Install/Receipt reports

PERFORM ACTION 

Navigate to Install/Receipt Reports 
screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select ILM Report Menu - press ‘enter’ 
C. Select Install/Receipt Reports - press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Enter report’s parameters Fill in the necessary information 
A. Enter Parent EIN or zoom to the EIN data file to select the 

EIN of interest. To do this, press (‘/z’, ‘t’, ‘F3”). 
B. ECS Name through Old User – these fields are reflected from 

the Parent EIN you entered above. 
C. Enter number of copies for the Install/Receipt Report. 

Exit the add mode Press ‘F3’ to exit add mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
D. Enter 1 and press ‘enter’– to view the report on the screen 
E. Enter 2 and press ‘enter’ – to save the report into a file. 

Enter the file name to be saved as. The file will be saved in 
the user’s home directory. 

F. Enter 3 and press ‘enter’ – to print the report to the defaulted 
printer 

Navigate through the report output D. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hard copy of the report 

E. After finished making the selection, press ‘q’ to exit the report 
screen. A message will come up specifying the number of 
reports generated, press ‘enter’. 

F. Another message will prompt “Another?” 
-Press ‘y’ to generate more reports. This will go back to the 
Install/Receipt Report screen, or 
-Press ‘n’ to go back to the ILM Report Menu. 

Remember to press <ENTER> after each field. 
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RUN DATE: 01/05/00 Page No: 1 
EOSDIS 

EQUIMENT INSTALLATION/RECEIPT REPORT 
BY ECN NUMBER 

ECN NUMBER: 00002534 USER CONTACT

DATE ON-SITE WARRANTY EXPIRES: 12/31/98 USER PHONE

WARRANTY END DATE: 12/31/98 LOCATION: Goddard

HTSC HELP CENTER PHONE: 1-800-ECS-DATA BUILDING # GSFC

HTSC HELP CENTER HOURS ARE: 08:00 - 17:00 EST ROOM #: C101

DATE RECEIVED: 05/09/97 HOST NAME: g0acs03


I certify that I have received the equipment only for work associated with NASA Contract NAS5 - 60000.


Signature: _____________________________________________________________________________________ Date:___/___/___


INSTALL 
MFR PRODUCT DESCRIPTION MODEL/VERSION PART NUMBER SERIAL NUMBER PART ECN DATE 
==================================================================================================================================== 
SUN Enterprize 3000 Enc, 4 Slot, CD 4, PWR/C E3001 715V006C 00002534 05/27/97 
WYE Terminal 900983-07 0ICD6800046 00003256 03/13/98 
WYE Keyboard 901867-01 97030769 00006417 05/27/97 
SUN 2.1 GB Internal HD X5153A 9644628234 C0009199 08/12/99 
SUN 250mhz Ultrasparc Modual 2530A 92F30203138 C0014226 05/27/97 
SUN 250mhz Ultrasparc Modual 2530A 92F30202448 C0014227 05/27/97 
SUN CPU/Memory Board 2600A 5012976058254 C0014228 05/27/97 
SUN SBUS I/O Board - Enterprise Family 2610A 5014287011120 C0014229 05/27/97 
SUN CD ROM - Internal 370-2203-01 9715003781 C0014230 05/27/97 
SUN 9.1 GB HD - 7200 RPM-3.5 Inch-F/W SCSI-2 540-2951-01 9707363003 C0014231 05/27/97 
SUN 9.1 GB HD - 7200 RPM-3.5 Inch-F/W SCSI-2 540-2951-01 9707363312 C0014232 05/27/97 
SUN 9.1 GB HD - 7200 RPM-3.5 Inch-F/W SCSI-2 540-2951-01 9715742422 C0014233 05/27/97 
SUN 32 MB RAM Expansion (1 of 8X32MB=256 MB) 7022A 501265378299929 C0014234 05/27/97 
SUN 32 MB RAM Expansion (1 of 8X32MB=256 MB) 7022A 501265378299923 C0014235 05/27/97 
SUN 32 MB RAM Expansion (1 of 8X32MB=256 MB) 7022A 501265378299891 C0014236 05/27/97 

. 

. 

. 
SUN Solaris Media for Servers 2.5.1 SOLS-C C0150689 05/27/97 

Figure 27.9.2-2. Equipment Installation/Receipt Report by ECN Number
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27.9.3 Installation Summary Reports 

This screen is designed to retrieve and print all receipts that have occurred for the designated PO, 
Vendor, or Date. Refer to Figure 27.9.3-2 for a sample report. Table 27.9.3-1 lists the field 
descriptions. Table 27.9.3-2 provides a set of procedures to generate the report. 

Figure 27.9.3-1. Installation Summary Reports Screen 

Table 27.9.3-1. Installation Summary Reports Field Descriptions 
Field Name Data Type Size Description 

INSTALLATION 
DATE or RANGE 

Date 2 Date or range of dates on which installation(s) occurred. 

NOTE 1, NOTE 2 String 40 A 40 character note to include in the report. 

INSTALLATION 
REPORTS 

Number 4 Number of copies of this report to generate. 

27-27 611-CD-510-001




Table 27.9.3-1. Procedures to generate installation summary reports

PERFORM ACTION 

Navigate to Installation Summary 
Reports Screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select ILM Report Menu - press ‘enter’ 
C. Select Installation Summary Reports - press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Enter report’s parameters A. Enter the Installation date or range (i.e. 10/10/98-11/10/98). 
B. Enter any note to appear on the heading of the report 
C. Specify number of copies. 

Exit the add mode Press ‘F3’ to exit the add mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
G. Enter 1 and press ‘enter’– to view the report on the screen 
H. Enter 2 and press ‘enter’ – to save the report into a file. Enter 

the file name to be saved as. The file will be saved in the 
user’s home directory. 

I. Enter 3 and press ‘enter’ – to print the report to the defaulted 
printer 

Navigate through the report output G. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hardcopy of the report 

H. After finished making the selection, press ‘q’ to exit the report 
screen. A message will come up specifying the number of 
reports generated, press ‘enter’. 

I. Another message will prompt “Another?” 
-Press ‘y’ to generate more reports. This will go back to the 
Installation Summary Report screen, or 
-Press ‘n’ to go back to the ILM Report Menu. 

Remember to press <ENTER> after each field.
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(installr) DATE: 01/05/00 TIME: 13:42 
ECS Development Facility INSTALLATION SUMMARY REPORT PAGE: 1 

Dates: 09/01/99-12/31/99 
PARENT EIN: 00000343 NAME: judge 
OEM PART: S20SX-50 OEM DESC: SPARCStation 20-50 SX 
INSTALL DATE: 03/10/95 
SITE: EDF ; ECS Development Facility 
BUILDING: 1616 ROOM: 1100A4 

CHILDREN INCLUDED: 

INSTALL 
EIN OEM PART DATE LOC BLDG ROOM USER 
==================== ================================== ======== ====== ====== ====== ============================== 
00000343 S20SX-50 03/10/95 EDF 1616 1100A4 Geistfeld 

Figure 27.9.3-2 Installation Summary Report


27-29 611-CD-510-001




27.10 Maintenance Menu 

The ILM Maintenance Menu s screen, Figure 27.10-1, is the primary screen the LMC will utilize 
in order to maintain and organize maintenance related data. Table 27.10-1 describes the function 
of each of the menu items. 

Figure 27.10-1. Maintenance Menu Screen 
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Table 27.10-1. Maintenance Menu options

Menu item Function Section 

Work Order Entry For entering work orders for repairs 27.10.2 

Work Order Modification For updating work orders as maintenance activity 
proceeds 

27.10.3 

Preventative 
Maintenance Items 

For designating which items in the EIN file require 
preventative maintenance 

27.10.4 

Generate PM Orders For generating work orders for items needing 
preventative maintenance 

27.10.5 

Work Order Parts 
Replacement History 

For reporting items replaced under one or more work 
orders. 

27.10.6 

Maintenance Work 
Order Reports 

For reporting about maintenance activity on selected 
machines 

27.10.7 

Work Order Status 
Reports 

For reporting the status of work orders 27.10.8 

Maintenance Codes For defining failure codes to be used when describing 
repairs and replacements 

27.10.9 

Maintenance Contracts For managing information about maintenance contracts 
with vendors and suppliers 

27.10.10 

Authorized Employees For identifying employees permitted access to vendors 
for repair notification 

27.10.11 

27.10.1 Filling out a Maintenance Work Order (MWO) 

The Maintenance Work Order (MWO) is the term used to define the formal reporting and 
documentation of maintenance events. The Work Order Entry screen and the Work Order 
Modification screen are used to initiate and complete the MWO process. The MWO tracks 
corrective maintenance, preventative maintenance, configuration changes, installation 
maintenance, equipment relocations, and spare replacements. Table 27.10.1-1 defines the 
different maintenance actions. Detailed instructions on how to initiate and complete the work 
order are contained in Section 27.10.2 thru 27.10.3. 
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Table 27.10.1-1. Types of MWO

TYPE CODE DEFINITION 

Corrective 
Maintenance 

CM Corrective Maintenance (CM) is the unscheduled repair of equipment that 
includes detection, diagnosis, isolation and resolution through line 
replaceable unit repair or replacement. 

Preventative 
Maintenance 

PM Preventative Maintenance (PM) is planned maintenance to include routine 
inspections and servicing that keeps the equipment in good repair in order to 
prevent failure. 

Configuration 
Change 

CC Configuration change (CC) is the change of the equipment’s configuration as 
directed by an approved CCR. 

Installation 
Maintenance 

IM Installation Maintenance (IM) is used for any maintenance action that occurs 
during the initial installation of new equipment. 

Property 
Relocation 

PR Equipment Relocations (PR) involves the movement of equipment as a 
result of intra-site or inter-site relocation. In the case of inter-site relocation, 
the losing site is responsible for stating the MWO. 

Spare 
Replacement 

SR Spare replacement involves the use of a pre-stocked spared part as 
corrective maintenance.. Only in the cases of spare use will two MWOs be 
created. One work order is used to account for the amount of time required 
to resolve the problem. A second work order is opened to account for the 
status of the failed component that the spare replaced. Specify the spare 
replacement action by entering “SR” in the “CODE” field 

NOTE: The two-letter maintenance action designator is entered in the Code field of the Work 
Order Modification screen. 

27.10.1.1 ECS Hardware States 

ECS hardware will be in one of the following states: 

‹	 Operational – Operational hours are not tracked or reported but are determined by 
functional string using a formula. 

‹	 Impaired – Impaired operations exist when the system performs in less than a fully 
operational state due to a hardware/software malfunction. Impaired time is reportable 
but not chargeable as down time. 

Note: The restore time between when the vendor completes his corrective maintenance until the 
time the system is fully functional (i.e. disk repartitioning, software restoration) is considered 
impaired time. 

‹	 Down – Down time occurs when a system is unable to perform its primary 
operational function due to a hardware malfunction. Down time is reportable and 
chargeable. Chargeable down time results only from inherent failures (i.e., no 
induced failures like power outages) of ECS hardware. Down time starts when the 
hardware problem is first recognized, and continues until the failed component is 1) 
repaired, 2) replaced, or 3) switched over to another system. 
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27.10.2 Work Order Entry Screen 

The Work Order Entry Screen (Figure 27.10.2-1) is used to initiate the work order process. The 
operator will complete the required fields and upon exit from the screen, the system copies the 
EIN children to the parent. This screen is always presented in ADD mode. 

Figure 27.10.2-1. Work Order Entry Screen 
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Table 27.10.2-1. Work Order Entry Field Descriptions (1 of 2)

Field Name Data 

Type 
Size Description 

WORK ORDER String 10 This is the actual Work Order number. The operator should always 
press RETURN to obtain the next number sequentially assigned by 
the system. 

PARENT EIN String 20 EIN of the host that the work order is written against. Refer to 
Tables 27.10.2-2 and 27.10.3 to determine the EIN of the host.. 

Serial Number String 30 Serial Number of the item entered as parent EIN. 

Name String 30 Name of the machine with which the item is associated. 

OEM Part String 34 Manufacturer’s part number for the item entered as Parent EIN. 

OEM Desc String 30 Manufacturer’s description for the item entered as Parent EIN. 

Mod/Ver String 24 Model or version of the item entered as Parent EIN. 

Location String 8 Designator for the inventory location of the item entered as Parent 
EIN. 

Building String 6 Building where the item entered as Parent EIN is situated. 

Room String 6 Room where the item entered as Parent EIN is located. 

TROUBLE 
TICKET # 

String 15 Identifier for the RemedyNCR trouble ticket associated with the 
work order 

NOTIFICATION 
DATE 

Date 2 Date the LMC is notified of the failure. The system defaults to the 
current date. 

NOTIFICATION 
TIME 

Time 2 Time the LMC is notified of the failure. The system defaults to the 
current time. 

PRIORITY String 1 Priority assigned to the work. 1 being the highest and 3 is the 
lowest. 

SUBMITTER String 10 Code of the employee who submitted the problem and caused the 
work order to be opened. The operator may zoom to the Employee 
table to choose the code, if it had been entered there previously. 
(See also ??? the Employee Manager section.) 

FAILURE DATE Date 2 The actual failure date. The earliest between the following: 1) the 
time the LMC is notified or 2) the time the hardware problem is first 
recognized. 

FAILURE TIME String 2 The actual failure time. The earliest between the following: 1) the 
time the LMC is notified or 2) the time the hardware problem is first 
recognized. 

MFG/DEV String 6 Code for the manufacturer. The operator may zoom to the Vendor 
table and choose the code, if it had been entered previously. 

VENDOR String 6 Code for the vendor from whom the item was purchased. The 
operator may zoom to the Vendor table and choose the code, if it 
had been entered previously. 

MAINT 
VENDOR 

String 6 Code for the item’s maintenance vendor. The operator may zoom 
to the Vendor table and choose the code, if it had been entered 
previously. 

VENDOR CALL 
DATE 

Date 2 Date the vendor was called and informed of the problem. 
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Table 27.10.2-1. Work Order Entry Field Descriptions (2 of 2)

Field Name Data 

Type 
Size Description 

VENDOR CALL 
TIME 

Time 2 Time the vendor was called and informed of the problem. 

VENDOR 
CONTACT 
NAME 

String 30 Vendor point of contact 

VENDOR 
REFERENCE 

String 20 Maintenance vendor’s trouble ticket number. For advance 
replacement support, enter both the vendor’s trouble ticket number 
and the RMA number. 

CODE String 2 Identifier for a type of category of the maintenance action. CM – 
Corrective Maintenance, PM – Preventative Maintenance, IM – 
Installation Maintenance, ER – Equipment Relocation, SR – Spare 
Replacement, and CC – Configuration Change. NOTE: The LMC 
only needs to enter a code if the maintenance action is something 
other than corrective maintenance. 

NOTE String 60 A brief description of the problem and resolution 

TEXT String 8 Press /Z at this prompt to obtain a free form text window. The 
operator should enter the failure / repair details in this window. 
When complete, press F3 to exit the text window. 

27.10.2.1 Definition of a Host 

The host is the hardware platform or item that is networked attached that performs a significant 
function in the operation or support of ECS systems. Table 27.10.2-2 identifies the equipment 
that has been designated as a host. 

Table 27.10.2-2. Equipment designated as host 
HOST NOT A HOST 

Servers, D3 stackers, 8mm stackers, 4mm 
stackers, Routers, Hubs, FDDI Switches, 
Concentrators, Robots, SCSI switches, Printers, 
Hippi, X-terms, Raid, CDROM, DiskPaks, 
Unipaks, Multipaks, Fax, and Scanner 

Light Pens, Wyse Terminals, Lan Analyzers, 
Keyboards, Monitors, Mice 

27.10.2.2 Process for Determining EIN of Host 

Figure 27.10.2-2 depicts the process for determining the EIN of the host that is entered in the 
Parent EIN field. 
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YES NO 

YES NO  NO 

YES 

Does the failed part 
have an EIN sticker? 

Is the failed part’s EIN 
identified as a host? 

Is next higher assembly a 
host? 

Determine the failed 
component’s host EIN 

Determine EIN of next 
higher assembly 

Determine EIN of next 
higher assembly 

Enter EIN of host in 
the parent EIN field. 

Enter EIN of host in 
the parent EIN field. 

Figure 27.10.2-2. Process for Determining the EIN of the Host 

Table 27.10.2-3 gives instructions on how to determine the next higher assembly. 
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Table 27.10.2-3. Determining Next Higher Assembly

PERFORM ACTION 

Navigate to the EIN Manager 
screen. 

From the Main Menu 
A. Select ILM Main Men – press ‘Enter’ 
B. Select EIN Menu – press ‘Enter’ 
C. Select EIN Manager – press ‘Enter’ 

Find the component EIN A. Press ‘f’ to invoke the find command 
B. Enter the 8 digit EIN number of the failed component EIN 
C. Press ‘F5’ to start the search 

Determine the upper level 
assembly of the failed component 

After the system found and displayed the failed component EIN 
record information on the screen, press ‘w’ to view the next upper 
level assembly. 
If ILM replied, “No records available” this means that this item is not 
attach to any parent structure. 

Exit the EIN Manager screen Press ‘F3’ twice to get out of the EIN Manager screen. 
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Table 27.10.2-4. Procedures to enter a new work order (1 of 2)

PERFORM ACTION 

Navigate to Work Order Entry 
screen. 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select Maintenance Menu – press ‘enter’ 
C. Select Work Order Entry – press ‘enter’ 

Filling out the work order Fill in the necessary information 
A. Press ‘enter’ to get the next work order number. 
B. Enter Parent EIN number (EIN of the host that the work order is 

written against). Refer to section 27.10.2-3 for the process of 
determining a host EIN. 

C. Enter the applicable trouble ticket number. Entry required only 
if the HW problem was transferred from a Remedy trouble 
ticket or NCR. 

D. Enter the date and time the LMC is notified of the failure. 
E. Enter problem priority 

Enter ‘1’ for any malfunction that results in down time of a 
production system and immediate corrective action is needed. 
Enter ‘2’ for any malfunction that impairs system performance 
but does not result in down time; however, may result in down 
time if system must be brought down to fix the problem. 
Enter ‘3’ for any malfunction that will not result in system down 
time (e.g. minor flickering screen, key sticking, sticking mouse, 
etc…) 

F. Enter the actual failure date and time. The earliest between 
the following: 1) the time the LMC is notified or 2) the time the 
hardware problem is first recognized. 

G. Enter date and time vendor was called and informed of the 
problem 

H. Enter maintenance vendor’s trouble ticket number. For 
advance replacement support, enter both the vendor’s trouble 
ticket number and the RMA number, e.g. TT# 123456 RMA # 
456789 

I. Enter the appropriate maintenance code: 
NOTE: Only need to enter a code if the maintenance action is 

something other than corrective maintenance. See table 27.10.1-1 
for a more detail definition of the maintenance categories. 

CM – Corrective Maintenance 
PM – Preventive Maintenance 
IM – Installation Maintenance 
ER – Equipment Relocation 
SR – Spare Replacement 
CC – Configuration Change 

J. Enter a brief description of the problem. 
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Table 27.10.2-4. Procedures to enter a new work order (2 of 2)

PERFORM ACTION 

Exit the add mode Press ‘F3’ to get out of add mode 

Copy component EINs into the 
work order and exit the Work 

Order Entry Screen 

Press 'F3" again to get out of the Work order Entry screen. ILM will 
ask "copy in EIN children say 'y" and "n" to exit. Enter ‘y’ to 
copy in children EIN. 

Remember to press <ENTER> after each field. 

27.10.3 Work Order Modification Screens 

The Work Order Modification screen, Figure 27.10.3-1, should be used when the repair has been 
completed and all appropriate information about the repair is known. The operator will enter or 
modify information in the fields as appropriate then invoke the item page to view the EIN 
children for the parent. The operator also has the ability with this screen to enter chargeable 
times. Press the ‘r’ key to move to the next screen to input chargeable times. 

Figure 27.10.3-1. Work Order Modification Screen 

Press RIGHT for Down Times -><-<- Press LEFT to return to main page 
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Table 27.10.3-1. Work Order Modification Field Descriptions (1 of 2)

Field Name Data Type Size Description 

WORK ORDER String 10 Identifier for the work order. 

STATUS String 1 Used for determining status of the MWO. The definition for each 
of the status is stated below. WARNING:  In order to ensure the 
integrity of the information, it is important that the LMC not update 
MWOs after the status has been changed to ‘A’ 
O – When the LMC opens the MWO. 
A  – When the MWO action is completed the LMC changes the 
status to ‘A’ for the ILS Maintenance Coordinator review. 
P – After ILS Maintenance Coordinator reviewed, the status is 
changed to ‘P’. 
R – After the ILS Property Administrator reviewed, status is 
changed to ‘R’. 

PARENT EIN String 20 EIN of the host that the work order is written against. Refer to 
section 27.10.2-3 for the process of how to determine a host EIN. 

Serial Number 
through Control 
Item ID 

MULTI-
FIELD 

These fields are all reflected from the EIN file for the Parent as 
entered. 

TROUBLE 
TICKET # 

String 15 Identifier for the Remedy/NCR trouble ticket associated with the 
work order 

NOTIFICATION 
DATE and TIME 

MULTI-
FIELD 

Date and time the problem was reported. These fields are 
initialized with the current date and time but can be modified. 

ALDT REASON 
CODE 

String 10 Code to describe the delays within the maintenance process. 
AP – Awaiting Part 
UD – User Determined 

PRIORITY String 1 Priority assigned to the work. 1 being the highest and 3 is the 
lowest. 

FAILURE DATE 
and TIME 

MULTI-
FIELD 

Actual failure date and time. The earliest between the following: 
1) the time the LMC is notified or 2) the time the hardware 
problem is first recognized. 

VENDOR CALL 
DATE and TIME 

MULTI-
FIELD 

Date and time the maintenance vendor was called. 

VENDOR 
ARRIVE DATE 
and TIME 

MULTI-
FIELD 

Date and time the vendor arrived to perform the repairs. 

VENDOR 
COMPLETE 
DATE and TIME 

MULTI-
FIELD 

Date and time the repair was completed whether by on-site 
support, advanced replacement, spare replacement, or local site 
personnel repairs. 

MFR/DEV String 6 Code identifying the Manufacturer or Developer ID for the 
specified parent EIN. 

MAINT 
VENDOR 

String 6 Code identifying the maintenance vendor for the specified parent 
EIN 

VENDOR 
CONTACT 
NAME 

String 30 Vendor point of contact 
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Table 27.10.3-1. Work Order Modification Field Descriptions (2 of 2)

Field Name Data Type Size Description 

VENDOR 
REFERENCE 

String 20 Maintenance vendor’s trouble ticket number. For advance 
replacement support, enter both the vendor’s trouble ticket 
number and the RMA number. 

CODE String 2 Identifier for a type of category of the maintenance action. CM – 
Corrective Maintenance, PM – Preventative Maintenance, IM – 
Installation Maintenance, ER – Equipment Relocation, SR – 
Spare Replacement, and CC – Configuration Change. NOTE: 
The LMC only needs to enter a code if the maintenance action is 
something other than corrective maintenance. 

EVENTS String N/A Used to enter information relevant to the maintenance event. 

NOTE String 60 Enter a brief description of the problem and resolution. 

START DATE 
and END DATE 

MULTI-
FIELD 

The first block – indicate the date and time the vendor returns 
call. 
Second and third blocks – indicate delay times for when the 
vendor’s work was suspended and resumed (include travel time, 
admin delays, and logistic delays). 
Fourth block – indicate the time between when the vendor 
leaves and the system is back up. 

REASON String 2 Enter the appropriate reason code for the delay entered. 
AP – Awaiting Part 
UD – User Determined 

27.10.3.1 Chargeable Hours Page for Work Order Modification screens 

This screen provides the ability to maintain chargeable hours to be used in calculations for 
downtime. Chargeable down time starts when the hardware problem is first recognized, and 
continues until the failed component is 1) repaired 2) replaced, or 3) switched over to another 
system.. 

27-41 611-CD-510-001




Figure 27.10.3-2. Chargeable Hours Page for Work Order Modification Screen 

Table 27.10.3-2. Chargeable Hours Page for Work Order Modification Screen 
Field Descriptions 

Field Name Data Type Size Description 

ALDT Floating 10.1 Duration, in hours, of any administrative logistic delays. 

TIME TO 
REPAIR 

Floating 10.1 Elapsed time required for technician to complete repair and 
to bring item to operational status. 

SWITCH OVER 
TIME 

Floating 10.1 The time required by the system to restore its functions by 
switching from the downed equipment to the backup 
equipment. Switch over time starts at the time of the failure 
and ends when the fail over system is functional. Enter the 
total hours ( in tenths of an hour). 

TOTAL 
CHARGEABLE 
DOWNTIME 

Floating 10.1 Total hours to be charged for downtime. Enter the total 
hours (in tenths of an hour). 

27.10.3.2 Items Page for Work Order Modification Screens 

This screen provides the ability to view which items have been replaced and to enter new items. 
This screen should be used when the repair has been completed and all appropriate information 
about the repair is known. The system will ask for verification to update the database. Type 'N" 
for no and the database will be updated after the review by the ILS Maintenance Coordinator and 
ILS Property Administrator. 
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Figure 27.10.3-3. Items Page for Work Order Modification Screen


Table 27.10.3-3. Items Page for Work Order Modification Field Descriptions

Field Name Data Type Size Description 

COMPONENT 
EIN 

String 20 This field is the component EIN number of the Parent EIN. 

OEM PART 
through 
WARRANTY 
DATE 

MULTI-
FIELD 

These fields are all copied from the child EIN record and 
may be modified in this screen as required. 

REPLACE (R) 
or NEW (N) 

String 1 An ‘R’ in this field for the Child EIN that had been replaced 
in the machine. When entering a new item, be sure to 
place an ‘N’ in this field to designate the record as being 
new. 

RECORD 
EVENTS 

String 40 A free form text window use to enter failure/repair details 

27-43 611-CD-510-001




Table 27.10.3-4. Procedures to Complete the Work Order (1 of 2)

PERFORM ACTION 

Navigate to Work Order 
Modification Screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select Maintenance Menu – press ‘enter’ 
C. Select Work Order Modification – press ‘enter’ 

Find the Work Order of interest A. Press ‘f’ to find work order to modify 
B. Enter the work order number and then press ‘F5’ , or press ‘v’ to 

go into the table view, find the particular record by placing the 
cursor on the line of the desired record and then press ‘v’ again 
to bring back to the individual form mode. 

Invoke the modify command Press ‘/m’ to go into modify mode. 

Enter new information about the 
work order as the maintenance 

proceed 

Fill in the necessary information 
A. Enter vendor arrive date and time – when the vendor technician 

arrived on site to perform repair. 
B. Enter vendor complete date and time whether by on-site support, 

advanced replacement, spare replacement, or local site 
personnel repairs. 

C. At the Events field - Press ‘/z’ to get access to the text box, enter 
the following information: old and new, part numbers, EIN, and 
serial number. Other appropriate notes would be any 
administrative logistics delay times, problems, excessive delays 
or problem that should be brought to the attention of the ILS 
office. 

D. Enter the appropriate maintenance code: 
NOTE: Only need to enter a code if the maintenance action is 

other than a corrective maintenance action. See Table 27.10.1-1 for 
a more detail definition of the maintenance categories. 

CM – Corrective Maintenance 
PM – Preventive Maintenance 
IM – Installation Maintenance 
ER – Equipment Relocation 
SR – Spare Replacement 
CC – Configuration Change 

E. Enter a brief description of the problem and resolution. 
Incorrect: Bad Hard drive. Replaced HD. 
Correct: System not powering up. Replaced HD 

F. Enter Start Date and End Date 
First block – indicate the time and date that the vendor returns 
call 
Second and third block – indicate delay times for when the 
vendor’s work was suspended and resumed (include travel time, 
admin delays, and logistic delays). Enter reason for the delay. 
AP – Awaiting Part and UD – User Determined. 
Fourth block – indicate the time between when the vendor leaves 
and the system is back up. 
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Table 27.10.3-4. Procedures to complete Work Order (2 of 2)

PERFORM ACTION 

Exit the modify mode Press ‘F3’ to go to the next step 

Filling in the chargeable hours 
page 

A. Press ‘r’ to go to the Chargeable Hours page for Work Order 
Modification screen. 

B. Press ‘/m’ to go into modify mode 
C. Enter Switch over time (in tenths of an hour) required for switchover. 

Switchover time starts at the time of the failure and ends when the 
failover system is functional. 

D. Enter the total hours (in tenths of an hour) to be charged for down 
time. 

Exit modify mode Press ‘F3’ to go to the next step 

Invoke the work order’s item 
page 

Press ‘I’ to invoke the items page where the different components of the 
parent machine are listed. 

Provide information about the 
failed component(s) and 
specify the replacement 

item(s) 

A. Look for the failed component by pressing ‘n’ for next or ‘p’ for 
previous, or do a find to find the item. 

B. Press ‘/m’ to specify the failed component(s) 
C. In the record of the failed item, fill in the necessary information 

- Mark the failed component as failed by entering an ‘R’ at the field 
“REPLACE (R) or NEW (N). 

- Enter replace date 
- Press ‘/z’ to obtain a free form text window at the “RECORD 

EVENTS” field. Enter the failure/repair details in this window. 
D. When completed, press ‘F3’ to exit the modify mode 

Exit the item page Press ‘F3’ again, ILM will ask if you want to process changes. Press 'n' for 
no. WARNING: Please DO NOT enter ‘Y’ for yes. If entered yes, the ILS 
Maintenance Coordinator will not be able to view and make changes to 
the work order. 

Change the MWO status to A 
for the ILS Maintenance 

Coordinate review when the 
LMC completed all the work 
relevant to the work order 

At the MWO Modification screen 
A. Press ‘/m’ to invoke the modify mode to change the status of the work 

order 
B. Enter an ‘A’ for audit. 
C. Press ‘F3’ to exit the modify mode. 

Exit the Work Order 
Modification screen 

Press ‘F3’ to exit Work Order Modification screen. 

Remember to press <ENTER> after each field. 

27.10.4 Preventative Maintenance Items Screens 

The designator of which items in the EIN file has been determined and its frequency entered by 
the ECS/ILS office. 
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Figure 27.10.4-1. Preventative Maintenance Items Screen 

Table 27.10.4-1. Preventative Maintenance Items Field Descriptions 
Field Name Data Type Size Description 

EIN through 
ROOM 

MULTI-
FIELD 

These fields are not modifiable by the operator and 
represent the actual data from the EIN file. 

SET AS PM 
ITEM (Y/N): 

String 1 Flag designating the item is to undergo preventative 
maintenance. Y = Yes; N = No 

FREQUENCY Number 3 Number of days between PM. 

LAST DATE Date 2 Last date a PM has performed for this item. 

MAINTENANCE 
DUE ON 

String 8 Date the next maintenance is due. 

27.10.5 Generate Preventative Maintenance Orders 

This screen provides the ability to generate Work Orders for item needing a PM. When 
executed, orders are created for all items needing a PM prior to the cutoff date entered and prints 
a summary report of orders created. 
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Figure 27.10.5-1. Generate Preventative Maintenance Orders Screen


Table 27.10.5-1. Generate Maintenance Orders Field Descriptions

Field Name Data Type Size Description 

CUTOFF DATE String 8 The last date for the system to examine PM items and 
generate orders. 

NOTE 1 and 
NOTE 2 

String 40 A 40 character note to include in the report 

NUMBER OF 
COPIES (PM 
ORDERS) 

String 1 Number of copies of the report to print 
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Table 27.10.5-2. Procedures to generate PM orders

STEP ACTION 

Navigate to the Generate 
PM Orders screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select Maintenance Menu – press ‘enter’ 
C. Select Generate PM Orders – press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Fill in the parameters to 
generate the PM orders 

Fill in the necessary information 
A. Enter the last date for the system to examine preventative maintenance 

items. 
B. Enter any note to appear on the header of the report 
C. Enter number of copies of the report 

Exit the add mode Press ‘F3’ to exit the add mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
A. Enter 1 and press ‘enter’– to view the report on the screen 
B. Enter 2 and press ‘enter’ – to save the report into a file. Enter the file 

name to be saved as. The file will be saved in the user’s home 
directory. 

C. Enter 3 and press ‘enter’ – to print the report to the defaulted printer 

Navigate through the report 
output 

A. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hard copy of the report 

B. After finished making the selection, press ‘q’ to exit the report screen. A 
message will come up specifying the number of reports generated, 
press ‘enter’. 

C. Another message will prompt “Another?” 
-Press ‘y’ to generate more PM. This will go back to the PM Orders 
screen, or 
-Press ‘n’ to go back to the Maintenance Menu. 

Remember to press <ENTER> after each field. 

27.10.6 Work Order Parts Replacement History Screen 

The Work Order Parts Replacement History screen (Figure 27.10.6-1) generates reports detailing 
parts replaced under maintenance work orders. Table 27.10.6-1 describes the screen’s fields. 
Table 27.10.6-2 provides the instruction to generate the report. 
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Figure 27.10.6-1. Work Order Parts Replacement History Screen


Table 27.10.6-1. Work Order Parts Replacement History Field Descriptions

Field Name Data Type Size Entry Description 

WORK ORDER or 
RANGE 

String 25 Required Identifier for a work order or range of orders. 

NOTE 1 and 
NOTE 2 

String 60 Optional A 40-character note to include in the report. 

NUMBER OF 
COPIES (WORK 
ORDER HISTORY 
REPORT) 

String 1 Required Number of copies of the report to print 
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Table 27.10.6-2. Procedures to generate Work Order Parts Replacement History

Report


STEP ACTION 

Navigate to the Work Order 
Parts Replacement History 

Report 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select Maintenance Menu – press ‘enter’ 
C. Select Work Order Parts Replacement History – press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Fill in the parameters to 
generate the report 

Fill in the necessary information 
A. Enter the work order number or range of work orders to report on 
B. Enter any note to include in the report 
C. Specify number of copies of the report to generate 

Exit the add mode Press ‘F3’ to exit the add mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
A. Enter 1 and press ‘enter’– to view the report on the screen 
B. Enter 2 and press ‘enter’ – to save the report into a file. Enter the file 

name to be saved as. The file will be saved in the user’s home 
directory. 

C. Enter 3 and press ‘enter’ – to print the report to the defaulted printer 

Navigate through the report 
output 

A. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hardcopy of the report 

B. After finished making the selection, press ‘q’ to exit the report screen. A 
message will come up specifying the number of reports generated, 
press ‘enter’. 

C. Another message will prompt “Another?” 
-Press ‘y’ to generate more reports. This will go back to the Work Order 
Parts Replacement History screen, or 
-Press ‘n’ to go back to the Maintenance Menu. 

Remember to press <ENTER> after each field. 

27.10.7 Maintenance Work Order Reports Screens 

This screen provides Work Order Reports for work done on selected machines. Table 27.10.7-1 
describes the screen’s fields. 
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Figure 27.10.7-1. Maintenance Work Order Reports Screen


Table 27.10.7-1. Maintenance Work Order Reports Field Descriptions

Field Name Data Type Size Description 

PARENT EIN String 20 Parent EIN for the installation/structure. 

OEM PART String 34 OEM part number reflected from the EIN record of the child. 

SERIAL NUMBER String 30 Serial number of the parent EIN. 

SITE (LOCATION) String 6 Code for the site which the items can be found. 

NOTE 1 String 40 A 40 character message to include in the report 

ENTER NUMBER 
OF COPIES 
(Maintenance 
Work Order 
Reports) 

Number 1 Number of copies of the report to print. 
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Table 27.10.7-2. Procedures to generate Maintenance Work Order Reports

PERFORM ACTION 

Navigate to the Maintenance 
Work Order Reports screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select Maintenance Menu – press ‘enter’ 
C. Select Maintenance Work Order Reports – press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Enter the report parameters Fill in the necessary information 
A. Enter the Parent EIN number, or you may press ‘/z’, choose the EIN 

from the list by pressing ‘t’, then press ‘F3’. 
B. Enter any note to appeal on the header of the report 
C. Enter number of copies of the report to print. 

Exit the add mode Press ‘F3’ to exit the add mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
A. Enter 1 and press ‘enter’– to view the report on the screen 
B. Enter 2 and press ‘enter’ – to save the report into a file. Enter the 

file name to be saved as. The file will be saved in the user’s home 
directory. 

C. Enter 3 and press ‘enter’ – to print the report to the defaulted printer 

Navigate through the report 
output 

A. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hard copy of the report 

B. After finished making the selection, press ‘q’ to exit the report 
screen. A message will come up specifying the number of reports 
generated, press ‘enter’. 

C. Another message will prompt “Another?” 
-Press ‘y’ to generate more reports. This will go back to the 
Maintenance Work Order Reports screen, or 
-Press ‘n’ to go back to the Maintenance Menu. 

Remember to press <ENTER> after each field. 

27.10.8 Work Order Status Reports Screens 

This screen provides status reports on selected Work Orders. Table 27.10.8-1 describes the 
screen’s fields. 
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Figure 27.10.8-1. Work Order Status Reports Screen 

Table 27.10.8-1. Work Order Status Reports Field Descriptions 
Field Name Data Type Size Description 

WORK ORDER or 
RANGE 

String 25 Identifier for a work order or a range of work orders. The 
operator may zoom to the Work Order file to choose an 
identifier, if it had been entered there previously. (See the 
Work Order Entry section.) 

PART (OEM PART 
NUMBER) or 
RANGE 

String 34 Manufacturer’s part number or a range of numbers for items. 
The operator may zoom to the OEM Part file to choose the 
part number, if it had been entered there previously. 

ORDER STATUS 
[ FRCX ] 
(STATUS) 

String 2 Code for the status of a work order 

NOTE 1, NOTE 2 String 40 A 40 character message to include in the report 

ENTER NUMBER 
OF COPIES 
(Work Order 
Status) 

Number 1 Number of copies of the report to print. 
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Table 27.10.8-2. Procedure to generate Maintenance Work Order Reports

PERFORM ACTION 

Navigate to the Work Order 
Status Reports Screen 

From the Main Menu 
A. Select ILM Main Menu – press ‘enter’ 
B. Select Maintenance Menu – press ‘enter’ 
C. Select Work Order Status Reports – press ‘enter’ 

Invoke the add command Press ‘/a’ to go into add mode. 

Enter the report parameters Fill in the necessary information. 
Fill in selection criteria for the other fields as required. 
A. Enter the Work order number, or you may press ‘/z’, choose the 

work order from the list by pressing ‘t’, then press ‘F3’. 
B. Enter the child OEM part number or press ‘/z’, choose the OEM Part 

from the list by pressing ‘t’, then press ‘F3’. 
C. Enter order status 

‘O’ – when the order is first entered 
‘A’ – when the order is being reviewed by the ILS MC. 
‘P’- when the order is being reviewed by the ILS PA. 
‘R’ – when the order is closed. 

D. Enter any note to appeal on the header of the report 
E. Enter number of copies of the report to print. 

Exit the add mode Press ‘F3’ to exit the add mode. 

Execute the report Press ‘e’ to execute the report. 

Report output View the report output options: 
A. Enter 1 and press ‘enter’– to view the report on the screen 
B. Enter 2 and press ‘enter’ – to save the report into a file. Enter the 

file name to be saved as. The file will be saved in the user’s home 
directory. 

C. Enter 3 and press ‘enter’ – to print the report to the defaulted printer 

Navigate through the report 
output 

A. Navigating through the report 
-Press ‘n’ for Next 
-Press ‘p’ for Previous 
-Press ‘r’ for Right 
-Press ‘q’ for Quit or 
-Press ‘h’ to print a hard copy of the report 

B. After finished making the selection, press ‘q’ to exit the report 
screen. A message will come up specifying the number of reports 
generated, press ‘enter’. 

C. Another message will prompt “Another?” 
-Press ‘y’ to generate more reports. This will go back to the 
Maintenance Work Order Reports screen, or 
-Press ‘n’ to go back to the Maintenance Menu. 

Remember to press <ENTER> after each field.
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27.10.9 Maintenance Codes Screens 

This screen provides failure codes and descriptions for use with repairs and replacements. Table 
27.10.9-1 describes the screen’s fields. 

Figure 27.10.9-1. Maintenance Codes Screen


Table 27.10.9-1. Maintenance Codes Field Descriptions

Field Name Data Type Size Description 

CODE 
(maintenance) 

String 2 Code that distinguishes among item failures according to 
their cause 

DESC 
(maintenance) 

String 30 Description for the failure code. 

27.10.10 Maintenance Contracts Screens 

This screen provides contract numbers for repair contracts with vendors and suppliers. Table 
27.10.10-1 describes the screen’s fields. 
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Figure 27.10.10-1. Maintenance Contracts Screen 

Table 27.10.10-2. Maintenance Contracts Field Descriptions 
Field Name Data Type Size Description 

CONTRACT ID String 15 Identifier for the maintenance contract as assigned by 
purchasing or provided by the vendor 

VENDOR String 6 Vendor code whom the item was purchased from. 

START DATE Date 2 Date the contract is to become effective. 

END DATE Date 2 Date the contract will expire. 

PO NUMBER String 10 Identifier for the purchase order under which maintenance was 
procured. 

PIN String 20 PIN number applicable for authorization for vendor contact. 

27.10.11 Authorized Employees Screens 

This screen provides employee codes for employees who have been permitted access to the 
vendor for repair notification. Table 27.10.11-1 describes the screen’s fields. 
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Figure 27.10.11-1. Authorized Employees Screen


Table 27.10.11-1. Authorized Employees Field Descriptions

Field Name Data Type Size Description 

EMPL String 10 Identifier for an employee. The operator may zoom to the 
Employee table and choose the code, if it had been 
entered there previously. (See the Employee Manager 
section.) 

CONTRACT NO String 10 Identifier for a maintenance contract. . The operator may 
zoom to the Maintenance Contracts table and choose the 
identifier, if it had been entered there previously. (See the 
Maintenance Contracts Manager section.) 

VENDOR String 6 Code for the vendor with whom the contract is placed. The 
operator may zoom to the Vendor table and choose the 
code, if it had been entered there previously. (See the 
Vendor Master Maintenance section. 

Last Name String 30 
Last name of the employee. The value is obtained from the 
Employee table. 

27.11 ILM Master Menu 

The ILM Master Menu provides the LMC with the ability to verify the accuracy of ILM in 
reference to employee information, inventory location, hardware and software codes. All 
additions, deletions or modifications are to be directed to the ILS Property Administrator. 
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Figure 27.11-1. ILM Master Menu 

The ILM Master menu is broken down into the following functions: 

Table 27.11-1. ILM Master Menu options (1 of 2) 
Menu item Function Section 

Employee Manager For maintaining employee information 27.11.1 

System Parameters 
Manager 

For creating parent/child relationship between 
components in an assembly 

27.11.2 

Inventory Location 
Manager 

For maintaining standardized information about ECS 
inventory locations for all ILM processes. 

27.11.3 

Hardware/Software 
Codes 

For maintaining a standard set of codes for classifying 
inventory items according to type. 

27.11.4 

Status Code Manager For maintaining a standard set of codes for classifying 
inventory items according to status. 

27.11.5 

DAAC Export Inventory 
Data 

For exporting a DAAC’s inventory data and transferring 
them to the SMC’s ILM system. 

27.11.6 

Transaction Log For reviewing events records from XRP-II’s system 
transaction log. 

See 27.12.3 

Transaction Archive For archiving records from XRP-II’s system transaction 
log. 

See 27.12.4 

ILM Import Records For uploading inventory data that had been exported at 
another site. 

27.11.7 

Site Codes for Scanned 
Data 

For maintaining a standard set of codes for uniquely 
identifying an ECS site and building. 

27.11.8 
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Table 27.11-1. ILM Master Menu options (2 of 2)

Menu item Function Section 

Scanned Data For reviewing and editing bar code scanner data prior 
to updating property records. 

27.11.9 

Process Scanned Data For updating inventory records using bar code scanner 
data. 

27.11.10 

27.11.1 Employee Manager Screens 

This screen provides for the maintenance of employee information. Table 27.11.1-1 describes 
the screen’s fields. 

Figure 27.11.1-1. Employee Manager Screen 
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Table 27.11.1-1. Employee Manager Field Descriptions

Field Name Data Type Size Description 

EMPLOYEE 
NUMBER (EMPL) 

String 10 Unique identifier for an employee. 

LAST NAME 
(EMPLOYEE) 

String 30 Last name of the employee. 

FIRST NAME 
(EMPLOYEE) 

String 30 First name of the employee. 

STATUS 
(EMPLOYEE) 

String 1 Status of the employee. 

WORK CENTER 
(EMPLOYEE) 

String 6 Code for work center where the employee is normally 
assigned. The operator may zoom to the Inventory 
Locations file to choose the code for the work center-type 
location, if it had been entered there previously. (See the 
Inventory Location Manager section.) 

PHONE 
(EMPLOYEE) 

String 18 Telephone number of the employee. 

FAX NUMBER 
(EMPLOYEE) 

String 13 FAX number of the employee. 

E-MAIL 
(EMPLOYEE) 

String 30 E-mail address for the employee. 

PAGER NUMBER 
(EMPLOYEE) 

String 13 Pager number for the employee. 

CC MAIL 
(EMPLOYEE) 

String 30 CC-mail address of the employee. 

27.11.2 System Parameters Manager Screen 

The System Parameters Manager screen (Figure 27.11.2-1) is for maintaining system-wide XRP-
II parameters and is principally used when first installing the system. Since ILM uses only a 
subset of the full XRP-II capabilities, this is a scaled down version of the screen described in the 
Section 6 of the XRP-II System Reference Manual. It contains only the fields needed to tailor the 
system to the site at which it operates. 

Several fields have particular significance for ILM. The Site ID field contains the code for the 
ECS site where the operator’s copy of XRP-II is installed. The field is interrogated by ILM 
processes that have to determine which assets belong to the local site. The Last EIN field is used 
by XRP-II to keep track of the most recently used, automatically assigned EIN. It updates the 
field whenever an operator presses <RETURN> in the EIN field when creating records via EIN 
Entry. The NASA Contract Number and Default MFG Year fields contain values used as 
defaults when creating ILM records, and the Export Functioning field precludes more than one 
export process from running at a time because they would conflict. 

Table 27.11.2-1 describes each of the screen’s fields. 
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Figure 27.11.2-1. System Parameters Manager CHUI 

Table 27.11.2-1. System Parameters Manager Field Descriptions 
Field Name Data Type Size Description 

SYSTEM 
PARAMETER 
KEY 

String 1 Code that designates the active record in XRP-II’s system 
parameter table. The active record must have the value “A”. 

SITE ID String 6 Code that identifies the ECS site where this XRP-II system is 
installed. 

LAST CONTROL 
ITEM ID 

String 20 Code used in determining the next sequentially available identifier 
when assigning control item identifiers automatically. 

LAST EIN String 20 Code used in determining the next sequentially-available identifier 
when assigning EIN numbers automatically 

USE BRANCH AS 
ORDER PREFIX 

String 1 Code that, if “Y”, causes all new purchase orders, work orders, and 
sale orders to be prefixed with the site code of the operator or, if 
null, the default site code. 

starting RAM Number 8 Initial amount of memory XRP-II is to use 

NASA 
CONTRACT 
NUMBER 

String 11 Code that is used by NASA to identify the ECS contract. It is 
attached to all property records 

DEFAULT MFG 
YEAR 

String 4 Year used as default to identify when an item was built. 

EXPORT 
FUNCTIONING 

String 1 Code that indicates if an XRP-II data “export” function is in 
progress; used to prevent multiple export routines being run 
concurrently 
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27.11.3 Inventory Location Manager Screens 

This screen provides for the maintenance of location information used in the inventory and 
logistics processes. Table 27.11.3-1 describes the screen’s fields. 

Figure 27.11.3-1. Inventory Location Manager Screen 

Table 27.11.3-1. Inventory Location Manager Field Descriptions (1 of 2) 
Field Name Data Type Size Description 

MATERIAL 
LOCATION ID 

String 6 ID for the location where material can be found. 

DESCRIPTION 
(Material Location) 

String 30 Text description of the utility of the site. 

LOCATION TYPE 
(Material Location) 

String 1 Code that specifies the material application at the site: Null or 
S = stock, R = received, N = non-nettable, W = work center, 
A = archive. 

SITE (LOCATION) String 6 Code for the ECS site hosting the inventory location. 

SHIPPING 
REPORT 
NUMBER 

Number 2 Report number assigned to this item when the item was 
shipped. 

SHIPPING 
REPORT ALPHA 

String 2 Shipping report code associating an alpha code to a numeric 
site code. See Shipment Numbers by Site screen (shipno). 

CONSIGNEE 
NAME 

String 30 Name of individual/office responsible for material at the site. 

ADDRESS 1 
(Consignee) 

String 30 First part of address 
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Table 27.11.3-1. Inventory Location Manager Field Descriptions (2 of 2)

Field Name Data Type Size Description 

ADDRESS 2 
(Consignee) 

String 30 Second part of address. 

CITY String 20 City part of address 

STATE String 2 State 2 character abbreviation of address. 

ZIP String 10 Zip code of address. 

PHONE String 18 Telephone number of address 

27.11.4 Hardware/Software Codes Screens 

This screen provides the maintenance of the codes used to identify maintenance cost source 
information in the inventory and logistics processes. Table 27.11.4-1 describes the screen’s 
fields. 

Figure 27.11.4-1. Hardware/Software Codes Screen 

Table 27.11.4-1. Hardware/Software Codes Field Descriptions 
Field Name Data 

Type 
Size Description 

CODE 
(Hardware/Software) 

String 10 Code for classifying the type of items. 

DESCRIPTION 
(Hardware/Software) 

String 30 Description for the hardware/software code 
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27.11.5 Status Code Manager Screen 

The Status Code Manager screen (Figure 27.11.5-1) maintains a set of standardized status codes 
for tracking property and events in the inventory and logistics processes. Table 27.11.5-1 
describes the screen’s fields. 

Figure 27.11.5-1. Status Code Manager CHUI 

Table 27.11.5-1. Status Code Manager Field Descriptions 
Field Name Data Type Size Description 

CODE String 4 Code for an inventory status for an item. 

DESCRIPTION String 30 Description for the code. 

27.11.6 DAAC Export Inventory Data Screen 

ILM at the SMC can maintain consolidated records about inventory, logistics, and maintenance 
activities system-wide. Records created at local sites can be exported and shipped to the SMC 
where they can be added to records that were centrally created. For ECS, only records about 
items at the site are to be exported. 

NOTE: ILM data import and export are now automated. The cron jobs are run daily at SMC 
and all the DAACs. LMCs do not need to invoke this process. The information providing here 
is just for the operator reference only. 

The DAAC Export Inventory Data utility supports this customized export process. It generates a 
formatted data file containing site records changed but not previously exported, and optionally 
transfers the file via ftp to a machine at the SMC. 
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The screen in Figure 27.11.6-1 initiates the export process. XRP-II analyzes the transaction log 
to determine what data changed since the last time the function was used and which site items 
were affected. EIN, EIN structure, purchase order, work order, inventory and transaction history 
records are copied and stored in files compatible with XRP-II’s ILM Import Records utility. 
These files are, in turn, archived in a tar file. The tar file is given a name that identifies the date 
and time the export was done, the origination site, the file’s type, and the machine to which the 
file is to be sent. If the SEND NOW feature is used, XRP-II transfers the files via ftp then moves 
them from the export directory to an archive directory. Otherwise, the files remain in the export 
directory to be transferred manually. 

Note: Export files that are transferred manually to a destination machine must also be moved 
manually to the export archive directory. 

Note: The export directory and its corresponding export archive directory are configuration 
parameters named via program environment variables set in the XRP-II configuration files 
during installation. 

Table 27.11.6-1 describes the screen’s fields. 

Figure 27.11.6-1. DAAC Export Inventory CHUI 

Table 27.11.6-1. DAAC Export Inventory Data Field Descriptions 
Field Name Data Type Size Description 

FIRST MACHINE 
TO SEND TO 

String 40 Full domain name or IP address of the machine to receive the 
exported inventory data. 

SEND NOW String 1 Flag to indicate if the export tar file is to be sent now. 
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27.11.7 ILM Import Records Screen 

ILM data will be exchanged among ECS sites on a routine basis. The ILM Import Records 
utility is designed to load data from tar files that had been created and forwarded using either of 
ILM data export utilities (see Sections 27.11.7). 

The screen shown in Figure 27.11.7-1 initiates the import process. Entering “Y” at the prompt 
causes XRP-II to process all files in the directory named in the IMPORTPATH environment 
variable. Import tar files -- whose names indicate the date and time they were made -- are 
processed in chronological order as determined from their file names. Upon completion, the 
original files are moved to an archive directory named in the IMPORTARC environment 
variable. 

NOTE: ILM data import and export are now automated. The cron jobs are run daily at SMC 
and all the DAACs. LMCs do not need to invoke this process. The information providing here 
is just for the operator reference only. 

Figure 27.11.7-1. ILM Import Records CHUI 

27.11.8 Site Codes for Scanned Data Screen 

This screen (Figure 27.11.8-1) allows operators to maintain a set of standard codes and 
descriptions for identifying ECS sites and buildings. Each code represents one site/building pair. 
They are used to decipher location codes used in bar code scanner data imported into ILM. Table 
27.11.8-1 describes the screen’s fields. 
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Figure 27.11.8-1. Site Codes for Scanned Data CHUI 

Table 27.11.8-1. Site Codes for Scanned Data Field Descriptions 
Field Name Data Type Size Description 

CODE Numeric 4 Code assigned to a Site and Building 

SITE String 6 Code for an ECS site. The operator may zoom to the Site Master 
file to choose the code, if it had been entered there previously. 
(See the Site Master Manager section.) 

BUILDING String 6 Identifier for the building where an item can be found. 

DESC String 40 Description of the Site/Bldg combination. 

27.11.9 Scanned Data Screen 

The Scanned Data screen (Figure 27.11.9-1) presents a set of bar code scanner data that had been 
loaded into ILM but not yet processed. It allows operators to review and edit scanned data that 
has been pre-processed and to create additional data if desired. Records are typically imported 
using ILM’s scan data processing function, which also deletes them after they have been 
processed successfully. Table 27.11.9-1 describes the screen’s fields. 
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Figure 27.11.9-1. Scanned Data CHUI 

Table 27.11.9-1. Scanned Data Field Descriptions 
Field Name Data Type Size Description 

CODE Numeric 4 Code assigned to a Site and Building 

ROOM String 4 Scanned room number 

PARENT String 20 Scanned Parent EIN 

CHILD String 20 Scanned Child EIN 

27.11.10 Process Scanned Data Screen 

The Process Scanned Data screen (Figure 27.11.10-1) controls the updating of ECS property 
records using information about EINs derived from bar code readers. The bar code data is 
typically obtained during a physical inventory or audit and is stored in a file specially formatted 
for processing by XRP-II. 

Operators can load data from the file and pre-process it to identify conflicts between it and 
information already stored in the ILM database. Among others, discrepancies can include: 

‹ EINs that were found by the audit but are not known to ILM; 

‹�EINs designated in ILM as a child of a parent but found associated with a different parent 
in the bar code data; and, 

‹�Parent EINs shown in ILM as being at the site but missing in the data. The Preprocess 
Data Report itemizes the findings. 

Operators process the data after the discrepancies are resolved, at which time the system updates 
the property records to reflect the location, building, and room for for the EINs in the file. 
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However, the database remains unchanged for EINs that still have product structure 
discrepancies and for those that have not yet been added to ILM. 

Table 27.11.10-1 describes this screen’s fields. 

Figure 27.11.10-1. Process Scanned Data CHUI 

Table 27.11.10-1. Process Scanned Data Field Descriptions (1 of 2) 
Field Name Data Type Size Description 

CLEAR DATA 
FILE (Y/N) 

String 1 Flag designating whether or not to clear previously loaded scanned 
data records before starting the pre-processing or processing 
activity. 

LOAD SCANNED 
DATA (Y/N) 

String 1 Flag designating if scanned data should be (re)loaded from the 
named file before starting the pre-processing or processing activity. 

FILE NAME String 40 Name of the file containing the bar code scan data to be imported 

RESET STATUS 
(Y/N) 

String 1 Flag designating if processing status flags that may have been 
previously set in loaded data records should be reset before 
starting the pre-processing or processing activity. Set to Y before 
preprocessing 

PREPROCESS 
RECORDS (Y/N) 

String 1 Flag designating whether or not to compare scanned data to 
existing inventory records before updating the databbase. 

ELIMINATE 
DUPLICATES 
(Y/N) 

String 1 Flag designating if duplicate records are to be eliminated from 
scanned data. Applies to pre-processing only. 

REPORT 
MISSING 
CHILDREN (Y/N) 

String 1 Flag designating whether or not to report child EINs not found in 
the scanned data. Applies to pre-processing only. 
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Table 27.11.10-1. Process Scanned Data Field Descriptions (2 of 2)

Field Name Data Type Size Description 

REPORT VALID 
RECORDS (Y/N) 

String 1 Flag designating whether or not to report records found to be valid 
in the scanned data file. Applies to pre-processing only. 

REPORT 
MISSING 
PARENTS (Y/N) 

String 1 Flag designating whether or not to report “top-level” EINs not found 
in the scanned data. Applies to pre-processing only. 

PROCESS 
RECORDS (Y/N) 

String 1 Flag designating whether or not to update location information in 
the database based on the scanned data. 

CLEAR DATA 
REPORT 

Numeric 2 Number of copies of “CLEAR DATA FILE” report desired. 

LOAD DATA 
REPORT 

Numeric 2 Number of copies of “LOAD DATA FILE” report desired. 

RESET DATA 
REPORT FILE 

Numeric 2 Number of copies of “RESET DATA FILE” report desired. 

PREPROCESS 
DATA REPORT 

Numeric 2 Number of copies of “PREPROCESS RECORDS” report desired. 

PROCESS DATA 
REPORT 

Numeric 2 Number of copies of “PROCESS RECORDS” report desired. 

27.12 System Utilities Menu (Perform XRP-II Master File Maintenance) 

XRP-II groups together several programs that help standardize values for all of XRP-II and 
support inter-site exchange of ILM data. The screens supporting these programs are accessed via 
the System Utilities menu (Figure 27.12-1). 

Figure 27.12-1. System Utilities Menu Screen
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The System Utilities menu is broken down into the following functions: 

Table 27.12-1. System Utilities Menu options 
Menu item Function Section 

System Parameters 
Manager 

For maintaining system-wide parameters 27.12.1 

Data Delete Utility For deleting unwanted records in the database 27.12.2 

Transaction Log For logging the database transactions 27.12.3 

Transaction Archive For archiving old database transactions 27.12.4 

Site Master Manager For maintaining a list of the ECS related sites 27.12.5 

27.12.1 System Parameters Manager Screen 

The screen shown in Figure 27.12.1-1 maintains system-wide, XRP-II parameters and is 
principally used when first installing the system. Since ILM uses only a subset of the full XRP-II 
capabilities, this is a scaled down version of the screen described in Section 6 of the XRP-II 
System Reference Manual. It contains only the fields needed to tailor the system to the site at 
which it operates. 

Figure 27.12.1-1. System Parameters Manager CHUI 

The system parameter key is the key field of the system parameter file. The value “A” designates 
the active record, which is set when the database is created. 

Note: An active record must always be present in order for XRP-II to function. 

In the site identifier field, enter the code for the ECS site where the copy of XRP-II that the 
operator is using is installed. This data is used primarily in report headers and file names that 
XRP-II creates. 
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Note: The site identifier field must have an entry in order for ILM’s data export processing to 
work properly. 

Table 27.12.1-1. System Parameters Manager Field Descriptions 
Field Name Data Type Size Description 

System 
parameter key 

string 1 Code that designates the active record in XRP-II’s system 
parameter table 

Site id string 6 Code that identifies an ECS site 

Last control item 
id 

string 20 Code used in determining the next sequentially-available identifier 
when assigning control item identifiers automatically 

Last ein string 20 Code used in determining the next sequentially-available identifier 
when assigning ein numbers automatically 

Use branch as 
order prefix 

string 1 Code that, if “Y”, causes all purchase orders, work orders, and 
sale orders to be prefixed with the site code of the user or, if null, 
the default site code 

Starting RAM numeric 8 Initial amount of memory XRP-II is to use 

NASA contract 
number 

string 60 Code that is used by NASA to identify the ECS contract and is 
attached to all property records 

Default mfg year numeric 4 Year used as default to identify when an item was built 

Export 
functioning 

string 1 Code that indicates if an XRP-II data “export” function is in 
progress; used to prevent multiple export routines being run 
concurrently 

27.12.2 Data Delete Utility 

Data Delete Utility enables the deletion of arbitrary types of data that are no longer wanted in the 
database. Access to this screen should be restricted to the System administrator. In a relational 
database with referential integrity it is not possible to delete a record in a database table that is 
referenced by a record in some other table. Data delete utility enables the user to specify a table 
and key value, then it identifies on the screen the data related to the specified data, and optionally 
allows the user to delete the related data and the base record. 
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Figure 27.12.2-1. Data Delete Utility Screen 

Table 27.12.2-1. Procedure to delete base records in the database 
PERFORM ACTION 

Navigate to the Data 
Delete Utility screen 

From the Main Menu 
A. Select System Utilities Menu – press ‘enter’ 
B. Select Data Delete Utility – press ‘enter’ 

Enter data to be deleted A. Enter the table name of a database table at the “Table:” prompt. XRP 
responds by listing the one or more fields which form the key of the file. 

B. Then enter the key value identifying the base record to be deleted. 
C. XRP specifies the number of record selected based on the key value the user 

entered. Press ‘enter’ to go to the next step. 
D. XRP prompts “DELETE MODE: Confirm Silent or Quit?” 

Confirm – Type ‘C’ to select confirm. XRP identifies and lists on the screen 
all of the tables in the database have one or more records referencing the 
base record. If the user confirms that the data is to be deleted, XRP deletes 
all of the related records and then the base record. The number of records 
deleted from each table is echoed to the screen. 
Silent – XRP will delete all the base records silently without asking the user to 
confirm the deletion. 
Quit – to exit out of the delete mode. 

Exit the screen Press ‘F3’ to exit Data Delete Utility screen. 

27.12.3 Transaction Log Screen 

The screen shown in Figure 27.12.3-1 allows operators to browse, and maintain if necessary, the 
database transaction log file. Values for all fields on this screen are system-supplied. When a 
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database record is modified via a data entry screen, the system provides the next available 
transaction number and record information about what field was modified when and by whom. 

The transaction log facilitates synchronizing database changes among sites. For example, the 
Export Site-Unique Changes utility (Section 27.11.6) analyzes the log’s entries to identify 
database records that have been modified, setting each Transferred field so it bypasses the entry 
next time the utility is run. 

Figure 27.12.3-1. Transaction Log CHUI 

The screen displays numbers to identify XRP-II database fields because field names are not 
stored in the database. Field names that correspond to the numbers can be found in file 
$MSPATH/mms/def/file.h, where MSPATH is an environment variable identifying XRP-II’s 
installation directory. 

Similarly, the screen uses numbers to identify locations of altered database records. The current 
contents of a referenced record can be displayed as follows, but only if the record at that location 
was neither deleted nor replaced by another since the log entry was made. At a Unix command 
line prompt, type: 

SYS920 Invokes UNIFY’s database test driver 
setloc <table> <location> Displays a record’s data 
end Exits program SYS920 

Note: Use Transaction Archive (Section 27.12.4) to remove obsolete transaction records. 
Transaction Archive preserves records that export utilities still need, and it saves a historical 
copy of the records it deletes. 

Table 27.12.3-1 describes this screen’s fields. 
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Table 27.12.3-1. Transaction Log Field Descriptions

Field Name Data Type Size Description 

transaction key numeric 5 Number that uniquely identifies each update transaction 

field number numeric 8 Numerical identifier for the XRP-II field affected by the 
transaction. 

table name string 10 Name of the XRP-II table affected by the update transaction 

operator id string 8 Userid of the operator making the update transaction 

date date N/A Date of the update transaction 

time time N/A Time of the update transaction 

transaction type string 1 Code for the type of transaction: 
A (add), M (modify), or D (delete) 

transferred string 1 Code that indicates that the transaction has been analyzed by 
an export utility. “T” means the corresponding control item 
record has been exported, while “X” means it did not need to be 
exported. 

record location numeric 8 Identifier for the relative record within the XRP-II table affected 
by the update transaction 

ilm string 1 Code that distinguishes between ILM-and BLM-related log 
entries; “Y” signifies ILM 

27.12.4 Transaction Archive Screen 

Control item data update transactions should periodically be deleted from the database after 
changed records have been exported. This makes room to log new transactions. 

The Transaction Archive screen shown in Figure 27.12.4-1 copies to a named file the records of 
transactions that occurred on or prior to a specified cutoff date. It then deletes the records from 
the database. 

Specify the date of the last transaction to archive and the name of a file in which to store the 
data. 

Note: XRP-II will only archive a transaction log record if its Transferred field contains the value 
“T” or “X”. The presence of a “T” or “X” means the record has been analyzed by a program for 
exporting records about control item changes to other sites (see Sections 27.11.6). Deleting 
unanalyzed transaction log records can cause incomplete data exchanges. 
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Figure 27.12.4-1. Transaction Archive CHUI 

Table 27.12.4-1. Transaction Archive CHUI Field Descriptions 
Field Name Data Type Size Description 

file name string 8 Name of the file in which to store transaction records being 
archived 

cutoff date date N/A Date of the most recent transaction to be archived 

27.12.5 Site Master Manager Screen 

The Site Master Manager screen (Figure 27.12.5-1) lets operators maintain an index of ECS­
related sites. This index, which identifies details about each site, also serves as a pick list to 
facilitate entering control item implementation status data and report generation parameters on 
other screens. This screen is identical to the Branch Master Maintenance screen described in 
Section 6.8 of the XRP-II System Reference Manual, except that the term “site” is used in lieu of 
“branch” and the tax code field has been deleted. Table 27.12.5-1 describes the “site” fields that 
were tailored for ECS. 
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Figure 27.12.5-1. Site Master Manager CHUI 

Table 27.12.5-1. Site Master Manager Field Descriptions 
Field Name Data Type Size Description 

site id string 6 Code that uniquely identifies an ECS site. 

site name string 46 Full name of an ECS site. 

phone number string 8 Phone number of a point of contact at the site 

street address string 30 Address for the site 

city string 20 Name of the city in which the site is located 

state string 2 Abbreviation for the state in which the site is located 

zip string 10 Postal code for the site 

country string 16 Code for the country in which the site is located 

27.13 System Tools Menu (Perform XRP-II System and Database 
Administration) 

XRP-II provides several programs for controlling user access, maintaining the database, and 
customizing the user interface. Many of the programs are supported by data entry screens 
accessed via XRP-II’s System Tools menu (Figure 27.13-1) 

Note:  The System Tools menu is new with version 3.0.1 of XRP-II. It moves control of menus, 
screens, and user access from ASCII files to the database and brings to the menu handler 
functions previously available only at the command line. Vendor manuals do not yet reflect the 
change. 
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Figure 27.13-1. System Tools Menu Screen 

The System Tools menu is broken down into the following functions: 

Table 27.12-1. System Utilities Menu options 
Menu item Function Section 

User Manager For registering new ILM users 27.13.1 

Screen Permission 
Control 

For Managing the user group and menu permission 27.13.2 

Data Dump Utility For dumping one or more ILM tables into specially 
formatted data files. 

27.13.3 

27.13.1 User Manager Screen 

Operators use the User Manager screen (Figure 27.13.1-1) to register the Unix userids of 
individuals authorized to run XRP-II. Individuals are assigned a group of menus and screens that 
may be accessed and a specific entry menu. As part of logon processing, XRP-II’s menu handler 
obtains an individual’s Unix userid from the system and verifies it against those that have been 
registered. 

Use this screen to add, delete, modify or browse XRP-II user records. 

Note: Consistent with the single login philosophy of ECS, XRP-II prompts the user for neither a 
userid nor a password when the ECS standard Baseline Manager startup script “ pcs” is used. 
The script passes XRP-II the operator’s userid as an argument based on results of a “whoami” 
command and access is controlled via screen permissions rather than passwords. 

Note: Data access for operators running XRP-II executable from the command line is governed 
by Unix file permissions rather than the menu handler. 
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Figure 27.13.1-1. User Manager CHUI


Table 27.13.1-1. User Manager Field Descriptions

Field Name Data Type Size Description 

login id String 32 Full, network-addressable name of a host 

password String 6 Code that uniquely identifies an ECS site 

first name String 30 First name of the user 

last name String 30 Surname of the user 

title String 20 Name of the user’s position or job 

group String 8 Name for a collection of XRP-II data entry screens and menus. 
These are the default screens and menus the user can access. 
Deviations can be specified via Screen Permission Control. 

address String 30 Street address where the responsible engineer is located 

city String 20 Name of the city in which the responsible engineer is located 

phone String 18 Phone number for the responsible engineer 

state String 2 Name of the state in which the responsible engineer is located 

zip String 10 Postal code where the responsible engineer is located 

start menu String 8 Name or code of the menu initially presented to the user at 
login 

27.13.2 Screen Permission Control Screen 

Screen Permission Control (Figure 27.13.2-1) lets operators specify the XRP-II menus and data 
entry screens a user or user group can access and the data manipulation permissions the user or 
group are granted when accessing a screen. It replaces reliance on the “users” and “groups” files 
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discussed in Sections 5 and D.5 of the XRP-II System Reference Manual, however the concept 
of access and privileges by group and user is the same. 

Use this screen to browse, add to, or edit existing screen permission control records. Each record 
renders a menu or data entry screen accessible to some user or group. For data entry screens, it 
also assigns to the user or group the privilege to query (inquire), add, modify, and/or delete 
records via the screen. A privilege is assigned by placing a “Y” in the appropriate privilege 
field. Similarly, a privilege is removed by placing an “N” in the appropriate privilege field. 

Consider the following when modifying screen permissions: 

•	 Privileges specified for a user take precedence over privileges specified for the user’s 
group 

• A user or group is granted access to a menu or screen only if a privilege is assigned. 

• Assignment of All Privilege overrides other privileges specified in the record 

•	 Privileges specified in the record do not override permission restrictions coded into 
specifications for the screen (e.g,, no user can update the database via a screen marked for 
querying the database only, regardless the privileges the user is given for the screen.) 

Figure 27.13.2-1. Screen Permission Control CHUI 

ILM is delivered with a default set of user groups and associated screen permissions (see Section 
27.2). Example ways an operator might extend this set include: 

•	 Making a screen available to a group - add a record that names the screen and group, then 
assign at least one privilege for the group 

•	 Making a screen accessible to only certain users - add a record for each user. Name the 
screen and the user, and assign at least one privilege for the user. Then find and delete 
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any records that make the screen accessible to groups other than any established for the 
system administrator. 

•	 Increasing a screen’s privileges for a member of a group - add a record that names the 
screen and the user, and assign the extra privilege for the user. 

•	 Restricting a screen’s privileges for a member of a group - add a record that names the 
screen and the user, and remove the privilege(s) for the user 

Table 27.13.2-1 describes this screen’s fields. 

Table 27.13.2-1. Screen Permission Control Field Descriptions 
Field Name Data Type Size Description 

screen or menu 
code 

string 8 Identifier (short name) that XRP-II programs use in referencing 
an XRP-II screen or menu (e.g., pici). 

group or user id string 8 Name that classifies XRP-II users according to access required 
to menus and screens, or an individual’s Unix userid 

inquire privilege string 1 Code indicating if the group or user can: 
a) read database records via the named screen; or 
b) can access the named menu. 

modify privilege string 1 Code indicating if the group or user can: 
a) modify database records via the named screen; or 
b) can access the named menu. 

delete privilege string 1 Code indicating if the group or user can: 
a) delete database records via the named screen; or 
b) can access the named menu. 

add privilege string 1 Code indicating if the group or user can: 
a) add database records via the named screen; or 
b) can access the named menu. 

all privilege string 1 Code indicating if the group or user can: 
a) read, modify, delete, and add database records via the 

named screen; or, 
b) can access the named menu. 

27.13.3 Data Dump Utility Screen 

Operators use the Data Dump Utility screen (Figure 27.13.3-1) to bulk dump one or more XRP-
II database tables into specially formatted data files. A file is created for each database table, 
and it contains all fields for all records in the table. Fields are separated by pipe symbols (|). 
The first line in each file identifies the field ordering. See the XRP Tools, Techniques, and 
Conventions Manual, Sections 1.5 and 1.6, for file format conventions XRP-II uses. 

Enter Modify mode and, using Table 27.13.3-1 as a guide, specify which tables to dump and 
whether to archive the resulting data files. Return to Inquiry mode, then enter “E” to initiate the 
dump and “Y” at the confirmation prompt. XRP-II will create the requested data files and return 
to the System Tools menu. 
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Note: If a tar file is named, XRP-II archives all formatted data files it finds regardless whether 
the corresponding database table was part of the current dump. 

Figure 27.13.3-1. Data Dump Utility CHUI 

Table 27.13.3-1. Data Dump Utility Field Descriptions 
Field Name Data Type Size Description 

Dump string 60 List of tables to dump (e.g., pm, ec, etc.). A null field causes 
all tables to be dumped. Section 4.3.3.4.1describes how to 
obtain a list of XRP-II table names 

Tar dump files string 1 Code indicating whether or not to tar the data tables that 
were dumped 

Tar file name string 40 Pathname for the tar file in, or relative to, the database 
directory specified in environment variable $DBPATH 
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Appendix A. Additional Material


TBS
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Abbreviations and Acronyms­

Ao Operational Availability


ACL Access Control List


ADC Affiliated Data Center (NOAA)


ADSERV Advertising Service


AI&T Algorithm Integration and Test


AIT Algorithm Integration Team


AMASS Archival Management and Storage System


ASCII American Standard Code for Information Interchange


BBS Bulletin Board System


CCB Configuration Control Board (NASA Convention)


CCR Configuration Change Request


CCRS Canada Centre for Remote Sensing


C D Compact Disk


CDE Common Desktop Environment


CD-ROM Compact Disk - Read Only Memory


CDR Critical Design Review


CDRL Contract Data Requirements List


CDS Cell Directory Service


CHCI Communications Hardware Configuration Item


CHUI Character User Interface


Configuration Item 

CIDM Client Interoperability and Data Management 

C M Configuration Management 

CMA CM Administrator 

CN Change Notice 

CO Contracting Officer 
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CI 



COTR Contracting Officer’s Technical Representative


COTS Commercial Off-the-Shelf (hardware or software)


CPU Central Processing Unit


CR Change Request


CRM Change Request Manager


CSCI Computer Software Configuration Item


CSMS Communications and Systems Management Segment (ECS)


CSR Consent To Ship Review


CSS Communication Subsystem


DAA Data Availability Acknowledgment


DAAC Distributed Active Archive Center


DADS Data Archive and Distribution System


DAN Data Availability Notice


DAP Delivered Algorithm Package


DAR Data Acquisition Request


DAS Data Availability Schedule


DAT Digital Audio Tape


DB Database


DBA Database Administrator


DBMS Database Management System


DCE Distributed Computing Environment (OSF)


DCF Data Capture Facility


DCN Document Change Notice


DCO Document Change Order


DCR Data Collection Request


DD Data Dictionary


DDA Data Delivery Acknowledgment


DDICT Data Dictionary


DDIST Data Distribution
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DDN Data Delivery Notice


DDSRV Document Data Server


DDTS Distributed Defect Tracking System


DES Data Encryption Standard


DESKT Desktop Configuration Item


DID Data Item Description


DIF Data Interchange Formant


DIMGR Distributed Information Manager


DME Distributed Management Environment


DMO Data Management Organization


DNS Domain Name Service


DOF Distributed Object Framework


DPR Data Processing Request


DPS Data Processing Subsystem


DR Delivery Record


DS Data Server


DSS Data Server Subsystem


e-mail Electronic Mail


EBNet EOSDIS Backbone Network (combines Ecom and ESN)


ECN Equipment Control Number


ECS EOSDIS Core System


EDC EROS Data Center (DAAC)


EDF ECS Development Facility


EDHS ECS Data Handling System


EGS EOS Ground System


EIN Equipment Identification Number


EMC Enterprise Monitoring and Coordination


EOC EOS Operations Center (ECS)


EOS Earth Observing System
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EOSDIS Earth Observing System Data and Information System


EP Evaluation Package


EROS Earth Resources Observation System


ESD Electrostatic Discharge


ESDIS Earth Science Data and Information System (GSFC Code 505)


ESDT Earth Science Data Type


ESOD Earth Science On-line Directory


ET Eastern (standard or daylight savings) Time


FDDI Fiber Distributed Data Interface


FORTRAN FORmula TRANslation (computer language)


FOS Flight Operations Segment (ECS)


FOT Flight Operations Team


FTP File Transfer Protocol


FTPD File Transfer Protocol Daemon


GB Gigabyte (109)


Gb Gigabit (109)


GBps Gigabytes per Second


Gbps Gigabits per Second


GCDIS Global Change Data and Information System


GCMD Global Change Master Directory


GFE Government Furnished Equipment


GFP Government Furnished Property


GSFC Goddard Space Flight Center


GUI Graphical User Interface


H/W Hardware


HDF Hierarchical Data Format


HIPPI High Performance Parallel Interface


HPOV HP Open View


HSM Hierarchical Storage Management
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HTML Hypertext Mark-Up Language


HWCI Hardware Configuration Item


I&AT Integration and Acceptance Test


I&T Integration and Test


I&TT Integration and Test Team


IATO Independent Acceptance Test Organization


ICD Interface Control Document


ICLHW Ingest Client Hardware [configuration item]


ILM Inventory, Logistics, and Maintenance


ILP Integrated Logistics Plan


ILS Integrated Logistics Support


ILSMT ILS Management Team


ILSO ILS Office


INGST Ingest Services


INS Ingest System


IOS Interoperability Subsystem


IP Internet Protocol


IQ Intelligent Query and IQ Access


Ir1 Interim Release 1


ISDN Integrated Services Digital Network


ISS Internetworking Subsystem


ISQL Interactive SQL


IV&V Independent Verification and Validation


JIL Job Information Language


JPL Jet Propulsion Laboratory (DAAC)


KB Kilobyte (103)


Kb Kilobit (103)


KBps Kilobytes per Second
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Kbps Kilobits per Second 

L-7 Landsat-7 (Landsat-7 for EDHS search) 

L0 Level 0 

L0-L4 Level 0 (zero) through Level 4 (use Level-0 through Level-4 for EDHS search)


LAN Local Area Network


Landsat Land Remote-Sensing Satellite


LaRC Langley Research Center (DAAC)


LDOS Landsat Data and Operations System


LIM Local Information Manager


LIMGR Local Information Manager


LMC Local Maintenance y


Loral Loral Aerosys (ECS Team)


LRU Line Replaceable Unit


M Million, mega (prefix)


M&O Maintenance and Operations


MAN Metropolitan Area Network


MB Megabyte (106)


Mb Megabit (106)


MBps Megabytes per Second


Mbps Megabits per Second


MCF	 Metadata Configuration File 
Metadata Control File 

MD Master Directory


MDA Management Data Access


MDT Mean Downtime


MHWCI Management Hardware Configuration Item


MHz Megahertz


MIB Management Information Base


MIS Management Information System
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MM Millimeter


MO&DSD Mission Operations and Data Systems Directorate (GSFC Code 500)


MOU Memorandum of Understanding


MR Malfunction Report


MSEC Millisecond


MSFC Marshall Space Flight Center (DAAC)


MSS Management Systems Subsystem


MTBCM Mean Time Between Corrective Maintenance


MTBF Mean Time Between Failure


MTBM Mean Time Between Maintenance


MTBPM Mean Time Between Preventive Maintenance


MTPE Mission to Planet Earth


MTTR Mean Time to Repair


MTTRes Mean Time to Restore


N/A Not Applicable


NA Network Administrator


NASA National Aeronautics and Space Administration


Nascom NASA Communications


NCC	 Network Control Center (GSFC) 
network communication center 

NCR Nonconformance Report


NCS Netscape Commerce Server


NCSA National Center for Supercomputer Applications


NMCI Network Management Configuration Item


NNM HPOpenView Network Node Manager


NOAA National Oceanic and Atmospheric Administration


NSI NASA Science Internet


NWCI Networking Configuration Item


OEM Original Equipment Manufacturer
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OJT On-the-Job Training


OPS Operations


Ops Super Operations Supervisor


ORPA Operations Readiness & Performance Assurance


ORR Operations Readiness Review


OS Operating System


OSF Open Software Foundation


OTS Off the Shelf


OVW HP OpenView Windows


PAIP Performance Assurance Implementation Plan


PB Petabyte (1015 )


PC	 Personal Computer 
Process Control 

PCF Process Control File


PDL Program Design Language


PDPS Planning and Data Processing System


PGE Product Generation Executive


PGS Product Generation Service


PI Principal Investigator


PIN Password Identification Number


PLANG Production Planning CSCI


PLNHW Planning Hardware [configuration item]


PLS Planning Subsystem


PM Preventative Maintenance


PPM Principal Period of Maintenance


PR Production Request


QA Quality Assurance


QC Quality Control


QRU Query, Retrieve, and Update
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R&M Reliability and Maintainability


RAID Redundant Array of Inexpensive Disks


RAM Random Access Memory


RE Responsible Engineer


RID Review Item Discrepancy


RMA Return Material Authorization


RMS Resource Management Subsystem


RSM Replication Server Manager


RSSD Replication Server System Database


Spacecraft 

S/W Software 

S/WCI Software Configuration Item 

SA System Administrator 

SATAN Security Administrator Tool for Analyzing Networks 

SCDO Science and Communications Development Office (ECS) 

SCF Science Computing Facility 

SCSI Small Computer System Interface 

SDP Science Data Processing 

SDPF Science Data Processing Facility 

SDPS Science Data Processing Segment (ECS) 

SDPS/W Science Data Production Software 

SDPTK Science Data Processing Toolkit 

SDSRV Science Data Server 

SE System Engineering 

SE&I System Engineering and Integration 

SEI&T System Engineering, Integration, and Test 

SEO Sustaining Engineering Organization 

SEPG Software Engineering Process Group 

SGI Silicon Graphics Incorporated 
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S/C 



SI&T System Integration and Test


SMC System(s) Monitoring and Coordination Center


SMF Status Message Facility


SMTP Simple Mail Transport Protocol


SNMP Simple Network Management Protocol


SOR System Operations Review


SORR Segment Operational Readiness Review


SPRHW Science Processing Hardware [configuration item]


SQL Structured Query Language


SQR SQL Report Writer


SRR System Requirements Review


SSAP Science Software Archive Package


SSI&T Science Software Integration and Test


SSL Secure Socket Layer


STMGT Storage Management


T&M Time and Materials


TB Terabyte (1012)


TBC To Be Confirmed


TBD To Be Determined


TBR To Be Resolved


TBS To Be Supplied


Tbyte Terabyte


TCP/IP Transmission Control Protocol/Internet Protocol


TEC Tivoli Enterprise Console


telecon Telephone Conference


TELNET Telecommunication Network


TRMM Tropical Rainfall Measurement Mission


TSDIS TRMM Science Data and Information System
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TT Trouble Ticket


UDP User Datagram Protocol


UR Universal Reference


URDB User Recommendations Database


URL Universal Resource Locator


USO User Support Office


US Rep User Services Representative


UWG User Working Group


VDD Version Description Document


VOB Versioned Object Base (ClearCase)


WAIS Wide Area Information Server


WAN Wide Area Network


WKBCH Workbench


WKSHCI Working Storage Hardware Configuration Item


WWW World Wide Web
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